# Contents

<table>
<thead>
<tr>
<th>Topic</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Jira Service Management Data Center and Server 5.8 documentation</td>
<td>6</td>
</tr>
<tr>
<td>Installing Jira Service Management</td>
<td>7</td>
</tr>
<tr>
<td>Jira applications overview</td>
<td>10</td>
</tr>
<tr>
<td>Permissions overview</td>
<td>12</td>
</tr>
<tr>
<td>Getting started with Jira Service Management</td>
<td>27</td>
</tr>
<tr>
<td>Getting started for service project admins</td>
<td>30</td>
</tr>
<tr>
<td>Setting up your service project</td>
<td>32</td>
</tr>
<tr>
<td>Creating service project request types</td>
<td>34</td>
</tr>
<tr>
<td>Making queues for your service project teams</td>
<td>38</td>
</tr>
<tr>
<td>Adding service project agents</td>
<td>41</td>
</tr>
<tr>
<td>Customize your service project channels</td>
<td>44</td>
</tr>
<tr>
<td>Bring your service project to the next level</td>
<td>48</td>
</tr>
<tr>
<td>Introduce customers to your service project</td>
<td>50</td>
</tr>
<tr>
<td>Explore a sample project</td>
<td>52</td>
</tr>
<tr>
<td>Getting started for service project agents</td>
<td>54</td>
</tr>
<tr>
<td>Administering service projects</td>
<td>57</td>
</tr>
<tr>
<td>Managing access to your service project</td>
<td>58</td>
</tr>
<tr>
<td>Configuring the customer portal</td>
<td>63</td>
</tr>
<tr>
<td>Receiving requests by email</td>
<td>68</td>
</tr>
<tr>
<td>Managing the email channel</td>
<td>71</td>
</tr>
<tr>
<td>Managing the allowlist and blocklist</td>
<td>73</td>
</tr>
<tr>
<td>Troubleshooting issues with the email channel</td>
<td>77</td>
</tr>
<tr>
<td>Setting up an email channel with the Microsoft Graph API protocol</td>
<td>80</td>
</tr>
<tr>
<td>Setting up service project users</td>
<td>84</td>
</tr>
<tr>
<td>Managing project role memberships</td>
<td>90</td>
</tr>
<tr>
<td>Setting up queues for your team</td>
<td>91</td>
</tr>
<tr>
<td>Automating your service project</td>
<td>93</td>
</tr>
<tr>
<td>Send alerts with Jira Service Management webhooks</td>
<td>98</td>
</tr>
<tr>
<td>Managing service project notifications</td>
<td>100</td>
</tr>
<tr>
<td>Translate service project notifications</td>
<td>108</td>
</tr>
<tr>
<td>Setting up request types</td>
<td>112</td>
</tr>
<tr>
<td>Troubleshooting issues with request types</td>
<td>117</td>
</tr>
<tr>
<td>Setting up SLAs</td>
<td>120</td>
</tr>
<tr>
<td>Create and edit SLA calendars</td>
<td>127</td>
</tr>
<tr>
<td>How teams see SLAs</td>
<td>132</td>
</tr>
<tr>
<td>Reporting on SLAs</td>
<td>139</td>
</tr>
<tr>
<td>Importing SLAs</td>
<td>141</td>
</tr>
<tr>
<td>Using JQL queries specific to SLAs</td>
<td>144</td>
</tr>
<tr>
<td>Example: creating a basic SLA</td>
<td>146</td>
</tr>
<tr>
<td>Example: creating an SLA that doesn’t track continuous time</td>
<td>147</td>
</tr>
<tr>
<td>Example: creating an SLA with multiple cycles</td>
<td>148</td>
</tr>
<tr>
<td>Example: creating an SLA based on due date</td>
<td>149</td>
</tr>
<tr>
<td>Setting up approvals</td>
<td>150</td>
</tr>
<tr>
<td>Setting up service project reports</td>
<td>155</td>
</tr>
<tr>
<td>Default service project configuration</td>
<td>162</td>
</tr>
<tr>
<td>Using Jira applications with Confluence</td>
<td>165</td>
</tr>
<tr>
<td>Working on service projects</td>
<td>168</td>
</tr>
<tr>
<td>Working with issues</td>
<td>169</td>
</tr>
<tr>
<td>Attaching files and screenshots to issues</td>
<td>171</td>
</tr>
<tr>
<td>Creating issues and sub-tasks</td>
<td>174</td>
</tr>
<tr>
<td>Creating issues using the CSV importer</td>
<td>177</td>
</tr>
<tr>
<td>Editing and collaborating on issues</td>
<td>184</td>
</tr>
<tr>
<td>Linking issues</td>
<td>189</td>
</tr>
<tr>
<td>Editing multiple issues at the same time</td>
<td>194</td>
</tr>
<tr>
<td>Moving an issue</td>
<td>200</td>
</tr>
<tr>
<td>Visual editing</td>
<td>201</td>
</tr>
<tr>
<td>Scheduling an issue</td>
<td>203</td>
</tr>
<tr>
<td>Logging work on issues</td>
<td>205</td>
</tr>
</tbody>
</table>
Default Assets custom field .................................................. 455
Referenced Assets custom field ............................................. 458
Read-only Assets custom field ............................................. 461
Enabling Assets custom fields on customer portals ....................... 463
Adding Assets functions to workflows in Jira ............................ 465
Conditions and validators .................................................. 466
Post functions ................................................................... 467
Groovy scripts ................................................................... 472
Adding approvers from Assets to requests in Jira ......................... 474
Importing and exporting object schemas ................................. 479
Assets REST API documentation ....................................... 482
Advanced usage guides ..................................................... 483
Upgrading Insight with Jira Service Management ...................... 484
Working with object schemas .............................................. 486
Creating object schemas .................................................... 487
  Object schema templates ................................................ 489
Configuring object schemas ............................................... 491
Configuring Assets automation rules .................................. 493
Configuring print labels .................................................... 501
Working with object types ................................................ 503
Creating object types ....................................................... 505
Adding attributes to object types ....................................... 506
Configuring inheritance of attributes ................................. 511
Customizing the object view layout .................................... 512
  Adding widgets ............................................................. 514
Working with objects ......................................................... 522
Creating objects ................................................................ 524
Adding objects to Jira issues ............................................ 526
Viewing objects in the object view .................................... 529
Viewing references in a graph ......................................... 534
Printing labels and QR codes ........................................... 537
Importing your data ............................................................ 538
Importing with Asset Discovery ....................................... 539
Importing with Integrations .............................................. 540
Importing with built-in importers ....................................... 541
  Understand importing concepts ..................................... 542
  1. Create your import configuration ............................... 545
  2. Create object type and attribute mapping ..................... 564
  3. Inspect your import configuration ............................. 568
  4. Enable and sync your import .................................... 569
Searching for objects ............................................................ 570
  Advanced searching: AQL - Assets Query Language ............ 572
  Advanced: Placeholders .............................................. 585
  Assets JQL functions .................................................. 590
Working with reports ............................................................. 592
Providing help in multiple languages .................................. 600
Collecting customer satisfaction (CSAT) feedback ..................... 604
Jira Service Management best practices ................................ 607
Best practices for designing the customer portal ....................... 608
Best practices for IT teams using Jira Service Management ........... 612
Fulfilling service requests with your IT service desk .................... 614
Managing changes with your IT service project ......................... 619
  What to expect: Sample lifecycle of a change .................... 622
  1. Update the change management workflow .................... 667
  2. Create resolutions, post-functions, and priorities ............ 669
  3. Create and update custom fields ............................... 671
  4. Link your project to Assets asset management ................ 674
  5. Add approvals to your workflow ............................... 678
  6. Create and update automation rules ......................... 682
  7. (Optional) Set up a calendar to coordinate your changes .... 686
Managing incidents with your IT service desk .......................... 687
Managing problems with your IT service desk .......................... 691
Calculating priority automatically .................................... 695
Manage changes with your IT service management project 1 ......... 698
Best practices for software teams using Jira Service Management ............... 701
Collaborate with other Jira teams on Jira Service Management issues ............. 702
Collect effective bug reports from customers ............................................. 704
Customize Jira Service Management’s bug report workflow ............................ 706
Escalate Jira Service Management issues to other Jira teams ....................... 709
Get set up for customer service ................................................................. 710
Getting help with Jira Service Management ................................................ 712
Automate your project ................................................................................. 714
Jira Data Center and Server mobile app ....................................................... 718
Accessibility ................................................................................................. 722
Jira Service Management Data Center and Server 5.8 documentation

Put the power of Jira in the hands of your service management team.

Get started

New to Jira Service Management? Check out our guides for new administrators and users.

View guide

Whats new

Time to upgrade? Get the lowdown on the latest and greatest in Jira Service Management 5.8.

View latest changes
Installing Jira Service Management

Jira Service Management is built on the Jira platform and has everything your IT teams need for service request, incident, problem, and change management. It's part of the Jira family of applications (Jira Software, Jira Service Management, Jira Core) and can be used separately or in any combination, on the same instance.

If you're ready to install or upgrade Jira Service Management, then this guide has you covered. If you have Jira Service Management installed and would like to learn how to configure and use it, head to the Jira Service Management documentation.

1. System requirements

Before you install Jira Service Management, you'll need to check if it supports your operating system, as well as a few other things.

Read

- Supported platforms
- Jira applications installation requirements

If everything looks good, it's time to decide which version and license is right for your organization. If you've already made a decision, jump to Install Jira Service Management.

2. Versions and licensing

If you plan on managing your own Jira Service Management instance (not hosted by Atlassian), you have the option of either a Server or Data Center license. Your license determines which features and infrastructure choices are available.

For organizations who need more time to prepare before upgrading to a new version, but still want critical bug fixes, an Enterprise release is a good choice.

Read

- Jira Service Management licensing and purchasing
- Jira Server and Data Center feature comparison
- Long Term Support releases

If you're clear on what you're getting and why, it's time to install Jira Service Management.
3. Install Jira Service Management

Here we’ll talk you through how to install Jira Service Management to trial and put into production, as well as how to add additional Jira applications to your existing installation.

Install Jira Service Management to trial

1. Download the installer for your operating system at https://www.atlassian.com/software/jira/service-desk/download.
2. Follow the steps at Evaluation installation. Jira Service Management comes with a handy embedded H2 database that you can use for evaluation purposes.
3. Once installed, read Getting started for service project admins to learn what you can do with Jira Service Management.

If you’d like to move into production, consider starting afresh by following the Install Jira Service Management for production guides below.

Install Jira Service Management for production

1. Set up your database by following the guide that applies to you at Connecting Jira applications to a database.
2. Install with your operating system by following the guide below that applies to you:
   - Installing Jira applications on Windows
   - Installing Jira applications on Linux
3. Once installed, follow the tutorial on Getting started for service project admins to set up Jira Service Management for your support teams.

Install additional Atlassian products

If you have Jira Core or Jira Software installed, you can install Jira Service Management as an additional application, and vice versa.

Head to Administration > Applications > Versions & licenses and follow the steps below:

1. Check which version of Jira Service Management is compatible with your existing installation at Jira Service Management version history.
2. Ensure you have Jira Administrator Global Permission.
3. Follow the steps at Installing additional applications and version updates.
4. Read the documentation for the product you’ve installed, to learn how to get started.

There are over 600 apps available from the Atlassian Marketplace that will help you supercharge your Jira Service Management. Read Managing apps to learn how to set these up.
4. Upgrade to a newer version

There are several ways to upgrade Jira Service Management. The method you choose will depend on the version of Jira Service Management you use, and the type of environment you use it in.

Steps to take

1. Decide which version to upgrade to by reading the release and upgrade notes.
2. Determine your upgrade path:

<table>
<thead>
<tr>
<th>Version</th>
<th>Upgrade path</th>
</tr>
</thead>
<tbody>
<tr>
<td>Earlier than 2.5.x</td>
<td>Upgrade to 3.0, then upgrade to the latest version.</td>
</tr>
<tr>
<td>3.0 to 3.16</td>
<td>Upgrade directly to the latest version.</td>
</tr>
<tr>
<td>4.0 or later</td>
<td>Upgrade directly to the latest version.</td>
</tr>
</tbody>
</table>

3. Choose your method from the below options and follow the steps on that page:

- Using the installer (the easiest way to upgrade your Jira instance)
- Upgrading manually (if you're moving to a different operating system or database software)
- Upgrading Jira Data Center (manual) with downtime
- Upgrading Jira Data Center with zero downtime

5. Get the most out of Jira Service Management

Now you have Jira Service Management installed, there's plenty of resources to help you set it up, learn the features, and get your dream team using it.

Getting started

- Getting started for service project admins
- Getting started for service project agents

Top tasks

- Configuring the Customer Portal
- Automating your service project
- Setting up SLAs

Best practice guides

- Set up a knowledge base for self-service
- Best practices for IT teams using Jira Service Management
- Best practices for software teams using Jira Service Management
Jira applications overview

Jira Service Management licensing overview

The Jira family of applications (Jira Software, Jira Service Management, Jira Core) are built on the Jira platform and can be used in any combination on the same instance. Depending upon of your setup, users can be licensed to one, all, or any combination of these applications. Read on to understand how Jira Service Management licensing and roles affect what agents, customers, and other Jira application users can do.

If you're a Jira administrator, check out more information on Licensing and application access.

Application features and project types

Each application delivers a tailored experience for its users, and has an associated project type which in turn offers application specific features. Below is a list of the project types, and their associated application specific features.

<table>
<thead>
<tr>
<th>Application</th>
<th>Project type</th>
<th>Application specific feature set</th>
</tr>
</thead>
<tbody>
<tr>
<td>Jira Core</td>
<td>Business projects</td>
<td>• Available to all licensed users</td>
</tr>
<tr>
<td>Jira Software</td>
<td>Software projects</td>
<td>• Integration with development tools</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Agile boards</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Release hub for software versions</td>
</tr>
<tr>
<td>Jira Service Management</td>
<td>Service projects</td>
<td>• Service Level Agreements (SLAs)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• A customizable web portal for customers</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Permission schemes allowing customer access</td>
</tr>
</tbody>
</table>

All users that can log in to a Jira instance will be able to see all the projects in that instance (pending permissions), but they will only be able to see the application-specific features when they have application access. For example, a Software project is able to display information from linked development tools, such as Bitbucket and FishEye, as well as agile boards, but this information is only viewable by a Jira Software user. A Jira Core user would be able to see the Software project, but would not be able to see the Software-specific features, like agile boards or the information from linked development tools. Likewise, a Jira Software user would not be able to see any Jira Service Management application-specific features on a service project, only a basic view of the project and its issues.

- Only a Jira administrator can create a project for an installed application. They do not need application access to create the project, but they do need application access if they'd like to view or use the project.
- Anonymous users will have access equivalent to Jira Core users. In other words, they can view issues and work in any type of project, but they won't see application-specific features, e.g. agile boards, which are Jira Software-specific features. To know how to allow anonymous users access to projects, see Allowing anonymous access to your instance.

A list of the applications, their user roles, and their project's application-specific features can be found below:
<table>
<thead>
<tr>
<th>Service Projects</th>
<th>Project level</th>
<th>Jira-Core-user</th>
<th>Jira-Software-user</th>
<th>Jira-ServiceDesk-agent</th>
<th>Custom users</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Create</td>
<td>✗</td>
<td>✗</td>
<td>✓</td>
<td>✗</td>
</tr>
<tr>
<td></td>
<td>View</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Issue level</td>
<td>Create</td>
<td>✗</td>
<td>✗</td>
<td>✓</td>
<td>✗</td>
</tr>
<tr>
<td></td>
<td>View</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td></td>
<td>Comment</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td></td>
<td>Transition</td>
<td>✗</td>
<td>✗</td>
<td>✓</td>
<td>✗</td>
</tr>
<tr>
<td>SLA level</td>
<td>Create</td>
<td>✗</td>
<td>✗</td>
<td>✓</td>
<td>✗</td>
</tr>
<tr>
<td></td>
<td>View</td>
<td>✗</td>
<td>✗</td>
<td>✓</td>
<td>✗</td>
</tr>
<tr>
<td>Queue level</td>
<td>Create</td>
<td>✗</td>
<td>✗</td>
<td>✓</td>
<td>✗</td>
</tr>
<tr>
<td></td>
<td>View</td>
<td>✗</td>
<td>✗</td>
<td>✓</td>
<td>✗</td>
</tr>
<tr>
<td>Jira Service Management gadgets</td>
<td>View</td>
<td>✗</td>
<td>✗</td>
<td>✓</td>
<td>✗</td>
</tr>
</tbody>
</table>
Permissions overview

This page describes the different types of permissions and access rights that can be set up in Jira applications.

What are permissions?

Permissions are settings within Jira applications that control what users within those applications can see and do. All Jira applications allow a variety of permissions: from whether users can create new projects to whether a user can see a specific type of comment on an issue. These permissions can differ between applications.

Permissions are different from application access, which is controlled by groups that have Use access for an application. For more information about setting application access, see Managing users.

Types of permissions

There are three types of permissions in Jira applications, and they range from the high-level to granular:

- **Global permissions** - These apply to applications as a whole, not individual projects (for example, whether users can see the other users in the application).
- **Project permissions** - Organized into permission schemes, these apply to projects (e.g. who can see the project's issues, create, edit and assign them). While project admins can assign users to a project, they can't customize the permission schemes for a project. There are lots of project-level permissions you can set to control what users can do within a project.
- **Issue security permissions** - Organized into security schemes, these allow the visibility of individual issues to be adjusted (within the bounds of the project's permissions). For example, issue security permissions can let you set up types of issues that can only be seen by project admins or users in specific groups.

How do permissions get assigned?

Permissions can be assigned to groups or to project roles and/or issue roles. This diagram illustrates how permissions are assigned to users:
Who can set permissions?

<table>
<thead>
<tr>
<th>Permission</th>
<th>Can be set by</th>
<th>For more info, see...</th>
</tr>
</thead>
<tbody>
<tr>
<td>Global permission</td>
<td>A user with the Jira System administrator permission</td>
<td>Managing global permissions</td>
</tr>
<tr>
<td></td>
<td>A user in a group with System Admin access</td>
<td></td>
</tr>
<tr>
<td>Project permission</td>
<td>A user with the Jira System administrator permission</td>
<td>Managing project permissions</td>
</tr>
<tr>
<td></td>
<td>A user in a group with Admin access</td>
<td></td>
</tr>
<tr>
<td>Issue security permission</td>
<td>A user with the Jira System administrator permission</td>
<td>Configuring issue-level security</td>
</tr>
<tr>
<td></td>
<td>A user in a group with Admin access</td>
<td></td>
</tr>
<tr>
<td></td>
<td>A project admin</td>
<td></td>
</tr>
</tbody>
</table>

Jira Service Management provides a standard permission scheme (Jira Service ManagementPermission scheme for project) that automatically gives your service desk users the correct permissions for the project role they are in. For example, adding agents to your service desk will add users to the Service Desk Team role. This role gives them access to Jira Service Management projects to which they're assigned and also allows them to work on issues.

**Global permissions**
At installation time, Jira Service Management creates a global permission named **Jira Service Management agent access**. If agent based pricing is enabled for the instance, users who require access to agent views or functionality need to have this permission. The number of users who are granted this permission determines how many agent licenses are used on the system.

## Project permissions

This table shows the permission configuration for a standard service desk project permission scheme:

<table>
<thead>
<tr>
<th>Project Permissions</th>
<th>Users / Groups / Project roles</th>
<th>Explanation</th>
</tr>
</thead>
<tbody>
<tr>
<td>Administer Projects</td>
<td>Project Role (Administrators)</td>
<td>Permission to administer a project. This includes the ability to edit project role membership, project components, project versions and certain project details (Project Name, URL, Project Lead, Project Description).</td>
</tr>
<tr>
<td>Browse Projects</td>
<td>Servicedesk Customer - Portal Access, Project Role (Service Desk Team), Project Role (Administrators)</td>
<td>Permission to browse projects, use the Issue Navigator and view individual issues (except issues that have been restricted via issue security). <strong>Many other permissions are dependent on this permission</strong>, e.g. the 'Work On Issues' permission is only effective for users who also have the 'Browse Projects' permission.</td>
</tr>
<tr>
<td>View Development Tools</td>
<td>Project Role (Administrators)</td>
<td>Permission to browse projects, use the Issue Navigator and view individual issues (except issues that have been restricted via issue security). <strong>Many other permissions are dependent on this permission</strong>, e.g. the 'Work On Issues' permission is only effective for users who also have the 'Browse Projects' permission.</td>
</tr>
<tr>
<td>View (Read-Only) Workflow</td>
<td>Users / Groups / Project roles</td>
<td>Explanation</td>
</tr>
<tr>
<td>---------------------------</td>
<td>--------------------------------</td>
<td>-------------</td>
</tr>
<tr>
<td>• Project Role (Service Desk Team)</td>
<td></td>
<td>Permission to view the project's 'read-only' workflow when viewing an issue. This permission provides the 'View Workflow' link against the Status field of the 'View Issue' page.</td>
</tr>
<tr>
<td>• Project Role (Administrators)</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Issue Permissions</th>
<th>Users / Groups / Project roles</th>
<th>Explanation</th>
</tr>
</thead>
<tbody>
<tr>
<td>Create Issues</td>
<td></td>
<td>Permission to create issues in the project. (Note that the Create Attachments permission is required in order to create attachments.) Includes the ability to create sub-tasks (if sub-tasks are enabled).</td>
</tr>
<tr>
<td></td>
<td>• Service Desk Customer Access</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Project Role (Service Desk Team)</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Project Role (Administrators)</td>
<td></td>
</tr>
<tr>
<td>Permission</td>
<td>Description</td>
<td></td>
</tr>
<tr>
<td>------------</td>
<td>-------------</td>
<td></td>
</tr>
<tr>
<td>Edit Issues</td>
<td>Permission to edit issues (excluding the 'Due Date' field; see the Schedule Issues permission). Includes the ability to convert issues to sub-tasks and vice versa (if sub-tasks are enabled). Note that the Delete Issue permission is required in order to delete issues. The Edit Issue permission is usually given to any groups or project roles who have the Create Issue permission (perhaps the only exception to this is if you give everyone the ability to create issues; it may not be appropriate to give everyone the ability to edit too). Note that all edits are recorded in the issue change history for audit purposes.</td>
<td></td>
</tr>
<tr>
<td>Transition Issues</td>
<td>Permission to transition (change) the status of an issue.</td>
<td></td>
</tr>
</tbody>
</table>

- Service Desk Customer - Portal Access
- Project Role (Service Desk Team)
- Project Role (Administrators)
<table>
<thead>
<tr>
<th>Schedule Issues</th>
<th>Permission to schedule an issue that is, to edit the ‘Due Date’ of an issue. In older versions of Jira this also controlled the permission to view the ‘Due Date’ of an issue.</th>
</tr>
</thead>
</table>
|                 | • Service Desk Customer - Portal Access  
|                 | • Project Role (Service Desk Team)  
|                 | • Project Role (Administrators) |
| Move Issues     | Permission to move issues from one project to another, or from one workflow to another workflow within the same project. Note that a user can only move issues to a project for which they have Create Issue permission. |
|                 | • Service Desk Customer - Portal Access  
|                 | • Project Role (Service Desk Team)  
<p>|                 | • Project Role (Administrators) |</p>
<table>
<thead>
<tr>
<th>Permission</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Assign Issues</strong></td>
<td>Permission to assign issues to users. Also allows autocompletion of users in the Assign Issue drop-down. (See also Assignable User permission below)</td>
</tr>
<tr>
<td></td>
<td>• Service Desk Customer - Portal Access&lt;br&gt;• Project Role (Service Desk Team)&lt;br&gt;• Project Role (Administrators)</td>
</tr>
<tr>
<td><strong>Assignable User</strong></td>
<td>Permission to be assigned issues. (Note that this does not include the ability to assign issues; see Assign Issue permission).</td>
</tr>
<tr>
<td></td>
<td>• Project Role (Service Desk Team)&lt;br&gt;• Project Role (Administrators)</td>
</tr>
<tr>
<td><strong>Resolve Issues</strong></td>
<td>Permission to resolve and reopen issues. This also includes the ability to set the 'Fix For version' field for issues. Also see the Close Issues permission.</td>
</tr>
<tr>
<td></td>
<td>• Service Desk Customer - Portal Access&lt;br&gt;• Project Role (Service Desk Team)&lt;br&gt;• Project Role (Administrators)</td>
</tr>
<tr>
<td>Permissions</td>
<td>Roles</td>
</tr>
<tr>
<td>-------------------------</td>
<td>-----------------------------------------------------------------------</td>
</tr>
<tr>
<td>Close Issues</td>
<td>• Service Desk Customer - Portal Access • Project Role (Service Desk Team) • Project Role (Administrators)</td>
</tr>
<tr>
<td>Modify Reporter</td>
<td>• Service Desk Customer - Portal Access • Project Role (Service Desk Team) • Project Role (Administrators)</td>
</tr>
<tr>
<td>Action</td>
<td>Permissions</td>
</tr>
<tr>
<td>-------------</td>
<td>-------------------------------------------------</td>
</tr>
<tr>
<td>Delete Issues</td>
<td>Permission to delete issues. Think carefully about which groups or project roles you assign this permission to; usually it will only be given to administrators. Note that deleting an issue will delete all of its comments and attachments, even if the user does not have the Delete Comments or Delete Attachments permissions. However, the Delete Issues permission does not include the ability to delete individual comments or attachments.</td>
</tr>
<tr>
<td>Link Issues</td>
<td>Permission to link issues together. (Only relevant if Issue Linking is enabled).</td>
</tr>
</tbody>
</table>

- **Service Desk Customer - Portal Access**
- **Project Role (Service Desk Team)**
- **Project Role (Administrators)**
<table>
<thead>
<tr>
<th>Set Issue Security</th>
<th></th>
<th>Permission to set the security level on an issue to control who can access the issue. Only relevant if issue security has been enabled.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Voters &amp; Watchers Permissions</td>
<td>Users / Groups / Project Roles</td>
<td>Explanation</td>
</tr>
<tr>
<td>View Voters and Watchers</td>
<td></td>
<td>Permission to view the voter list and watcher list of an issue. Also, see the Manage Watcher List permission.</td>
</tr>
<tr>
<td>Manage Watcher List</td>
<td>Explanation</td>
<td></td>
</tr>
<tr>
<td>---------------------</td>
<td>-------------</td>
<td></td>
</tr>
<tr>
<td>Service Desk Customer - Portal Access</td>
<td>Permission to manage (i.e. view/add/remove users to/from) the watcher list of an issue.</td>
<td></td>
</tr>
<tr>
<td>Project Role (Service Desk Team)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Project Role (Administrators)</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Comments Permissions</th>
<th>Explanation</th>
</tr>
</thead>
<tbody>
<tr>
<td>Add Comments</td>
<td>Permission to add comments to issues. Note that this does not include the ability to edit or delete comments.</td>
</tr>
<tr>
<td>Service Desk Customer - Portal Access</td>
<td></td>
</tr>
<tr>
<td>Project Role (Service Desk Team)</td>
<td></td>
</tr>
<tr>
<td>Project Role (Administrators)</td>
<td></td>
</tr>
<tr>
<td>Edit All Comments</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>• Project Role (Service Desk Team)</td>
<td>Permission to edit any comments, regardless of who added them.</td>
</tr>
<tr>
<td>• Project Role (Administrators)</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Edit Own Comments</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>• Service Desk Customer - Portal Access</td>
<td>Permission to edit comments that were added by the user.</td>
</tr>
<tr>
<td>• Project Role (Service Desk Team)</td>
<td></td>
</tr>
<tr>
<td>• Project Role (Administrators)</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Delete All Comments</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>• Project Role (Service Desk Team)</td>
<td>Permission to delete any comments, regardless of who added them.</td>
</tr>
<tr>
<td>• Project Role (Administrators)</td>
<td></td>
</tr>
</tbody>
</table>
| Delete Own Comments | Service Desk Customer - Portal Access  
|                     | Project Role (Service Desk Team)  
|                     | Project Role (Administrators) | Permission to delete comments that were added by the user. |

<table>
<thead>
<tr>
<th>Attachments Permissions</th>
<th>Users / Groups / Project Roles</th>
<th>Explanation</th>
</tr>
</thead>
</table>
| Create Attachments      | Service Desk Customer - Portal Access  
|                        | Project Role (Service Desk Team)  
|                        | Project Role (Administrators) | Permission to attach files to an issue. (Only relevant if attachments are enabled). Note that this does not include the ability to delete attachments. |
| Delete All Attachments | • Project Role (Service Desk Team)  
|                        | • Project Role (Administrators)  
|                         | Permission to delete any attachments, regardless of who added them. |
| Delete Own Attachments  | • Service Desk Customer - Portal Access  
|                        | • Project Role (Service Desk Team)  
|                        | • Project Role (Administrators)  
|                         | Permission to delete attachments that were added by the user. |
| Time Tracking Permissions | Users / Groups / Project Roles | Explanation |
| Work On Issues         | • Project Role (Service Desk Team)  
|                        | • Project Role (Administrators)  
<p>|                         | Permission to log work against an issue, i.e. create a worklog entry. (Only relevant if Time Tracking is enabled). |</p>
<table>
<thead>
<tr>
<th><strong>Edit Own Worklogs</strong></th>
<th>Permission to edit worklog entries that were added by the user. (Only relevant if Time Tracking is enabled). Also, see the Work On Issues permission.</th>
</tr>
</thead>
</table>
| • Project Role (Service Desk Team)  
• Project Role (Administrators) |                                                                                                                                                                                                |
<table>
<thead>
<tr>
<th><strong>Edit All Worklogs</strong></th>
<th>Permission to edit any worklog entries, regardless of who added them. (Only relevant if Time Tracking is enabled). Also, see the Work On Issues permission.</th>
</tr>
</thead>
<tbody>
<tr>
<td>• Project Role (Administrators)</td>
<td></td>
</tr>
<tr>
<td><strong>Delete Own Worklogs</strong></td>
<td>Permission to delete worklog entries that were added by the user. (Only relevant if Time Tracking is enabled). Also, see the Work On Issues permission.</td>
</tr>
<tr>
<td>-----------------------</td>
<td>--------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
</tbody>
</table>
| • Project Role (Service Desk Team)  
• Project Role (Administrators) |                                                                                                                                                                                                |
<table>
<thead>
<tr>
<th><strong>Delete All Worklogs</strong></th>
<th>Permission to delete any worklog entries, regardless of who added them. (Only relevant if Time Tracking is enabled). Also, see the Work On Issues permission.</th>
</tr>
</thead>
<tbody>
<tr>
<td>• Project Role (Administrators)</td>
<td></td>
</tr>
</tbody>
</table>

**Using custom permission schemes**

If you are a service desk administrator and you want to customize the standard permission scheme, make sure that the roles have the mandatory permissions. See [Customizing Jira Service Management permissions](#).

**Resolving permission scheme errors**

If you encounter any error messages related to your service desk's permission scheme, check out [Resolving Jira Service Management permission errors](#).
Getting started with Jira Service Management

Learn about Jira Service Management’s different user types and roles, get a brief introduction to how your customers raise requests, and learn what those requests look like for agents. When you’re ready, pick a tutorial and learn how to make your service desk work better for your team and your customers.

User types and roles

Licensed users manage customer requests in your instance of Jira Service Management. These are most likely your project administrators, service desk team members, employees and even contractors. They track and resolve your customers’ requests, transition issues through workflows, and contribute to their team’s service level agreements (SLAs).

Unlicensed users raise requests and interact with service desk agents for free. These are your customers. They submit requests via your service project’s customer portal or email address, comment on requests, and read knowledge base articles. Customers do not require a license, so you can have an unlimited number of customers who can submit an unlimited number of requests, free of charge.

Most of the information in these documents focuses on two licensed roles: administrators and agents. The administrator sets up and configures service projects. The agent works in these projects.

Admins

Project administrators for your service project can:

- Access all features in Jira Service Management
- Manage users and roles in service projects
- Set up customer portals, request types, queues, reports and SLAs
- Perform all tasks that agents can

Agents

Service project team members who work on customer requests can:

- View the customer portal, queues, reports and SLA metrics for a project
- Add, edit, and delete customer-facing and internal comments on issues
- Add customers to a project
- Read knowledge base content
- Manage organizations (if allowed at the application level)
- Create knowledge base content (with a Confluence license)

Customers

The people you serve through your service project can:

- Raise requests via the customer portal or email channel
- Track their requests in the customer portal
- Comment on their requests
- Read knowledge base articles
- Approve other customers’ requests
- Share requests with other customers (if allowed by Customer permissions)

All this is free for your customers.

How a service project works (in 4 simple steps)

Here’s how your customers and service project agents work together to resolve a request:
1. Your customer submits a request to your service agents through a portal or via email.

2. A service project agent sees the request in their Jira Service Management queue and looks into the issue.

3. Your customer and other participants use the portal or email to discuss the request with your service project agent, who works in Jira Service Management.

4. Your agent completes the request and your customer is satisfied!

"Requests" vs. "issues"

Your customers submit a request through the customer portal or by email. These requests become issues that your agents work on in their agent view.

How customers see their requests in the customer portal:

How agents see those corresponding issues:
Ready to get started?

Choose your Jira Service Management tutorial:

I am an admin  I am an agent
Getting started for service project admins

Welcome to Jira Service Management for admins! In this tutorial, we'll introduce you to your workspace and walk you through the process of setting up a service project for your team of agents and a corresponding customer-facing site (which we call the customer portal).

We'll be focusing on basic Jira Service Management features and tasks to help you get up and running quickly. By the end of this tutorial, you will have:

- Set up 1 service project
- Added 3 agents
- Prepared your customer portal to receive customer requests

Let's take a quick look at Jira Service Management...

Queues

As an admin, you will set up and configure queues for your agents. Your agents will then view and work on issues from the same tab:

![Queues Image]

Reports

Use the Reports tab to view your team's workload. You can also set up custom reports to track your team's progress in more detail:

![Reports Image]
Project settings

Here, you will set up request types, brand your customer portal, link your service project to an email account, and manage users:

Customer portal

This link lets you navigate the customer view of your service project:

Now that you’re familiar with your service project workspace, you can set up your own Jira Service Management site and add your first project.

Let’s go!
Setting up your service project

1. Setting up your service project
2. Creating service project request types
3. Making queues for your service project teams
4. Adding service project agents
5. Customize your service project channels
6. Bring your service project to the next level
7. Introduce customers to your service project
8. Explore a sample project

You'll need a working Jira Service Management instance to complete this tutorial, and we have installation instructions for both Windows and Linux operating systems.

- Windows installation instructions
- Linux installation instructions

If you have an existing Jira Service Management site, skip ahead to create a service project. If your administrator has set you up as a project admin for an existing project, jump to Step 2 to create your request types.

Create a project

Jira Service Management comes with default project templates that you can use to suit your team's needs. There are three templates you can choose from:

- The Basic Service Desk template is set up for internal business teams, like HR, finance, or small IT teams. The template comes with just a few recommended request forms and is easy to customize and expand with your needs.
- We recommend the IT Service Desk template for IT teams who maintain a more complex infrastructure. The template comes with ITIL-inspired workflows for change, incident, and problem management.
- If you help external customers and want to collect bug reports or take suggestions for new feature, we recommend the Customer Service desk template. The template comes ready for your customers to request technical or billing help, and report issues.
For now, let's get you set up with a basic service project.

1. If you're working with an existing Jira Service Management instance, select **Projects > Create Project** from the top navigation bar of your instance. If you've just installed and set up Jira Service Management, you'll have the option to Create a new project by selecting **Create new project**.
2. Select "**Basic Service Desk**" as the project type.
3. Name your project. In this example, we'll use the project name "Charlie Travel Franchises". The project key should be automatically populated, but you can change the key if you'd like. If you see options to link another application, leave these options unchecked.
4. Select **Submit** to create your project.

Nice work! You now have a service management site with one project. You will now learn to set up request types, which define the requests customers can submit to your team's service project.
Creating service project request types

1. Setting up your service project
2. Creating service project request types
3. Making queues for your service project teams
4. Adding service project agents
5. Customize your service project channels
6. Bring your service project to the next level
7. Introduce customers to your service project
8. Explore a sample project

Request types let you define and organize incoming issues so your service project team can more efficiently help your customers. If you're moving from an existing help desk application, you can add your existing request categories during this step.

If you're setting up service project request types for the first time:

- Think about how your customer would write a request, for example 'Order a new monitor' over 'Submit a hardware request'.
- Break things down into smaller chunks, such as 'Get help with printers' or 'Get wi-fi access'.
- Avoid specialist terminology; think 'I need access' more than 'Deploy SSH key'.

By the end of this step, your project's request type page should look something like this:
Create new request types

Let's go ahead and add two new request types, so you can familiarize yourself with the request type configuration options.

1. In your new service project, select Project settings > Request types.
2. In the new request type form at the top of the page, change the request type icon and enter the following details for a new "Connect to wi-fi" request type.

Select Create request type when you've finished entering your request type details.

3. Create a second request type called "Order a monitor" with the following details:

Select Create request type when finished.

Edit the fields your customers see

Now that you have requests in the customer portal, you can prompt your customers to give you the information you need to help them quickly. These simplified fields help customers understand what information they need to provide when submitting a request.

Let's add some fields to your request types, so you can collect some additional information.

1. For the "Connect to wi-fi" request type, select Edit fields.
2. Under **Visible fields**, click the "Summary" display name and rename it to "What do you need?". Add some placeholder text to the **Field help** to gather useful details from your customers. For example:

   ![Visible fields table]

   Select **Update** when finished.

3. Select **Add a field** to add the "Priority" field to the request form and select **Apply**.

4. On the **Workflow Statuses** tab, you will see the default Jira workflow status names displayed on the left hand side. You can change how these statuses appear to customers by editing the **Status name to show customer** fields as shown:

   ![Workflow Statuses]

   Select **View this request form** to see how your changes appear in the customer portal.

5. **Organize your requests with groups**

   A group is simply a category you can assign to each request type. In the customer portal, your request types are organized vertically based on your groups.

   ![Request types]

   We think groups are helpful if you have **seven or more** request types.

   Go to **Project settings > Request types**. You should see your groups in the sidebar:

   Let's add a few groups to help your customers find the request they need:
1. To add request groups, select **Add group**. Add two groups for your new request types, "Hardware requests" and "Access".

2. When viewing your "Access" request group, select **Add existing request type** and choose your "Connect to wi-fi" request type:

3. Switch to your "Hardware requests" group in the sidebar.

4. Select **Add existing request type** and choose your "Order a monitor" request type.

5. Open the customer portal link from your project sidebar to see your requests organized into groups.

6. To rearrange the order of how your groups appear in the customer portal, go back to your project settings and drag and drop the groups in the request types sidebar.

Create a request from the customer portal

1. Keep the customer portal preview open, so you can create test requests from a customer's perspective.
2. Select the "Connect to wi-fi" request type.
3. Enter "Test wi-fi request" in the open field and select Medium priority.
4. Click **Create** to complete your request and view the open request in the customer portal.
5. Click **Close** to exit the customer view and return to your service desk project.

Excellent work! You now have four request types and a new issue in your project. Next, you will learn how to sort these issues into queues, which will allow you to manage your team's workload.
Making queues for your service project teams

1. Setting up your service project
2. Creating service project request types
3. Making queues for your service project teams
4. Adding service project agents
5. Customize your service project channels
6. Bring your service project to the next level
7. Introduce customers to your service project
8. Explore a sample project

Your teams will spend the majority of their time working out of the queues you set up. Agents do not have the permissions to add new queues or configure existing ones; however, Jira Service Management queues allow you to automatically triage and prioritize issues for them. If you want your team to focus on requests that must be completed by next week, for example, you can set up a queue that only contains requests with a set due date in that week.

Your site comes with preconfigured queues (for example, "Unassigned issues"), but let's go ahead and create three new queues for your team:

1. From your service project sidebar, select **Queues**.
2. Select **New queue** and name your first new queue "Service requests".
3. Define the issues you want to appear in this queue by selecting the following drop-down menus: Type (select "Service Request"); Status (select "Waiting for support"), and Resolutions (select "Unresolved").

4. Select the following column names that will display in this queue from the More menu: "Key", "Summary", "Created", "Updated", "Due Date". You can reorder the columns by dragging the name (for example, "Key") across the column field.

5. Select Create to add this queue to your team's workspace.

6. Create two new queues with the following two search queries: "Completed requests" for Service requests that have been successfully resolved.
"Due this week" for requests that must be completed in the next week

7. Reorder your saved queues by clicking and dragging them to their new location.

You now have three new queues in your project! You will next learn how to add agents to your siteso you can get your teams up and running with Jira Service Management.
Adding service project agents

1. Setting up your service project
2. Creating service project request types
3. Making queues for your service project teams
4. Adding service project agents
5. Customize your service project channels
6. Bring your service project to the next level
7. Introduce customers to your service project
8. Explore a sample project

There are two default project roles you can assign users to in Jira Service Management:

- Service Desk Customers who create requests via email or the customer portal
- Service Desk Team who view and respond to these requests

As the user who created this project, you have been automatically added to the Administrators project role.

Add your agents

Project administrators can add agents with existing user accounts to their project. If you are a project administrator, you will need to contact your site administrator to add user accounts for new agents. Make sure you’re signed in as an administrator for this step, you can invite three new agents to your project - Diane, Martin, and Waldo:

1. In your project sidebar, select Invite team.
2. Enter the email addresses for your new agents and select **Invite 3 people**.

![Invite team dialog box](image)

3. The agents are added to the Service Desk Team role in **Project settings > Users and roles**.

Assign issues to agents

Your agents will generally work out of queues that have issues automatically triaged into them. Let's test out manually assigning issues in case you ever come across a customer request that you want a certain agent or team to handle.

1. From the **Queues** tab, open one of your test requests by clicking the issue summary or issue key.
2. Select **Assign**.
3. Enter Waldo in the **Assignee** field and select **Assign**. When Waldo signs into Jira Service Management, this issue appears in his queue.
4. Assign another test issue to Diane.

Add your customers

You don't need to add customers to your service project during this tutorial, but let's check out where you would add them, so you're familiar with the steps:

1. From your project sidebar, select **Customers**.
2. Select **Add customers** in the top right corner and enter one or more email addresses.
3. When you select **Invite**, the customers receive an email invitation with a link to your customer portal, where they can complete the signup process.

You're almost done! You have now added 3 agents to your service project and reviewed the process of assigning issues to these agents. You can now customize your customer portal and share it with the rest of your team.
Customize your service project channels

1. Setting up your service project
2. Creating service project request types
3. Making queues for your service project teams
4. Adding service project agents
5. Customize your service project channels
6. Bring your service project to the next level
7. Introduce customers to your service project
8. Explore a sample project

Service project customers can send you requests in two ways:

- through an online portal
- to an email account you've linked to your service project.

Let's customize the portal and add an email account, so customers can get in touch.

Customize the help center

Your service project comes with an online help center for your customers. From the help center, customers can browse all the service projects they have access to.

It will look something like this:
1. Go to Jira administration > Applications > Jira Service Management > Configuration.
2. Below Help center, click the link View and customize.
3. In the customize panel on the right hand side, do any the following:
   - Add a help center announcement
   - Add an announcement to the login screen
   - Give your help center a name
   - Add a logo
   - Add a banner image or banner background color
   - Change the color of some components
4. Choose Save changes to publish your announcement.

To learn more about the help center check out Using the help center.

Customize the customer portal

Now that your help center looks inviting, you can customize the customer portal for each of your service desks. Add a name and logo to your customer portal so that people know they’re sending requests to the right team. The banner, links, and button colors are all inherited from the help center.

It will look something like this:

To customize your customer portal:

1. In your service project, go to Project settings > Portal settings.
2. Edit your customer portal name and intro text by typing in the fields.
3. Save any edits by clicking the tick icon in the field you’re editing.
4. Add a customer portal logo by selecting **Use a custom logo**.
5. Select **Save logo**, once you’ve uploaded your image.

To learn more about the customer portal check out [Configuring the customer portal](#).

**Link an email account**

Customers can also create requests and communicate with your team by email. If you haven’t already, create an email address that you’d like your team to be contacted on.

To link an email to your service desk project:

1. Go to **Project settings > Email requests**.
2. Select **Add email address** and fill in the details. If you use 2-step-verification for Gmail, generate an [application-specific password](#) when adding your email account details.

![Set up your email channel](#)

3. Once you’ve linked an email to your service project, we’ll send a test email to your inbox and create a test request in your service project.

To learn more linking an email to your service project, check out [Receiving requests by email](#).

- **If you use POP**, make sure the email account you choose for this channel has an **empty inbox** so you do not lose any existing emails.

**Tell customers about your service project**

Now that your service project is ready to receive requests, share the project’s email address (for example, [helpdesk@example.com](mailto:helpdesk@example.com)) with your customers or give them a direct link to the customer portal.

You can give either, or both, of the following URLs to your customers, depending on your setup:

- **URL to a customer portal** give this URL to your customers if you’ve enabled public signup and want them to sign up for accounts on their own.
- **URL to the help center** here they will see all the service projects they have access to. The URL is: [https://<computer_name_or_IP_address>:<HTTP_port_number>/Jira/servicedesk/customer/portals](https://<computer_name_or_IP_address>:<HTTP_port_number>/Jira/servicedesk/customer/portals)
Here are other ways that some customers promote their service project:

- post a link on the intranet or other communication channels
- email their customers to tell them there's a new way to get help
- put posters up in communal areas around the office.

You've now finished setting up your service project! Continue to learn more advanced tips on tracking your team's progress and supporting your customers.

Next
Bring your service project to the next level

1. Setting up your service project
2. Creating service project request types
3. Making queues for your service project teams
4. Adding service project agents
5. Customize your service project channels
6. Bring your service project to the next level
7. Introduce customers to your service project
8. Explore a sample project

Now that you have your basic service project up and running, you can learn about the following advanced features:

- Serve your customers and your team better with SLAs
- Track your team’s success with reports
- Solve requests faster with a knowledge base

Serve your customers and your team better with SLAs

Service-level agreements (SLAs) help you communicate service agreements to your customers and keep track of your team’s performance. An SLA consists of a time metric and a corresponding goal or target.

As the administrator, you can configure each SLA metric and goal using the Jira Service Management SLA designer. SLA information will appear in the internal issue and your agents can also view SLA goals by going to Reports > Workload when they log in to your service desk project.

Let’s have a quick look at where you can create a new SLA metric:

1. In your service project, select Project settings > SLAs.
2. Select Create SLA to create a new SLA metric for your service desk project.
3. For more information, check out Setting up service level agreements (SLAs).

Track your team’s success with reports
Jira Service Management lets you display selected SLA metrics and goals in interactive reports. Reports can be used to help you visualize your team's performance so you can identify bottlenecks and optimize your team's workload. Your team of agents can then view the read-only versions of your reports to see how they are tracking towards their goals.

Let's now have a quick look at the **Reports** tab:

1. From your service project sidebar, select **Reports** to view the pre-configured reports in your project.
2. Select **+New Report** to create a new report, or simply edit one of the pre-configured reports.
3. For more information, check out [Setting up service project reports](#).

### Solve requests faster with a knowledge base

You can deflect common requests and solve issues faster by linking a Confluence knowledge base to your service project. When you link a knowledge base to your project, customers can search for solutions in the portal and help center before they raise a request:

![Knowledge base](image)

A knowledge base helps agents, too. When they work on issues, they can see related knowledge, search for solutions, and create new articles from issues:

![Knowledge base in Jira](image)

Customers can use the articles to self-service problems, and agents can use them to solve requests faster. Everybody wins.

To learn more about linking a knowledge base to your service project, see [Set up a knowledge base for self-service](#).

You're almost done! We'll now review the ways customers can contact your team and be informed of updates to their requests.

Next
Introduce customers to your service project

1. Setting up your service project
2. Creating service project request types
3. Making queues for your service project teams
4. Adding service project agents
5. Customize your service project channels
6. Bring your service project to the next level
7. Introduce customers to your service project
8. Explore a sample project

Now that you have set up your project in a way that serves both your agents and your customers, it’s time to show your customers how to start using Jira Service Management.

Create requests through the customer portal

1. Visit the customer portal.
2. Pick an option that matches what you need and fill in the details of the request.
Create requests by email

Another way of creating requests is by sending emails to a linked service project. Ask your service team if they are set up to receive email in their service project. If they are, simply email them a request directly and keep the conversation going from your inbox.

Create requests in multiple service projects

To send the same request to multiple teams, you have the following options:

- If all of the teams you want to contact have linked their service project to an email account, you can easily create the request by sending one email message to all linked service project email accounts.
- If the teams you want to contact have not all linked their service project to an email account, you will need to create the request in each service project one by one, either through their customer portal or sending emails.

Track and comment on requests

Use the customer portal to see all requests you have created, read comments from agents as they are updated, and check the status of a request. You can add comments and attachments to requests on the customer portal as well.

Another way of tracking requests is through email notifications. You receive email notifications when agents respond to your requests and when the request has been resolved. To add comments to requests, you can simply reply to the email notifications and your reply will be added as a comment to the request.

Congrats! You’ve completed the Getting started for service project admins tutorial.

Want to learn more? Check out the home of Jira Service Management documentation here.
Explore a sample project

Jira Service Management comes with sample data to help you explore and learn how to use key features.

When you create a sample project, it gets populated with issues that new team members can use to learn about concepts like queues, SLAs, and generate reports like the one below without fear of affecting any real work.

If you are a Jira Service Management administrator, we suggest you create and explore a sample project to help you and any new team members explore how a service desk project works.

Create a sample project

You need to be a Jira Service Management administrator.

1. Go to Project -> Create project.
2. In the Create project screen, click Create sample data.
3. In the Create project with sample data screen, select IT Service Desk and click Next.
4. Enter a name for the sample project.
   Tip: If you are creating the project for a specific user, name the project "Sample - [name user]". This will make it easier to find and delete later.
5. Click Submit.

Sample project access Depending on how user access is set up in your Jira Service Management version, you may need to give new users access to the project as well.

Learn about key features

Here are a list of tasks that we highly recommend you have a go at:
Explore the customer portal and see what your customers see
Create a new request and assign it to yourself
View the queue, edit an issue description, or add a label
Comment on an issue
Try out your email channel
Play with reports

Get on board your new service desk

- Be awesome
- Learn the key concepts of Jira Service Desk
- Create a request in the customer portal
- View issues in queues, where customer requests live
- See what you can do as a service desk admin

Check out tutorials and best practices in the documentation

Finished playing with your sample project?
When a sample project has served its purpose, delete it from the project directory. You need to be a Jira Service Management administrator to do this.
Getting started for service project agents

On this page, we introduce you to your workspace and walk you through the process of responding to your customers’ requests.

On this page
- Navigate your workspace
- Work on customer issues
- View and create knowledge

Navigate your workspace

Use the Jira Service Management sidebar to navigate your workspace:

1. Queues: view issues that customers have submitted to your service desk.
2. Customers: view your customers and requests, and invite new customers to the service project.
3. Reports: view reports about your team’s SLA goals, knowledge base and workload.
4. Raise a request: raise a request on behalf of a customer.
5. Knowledge base: search your team’s knowledge base or create an article.
6. Customer channels: view your service project’s customer portal and email address.
7. Invite team: invite an existing agent to work on your project.

Work on customer issues

When customers submit requests to your service project, the issues are grouped into queues on the Queues page.

Select an issue’s Summary or Key to view more information about an issue, or start working on an issue. The issue view looks like this:
From here, you can work with customers and your team to resolve requests. If your service project is linked to a knowledge base, you can also view, share, and create knowledge from the issue.

Comment on an issue

When you select **Respond to customer**, add an attachment, or comment on an issue, you can share your response with the customer, or comment internally.

- If you share with the customer, the customer is notified and can see the comment or attachment when they view the request in the customer portal.
- If you make an internal comment, the customer isn't notified and can't view the comment or attachment on the customer portal. People who are watching the issue are notified, and your team can see the comment when they view the issue in your service project.

React to a comment

You need a Data Center license to use comment reactions.

Add a comment reaction

You can use comment reactions in the issue view instead of replying to a comment.

To add a reaction to a comment:

1. Go to your issues comment section.
2. Select the **add emoji icon 😊**.
3. Select the relevant reaction.
Your customers can react to comments with emojis, too. As the customer portal comment reactions are disabled by default, you first need to allow their use.

To enable comment reactions:

1. Go to Project settings > Portal settings.
2. Go to the Comment reactions section.
3. Select Allow comment reactions on the customer portal for this project.

You can fully disable comment reactions via the global system settings.

Collaborate on an issue

You might want to share the issue with other customers who have a similar problem, or with other people on your team who can help you resolve the issue. Here are some ways you can involve other people in the issue:

- Select Share to email a link to the issue to other people on your team.
- Use @mentions (@username) to mention a team member in a comment.
- Add watchers to involve other users from your Jira site. Someone leaves an internal comment or transitions an issue.
- Add request participants to share the issue with other customers or organizations. Request participants receive the same notifications as the reporter.

View and create knowledge

If your service project has a linked knowledge base, you can use knowledge articles to solve issues faster:

For example, if you get a lot of requests about printing problems, you can write a step-by-step article that helps customers troubleshoot the problem themselves:

- When customers search for help from the customer portal, they can use articles to solve problems instead of raising requests.
- When you work on an issue, you can share the article with customers so they can try to troubleshoot on their own.

You can also write internal articles and reference them while you work on an issue. Articles that the reporter can't view are marked with a red padlock.

When you create a new article from an issue, you can choose a handy how-to or troubleshooting template to guide you. The issue summary and description become the article's title and body text.

Nice work! Want to learn more? Proceed to Working on service projects to learn more about what a service project agent can do.
Administering service projects

Welcome to the source of truth for Jira Service Management administrator knowledge and power.

This section is for Jira Service Management project administrators. You’re in the right place if you’re the one who adds agents and sets up your service project. If you’re new to Jira Service Management, check out our getting started guides.

Get started

Here are some pages to get you started:

- Managing access to your service project
- Configuring the customer portal
- Receiving requests by email
- Setting up service project users
- Setting up queues for your team
- Automating your service project
- Managing service project notifications
- Setting up request types
- Setting up SLAs
- Setting up approvals
- Setting up service project reports
- Default service project configuration
- Using Jira applications with Confluence
Managing access to your service project

Go to Project settings > Customer permissions to choose who can raise requests in your service desk and who your customers can share requests with.

On this page:
- Choose who can raise requests
- Choose who customers can share requests with
- Choose whether customers can vote for requests
- Which settings are best for my team?
- Security advice: Choosing who can raise requests

Choose who can raise requests

People need to be customers to raise requests in your service desk. You can let your team control who becomes a customer, or let customers create their own accounts in your service desk.

<table>
<thead>
<tr>
<th>Who can raise requests</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Customers who are added to the project</td>
<td>Your team adds customers to the project via the Customers page, or by raising requests on their behalf.</td>
</tr>
<tr>
<td>Customers who have an account on this Jira site</td>
<td>People with accounts on your Jira site are automatically added to the Customers list and can raise requests.</td>
</tr>
</tbody>
</table>
| Anyone can email the service project or raise a request in the portal | - New customers can create their own accounts in your service desk via the customer portal.  
- Raising an email request automatically creates an account for the sender.  
- If you allow customers to share requests, then people they share with also become customers and can raise requests.  
- A honeypot technique is enabled to help prevent spambots from creating accounts through the customer portal.  
- If login-free portal has been enabled by your Jira administrator, and this option is selected, anyone will be able to access your portal and raise requests without logging in. Learn more about login-free portal |

If this option is disabled, then your Jira administrator has not turned on public signup for service desks on this Jira site. Learn more about enabling public signup

⚠️ When you choose this option, you have no control over who can create an account and raise requests. We strongly recommend that you use the Customers who have an account on this Jira site option instead, unless the requirement for a Jira account won't work for your use case.

Read more in our security advice

Choose who customers can share requests with

You can allow customers to share requests with their organizations, anyone in the service desk, or people who aren't customers yet. The people customers share with become participants in the request. Request participants can comment on and share requests, and receive the same notifications from Jira Service Desk as the reporter. Learn more about request participants
The following table describes the ways customers can share requests:

<table>
<thead>
<tr>
<th>Who customers can share with</th>
<th>Description</th>
</tr>
</thead>
</table>
| Other customers in their organization | - Customers can share requests with their organization, or raise a private request.  
- Customers can search their organization for people to share with:  

![Share this request](image)

- Customers who aren't in an organization can't share requests. |

| Any customer, by typing an email address | Customers can share requests with other customers in their organization (like in the option above), and also:  
- Share requests with anyone in the service project, if they know their email address  
- If anyone can email the service project or raise a request in the portal, then customers can also share requests with people who aren't customers yet. They can provide email addresses of these people and Jira will create accounts for them. Such unregistered email addresses can only be entered in the **Share this request** field but not a regular user picker field. |

| Any customer or organization, by searching in this project | Customers can share their requests with anyone in the project. They can also search the service project for people to share with.  
- If anyone can email the service project or raise a request in the portal, then customers can also share requests with people who aren't customers yet. They can provide email addresses of these people and Jira will create accounts for them. Such unregistered email addresses can only be entered in the **Share this request** field but not a regular user picker field.  

![](image)

If your service project uses user picker custom fields, such as the **Approvers** field, choose this setting to make sure customers can select users. |

Choose whether customers can vote for requests

You can allow customers to vote for requests directly in the customer portal. This lets them cast their votes for requests they'd like to see done without having user accounts on your Jira instance.

To enable voting in the portal, you need to have global voting enabled for your Jira instance.
The following table describes different options for this setting:

<table>
<thead>
<tr>
<th>Can customers vote in the portal?</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Yes, any customer with portal access can vote directly in the portal</td>
<td>Customers will see an extra option to vote when they view a request in the portal. They can then add their vote or remove it.</td>
</tr>
<tr>
<td>No, customers can't vote directly in the portal</td>
<td>If the global voting is enabled, users with accounts on your Jira instance will still be able to vote, but your agents will have prioritized votes.</td>
</tr>
</tbody>
</table>

Which settings are best for my team?

Not sure how to set up permissions for your team? Here are some suggestions for how to make customer permissions work for you:

- If you want to allow customers to vote directly in the portal, select the option where they can see an extra option to vote. This will give customers the ability to express their preferences directly, which can be helpful for gathering feedback.

- If you want to limit voting to your agents, select the option where customers can't vote directly in the portal. This will ensure that your team has control over the voting process and can prioritize requests accordingly.
If you're like this | Who can raise requests | Who customers can share with | Can customers vote?
---|---|---|---
You have a service project that handles contractors' leave requests. Only contractors can use the service project, and you don't want non-contractors to get confused about where to request leave. | Customers who are added to the project | Other customers in their organization | No, as contractors probably don't need to vote for their leave requests.
Your company has an IT service desk, and you want all employees to be able to create their own accounts and email requests. | Customers who have an account on this Jira site | Any customer or organization, by searching in this project | No, if your team is mostly handling requests for individual employees, such as "I need a new monitor". Yes, if your team is handling requests for general improvements. For example, employees could vote for what they'd like to be added to their office.
Your team provides software support for individuals. For example, if your company makes a free SAAS application that individuals use to manage finances, you can let your customers email bugs and questions to your service project email channel. | Anyone can email the service project or raise a request in the portal | Any customer, by typing an email address | Yes, it might be useful for individuals to vote for bugs or requests they'd like to see fixed first.

Security advice: Choosing who can raise requests

This is security advice regarding the option Who can raise requests.

When allowing anyone to create and raise requests, we strongly recommend that you use a separate domain for your incoming email account and configure this account to filter against automatic emails by blocking the addresses with a local-part, such as no-reply, support, servicedesk, and so on.

Reason

Configuring your Jira Service Management instance using an incoming email address with a domain at your company level can result in bad actors abusing the system to gain access to restricted services.

Example

For example, assume that your domain is http://mycompany.com, and you have set up a customer portal with an incoming email support@mycompany.com, allowing anyone to create and raise requests. Now, lets say a bad actor is trying to gain access to teamsinspace.com for which your company already has an account (e.g. admin@mycompany.com).

If the bad actor creates a new ticket in your customer portal and adds no-reply@teamsinspace.com as a participant, they can now go to teamsinspace.com and open an account for support@mycompany.com and provide a team name including the ticket number. Since teamsinspace.com includes the team name in their confirmation emails (and other websites might include other details), such an email will be sent to your incoming email address in Jira Service Management, and added as a comment to the ticket. By clicking on the confirmation email, the bad actor could open an account on teamsinspace.com on behalf of your company.

Mitigating this issue
Using a separate domain or sub-domain dedicated for your customer portal will help prevent this as long as you make sure to not sign up to services using that domain. What's more, adding filters against automatic emails (e.g. no-reply) at the incoming email account level will further help mitigate the issue because no-reply emails will be blocked.
Configuring the customer portal

Every service project comes with an online portal that your customers use to interact with your service team.

If you link your project to a Confluence knowledge base space, customers can troubleshoot by searching for relevant articles.

To access your customer portal, select Customer channels in the project sidebar, then the link Visit the portal.

On this page:

- Brand your customer portal
- Set up request types
- Add transitions
- Manage access to your portal
- Choose whether you need search
- Enable comment reactions
- View all customer portals in your help center
  - Share the help center
Brand your customer portal

As a project admin, you can change the following components on the customer portal:

- name
- welcome message
- logo
- announcement.

The banner, links, and button colors are all inherited from the help center. Learn more at Using the help center.

To brand the customer portal:

1. Go to Project settings > Portal settings and change the messaging and logo. Your logo will appear in notifications sent by your service project.
2. Select the link View and change under the Announcement heading, to add important information (for example, working hours).
Set up request types

You can customize the types of requests that customers raise from the portal. To create and manage request types, visit **Project settings > Request types**.

Jira Service Management includes several request types that address common IT help scenarios. The request types are organized into groups to help customers find what they need. For example, you can add a 'Common requests' group to help customers address issues like IT support.

To learn more about customizing request types, check out **Setting up request types**.

Add transitions

You can show transitions on the customer portal so that customers can change the status of their request.

For example, say an agent shares a knowledge base article with a customer and the article solves their problem. The customer can mark their request as resolved, directly from the customer portal.

To add a transition to the portal:

1. In your service project, go to **Project settings > Workflows**.
2. Select the pencil icon beside the workflow that has the transition you want to add to the portal.
3. Select **Diagram** to open the diagram view.
4. Select the transition in the workflow, and check the box beside **Show transition on the customer portal**.
Customer transitions behave slightly differently than other workflow transitions:

- Screens don't display on the customer portal. When you add a transition to the portal, you can set a resolution for requests that customers transition.
- When an issue is transitioned from the portal, it bypasses any validators that are defined for the transition.

To learn more about workflows and transitions check out Advanced workflow configuration.

If it seems like the portal transition isn't working, check if there's an automation rule in conflict with the transition. To learn more about automation rules, check out Automating your service project.

Manage access to your portal

You can allow anyone to sign up for an account to your portal, or only allow customers you've added.

If a Jira administrator has configured the login-free portal setting across your Jira Service Management instance, this may mean anyone can access your portal and raise requests without logging in. To learn more about different access options, check out Managing access to your service project.

Choose whether you need search

If you don't have a Confluence knowledge base linked to your project, it might be a good idea to disable the search bar on your customer portal, just to not confuse your customers. This option is often used when you want to give your portals more simplicity and space.

To disable the portal search:

1. Open your project.
2. Go to Project settings > Portal settings.
3. In the Search section, disable the search bar.

Good to know

- Well only disable search for your specific portal, but well keep it on the help center.
Enable comment reactions

Your customers can react to comments with emojis. As the customer portal comment reactions are disabled by default, you first need to allow their use.

To enable comment reactions:

1. Go to **Project settings > Portal settings**.
2. Go to the **Comment reactions** section.
3. Select **Allow comment reactions on the customer portal for this project**.

View all customer portals in your help center

The help center shows all of the customer portals in your Jira Service Management instance. From here, customers can raise requests in any of the portals they have access to. They can also view all the requests they’ve raised, via the **Request** button in the top-right corner of the screen.

Check out **View requests in the help center** to learn how this works.

Share the help center

To share the help center with your customers, send them the following link:

http://<computer_name_or_IP_address>:<http_port_number>/jira/servicedesk/customer/portals

If you add a customer to a service project, they’ll have an account in the help center.
Receiving requests by email

If your customers prefer to raise requests from the comfort of their email inbox, you can set up an email address to receive requests in your service project. Every channel you create can be used to receive different request types. Emailed requests are added to your queues so your team can focus on customers without worrying about missing requests or handling multiple inboxes.

You need a Data Center license to create multiple email channels for a service project.

Before you begin:

- Make sure you’re a Jira administrator and read Managing the email channel to learn more about global mail settings.
- Enable public signup, or add customers to your service project to ensure that you receive new requests.
- Set up a suitable request type with Summary and Description as required, visible fields. Any other fields must be optional.
- Learn which emails from your mail client will be processed.
- If you want to set a Google or Microsoft email address for your project, you need to first create an OAuth 2.0 integration. This is necessary as Google and Microsoft disabled basic authentication (user and password). For more info, see Configure an outgoing link.
- If you want to set a Microsoft GCC email address for your project, you need to select the Other email service provider type.

If you encounter any issues during the email setup process, check out some common errors and resolutions.

Customer requests and comments are processed differently than Jira mail. Issues created via Jira email handlers don’t show up as service project customer requests. For this reason, we don’t recommend using a Jira mail handler for service projects. Read Creating issues and comments from email for more information.

How your customers send requests by email

How receiving requests by email works:

1. A customer emails a request to an email address assigned to your service project. The request becomes an issue in your service project and is added to a queue based on the request type.
2. An agent comments on the issue.
3. The customer receives an email notification that contains the agent's comment.
4. The customer replies to the email notification and the reply is added as a comment on the issue in the service project.

Add an email channel

In Jira Service Management Server, you can add one linked email account to each service desk project.

Before you begin:

With Google and Microsoft deprecating basic authentication, you need to configure an OAuth 2.0 integration if you’re using one of these email providers. The outgoing OAuth 2.0 link can be configured once by a Jira system admin, and then selected as an authentication method in your projects. For more info, see Configure an outgoing link.
If you want to use the Microsoft Graph API protocol for your email channel, follow the steps in Setting up an email channel with the Microsoft Graph API protocol.

To add a new email:

1. From your service project, select **Project settings > Email requests**.
2. Select **Add an email address**.
3. If you're using Google or Microsoft as email providers, set the authentication method to the OAuth 2.0 integration configured in your Jira instance. You should see available OAuth 2.0 integrations in the dropdown list.

   When adding an email channel, you need to be able to authenticate to the email service provider used in your OAuth 2.0 integration.

4. Select a suitable request type for this channel.
5. Optionally, specify the name of the folder where emails are received. The default value is inbox. Note: this value might be case-sensitive, depending on your email provider.
6. Select **Save**. You'll be redirected to your email account.
7. Once authorized, you will see a success message about the channel being enabled. Your customers should now be able to create their requests via email.

    **Good to know**

    - If your Gmail or Yahoo! account uses two-step verification, you'll need to set up an [application-specific password](https://support.google.com/mail/article/7009554).
    - If you use more than one email address to interact with your customers, you might be able to set up forwarding rules or aliases to receive requests in the email linked to your service desk project. You will need to configure any forwarding rules or aliases in your email clients.

Verify your linked email channel

Once you've created a new email channel for a suitable request type, Jira Service Management sends a test email and creates a corresponding test request.

To verify your email:

1. From your service project, go to **Queues**.
2. Verify that your linked email channel works by finding the test request.

New messages sent to your linked email channel appear as service requests in your project.

Set up permissions so customers can send email requests

Before you share an email address with your customers, check your customer permissions.

- If **anyone can email your service** project, then your email address is ready to be shared. People who email your service project automatically become customers.
- If customers have to be manually added to your project, make sure your team creates new customer accounts for them. Otherwise, the customers' requests won't be processed.
How different types of emails are processed

Jira Service Management processes emails in different ways, depending on the protocol. See the option that applies to you:

**Emails using POP**

Jira Service Management looks for messages in your inbox that:

- have the `Deleted` flag set to false
- were received after your email account and service project were linked

To link your email account using POP with a service project, make sure that your email inbox is empty by moving existing messages to another folder, archiving, or deleting them. Starting with an empty inbox ensures that you do not lose emails unintentionally, as POP emails are deleted after they are processed by Jira Service Management.

**Emails using IMAP**

Jira Service Management looks for messages in your inbox that:

- have the `Deleted` and `Seen` flags set to false
- were received after your email account and service project were linked

If you use IMAP, emails are marked as read (not deleted) after they are processed by Jira Service Management. If you want existing messages to be pulled in by Jira Service Management, you can move them back to your inbox and mark them as unread after the connection has been established.
Managing the email channel

After you set up your email channel, you can change how emails are parsed, if customers are created directly from emails, or view logs and check the email connection for any email channel on the site.

Manage the email channel for multiple service projects

You must be a Jira administrator to manage the email channel.

To manage the email channel:

1. Select Administration > Applications.
2. Under Jira Service Management, select Email requests.
3. Change any (or all) of the following settings:
   - Strip quotes: choose whether emailed comments contain the entire email thread, or just the most recent reply.
   - HTML email parsing: choose whether HTML emails display in wiki markup or plain text.
   - Public email comments: choose whether replies are added as comments to existing requests.
   - Customer account creation: choose whether new customers are created from the address list of email messages.
   - View status and logs: view the status of each email channel on your service project's site, logs, or delete a channel. Information older than 6 months is deleted daily.
   - Email filters: choose whether you want to use the built-in email filters for auto-generated emails and bulk emails. If you notice that email requests from your customers arent processed and tickets arent being created, you can switch one, or both, of the filters off. Alternatively, you can also use the allowlist and blocklist to manage incoming email requests. Learn more about the allowlist and blocklist.

Manage global mail settings

There are two global mail settings email puller and email processor that are used by Jira Service Management only. They dont impact any other email settings you have set up for Jira.

To manage global mail settings:

1. Select Administration > System.
2. Under Mail, select Global mail settings.
3. Choose one of the following:
   - Email puller: connects to your mail servers every minute and pulls the email data into the database. Emails with attachments larger than 25MB are not be pulled.
   - Email processor: filters the emails (for example, to remove auto-replies and spam) using information stored in the database.

How to configure a mail server and mail handler

To learn how to configure Jira Service Management to receive and process emails, check out Creating issues and comments from email.
You must be a Jira administrator to do this.
Managing the allowlist and blocklist

You need a Data Center license to use this feature.

Depending on your settings, emails that customers send to your email channels can be filtered by Jira Service Management. If the filters detect auto-generated or bulk emails, those messages aren’t processed further and don’t reach your queue. To fine-tune the way these filters work in your instance, you can turn them on or off, or use the allowlist and the blocklist.

To make sure that emails received from specific domains are always processed, regardless of your filter settings, add the domains to your allowlist.

To avoid requests that you don’t want to see in your queue, add domains or email addresses to your blocklist.

The allowlist and blocklist are global lists that are used across all of your service projects.

For all of the following procedures, you must be logged in as a user with the Jira Administrators or Jira System Administrators global permission.

The allowlist and blocklist are only used for Jira Service Management email channels. If you also have Jira incoming emails configured, they’re not affected.

The settings in your service projects can also affect which email requests show up in your queue. Learn more about managing customer access to your service projects.

- Managing your allowlist
  - Add a domain to your allowlist
  - Edit a domain in your allowlist
  - Remove a domain from your allowlist
- Managing your blocklist
  - Add a domain or email address to your blocklist
  - Edit a domain or email address in your blocklist
  - Remove a domain or email address from your blocklist

Managing your allowlist

Add a domain to your allowlist

If you add a domain to your allowlist, requests sent from addresses that belong to that domain will always be processed by Jira Service Management. This means that all incoming emails will be ignored by the auto-generated email and bulk email filters and will be turned into issues.

Example: if you add atlassian.com to your allowlist, all requests coming from customers with an atlassian.com email address will become issues and will be added to your queues.
To add a domain to your allowlist:

1. Select Administration > Applications > Email requests > Allowlist.
2. Select Add domain.
3. Enter the domain and select Save.

- Currently, the allowlist only supports exact domain matching. For example, adding `example.com` will match `anyuser@example.com`. However, it won't match `anyuser@example.com.au` or `anyuser@mail.example.com`.
- The allowlist does not support individual email addresses, wildcards, or pattern matching.
- A domain can't exist in both the allowlist and in the blocklist at the same time.

### Edit a domain in your allowlist

To edit a domain that already exists in your allowlist:

1. Select Administration > Applications > Email requests > Allowlist.
2. Find the domain you want to edit.
4. Update the domain and select Save.

### Remove a domain from your allowlist

To remove a domain from your allowlist:

1. Select Administration > Applications > Email requests > Allowlist.
2. Find the domain you want to remove.
3. Select More > Remove.

### Managing your blocklist

#### Add a domain or email address to your blocklist
If you add a domain or an email address to your blocklist, messages that are sent from that domain or address will be ignored by Jira Service Management. This means that the emails won’t be processed and won’t show up in your queues.

**Example:** If you add `example.com` to your blocklist, all requests coming from customers with an `example.com` email domain will not be processed. If you add `user@example.com` to your blocklist, any requests that are sent from that email address will be ignored. However, emails from `anotheruser@example.com` or any other `example.com` email address will be processed by Jira Service Management.

To add a domain or an email address to your blocklist:

1. Select **Administration** > **Applications** > **Email requests** > **Blocklist**.
2. Select **Add domain or email address**.
3. Enter the domain or email address and select **Save**.

- The blocklist doesn't support wildcards, so if you want to add multiple domains or email addresses, add them individually.
- A domain can’t exist in both the allowlist and blocklist at the same time.

**Edit a domain or email address in your blocklist**

To edit a domain that already exists in your blocklist:

1. Select **Administration** > **Applications** > **Email requests** > **Blocklist**.
2. Find the domain you want to edit.
3. Select **More → Edit**.
4. Update the domain and select **Save**.

**Remove a domain or email address from your blocklist**

To remove a domain from your blocklist:
1. Select Administration > Applications > Email requests > Blocklist.
2. Find the domain you want to remove.
3. Select More > Remove.
Troubleshooting issues with the email channel

When setting up an email channel for your service project, you might run into some issues. If you're not receiving requests or if you're getting errors, start with checking the email connection. To see why a certain type of email isn't making it to your service project, you can review how your emails are processed.

Check your email connection

To troubleshoot email channel issues, the first thing to do is to check the connection between Jira Service Management and your email account. You will see error messages that show you why the email channel doesn't work for your service project.

To check your connection:

1. Select Administration > Applications.
2. Under Jira Service Management, select Email requests.
3. Select Test.

Check how you process email requests

Global mail settings control how your site processes requests that your customers send to your service project's email addresses. We process emails in three stages:

- **Email puller**: fetches unread emails from the service project's associated inbox every minute, and copies them to the email database. Emails with attachments larger than 25MB are not fetched.
- **Email processor**: filters pulled emails to remove things like auto-replies and spam.
- **Database cleaner**: deletes old emails from the database that are older than 45 days. You can change the purge to a range of intervals from 14 days to 180 days.

You can temporarily adjust these settings to troubleshoot your email channel.

To change global mail settings:

1. Select Administration > System.
2. Go to Mail > Global mail settings.

Common email channel errors

This section describes the common errors and provides information about how to resolve them.

**Setting up the email channel**

**Message:**

This authentication method is deprecated, you should use OAuth 2.0 instead.

**Resolution:**

You're trying to use an email account from Google or Microsoft with the basic authentication credentials user and password. Since basic authentication is being deprecated by Google and Microsoft, you need to switch to the OAuth 2.0 authentication method. OAuth 2.0 can be configured by your Jira system admin for the whole Jira instance and then used in your projects. Once it's configured, you can choose it as a method from the drop-down list instead of providing the credentials. Learn how to configure OAuth 2.0.

**Message:**

The email address you entered is currently used by another project's email channel. Please choose another email address. Check out our troubleshooting docs for help resolving the issue.
Resolution:

Make sure each of your service projects has a unique email account. An email account can't connect with multiple service projects.

You can also receive this message if you're trying to use multiple email aliases that point to the same email account for multiple service project email channels.

Requests aren't created or notifications received

Description:

Customers are emailing requests that aren't arriving in your queues. They also aren't receiving notifications.

Resolution:

1. Use the instructions above to check the email connection.
2. Verify that the customer has permission to email the service desk.
3. Verify that the default request type for the email channel has visible Summary and Description fields.
4. Verify that the Email puller is on in Global mail settings.

No suitable request type for the email channel

Message:

No suitable request type for the email channel

You will select the default request type assigned to requests created from the email channel during the setup. However no existing request types are suitable for email requests. A suitable request type must have both the Summary and Description fields as visible fields, and all the other visible fields, if any, must be optional. If you want to enable the email channel, add a new request type that meets the criteria or modify an existing one on the Request types page.

Resolution:

1. In your service project, select Project settings > Request types.
2. Add a new request type or choose an existing one.
3. Select Edit fields.
4. Make sure both the Summary and Description fields are added and marked as Visible. Add an Attachment field and mark it as not Required.
5. Select Save, then head back to Project settings > Email requests.

Archived messages are creating requests

Description:

When Jira Service Management checks your email accounts for new messages, it polls the inbox folder. Gmail uses labels to classify messages into categories and only has the following folders:

- Inbox
- Sent Mail
- Bin (or Trash)

This means that the archived messages are treated like they’re in the inbox folder. With POP3, Jira Service Management is not able to identify archived messages by labels and therefore still brings them in as requests.

Resolution:

Use IMAP instead.
Setting up a Gmail account

Message:
Unfortunately Jira couldn't connect to the mail server. Here is what the mail server said: "[ALERT] Please log in via your web browser: http://support.google.com/mail/accounts/bin/answer.py?answer=78754 (Failure)

Resolution:
Create an application-specific password for Jira Service Management in your Gmail account settings.

Setting up a Yahoo! account

Message:
Unfortunately Jira couldn't connect to the mail server. Here is what the mail server said: "[AUTHENTICATIONFAILED] (#MBR1240) Please verify your account by going to https://login.yahoo.com"

Resolution:
Create an application-specific password for Jira Service Management in your Yahoo! account settings.

Microsoft Outlook locks account for security

Message:
Unfortunately Jira Service Management couldn't connect to the mail server. Here is what the mail server said: "STAT command failed: Exceeded the login limit for a 15 minute period. Reduce the frequency of requests to the POP3 server.

Resolution:
Jira Service Management checks email accounts every minute. Microsoft Outlook might suspect inappropriate usage of this account and lock it for security reasons. To resolve this, use IMAP instead.

Jira doesn't trust the SSL certificate on the the mail server

Message:
Unfortunately JIRA couldn't connect to the mail server. Here is what the mail server said: "unable to find valid certification path to requested target"
Check out our troubleshooting docs for help resolving the issue.

Resolution:
Make sure that the SSL certificate chain from the mail server is imported into Jira's Java trust store. Follow the steps on https://confluence.atlassian.com/kb/unable-to-connect-to-ssl-services-due-to-pkix-path-building-failed-779355358.html.
Setting up an email channel with the Microsoft Graph API protocol

Your customers can send requests to your queues from the comfort of their own mailbox. To receive their emails and have them turned into requests in Jira Service Management, you need to set up an email channel. One of the protocols that you can choose from is Microsoft Graph API. To use this protocol, there are a few steps that you need to take.

In Jira Service Management 5.8, Microsoft Graph API can only be used for incoming email.

Since Microsoft Graph API is based on OAuth 2.0, before you start setting up the email channel, you need to configure your Azure Active Directory integration and add an application link in Jira Service Management. Learn how to configure OAuth 2.0 integration with Microsoft Azure.

To use Microsoft Graph API for incoming email, you need to add the Mail.Read and offline_access permissions to your API permissions in your Azure Active Directory app registry. You also need to add the following URLs to the Scopes section in the application link configuration in Jira:

https://graph.microsoft.com/Mail.Read

https://graph.microsoft.com/offline_access

To configure application links, you must be logged in as a user with the Jira Administrators or Jira System Administrators global permission.

API permissions in Microsoft Azure
Once your Azure Active Directory integration and Jira Service Management application link are ready, you can proceed to adding the email channel.

1. Go to **Project Settings > Email requests** and create a new channel.
2. Select **Microsoft** as the **Email service provider** and Microsoft Graph API as the **Email protocol**.
3. Enter your email address and select the application link you configured as the authentication method.
4. After you select Save, you’ll be redirected to the Microsoft authorization page. Log in and give Jira the required permissions. Once that’s done, you’ll be taken back to the Email requests page in your project settings.

Jira Service Management will test the connection with the newly created Microsoft Graph API email channel and pull the first emails. To see the status of this process, select Actions → View log next to the new email channel on the Email requests page in your project settings.

The status of a connection to an email channel in the connectivity log

Jira Service Management pulls unread emails from the mailbox once a minute. After a message is processed, its marked as read. This is done to distinguish between new and old messages. To see what has been processed in your email channel, select Actions → View log next to the channel on the Email requests page in your project settings.

The status of processed emails in the processing log
Setting up service project users

When you set up your service project, you add users to the project so that your team can start receiving and resolving requests. Your service project has the following users:

- **Project administrators** set up the service project and users.
- **Agents** work on customer requests and add customers to the project.
- **Customers** send requests to your service project.
- **Organizations** are groups of customers that are shared across projects.

By default, you need different permissions to manage different types of users in the project:

- **Jira administrators** can manage users and licenses across multiple projects.
- **Project administrators** can add agents from other projects. They can also manage customers and organizations.
- **Agents** can manage customers and organizations.

Add agents to a project

By default, project administrators can add agents from other projects to the project. Jira administrators can add anyone to the project.

To add agents:

1. From your service project, click **Add team** in the sidebar.
2. The agents are emailed a link to the service project and are added to the **Service Desk Team** project role.

View roles of team members

You must be a project administrator to view the roles of team members.

To view the roles of each team member:
1. From your service project, select **Project settings > Users and roles**.
2. Select the **Roles** dropdown, or search for the team member directly.

When a Jira administrator adds a new agent to the project, the agent is also assigned a Jira Service Management license and added to the **service-desk-users** license group.

To view what license or group a user belongs to:

1. Go to **Jira administration > User management**.
2. Search for and select a user to view their profile.

If your agents need to collaborate with Jira Core or Jira Software users to resolve an issue, you can grant the Jira users limited access to your service project. Learn more at [Involve Jira Software and Jira Core users](#).

### Remove agents from a project

You must be a project administrator to remove an agent from a project.

To remove an agent from a project:

1. From your service project, select **Project settings > Users and roles**.
2. Hover over the user or group you’d like to remove from the **Service Desk Team** project role, then click the trash can icon to the right.

### Unlicense agents

Jira administrators can remove an agent's license.

To unlicense an agent:

1. Go to **Jira administration > User management**.
2. Select the user.
3. Under the **Actions** column, choose **Edit user groups**, then remove them from the **Jira-service-desk-users** group.

### What is a customer?

Customers are people who can send requests to your service project via the portal or email. How people become customers depends on your project's customer permissions. To see your customers, go to **Customers** from your service project.

Customers are automatically added to the list if your project is open to users with Jira accounts, or allows customers to create their own accounts. Customers who do not have Jira accounts are added to the **Service Desk Customers** project role in **Project settings > Users and roles**. Customers are also granted restricted access to the Customer portal only (not Jira).

For more information about how people become customers, see [Managing access to your service project](#).

### Add a customer

Both agents and project administrators can add customers to projects.

To add customers:

1. From your service project, go to **Customers**.
2. Click **Add customers** to add customers to your projects.
Remove customers from a project

You must be a project administrator to remove customers from a project.

To remove a customer from a project:

1. From your service project, select Project settings > Users and roles.
2. Hover over the customer you would like to remove from the Service Desk Customers project role, then click the trash can icon to the right.

If the customers have Jira accounts or created their own accounts, then a Jira administrator needs to deactivate them.

To deactivate a user:

1. Go to Jira administration > User management.
2. Search for and select the user you want to deactivate.
3. Under the Actions column, select Edit.
4. Uncheck the box beside Active to deactivate the user.

What is an organization?

Organizations are groups of customers that can be used in multiple projects. When you add an organization to a project, its members can raise requests in the project and share them with the organization. They’re also notified about the organization's requests and can view and search them on the My Requests page in the portal. Learn more about how customers share requests with organizations.

By default, you need the Service Desk Team role for a project to manage organizations in it. However, a Jira admin can restrict organization management to Jira admins by turning off the Organization management setting:

1. Go to Jira administration > Applications.
3. Look for the Organization management heading.
4. Organizations are managed from a project's Customers list.

Add organizations

Organizations are groups of customers that can be used in multiple projects.

You must be a project administrator to add organizations to the project.

To add an organization:

1. From your service project, go to Customers.
2. Select Add organizations.
3. Add a new organization, or add an existing organization.

The organizations that you add display on the Customers list.

Add customers to an organization

Rather than add customers individually, you can group customers into organizations which can be part of multiple projects. Customers can then raise requests in all service projects they have access to.

You must be a project administrator to add customers to an organization.
To add customers to an organization:

1. From your service project, go to Customers.
2. Select the organization you want to add customers to.
3. Click Add customer.

If the customers are new to the Jira site they are given restricted access to the Customer portal only (not Jira). Also, customers are not added to the Service Desk Customers project role, because the organization can be used in multiple projects. However, they can still raise requests in all projects that use the organization.

Remove customers from an organization

Customers removed from organizations lose access to projects that use the organization, unless they have access through another organization, have the Service Desk Customers project role, or the project allows anyone to raise a request without logging in.

You must be a project administrator to remove customers from an organization.

To remove customers from an organization:

1. From your service project, go to Customers.
2. Select an organization in the Customers list.
3. Find the customer you want to remove, and then click X to the right.

Remove an organization from a project

When you remove an organization from a project, its members lose access to the project unless they have the Service Desk Customers project role, have access through another organization, or the project allows anyone to raise a request without logging in.

You must be a project administrator to remove an organization from a project.

To remove organizations from a project:

1. From your service project, go to Customers.
2. Select an organization in the Customers list.
3. Click Remove from project.

Delete an organization from a site

Deleting an organization does not delete the customers who are in it. The customers still exist on the Jira site and have access to any projects for which they have the Service Desk Customers role or access via another organization.

You must be a Jira admin to delete an organization from a Jira site.

To delete an organization from a site:

1. From your service project, go to Customers.
2. Select an organization in the Customers list.
3. Select Remove from project > Delete organization.

Involve Jira Software or Jira Core users
You can give users with Jira Software or Jira Core licenses permission to view and comment on service project issues without a Jira Service Management license, only if Jira Core, Jira Software, and Jira Service Management are licensed on the same Jira instance.

To involve Jira application users:

1. From your service project, select **Project settings > Users and roles**.
2. Add users to the **Service Desk Team** role.

These users can:

- View issues, comments, and attachments
- Add and delete their own attachments and internal comments
- Watch and vote for issues

These users can't:

- Leave comments for customers
- View queues, the customer list, or reports
- Transition service project issues
- Log work on a service project issue
- Be assigned to a service project issue

Learn more about collaborating with Jira Software or Jira Core users.

**Example of collaboration between Jira Service Management and Jira Software**

1. Martin, an IT service desk team agent, links an incident ticket in a service project to an underlying network problem ticket in a Jira Software project.
2. Andrew, a Jira Software developer on the network operations team, assigns this network issue to himself and starts working on it.
3. After fixing the problem, Andrew opens the linked service incident ticket and leaves an internal comment asking Martin to try the network connection again.
4. After receiving the internal comment, Martin verifies the network connection and tells the customer that the problem is resolved.

Learn more about managing users

Check out the following documentation to learn more about managing users and permissions:

<table>
<thead>
<tr>
<th>Documentation</th>
<th>Details</th>
</tr>
</thead>
<tbody>
<tr>
<td>User management</td>
<td>Add and remove users, manage users with groups, and manage access to Jira applications.</td>
</tr>
<tr>
<td>Managing project roles</td>
<td>Add and remove project roles and manage project role membership.</td>
</tr>
<tr>
<td>Enabling public signup</td>
<td>Allow customers to create their own accounts by signing up on the customer portal or emailing the email channel</td>
</tr>
<tr>
<td>Configuring permissions</td>
<td>Learn how global permissions affect licensing, how project permissions are associated with a project role, and how to customize the default service desk project permission scheme.</td>
</tr>
<tr>
<td>Customizing Jira Service Management permissions</td>
<td>For advanced admins, find out more about service project users’ required permissions.</td>
</tr>
<tr>
<td>Resolving Jira Service Management permission errors</td>
<td>Troubleshoot permission errors.</td>
</tr>
</tbody>
</table>
Managing project role memberships

You can use project roles to easily associate users and groups with a particular project. For example, you may want to send notifications to a specific set of users associated with your project, and by adding them all to a project role, you can then use that project role to control who receives the notifications.

You can also use project roles to restrict how much access certain users or groups have. Unlike groups, which have the same membership throughout your application, project roles have specific members for each project.

This page contains instructions for managing membership of existing project roles. For information on creating and using project roles, see Managing project roles.

Viewing and editing project role members

1. Log in as a project administrator and open your project.
2. Select Project settings > Users and roles.
3. You'll see all users and groups associated with each project role.
4. To add users or groups to a project role, select Add users to a role in the top right corner. Enter the users or groups and select the project role you wish to add them to.
5. To remove a user or group from a project role, hover over the user or group row, and select Delete.

Since group membership can only be edited by users with the Jira Administrator global permission, project administrators may therefore prefer to assign users, rather than groups, to their project roles.
Setting up queues for your team

Make sure that your team is working on the right requests at the right time with easily configurable service project queues. A queue is a filtered set of issues that are displayed to your team. Use your project's default queues or create custom queues to save time triaging requests, and to give your agents more visibility of the number and type of incoming customer requests they need to work on.

You need to be an administrator for your project to set up queues.

You can set up queues on the aptly named Queues tab in your service project:

Creating new queues

When creating a new queue, you can select the queue name, the issues that will be filtered into this queue, and the columns that appear in the queue to make life easier for your service team. Here's how you create a new queue:

1. From your service project sidebar, select Queues > New queue.
2. Name your queue using language your team will understand (for example, "Due this week").
3. Select which issues will show up in this queue using the dropdown options in the Basic search view:

You can also select the advanced search view to enter a Jira Query Language (JQL) statement.

4. Add or remove columns to control what issue information, such as the issue key and issue creation date, is displayed in your queue.

5. Select Create. If you have existing issues in your project that fit the criteria selected in "Issues to show", these issues will now appear in your new queue.

Managing queues

You can reorder or delete queues at any time by hovering over the Queues sidebar and selecting Manage. In the Manage queues dialog that appears, you can see the number of issues in each queue, and drag and drop queues to reorder them.

You can edit existing queues by selecting the queue you wish to configure and selecting Edit queue in the top right corner. You can edit the queue name, the issues shown, the columns, and column order. Note that you will see a live preview of the updated issues that appear in this queue as you configure it.

If you’re using filters in your queues, make sure these filters include all the priorities defined in the associated priority scheme. See Associating priorities with projects for more details.

How your team uses queues

Queues give your agents a single view of the work that needs to be done across their team. Agents can view all of the queues in your service project; however, they cannot create or edit queues.
Automating your service project

You're viewing Legacy automation

We've renamed Automation to Legacy automation after introducing new automation engine to Jira Data Center. The page you're viewing describes original automation rules that have been part of Jira Service Management since the beginning. You can still use them and your existing automation rules will keep working. We recommend, however, that you switch to the more powerful Automation.

To check out the new Automation, see Automate your project.

Create automation rules to perform actions in your service project based on specific triggers and conditions. For example, you can set an automation rule that alerts an agent when a high priority issue is created. Or, service project can reopen an issue if your customer comments on it after it has been resolved.

Set up a preset automation rule

If your automation rules involve priorities and you're using filters in your service project, make sure these filters include all the priorities defined in the associated priority scheme. See Associating priorities with projects for more details.

To set up an automation rule:

1. In your service project, select Project settings > Legacy automation.
2. Select Add rule.
3. Select a preset rule from the list, then select Next. The rule configuration screen appears.
4. Edit the rule name and description as needed. The rule name appears on the main automation settings page, so select a name that explains what it does.
5. Edit and update any fields that appear in the configuration dialog.
6. Select Save.

Your service project comes with preset rules that you can use to set up automation. Here are the preset rules that come out-of-the-box:
Preset rules

Transition on comment
When a comment is added to an issue, this rule automatically transitions the issue so it's clear who it's waiting on.

Reopen on customer comment
When a comment is added to a resolved issue, this rule will reopen the issue.

Be aware of urgent issues
This rule alerts you (via an @mention) to urgent issues when they are raised, so you can address them immediately.

Keep on top of SLAs
This rule alerts you (via an @mention) when a serious issue is about to breach one of your SLAs.

Set customer expectations
This rule lets your customers know when to expect a response based on the priority of their ticket, by adding a prepopulated comment to the issue.

Update when a linked issue changes
This rule will add a comment to related issues, when the status of an issue changes.

Triage requests sent by email
This rule updates issues received by email with the correct request type, based on keywords present in the request summary or description.

Edit preset automation rules

To edit a preset rule:
1. In your service project, select **Project settings > Legacy automation**.
2. Select **Edit** next to the rule in your automation list to see how it's configured.
3. Select the **WHEN**, **IF**, or **THEN** fields to change your rule's trigger, conditions, or resulting actions. Use **Tips for customizing this rule** for suggestions on what to enter in these fields.
4. Select **Save** to publish your changes.

Create a custom automation rule

To create a custom automation rule:
1. In your service project, select **Project settings > Legacy automation**.
2. Select **Add rule**.
3. Select **Custom rule** from the list, then select **Next**. The rule configuration screen appears.
4. Give your custom rule a name and a description.
5. Configure your rule by defining the **WHEN**, **IF**, and **THEN** fields.
6. Select **Save**.

Here are the rule sets that are allowed in the automation engine:
<table>
<thead>
<tr>
<th>WHEN</th>
<th>IF (optional)</th>
<th>THEN</th>
</tr>
</thead>
<tbody>
<tr>
<td>Comment added</td>
<td>Issue matches a certain filter</td>
<td>Add comment, either internal or external</td>
</tr>
<tr>
<td></td>
<td>Comment visibility is internal or external</td>
<td>Alert user to prompt a specific user or users via an @mention</td>
</tr>
<tr>
<td></td>
<td>User type is a customer or agent</td>
<td>Archive issue to remove it from search results, queues, the customer portal, and all other places it previously appeared. You can access archived issues through direct links, and restore if needed. [Learn more]</td>
</tr>
<tr>
<td></td>
<td>Comment contains a key phrase</td>
<td>Auto-approve/decline to approve/decline a request based on your IF field</td>
</tr>
<tr>
<td>Comment edited</td>
<td>Issue matches a certain filter</td>
<td>Edit request type to change the request type (Because request types are mapped to specific issue types, automation isn't able to change issue types. Be sure your request types are the same issue type before applying this rule)</td>
</tr>
<tr>
<td></td>
<td>Comment visibility is internal or external</td>
<td>Edit issue to select and change a field in your issue, like assignee or priority, as well as Jira supported custom fields (see Jira administration &gt; Issues &gt; Custom fields).</td>
</tr>
<tr>
<td></td>
<td>User type is a customer or agent</td>
<td>Send email to create an email notification.</td>
</tr>
<tr>
<td></td>
<td>Comment contains a key phrase</td>
<td>Transition issue to change its position in the workflow</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Webhook to send a POST request.</td>
</tr>
<tr>
<td>Issue is created</td>
<td>Issue matches a certain filter</td>
<td></td>
</tr>
<tr>
<td></td>
<td>User type is a customer or agent</td>
<td></td>
</tr>
<tr>
<td>Issue resolution is changed</td>
<td>Issue matches a certain filter</td>
<td></td>
</tr>
<tr>
<td></td>
<td>User type is a customer or agent</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Resolution change is either set or cleared</td>
<td></td>
</tr>
<tr>
<td>Status changed</td>
<td>Issue matches a certain filter</td>
<td></td>
</tr>
<tr>
<td></td>
<td>User type is a customer or agent</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Status change visible to customer</td>
<td></td>
</tr>
<tr>
<td>Event Description</td>
<td>Condition Description</td>
<td></td>
</tr>
<tr>
<td>-------------------------------------------</td>
<td>---------------------------------------------------------------------------------------</td>
<td></td>
</tr>
<tr>
<td>A linked issue is transitioned</td>
<td>Link type matches a certain type of link (for example, is related to or blocks)</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Issue matches a certain filter</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Linked issue matches a certain filter</td>
<td></td>
</tr>
<tr>
<td></td>
<td>User type is a customer or agent</td>
<td></td>
</tr>
<tr>
<td>Request participant added</td>
<td>Issue matches a certain filter</td>
<td></td>
</tr>
<tr>
<td></td>
<td>User type is a customer or agent</td>
<td></td>
</tr>
<tr>
<td>Organization added to issue</td>
<td>Issue matches a certain filter</td>
<td></td>
</tr>
<tr>
<td></td>
<td>User type is a customer or agent</td>
<td></td>
</tr>
<tr>
<td>Approval required</td>
<td>Issue matches a certain filter</td>
<td></td>
</tr>
<tr>
<td></td>
<td>User type is a customer or agent</td>
<td></td>
</tr>
<tr>
<td>SLA time remaining</td>
<td>Issue matches a certain filter</td>
<td></td>
</tr>
</tbody>
</table>

Customize automation webhooks

Jira Service Management webhooks let you send information to third party web services without the need for a third party app. For example, you can post a message in a Slack channel when a major incident occurs.

Read [Send alerts with Jira Service Management webhooks](#) to learn more.

Rule run options

Select **Options** in the rules configuration page to change the behavior of how a rule runs, as shown in the image below:
Run rule as: By default, rules run as the person who created the project. Alternatively, you can run rules as the person who triggers the rule. For example, if a rule responds to a customer, then you might want the comment to be from the agent who is working on the request, not from the person who created the project. In this case, you would want to set the Run rule as to User who triggered the rule. Make sure the person you choose has permission to complete all the actions taken by the rule.

Triggered by other rules: By default, rules can trigger other rules. In some cases, you might need to disable this to prevent two rules from triggering each other infinitely.

To change the default Run as user, go to Legacy automation > Change default event user. Make sure the person you choose has permission to perform all the actions that you might try to automate in all your rules.

Disable an automation rule

To disable an automation rule:

1. Go to Project settings > Legacy automation.
2. Select Edit next to the rule in your automation list. The rule configuration screen appears.
3. Unselect the Enable rule checkbox (at the bottom) and select Save.

Disabled rules appear in your automation list with a Disabled badge.
Send alerts with Jira Service Management webhooks

Webhooks are ways for one application to send automated information to another. You might use a webhook to communicate something important after a particular event has occurred. For example, you can send an SMS to a team lead when a high priority issue is created.

A webhook is made up of two things:

- **payload** the message itself
- **URL** the destination of the message. This URL needs to be allowlisted in Jira.

By default, we will send payloads in JSON format using an HTTP POST request.

Add a webhook to a Jira Service Management automation rule

A Jira Service Management webhook is a **THEN** action in an automation rule. When you configure a rule you can specify **WHENs** and **IFs**, then use the webhook to define your action.

Before you begin:

- The destination URL needs to be allowlisted in Jira.

To add a webhook to a Jira Service Management automation rule:

1. Go to **Project settings > Automation**.
2. Create a Custom rule or edit an existing rule.
3. Configure the **WHEN** and **IF** settings as you like.
4. Add a **THEN** action and choose **Webhook** from the dropdown.
5. Configure the webhook settings, name your rule, then hit **Save**.

See the example below of an automation rule that posts a message to Slack when a major incident occurs:
Payload body options

You can choose one of the following three options for the payload's request body:

- **Send empty payload** - you might choose this option if you're communicating with an app that requires no information.
- **Send Jira issue as payload** - the Jira issue, user, and any comments will be sent.
- **Send custom payload** - you can choose the variables to include and customize your payload you'll need to specify your payload in JSON format. Check the **Encode as form** box if you want the payload to be URL-encoded.

Read the [developer tutorial](#) for detailed information on how to configure Jira Service Management webhooks.
Managing service project notifications

Customers, agents, and admins get email notifications about the status of, and activity on, requests. You can customize the recipients, content, and style of these notifications. This page is about customizing notifications that go to your customers.

To customize the notifications that go to agents and admins, make changes to the Jira notification scheme.

How different roles receive notifications

A service project sends notifications based on two schemes:

- One for your customer, and
- One for your licensed users, who are most likely agents and admins

Customers

When a customer submits a request, they receive the same default email notifications as the issue reporter or participant. When customers share requests in an organization, customers in that organization receive notifications. They can opt in and opt out of notifications for other activity on the request.

When an approver needs to approve the request, they'll receive a notification. They can opt in to notifications for other activity on the request.

Other customers receive notifications on public activities for requests they're involved with. They can opt in and opt out of notifications in the customer portal or email. Reporters who decline are only notified when a team member resolves a request.

When a customer first contacts a service project that has incoming email and public sign-up enabled, an account is set up for them in the background. They'll receive an email that asks them to reset their password and verify their account details. Project administrators can disable these account verification emails.

Agents and admins

When agents and admins work on a request, they receive notifications as part of the project's notification scheme.
Agents don’t receive notifications on their own changes when they act as a customer on issues with a set request type. Jira Service Management treats agents acting as a reporter, participant or approver on these issues as a customer. This occurs regardless of the notification scheme.

Agents who are part of an organization will only receive a customer notification when a request is shared with that organization. If the agent is the assignee of the issue, they won’t receive any notifications from the project’s Jira notification scheme.

Account verification emails

When a customer raises a request by email for the first time, the following events take place:

- An account is created for the customer in the backend.
- A notification is sent to the customer asking them to verify their email address and reset their password, so they can access the customer portal.

This is confusing for customers of organizations running email-based service projects because, most likely, only the agents and admins are using the customer portal. The good news is that you can disable account verification emails to avoid customer confusion: you need to be a project administrator to do this.

To disable account verification emails:

1. Go to Project settings > Customer notifications.
2. Navigate to the heading Account verification email.
3. Enable the Do not send account verification emails toggle (displaying as green with a tick).

Opt in and out of customer notifications

Customers receive notifications when other customers share requests with them. They can opt in and opt out of these notifications in the customer portal, or in email.

To opt in and opt out of notifications in the customer portal:

1. From your customer portal, select Requests > All requests.
2. Select the request whose notifications you want to opt in or opt out of.
3. Select either Get notifications or Don’t notify me, besides the eye icon.

To opt out of notifications in email, select the link Turn off this request’s notifications at the bottom of the email.

Disable the customer scheme for customer notifications

If you have an internal service project where all your help seekers have Jira licenses, you might prefer to disable the customer scheme. In this case, you can work from the licensed user scheme.

To disable the customer scheme:

1. Go to Jira administration > Applications > Jira Service Management > Configuration:
2. Under the heading Notifications, select Yes. This tells your project to stop blocking Jira notifications for customers.
3. Disable the service desk notifications in Project settings > Customer notifications.
4. For each rule, select Edit and deselect the Enable checkbox at the bottom.
5. Go to your Jira notification scheme and customize the notifications for your customers, agents, and admins.

Edit customer notifications

To edit the recipients or message content of your service project notifications:

1. From your service project, select Project settings > Customer notifications.
2. Select the notification you want to edit, then select Edit under the Action column.
3. Select recipients by selecting and editing the To field. You can delete recipients by selecting the X next to an added recipient.

4. Under Content, edit the message. You can add variables using the Insert variable dropdown to pull blocks of information from issues.

5. To disable a notification, untick the Enable checkbox.

6. Select Save to confirm your changes.
Customer notifications

Request created

To
Customers involved ✗

☐ Exclude person who caused the action

Content

English (United States) [Default]

Just confirming that we got your request. We're on it.

Preview

Just confirming that we got your request. We're on it.

View request  ·  Turn off this request's notifications

This is shared with Alpha, Brett Kennedy, Rey Jakku, and Finn 218

Help center, powered by Jira Service Desk, sent you this message.
Select recipients

When choosing recipients, add at least one of the following to the To field:

<table>
<thead>
<tr>
<th>Recipient options</th>
<th>Details</th>
</tr>
</thead>
<tbody>
<tr>
<td>Reporter (customer)</td>
<td>The reporter of the request. This notification is sent even if the reporter has opted out of receiving notifications on the customer portal.</td>
</tr>
<tr>
<td>Customers involved</td>
<td>All customers involved in the request, including:</td>
</tr>
<tr>
<td></td>
<td>• the reporter</td>
</tr>
<tr>
<td></td>
<td>• the request participants</td>
</tr>
<tr>
<td></td>
<td>• the people in the organization that the request has been shared with</td>
</tr>
<tr>
<td></td>
<td>• the approver, in case the request requires an approval</td>
</tr>
<tr>
<td>Notes:</td>
<td>This notification isn't sent to customers if they have turned off notifications for an individual request in the portal or a request's email thread.</td>
</tr>
<tr>
<td></td>
<td>For the users which fall into the category of people in an organization that the request has been shared with as approvers, this notification is turned off by default. This means that to receive notifications meant for the recipient of a specific request, they need to explicitly turn on notifications for that request by selecting <strong>Get notifications</strong>.</td>
</tr>
<tr>
<td>Added participants</td>
<td>The people who have been added as request participants.</td>
</tr>
<tr>
<td>Added organizations</td>
<td>The people in an organization that the request has been shared with.</td>
</tr>
<tr>
<td>Approvers</td>
<td>The people who need to approve or decline a request.</td>
</tr>
<tr>
<td>Exclude person who</td>
<td>Prevents the person who triggered the rule from receiving a notification. For example, if a customer adds a comment to a request, you can select to exclude them so they don't receive a notification about their own comment.</td>
</tr>
<tr>
<td>caused the action</td>
<td></td>
</tr>
</tbody>
</table>

Include issue variables

You can use variables to pull blocks of information from issues and insert them into your message. Select the **Insert variable** drop-down menu to add valid variables for the notification you're customizing.
<table>
<thead>
<tr>
<th>Name</th>
<th>Format</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Recipient name</td>
<td>${recipient.name}</td>
<td>The full name of the person receiving the email.</td>
</tr>
<tr>
<td>Name of person who caused</td>
<td>${event.user.name}</td>
<td>The full name of the person who triggered the notification, for example by</td>
</tr>
<tr>
<td>the action</td>
<td></td>
<td>adding a comment.</td>
</tr>
<tr>
<td>Issue summary</td>
<td>${issue.summary}</td>
<td>The summary of the issue, or blank if there's none.</td>
</tr>
<tr>
<td>Issue description</td>
<td>${issue.description}</td>
<td>The description of the issue, or blank if there's none.</td>
</tr>
<tr>
<td>Issue key</td>
<td>${issue.key}</td>
<td>The issue key (for example, IT-123).</td>
</tr>
<tr>
<td>Issue reporter</td>
<td>${issue.reporter.name}</td>
<td>The full name of the user that reported the issue.</td>
</tr>
<tr>
<td>Issue resolution</td>
<td>${issue.resolution}</td>
<td>The resolution of the issue, for example &quot;done&quot;.</td>
</tr>
<tr>
<td>Request URL</td>
<td>${request.url}</td>
<td>The URL of the request in the customer portal.</td>
</tr>
<tr>
<td>Comment</td>
<td>${comment}</td>
<td>The comment added to the issue.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>This is only available using the &quot;Comment added&quot; or &quot;Comment edited&quot; WHEN</td>
</tr>
<tr>
<td></td>
<td></td>
<td>trigger.</td>
</tr>
<tr>
<td>Request status</td>
<td>${request.status}</td>
<td>The customer-visible status of the request, as shown on the customer portal.</td>
</tr>
<tr>
<td>Portal name</td>
<td>${portal.name}</td>
<td>The portal name, which can be edited on the Portal settings page.</td>
</tr>
<tr>
<td>Request details</td>
<td>${request.details}</td>
<td>The full details of a request. This includes the creation date, request</td>
</tr>
<tr>
<td></td>
<td></td>
<td>type, summary, and the same fields configured as visible in the request type</td>
</tr>
<tr>
<td></td>
<td></td>
<td>settings.</td>
</tr>
<tr>
<td></td>
<td></td>
<td><strong>This does not include fields created by third-party add-ons.</strong></td>
</tr>
<tr>
<td>Approval buttons</td>
<td>${approval.buttons}</td>
<td>The Approve and Decline buttons to action requests from within the email.</td>
</tr>
</tbody>
</table>

Fast-track the time it takes approvers to action pending requests by inserting **Request details** and **Approval buttons** to your approval notifications template, if they aren't there already.

Automatically send emails as customer notifications

To create custom email triggers:

1. From your service project, select **Project settings** > **Automation**.
2. Select **Add rule** > **Custom rule** > **Next**.
3. Edit the name and description as needed.
4. Edit these fields to configure your rule:
   - **WHEN**: select what triggers your rule.
IF: select the conditions of your rule
THEN: send email

5. Select Save to create your custom rule.

Translate customer notifications into different languages

Jira Service Management lets you provide translations and regional messages to your customers, and supports a large number of languages.

Read Translate service project notifications to learn how to do this.

Customize customer notifications

Your service project adds a default subject line that you can customize to better fit your brand.

To customize notifications:

1. From your service project, select Project settings > Customer notifications.
2. Under Templates, select Edit templates.
3. Under Subject, edit your subject line. You need to keep the issue key somewhere in the subject line to send a request's notifications into a single email conversation.
4. Under Styles, adjust the HTML, CSS, and plain text styles as you like. You can include more template variables by selecting the Insert variable drop down.

Include more information using template variables

You can use this set of variables to pull blocks of information and add it to your email template.

<table>
<thead>
<tr>
<th>Name</th>
<th>Format</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Message content</td>
<td>${message.content}</td>
<td>The content of your notifications. We require this variable. This variable includes batched messages.</td>
</tr>
<tr>
<td>Request location</td>
<td>${request.url}</td>
<td>The URL of the request.</td>
</tr>
<tr>
<td>Disable notifications location</td>
<td>${request.disable.notifications.url}</td>
<td>The URL to turn off notifications for the request. As a best practice, we recommend always including this link.</td>
</tr>
<tr>
<td>List of request viewers</td>
<td>${request.sharedwith}</td>
<td>The participants, approvers and customer organizations who can also view the request.</td>
</tr>
<tr>
<td>Help center name</td>
<td>${helpcenter.name}</td>
<td>The name of your site's help center, an entry point to all customer portals on your site.</td>
</tr>
<tr>
<td>Jira Service Management homepage</td>
<td>${atlassian.url}</td>
<td>The URL of Jira Service Management's homepage.</td>
</tr>
</tbody>
</table>

Style more CSS classes

You can style more classes than appear in the default template.

<table>
<thead>
<tr>
<th>Name</th>
<th>Class</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Reply marker</td>
<td>.jsd-reply-marker</td>
<td>The style of the reply marker. This series of dashes and hyphens is used to process comments when a customer replies to a notification.</td>
</tr>
<tr>
<td>Batched item container</td>
<td>.jsd-activity-item-content</td>
<td>The style of a division used to wrap individual messages added to a batched notification.</td>
</tr>
<tr>
<td>Batched message separator</td>
<td>.jsd-activity-item-separator</td>
<td>The style of a separator inserted when batches of messages are sent as a single notification.</td>
</tr>
</tbody>
</table>
Select HTML or plain text

If the default type is set to HTML, we send dual-encoded notifications. This means your customers can then select the HTML or plain text view in their mail client. If your customers use a plain text mail client, change your default setting and apply it to new and existing customers.

You must be a Jira administrator to set the default email type.

1. Select **Project administration > System**.
2. Under **User Interface**, select **Default User Preferences**.
3. Select **Edit default values**.
4. Change the **Default outgoing email format** to HTML or text and select **Update**. At this point, the email format you have selected will only be applied to new service project customers.
5. If you also want to override the email format chosen by existing service project customers and agents, select **Apply** under **Actions**.
6. Select **Update** to finish applying the email preference to all user accounts.
Translate service project notifications

When you create a project, its help center and customer portal display in the default language from your Jira instance.

To support your customers who speak different languages, you can translate the notifications they receive like the confirmation email that lands in their inbox after they submit a request.

On this page:
- Add or remove a language
- Review and translate customer notifications

Add or remove a language

When you add a language, your service project introduces translated notification messages and templates from our default style.

To add or remove a language to your service project:

1. Go to Project settings > Customer notifications.
2. Under Language support, select Manage languages.
3. Select Add languages, the languages your service project supports appear in the table.
4. Choose the language(s) you’d like to translate.
5. Under the Action column, you can Enable or Disable languages. We disable newly added languages by default, so you can quality check your translation before enabling it.

If a language isn't supported in your service project, your customers receive notifications in the project's default language. You'll see a project default badge beside the default language, and you can change this via the Set project default language link.

Check out Managing service project notifications to learn:
- how different roles receive notifications
- how to customize notifications

108
Review and translate customer notifications

To translate a customer notification:
1. Go to Project settings > Customer notifications.
2. Under Default rules, choose the notification to translate, then select Edit.
3. On the notification screen, under Content, select a language from the drop down.
4. Insert any additional variables or custom content. You'll need to add translations for your custom content, otherwise, customers will see that content in the project default language.
5. Preview the content, then hit Save.
Project settings

Customer notifications
Request created

To
Customers involved

Exclude person who caused the action

Content

1

Formatting help
Revert to default content

Created in 2023 by Atlassian. Licensed under a Creative Commons Attribution 2.5 Australia License.
Setting up request types

Jira Service Management provides a set of default request types that are configured for basic IT help desk scenarios. You can configure the default request types or add new ones to suit the needs of your customers and team. Request types can be organized into groups to help customers find the request they need on the customer portal.

You need to be an administrator to set up request types and workflows in your project.

Set up request types

Each request type in a service project is based on an issue type. Open Project settings > Request types to manage your project’s request types:

1. **Request name**: give the request an intuitive name by using keywords that your customers look for.
2. **Issue type**: add a new request type by selecting the issue type the request is based on.
3. **Description**: help your customers choose the right request type by providing helpful descriptions.
4. **Edit fields**: customize request fields and workflow statuses, and add request types to groups on your customer portal.

A single issue type can be the basis for many different request types. For example, the Service Request issue type serves as the basis for both the “Get IT help” and “Connect to wi-fi” requests.

Organize request types into groups

We recommend using groups if you have seven or more request types, so you can make your request types easier to find on the customer portal. You must have more than one group for the groups to appear in the customer portal. For example, ‘Logins and Accounts’, ‘Applications’, and ‘Common Requests’:
Administrators and project administrators can manage request type groups in Project settings > Request types. Click on a group to add new or existing request types to it. You can also create a new group by clicking + Add group and these request type groups are unique to each service desk project.

- Drag and drop request types to rearrange them in your groups (and, consequently, on your customer portal).
- If you assign multiple groups to a single request type, the request type will appear on multiple tabs.

Customize the fields on a request type

The fields and descriptions that appear in a request type are based on the field configured for the issue type (that is, the issue type the request type is based on).

When editing the request type fields, you can use the Fields tab to change the default Jira field names to more customer friendly language. For example, the “Summary” field appears as “What do you need?” for customers.
You can also keep fields hidden but available on the request type so that their value can be used for other processes. For more details about how different types of fields work in Jira Service Management, see Hidden fields and unsupported fields.

If the issue type doesn't have the fields you need, you must add a field to the Jira issue type that the request type is based on. If the issue type uses multiple screen schemes, the new field must be available in the create screen. See Associating a screen with an issue operation.

Customize the workflow statuses for a request type

Jira Service Management uses the workflow associated with the request's issue type for the flow of the request.

You can re-map the default workflow statuses to more customer friendly statuses that will appear for customers, and you can also map multiple statuses to a single customer status to simplify the appearance of the workflow. Use the Workflow statuses tab to customize the workflow that customers will see.
Only changes between these customer-visible 'status names' will be reflected in the Customer Portal and its notifications (e.g., a transition between two workflow statuses can be hidden on the Portal by giving them the same 'status name'). For more information about notifications, see Managing service project notifications.

If you need to change the workflow of a request, you must edit the workflow associated with the service project by going to Project settings > Workflow.

Hidden fields and unsupported fields

Each request type in a service project is based on an issue type. Every issue type has a set of allowed (and possibly required) fields associated with it. As you set up the request type, you can choose to include fields that are hidden on the customer portal but still provide a value to assist with your internal processes and reporting. For example, you might want to set the value of the "Label" field as "hardware" for the "Request new hardware" request type, and set the value as "software" for the "Request new software" request type.

Some fields used by an issue type are not supported for use in the customer portal; if you include these fields on a request type, they will automatically be added to the Hidden fields with preset values section and you'll be required to set a value for them.

Other fields aren't supported for use in Jira Service Management.

These fields can be added to the request type and given a preset value, but you cannot make them visible on the customer portal:

- Assignee
- Linked issues
- Any fields that are defined by other Jira applications
- Group, project, and version picker custom fields
- Security level

These types of fields can't be added to a request type and won't appear in the Add a field dialog:

- Issue type
- Log work
- Reporter
- Time tracking

Set up URLs with auto-populated request fields

You can generate URLs that will automatically populate selected request fields with contextual data. This way you can direct your customers to the customer portal from an external website and transfer certain details into the request fields.

- If an incorrect value is loaded via the URL, the field can display incorrect malformed data.
- The URL max length is 2048 characters.
- All values must be URI encoded.
- If the custom field is a default field from Jira or Jira Service Management, it will use its field name, e.g. Summary, Priority. If it's a user-generated field, it will require the custom field ID. Learn how to find ID for custom fields.

URLs can fill in the following request field types:

<table>
<thead>
<tr>
<th>Field type</th>
<th>Example usage</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Summary</td>
<td>&amp;summary=Hello%20World</td>
<td>URI encode value and attach it to the custom field.</td>
</tr>
<tr>
<td>Description</td>
<td>&amp;description=About%20us.</td>
<td></td>
</tr>
<tr>
<td>Priority</td>
<td>&amp;priority=4</td>
<td></td>
</tr>
<tr>
<td>Text</td>
<td>&amp;customfield_1000=Lost%20phone</td>
<td></td>
</tr>
<tr>
<td>Textarea</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Date</td>
<td>&amp;duedate=12/24/95</td>
<td>Format = MM/DD/YY</td>
</tr>
<tr>
<td>Due date</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Date time</td>
<td>&amp;customfield_1000=12/14/21-14:39:21</td>
<td>Format = MM/DD/YY-HH:MM</td>
</tr>
<tr>
<td>Label picker</td>
<td>&amp;customfield_1000=hello,atlassian</td>
<td>Comma separated labels.</td>
</tr>
<tr>
<td>Checkbox</td>
<td>&amp;customfield_1000=500,501,502</td>
<td>Pass values of the option ID to be selected, separated by comma.</td>
</tr>
<tr>
<td>Multi-select</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Radio</td>
<td>&amp;customfield_1000=500</td>
<td>Pass a single value to be selected.</td>
</tr>
<tr>
<td>Select</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Cascading select</td>
<td>&amp;customfield_1000=500,1</td>
<td>Pass 1 or two values. The first value is the first select option to be selected. If a second value is passed, then it is the second select value to be selected.</td>
</tr>
</tbody>
</table>
# Troubleshooting issues with request types

This page contains information about the errors and problems that you might have when setting up request types for your service project.

<table>
<thead>
<tr>
<th>Issue</th>
<th>Resolution</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cannot delete the request type because it is the default request type for the email channel.</td>
<td>Jira administrators can change the default request type for email requests to be another one by going to Project settings&gt; Email settings in your service project. For more information about the email channel setup, see Receiving requests by email.</td>
</tr>
</tbody>
</table>

If you see this error when trying to delete a request type, it means that the email channel for your service project uses this request type as the default one for all the requests coming from emails. When Jira Service Management pulls emails from the associated email account and creates requests, this request type is assigned to the requests automatically.
<table>
<thead>
<tr>
<th>Cannot show a hidden field or make an optional field required because the request type is the default for the email channel. When Jira Service Management creates new requests from emails sent to the email account associated with your service desk, it copies the email subject to the <strong>Summary</strong> field and the email content to the <strong>Description</strong> field. When more fields are required, Jira Service Management cannot parse emails to fill them in with correct values.</th>
</tr>
</thead>
<tbody>
<tr>
<td>You have the following options:</td>
</tr>
<tr>
<td>- If you want to show a hidden field, make it an optional one.</td>
</tr>
<tr>
<td>- Ask your Jira administrator to change the default request type for the email channel to use a different request type, and then modify your request type to include more required fields. You can also create a new request type for the email channel if no existing types are suitable. For more information about the email channel setup, see <a href="#">Receiving requests by email</a>.</td>
</tr>
</tbody>
</table>
Request type displayed as "No match" in agent view.

In Jira Service Management, the service project request type is stored with the PortalKey /RequestType Name value. For example, a "New Feature" request created in your "HelpDesk" Customer Portal would have the HelpDesk /NewFeature value. When you move this request to a new project, the HelpDesk /NewFeature value no longer matches the new project's Customer Portal name and request type values.

You have the following options.

- When you move a single issue to a new project, simply edit the service project request type field with the correct request type:

- If you need to move a group of issues, you can search for issues with the same issue type in your existing project and then use the Bulk Edit wizard. In the third step, check Change Customer Request Type and select the request type that applies to this group of issues.
Setting up SLAs

Good service is what keeps customers coming back and a key ingredient of good service is responsiveness.

With Jira Service Management, you can keep your team on track by setting goals for how quickly you manage customer issues. If these goals are set by your customer contracts, you might know them as Service Level Agreements, or SLAs.

SLAs track the progress of things like:

- Respond to all requests within 2 hours.
- Resolve high-priority requests within 24 hours.

How SLAs look

To see how SLAs are displayed in the agent view and customer portal in different scenarios, see How teams see SLAs.

How to set SLAs

Your Jira admin or project admin can set SLAs in Project settings > SLAs.

When you set an SLA, you select three things:

- Who can view your SLA: only agents or also customers on the customer portal
- A time metric, which defines how and when time will be measured
- A goal, which defines the target to be met

Select who can view your SLA

You need a Data Center license to use this feature.

By default, SLAs are visible only for agents. You can select to display each SLA individually also for customers on the customer portal. Customers will see the status of your SLA and its time metric, but they won't see the goal itself (for example, within 5d).

Set a time metric

The time metric works like a stopwatch, tracking the time between two points in an issue’s lifecycle. For example, you might start time when an issue is created, pause time while you wait for the customer to respond, and stop time when the issue is resolved.
Jira Service Management has pre-configured time metrics to cover the most common IT requirements, but you can modify these or create your own as needed.

To create a new metric, from your service desk project sidebar, select **Project settings > SLAs > Create SLA** and fill in the following conditions:

<table>
<thead>
<tr>
<th>Condition</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>This name (for example <em>Time to resolution</em>) will appear to agents in the <strong>SLAs</strong> section of issues. Agents should be able to read the name and know what they're being measured on. You can’t change the name of an SLA metric after you’ve saved it.</td>
</tr>
<tr>
<td>Start</td>
<td>Time starts being counted against the SLA when any of these occur (for example, <em>Issue Created</em>).</td>
</tr>
<tr>
<td>Pause on</td>
<td>Time doesn’t get counted against the SLA when at least one of these conditions apply to the issue (for example, <em>Status: Waiting for Customer</em>).</td>
</tr>
<tr>
<td>Stop</td>
<td>Time stops being counted against the SLA when any of these occur (for example, <em>Resolution Set</em>).</td>
</tr>
</tbody>
</table>

You can set multiple conditions for the start, stop, and pause time. Here’s an example of the conditions set for the *Time to resolution* SLA.

![Time metric diagram](image)

You can set multiple conditions for the start, stop, and pause time. Here’s an example of the conditions set for the *Time to resolution* SLA.

Check out [Example: creating an SLA with multiple cycles](#) to learn how to create a more complex SLA by starting and stopping the time counter throughout the workflow.

**Set a goal**

In the **Goals** section of the SLA metric, select the type of issue you want to track (**Issues**), how quickly you want to resolve it (**Goal**), and your teams working hours (**Calendar**).

Here are some examples of goals you might set:
• Resolve blocker issues within 24 hours.
• Resolve blocker issues created by the Build Engineering team within 12 hours.
• Resolve blocker issues created by the Accounting team within 36 hours.

In the New SLA or Edit SLA screen, fill out the following fields to define a goal:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Issues</td>
<td>You can enter specific issue criteria using Jira Query Language (JQL). Base goals on criteria that remain relatively constant throughout an issue's lifecycle (for example, an issue's priority rather than its workflow status).</td>
</tr>
<tr>
<td>Goal</td>
<td>This is where you specify the target time for the SLA conditions you previously set. When specifying SLA goals that use a fraction of an hour, write the time as Xh Ym (for example, 3h 30m). You can write SLA goals as hours and minutes, but not days.</td>
</tr>
<tr>
<td>Calendar</td>
<td>The calendar allows you to specify working hours when time can be counted against SLAs.</td>
</tr>
</tbody>
</table>

You can drag goals in order of importance. An issue is tracked against the first goal criteria it matches on the list:

Set your working hours

Jira Service Management lets you create calendars that match the working hours of your team including lunch breaks, holidays, and weekends. You can then assign that calendar to an SLA, so the clock stops when your team are away.

Read Create and edit SLA calendars to learn how to do this.

Configure your SLA settings

As a Jira administrator, you can manage permissions, formatting, and other SLA settings.

To configure your SLAs:

1. Go to Administration > Applications.
2. Select **SLA configuration**.

3. Find the section you want to manage.

4. Select **Configure**.

**Clean up SLA debug log events**

Whenever a Jira Service Management issue event is triggered or an SLA is created or deleted, Jira Service Management updates the corresponding SLAs. The SLA debug log feature creates an entry in the database (AO_54307E_SLAAUDITLOG and AO_54307E_SLAAUDITLOGDATA tables) to reflect that change.

As a Jira administrator, you can decide how you want the SLA debug log to be cleaned up. You can also select how often the events will be deleted from the database.

<table>
<thead>
<tr>
<th>SLA debug log events</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>SLA events are stored in the debug log</strong></td>
<td></td>
</tr>
<tr>
<td>- Enabled</td>
<td></td>
</tr>
<tr>
<td>- Disabled</td>
<td></td>
</tr>
<tr>
<td><strong>SLA audit log cleanup method</strong></td>
<td></td>
</tr>
<tr>
<td>- Smart</td>
<td>Clean SLA debug logs only for inactive issues older than 30 days.</td>
</tr>
<tr>
<td>- Full clean</td>
<td>Clean all SLA debug logs older than 30 days.</td>
</tr>
<tr>
<td><strong>Specify how old debug logs have to be cleaned</strong></td>
<td></td>
</tr>
<tr>
<td>- 30 days</td>
<td></td>
</tr>
<tr>
<td>Max. 90 days.</td>
<td></td>
</tr>
</tbody>
</table>
Configure thread processing

To increase the performance of Jira Service Management, we run SLA calculations in background tasks. A thread, in this context, executes those tasks, in parallel with other threads.

<table>
<thead>
<tr>
<th>Processing method</th>
<th>Description</th>
</tr>
</thead>
</table>
| Multi-threaded serialized processing (Number of threads is configurable) | **We recommend using this processing method.**  
Introduced in version 4.21.0, this new processing method is self-healing, more cluster-efficient, and more reliable, specifically when Jira is running in a multi-node cluster mode.  
This method allows any Jira node to process any of the stored events. Unlike the in-memory processing mode, application restarts don't affect SLA processing with this method. Even if you only have one node in your cluster, SLA calculations will resume from the place they were interrupted should any interruption happen.  
It uses historical event data stored in the database to calculate SLAs in the order the events arrived for an issue. The thread pool in this method is configurable in the range of 1-20 threads. |
| Multi-threaded in-memory processing (Number of threads is configurable) | This method is considered a legacy processing mode. The thread pool here is configurable in the same way as in the serialized processing method in the range of 1-20 threads.  
In this mode, all processed events are bound to the node they had happened on. When the application stops on one node, all unprocessed events are lost, and not included in the SLA history until it's manually reconstructed (for versions before 5.0) or until another event happens on the same issue (from version 5.0). |
SLA calculations result in querying the database to fetch information. Our databases use connection pools to limit simultaneous active connections to it. In case of no background processing, we don't control the pool count as it works on HTTP threads. This may lead to a fast database connection pool exhaustion under load. Learn more about database connections

Configure the SLA thread count

If you select the multi-threaded serialized or the multi-threaded in-memory processing method, you can configure the thread pool count for your SLA calculations in the range of 1-20. Thread count values are synchronized across all nodes without restarting the processors.

The default number of SLA threads per node is set to 5. However, in case the SLA calculations aren't keeping up with issue updates, we suggest using the recommended multi-threaded serialized processing method and bumping up the SLA thread count in small increments while observing the system response.

### Updating SLAs

When you change the configuration of existing SLAs, we follow these rules:

- We don't recalculate, or touch in any way, cycles that have already been completed. A cycle is completed when a request fulfills the **Start** and **Stop** conditions (depending on your configuration and events, another cycle of the same SLA might then be started).
- We recalculate ongoing SLAs so they measure against your new configuration and metrics.

It might happen that ongoing SLAs will be completed or discarded entirely after changing the configuration. This can happen if you remove the previous **Start** or **Stop** conditions or change them to something else, which will trigger the completion. As mentioned earlier, ongoing SLAs will be recalculated to use your new configuration.

### Recalculate your SLAs for a single issue

Occasionally, issue events that should trigger a change to an SLA value are missed or interpreted incorrectly resulting in an incorrect SLA value showing in the queues or the issue view. Usually, SLA calculations will catch up to missed events and correct the values, but if they don't, you can recalculate the SLAs for an issue in the issue view.

**SLA recalculation replaces the existing SLAs values using the current SLA configurations for the project. This operation is irreversible and may result in data loss.**

To recalculate your SLAs for an issue:

1. Go the issue view.
2. From the SLAs section select the more actions menu ⋮ > Recalculate all SLAs.

3. Select Recalculate.

Best practice SLA usage

1. Try to select an Assignee who's not the Reporter of an issue. If you assign the same user, your SLA might work incorrectly.
2. If issue data changes in such a way that the goals for the issue change (for example, the priority changes from Critical to Blocker), the time against the previous goal will be tracked against the new goal, for open issues only.
   For example, if the Support team spent an hour on a Critical issue, when the issue is escalated to Blocker, the hour still counts against the new goal, even if it causes the SLA to be breached.
3. If you're using filters in your service project to track SLA data, specifically priorities, make sure these filters include all the priorities defined in the associated priority scheme. See Associating priorities with projects for more details.
4. We do not recommend setting up a goal to be dependent on a different SLA.
Create and edit SLA calendars

When you create an SLA, you can link that SLA to a calendar to ensure the clock only ticks when your team are available. To support different ways of working, you can create calendars that take into account shift work, breaks, and holidays.

To get you started, Jira Service Management comes with two default calendars:

- Default 24/7 calendar. This is used when no calendar has been assigned to an SLA goal.
- Sample 9-5 calendar. This tracks hours from 9am to 5pm, Monday through Friday.
### Create a new calendar

To create a new calendar in your service project:

1. Go to Project settings > Calendars (underneath SLAs).
2. In the top right corner, select Add calendar.
3. Fill out the Name and Description, so it's easy to know what hours are being tracked.
4. Choose the working hours for each day, and click ‘+’ to add a new row.
5. Select Save.
Edit or delete a calendar

To edit an existing calendar in your service project:

1. Go to Project settings > Calendars (underneath SLAs).
2. Find the calendar, select either Edit or Delete.
   • If deleting, you can't delete the Default 24/7 calendar. You also need to remove a calendar that's being used by an SLA from the SLA itself, before you can delete it here.
   • If editing, you can't edit the Default 24/7 calendar.
3. Once you've made your changes, select Save.

When you make changes, we'll recalculate any project SLAs linked to this calendar.

Import holidays

To import holidays to a calendar:

1. Go to the Holidays section at the bottom of the calendar.
2. Select the Import holidays link.
3. Choose your ICS file, and set it to UTC/GMT+10.
4. Select Import. You'll see a modal that lists the holidays about to be imported. Delete unwanted holidays by clicking 'x'.
5. Select Import.

Imported holidays will be added to any existing holidays in the calendar. If you'd like a holiday to repeat the following year, check the Repeat yearly box and you won't have to import it again.
Link calendars to SLAs

To link a calendar to an SLA:

1. Go to Project settings > SLAs.
2. Choose the SLA you want to link to, select Edit SLA.
3. Set your Start, Pause, and Stop conditions.
4. In the Goals section under Issues, choose the type of issues you want to track.
5. Under Goal, choose how quickly you want to resolve them.
6. Under Calendar, select the edit icon and choose a calendar from the dropdown.
7. Select Save.
To learn all about SLAs and how to set them up, go to Setting up SLAs.
How teams see SLAs

Support teams rely on SLAs to plan and track their time against issues.

Jira Service Management shows SLAs in a human readable time, instead of only hours and minutes. That way, service project agents don’t spend precious time working out what 78:00 means in days.

How it looks

The SLAs look a bit differently for agents and for customers, if they’re enabled on the customer portal:

- **Agents** see a read-only version of the tab, so they know how the is configured. In the issue view, the SLAs section lists more information about the that the issue is being measured against.

- **Customers** see SLAs that have been enabled on the customer portal, but they only see the status, without the actual goal. They can still see if an is at risk or breached.

Ongoing SLAs

The tracker uses colors to indicate the urgency of an for an issue, based on the time remaining.
## Completed SLAs

A completed displays the time remaining when the was completed (or the amount of time breached) and an icon to indicate whether the was completed successfully or unsuccessfully.

<table>
<thead>
<tr>
<th>Agent view</th>
<th>Customer portal</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>29min</strong></td>
<td>Time to resolution within 30min</td>
</tr>
<tr>
<td><strong>-2min</strong></td>
<td>Time to resolution within 5min</td>
</tr>
<tr>
<td><strong>1h</strong></td>
<td>Time to resolution within 1h</td>
</tr>
<tr>
<td><strong>44min ✓</strong></td>
<td>Time to resolution within 1h</td>
</tr>
</tbody>
</table>
Past cycles

SLAs can be configured to start, pause, and stop based on various conditions. After an SLA has stopped and if one of the start conditions is detected again, the SLA will be reset to start a new cycle.

The past cycle will be displayed in the SLAs panel in the issue view, underneath the SLAs name. You will see an expander under that where the corresponding cycles are listed.

There will be as many previous cycles as times an SLA is reset.

- Past SLA cycles show only in the agent view and are not available in the customer view.

Here’s how past SLA cycles are displayed.

<table>
<thead>
<tr>
<th>Agent view</th>
<th>Customer view</th>
</tr>
</thead>
<tbody>
<tr>
<td>SLAs</td>
<td>SLAs</td>
</tr>
<tr>
<td>Time to response within 30min</td>
<td>Time to response</td>
</tr>
<tr>
<td>28min</td>
<td>28min</td>
</tr>
<tr>
<td>2 cycles</td>
<td>2 cycles</td>
</tr>
<tr>
<td>35m</td>
<td>3m</td>
</tr>
</tbody>
</table>

The SLA has two past cycles:
1. The first cycle where the SLA was not breached, and 3 minutes passed.
2. The second cycle where the SLA was breached, and 35 minutes passed.

Units of time

The following units represent time in an:

- 3min
- -3min
- 3m
- 35m
- 28min
- Time to resolution within 5min
- Time to response
<table>
<thead>
<tr>
<th>Seconds</th>
<th>n/a</th>
</tr>
</thead>
<tbody>
<tr>
<td>Minutes</td>
<td>m (min if single unit)</td>
</tr>
<tr>
<td>Hours</td>
<td>h</td>
</tr>
<tr>
<td>Days</td>
<td>d</td>
</tr>
<tr>
<td>Weeks</td>
<td>w</td>
</tr>
<tr>
<td>Months</td>
<td>mo</td>
</tr>
<tr>
<td>Years</td>
<td>yr</td>
</tr>
</tbody>
</table>

Only 1 or 2 units, at a time, are displayed for simplicity, with a combination of the following:

<table>
<thead>
<tr>
<th>min</th>
<th>h</th>
<th>m</th>
</tr>
</thead>
<tbody>
<tr>
<td>d</td>
<td>h</td>
<td></td>
</tr>
<tr>
<td>w</td>
<td>d</td>
<td></td>
</tr>
<tr>
<td>mo</td>
<td></td>
<td></td>
</tr>
<tr>
<td>yr</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

How the clock works

Jira Service Management calculates minutes, hours, days, and weeks by using the working hours set in the associated calendar. It calculates a month and a year by using approximations of 4 weeks and 12 months respectively.

Read Create and edit calendars to learn how to track your teams' working hours and assign calendars to a goal.

**Remaining time**

Remaining time is calculated by looking at the time from now until due, taking into account any pauses.

For example, Request A has an goal time of **16 hours**, with a start time of **11:00** on Monday, and working hours as follows:

- Monday 09:00-17:00
- Tuesday 09:00-16:00
- Wednesday not working
- Thursday 08:00-17:00
- Friday not working
- Saturday not working
- Sunday not working

**How to read the diagrams:**
### Remaining time (1d 9h)

**Goal time 16h | Start 11:00 Monday | Now 11:00 Monday**

| Hour of day | 0 | 1 | 2 | 3 | 4 | 5 | 6 | 7 | 8 | 9 | 10 | 11 | 12 | 13 | 14 | 15 | 16 | 17 | 18 | 19 | 20 | 21 | 22 | 23 | 24 | Hours |
|-------------|---|---|---|---|---|---|---|---|---|---|----|----|----|----|----|----|----|----|----|----|----|----|----|----|----|----|----|----|    |
| Monday      |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   | 6h |   |   |   |   |   |   |   |    |
| Tuesday     |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   | 1d |   |   |   |   |   |   |   |    |
| Wednesday   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   | -  |   |   |   |   |   |   |   |    |
| Thursday    |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   | 3h |   |   |   |   |   |   |    |

### Remaining time (1d 7h)

**Goal time 16h | Start 11:00 Monday | Now 13:00 Monday**

| Hour of day | 0 | 1 | 2 | 3 | 4 | 5 | 6 | 7 | 8 | 9 | 10 | 11 | 12 | 13 | 14 | 15 | 16 | 17 | 18 | 19 | 20 | 21 | 22 | 23 | 24 | Hours |
|-------------|---|---|---|---|---|---|---|---|---|---|----|----|----|----|----|----|----|----|----|----|----|----|----|----|----|----|----|----|    |
| Monday      |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   | 4h |   |   |   |   |   |   |   |    |
| Tuesday     |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   | 1d |   |   |   |   |   |   |   |    |
| Wednesday   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   | -  |   |   |   |   |   |   |   |    |
| Thursday    |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   | 3h |   |   |   |   |   |   |    |
Goal time

Jira Service Management calculates goal time similar to remaining time, but now is set to start of goal. Goal time doesn't take any future pauses into account.

Regardless of the current time, the goal time is always calculated from the start time.

Partial days

In some situations, your Agents might see time displayed as something like 1d 26h. This happens when an starts and stops for a period of less than a day (for example, 7 hours in an 8 hour working day).

All partial days are accumulated as hours and minutes, but not converted to 1 day, because the definition of a day will change depending on the working hours set in the calendar.

For example, Request B has a goal time of 24 hours, with a start time of 10:00 on Monday, and working hours displayed in the diagram below. The goal is 1d 15h and the is due at 16:00 on Wednesday.
It works like this:

1. From 10:00-18:00 on Monday is not a complete working day (according to the calendar). Total = 8 hours.
2. From 09:00-18:00 on Tuesday is a complete working day (according to the calendar). Total = 1 day.
3. From 09:00-16:00 on Wednesday (due time) is not a complete working day (according to the calendar). Total = 7 hours.
   8 hours + 1 day + 7 hours = **1 d 15h**

Multiple targets

If the issue meets the criteria for multiple SLAs, trackers for each will appear. In addition, if the has had multiple cycles, you can hover over the symbols for more details on how the was met for that particular cycle. For example, in an that is measured based on when an issue is *Waiting for support*, you can see whether the was met each time the issue started *Waiting for support*.

Sorting

When you view a list of issues (in a queue or elsewhere), you can sort them by their remaining times. Ongoing issues are listed first, with the shortest time remaining at the beginning of the list. Completed issues are ranked last, but aren’t sorted by the remaining time.
Reporting on SLAs

The following describes reports we recommend for teams that track SLA goals which metrics we think are useful and why, and how to create reports.

To view your service project's reports or create new ones, select **Reports** in your service project sidebar. **You must be an administrator to create or edit reports.**

- If your SLA goals use overlapping JQL filters, your custom SLA reports may be inaccurate. [Read more about setting up SLA goals.]
- If your JQL filters use priorities, make sure these filters include all the priorities defined in the associated priority scheme. [See Associating priorities with projects for more details.]

Track success with percent of SLAs met

By default, Jira Service Management includes an SLA goals report that shows how your team performed against its goals during the past week. This report shows the big picture.

But, if you're interested in trends, want to see a different timeframe or are just more of a visual person, you may find creating a custom report more useful.

For example, you can create reports to see how well your team performs per request type. Create a report with the following series to drill into how your team is doing on each of your SLA goals for IT help requests:

- **Series**= Time to first response % met
- **Label**= Time to first response
- **Filter by**(advanced) = "Customer Request Type" = "Get IT help"

- **Series**= Time to resolution % met
- **Label**= Time to resolution
- **Filter by**(advanced) = "Customer Request Type" = "Get IT help"

You may find your team is speeding up on responding to customers with these requests but slowing down on resolving these issues. Looking at the details, you might see issues that are breaching your SLA goals feature words like "wi-fi" or "access".

Maybe you need to consider more reliable network hardware or you may need to train your organization about how to properly use the network. You may consider creating a knowledge base article that you can use to quickly answer these questions and increase the percentage of SLA goals met for resolving these requests.
Get insight into an agent’s performance per SLA

Line managers and other stakeholders may wish to view individual agent performance trends to help determine when agents are being stretched too thin or ensure work is being distributed appropriately.

Use the assignee field and make some reports for your agents to see how they are keeping up with their workload and where their strengths lie.

- **Series** = Time to first response % met
- **Label** = Time to first response
- **Filter by (advanced)** = assignee = agentUserName

- **Series** = Time to resolution % met
- **Label** = Time to resolution
- **Filter by (advanced)** = assignee = agentUserName

You may find that an agent is slow to respond but very quick to resolve requests. Working with the agent, you may be able to strategize how to better notify them about requests when they are raised.
Importing SLAs

You can reuse SLAs that exist in another service project, in your own project. Importing SLAs will import the full configuration of your SLA including calendars, and allow you to use the same SLAs in your project.

SLAs are not linked, so if you make a change to them in the source project, you’d need to reimport the SLAs to see them in your new project.
How to import an SLA configuration

Before you import your SLAs we recommend you take a look at how the SLAs are set up in the source project. Make sure you have the required elements in your project. For example, you'll need to have the same Start, Pause, and Stop conditions available, and the same request types available. These elements are what's used to calculate your SLA.

To import an SLA configuration:

1. Go to Project settings in the sidebar.
2. Select SLAs.
3. Select + Import SLA configuration.
4. Choose the project you want to import the SLAs from. If there's any errors or warnings that relate to your import, like duplicate SLA names, you'll be informed. You can fix some of these at a later date, or you can choose to stop the import, make the changes, and then reinitiate the import.
5. If you want to replace all existing SLAs, check the relevant box.
6. Select Import.

You've just imported the SLA and they're ready to go into your project. Note that these SLAs will not affect any closed issues, but if you have open issues their SLAs will be recalculated.

How to fix your SLA import

When you import SLAs you'll be notified of any issues with your import that you'll need to fix. Here's a list of the issues and resolutions to help you get your project up and running, as soon as possible.

Jump to issue...

- Goal triggers
- Goals
- Calendars
- Reports
- Request and issue types

Issues with goal triggers

The start, pause, and/or stop conditions used by the SLAs you're importing don't exist in the project you're importing them too.

How to resolve

Depending on your project and what you need to use the SLAs for, you might want to:

- delete the condition from your imported SLA
- create the condition/s that's missing in your imported SLA.

Issues with goals

The start, pause, and/or stop conditions used by the SLAs you're importing don't exist in the project you're importing them too.

How to resolve

Edit the SLA's search filter and remove the incorrect criteria to fix it.

Issues with calendars

A calendar you're importing has no hours assigned to the working week.

How to resolve
Add working hours to the calendar, or delete the existing calendar and create another calendar. Learn more at Create and edit SLA calendars.

**Issues with reports**

There's an existing report that uses an SLA you're about to delete during your import.

**How to resolve**

Fix the report(s) affected and either:

- replace the SLA in the affected report
- delete the report.

**Issues with request and issue types**

The request and/or issue types used by the SLAs you're importing don't exist in the project you're importing too.

**How to resolve**

Either delete references to these in the SLAs, or create the missing request types/issue types and add them to the JQL or condition.
Using JQL queries specific to SLAs

Jira Service Management includes specific JQL syntax that can help you sort through the details of your requests and issues, and make sure you're hitting your SLA goals. Read more about JQL syntax.

- If your SLA goals use overlapping JQL filters, your JQL queries may return unexpected results. Read more about setting up SLA goals.
- If your JQL filters use priorities, make sure these filters include all the priorities defined in the associated priority scheme. See Associating priorities with projects for more details.

Find issues breaching your SLA goals

There are two functions you can use to search for issues that are in a certain state of SLA goal-ness:

- `breached()` filters out issues whose last SLA cycle has failed to meet its target goal
- `everBreached()` filters out issues that have failed to meet their target goal

For example, if you wanted to find all the issues in your project that have successfully completed your first-response goals, use the following query:

"Time to first response" != everBreached()

Find issues that have paused, completed and are still running an SLA clock

There are three functions you can use to search for issues that are in a certain state of completion:

- `paused()` filters issues whose current SLA cycle is paused. This is determined by your SLA conditions. For example, you may pause an issue's SLA clock when the issue's status is set to "waiting for customer".
- `completed()` filters issues whose SLA cycle is complete, meaning they've reached one of their stop events.
- `running()` filters issues whose SLA clock is running, meaning they haven't yet reached one of their stop events.
- `withincalendarhours()` filters issues whose SLA clock is running or not running according to the SLA calendar, `not` conditions.

The paused and running functions do not return issues whose SLA cycles haven't started yet.

For example, if you want to find all the issues that are paused while completing a time to resolution SLA cycle, use the following query:

"Time to resolution" = paused()

Find issues based on their SLA clock

There are two functions you can use to search for issues that have a certain amount of time on their SLA cycle's clock:

- `elapsed()` filters issues whose SLA cycle's clock meets a specified time condition since the ongoing SLA cycle's start event
- `remaining()` filters issues whose SLA cycle's clock meets a specified time condition before the issue will breach an SLA goal

If your JQL goals use overlapping JQL filters, your JQL queries may return unexpected results. Read more about setting up SLA goals.

Find issues breaching your SLA goals

Find issues that have paused, completed and are still running an SLA clock

Find issues based on their SLA clock
For example, if you want to find requests that have been waiting for a first response for less than 10 min, use the following query:

"Time to first response" < elapsed("10m")

Or, if you want to find issues that will breach their resolution target within the next two hours, use this query:

"Time to resolution" < remaining ("2h")
Example: creating a basic SLA

This example looks at how you might create a very basic SLA for a service project with a basic workflow:

Basic SLA configuration

All highest and blocker issues must be resolved within 24 hours. You provide 24/7 support for certain customers (these issues are labeled with "24H"). You provide 9-5 support for all other customers, but you don’t track SLA metrics for them.

Basic issue workflow
Example: creating an SLA that doesn't track continuous time

This example looks at how you might create a more complex SLA by pausing the time counter during the workflow:

Example SLA configuration

Support wants to complete all issues within 40 hours. Time spent waiting on the customer doesn't count against the 40 hour goal.

<table>
<thead>
<tr>
<th>Time for support on all issues</th>
</tr>
</thead>
<tbody>
<tr>
<td>Time will be measured between the <strong>Start</strong> and <strong>Stop</strong> conditions below.</td>
</tr>
</tbody>
</table>

**Start**

- Begin counting time when: Issue Created

**Pause on (Optional)**

- Time is not counted during: Status: Waiting for customer

**Stop**

- Finish counting time when: Resolution: Set

**Goals**

Issues will be checked against this list, top to bottom, and assigned a time target based on the first matching JQL statement.

<table>
<thead>
<tr>
<th>Issues (JQL)</th>
<th>Goal</th>
<th>Calendar</th>
</tr>
</thead>
<tbody>
<tr>
<td>All remaining issues</td>
<td>40h</td>
<td>Default 24/7 calendar</td>
</tr>
</tbody>
</table>

Example issue workflow
Example: creating an SLA with multiple cycles

This example looks at how you might create a more complex SLA by starting and stopping the time counter throughout the workflow. You might set up an SLA like this to track response times (for example, how long it takes your team to respond each time a customer updates an issue with more information). This example also illustrates how goals for different issue criteria can be tracked from a single SLA.

Example SLA configuration

Support wants to respond to **Service requests** within two hours: this includes responding within two hours when the issue is created, as well as each time the issue is updated with more information from the customer.

All other issues have a response time goal of 24 hours.

Example issue workflow

For further information about how SLAs with multiple start and stop conditions appear in the SLA tracker, see [Setting up SLAs](#).
Example: creating an SLA based on due date

Here's an example of how you might create a more dynamic SLA by pausing the time counter until a specified due date has passed. Set up an SLA like this if your team can't begin their work until a date in the future. For example, setting up a workstation when a new hire starts.

For this SLA to trigger, configure the Due field to display on the Issue type screen, and set the Due field when the issue gets created. Read Defining issue type field values to learn how to set this up.

Example SLA configuration

Support want to complete all hardware requests within 24 hours. They want to pause the SLA until they receive the hardware from their supplier (on the expected due date), then unpause the SLA when the due date has passed. All other issues have the same response time goal of 24 hours.

See the image below for how you could set up this SLA in Jira Service Management:
Setting up approvals

Some requests might need approval before your team can work on them. For example, a manager might approve leave requests or an IT manager might approve new system accounts. People don't need a Jira Service Management license to approve requests; they just have to be customers of the service desk project.

Pro tip: Fast-track the time it takes approvers to action pending requests, by inserting Request details and Approval buttons to your approval notifications template, if they aren’t there already. See Managing service project notifications.

Approvers view in the customer portal

How it works:

1. A customer creates a request on the customer portal, and selects the approver required by entering the user name or email address. Alternatively, you can hide the approver field from the customer, and set up a defined list of approvers who are required for that request type.
2. When the request enters the approval status the approver will receive an email.
   a. If the Request details and Approval buttons variables have been added to the approval notifications template, they can view the full details of the request and take action from within the email.
   b. If the Request details and Approval buttons variables have not been added to the approval notifications template, they can view and action the request through the service desk customer portal.
3. The approver can Approve or Decline the request and add an optional comment. The customer receives a standard notification when the request is transitioned out of an approval step, and when the approver leaves a comment.
   a. If declined, the request moves to the next status in the workflow.
   b. If approved, the request moves to the next status in the workflow, and an agent is able to work on it.

Setting up an approval step

To set up an approval step on a workflow for your project, you need to have the Jira administrator global permission.

Here are the steps to get approvals working for your project:
• Jira Service Management creates the Approvers custom field automatically. If you want to use another field, make sure you have a user picker custom field available in your Jira instance and on the screens used by your project - this is used on the approval step.
• Add the same user picker custom field to your request type if you want your customers to choose the approver - this will provide the field for your request that allows an approver to be selected.
• Configure the approvals step on the workflow - this allows you to decide if you require one or multiple approvers, and what happens when the approval is declined or approved.

Detailed steps on setting up an approval are available in the Jira administration documentation.

If you set up your approval step on a status with only two outgoing transitions, they will be used for Approve and Decline. In this case, agents can view requests that require approval, and can modify the approver if required, but they can't change the status until the approver has actioned the request.

If you set up the approval step on a status that has more than two transitions, an agent will be able to transition the request using any of the other transitions that aren't defined as the Approve or Decline transitions. This means the approval step is not enforced.

In certain situations, you may even want to add additional approval steps. For example, if a request needs to be approved by your manager first, and then approved by your finance department. Below are some examples of how you might use approvals:

<table>
<thead>
<tr>
<th>Request type</th>
<th>Approval field</th>
<th>Approver</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Office equipment</td>
<td>Visible on customer portal</td>
<td>Customer selects approver</td>
<td>The customer should select their manager for approval, as each customer could have a different manager.</td>
</tr>
<tr>
<td>Computer software</td>
<td>Hidden from customer portal</td>
<td>Set list of approvers</td>
<td>You set the list of approvers, this could be several members of your finance team.</td>
</tr>
<tr>
<td>Flights</td>
<td>Two approval steps, one visible, one hidden</td>
<td>First approver is selected by customer. Second approver is a set list</td>
<td>The customer can select the first approver, which could be their manager who approves the business case for their trip. The second approver is from a set list (maybe a finance team) that approves the payment of the flights.</td>
</tr>
</tbody>
</table>

Best practice customizations

You can make the approval process more awesome by making some simple customizations to your service project, and that means both you and your customers have a better experience.

1. Make sure you make the name of your multi-user picker custom field, customer friendly on your request. And add a useful help tip, like how many approvers may be required. This will help ensure your customers provide all the correct information first time. Read up on customizing the fields of your requests for more information on how to do this.
2. When the approval of a request is declined, consider closing the request straight away. This means that if you're setting up a custom approval step, you should ensure that the transition you select for decline leads to a status in the Done category, and the transition has a post function to set the resolution status.
It's good practice for your approvers to add a comment telling the customer why their request has been declined, and what their next steps should be; for example, the customer should open a new request and provide more information regarding their requirements.

Auto-approve requests

You can use automation rules to auto-approve requests that meet certain conditions. For example, you might auto-approve hardware requests that are under a certain amount.

To set up an auto-approval, create an automation rule with the THEN action auto-approve. For example, any hardware requests created for an item that costs less than $20 are automatically approved, or any software requests over $10,000 are automatically declined.

In the example below, we've set up a rule for our customer reimbursement requests, and if the Customer value is under $50, the request is automatically approved.

<table>
<thead>
<tr>
<th>WHEN</th>
<th>IF</th>
<th>THEN</th>
</tr>
</thead>
<tbody>
<tr>
<td>Issue created</td>
<td>Issue matches “Customer value”...</td>
<td>Auto-approve/de... Approve</td>
</tr>
</tbody>
</table>

For more information, see Automating your service project.

Approval FAQs

Make sure you've added the user picker custom field that's used in the approval step on the workflow to your request type, and it's visible to customers. If it's still not showing, or it's not listed as a field you can add to your requests, check with your Jira administrator to ensure the field is still available on your project's issue screens.

A request will only show as closed when the resolution has been set, so the transition you use to decline the request needs to also set the resolution field. You can achieve this by adding a post function to the transition in your workflow that sets the resolution field of your request. You read up more on post functions on the administration advanced workflow page.
If you need to change the approvers on a request for any reason, you need to edit the user picker custom field that was added in the approval step. View the request in your service project, and the editable user picker custom field is displayed in the People section of the request. You can make any changes you need to make inline. Note that there is also an Approvals section that lists all approvers; however, you can't make any edits here.

If the field isn't showing, you may need to get a Jira administrator to check the field is still available on your project screens.

In both your customer portal and your service project, you'll see a list of approvers in the Approvals section.

A list of appointed approvers appears in the Approvals section, and this section only appears when there are pending approvals for the request.
When a request is approved, the **Approvals** section disappears, and details about the approval will be added to the **Activity** section, e.g. Your request was **APPROVED** and the status changed to **Waiting for support**.

When a request is approved...

- The approved request displays in the **Past approvals** section, with ✔ beside the approver’s name.
- If multiple approvals are required, the request is approved when the minimum number of approvals is reached.
- The **Approvals** tab appears in the **Activity** section, and shows the all the activity involving approvals for the request.

Make sure you add **descriptive titles and help text** for the approvals field on your portal. This should include details on who the customer should add (such as their manager, or a member of their IT team), and how many approvers. Depending on your **customer access settings**, your customers may be able to select users or other customers from a drop-down list. Take this into account when adding your title and help text.
Setting up service project reports

Reports allow teams to look at trends in their project such as the amount and types of requests received, and how they're resolved. We recommend that all teams use reports, especially those who use SLAs. Read more about reporting on SLAs.

To view or create reports, go to Reports from your service desk project's sidebar. You must be a project administrator to create or edit reports.

If the JQL filters in your reports use priorities, make sure these filters include all the priorities defined in the associated priority scheme. See Associating priorities with projects for more details.

Compare requests created vs requests resolved

The most common way to measure your service team's health is by comparing how many requests come in with how many your team can resolve.

Resolution trends like this can answer questions like:

- Was this week's volume of requests a one-time occurrence or the start of a trend?
- Do we support a service that causes more issues than it's worth?
- Is our service project scaling with our business or do we need to add staff?

We include this report by default because it's the quickest way to check the health of your service project. You can find the other default reports in the Reports sidebar.

To compare requests created vs resolved:

1. From your service project, go to Reports.
2. Select the Created vs Resolved report in the sidebar.
3. In the dropdown field below the graph, choose the date range you're interested in.
4. Click on a number count in the table to drill down into individual requests.
You can also create a CSV report of the dataset by choosing **Export CSV** in the top right-hand corner.

### Default Jira Service Management reports

Here are the reports we include by default:

<table>
<thead>
<tr>
<th>Report name</th>
<th>Details</th>
</tr>
</thead>
<tbody>
<tr>
<td>Workload</td>
<td>The number of requests assigned to your agents</td>
</tr>
<tr>
<td>SLA goals</td>
<td>How your team is tracking towards each of the SLA goals you have set</td>
</tr>
<tr>
<td>Satisfaction</td>
<td>The average customer satisfaction rating for your team</td>
</tr>
<tr>
<td>Article usage</td>
<td>The number of times your customers viewed knowledge base articles in the portal and found them helpful</td>
</tr>
<tr>
<td>Article effectiveness</td>
<td>Learn which articles solved requests and how many views each got (as well as other useful metadata) by clicking on the number count in the table below the graph.</td>
</tr>
<tr>
<td>Created vs resolved</td>
<td>The number of requests resolved with and without knowledge base articles</td>
</tr>
<tr>
<td></td>
<td>Learn which articles were shared by agents and which requests were resolved without an article (as well as other useful metadata) by clicking on the number count in the table below the graph.</td>
</tr>
<tr>
<td></td>
<td>Compares the number of requests created and resolved over time</td>
</tr>
</tbody>
</table>
### Time to resolution
Compares the length of time taken to resolve requests of type or priority

### SLA met v breached
Compares the number of requests that have met or breached an SLA goal

### Resolution by component
Compares the resolution times for each component (for basic service desks only)

### Incidents reports by priority
Compares the priority of incidents your customers have reported (for IT service desks only)

Besides the above, you can dig deeper. Why does your performance look like this? Create custom reports for your service desk and explore this question.

## Create custom reports

Custom reports, where you define the series, help you to find out more about why your performance is the way it is.

Series are a set of data points used to make reports. For example, a series could be the number of requests received on day 1, 2, 3 and so on for the past week. This would compare the difference in the number of requests received on each day of the week. While they can point out trends on their own, they’re more powerful when plotted together.

To create a custom report:

1. From your service project, go to **Reports**.
2. Select **New report**.
3. Choose a report name that you and your team will understand. For example, **High priority issues** would be a report that shows data on prioritized issues.
4. Click **Add a series**.
5. Fill in the following details: **Series**, **Label**, **Color**, and, optionally a filter.
6. Click **Add**.
7. Add more series to compare values.
8. Click **Create**.

Check out the recommended reports below to explore how reports benefit your organization. See examples of what series and their associated JQL filters may be useful to you. Read more about [Advanced searching through JQL](#).
Customer satisfaction report

One of the best measures of performance is your customers' happiness. Jira Service Management comes with reports on customer satisfaction, but a custom report can help you find more trends. First, be sure to collect customer satisfaction information on your requests. Learn how to enable customer satisfaction feedback.

Use the average rating customer satisfaction series to see how your team performs. For example, you can use issue types to investigate sections of your business.

To create a report to see if your customers are satisfied:

1. From your service project, go to Reports.
2. Click New report.
3. Enter "Customer satisfaction" as the Name.
4. Add the following series, then click Create:

   - **Series** = Average rating
   - **Label** = Bugs
   - **Filter by** (advanced) = issuetype = "Bug"

   - **Series** = Average rating
   - **Label** = Feedback
   - **Filter by** (advanced) = issuetype = "Feedback"

   - **Series** = Average rating
   - **Label** = Support
   - **Filter by** (advanced) = issuetype = "Support"

   - **Series** = Average rating
   - **Label** = New feature
   - **Filter by** (advanced) = issuetype = "New feature"

You might find some interesting results. For example, your response to feature requests may please your customers, but they aren't happy when they raise requests about billing. If you select a data point in the report you can look for feature words like "payment" or "credit card".

Details like these can expose your customers' pain points. Maybe your organization needs an easier to use billing form. Or perhaps you can be clearer about how much your products or services cost, or which credit cards you accept.
Requests created per channel report

Monitoring how your customers submit requests can give you useful insights. Are you getting more requests from email than from your customer portal? You can create a report to see how many requests customers create in each channel.

To create a report to track requests sent by portal and email:

1. From your service project, go to Reports.
2. Click New report.
3. Enter "Requests created per channel" as the Name.
4. Add the following series and click Create:
   - Series = Created
   - Label = Email
   - Filter by (advanced) = request-channel-type = email

Pyramid

Series = Created
Label = Portal
Filter by (advanced) = request-channel-type = portal

Series = Created
Label = Agent on behalf of customer
Filter by (advanced) = request-channel-type = Jira

The last series catches issues agents raise outside the portal.

How your customers request help might surprise you. You might find that your agents raise more and more requests on your customers' behalf. If so, you can find ways to direct customers to your portal or email channels. That way your agents have more time to resolve issues, rather than raise them.
Average resolution time by issue type report

Jira Service Management tracks requests by time. The time it takes your team to resolve a type of issue can show trends in your teams' efficiency.

To create a report to see your average resolution by issue type:

1. From your service project, go to Reports.
2. Click New report.
3. Enter "Resolution by issue type" as the Name.
4. Add the following series and click Create:
   - Series= Time to resolution (Avg.)
   - Label= General requests
   - Filter by(advanced) = "Customer Request Type" = "General requests"

   - Series= Time to resolution (Avg.)
   - Label= IT help
   - Filter by(advanced) = "Customer Request Type" = "IT help"

   - Series= Time to resolution (Avg.)
   - Label= Requests with approvals
   - Filter by(advanced) = "Customer Request Type" = "Request with approval"

You may find that IT help requests take more of your teams' time than general requests. Take into account how many IT help requests come through your service project. With this info, you can better divide your agents, and their time, to make your customers happier.
Regional trends report

If you service more than one location, you can cut out noise by viewing your regional performance. Start by adding labels to requests, identifying and helping to sort them into regions.

For example, if your business operated in New York and Rio de Janeiro, your service project agents can add a location label to requests from each region.

To create a report to see how many requests come from each location:

1. From your service desk project, go to Reports.
2. Click New report.
3. Enter “Requests by region” as the Name.
4. Add the following series and click Create:

   - Series = Created
   - Label = New York
   - Filter by (advanced) = labels = ny

   - Series = Created
   - Label = Rio
   - Filter by (advanced) = labels = rio

If you see an increasing trend in one location, you may decide to shuffle around resources. Maybe you've opened a new location without a dedicated service project team member, and the new location finds it difficult to ramp up operations. Perhaps you need to send someone to provide training? Or, maybe there's a language barrier with your knowledge base. You may consider providing support articles in more than one language.

You might see the opposite, a decline in requests coming from one location. Are people abandoning your service project? Do you need to make it clear that the service project operates for all locations?
Default service project configuration

Use this page as a reference for the default configuration of your service projects, including custom fields, permissions, and database tables.

- Custom fields
- Request types, issue types, and workflows
- Project permissions
- Security types
- Database tables

Custom fields

If required, Jira Service Management will create the following custom fields:

<table>
<thead>
<tr>
<th>Custom field</th>
<th>Type</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Viewport Origin</td>
<td>String value, storing the 'Portal' and 'Request Type' if a request was created through the customer portal.</td>
<td>Issues must have this field to be a service desk request.</td>
</tr>
<tr>
<td>Time to resolution</td>
<td>An SLA field, stored in JSON format.</td>
<td>This field stores SLA information for time until a request's resolution is set. See Setting up SLAs for more information.</td>
</tr>
<tr>
<td>Customer Request Type</td>
<td>String value</td>
<td>Issues must have this field to be a service desk request.</td>
</tr>
</tbody>
</table>

Request types, issue types, and workflows

The default issue types, request types, and workflows are different for each service desk project type. When you create a new service project, you can view these defaults by selecting Request types, Issues types, or Workflows from the Project settings menu.

Project permissions

At installation time, Jira Service Management creates a project permission called Jira Service Management agent access. Users who require full access to service desk projects or functionality need to have this permission.

This page shows the permission configuration for a standard service project permission scheme.

- To see an overview of how permissions are set up for a service project, see Permissions overview.
- If you want to customize the permission scheme, see Customizing Jira Service Management permissions.
- If you run into permission-related problems, see Resolving Jira Service Management permission errors.

Security types

Jira Service Management introduces the Service Desk Customer - Portal Access security type. A security type is a concept that allows restriction of users to certain permissions, examples of security types include project roles and groups.

Service Desk Customer - Portal Access is a special security type that only applies to users while they are viewing the customer portal; it was created specifically to allow customers to use the customer portal without giving them access to the internal service project view and your other Jira applications.
Database tables

When you set up Jira Service Management, the following tables will be created in your Jira application database.

**General Jira Service Management:**

- AO_54307E_AGENTSIGNAUTHRES
- AO_54307EASYNCUPGRADERECORD
- AO_54307ECAPABILITY
- AO_54307ECONFLUENCEKB
- AO_54307ECONFLUENCEKBENABLED
- AO_54307ECONFLUENCEKBLABELS
- AO_54307ECUSTOMGLOBALETHEME
- AO_54307ECUSTOMTHEME
- AO_54307EMAILCHANNELSETTING
- AO_54307EMAILSETTINGS
- AO_54307EGOAL
- AO_54307EGROUP
- AO_54307EGROUPTOREQUESTTYPE
- AO_54307EIMAGES
- AO_54307EMETRICCONDITION
- AO_54307EPARTICIPANTSETTINGS
- AO_54307EQUEUE
- AO_54307EQUEUECOLUMN
- AO_54307EREPORT
- AO_54307E SERIES
- AO_54307ESERVICEDESK
- AO_54307ESTATUSMAPPING
- AO_54307ETHRESHOLD
- AO_54307ETIMEMETRIC
- AO_54307EVIEWPORT
- AO_54307EVIEWPORTFIELD
- AO_54307EVIEWPORTFIELDVALUE
- AO_54307EVIEWPORTFORM

**Jira Email Processor Plugin:**

- AO_2C4E5C_MAILCHANNEL
- AO_2C4E5C_MAILCONNECTION
- AO_2C4E5C_MAILGLOBALHANDLER
- AO_2C4E5C_MAILHANDLER
- AO_2C4E5C_MAILITEM
- AO_2C4E5C_MAILITEMAUDIT
- AO_2C4E5C_MAILITEMCHUNK
- AO_2C4E5C_MAILRUNAUDIT

**Automation:**

- AO_9B2E3B_EXEC_RULE_MSG_ITEM
- AO_9B2E3B_IF_CONDITION_CONFIG
- AO_9B2E3B_IF_COND_CONF_DATA
- AO_9B2E3B_IF_COND_EXECUTION
- AO_9B2E3B_IF_EXECUTION
- AO_9B2E3B_IF_THEN
- AO_9B2E3B_IF_THEN_EXECUTION
- AO_9B2E3B_PROJECT_USER_CONTEXT
- AO_9B2E3B_RSETREV_PROJ_CONTEXT
- AO_9B2E3B_RSETREV_USER_CONTEXT
- AO_9B2E3B_RULE
- AO_9B2E3B_RULESET
- AO_9B2E3B.RuleSet_REVISION
- AO_9B2E3B_RULE_EXECUTION
- AO_9B2E3B_THEN_ACTION_CONFIG
- AO_9B2E3B_THEN_ACT_CONF_DATA
- AO_9B2E3B_THEN_ACT_EXECUTION
- AO_9B2E3B_THEN_EXECUTION
- AO_9B2E3B_WHEN_HANDLER_CONFIG
- AO_9B2E3B_WHEN_HAND_CONF_DATA

**Jira Timed Promises Plugin:**

- AO_F1B27B_HISTORY_RECORD
- AO_F1B27B_KEY_COMPONENT
- AO_F1B27B_KEY_COMP_HISTORY
- AO_F1B27B_PROMISE
- AO_F1B27B_PROMISE_HISTORY
Using Jira applications with Confluence

What is Confluence?

Confluence is a content creation and collaboration platform that connects teams with the content, knowledge, and coworkers they need to get work done, faster. Confluence spaces are great for creating and organizing rich content related to Jira projects using Confluence pages, meeting notes, project plans, requirements documents, release notes, roadmaps, and more.

Why use Confluence with Jira?

Here are some of the reasons we think you might like to add Confluence to your Jira instance:

<table>
<thead>
<tr>
<th>For a...</th>
<th>You can...</th>
</tr>
</thead>
<tbody>
<tr>
<td>Bug</td>
<td>Create a knowledge base article to document a workaround for a bug.</td>
</tr>
<tr>
<td>New Feature</td>
<td>Create a product requirements document for a new feature.</td>
</tr>
<tr>
<td>General Jira Use Case</td>
<td>Document and collaborate with your team on an issue in Confluence.</td>
</tr>
</tbody>
</table>

And here are just a few of the things Confluence allows you to do:

- Collaborative commenting, especially through the use of @mentions
- Share pages
- Watch pages
- Form a ‘team’ network and let them know what you are doing via a status update
- Add images, picture galleries, videos, and more
- Enable various content macros
Confluence features for Jira users

Here are some of the best features of Confluence that Jira users would benefit from.

Define product requirements

Many of our customers write product requirements using Confluence to plan new product features. TFS Requirements Blueprint helps development teams create, discuss, and organize their product requirements to link your product requirements in Confluence to Jira.

For more information, see Blueprints.

Team Calendars: Your Birds-Eye View of Jira

Surface everything your development team is working on in Jira to the teams that live in Confluence with Team Calendars.

- Timeline Calendar: View plans 3 months ahead of time.
- JQL Support: Track your versions, issues, and agile sprints.
- Date Ranges: Visualize issues over time to understand upcoming workload.

To install this feature, please visit Atlassian Marketplace.

Insert issues on any Confluence page using the Jira Issues macro
Any Jira search result can be embedded in a Confluence page using the **Jira Issues macro** with your choice of included fields and field ordering. With the Jira Issues macro, you can:

- Display a table of issues on your page, based on the results of a search using **Jira Query Language (JQL)** syntax or a Jira URL.
- Display a single issue from the Jira site, or a subset of selected issues from your Jira search results.
- Display a count of issues from the Jira site.
- Create a new issue on the Jira site and display that issue on your page.

**Autoconvert pasted issue links**

Autoconvert makes producing reports of issues, backlogs, and tasks as easy as copy and paste. With Jira and Confluence connected, you can paste individual issues or Jira query URLs into the editor and watch them immediately transform into the Jira Issues macro.

**Automatic links**

Whenever an issue is mentioned in a Confluence page using the Jira Issues macro, Jira will create an issue link to that page for you, automatically. Specs to issues, knowledge base articles to support tickets, project outlines to tasks, it all works.

**Gadgets**

You can embed a Confluence activity stream or a Confluence page in Jira's dashboard. Likewise, Jira gadgets can be rendered on a Confluence page.
Working on service projects

If you are an agent working on a Jira Service Management project, you’re in the right place!

If this is the first time you have used Jira Service Management, check out [Getting started for service agents](#) for a brief introduction to your new workspace.

If you’re familiar with Jira Service Management, use the search bar below to find any needed information.

<table>
<thead>
<tr>
<th>Working on issues</th>
<th>Tracking your work</th>
<th>Serving your customers</th>
</tr>
</thead>
<tbody>
<tr>
<td>• Work with issues</td>
<td>• Keep on top of SLAs</td>
<td>• Raise requests on behalf of customers</td>
</tr>
<tr>
<td>• Edit and collaborate on issues</td>
<td>• Set up dashboards</td>
<td></td>
</tr>
<tr>
<td>• Attach files and screenshots to issues</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
Working with issues

In Jira Service Management, customer requests are automatically triaged into queues, so you can easily find the issues you need to work on. If you are ready to jump in and learn more about working on and managing customer issues, you’re in the right place. This page introduces you to the concept of an issue. You can then learn more about creating, editing, and collaborating issues in the Next steps section.

What is an issue?

Different organizations use Jira applications to track different kinds of issues, which can represent anything from a software bug, a project task, to a leave request form.

In Jira Service Management, an issue is a packet of work that agents work on. In an IT service desk, it represents an incident, a change, and a service request, etc. For example, a customer request of “Our printer is not working” appears as follows in the customer portal:

![Customer Portal Example](image)

As an agent, you will pick the issue up internally in the service desk project to work on and it will look like the following:

![Agent Portal Example](image)

The **History** tab of an issue records the following information: creator of the issue (this may be the same as the reporter, but can be distinct), changes to an issue field, attachment of a file, deletion of a comment, deletion of a worklog, creation or deletion of an issue link.

The **Activity** tab has the same information, plus additional information, such as comments. However, this may load more slowly, especially if there has been a lot of activity on the issue.
Next steps

Check out the following pages to reach issue ninja status:

- Creating issues and sub-tasks
- Attaching files and screenshots to issues
- Editing and collaborating on issues
- Logging work on issues
Attaching files and screenshots to issues

To share information with your customers, you can attach documents, images, and screenshots to your Jira Service Management issues. You can also restrict attachments to be viewed by your internal team only.

Before you begin

A Jira admin must enable specific user permissions so that you can add attachments and screenshots to issues. The most common permissions are described below. To learn more about this check out Configuring file attachments.

Jira admin set permissions

- You can attach files and screenshots if your Jira admin has enabled file attachments.
- You need the Create attachments permission in the appropriate projects.
- If your Jira admin has disabled thumbnails in Jira's attachment settings, the image files will appear as a list.
- If your Jira admin has disabled ZIP support in Jira's attachment settings, the attachments feature will not be available. You must download the file to your computer before accessing its individual files.
- To remove attachments from an issue, you need one of the following project permissions in that issue's project:
  - Delete own attachments to delete files that you have added to the issue.
  - Delete all attachments to delete files that anyone has added to the issue.
- If you're using Google Chrome, Mozilla Firefox, or Internet Explorer 11, attaching screenshots relies on HTML5 compatibility.

Add attachments

You can add files and images to any issue in your service desk project.

1. When working on an issue, drop a file onto the issue or select browse.
2. Add a comment with more information about the attachment (optional).
3. Share the file and comment with your customer, or with your internal team only.
When adding or editing a comment you can also select to add attachments. In this case, you'll see wiki markup added to the comment field. As soon as you share your comment, you'll see the file preview.

Some considerations for attached files:

- File formats: GIFs, JPGs, PNGs
- File names can't contain any of these characters: ",`, '/', '\', '%', ':', '$', '?', '*'.
- By default, the maximum size of any one file is 10MB, although this limit can be customized by your Jira admin.

Sort and manage attachments

The attachments section of the issue displays a list of options to sort, manage, and download attachments.

1. Select the three dots to the right of the attachments section to open the menu.
2. Reorder the attachments according to a selected criteria. This criteria will be applied to all issues in your project, and will be lost once you log out.
3. To remove attachments from the issue, select Manage attachments or hover over the attachment and select the bin icon.
Access ZIP file contents

You can view the contents of a ZIP file (including `.zip` or `.jar` file name extensions) in the attachments section.

1. Click the three dots and select **List**.
2. In list view, click the arrow icon in front of the zipped file's name to view and download its individual files.
3. To download the entire zip file, click **Download Zip**.

Capture and attach screenshots

You can capture a screenshot to the system clipboard and paste it directly onto an issue.

1. Capture a screenshot using your system keyboard shortcut.
2. Paste the image from your clipboard onto the issue using your system keyboard shortcut or right-click menu. The **Attach screenshot** dialog will display.
3. Enter a unique filename for each file.
4. Select **Upload**.
Creating issues and sub-tasks

The building blocks of any project are issues. Issues act as the packets of work that travel through their respective workflows within their projects, until the work is completed. An issue may also have sub-tasks that can be assigned and tracked individually, as well as issue level security to restrict the issue to select members of your team.

On this page, you'll learn more about creating and converting issues and sub-tasks, and setting issue level security. If you are looking to import multiple issues (and sub-tasks) using a CSV file, you can find the import process explained in more detail here.

Before you begin

You need the Create Issue project permission for the issue's relevant project.

Creating an issue

1. Select Create at the top of the screen to open the Create Issue dialog box.
2. Select the relevant Project and Issue Type in the Create Issue dialog box.
3. Type a Summary for the issue and complete any appropriate fields at least the required ones that are marked by an asterisk.
   
   If you want to access fields that are not shown in this dialog box, or you want to hide existing fields:
   a. Select the Configure Fields button at the top right of the screen.
   b. Select Custom and select the fields you want to show or hide by selecting or clearing the relevant check boxes respectively, or select All to show all fields.
   
   When you next create an issue, these selected fields will be displayed.
4. Optional: To create a series of similar issues with the same Project and Issue Type select the Create another checkbox at the bottom of the dialog. Depending on your configuration and the values you may have specified when creating previous issues, some of the fields in the new Create Issue dialog box may be pre-populated. Make sure you check they're all correct before creating the next issue.
5. When you are satisfied with the content of your issue, select the Create button.

Cloning an issue

Cloning an issue lets you quickly create a duplicate of an issue within the same project. The cloned issue contains most of the same details stored in the original issue e.g. Summary, Affects Versions, Components, etc. Other details are not cloned e.g. Work Log, Comments, Issue history, and Links to Confluence pages. The issue status also returns to the first step of the corresponding workflow, and the resolutions are cleared. The cloned issue can be linked to the original issue, but does not have to be.

Note that, if you don't have the Modify reporter permission, the clone issue will be created with Reporter as the current user cloning the issue.

1. Open the issue you wish to clone.
3. You can edit the clone issue's Summary if you want.
4. If applicable to the issue you are cloning, you can also select from these options:
   - Clone sub-tasks to copy existing sub-tasks
   - Clone attachments to add any existing attachments
   - Clone links to add any existing linked issues
   - Clone sprint values to copy across the issue's current and closed sprint values
5. Select Create.

Creating a sub-task

A sub-task can be created for an issue to either split the issue into smaller chunks, or to allow various aspects of an issue to be assigned to different people. If you find a sub-task is holding up the resolution of an issue, you can convert the sub-task to an issue, to allow it to be worked on independently. If you find an issue is really just a sub-task of a bigger issue, you can also convert an issue to a sub-task.
1. Navigate to the issue you would like to be the parent issue of the sub-task you are about to create.
2. Select More > Create sub-task. You will see the Create sub-task screen.
3. Fill in the details as needed, and then select Create at the bottom of the page.

Note that when you create a sub-task, the following values are inherited from the parent task:

- project
- issue security level
- sprint value, if any (only for Jira Software issues)

**Tip:** You can customize the Create sub-task screen to show fields you use most often. To do this, select Configure fields at the top right corner of the dialog, and use the All and Custom links to switch between the default screen and your custom settings. Your changes are saved for future use.

Converting a sub-task to an issue

1. Navigate to the sub-task issue you would like to convert.
2. Select More > Convert to issue.
3. In the Step 1. Select Issue Type screen, select a new issue type (i.e. a standard issue type) and select Next.
4. If the sub-task's current status is not an allowed status for the new issue type, the Step 2. Select New Status screen is displayed. Select a new status and select Next.
5. In the Step 3. Update Fields screen, you will be prompted to enter any additional fields if they are required. Otherwise, you will see the message 'All fields will be updated automatically'. Select Next.
6. The Step 4. Confirmation screen is displayed. If you are satisfied with the new details for the issue, select Finish.
7. The issue will be displayed. You will see that it is no longer a sub-task, that is, there is no longer a parent issue number displayed at the top of the screen.

Converting an issue to a sub-task

1. Navigate to the issue you would like to convert.
2. Select More > Convert to sub-task.
3. In the Step 1. Select Parent Issue and Sub-Task Type screen, type or select the appropriate parent issue type and the new issue type (i.e. a sub-task issue type). Select Next.
4. If the issue's current status is not an allowed status for the new issue type, the Step 2. Select New Status screen is displayed. Select a new status and select Next.
5. In the Step 3. Update Fields screen, you will be prompted to enter any additional fields if they are required. Otherwise, you will see the message 'All fields will be updated automatically'. Select Next.
6. The Step 4. Confirmation screen is displayed. If you are satisfied with the new details for the issue, select Finish.
7. The issue will be displayed. You will see that it is now a sub-task, that is, its parent's issue number is now displayed at the top of the screen.

**Note:** You will not be able to convert an issue to a sub-task if the issue has sub-tasks of its own. You first need to convert the issue's sub-tasks to standalone issues; you can then convert them to sub-tasks of another issue if you wish. Sub-tasks cannot be moved directly from one issue to another; you will need to convert them to standard issues, then to sub-tasks of their new parent issue.

Restricting access to an issue

When creating (or editing) an issue, you can restrict access to that issue to members of your team who are part of a chosen security level. To be able to set the security level for an issue, your administrator must add you to the appropriate issue security level, and also grant you the 'Set Issue Security' permission for the appropriate projects.

1. Create/edit the relevant issue.
2. In the **Security Level** drop-down field, select the desired security level for the issue. You will only see the security levels you belong to.

3. Save the issue. It is now only accessible to members of the specified security level. Users who are not members of this security level will not be able to access that issue, or see it in any filters, queries, or statistics.
Creating issues using the CSV importer

If you have the Create Issue project permission and the Bulk Change global permission for the relevant projects, you can create issues in bulk by using a comma-separated value (CSV) file. To find out what permissions you have, contact your Jira admin.

CSV files are text files that represent tabulated data and are supported by most applications that handle tabulated data, such as Microsoft Excel, Numbers, and databases.

Jira’s CSV importer (also CSV file import wizard) allows you to import data from external systems that export their data in a tabulated format. Also, you can create your own CSV file to bulk create or update issues.

There are two main steps to use the CSV importer:

1. Preparing your CSV file
2. Running the CSV import wizard

Preparing your CSV file

The CSV importer assumes that your CSV file is based off a default Microsoft Excel-styled CSV file:

- Fields are separated by commas
- Any content that must be treated literally, such as commas, new lines/ (e.g. "carriage returns"), or angle brackets, are enclosed in quotes

For Microsoft Excel and OpenOffice, you don’t need to place cell values in quotation marks. These applications do this automatically.

CSV file requirements

In addition to being “well-formed”, your CSV file should meet the following requirements:

- The file must have a header row. The CSV Importer uses the header row to determine how to map data from the CSV file’s second row and beyond to Jira fields.
- The header row must contain the Summary column for the issues summary.
- The header row shouldn’t contain any punctuation, except for commas separating columns or fields. Otherwise, the import may work incorrectly.
- Commas as column or field separators can’t be omitted throughout the file.

```
Summary, Assignee, Reporter, Issue Type, Description, Priority
"Test issue", admin, admin, 1, ,
```

```
Summary, Assignee, Reporter, Issue Type, Description, Priority
"Test issue", admin, admin, 1,
```
Encapsulating Jira data structure in your CSV file

To import issues correctly, you should know how to encapsulate different data in your CSV file. In this way, Jira will be able to process them and create or update issues correctly.

Here, you'll find tips on and examples of building a CSV file with multiple-line fields, special characters, multiselect fields, and many more.

Learn more about the specifics of issue fields in Tips for importing CSV data into issue fields.

Capturing data that spans multiple lines

Use double quotation marks (""") in your CSV file to capture data that spans multiple lines. For example, during the import, Jira will treat the following as a valid CSV file with a single record:

```
Summary, Description, Status
"Login fails", "This is on a new line", Open
```

Treating special characters literally

Put the text with special characters in double quotation marks (""") to treat these characters literally. Once imported to Jira, these special characters will be stored as part of Jira's field value. Examples of special characters include carriage returns/enter characters, commas, etc.

If the text contains words or phrases in quotation marks and you want Jira to treat these quotation marks literally, put these words or phrases in another pair of quotation marks.

Example:

```
"Clicking the "Add" button results in a page not found error"
```

The name of the button is stored in one pair of quotation marks, as it should be.

Aggregating multiple values into single issue fields

You can import multiple values into an issue field that accepts multiple values. For example, `Fix (for) Version, Affects Version, Component, Labels`. To do this, your CSV file must specify the same column name for each value you wish to aggregate into the mapped issue field. The number of column names must match the maximum number of values to be aggregated into the mapped field.

For example:

```
IssueType, Summary, FixVersion, FixVersion, FixVersion, Component, Component
bug, "First issue", v1, , , Component1,
bug, "Second issue", v2, , , Component1, Component2
bug, "Third issue", v1, v2, v3, Component1,
```

In this example, the `Component` field of the second issue and the `Fix Version` field of the third issue will generate multiple values in appropriate issue fields after the import.

⚠️ Be aware that only a limited number of issue fields support multiple values. The CSV importer will not allow you to import aggregated data into issue fields that only support a single value.

Importing issues into multiple projects

You can import issues from your CSV file into different projects through a CSV file import. To do this:
The CSV file must have two additional columns with the exact names of Project Name and Project Key. These are the mandatory values required for the correct import of issues from the CSV file to specific Jira projects.

Ensure that every issue represented in your CSV file contains the appropriate name and key in these columns for the projects to which they will be imported.

For example:

<table>
<thead>
<tr>
<th>Issue Type, Summary, Project Name, Project Key</th>
</tr>
</thead>
<tbody>
<tr>
<td>bug, &quot;First issue&quot;, Sample, SAMP</td>
</tr>
<tr>
<td>bug, &quot;Second issue&quot;, Sample, SAMP</td>
</tr>
<tr>
<td>task, &quot;Third issue&quot;, Example, EXAM</td>
</tr>
</tbody>
</table>

In this example, the first and second issues will be imported into the "Sample" project (with project key "SAMP") and the third issue will be imported into the "Example" project (with project key "EXAM"), assuming you match the "Project Name" and "Project Key" fields in your CSV file to the Project name and Project key issue fields respectively during the CSV file import wizard.

Importing work log entries

Your CSV file can contain work log entries. You need to use seconds to track the time spent. For example:

<table>
<thead>
<tr>
<th>Summary, Worklog</th>
</tr>
</thead>
<tbody>
<tr>
<td>Only time spent (one hour), 3600</td>
</tr>
<tr>
<td>With a date and an author, 2012-02-10 12:30:10; wseliga; 120</td>
</tr>
<tr>
<td>With an additional comment, Testing took me 3 days; 2012-02-10 12:30:10; wseliga; 259200</td>
</tr>
</tbody>
</table>

Importing to multi select custom fields

Your CSV file can contain multiple entries for the one multi select custom field. Here is an example showing how to populate the multi select custom field with multiple values:

<table>
<thead>
<tr>
<th>Summary, Multi Select, Multi Select, Multi Select</th>
</tr>
</thead>
<tbody>
<tr>
<td>Sample issue, Value 1, Value 2, Value 3</td>
</tr>
</tbody>
</table>

Importing cascading choice custom fields

You can import values to a custom field with cascading choice by using the following syntax:

<table>
<thead>
<tr>
<th>Summary, My Cascading Custom Field</th>
</tr>
</thead>
<tbody>
<tr>
<td>Example Summary, Parent Value -&gt; Child Value</td>
</tr>
</tbody>
</table>

The separator allows you to import the hierarchy.

Currently Jira does not support importing multi-level cascading select fields via CSV ( JRASERVER-34202 - Allow CSV import to support Multi-Level Cascading Select plugin fields ).
Running the CSV file import wizard

If your Jira installation has existing data, you should back it up before proceeding with the following steps.

To import a CSV file with your Jira issues:

1. Select **Issues > Import Issues from CSV** to open the **Bulk Create Setup** page. If you do not have the option **Import issues from CSV**, your Jira admin must update the Jira Importers plugin to version 6.2.3 or above.

2. On the **Bulk Create Setup** page, select your **CSV Source File**. Leave the **Use an existing configuration file** checkbox cleared if you do not have a configuration file or if you want to create a new configuration file. Configuration files specify a mapping between column names in your CSV file's header row and fields in Jira.

3. Select **Next** to proceed to the **Settings** step of the CSV file import wizard.

4. On the Settings page, populate the required fields and select **Next**.

   - **Import to Project**: select a project where you want to create or update issues.
   - **File encoding**: the type of character encoding in your CSV file.
   - **Delimiter**: a character that separates columns or fields in your CSV file. If your delimiter is a tab, specify it as "/t".
   - **Date format**: the format of dates in your CSV file.
5. On the **Map fields** page, map the fields from your CSV file to issue fields in the selected project. If you also want to map values of these fields, select the **Map field value** checkbox. After you finish, select **Next**.

6. On the **Map values** page, you can check and reset the target values of the issue fields for which you've selected the **Map field value** checkbox on the previous page. If you haven't selected the checkbox, proceed to the next step.

   **Example:**
   Your issue types may have a CSV field value of **Feature Request**, which you may want to map to the issue type field value **Feature**.

   - On this page, you'll see all values of all fields for which you've selected the **Map field value** checkbox on the **Map fields** page.
   - If you want a field to be empty after the import, select **Import as blank** in **Target value in Jira**.
7. You may want to check your configuration for errors or warnings before running the import. To do it, select Validate. If your file contains warnings or errors, we recommend fixing them and uploading the file again. To learn more, download the detailed log of the validation.

If you need to import another CSV file with the same (or similar) settings to what you used through this procedure, select the save the configuration link to download a CSV configuration file, which you can use at the first step of the CSV file import wizard. For example, you may want to use the same field or value mappings for the next imports.

8. When you're sure about the correctness of data in your CSV file, select Begin Import. The importer will display updates as the import progresses, then a success message when the import is complete. After the import is completed, you can check the created or updated issues in Jira. Also, you can download the detailed log of the import or save the configuration for future use.

9. Congratulations! You have successfully imported your CSV data into Jira! If you have any questions or encounter any problems, contact Atlassian support.

Tips for importing CSV data into issue fields

Here are some helpful tips on importing data from your CSV file into specific issue fields:

<table>
<thead>
<tr>
<th>Issue field</th>
<th>Import notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Project</td>
<td>CSV data is imported on a per-project basis. You can either specify an existing projects as the target, or the importer will automatically create new projects during the import.</td>
</tr>
<tr>
<td>Summary</td>
<td>This is the only required field.</td>
</tr>
<tr>
<td>Component(s)</td>
<td>Import issues with multiple components by entering each component in a separate column.</td>
</tr>
<tr>
<td>Affects Version(s)</td>
<td>Import issues with multiple Affects Versions by entering each version in a separate column.</td>
</tr>
<tr>
<td>Fix Version(s)</td>
<td>Import issues with multiple Fix Versions by entering each version in a separate column.</td>
</tr>
<tr>
<td>Due Date</td>
<td>Make sure to use the date format specified on the second step of the CSV import wizard: dd/MMM/yy h:mm a.</td>
</tr>
<tr>
<td>Issue Type</td>
<td>If not specified in your CSV file, imported issues will be given the default (i.e. first) Issue Type as specified in your Jira system. For more information, see Defining issue type field values. You can also create new values on the fly during the import process.</td>
</tr>
<tr>
<td>Labels</td>
<td>Import issues with multiple labels by entering each label in a separate column or by putting all labels in one column, delimited by a space.</td>
</tr>
<tr>
<td>Priority</td>
<td>If not specified in your CSV file, imported issues will be given the default (i.e. first) Priority as specified in your Jira system. For more information, see Defining priority field values.</td>
</tr>
</tbody>
</table>
You can also create new values on the fly during the import process.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Original Estimate</td>
<td>Set this value as a total number of seconds.</td>
</tr>
<tr>
<td>Remaining Estimate</td>
<td>Set this value as a total number of seconds.</td>
</tr>
<tr>
<td>Users</td>
<td>Choose to automatically create Jira users for any values of the Assignee or Reporter field.</td>
</tr>
<tr>
<td></td>
<td>- Users will be created as active accounts in Jira. Users should receive emails with passwords for the first-time login to Jira.</td>
</tr>
<tr>
<td></td>
<td>- To create full names for users with no real names, Jira will take the part of their email addresses before the @ character.</td>
</tr>
<tr>
<td></td>
<td>- If you are using external user management system, Jira users won't be created during the import. Instead, the import wizard will give you a list of any new users that need to be created. You will need to create the users in your external user repository before running the import.</td>
</tr>
<tr>
<td></td>
<td>- If you have a user-limited license (a personal license), and the number of users is larger than the limit, then the import will be stopped. You'll see the list of users that can't be created.</td>
</tr>
<tr>
<td></td>
<td>- If Assignee and Reporter aren't mapped, no usernames will be created.</td>
</tr>
<tr>
<td>Other fields</td>
<td>If you wish to import any other fields, you can choose to map them to one or multiple Jira custom fields. If your custom fields don't exist yet in Jira, the importer can automatically create them for you.</td>
</tr>
<tr>
<td></td>
<td>If your custom field is a date field, please use the date format specified in the second step of the CSV import wizard: dd/MMM/yyyy h:mm a.</td>
</tr>
</tbody>
</table>

If you aren’t a Jira administrator, you won’t be able to map the following fields in the CSV file to their equivalents in Jira:

- Attachments
- Comment Body
- Date Created
- Date Modified
- Date Resolved
- Project Key
- Project Name
- Project Type
- Resolution
- Status
- Worklog

To complete the field mapping, select either any other available field or the **Dont map this field** option.

**Known issues**

In case your issues get created but the multi-select fields are not populated, contact your admin. They can rerun the import by using Jira admin tools.

CSV import may run incorrectly for a project with only one issue type and a required custom field with context. For details and the workaround, see JRASERVER-41584.
Editing and collaborating on issues

Resolve your customer requests more efficiently with these tips and tricks for editing and collaborating on Jira Service Management issues.

In addition to learning about the basics of editing and commenting on an issue, you can refer to this page for help with:

- Using the wiki toolbar to make your comments and descriptions pop
- Sharing issues with your team and adding request participants
- Keeping track of issues with labels and issue watchers

Attaching files and screenshots

If your administrator has enabled file attachments, you and your customers can attach files and screenshots to issues you’re working on. See Attaching files and screenshots to issues for more information.

Collaborating on issues

Sharing issues with other users

You can easily keep your team informed by sharing issues with them via email.

To share the issue:

1. In the upper-right corner of the screen, select the Share button.
2. Enter usernames or emails of users that you want to share the issue with.
3. Select Share.

If your administrator has enabled anonymous access to your project, you can also share issues by entering the email address of a non-Jira user.
You can easily keep your team informed by using the Share button to share an issue with other Jira users. If your administrator has enabled anonymous access, you can also share issues by entering the email address of a non-Jira user. In Jira Service Management, your administrator can also enable Request participants, which will appear as another issue field. You can add other agents and customers from your service desk project to help you resolve the original customer’s request.

**Mentioning users on issues**

If you want to invite members of your team to help you work on an issue, you can mention them by typing @ and their usernames in the issue description or comment.

People already involved in the issue, like the reporter or a commenter, will be listed first in the user list so you can select them faster. Note that the users you mention will be notified once you save the issue description or comment.

**Editing issue details**

To edit an existing issue, select Edit to open the Edit Issue dialog box and modify the issue details. If you want to change the fields you need to edit, select Configure fields > Custom and choose the fields you want to show or hide. Select Update to save your changes.

**Commenting on issues**

To add comments to an issue, you must have the following permissions for the relevant project:

- **Browse project** permission to view the issue you want to comment on.
- **Add comments** permission to add a comment to the issue. Without this permission, you won’t see the Comment button.

You can add and manage comments in the issue view:

1. Edit, delete, or pin comments.
2. **Sticky comment footer:** Add a new comment to an issue.
3. **Sort comments:** Display comments from newest or oldest first, or vice versa.
Add a comment

Open the issue you want to comment on and start typing your message in the sticky comment footer.

In Jira, you automatically become a watcher of the issues that you’ve commented on. To disable this:

1. Select your user name in the upper right corner of the screen, then select Profile.
2. In the Preferences section, set Autowatch to Disabled.

Delete a comment

Open the issue you’ve commented on, find the comment you want to remove, and then select Delete at the bottom of the comment. Confirm that you want to remove this comment from the issue by selecting Delete when prompted.

You can’t delete comments added by other users.

Edit a comment

Open the issue, select Edit at the bottom of your comment, and edit the text or restrictions (Viewable by...) as needed. When you save your revised comment, you’ll see the text edited next to the comment date, indicating that the comment has been edited.

You can hover over edited to see who edited the comment and when.

Link to a comment

Right-click on the comment timestamp, and then copy the link address. Paste the copied permanent link into your email or chat message.

Clicking the permanent link takes you to that particular comment in the Jira issue. If your Jira issue contains an extensive list of comments, the issue page will automatically be scrolled down so that the linked comment is visible.

Restrict a comment

Select Comment internally (for other internal agents and collaborators) or Share with customer (for customers) tab.

Canned responses for comments

Canned responses allow you to create, edit and manage responses that you can then use at any time, directly from the view issue screen. All agents in your project have access to the canned responses saved, so your colleagues can take advantage of your saved responses, and you can take advantage of theirs. Some typical examples of canned responses could be:

- a request for more information from the customer,
- an short message confirming work in ongoing and the next update will be in 24 hours, or
- a lengthy response asking a customer to accept terms and agreements before you continue with the work.

You can access your canned responses when adding a comment by selecting the canned responses icon. You can add a response directly from the Popular or Frequently used menu, or you can search for your response by typing the name in the search field, and selecting it. The canned response will be added to the comment field. Feel free to further edit your comment, it won’t be added to the issue until you add the comment.

To edit a canned response, select > Edit responses, select the response you’d like to change and click Edit.
To add a canned response, you can either start with the text you've already added to the comment field, or with a blank comment field. Select > **Save as a response**, and complete the form with a name for your response, the response, and then select **Save**.

**Using variables in canned responses**

A variable is a powerful way to customize your response. Using a variable in your response allows the response to automatically contain information related to the issue. For example, you may want to personalize your response by adding the reporter's name, or by adding the issue key. The current list of variables are shown on the image below:

```
Hello ${issue.reporter.name},
Thanks for logging ${issue.key}. To take this further, we need a little more information.
Could you please give us:
  * The time and date of the event
  * How many people are attending
  * Your cost centre

Thanks!
```

**Formatting text with wiki markdown**

**Jira application** allows you to use rich-text features, such as:

- Italic, bold, underlined text
- Multiple levels of headings
- Bullets, numbered lists, tables, and quotations
- Images
- Macros

When you edit an issue description, comment, or any rich-text field, you can expand the simple wiki editor toolbar to format your text and select **preview** to see how your formatted text will appear. Note that your Jira administrator can enable, disable and configure the renderer which allows you to use wiki markdown, so your options may vary slightly.

**HTML macro**

When using the HTML macro, which allow you to add HTML code to an issue, you should only use formatting as if you are including something inside the `{{<body>}}` directly. This prevents you from accidentally breaking the page formatting, or overriding Jira's CSS.

Note that if you're administrator has enabled the rich text editor, you'll still be able to format your content using wiki markdown, but if you select the **visual editor**, you'll see the markdown applied directly.

**Tracking issues with labels**
Labeling helps you categorize and search for an issue. When viewing an issue, select **More > Labels** to add or remove labels, which will appear in the Details section:

<table>
<thead>
<tr>
<th>Details</th>
</tr>
</thead>
<tbody>
<tr>
<td>Type: Task</td>
</tr>
<tr>
<td>Priority: Medium</td>
</tr>
<tr>
<td>Affects Version/s: None</td>
</tr>
<tr>
<td>Component/s: Engine</td>
</tr>
<tr>
<td>Labels: DOC</td>
</tr>
</tbody>
</table>

You can click a label (e.g. `doc` in the above screenshot) to jump to the Issue Navigator and see a list of all issues that have this label. You can also add the **Labels Gadget** to your dashboard to quickly find issues with labels relevant to you and your team.

**What permissions do you need?**

To view other users watching or voting for an issue, you need the **View Voters and Watchers** and **Manage Watcher List** project permissions.

If your administrator has set up the needed notification scheme, you can select **Start watching this issue** to be automatically notified of issue updates. You can also click the number of watchers on the issue to add other Jira users as watchers.

If your administrator has enabled the voting on issues, you can select **Vote for this issue** to encourage the responsible team to resolve or complete the issue.

**Reordering sub-tasks on an issue**

If you’ve added sub-tasks to an issue, and need to reorder them, you can drag and drop them on the issue navigator view of the parent issue. If you’re using a board in Jira Software, you can also reorder the sub-tasks on the board view. However, these two methods are independent of each other. Reordering sub-tasks on the parent issue will not reorder tasks on an existing board, and vice-versa.
Linking issues

Issue linking allows you to create an association between two existing issues on either the same or different Jira servers. For example:

- An issue may *relate* to another.
- An issue may *duplicate* another.
- An issue may *block* another.

Issue linking also allows you to:

- Create a new linked issue from an existing issue in a service desk or business project.
- Create an association between an issue and a Confluence page.
- Link an issue to any other web page.

Your Jira administrator can customize the types of links that you can create, see *configuring issue linking*.

Issue links within an issue look like this:

![Issue Links Example](image)

**Note:** Resolved issues (i.e. issues with a Resolution set) are displayed in strike-through font, e.g. DEMO-1.

To create links on issues, you need to have the Link Issues permission in the project(s) to which the issues belong.

Creating a link to another issue on the same Jira site

1. Open the issue you wish to link to another issue in the same Jira site.
2. Select More > Link to display the Link dialog box.

3. Ensure that the Jira Issue item is selected at the left of the dialog box and then choose the type of link to be created from the This issue drop-down list.

   If your Jira system administrator has configured fully reciprocal application links between your Jira site and another one, a Server drop-down list may appear above the This issue list. If this is the case, ensure your Jira site appears or has been selected from the Server list.

4. In the Issues field, specify the issue(s) to be linked to your currently viewed/selected issue. There are two ways to do this:
   - Type the full issue key (e.g. ABC-123) or to link to multiple issues, press the 'Enter' key between each typed issue key.
   - If you have previously browsed an issue, you can quickly find the issue by typing the first few letters of the issue key (or part of the Summary), which will appear in an 'autocomplete' drop-down list for selection:
     OR:
   - Click the search for an issue link to use the Find Jira issues popup, which allows you to perform either a simple text search or an advanced search for issues.

5. Optional: Add a Comment to describe why you are linking these issues.

6. Click the Link button at the bottom of the dialog.

Creating a link to an issue on another Jira site

To create this type of link, your Jira system administrator should have configured fully reciprocal application links between your Jira site and the other Jira site containing the issue(s) you want to link to.

1. Open the issue you wish to link to another issue.
2. Select More > Link to display the Link dialog box.
3. Ensure that the Jira Issue item is selected at the left of the dialog box.

   Note:
   - This option will not be available if your Jira system administrator has not configured an application link between your Jira site and the remote Jira site.
   - If, after selecting this option, you are prompted for authorization, you may be required to log in to the remote Jira site, which will allow your Jira site to access the remote Jira site on behalf of your account on the remote Jira site.
   - This behavior means the application links configured between your Jira site and the remote Jira site use OAuth authentication.

4. If your Jira site is connected to multiple remote Jira sites, choose the relevant Jira site from the Server drop-down list.
5. Choose the type of link to be created from the **This issue** drop-down list.
6. Type the **issue** key of the issue on the remote Jira site that you want to link to. Alternatively, you can search for issues on the remote Jira site by clicking the **search for an issue** link, which opens the **Find Jira issues** popup.

   You can link to any issue on the remote Jira site to which you have access on that site.

7. Select the **Create reciprocal link** checkbox to create the complementary link on the remote issue you are linking to, back to your issue. For example, if you create a block link type to a remote issue, the reciprocal link generated on the remote issue will be an **blocks** link type back to your local issue.

8. Optional: Add a **Comment** to describe why you are linking these issues.

9. Click the **Link** button at the bottom of the dialog.

**Troubleshooting**

**Problem:** If you selected the **Create reciprocal link** checkbox, but after clicking the **Link** button, you discover that a reciprocal link from the remote issue back to your issue has not been created, then your Jira system administrator has most likely created only a one-way link from your Jira site to the remote Jira site.

**Solution:** Ask your Jira system administrator to configure fully reciprocal application links between your Jira site and the remote Jira site.

**Problem:** If you attempted to create a reciprocal link but received the following message:

'A reciprocal link from issue 'XYZ-123' back to this issue was not created as the remote Jira server returned the following error: No Link Issue Permission for issue 'XYZ-123'.' (where 'XYZ-123' is the issue key on the remote Jira site),

then a reciprocal link on the remote Jira site will not have been created, because the user account through which you authenticated on the remote Jira site (at step 3 above) does not have the Link Issues project permission.

**Solution:**

- Ask the Jira project administrator(s) on the remote Jira site to grant your user account the Link Issues project permission for the relevant project(s) to which you need to create issue links.
- Alternatively, if the application link between your Jira site and the remote Jira site use OAuth authentication and you suspect you may have authenticated on the remote site with another user account that does not have the Link Issues project permission, repeat the procedure above but during the authentication step (at step 3), authenticate on the remote site with a user account which has this permission.

   If you are not prompted for authentication during authorization, try clearing your browser’s cookies first and repeat the procedure again.

Create a new linked issue from an existing issue in a service desk or business project

To create a linked issue, you need to have Create issue and Linked Issues permissions in the destination project(s).

To create a linked issue:

1. Open the issue from which you wish to create the linked Jira issue.
2. In the Issue screen, select **More > Create linked issue** to display the **Create Linked Issue** dialog box. The newly created linked issue contains the same Project, Issue Type, and Summary information stored in the original issue. It is also linked to the service desk issue, in this case CTF-2.

![Create linked issue dialog box](image)

3. Select the destination **Project** in which the new linked issue is to be created.
4. Select the correct Issue Type for the new linked issue.
5. In the **Linked issues** field, specify issue(s) to be linked to your new linked issue.
6. Edit the linked issue **Summary**.
7. Edit the **Description** and describe why you are linking these issues.
8. Select the **Copy attachments** checkbox to include any attachments from the original issue.
9. Select the **Copy links** checkbox to include any URLs from the original issue.
10. Click the **Create** button at the bottom of the dialog.

Your linked issue has now been created.

### Creating a link to a Confluence page

⚠️ This feature is only supported in Confluence versions 4.0 or later.

To create this type of link, your Jira system administrator needs to have configured an **application link** between your Jira site and the Confluence site containing the pages you want to link to.

1. Open the issue you wish to link to another issue.
2. Select **More > Link** to display the **Link** dialog box.
3. Click the **Confluence Page** option at the left of the dialog box.
   ⚠️ This option is not available if your Jira system administrator has not configured an application link between your Jira site and Confluence site.
4. If more than one application link has been configured between your Jira site and other Confluence sites, then choose the appropriate Confluence site from the **Server** drop-down list.
5. Specify the Confluence page to be linked to your currently viewed issue. There are two ways to do this:
   - In the **Page URL** field, enter the URL of a page on the Confluence site you want to link to. For example:
     
     ```
     http://<confluence-server>/display/ds/Welcome+to+the+Confluence+Demonstration+Space
     ```
• Click the search for a page link. The Link dialog box is replaced by the Find a Confluence page dialog box.

If you are prompted for authorization, you may be required to log in to the Confluence site, which will allow your Jira site to access the Confluence site on behalf of your account on the Confluence site.

This behavior means the application links configured between your Jira site and the remote Confluence site use OAuth authentication.

a. In the first Search field, specify one or more search terms that appear in the page you want to link to. This field is mandatory.

b. Optional: In the second Search field, select the Confluence space to further narrow down the search.

c. Click the Search button and then the title of the page you want to link to.

6. Optional: Add a Comment to describe why you are linking these issues.

7. Click the Link button at the bottom of the dialog.

Troubleshooting

Problem: If Confluence page links you create show Failed to load on the issue or if you attempted to search for a Confluence page but received the following message:

‘Content on the Confluence site could not be accessed because the Confluence server’s ‘Remote API’ feature is disabled. The Confluence system administrator must enable this ‘Remote API’ feature for Jira to successfully access this content.’

then Jira was unable to communicate with the Confluence server to either:

• retrieve information about the link or
• conduct a Confluence page search in the Find a Confluence page dialog box.

Solution:

Ask the Confluence system administrator to enable the Remote API (XML-RPC & SOAP) feature, since this Confluence feature is disabled by default. See Enabling the Remote API in the Confluence documentation for details.

Creating a link to any web page URL

1. Open the issue you wish to link to another issue.
2. Select More > Link to display the Link dialog box.
3. Click the Web Link option at the left of the dialog box.
4. Specify the URL of the web page you want to link to.
5. Specify the Link Text that will appear in the Issue Links section of the ‘view issue’ page and will be hypelinked to your URL.
6. Optional: Add a Comment to describe why you are linking these issues.
7. Click the Link button at the bottom of the dialog.

Deleting a link

1. Go to an issue that contains links, and locate the Issue Links section.
2. Hover your mouse over the link you wish to delete, and click the Delete (trashcan) icon that appears.

Searching for linked issues

You can search for issues that are linked to a particular issue. See Advanced searching for more information.

Be aware that this functionality does not extend to issues on a remote Jira server.
Editing multiple issues at the same time

At some point, you may need to change multiple issues at the same time. You can do this by performing a Bulk Change operation.

There are restrictions placed on some of the bulk operations. For example, if you select multiple issues with different workflows, you can only transition them in groups with the same workflow, and one group at a time. You can only bulk change 1000 issues as loading more than that might result in the Out Of Memory error. The restrictions are explained further in the relevant sections.

Before you begin

Required permissions

To perform a bulk change operation, you need the appropriate project-specific permissions and the global Bulk Change permission. For example, you would need to have both the Move Issue and Bulk Change permissions to perform the Bulk Move operation. If you cannot access the Bulk Change functionality, ask your project admin to grant you the required permissions.

Using the bulk change wizard

The bulk change wizard will progress you through your bulk change. To open the wizard:

- Perform a search with the required filters to produce a list of issues and select Tools > Bulk Change.
- Bulk edit issues in the Backlog. Use Shift+select to choose multiple issues and then right-click the selected items to start the bulk change operation.

To go back to any step of the operation, select the relevant step in the menu on the left-hand side of the wizard. Selecting Cancel will cancel the entire process.

Disable notifications for bulk operations

You can disable mail notifications for a particular bulk operation by deselecting the Send Notification check box in the bulk operation wizard. For this option to be available, you must be a Jira administrator or project administrator of all the projects associated with your selected issues. Deselecting Send Notification only disables Jira notifications. It doesn't affect notifications that are sent to your service desk customers.
Transition multiple issues

This bulk operation allows you to transition multiple issues through a workflow at the same time. You can only perform one transition bulk operation at a time. You will also need to provide any values required to complete the transition. For example, to close multiple issues, you will need to provide a value for the Resolution field, such as Done, Fixed, or Won't Fix.

To transition multiple issues:

1. Perform a search with the required filters to produce a list of issues.
2. Select Tools > Bulk Change.
3. Select the issues you’d like to perform the bulk operation on and then select Next.
4. Select Transition Issues and then select Next.
5. Select the available workflow action. The actions available are dependent on the issues (and their associated workflows) that you have selected. Select Next.
6. Select a value for any required fields for this transition, and if available, decide whether you’d like to send email notifications. Select Next.
7. Review your bulk operation, and select Confirm when you are happy with the operation.

Delete multiple issues

This bulk operation allows you to delete multiple issues at the same time. To delete multiple issues:

1. Perform a search with the required filters to produce a list of issues.
2. Select Tools > Bulk Change.
3. Select the issues you’d like to perform the bulk operation on, and select Next.
4. Select Delete Issues and then select Next.
5. If available, decide whether you’d like to send email notifications. Select Next.
6. Review your bulk operation, and select Confirm when you are happy with the operation.

Move multiple issues

This bulk operation allows you to move multiple issues at the same time. The issues you’re moving need to be mapped to both a project and an issue type, and in doing this, you may need to also map the status and fields of the issues. Subtasks need to be mapped, too.

You can bulk move both standard issues and sub-tasks to another project and issue type, as well as convert a sub-task to an issue and vice versa. To learn more about issue types, see Issue fields and statuses.

You can also select both a sub-task and its parent to bulk move. However, you’ll only be asked to move sub-tasks if you’re moving a parent issue to another project. This is to maintain the parent/sub-task relationship (i.e., the sub-task is always located in the same project as the parent issue). For example, you have issue B being a sub-task of issue A and you try to bulk move both A and B simultaneously. You will be prompted to select a target project and issue type for issue A. If you select a new project for A, you will be prompted to move the sub-task to a new issue type based on issue A’s new project. If you don’t change the project for issue A, the sub-task will not be required to be moved.

To move multiple issues:

1. Perform a search with the required filters to produce a list of issues.
2. Select **Tools > Bulk Change**.

3. Select the issues you’d like to perform the bulk operation on, and select **Next**. The bulk move operation may require additional information depending on which issues you have selected to move (expand the following dropdown for details).

| Select Projects and Issue Types | The first step of the Bulk Move wizard is to choose which projects and issue types you will move your issues to. The target project and issue type will determine whether extra steps will be required to migrate statuses and fields.

Selected issues are grouped by their current project and issue type. You can either select a new project and issue type for each one or choose to move all standard issues to a single project and issue type. |
| Select Projects and Issue Types for Sub-Tasks | If you are moving issues with sub-tasks to another project, you will also need to move the sub-tasks to the new project. You can also elect to change the issue types of the sub-tasks being moved if you need to. |
| Select statuses migration mappings for invalid statuses | As multiple workflows can be active simultaneously, some statuses associated with the collection of selected issues may not be valid in the target workflow. In this case, you should map invalid statuses to valid statuses in your new workflow. |
| Select values for required fields and fields with invalid values | To adhere to the field configuration scheme associated with the target project and issue type, it may be necessary to update/populate required fields (e.g. fields that are required in the target project, but may not have been in the original project). For each field that needs to be populated, you will be prompted to supply a value. This value will be applied to all issues that are being bulk moved together.

For the following fields, you can select from a list of possible values provided for you:
- Component
- Affects Version
- Fix Version
- Custom fields of type "Version-Picker"

Versions which have been archived in the target project cannot be selected as the target when performing a bulk move. If you need to move issues into an archived version, you will need to first unarchive the version in the target project.

It is possible to retain original field values that are valid in the target destination by checking the **Retain** checkbox associated with the field. For example, some issues may already include a valid custom field value; these values can be retained, while issues that require an update will adopt the value specified on the **Field Update** screen.

- **Checked**: the original value is retained where possible. The field will not be updated with the specified new value.
- **Unchecked**: all fields will be updated with the specified new value.

Note that the "Retain" checkbox is not available for the following fields, since an explicit mapping is required:
4. Select Move Issues and then select Next.
5. Confirm your changes and complete the operation. Note that you'll need to specify "Status migration mappings for invalid statuses" and "Values for required fields and fields with invalid values" once for each different target project and issue type combination.

When all move parameters e.g. target project, status mappings and field updates have been specified for all issues, you will be presented with a confirmation screen displaying all changes that will be made to the issues being moved. The following details are displayed as applicable:

- **Issue Targets:** the target project and issue type
- **Workflow:** the target workflow and invalid status mappings
- **Updated Fields:** new values for fields that require updating
- **Removed Fields:** values to be removed in fields that are not valid in the target

The issues will only be moved once the Confirm button is clicked from the confirmation page. If the operation is exited anytime before this step, no changes will be made to the issues.

**Edit multiple issues**

This bulk operation allows you to edit multiple issues at the same time. The bulk edit operations available depend on the issues selected and the nature of the field/s you want to change.

To edit multiple issues:

1. Perform a search with the required filters to produce a list of issues.
2. Select Tools > Bulk Change.

3. Select the issues you’d like to perform the bulk operation on and then select Next.
4. Select Edit Issues and then select Next.
5. Select the bulk edit operation from the list of available operations (expand more information for a full list of available and unavailable operations, and their conditions).

<table>
<thead>
<tr>
<th>Available Operations</th>
<th>Conditions</th>
</tr>
</thead>
<tbody>
<tr>
<td>Change Affects Version/s</td>
<td>• Selected issues belong to one project, and that project has version/s</td>
</tr>
<tr>
<td></td>
<td>• This field is not hidden in any field configurations the selected issues</td>
</tr>
<tr>
<td></td>
<td>belong to</td>
</tr>
<tr>
<td></td>
<td>• Current user has &quot;edit issue&quot; permission for all the selected issues</td>
</tr>
<tr>
<td>Change Assign To</td>
<td>• This field is not hidden in any field configurations the selected issues</td>
</tr>
<tr>
<td></td>
<td>belong to</td>
</tr>
<tr>
<td></td>
<td>• Current user has &quot;assign issue&quot; permission for all the selected issues</td>
</tr>
<tr>
<td>Change Comment</td>
<td>• This field is not hidden in any field configurations the selected issues</td>
</tr>
<tr>
<td></td>
<td>belong to</td>
</tr>
<tr>
<td></td>
<td>• Current user has &quot;comment issue&quot; permission for all the selected issues</td>
</tr>
<tr>
<td>Change Component/s</td>
<td>• Selected issues belong to one project, and that project has component/s</td>
</tr>
<tr>
<td></td>
<td>• This field is not hidden in any field configurations the selected issues</td>
</tr>
<tr>
<td></td>
<td>belong to</td>
</tr>
<tr>
<td></td>
<td>• Current user has &quot;edit issue&quot; permission for all the selected issues</td>
</tr>
<tr>
<td>Change Due Date</td>
<td>• This field is not hidden in any field configurations the selected issues</td>
</tr>
<tr>
<td></td>
<td>belong to</td>
</tr>
</tbody>
</table>
### Change Fix For Version/s
- Selected issues belong to one project, and that project has version/s
- This field is not hidden in any field configurations the selected issues belong to
- Current user has "edit issue" permission for all the selected issues

### Change Issue Type
- Current user has "edit issue" permission for all the selected issues

### Change Priority
- This field is not hidden in any field configurations the selected issues belong to
- Current user has "edit issue" permission for all the selected issues

### Change Reporter
- This field is not hidden in any field configurations the selected issues belong to
- Current user has "edit issue" permission for all the selected issues
- Current user has "modify reporter" permission for all the selected issues

### Change Security Level
- This field is not hidden in any field configurations the selected issues belong to
- All the selected projects are assigned the same issue level security scheme
- Current user has "edit issue" permission for all the selected issues
- Current user has "set issue security" permission for all the selected issues

### Change Custom Fields
The "Change Custom Fields" operation is available only if:
- a global custom field exists OR
- an issue type custom field exists and the issues are all of this specific issue type OR
- a project custom field exists and the issues are all of the same project

### Edit a Closed Issue
- Your workflow must allow editing of closed issues

### Change Sprint
You need to specify the sprint ID.
- This operation only affects active and future sprints, i.e. closed/completed sprints are not included when bulk editing the Sprint field.

---

The fields listed in this section have no operations for bulk editing. This is because there is an alternative method or it is not logical to perform bulk edit on them.

The following system fields are unavailable for bulk editing:
- Attachments
- Summary
- Description
- Environment
- Project. Use "Bulk Move" to move issues between projects
- Resolution. Use "Bulk Workflow Transitions" to modify the resolution of issues
- Time Tracking fields: Original Estimate, Remaining Estimate, Time Spent

The following custom field types are unavailable for bulk editing:
- Import Id
- Read Only Text
  a. Select a value for any required fields for this operation, and if available, decide whether you'd like to send email notifications. Select Next.
  b. Review your bulk operation, and select Confirm when you are happy with the operation.

---

Watch / stop watching multiple issues
These bulk operations allows you to start watching or stop watching multiple issues at the same time.

To watch multiple issues:

1. Perform a search with the required filters to produce a list of issues.
2. Select **Tools > Bulk Change**.
3. Select the issues you’d like to perform the bulk operation on and then select **Next**.
4. Select **Watch Issues** and then select **Next**.
5. Review your bulk operation, and select **Confirm** when you are happy with the operation.

To stop watching multiple issues:

1. Perform a search with the required filters to produce a list of issues.
2. Select **Tools > Bulk Change**.
3. Select the issues you’d like to perform the bulk operation on, and select **Next**.
4. Select **Stop Watching Issues** and then select **Next**.
5. Review your bulk operation, and select **Confirm** when you are happy with the operation.

Archive multiple issues

> This functionality is available with the Jira Data Center license.

If you want to archive thousands of issues at once, instead of selecting the issues manually, you can make a bulk change. By default, this option allows you to archive all the issues on the current page or a maximum of 1000 issues. However, a system admin can raise this limit if needed.

The issues will be archived with all their subtasks. Note that issues might have multiple subtasks so archiving might take a while because of a great number of subtasks.

To archive multiple issues:

1. Perform a search with the required filters to produce a list of issues. You can archive all the issues on the current page or a maximum of 1000 issues.
2. Select **Tools > Bulk Change**.
3. Select the issues you’d like to perform the bulk operation on, and select **Next**.
4. Select **Archive issues** and then select **Next**.
5. Review your bulk operation, and select **Confirm** when you are happy with the operation.
Moving an issue

Sometimes, an issue may belong to a different project, and you may want to move this issue to another project. You can easily do this by using the Move issue wizard.

Before you begin:

- You must have the Move Issues permission for the project that has the issue that you want to move.
- You must have the Create Issues permission for the project that you wish to move your issue to.

If you do not have either of these permissions, please contact your Jira administrator to have these added to your user profile.

Moving an issue

The Move issue wizard allows you to specify another project in your Jira instance to move your selected issue to. As there may be significant differences in the configuration of your original project and target project, the Move issue wizard allows you to change certain attributes of the issue. These include:

- **Issue type** If your issue is a custom issue type that does not exist in your target project, you must select a new issue type. You can also choose to arbitrarily change the issue type.
- **Issue status** You may have set up custom issue statuses as part of a workflow. If you have assigned a custom status to your issue, and it does not exist in your target project, you must select a new issue status for your issue. You cannot arbitrarily change the issue status, i.e. the option to change the issue status will only appear if you are required to change it.
- **Custom fields** If you have defined required custom fields for your issue that do not exist in your target project, you must set values for them. You will only be prompted to enter the values for required custom fields in the target project that are missing values. If the custom fields of your original project also exist in your target project, and these custom fields are not required in the target project, you may need to set values for them, to move the issue successfully. If you wish to change the existing values for other fields on your issue, you can do this after the move is complete.

To move an issue:

1. View the issue that you wish to move.
2. Select More > Move.
3. The first page of the Move issue wizard is displayed. Complete the steps required.
4. The confirmation page will display with all of your changes. If you wish to revise any of your changes, you can select the appropriate step in the left-hand menu to return to that page of the wizard. Once you are happy with your changes, select Move to move the issue to the target project.
5. Your issue will be moved to the target project and displayed on screen. You can now edit the issue to make further changes, if you wish.

Moving related issues

- If your issue has sub-tasks, the Move issue wizard will also move the sub-tasks to the target project.
- If you’re moving an epic, the Move issue wizard will not move the issues in the epic. The epic and the issues in the epic will still be linked to each other, but the issues in the epic will remain in the original project. You will need to move them separately.
- If your issue has values in the Components field, since the components field is project-tied, the target project must have the same component value already in place with the exact same name. Otherwise, the value will be lost during the move operation.

Troubleshooting

- Restricted comments appear to be removed after moving the issue. See this article: Restricted comments disappear after moving an issue to a new project.
Visual editing

Formatting content in Visual mode gives you a What You See Is What You Get (WYSIWYG) experience. Formatting appears as you apply it, and you no longer have to flip to a Preview to see what your content will look like when saved. You still have the option to view the wiki markup by selecting the Text tab. You'll know you have access to the visual editor because you'll see the Visual and Text tabs.

| Style | B | I | U | A |  |  |  |  |  |
|-------|---|---|---|---|---|---|---|---|

The new visual editor is **AWESOME**!!
I can apply formatting using the toolbar or typing wiki markdown, and it appears as I apply it! Things like:

- color
- underline
- emoticons 😊

and I even get

<table>
<thead>
<tr>
<th>Tables</th>
</tr>
</thead>
<tbody>
<tr>
<td>that look like tables!</td>
</tr>
</tbody>
</table>

In Visual mode, you can still enter wiki markup syntax as you add your content, and it'll be rendered exactly as it'll display when you save. You can even flip between modes to view the formatted content, and the wiki markup syntax. You can also use the toolbar to format and style your content.

As Visual editing is really a preview of what we're working on, there's a few things that may not work quite as you'd expect them:
• Formatting content in a complex way can affect it’s ability to be rendered, things like tables in the cells of other tables, and adding images to table cells won’t work.
• Pasting content may not work as expected, as the source content may really be formatted using a method we don’t support. So pasting tables may work, and it may not, depending on the source. Pasting plain text is absolutely fine.
• If you have macros provided by 3rd party apps, and they’re incompatible with Visual mode, you won’t be able to edit the macro header, and it’s content will be rendered as text (wiki markup).
Scheduling an issue

You can schedule issue due dates in Jira Service Management to help your agents prioritize incoming customer requests and find overdue issues that need urgent attention. The powerful scheduling feature allows you to perform fixed and relative date searches based on specific due dates as well as arbitrary search periods. You can also perform advanced searches using Jira Query Language.

Scheduling an issue

To schedule an issue, populate its Due date field. This can be done either when creating an issue, or at a later stage by editing the issue.

Searching by due date

You can use either basic search or advanced search to search for issues by their Due Date.

Using simple search

You can search for issues using the search form in Issue Navigator (see Searching for Issues). There are two ways to search for issues based on the Due date field. The first way is using fixed date values, the second is using periods that are relative to the current date.

Fixed date searches

There are two text fields in the search form that allow searching based on the Due date field.

- To search for all issues that are due after a certain date, enter the date in the Due After text field. For example, to find all issues that are due after 1st June 2010, enter 1-6-2010 in the Due After field. You can also use the Calendar popup to select a date by clicking the calendar icon to the right of the field.

- To search for issues that are due before a certain date, enter the date in the Due Before text field. For example, to find all issues that are due before 1st July 2010, enter 1-7-2010 in the Due Before field.

To search for issues that are due between two dates, populate both the Due After and the Due Before fields.

Relative period search

It is possible to perform a search that is relative to the time when it is run. For example, it is possible to do a search for issues that are due seven days from now. To do this, enter 7d in the Due Date To text field of the Issue Navigator. If the search is saved and run the next day, the issues that are due in seven days from the time that the search is run will be retrieved. Thus, this search will find all issues that are due within a week every time it is run.

The values that are entered in the Due Date From and Due Date To fields have to conform to a special syntax (described below). However, it is also possible to use the Due Date popup by clicking the icon to the right of the Due Date To text field to specify the search period.

Due Date Popup

Use the Due Date popup to do the following:

- To search for issues that are overdue at the time of the search, select the first radio button, and click OK.
- To search for issues that are overdue by more than a certain number of days, populate the text field in the second row, and click OK.
• To search for issues that are due in the next certain amount of days, and are not overdue at the time of the search, populate the text field in the third row with the number of days, and choose \textbf{and not} from the select box in the third row. Select the third radio button, and click \textbf{OK}.

• To search for issues that are due in the next certain amount of days, and are overdue at the time of the search, populate the text field in the third row with the number of days, and choose \textbf{and} from the select box in the third row. Select the third radio button, and click \textbf{OK}.

• The fourth row of the popup is used for arbitrary period searches. Use the \textbf{to} text field to specify the upper bound of the search, and the \textbf{from} text field to specify the lower bound of the search. A blank text field means no bound. Populating the text fields in the fourth row actually has the same effect as populating the Due Date From and Due Date To text boxes. The syntax is described below.

**Relative Period Search Syntax**

The Due Date From and Due Date To fields use a special syntax to denote time period bounds. The syntax uses numbers and abbreviations that follow the numbers to represent what the numbers actually mean. The abbreviations are "w" for weeks, "d" for days, "h" for hours, and "m" for minutes. For example, to specify 10 days in the future, use "10d" or "1w 3d". To specify a period bound in the past, prefix the value with the "-" sign. For example, to specify 2 days, 4 hours, and 3 minutes ago, use "-2d 4h 3m".

**Using advanced search**

You can also use Jira Query Language (JQL) to search for issues by due date see \textbf{Advanced Searching}, and particularly the documentation on the \textbf{Due} field.
Logging work on issues

In Jira Service Management, you use Service Level Agreements (SLAs) configured by your administrator to help you track how well you're meeting customer expectations (e.g. responding to a request within 4 hours). You can use the Time Tracking feature in addition to SLAs to generate a workload report when you're working on a customer request with other agents, or when you need to track time spent fixing a problem that affects multiple customer requests.

Here's how time tracking appears on an issue:

- The Estimated field displays the amount of time originally anticipated to resolve the issue
- The Remaining field displays the amount of time currently anticipated to resolve the issue
- The Logged field displays the amount of time logged working on the issue so far
- Choosing to include sub-tasks displays the aggregated time of an issue and all its sub-tasks

When you log time for the first time, the time spent is subtracted from the original estimate, and the resulting value is automatically presented in the remaining estimate. When subsequent work is logged, anytime spent is subtracted from the remaining estimate.

Before you begin

- Make sure your Jira administrator has enabled the Time Tracking feature.
- Make sure you have the Work on Issues, Delete Work Logs, and Edit Work Logs project permissions.

Note that anyone with the Browse Project permission can view time tracking information on an issue.

Setting a time estimate for an issue

Teams can set a time estimate for an issue in order to calculate how long it will take to solve the issue.

1. Open the issue and select Edit.
2. Scroll down the Edit issue window to fill in the following time tracking fields:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Original Estimate</td>
<td>Amount of time you believe is required to solve the issue. If you want to change original estimate values once they have logged work time, ask your Jira administrator to disable legacy mode on time tracking.</td>
</tr>
<tr>
<td>Remaining Estimate</td>
<td>Amount of time you believe is required to solve the issue in its current state.</td>
</tr>
</tbody>
</table>
If the Jira time tracking feature is in legacy mode, you will only see the original estimate field if work has not been logged. Once work time has been logged, you will only see the remaining estimate field.

**Tips:**
- You can specify additional time units after a time value 'X', such as Xw, Xd, Xh, or Xm, to represent weeks (w), days (d), hours (h), and minutes (m), respectively. If you type a number without specifying a time unit (e.g. if you type '2' instead of '2h'), the default time unit that your Jira administrator specified will apply.
- Default conversion rates are 1w = 5d and 1d = 8h.

3. Select **Update**.

When work is first logged against the issue, the **Time Spent** is subtracted from the **Original Estimate**, and the resulting value is automatically presented in the **Remaining Estimate**. When subsequent work is logged, any **Time Spent** is subtracted from the **Remaining Estimate**.

Additionally, once work has been logged on an issue, various reports based on the time tracking information become available.

### Logging work on an issue

Once you have started to work on a specific issue, you can log your work by following these steps:

1. Select the issue you want to log time on.
2. Go to **More > Log Work**.
3. Fill in the following **Log Work** fields, and select **Log**:

<table>
<thead>
<tr>
<th>Log Work field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Time spent</strong></td>
<td>The amount of time spent on the issue. This is the aggregate amount of time that has been logged against this issue.</td>
</tr>
<tr>
<td><strong>Date started</strong></td>
<td>Date and time when you started this unit of work.</td>
</tr>
<tr>
<td><strong>Remaining estimated</strong></td>
<td>Amount of time anticipated to resolve the issue after completing this unit of work. You can adjust this value using the following options:</td>
</tr>
<tr>
<td>- <strong>Adjust Automatically</strong></td>
<td>Adjust the remaining estimate value by subtracting the amount of work logged in the <strong>Time Spent</strong> field from the remaining estimate current value.</td>
</tr>
<tr>
<td>- <strong>Leave Estimate unset</strong></td>
<td>This option is displayed only if no time estimate has been specified on the issue. You can use this option when you want to keep track of work, but you don't necessarily have a time estimate for an issue.</td>
</tr>
<tr>
<td>- <strong>Use Existing Estimate of</strong></td>
<td>Select this option if you do not want to change the issue remaining estimate value.</td>
</tr>
<tr>
<td>- <strong>Set to</strong></td>
<td>You can adjust the remaining estimate value to the amount of time you specify in this field.</td>
</tr>
<tr>
<td>- <strong>Reduce by</strong></td>
<td>Select this option to manually adjust the remaining estimate value by subtracting the amount of time you specify in this field.</td>
</tr>
</tbody>
</table>

**Tips:**
- You can specify additional time units after a time value 'X', such as Xw, Xd, Xh, or Xm, to represent weeks (w), days (d), hours (h), and minutes (m), respectively. If you type a number without specifying a time unit (e.g. if you type '2' instead of '2h'), the default time unit that your Jira administrator specified will apply.
- Default conversion rates are 1w = 5d and 1d = 8h.
<table>
<thead>
<tr>
<th>Work description</th>
<th>Type a description related to the achieved work.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Comments</td>
<td>are copied to the Workflow Description by default, but your Jira administrator can change this option in the 'Copy Comment to Workflow Descriptions' settings. If this setting is disabled:</td>
</tr>
<tr>
<td>• The work log entry may be visible to anyone. If this is a concern, you need to edit this work log entry after creating it to modify its visibility.</td>
<td></td>
</tr>
<tr>
<td>• You have to manually copy comments to a workflow description once you have logged work.</td>
<td></td>
</tr>
</tbody>
</table>

You can also log work while resolving or closing an issue by closing it and editing the log work fields. Select the padlock icon to set the work logged to be viewable only by members of a particular project role or group.

### Editing a work log entry

You can edit your own work log entries if you have been granted the Edit Own Work Logs permission. You can also edit other people’s work log entries if you have been granted the Edit All Work Logs permission.

### Deleting a work log entry

You can delete your own work log entries if you have been granted the Delete Own Work Logs permission. You can also delete other people’s work log entries if you have been granted the Delete All Work Logs permission.

1. Go to the desired issue, and open the Work Log tab.
2. Hover over the work log entry to display the actions for the entry on the right side.
3. Select the entry you want to delete, and click the trash can icon. You will be prompted to choose how the Remaining Estimate is affected by deleting the work log:

<table>
<thead>
<tr>
<th>Option field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Auto adjust</td>
<td>Choose this option to automatically add the time spent value to the current remaining estimate value.</td>
</tr>
<tr>
<td>Leave existing estimate</td>
<td>Select this option if you do not want to change the issue’s remaining estimate value.</td>
</tr>
<tr>
<td>Set estimated time remaining</td>
<td>Choose this option to manually set the issue’s remaining estimate value to the specified amount.</td>
</tr>
<tr>
<td>Increase estimated time remaining</td>
<td>Select this option to increase the estimated remaining.</td>
</tr>
</tbody>
</table>

4. Click Delete.

### Customized Jira installations

Jira applications can be customized by your Jira administrator by adding the Log Work and Time Tracking fields to the customized screens. This way, you can log work and specify time estimates on the same Jira screen when performing any Jira operation, such as editing, creating an issue, or transitioning an issue to another status.

If you want to work and specify time estimates on the same Jira screen:

1. Navigate to the issue and view its details.
2. Perform the customized Jira operation that allows you to log work and specify time estimates on the same Jira screen. For example, assuming that your Jira administrator has added the Time Tracking fields to the Resolve Issue Screen, and assuming this screen also retains the default Log Work fields, select Workflow > Resolve Issue at the top of the issue.
If your Jira administrator has configured the Log Work fields as optional, then you can choose whether or not to log work by checking the Log Work checkbox.

If your Jira administrator has made logging work mandatory, you will not see the Log Work checkbox, and will instead need to log work when transitioning an issue.
Approving a service project request

Jira Service Management projects have an option to include an approval step and assign approvers to their issues. You may be asked to approve a service request if you've been assigned the role of "approver". When this happens, you'll receive an email notifying you that your approval is required. If the Request Details and Approval buttons variables have been added to the project's approval notifications template, you can action the request from within the email. If not, there will be a link to the customer portal where you can view and action the request.

How to approve and decline from the customer portal

Pro tip: Ask your Project Administrator to add Request details and Approval buttons to your approval notifications template, so you can quickly action a request from within your email. See Managing service project notifications.

It's likely that you've upgraded from a version of Jira Service Management prior to 3.12, and the approval notifications template hasn't been updated.

1. Navigate to the service desk customer portal by either selecting the link in your email, or entering the URL.
2. View the approval request and review the supporting information.
3. Leave a comment by selecting Add below the comment field. Depending on the settings in the projects workflow, your comment may or may not be required. Even if its not required, it helps to let the customer know why you responded the way you did, especially if you're declining the request.
4. Select Approve or Decline. If a comment is required, you will need to provide a comment in the Approve this request or Decline this request dialogs.
   Note that even if you've already added a comment to the request, you'll still need to enter a comment to proceed.
5. The customer will receive a notification of the selected action you have taken.

How to approve and decline from email

1. Approvals section, which lists the appointed approvers for the request. This section only appears when there are pending approvals for the request.
2. When a request is approved, the Approvals section disappears, and details about the approval will be added to the Activity section.
   For example, Your request was APPROVED and the status changed to Waiting for support.
Good news! You're using the default approval notifications template.

1. View the approval request and decide what action you'd like to take.
2. Select either the Approve or Decline button within the email. If you aren't logged into the customer portal, you will be prompted to do so. You'll then see:
   a. If you hit Approve, a confirmation screen.
   b. If you hit Decline, a screen prompting you to leave a comment and confirm your decision. Depending on the settings in the projects workflow, your comment may or may not be required. Even if it's not required, it helps to let the customer know why you're declining the request.
3. The customer will receive a notification of the selected action you have taken.

1. Approval buttons, that let the approver action requests from within their email.
2. Request details, that show the full details of a request (including request type, summary, creation date, and the same fields chosen in the request type settings).

If you're the only approver required on the request, and you approve it, the request will be moved to the status defined in the workflow for the approve transition. If there is more than one approval required, the status will remain the same until all approvers have responded, and your approval will be noted on the request.

If you decline a request (or any of the approvers decline it), it's automatically moved to the status as defined in the workflow for the decline transition, and your response is noted on the request.
Customizing the issues in a project

Issues are the packets of work that need to be completed in a project. These issues are made up of issue fields, and the issue fields contain data about the issue. This data is important, as it helps define the issue, and can contain important information about the issue, such as a summary, a description, due dates, and when and where the work is required. This information is presented on a screen. A screen groups all available fields (or a subset of all available fields) defined in Jira applications, and organizes them for presentation to a user. Jira Service Management allows you to customize the configuration and behavior of issues to better suit the needs of your customers and agents. You may choose to:

- Change a field's behavior (such as change a field's description, make a field hidden or visible, or make a field required or optional)
- Add your own values for fields that have default values assigned (e.g. Resolution and Status)
- Create new 'custom' fields
- Configure different renderers for (some) fields
- Change the position fields on a screen
- Choose which screen should be displayed for each issue operation (e.g. 'Create Issue', 'Edit Issue') or workflow transition (e.g. Resolve Issue, Close Issue)

A simple example of how customizing an issue could benefit your team could be marking fields as 'Required' when an issue is created. This would ensure you always capture the required information you need to get the work done to resolve the issue. If you couple this with positioning the required fields at the top of the screen, and even hiding fields you know the issue creator won't use, you'll make sure your users can see and complete the required fields as quickly as possible.

You can make this...

![Image of a Jira screen](image)

...into this...

![Image of a customized Jira screen](image)
Jira administrators and project administrators have different permissions when it comes to customizing issues.

**Project administrators**

As a project administrator, you're able to customize some aspects of the issues in your project if:

- you have the *Extended project administration* permission, which is enabled by default (you can check that in **Project settings > Permissions**),
- the screens you make the changes on must not be used by other projects, or used as a transition screen in a workflow.
- the screen isn't the default Jira screen (no-one can edit these screens).

If a screen is shared by another project, you'll see this information when you view the screen. If your screen suits the criteria above, you can:

- add and remove tabs that will appear on a screen, and edit the name of the tab,
- add, remove and rearrange system fields, and
- add, remove and rearrange existing custom fields, but you can't create custom fields.

**Editing a screen**

1. Select **Projects** and choose the project whose screen/s you want to view.
2. Select **Project settings** in the sidebar.
3. Select **Screens** in the Project settings sidebar.

You'll see the screen scheme/s used by your project, and the issue types that use that scheme. Expand the screen scheme to see the screens associated with that scheme and issue types. Select the screen you wish to edit. You can perform the following actions:

<table>
<thead>
<tr>
<th>Action</th>
<th>Instructions</th>
</tr>
</thead>
<tbody>
<tr>
<td>Add a tab</td>
<td>Click <strong>Add Tab</strong> 🔄. Enter the name of the new tab in the dialog that appears and click <strong>Add</strong>.</td>
</tr>
<tr>
<td>Move a tab</td>
<td>Hover over the dotted part of the tab (next to the tab name) and drag the tab to the desired position.</td>
</tr>
<tr>
<td>Rename a tab</td>
<td>1. Hover over the tab name and click the <strong>pencil icon</strong>. 2. Enter the new name and click <strong>OK</strong>.</td>
</tr>
</tbody>
</table>
### Jira administrators

As a Jira administrator, you can view more conceptual information on customizing issues in the Jira administrator's documentation.
Searching for issues

Can't find the customer issue you've been working on? This page will show you how to search for issues in Jira Service Management. Any agent can search for issues, although they will only see results from projects they have access to. You'll find a step-by-step guide below that will show you how to run a search and use the search results. If you want more details on anything described on this page, see the related topics at the bottom of the page.

On this page:

1. Define your search criteria
2. Change your view of the search results
3. Working with the search results
4. Save your search
5. Good to know
6. Next steps

1. Define your search criteria

The first step in searching for issues is to define the criteria for your new search. You can define your search criteria in three different ways: using the quick search, using the basic search, or using the advanced search.

<table>
<thead>
<tr>
<th>Quick search</th>
<th>The quick search is the fastest way to define search criteria. However, it is less precise than other complex queries (e.g. project = Jira AND status = Open AND priority = High). If your search criteria is not complex, for example, you know the project key and some key words.</th>
<th>To use the quick search: Enter your search criteria in the search box in the header bar of Jira. Tip: If you know the issue key or project key, enter it before other search terms, e.g. &quot;JRA help link is broken&quot;.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Basic search</td>
<td>The basic search is more precise than the quick search, but easier to use than the advanced search. It provides a user-friendly interface that lets you define complex queries, without needing to know how to use JQL (advanced searching).</td>
<td>To use the basic search: Navigate to Issues (in header) &gt; Search for issues, then enter your search criteria. Tip: If the advanced search is shown instead of the basic search, click Basic next to the icon.</td>
</tr>
<tr>
<td>Advanced search</td>
<td>The advanced search is the most powerful of the three search methods. You can specify criteria defined in the other searches (e.g. ORDER BY clause). However, you need to know how to construct queries using the Jira Query Language (JQL) to use this feature.</td>
<td>To use the advanced search: Navigate to Issues (in header) &gt; Search for issues, then enter your search criteria. Tip: If the basic search is shown instead of the advanced search, click Advanced next to the icon.</td>
</tr>
</tbody>
</table>

2. Change your view of the search results

You have crafted the perfect search criteria and run the search. Your search results will be displayed in the issue navigator. The issue navigator allows you to change how the search results are displayed. For example, you may want to bring high priority issues to the top or hide certain fields.
3. Working with the search results

You've got the search results displaying the way that you want. Now you can work with the actual issues in the search results. The issue navigator lets you action individual issues, as well as the entire set of issues returned by your search.

Individual issues:
- **View the issue**: Click the issue key or name.
- **Action individual issues**: Click the cog icon next to the issue row and select an option.

All issues in the search results:
- **Export the search results to different formats, like CSV and XML**: Click Export and select the desired format.
- **Share the search results**: Click Share, then enter the recipient's details.
- **Create an RSS feed**: Click Export > RSS (Issues) or RSS (Comments).
- **Bulk modify issues in search results**: Click Tools and select all <n> issue(s) under Bulk Change.

4. Save your search

If you frequently run the same search, you can save the search criteria as a filter. This saves you from having to manually redefine the search criteria every time. Jira applications also include a number of predefined system filters for common queries, such as 'My Open Issues', 'Reported by Me', 'Recently Viewed', and 'All Issues'.

**To save your search as a filter**: On the search results page, click Save as and enter a name for the filter. Your new filter will be shown in the left panel with your other favorite filters, filters shared with you, and the system filters. To run a filter, just click it.

**Good to know**

Keep in mind that your search won't include issues that have been archived. These are removed from Jira's index, and can't be searched for like other issues.

**Next steps**

Read the following related topics:
- Quick searching
- Basic searching
- Advanced searching
- Saving your search as a filter
- Working with search results
Basic searching

The basic search provides a user-friendly interface that lets you define complex queries, without needing to know how to use JQL (advanced searching).

- If you don’t have complex search criteria, you may want to use quick search instead.
- If you are comfortable with the Jira Query Language (JQL), you may want to use advanced search instead. This search is more powerful than the basic search.

Screenshot: Basic search

On this page:
- Basic searching
- Running a saved search
- Troubleshooting
- Next steps

Basic searching

   - If there are existing search criteria, click the New filter button to reset the search criteria.
   - If the advanced search is shown instead of the basic search, click Basic (next to the Search button).

   In general, a query created using basic search will be able to be translated to advanced search, and back again. However, a query created using advanced search may not be able to be translated to basic search, particularly if:

   - the query contains an OR operator (note you can have an IN operator and it will be translated, e.g. project in (A, B))
   - i.e. even though this query: (project = JRA OR project = CONF) is equivalent to this query: (project in (JRA, CONF)), only the second query will be translated.
   - the query contains a NOT operator
   - the query contains an EMPTY operator
   - the query contains any of the comparison operators: !=, IS, IS NOT, >, >=, <, <=
   - the query specifies a field and value that is related to a project (e.g. version, component, custom fields) and the project is not explicitly included in the query (e.g. fixVersion = "4.0", without the AND project=JRA). This is especially tricky with custom fields since they can be configured on a Project/Issue Type basis. The general rule of thumb is that if the query cannot be created in the basic search form, then it will not be able to be translated from advanced search to basic search.

2. Enter the criteria for the search. You can search against specific fields and/or search for specific text.
   - If you are searching against a field and can’t find the field you want, or the field is displaying greyed out text, see the Troubleshooting section below.
   - If you are searching for text, you can use special characters and modifiers in your search text, such as wildcards and logical operators. See Search syntax for text fields.

3. The search results will automatically update in the issue navigator, unless your administrator has disabled automatic updates of search results. If so, you will need to click the Update button on the field drop-down after every change.

Running a saved search
Saved searches (also known as filters) are shown in the left panel, when using basic search. If the left panel is not showing, hover your mouse over the left side of the screen to display it.

To run a filter, e.g. My Open Issues, simply click it. The search criteria for the basic search will be set, and the search results will be displayed.

Note, clicking the Recently Viewed filter will switch you to the advanced search, as the basic search cannot represent the ORDER BY clause in this filter.

Troubleshooting

Some fields are only valid for a particular project/issue type context. For these fields, you must select the applicable project/issue type. Otherwise, the field is not available for selection.

Some fields are only valid for a particular project/issue type context. If you choose a field in your search, then remove all projects/issue types that reference the field, then the field is invalid. The invalid field does not apply to your search and displays in grey text.

Some field values are only valid for a particular project/issue type context. For example, you may have configured a project to use a status In Review in its workflow. If you select this project and status in your search, then change the search to filter for a project that doesn’t use In Review, the status will be invalid and ignored in the search.

Your search results will always update automatically whenever any fields are changed, provided that your administrator has not disabled automatic updates of search results. Ask your administrator whether they have disabled automatic updates of search results.

Next steps

Read the following related topics:

- Searching for issues
- Advanced searching
- Saving your search as a filter
- Working with search results find out how to use the issue navigator, export your search results, bulk modify issues, and share your search results.
Quick searching

Sometimes, you just want to be able to get to the particular issue that you're interested in. Other times, you can't remember what the issue was, but you remember that it was an open issue, assigned to you, or you have its name on the tip of your tongue. Quick search can help you in these scenarios.

The search box is located at the top right of your screen, in the Jira header bar. To use quick search, just start typing what you're looking for.

1. **Search**: Click anywhere in the box to display your recent work, or start typing to search through all your issues and projects.
2. **Issues**: Recent issues (before searching), or issues that match your search.
3. **Projects**: Recent projects (before searching), or projects that match your search.

Using quick search by many users at once can affect performance. You can limit the number of concurrent searches, or monitor how your users are searching in real-time. [Learn more](#)

Understanding quick searching

Read the following topics to learn how to get the most out of quick searching:

- Jumping to an issue
- Searching as you type
- Free-text searching
- Smart querying

**Jumping to an issue**

If you type in the key of an issue, you will jump straight to that issue. For example, if you type in 'ABC-107' (or 'abc-107'), and press the **Enter** button, you will be redirected to the issue 'ABC-107'.

In many cases, you do not even need to type in the full key, but just the numerical part. If you are currently working on the 'ABC' project, and you type in '123', you will be redirected to 'ABC-123'.

**Searching as you type**

When you start typing the word you're looking for, the quick search will react instantly by showing and refreshing the list of most relevant results. To display these results, your search term is matched against the following fields:

- Summary (projects and issues)
- Description (issues)
**Free-text searching**

You can additionally search through comments or use extra operators for fuzzy or wildcard search. These results won't be displayed as 'instant results', but you can view them after pressing Enter in the search box.

You can combine free-text and keywords together, e.g. "my closed test tasks". You can also you wildcards, e.g. "win*8".

For more information on free-text searching, see [Search syntax for text fields](#).

**Smart querying**

Quick search also enables you to perform 'smart' searches with minimal typing. For example, to find all the open bugs in the 'TEST' project, you could simply type 'test open bugs' and quick search would locate them all for you.

Your search results will be displayed in the Issue Navigator, where you can view them in a variety of useful formats (Excel, XML, etc).

The search terms that quick search recognizes are:

<table>
<thead>
<tr>
<th>Search Term</th>
<th>Description</th>
<th>Examples</th>
</tr>
</thead>
<tbody>
<tr>
<td>my</td>
<td>Find issues assigned to me.</td>
<td>my open bugs</td>
</tr>
<tr>
<td>r:</td>
<td>Find issues reported by you, another user or with no reporter, using the prefix r: followed by a specific reporter term, such as me, a username or none.</td>
<td>r:me finds issues reported by you. r:samuel finds issues reported by the user whose username is &quot;samuel&quot;. r:none finds issues with no reporter.</td>
</tr>
<tr>
<td>&lt;project name&gt;</td>
<td>Find issues in a particular project.</td>
<td>test project TST tst</td>
</tr>
<tr>
<td>overdue</td>
<td>Find issues that were due before today.</td>
<td>overdue</td>
</tr>
<tr>
<td>created:</td>
<td>Find issues with a particular Created, Updated, or Due Date using the prefixes created:, updated:, or due:, respectively. For the date range, you can use today, tomorrow, yesterday, a single date range (e.g. '-1w'), or two date ranges (e.g. '-1w,1w'). Note that date ranges cannot have spaces in them. Valid date/time abbreviations are: 'w' (week), 'd' (day), 'h' (hour), 'm' (minute).</td>
<td>created:today created:yesterday updated:-1w finds issues updated in the last week. due:1w finds issues due in the next week. due:-1d,1w finds issues due from yesterday to next week. created:-1w,30m finds issues created from one week ago, to 30 minutes ago. created:-1d updated:-4h finds issues created in the last day, updated in the last 4 hours.</td>
</tr>
<tr>
<td>priority</td>
<td>Find issues with a particular Priority.</td>
<td>blocker major trivial</td>
</tr>
</tbody>
</table>
| **<issue type>** | Find issues with a particular Issue Type. Note that you can also use plurals. | **bug**
**task**
**bugs**
**tasks** |
|------------------|---------------------------------------------------------------------------------|---------|
| **<resolution>** | Find issues with a particular Resolution.                                      | **fixed**
**duplicate**
**cannot reproduce** |
| **c:**           | Find issues with a particular Component(s). You can search across multiple components.  
Note that there can be no spaces between "c:" and the component name. | **c:security** finds issues with a component whose name contains the word "security". |
| **v:**           | Find issues with a particular Affects Version(s). To find all issues belonging to a 'major' version, use the wildcard symbol ' * '.  
Note that there can be no spaces between "v:" and the version name. | **v:3.0** finds issues that match the following versions (for example):  
• 3.0  
• 3.0 eap  
• 3.0 beta  
...but will not match against the following versions (for example):  
• 3.0.1  
• 3.0.0.4  
That is, it will match against any version that contains the string you specify followed immediately by a space, but not against versions that do not contain a space immediately after the string you specify. |
| **ff:**          | Find issues with a particular Fix For Version(s). Same usage as **v:** (above). | **v:3.2*** finds any issue whose version number is (for example):  
• 3.2  
• 3.2-beta  
• 3.2.1  
• 3.2.x |
| **v:**           | **Wildcard** symbol ' * '. Can be used with **v:** and **ff:**. |  |

In Mozilla-based browsers, try creating a bookmark with URL `http://<your-Jira-site>/secure/QuickSearch.jspa?searchString=%s` (substituting `<your-Jira-site>` with your Jira instance's URL) and keyword (such as '?'). Now, typing 'my open bugs' in the browser URL bar will search your Jira instance for your open bugs. Or simply type your search term in the Quick Search box, then right-click on the Quick Search box (with your search term shown) and select "Add a Keyword for this search...".

---

**Searching issues from your browser’s search box**

---

*Created in 2023 by Atlassian. Licensed under a [Creative Commons Attribution 2.5 Australia License](http://creativecommons.org/licenses/by/2.5/au/).*
If you are using Firefox or Internet Explorer 8 (or later), you can add your Jira instance as a search engine/provider via the drop-down menu next to the browser’s search box. Once you add your Jira instance as a search engine/provider in your browser, you can use it at any time to conduct a Quick Search for issues in that Jira instance.

**OpenSearch**

Jira supports this browser search feature as part of the autodiscovery part of the OpenSearch standard, by supplying an OpenSearch description document. This is an XML file that describes the web interface provided by Jira’s search function. Any client applications that support OpenSearch will be able to add Jira to their list of search engines.

Next steps

Read the following related topics:

- [Searching for issues](#)
Advanced searching

The advanced search allows you to build structured queries using the Jira Query Language (JQL) to search for issues. You can specify criteria that cannot be defined in the quick or basic searches. For example, you can use the `ORDER BY` clause to sort Jira issues either in descending or ascending order or narrow down your search results for the desired date range.

If you don’t have complex search criteria, you may want to use quick search instead.

If you are not comfortable with the Jira Query Language (JQL), you may want to use basic search instead.

Note that JQL is not a database query language, even though it uses SQL-like syntax.

The following is the example of an advanced search query in Jira that returns all issues for the Teams in the Space project.

1. **JQL query** that refines the search results.
2. A list of Jira issues that match the search criteria.

Using advanced search

1. Go to issues (in the header) > Search for issues.

   - If there are existing search criteria, select the New search button to reset the search criteria.
• If the basic search is shown instead of the advanced search, select Advanced (next to the Search button).

2. Enter your JQL query. As you type, Jira will offer a list of "auto-complete" suggestions based on the context of your query. Note that auto-complete suggestions only include the first 15 matches, displayed alphabetically, so you may need to enter more text if you can't find a match.

If you don't see auto-complete suggestions, this might happen because of the following:
- Your administrator may have disabled the "JQL Auto-complete" feature for your Jira instance.
- Auto-complete suggestions are not offered for function parameters.
- Auto-complete suggestions are not offered for all fields. Check the fields reference to see which fields support auto-complete.

3. Press Enter or select Search to run your query. Your search results will display in the issue navigator.

Switch between basic and advanced search

In general, a query created using basic search will be able to be translated to advanced search, and back again. However, sometimes a query created using an advanced search may not be able to be translated into a basic search. Expand the following section for details.

You might not switch between two searches if:
- the query contains an OR operator.
- You can have an IN operator and it will be translated, e.g. project in (A, B). Even though this query: (project = JRA OR project = CONF) is equivalent to this query: (project in (JRA, CONF)), only the second query will be translated.
- the query contains a NOT operator.
- the query contains an EMPTY operator.
- the query contains any of the comparison operators: !=, IS, IS NOT, >, >=, <, <=.
- the query specifies a field and value that is related to a project (e.g. version, component, custom fields) and the project is not explicitly included in the query (e.g. fixVersion = "4.0", without the and project=JRA). This is especially tricky with custom fields since they can be configured on a Project/Issue Type basis. The general rule of thumb is that if the query cannot be created in the basic search form, then it won't be able to be translated from advanced search to basic search.

Understanding advanced searching

Read the following topics to learn how to get the most out of advanced searching:

- Constructing JQL queries
- Precedence in JQL queries
- Restricted words and characters
- Performing text searches

Constructing JQL queries

A simple query in JQL (also known as a "clause") consists of a field, followed by an operator, followed by one or more values or functions.
Example 1

This query will find all issues in the TEST project.

```sql
project = "TEST"
```

This query will find all issues in the TEST project. It uses the project field, the EQUALS operator, and the value TEST.

Example 2

A more complex query might look like this:

```sql
project = "TEST" AND assignee = currentUser()
```

This query will find all issues in the TEST project where the assignee is the currently logged in user. It uses the project field, the EQUALS operator, the value TEST, the AND keyword and the currentUser() function.

Example 3

A JQL query that will search for more than one value of a specific field. This query will find all issues of type Bug, which have accessibility and "3rd-party apps" values for the Component field:

```sql
issuetype = Bug AND component in (accessibility, "3rd-party apps")
```

The query uses the issuetype field, the EQUALS operator, the value Bug, the AND keyword, the component field, and the IN operator.

Example 4

A JQL query that will find issues created since the start of the current year and updated since the start of the current month:

```sql
project = "Analytics" and created > startOfYear() and updated > startOfMonth()
```

Example 5

A JQL query that will find any issues that are created in the Test project and contain the "pre-landing report" text in a summary or description:

```sql
project = "Test" AND text ~ "pre-landing report"
```

For more information on fields, operators, keywords and functions, see the Reference section.

Precedence in JQL queries

Precedence in JQL queries depends on keywords that you use to connect your clauses. For example, a clause can be: project = Teams in Space. The easiest way to look at this is to treat the AND keyword as the one grouping clauses, and OR as the one separating them. The AND keyword takes precedence over other keywords, because it groups clauses together, essentially turning them into one combined clause.

Example 1

```sql
status=resolved AND project=Teams in Space OR assignee=captainjoe
```
This query will return all resolved issues from the Teams in Space project (clauses grouped by AND), and also all existing issues assigned to captainjoe. The clause after the OR keyword is treated as separate.

Example 2

```
status=resolved OR project="Teams in Space" AND assignee=captainjoe
```

This query, on the other hand, will return captainjoes issues from the Teams in Space project (clauses grouped by AND), and also all existing resolved issues (a clause separated by OR).

Example 3

```
status=resolved OR projects="Teams in Space" OR assignee=captainjoe
```

When you only use the OR keyword, all clauses will be treated as separate, and equal in terms of precedence.

Setting the precedence

You can set precedence in your JQL queries by using parentheses. Parentheses will group certain clauses together and enforce precedence.

Example 1

As you can see in this example, parentheses can turn our example JQL query around. This query would return resolved issues that either belong to the Teams in Space project or are assigned to captainjoe.

```
status=resolved AND (project="Teams in Space" OR assignee=captainjoe)
```

Example 2

If you used parentheses like in the following example, they wouldnt have any effect, because the clauses enclosed in parentheses were already connected by AND. This query would return the same results with or without the parentheses.

```
(status=resolved AND project="Teams in Space") OR assignee=captainjoe
```

Restricted words and characters

Reserved characters

JQL has a list of reserved characters:

```
space (" ") + . , ; ? | * / % ^ $ # @ [ ]
```

If you wish to use these characters in queries, you need to:

- Surround them with quote-marks. You can use either single quotation marks (') or double quotation marks (").
  
  and

- If you are searching a text field and the character is on the list of special characters in text searches, precede them with two backslashes. This will let you run the query that contains a reserved character, but the character itself will be ignored in your query. For more information, see Special characters in Search syntax for text fields.

For example:

- version = "[example]"
Reserved words

JQL also has a list of reserved words. These words need to be surrounded by quotation marks (single or double) if you wish to use them in queries.

"abort", "access", "add", "after", "alias", "all", "alter", "and", "any", "as", "asc", "audit", "avg", "before", 
"begin", "between", "boolean", "break", "by", "byte", "catch", "cf", "char", "character", "check", 
"checkpoint", "collect", "collation", "column", "commit", "connect", "continue", "count", "create", "current", 
"date", "decimal", "declare", "decrement", "default", "defaults", "define", "delete", "delimiter", "desc", 
"difference", "distinct", "divide", "do", "double", "drop", "else", "empty", "encoding", "end", "equals", 
"for", "from", "function", "go", "goto", "grant", "greater", "group", "having", "identified", "if", "immediate", 
"in", "increment", "index", "initial", "inner", "inout", "input", "insert", "int", "integer", "intersect", 
"intersection", "into", "is", "isempty", "isnull", "join", "last", "left", "less", "like", "limit", "lock", "long", "max", 
"min", "minus", "mode", "modify", "modulo", "more", "multiply", "next", "noaudit", "not", "notin", "nowait", 
"null", "number", "object", "of", "on", "option", "or", "order", "outer", "output", "power", "previous", "prior", 
"privileges", "public", "raise", "raw", "remainder", "rename", "resource", "return", "returns", "revoke", 
"string", "subtract", "sum", "synonym", "table", "then", "to", "trans", "transaction", "trigger", "true", "uid", 
"union", "unique", "update", "user", "validate", "values", "view", "when", "whenever", "where", "while", "with"

Performing text searches

You can use Lucene’s text-searching features when performing searches on the following fields by using the CONTAINS operator.

- Summary.
- Description.
- Environment.
- Comments.
- Custom fields that use the "Free Text Searcher”. These are custom fields of the following built-in custom field types: Free Text Field, Text Field, and Read-only Text Field.

When searching for text fields, you can also usesingle and multiple character wildcard searches. For more information, see Search syntax for text fields.

Differences between day and time search

A day (1d) and time (24h) values are differently calculated in a query and don't return the same results:

- If you specify "1d", the start of the day will start calculating at 00:00 of the server timezone unless you also add the exact time. "1d" will also include the current day if you execute the query now. It doesn't take into account the amount of time relative to the time you had executed the query (24 hours from the time you executed the JQL).
- If you use "24h", it will start calculating from the hour when you executed it (-24 hours from the time you run the JQL).

Example

Let's assume that you updated an issue's status to "Closed" yesterday at 3 PM. You run the following queries at 1 PM today:

- status changed to "Closed" after -1d won't return the closed issue. However, it'll return the result if you run status changed to "Closed" after -2d.
- status changed to "Closed" after -24h will return the closed issue.
Reference

Here you can find a brief overview of Jira fields, operators, keywords, and functions used to compose JQL queries. For detailed description and examples of their usage for advance searching, check the links from the Reference column.

<table>
<thead>
<tr>
<th>Description</th>
<th>Reference</th>
</tr>
</thead>
</table>


### Fields

A field in JQL is a word that represents a Jira field (or a custom field that has already been defined in Jira). You can perform an advanced search on your Jira fields to look for issues created on, before, or after a particular date (or date range) and time.

To view a detailed information about fields and how to use them for advanced searching, check out Fields reference page.

- affectedVersion
- approvals
- assignee
- attachments
- category
- comment
- component
- created
- creator
- customFieldName
- "Customer Request Type"
- description
- due
- environment
- "epic link"
- filter
- fixVersion
- issueKey
- Issue link type
- labels
- lastViewed
- level
- originalEstimate
- parent
- priority
- project
- remainingEstimate
- reporter
- request-channel-type
- request-last-activity-time
- resolution
- resolved
- sprint
- status
- summary
- text
- timeSpent
- type
- updated
- voter
- votes
- watcher
- watchers
- worklogAuthor
- WorklogComment
- WorklogDate
- WorkRatio
<table>
<thead>
<tr>
<th>Operators</th>
<th>An operator in JQL is one or more symbols or words that compare the value of a field on its left with one or more values (or functions) on its right, such that only true results are retrieved by the clause. Some operators may use the NOT keyword.</th>
</tr>
</thead>
<tbody>
<tr>
<td>To view a detailed information about operators and how to use them for advanced searching, check out Operators reference page.</td>
<td></td>
</tr>
<tr>
<td>• EQUALS: =</td>
<td></td>
</tr>
<tr>
<td>• NOT EQUALS: !=</td>
<td></td>
</tr>
<tr>
<td>• GREATER THAN: &gt;</td>
<td></td>
</tr>
<tr>
<td>• GREATER THAN EQUALS: &gt;=</td>
<td></td>
</tr>
<tr>
<td>• LESS THAN: &lt;</td>
<td></td>
</tr>
<tr>
<td>• LESS THAN EQUALS: &lt;=</td>
<td></td>
</tr>
<tr>
<td>• IN</td>
<td></td>
</tr>
<tr>
<td>• NOT IN</td>
<td></td>
</tr>
<tr>
<td>• CONTAINS: ~</td>
<td></td>
</tr>
<tr>
<td>• DOES NOT CONTAIN: !~</td>
<td></td>
</tr>
<tr>
<td>• IS</td>
<td></td>
</tr>
<tr>
<td>• IS NOT</td>
<td></td>
</tr>
<tr>
<td>• WAS</td>
<td></td>
</tr>
<tr>
<td>• WAS IN</td>
<td></td>
</tr>
<tr>
<td>• WAS NOT IN</td>
<td></td>
</tr>
<tr>
<td>• WAS NOT</td>
<td></td>
</tr>
<tr>
<td>• CHANGED</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Keywords</th>
<th>A keyword in JQL is a word or phrase that does (or is) any of the following:</th>
</tr>
</thead>
<tbody>
<tr>
<td>• joins two or more clauses together to form a complex JQL query.</td>
<td></td>
</tr>
<tr>
<td>• alters the logic of one or more clauses.</td>
<td></td>
</tr>
<tr>
<td>• alters the logic of operators.</td>
<td></td>
</tr>
<tr>
<td>• has an explicit definition in a JQL query.</td>
<td></td>
</tr>
<tr>
<td>• performs a specific function that alters the results of a JQL query.</td>
<td></td>
</tr>
<tr>
<td>To view a detailed information about keywords and how to use them for advanced searching, check out Keywords reference page.</td>
<td></td>
</tr>
<tr>
<td>• AND</td>
<td></td>
</tr>
<tr>
<td>• OR</td>
<td></td>
</tr>
<tr>
<td>• NOT</td>
<td></td>
</tr>
<tr>
<td>• EMPTY</td>
<td></td>
</tr>
<tr>
<td>• NULL</td>
<td></td>
</tr>
<tr>
<td>• ORDER BY</td>
<td></td>
</tr>
</tbody>
</table>
### Functions

A function in JQL appears as a word followed by parentheses, which may contain one or more explicit values or Jira fields.

A function performs a calculation on either specific Jira data or the function’s content in parentheses, such that only true results are retrieved by the function, and then again by the clause in which the function is used.

To view a detailed information about functions and how to use them for advanced searching, check out Functions reference page.

- approved()
- approver()
- cascadeOption()
- closedSprints()
- componentsLeadByUser()
- currentLogin()
- currentUser()
- earliestUnreleasedVersion()
- endOfDay()
- endOfMonth()
- endOfWeek()
- endOfYear()
- issueHistory()
- issuesWithRemoteLinksByGlobalId()
- lastLogin()
- latestReleasedVersion()
- linkedIssues()
- membersOf()
- myApproval()
- myPending()
- now()
- openSprints()
- pending()
- pendingBy()
- projectsLeadByUser()
- projectsWhereUserHasPermission()
- projectsWhereUserHasRole()
- releasedVersions()
- standardIssueTypes()
- startOfDay()
- startOfMonth()
- startOfWeek()
- startOfYear()
- subtaskIssueTypes()
- unreleasedVersions()
- votedIssues()
- watchedIssues()

### Running a saved search

You can find saved searches (also known as Saving your search as a filter) in the left-side panel, when using advanced search. If the left panel is not showing, hover your mouse over the left side of the screen to display it.
To run a filter, such as **New_issues**, select the filter name. The JQL for the advanced search will be set, and the search results will be displayed.

1. A **search saved as a filter**, which returns issues based on the criteria specified in a JQL query.
2. **JQL query** that specifies search criteria.
3. **Issues** that match the search criteria.

If you want to delete a saved search, see [Deleting a filter](#).

**Notes**

To find out the version of Lucene Jira Software is using, go to `/installation-directory/atlassian-jira/WEB-INF/lib` and locate the Lucene jar files. The Lucene version number will be part of the filename.
Advanced searching - fields reference

This page describes information about fields that are used for advanced searching. A field in JQL is a word that represents a Jira field (or a custom field that has already been defined in your Jira applications). In a clause, a field is followed by an operator, which in turn is followed by one or more values (or functions). The operator compares the value of the field with one or more values or functions on the right, such that only true results are retrieved by the clause. Note: it is not possible to compare two fields in JQL.

Affected version

Search for issues that are assigned to a particular affects version(s). You can search by version name or version ID (i.e. the number that Jira automatically allocates to a version). Note, it is better to search by version ID than by version name. Different projects may have versions with the same name. It is also possible for your Jira administrator to change the name of a version, which could break any saved filters that rely on that name. Version IDs, however, are unique and cannot be changed.

Syntax

<table>
<thead>
<tr>
<th>Syntax</th>
<th>affectedVersion</th>
</tr>
</thead>
</table>

Field Type

<table>
<thead>
<tr>
<th>Field Type</th>
<th>VERSION</th>
</tr>
</thead>
</table>

Auto-complete

| Yes |

Supported operators

<table>
<thead>
<tr>
<th>=, !=, &gt;, &gt;=, &lt;, &lt;=, <del>, !</del> IS, IS NOT, IN, NOT IN</th>
</tr>
</thead>
</table>

- The comparison operators (e.g. ">") use the version order that has been set up by your project administrator, not a numeric or alphabetic order.
- For this field, the contain operators (~ and !~) find exact matches, and can be used to search through versions with a wildcard.

Unsupported operators

<table>
<thead>
<tr>
<th>WAS, WAS IN, WAS NOT, WAS NOT IN, CHANGED</th>
</tr>
</thead>
</table>

Supported functions

When used with the IN and NOT IN operators, this field supports:

- releasedVersions()
- latestReleasedVersion()
- unreleasedVersions()
- earliestUnreleasedVersion()

Examples

- Find issues with an AffectedVersion of 3.14:
  affectedVersion = "3.14"
  Note that full-stops are reserved characters and need to be surrounded by quote-marks.
- Find issues with an AffectedVersion of "Big Ted":
  affectedVersion = "Big Ted"
- Find issues with an AffectedVersion ID of 10350:
  affectedVersion = 10350
Approvals

Only applicable if Jira Service Management is installed and licensed, and you're using the Approvals functionality.

Search for issues that have been approved or require approval. This can be further refined by user.

<table>
<thead>
<tr>
<th>Syntax</th>
<th>approvals</th>
</tr>
</thead>
<tbody>
<tr>
<td>Field Type</td>
<td>USER</td>
</tr>
<tr>
<td>Auto-complete</td>
<td>No</td>
</tr>
<tr>
<td>Supported operators</td>
<td>=</td>
</tr>
</tbody>
</table>

Unsupported operators: ~, !, !=, >, >=, <, <=, IS, IS NOT, IN, NOT IN, WAS, WAS IN, WAS NOT, WAS NOT IN, CHANGED

Supported functions:
- approved()
- approver()
- myApproval()
- myPending()
- pending()
- pendingBy()

Examples:
- Find issues that require or required approval by John Smith:
  ```
  approval = approver(jsmith)
  ```
- Find issues that require approval by John Smith:
  ```
  approval = pendingBy(jsmith)
  ```
- Find issues that require approval by the current user:
  ```
  approval = myPending()
  ```
- Find all issues that require approval:
  ```
  approval = pending()
  ```

Assignee

Search for issues that are assigned to a particular user. You can search by the user’s full name, ID, or email address.

<table>
<thead>
<tr>
<th>Syntax</th>
<th>assignee</th>
</tr>
</thead>
<tbody>
<tr>
<td>Alias</td>
<td>cf[CustomFieldID]</td>
</tr>
<tr>
<td>Field Type</td>
<td>USER</td>
</tr>
<tr>
<td>Auto-complete</td>
<td>Yes</td>
</tr>
</tbody>
</table>
Supported operators

<table>
<thead>
<tr>
<th>Operator</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>=, !=</td>
<td>Is equal to or not equal to</td>
</tr>
<tr>
<td>IS, IS NOT, IN, NOT IN, WAS, WAS IN, WAS NOT, WAS NOT IN, CHANGED</td>
<td>Note that the comparison operators (e.g. <code>&gt;</code>) use the version order that has been set up by your project administrator, not a numeric or alphabetic order.</td>
</tr>
</tbody>
</table>

Unsupported operators

<table>
<thead>
<tr>
<th>Operator</th>
</tr>
</thead>
<tbody>
<tr>
<td><del>, !</del>, &gt;, &gt;=, &lt;, &lt;=</td>
</tr>
</tbody>
</table>

Supported functions

When used with the `IN` and `NOT IN` operators, this field supports:

- `membersOf()`

When used with the `EQUALS` and `NOT EQUALS` operators, this field supports:

- `currentUser()`

Examples

- Find issues that are assigned to John Smith:
  
  ```
  assignee = "John Smith"
  ```

- Find issues that are currently assigned, or were previously assigned, to John Smith:

  ```
  assignee WAS "John Smith"
  ```

- Find issues that are assigned by the user with email address "bob@mycompany.com":

  ```
  assignee = "bob@mycompany.com"
  ```

Note that full-stops and `@` symbols are reserved characters and need to be surrounded by quotation marks.

Attachments

Search for issues that have or do not have attachments.

<table>
<thead>
<tr>
<th>Syntax</th>
<th>attachments</th>
</tr>
</thead>
<tbody>
<tr>
<td>Field Type</td>
<td>ATTACHMENT</td>
</tr>
<tr>
<td>Auto-complete</td>
<td>Yes</td>
</tr>
</tbody>
</table>

Supported operators

<table>
<thead>
<tr>
<th>Operator</th>
</tr>
</thead>
<tbody>
<tr>
<td>IS, IS NOT</td>
</tr>
</tbody>
</table>

Unsupported operators

<table>
<thead>
<tr>
<th>Operator</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>=, !=, <del>, !</del>, &gt;, &gt;=, &lt;, &lt;= IN, NOT IN, WAS, WAS IN, WAS NOT, WAS NOT IN, CHANGED</td>
<td></td>
</tr>
</tbody>
</table>

Supported functions

None
### Examples

- Search for issues that have attachments:
  
  attachments IS NOT EMPTY

- Search for issues that do not have attachments:
  
  attachments IS EMPTY

---

### Category

Search for issues that belong to projects in a particular category.

<table>
<thead>
<tr>
<th>Syntax</th>
<th>category</th>
</tr>
</thead>
<tbody>
<tr>
<td>Field Type</td>
<td>CATEGORY</td>
</tr>
<tr>
<td>Auto-complete</td>
<td>Yes</td>
</tr>
</tbody>
</table>
| Supported operators | =, !=
  
  IS, IS NOT, IN, NOT IN |
| Unsupported operators | ~, !~
  
  >, >=, <, <=
  
  WAS, WAS IN, WAS NOT, WAS NOT IN, CHANGED |
| Supported functions | None |

**Examples**

- Find issues that belong to projects in the "Alphabet Projects" Category:
  
  category = "Alphabet Projects"

---

### Comment

Search for issues that have a comment that contains particular text. **Jira text-search syntax** can be used.

<table>
<thead>
<tr>
<th>Syntax</th>
<th>comment</th>
</tr>
</thead>
<tbody>
<tr>
<td>Field Type</td>
<td>TEXT</td>
</tr>
<tr>
<td>Auto-complete</td>
<td>No</td>
</tr>
<tr>
<td>Supported operators</td>
<td><del>, !</del></td>
</tr>
</tbody>
</table>
| Unsupported operators | =, !=, >, >=, <, <=
  
  IS, IS NOT, IN, NOT IN, WAS, WAS IN, WAS NOT, WAS NOT IN, CHANGED |
| Supported functions | None |

---
Examples

- Find issues where a comment contains text that matches "My PC is quite old" (i.e. a "fuzzy" match):
  \[\text{comment} \sim "\text{My PC is quite old}"\]
- Find issues where a comment contains the exact phrase "My PC is quite old":
  \[\text{comment} \sim "\text{"My PC is quite old"}\]
Or use "w" (weeks), "d" (days), "h" (hours) or "m" (minutes) to specify a date relative to the current time. The default is "m" (minutes). Be sure to use quote-marks ("); if you omit the quote-marks, the number you supply will be interpreted as milliseconds after epoch (1970-1-1).

<table>
<thead>
<tr>
<th>Syntax</th>
<th>created</th>
</tr>
</thead>
<tbody>
<tr>
<td>Alias</td>
<td>createdDate</td>
</tr>
<tr>
<td>Field Type</td>
<td>DATE</td>
</tr>
<tr>
<td>Auto-complete</td>
<td>No</td>
</tr>
<tr>
<td>Supported operators</td>
<td>=, !=, &gt;, &gt;=, &lt;, &lt;= IS, IS NOT, IN, NOT IN</td>
</tr>
<tr>
<td>Unsupported operators</td>
<td><del>, !</del> WAS, WAS IN, WAS NOT, WAS NOT IN, CHANGED</td>
</tr>
<tr>
<td>Supported functions</td>
<td>When used with the EQUALS, NOT EQUALS, GREATER THAN, GREATER THAN EQUALS, LESS THAN or LESS THAN EQUALS operators, this field supports:</td>
</tr>
<tr>
<td></td>
<td>currentLogin()</td>
</tr>
<tr>
<td></td>
<td>lastLogin()</td>
</tr>
<tr>
<td></td>
<td>now()</td>
</tr>
<tr>
<td></td>
<td>startOfDay()</td>
</tr>
<tr>
<td></td>
<td>startOfWeek()</td>
</tr>
<tr>
<td></td>
<td>startOfMonth()</td>
</tr>
<tr>
<td></td>
<td>startOfYear()</td>
</tr>
<tr>
<td></td>
<td>endOfDay()</td>
</tr>
<tr>
<td></td>
<td>endOfWeek()</td>
</tr>
<tr>
<td></td>
<td>endOfMonth()</td>
</tr>
<tr>
<td></td>
<td>endOfYear()</td>
</tr>
<tr>
<td>Examples</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Find all issues created before 12th December 2010: created &lt; &quot;2010/12/12&quot;</td>
</tr>
<tr>
<td></td>
<td>Find all issues created on or before 12th December 2010: created &lt;= &quot;2010/12/13&quot;</td>
</tr>
<tr>
<td></td>
<td>Find all issues created on 12th December 2010 before 2:00pm: created &gt; &quot;2010/12/12&quot; and created &lt; &quot;2010/12/12 14:00&quot;</td>
</tr>
<tr>
<td></td>
<td>Find issues created less than one day ago: created &gt; &quot;-1d&quot;</td>
</tr>
<tr>
<td></td>
<td>Find issues created in January 2011: created &gt; &quot;2011/01/01&quot; and created &lt; &quot;2011/02/01&quot;</td>
</tr>
<tr>
<td></td>
<td>Find issues created on 15 January 2011: created &gt; &quot;2011/01/15&quot; and created &lt; &quot;2011/01/16&quot;</td>
</tr>
</tbody>
</table>
Search for issues that were created by a particular user. You can search by the user's full name, ID, or email address.

<table>
<thead>
<tr>
<th>Syntax</th>
<th>creator</th>
</tr>
</thead>
<tbody>
<tr>
<td>Field Type</td>
<td>USER</td>
</tr>
<tr>
<td>Auto-complete</td>
<td>Yes</td>
</tr>
<tr>
<td>Supported operators</td>
<td>= , !=, IS , IS NOT , IN , NOT IN, WAS, WAS IN, WAS NOT, WAS NOT IN</td>
</tr>
<tr>
<td>Unsupported operators</td>
<td>~ , !~ , &gt; , &gt;= , &lt; , &lt;=, CHANGED</td>
</tr>
</tbody>
</table>
| Supported functions | When used with the IN and NOT IN operators, this field supports:  
  - membersOf()  
When used with the EQUALS and NOT EQUALS operators, this field supports:  
  - currentUser() |
| Examples |  
  - Search for issues that were created by Jill Jones:  
    creator = "Jill Jones"  
    or  
    creator = "jjones"  
  - Search for issues that were created by the user with email address "bob@mycompany.com":  
    creator = "bob@mycompany.com"  
    (Note that full-stops and "@" symbols are reserved characters, so the email address needs to be surrounded by quote-marks.) |

Custom field

Only applicable if your Jira administrator has created one or more custom fields.

Search for issues where a particular custom field has a particular value. You can search by custom fieldname or custom fieldID (i.e. the number that Jira automatically allocates to an custom field).

Note, it is safer to search by custom fieldID than by custom fieldname. It is possible for a custom field to have the same name as a built-in Jira system field; in which case, Jira will search for the system field (not your custom field). It is also possible for your Jira administrator to change the name of a custom field, which could break any saved filters that rely on that name. Custom fieldIDs, however, are unique and cannot be changed.

<table>
<thead>
<tr>
<th>Syntax</th>
<th>CustomFieldName</th>
</tr>
</thead>
<tbody>
<tr>
<td>Alias</td>
<td>cf[CustomFieldID]</td>
</tr>
</tbody>
</table>
| Field Type | Depends on the custom field's configuration  
  *Note, Jira text-search syntax can be used with custom fields of type ’Text’. |
<table>
<thead>
<tr>
<th><strong>Auto-complete</strong></th>
<th>Yes, for custom fields of type picker, group picker, select, checkbox and radio button fields</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Supported operators</strong></td>
<td>Different types of custom field support different operators.</td>
</tr>
</tbody>
</table>
| **Supported operators: number and date fields** | $=, !=, >, >=, <, <=$  
$IS, IS\ NOT, IN, NOT\ IN$ |
| **Unsupported operators: number and date fields** | $\sim, \!\sim$  
$WAS, WAS\ IN, WAS\ NOT, WAS\ NOT\ IN, CHANGED$ |
| **Supported operators: picker, select, checkbox and radio button fields** | $=, !=, >, >=, <, <=$  
$IS, IS\ NOT, IN, NOT\ IN$ |
| **Unsupported operators: picker, select, checkbox and radio button fields** | $\sim, \!\sim, >, >=, <, <=$  
$WAS, WAS\ IN, WAS\ NOT, WAS\ NOT\ IN, CHANGED$ |
| **Supported operators: text fields** | $\sim, \!\sim$  
$IS, IS\ NOT$ |
| **Unsupported operators: text fields** | $=, !=, >, >=, <, <=$  
$IN, NOT\ IN, WAS, WAS\ IN, WAS\ NOT, WAS\ NOT\ IN, CHANGED$ |
| **Unsupported operators** | $\sim, \!\sim, >, >=, <, <=$  
$WAS, WAS\ IN, WAS\ NOT, WAS\ NOT\ IN, CHANGED$ |
| **Supported functions** | Different types of custom fields support different functions. |
| **Supported functions: date/time fields** | When used with the **EQUALS, NOT EQUALS, GREATER THAN, GREATER THAN EQUALS, LESS THAN** or **LESS THAN EQUALS** operators, this field supports: |
|  | • currentLogin()  
|  | • lastLogin()  
|  | • now()  
|  | • startOfDay()  
|  | • startOfWeek()  
|  | • startOfMonth()  
|  | • startOfYear()  
|  | • endOfDay()  
|  | • endOfWeek()  
|  | • endOfMonth()  
|  | • endOfYear()  

Supported functions: version picker fields

Version picker fields: When used with the IN and NOT IN operators, this field supports:

- releasedVersions()
- latestReleasedVersion()
- unreleasedVersions()
- earliestUnreleasedVersion()

Examples

- Find issues where the value of the "Location" custom field is "New York":
  location = "New York"
- Find issues where the value of the custom field with ID 10003 is "New York":
  cf[ 10003 ] = "New York"
- Find issues where the value of the "Location" custom field is "London" or "Milan" or "Paris":
  cf[ 10003 ] in ( "London" , "Milan" , "Paris" )
- Find issues where the "Location" custom field has no value:
  location != empty

Customer Request Type

Only applicable if Jira Service Management is installed and licensed.

Search for Issues matching a specific Customer Request Type in a service desk project. You can search for a Customer Request Type either by name or description as configured in the Request Type configuration screen.

<table>
<thead>
<tr>
<th>Syntax</th>
<th>&quot;Customer Request Type&quot;</th>
</tr>
</thead>
<tbody>
<tr>
<td>Field Type</td>
<td>Custom field</td>
</tr>
<tr>
<td>Auto-complete</td>
<td>Yes</td>
</tr>
</tbody>
</table>
| Supported operators | = , !=
| IN , NOT IN     |                          |
| Unsupported operators | ~ , !~, > , >= , < , <=
| IS , IS NOT , WAS , WAS IN , WAS NOT , WAS NOT IN , CHANGED |

Note that the Lucene value for Customer Request Type, is portal-key/request-type-key. While the portal key cannot be changed after a service desk portal is created, the project key can be changed. The Request Type key cannot be changed once the Request Type is created.
### Examples

- Find issues where Customer Request Type is **Request a new account** in projects that the user has access to:
  
  "Customer Request Type" = "Request a new account"

- Find issues where the Customer Request Type is **Request a new account** in **Simpl eDesk project**, where the right operand is a selected Lucene value from the auto-complete suggestion list.
  
  "Customer Request Type" = "sd/system-access"

- Find issues where Customer Request Type is either **Request a new account** or **Get IT Help**.
  
  "Customer Request Type" IN( "Request a new account", "Get IT Help")

### Description

Search for issues where the description contains particular text. Jira text-search syntax can be used.

<table>
<thead>
<tr>
<th>Syntax</th>
<th>description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Field Type</td>
<td>TEXT</td>
</tr>
<tr>
<td>Auto-complete</td>
<td>No</td>
</tr>
<tr>
<td>Supported operators</td>
<td><del>, !</del> IS, IS NOT</td>
</tr>
<tr>
<td>Unsupported operators</td>
<td>=, != , &gt; , &gt;= , &lt; , &lt;= IN , NOT IN , WAS, WAS IN, WAS NOT, WAS NOT IN , CHANGED</td>
</tr>
<tr>
<td>Supported functions</td>
<td>None</td>
</tr>
<tr>
<td>Examples</td>
<td></td>
</tr>
</tbody>
</table>

- Find issues where the description contains text that matches "Please see screenshot" (i.e. a "fuzzy" match):
  
  description ~ "Please see screenshot"

- Find issues where the description contains the exact phrase "Please see screenshot":
  
  description ~ "\"Please see screenshot\""

### Due

Search for issues that were due on, before, or after a particular date (or date range). Note that the due date relates to the *date* only (not to the time).

Use one of the following formats:

- "yyyy/MM/dd"
- "yyyy-MM-dd"

Or use "w" (weeks) or "d" (days) to specify a date relative to the current date. Be sure to use quote-marks (").
<table>
<thead>
<tr>
<th>Alias</th>
<th>dueDate</th>
</tr>
</thead>
<tbody>
<tr>
<td>Field Type</td>
<td>DATE</td>
</tr>
<tr>
<td>Auto-complete</td>
<td>No</td>
</tr>
<tr>
<td>Supported operators</td>
<td>= , != , &gt; , &gt;= , &lt; , &lt;= IS , IS NOT , IN , NOT IN</td>
</tr>
<tr>
<td>Unsupported operators</td>
<td>~ , !~ WAS , WAS IN , WAS NOT , WAS NOT IN , CHANGED</td>
</tr>
</tbody>
</table>

**Supported functions**

When used with the **EQUALS, NOT EQUALS, GREATER THAN, GREATER THAN EQUALS, LESS THAN, LESS THAN EQUALS** operators, this field supports:

- `currentLogin()`
- `lastLogin()`
- `now()`
- `startOfDay()`
- `startOfWeek()`
- `startOfMonth()`
- `startOfYear()`
- `endOfDay()`
- `endOfWeek()`
- `endOfMonth()`
- `endOfYear()`

**Examples**

- Find all issues due before 31st December 2010:
  
  `due < "2010/12/31"`

- Find all issues due on or before 31st December 2010:
  
  `due <= "2011/01/01"

- Find all issues due tomorrow:
  
  `due = "1d"

- Find all issues due in January 2011:
  
  `due >= "2011/01/01" and due <= "2011/01/31"

- Find all issues due on 15 January 2011:
  
  `due = "2011/01/15"

---

**Environment**

Search for issues where the environment contains particular text. **Jira text-search syntax** can be used.

<table>
<thead>
<tr>
<th>Syntax</th>
<th>environment</th>
</tr>
</thead>
<tbody>
<tr>
<td>Field Type</td>
<td>TEXT</td>
</tr>
<tr>
<td>Auto-complete</td>
<td>No</td>
</tr>
<tr>
<td>Supported operators</td>
<td>~ , !~ IS , IS NOT</td>
</tr>
<tr>
<td>Unsupported operators</td>
<td>= , != , &gt; , &gt;= , &lt; , &lt;= IN , NOT IN , WAS , WAS IN , WAS NOT , WAS NOT IN , CHANGED</td>
</tr>
</tbody>
</table>
**Supported functions**

None

---

**Examples**

- Find issues where the environment contains text that matches "Third floor" (i.e. a "fuzzy" match):
  
  environment ~ "Third floor"

- Find issues where the environment contains the exact phrase "Third floor":
  
  environment ~ "\"Third floor\""

---

**Epic link**

Search for issues that belong to a particular epic. The search is based on either the epic's name, issue key, or issue ID (i.e. the number that Jira automatically allocates to an issue).

**Syntax**

"epic link"

**Field Type**

Epic Link Relationship

**Auto-complete**

Yes

**Supported operators**

= , !=

IS , IS NOT, IN , NOT IN

**Unsupported operators**

~ , != , >, >=, < , <=

WAS, WAS IN, WAS NOT, WAS NOT IN , CHANGED

**Supported functions**

When used with the **NOT** operator, epic link supports:

- issueHistory()
- linkedIssues()
- votedIssues()
- watchedIssues()

**Examples**

- Find issues that belong to epic "Jupiter", where "Jupiter has the issue key ANERDS-31:

  "epic link"= ANERDS-31
  
  or
  
  "epic link"= Jupiter

---

**Filter**

You can use a saved filter to narrow your search. You can search by filter name or filter ID (i.e. the number that Jira automatically allocates to a saved filter).

**Note:**

- It is safer to search by filter ID than by filter name. It is possible for a filter name to be changed, which could break a saved filter that invokes another filter by name. Filter IDs, however, are unique and cannot be changed.
- An unnamed link statement in your typed query will override an ORDER BY statement in the saved filter.
• You cannot run or save a filter that would cause an infinite loop (i.e. you cannot reference a saved filter if it eventually references your current filter).

<table>
<thead>
<tr>
<th>Syntax</th>
<th>filter</th>
</tr>
</thead>
<tbody>
<tr>
<td>Aliases</td>
<td>request, savedFilter, searchRequest</td>
</tr>
<tr>
<td>Field Type</td>
<td>Filter</td>
</tr>
<tr>
<td>Auto-complete</td>
<td>Yes</td>
</tr>
<tr>
<td>Supported operators</td>
<td>=, !=, IN, NOT IN</td>
</tr>
<tr>
<td>Unsupported operators</td>
<td><del>, !</del>, &gt;, &gt;=, &lt;, &lt;=, IS, IS NOT, WAS, WAS IN, WAS NOT, WAS NOT IN, CHANGED</td>
</tr>
<tr>
<td>Supported functions</td>
<td>None</td>
</tr>
<tr>
<td>Examples</td>
<td>• Search the results of the filter &quot;My Saved Filter&quot; (which has an ID of 12000) for issues assigned to the user jsmith: filter = &quot;My Saved Filter&quot; and assignee = jsmith or filter = 12000 and assignee = jsmith</td>
</tr>
</tbody>
</table>

^ top of page

Fix version

Search for issues that are assigned to a particular fix version. You can search by version name or version ID (i.e. the number that Jira automatically allocates to a version).

Note, it is safer to search by version ID than by version name. Different projects may have versions with the same name, so searching by version name may return issues from multiple projects. It is also possible for your Jira administrator to change the name of a version, which could break any saved filters that rely on that name. Version IDs, however, are unique and cannot be changed.

<table>
<thead>
<tr>
<th>Syntax</th>
<th>fixVersion</th>
</tr>
</thead>
<tbody>
<tr>
<td>Field Type</td>
<td>VERSION</td>
</tr>
<tr>
<td>Auto-complete</td>
<td>Yes</td>
</tr>
<tr>
<td>Supported operators</td>
<td>=, !=, &gt;, &gt;=, &lt;, &lt;=, <del>, !</del>, IS, IS NOT, IN, NOT IN, WAS, WAS IN, WAS NOT, WAS NOT IN, CHANGED</td>
</tr>
<tr>
<td>Unsupported operators</td>
<td>The comparison operators (e.g. &quot;&gt;&quot;) use the version order that has been set up by your project administrator, not a numeric or alphabetic order. For this field, the contain operators (~ and !~) find exact matches, and can be used to search through versions with a wildcard.</td>
</tr>
</tbody>
</table>
When used with the \texttt{IN} and \texttt{NOT IN} operators, this field supports:

- \texttt{releasedVersions()}
- \texttt{latestReleasedVersion()}
- \texttt{unreleased Versions()}
- \texttt{earliestUnreleasedVersion()}

### Examples

- Find issues with a Fix Version of 3.14 or 4.2:
  \begin{verbatim}
  fixVersion \texttt{in} ("3.14", "4.2")
  \end{verbatim}
  (Note that full-stops are reserved characters, so they need to be surrounded by quote-marks.)

- Find issues with a Fix Version of "Little Ted":
  \begin{verbatim}
  fixVersion = "Little Ted"
  \end{verbatim}

- Find issues with a Fix Version ID of 10001:
  \begin{verbatim}
  fixVersion = 10001
  \end{verbatim}

### Issue key

Search for issues with a particular issue key or issue ID (i.e. the number that Jira automatically allocates to an issue).

<table>
<thead>
<tr>
<th>Syntax</th>
<th>issueKey</th>
</tr>
</thead>
</table>

| Aliases | id , issue , key |

| Field Type | ISSUE |

| Auto-complete | No |

| Supported operators | = , \texttt{!} = , > , \texttt{>=} , < , \texttt{<=} , \texttt{IS} , \texttt{IS NOT} , \texttt{IN} , \texttt{NOT IN} |

| Unsupported operators | \texttt{~} , \texttt{!~} , \texttt{WAS} , \texttt{WAS IN} , \texttt{WAS NOT} , \texttt{WAS NOT IN} , \texttt{CHANGED} |

| Supported functions | When used with the \texttt{IN} or \texttt{NOT IN} operators, \texttt{issueKey} supports: |

| - issueHistory() |
| - linkedIssues() |
| - updatedBy() |
| - votedIssues() |
| - watchedIssues() |

| Examples | Find the issue with the key "ABC-123":
  \begin{verbatim}
  issueKey = ABC-123
  \end{verbatim}

- Find several issues with the known keys "SCRUM-25" and "SCRUM-12":
  \begin{verbatim}
  issueKey \texttt{in} (SCRUM-25, SCRUM-12)
  \end{verbatim}
Issue linking allows you to create associations between issues on either the same or different Jira servers. For example, an issue may duplicate another issue or depend on the resolution of another issue. You can find detailed information about issue links in Configuring issue linking.

When searching for issues with a particular link type, you can only find linked issues that are on the same Jira instance you’re searching on. Links to issues on a remote Jira instance or to Confluence pages won’t be included.

Syntax

<table>
<thead>
<tr>
<th>Supported operators</th>
<th>Supported functions</th>
</tr>
</thead>
<tbody>
<tr>
<td>=, !=, IN, NOT IN</td>
<td>None</td>
</tr>
</tbody>
</table>

Examples

- Find issues with a link type of "blocks":
  issueLinkType = blocks
- Find issues with an issue type of "duplicates" or "is duplicated by":
  issueLinkType in (duplicates,"is duplicated by")
- Find issues with link types other than clones:
  issueLinkType != clones
  This query will also return issues with no links at all.
- Find issues that are blocker by other issues, or that don’t have any blockers.
  issueLinkType = "is blocked by"
  issueLinkType != "is blocked by"

Labels

Search for issues tagged with a label or list of labels. You can also search for issues without any labels to easily identify which issues need to be tagged so they show up in the relevant sprints, queues or reports.

Syntax

<table>
<thead>
<tr>
<th>Field Type</th>
<th>Label</th>
</tr>
</thead>
<tbody>
<tr>
<td>Auto-complete</td>
<td>Yes</td>
</tr>
</tbody>
</table>

Examples

- We recommend using IS or IS NOT to search for a single label, and IN or NOT IN to search for a list of labels.
- For example, add a red stripe to issues that have some blockers, and keep all other issues green. This will help you bring the right information to your teams attention, at a glance. For more info, see Customizing cards.
Supported functions

<table>
<thead>
<tr>
<th>Supported functions</th>
<th>None</th>
</tr>
</thead>
</table>

Examples

- Find issues with an existing label:
  
  `labels = "x"`

- Find issues without a specified label, including issues without a label:
  
  `labels not in ("x") or labels is EMPTY`

Last viewed

Search for issues that were last viewed on, before, or after a particular date (or date range). Note that if a time-component is not specified, midnight will be assumed. Please note that the search results will be relative to your configured time zone (which is by default the Jira server's time zone).

Use one of the following formats:

- `"yyyy/MM/dd HH:mm"`
- `"yyyy-MM-dd HH:mm"`
- `"yyyy/MM/dd"`
- `"yyyy-MM-dd"`

Or use "w" (weeks), "d" (days), "h" (hours) or "m" (minutes) to specify a date relative to the current time. The default is "m" (minutes). Be sure to use quote-marks ("); if you omit the quote-marks, the number you supply will be interpreted as milliseconds after epoch (1970-1-1).

Syntax

<table>
<thead>
<tr>
<th>Syntax</th>
<th>lastViewed</th>
</tr>
</thead>
</table>

Field Type

<table>
<thead>
<tr>
<th>Field Type</th>
<th>DATE</th>
</tr>
</thead>
</table>

Auto-complete

<table>
<thead>
<tr>
<th>Auto-complete</th>
<th>No</th>
</tr>
</thead>
</table>

Supported operators

<table>
<thead>
<tr>
<th>Supported operators</th>
<th>= , != , &gt; , &gt;= , &lt; , &lt;=</th>
</tr>
</thead>
</table>

Unsupported operators

<table>
<thead>
<tr>
<th>Unsupported operators</th>
<th>~ , !~</th>
</tr>
</thead>
</table>

Supported functions

When used with the **EQUALS, NOT EQUALS, GREATER THAN, GREATER THAN EQUALS, LESS THAN, LESS THAN EQUALS** operators, this field supports:

- `currentLogin()`
- `lastLogin()`
- `now()`
- `startOfDay()`
- `startOfWeek()`
- `startOfMonth()`
- `startOfYear()`
- `endOfDay()`
- `endOfWeek()`
- `endOfMonth()`
- `endOfYear()`
Examples

- Find all issues last viewed before 12th December 2010:
  `lastViewed < "2010/12/12"`
- Find all issues last viewed on or before 12th December 2010:
  `lastViewed <= "2010/12/13"`
- Find all issues last viewed on 12th December 2010 before 2:00pm:
  `lastViewed > "2010/12/12" and created < "2010/12/12 14:00"`
- Find issues last viewed less than one day ago:
  `lastViewed > "-1d"`
- Find issues last viewed in January 2011:
  `lastViewed > "2011/01/01" and created < "2011/02/01"`
- Find issues last viewed on 15 January 2011:
  `lastViewed > "2011/01/15" and created < "2011/01/16"`

Level

*Only available if issue level security has been enabled by your Jira administrator.*

Search for issues with a particular security level. You can search by issue level security name or issue level security ID (i.e. the number that Jira automatically allocates to an issue level security).

Note, it is safer to search by security level ID than by security level name. It is possible for your Jira administrator to change the name of a security level, which could break any saved filter that rely on that name. Security level IDs, however, are unique and cannot be changed.

<table>
<thead>
<tr>
<th>Syntax</th>
<th>level</th>
</tr>
</thead>
<tbody>
<tr>
<td>Field Type</td>
<td>SECURITY LEVEL</td>
</tr>
<tr>
<td>Auto-complete</td>
<td>Yes</td>
</tr>
<tr>
<td>Supported operators</td>
<td>=, !=, IS, IS NOT, IN, NOT IN</td>
</tr>
<tr>
<td>Unsupported operators</td>
<td>&gt;, &gt;=, &lt;, &lt;=, <del>, !</del>, WAS, WAS IN, WAS NOT, WAS NOT IN, CHANGED</td>
</tr>
<tr>
<td>Supported functions</td>
<td>None</td>
</tr>
</tbody>
</table>
| Examples   | Search for issues with a security level of "Really High" or "level1":
  level in ("Really High", level1)
  Search for issues with a security level ID of 123:
  level = 123 |

Original estimate

*Only available if time-tracking has been enabled by your Jira administrator.*

Search for issues where the original estimate is set to a particular value (i.e. a number, not a date or date range). Use "w", "d", "h" and "m" to specify weeks, days, hours, or minutes.

| Syntax | originalEstimate |
### Alias

<table>
<thead>
<tr>
<th>Field</th>
<th>timeOriginalEstimate</th>
</tr>
</thead>
</table>

**Field Type**: DURATION  
**Auto-complete**: No  
**Supported operators**: = , != , > , >= , < , <= , IS , IS NOT, IN , NOT IN  
**Unsupported operators**: ~ , !~ , WAS, WAS IN, WAS NOT, WAS NOT IN, CHANGED  
**Supported functions**: None  
**Examples**

- Find issues with an original estimate of 1 hour:  
  
  ```
  originalEstimate = 1h
  ```

- Find issues with an original estimate of more than 2 days:  
  
  ```
  originalEstimate > 2d
  ```

---

### Parent

Only available if sub-tasks have been enabled by your Jira administrator.  

Search for all sub-tasks of a particular issue. You can search by issue key or by issue ID (i.e. the number that Jira automatically allocates to an Issue).

**Syntax**:  
```parent```

**Field Type**: ISSUE  
**Auto-complete**: No  
**Supported operators**: = , != , IN , NOT IN  
**Unsupported operators**: > , >= , < , <= , ~ , !~ , IS , IS NOT, WAS, WAS IN, WAS NOT, WAS NOT IN, CHANGED  
**Supported functions**: None  
**Examples**

- Find issues that are sub-tasks of issue TEST-1234:  
  
  ```
  parent = TEST- 1234
  ```

---

### Priority

Search for issues with a particular priority. You can search by priorityname or priorityID (i.e. the number that Jira automatically allocates to a priority).

Note, it is safer to search by priorityID than by priorityname. It is possible for your Jira administrator to change the name of a priority, which could break any saved filter that rely on that name. Priority IDs, however, are unique and cannot be changed.
### Syntax

<table>
<thead>
<tr>
<th>priority</th>
</tr>
</thead>
</table>

### Field Type

PRORTY

### Auto-complete

Yes

### Supported operators

=, !=, >, >=, <, <=
IS, IS NOT, IN, NOT IN, WAS, WAS IN, WAS NOT, WAS NOT IN, CHANGED

### Unsupported operators

~, !~

### Supported functions

None

### Examples

- Find issues with a priority of "High":
  priority = High
- Find issues with a priority ID of 10000:
  priority = 10000

---

### Project

Search for issues that belong to a particular project. You can search by project name, by project key or by project ID (i.e. the number that Jira automatically allocates to a project). In the rare case where there is a project whose project key is the same as another project's name, then the project key takes preference and hides results from the second project.

<table>
<thead>
<tr>
<th>project</th>
</tr>
</thead>
</table>

### Field Type

PROJECT

### Auto-complete

Yes

### Supported operators

=, !=
IN, NOT IN
IS, IS NOT

### Unsupported operators

>, >=, <, <=, ~, !~
WAS, WAS IN, WAS NOT, WAS NOT IN, CHANGED

### Supported functions

When used with the `IN` and `NOT IN` operators, `project` supports:

- `projectsLeadByUser()`
- `projectsWhereUserHasPermission()`
- `projectsWhereUserHasRole()`

### Examples

- Find issues that belong to the Project that has the name "ABC Project":
  project = "ABC Project"
- Find issues that belong to the project that has the key "ABC":
  project = "ABC"
- Find issues that belong to the project that has the ID "1234":
  project = 1234

---

Created in 2023 by Atlassian. Licensed under a [Creative Commons Attribution 2.5 Australia License](https://creativecommons.org/licenses/by/2.5/au/).
Remaining estimate

*Only available if time-tracking has been enabled by your Jira administrator.*

Search for issues where the remaining estimate is set to a particular value (i.e. a number, not a date or date range). Use "w", "d", "h" and "m" to specify weeks, days, hours, or minutes.

<table>
<thead>
<tr>
<th>Syntax</th>
<th>remainingEstimate</th>
</tr>
</thead>
<tbody>
<tr>
<td>Alias</td>
<td>timeEstimate</td>
</tr>
<tr>
<td>Field Type</td>
<td>DURATION</td>
</tr>
<tr>
<td>Auto-complete</td>
<td>No</td>
</tr>
<tr>
<td>Supported operators</td>
<td>= , != , &gt; , &gt;= , &lt; , &lt;=</td>
</tr>
<tr>
<td></td>
<td>IS , IS NOT , IN , NOT IN</td>
</tr>
<tr>
<td>Unsupported operators</td>
<td>~ , !~</td>
</tr>
<tr>
<td></td>
<td>WAS, WAS IN, WAS NOT, WAS NOT IN , CHANGED</td>
</tr>
<tr>
<td>Supported functions</td>
<td>None</td>
</tr>
<tr>
<td>Examples</td>
<td>• Find issues with a remaining estimate of more than 4 hours: remainingEstimate &gt; 4h</td>
</tr>
</tbody>
</table>

Reporter

Search for issues that were reported by a particular user. This may be the same as the creator, but can be distinct. You can search by the user's full name, ID, or email address.

<table>
<thead>
<tr>
<th>Syntax</th>
<th>reporter</th>
</tr>
</thead>
<tbody>
<tr>
<td>Field Type</td>
<td>USER</td>
</tr>
<tr>
<td>Auto-complete</td>
<td>Yes</td>
</tr>
<tr>
<td>Supported operators</td>
<td>= , !=</td>
</tr>
<tr>
<td></td>
<td>IS , IS NOT, IN , NOT IN</td>
</tr>
<tr>
<td></td>
<td>WAS, WAS IN, WAS NOT, WAS NOT IN , CHANGED</td>
</tr>
<tr>
<td>Unsupported operators</td>
<td>~ , !~ , &gt; , &gt;= , &lt; , &lt;=</td>
</tr>
<tr>
<td>Supported functions</td>
<td>When used with the IN and NOT IN operators, this field supports:</td>
</tr>
<tr>
<td></td>
<td>• membersOf()</td>
</tr>
<tr>
<td></td>
<td>When used with the EQUALS and NOT EQUALS operators, this field supports:</td>
</tr>
<tr>
<td></td>
<td>• currentUser()</td>
</tr>
</tbody>
</table>
Examples

- Search for issues that were reported by Jill Jones:
  
  reporter = "Jill Jones"
  
or
  reporter = jJones
  
- Search for issues that were reported by the user with email address "bob@mycompany.com":
  
  reporter = "bob@mycompany.com"

(Note that full-stops and "@" symbols are reserved characters, so the email address needs to be surrounded by quote-marks.)

Request channel type

Only applicable if Jira Service Management is installed and licensed.

Search for issues that were requested through a specific channel (e.g. issues submitted via email or through a Service Desk portal).

<table>
<thead>
<tr>
<th>Syntax</th>
<th>request-channel-type</th>
</tr>
</thead>
<tbody>
<tr>
<td>Field Type</td>
<td>TEXT</td>
</tr>
<tr>
<td>Auto-complete</td>
<td>Yes</td>
</tr>
<tr>
<td>Supported operators</td>
<td>= , !=</td>
</tr>
<tr>
<td></td>
<td>IS, IS NOT, IN, NOT IN</td>
</tr>
<tr>
<td>Unsupported operators</td>
<td>~ , !~ , &gt; , &gt;= , &lt; , &lt;=</td>
</tr>
<tr>
<td></td>
<td>WAS, WAS IN, WAS NOT, WAS NOT IN, CHANGED</td>
</tr>
</tbody>
</table>

Supported functions

When used with the **IN** and **NOT IN** operators, this field supports:

- email: requests submitted via email
- Jira: requests created using Jira
- portal: requests created using a Service Desk portal
- api: requests created using a REST API

Examples

- Find issues where the request channel was email:
  
  request-channel-type = email

- Find issues where the request channel was something other than a service desk portal:
  
  request-channel-type != portal

Request last activity time

Only applicable if Jira Service Management is installed and licensed.

Search for issues that were last acted on or created:

- on a particular date.
before/after a particular date (or date range).

Note that if a time-component is not specified, midnight will be assumed. Please note that the search results will be relative to your configured time zone (which is by default the Jira server's time zone).

Use one of the following formats:

"yyyy/MM/dd HH:mm"
"yyyy-MM-dd HH:mm"
"yyyy/MM/dd"
"yyyy-MM-dd"

Or use "w" (weeks), "d" (days), "h" (hours) or "m" (minutes) to specify a date relative to the current time. The default is "m" (minutes). Be sure to use quote-marks ("); if you omit the quote-marks, the number you supply will be interpreted as milliseconds after epoch (1970-1-1).

<table>
<thead>
<tr>
<th>Syntax</th>
<th>request-last-activity-time</th>
</tr>
</thead>
<tbody>
<tr>
<td>Field Type</td>
<td>DATE</td>
</tr>
<tr>
<td>Auto-complete</td>
<td>Yes</td>
</tr>
<tr>
<td>Supported operators</td>
<td>= , != , &gt; , &gt;= , &lt; , &lt;= IS, IS NOT, IN, NOT IN</td>
</tr>
<tr>
<td>Unsupported operators</td>
<td>~ , !~ WAS, WAS IN, WAS NOT, WAS NOT IN, CHANGED</td>
</tr>
<tr>
<td>Supported functions</td>
<td>When used with the EQUALS, NOT EQUALS, GREATER THAN, GREATER THAN EQUALS, LESS THAN or LESS THAN EQUALS operators, this field supports:</td>
</tr>
<tr>
<td></td>
<td>• currentLogin()</td>
</tr>
<tr>
<td></td>
<td>• lastLogin()</td>
</tr>
<tr>
<td></td>
<td>• now()</td>
</tr>
<tr>
<td></td>
<td>• startOfDay()</td>
</tr>
<tr>
<td></td>
<td>• startOfWeek()</td>
</tr>
<tr>
<td></td>
<td>• startOfMonth()</td>
</tr>
<tr>
<td></td>
<td>• startOfYear()</td>
</tr>
<tr>
<td></td>
<td>• endOfDay()</td>
</tr>
<tr>
<td></td>
<td>• endOfWeek()</td>
</tr>
<tr>
<td></td>
<td>• endOfMonth()</td>
</tr>
<tr>
<td></td>
<td>• endOfYear()</td>
</tr>
</tbody>
</table>
| Examples             | • Find all issues last acted on before 23rd May 2016: request-last-activity-time < "2016/05/23"
|                      | • Find all issues last acted on or before 23rd May 2016: request-last-activity-time <= "2016/05/23"
|                      | • Find all issues created on 23rd May 2016 and last acted on before 2:00pm that day: created > "2016/05/23" AND request-last-activity-time < "2016/05/23:20:00"
|                      | • Find issues last acted on less than one day ago: request-last-activity-time > ":-1d"
|                      | • Find issues last acted on in January 2016: request-last-activity-time > "2016/01/01" and request-last-activity-time < "2016/02/01" |
Resolution

Search for issues that have a particular resolution. You can search by resolution name or resolution ID (i.e. the number that Jira automatically allocates to a resolution).

Note, it is safer to search by resolution ID than by resolution name. It is possible for your Jira administrator to change the name of a resolution, which could break any saved filter that rely on that name. Resolution IDs, however, are unique and cannot be changed.

<table>
<thead>
<tr>
<th>Syntax</th>
<th>resolution</th>
</tr>
</thead>
<tbody>
<tr>
<td>Field Type</td>
<td>RESOLUTION</td>
</tr>
<tr>
<td>Auto-complete</td>
<td>Yes</td>
</tr>
<tr>
<td>Supported operators</td>
<td>=, !=, &gt;, &gt;=, &lt;, &lt;=, IS, IS NOT, IN, NOT IN, WAS, WAS IN, WAS NOT, WAS NOT IN, CHANGED</td>
</tr>
<tr>
<td>Unsupported operators</td>
<td><del>, !</del></td>
</tr>
<tr>
<td>Supported functions</td>
<td>None</td>
</tr>
</tbody>
</table>
| Examples     | • Find issues with a resolution of "Cannot Reproduce" or "Won't Fix": resolution in ("Cannot Reproduce", "Won't Fix")
               • Find issues with a resolution ID of 5: resolution = 5
               • Find issues that do not have a resolution: resolution = unresolved |

Resolved

Search for issues that were resolved on, before, or after a particular date (or date range). Note that if a time-component is not specified, midnight will be assumed. Please note that the search results will be relative to your configured time zone (which is by default the Jira server’s time zone).

Use one of the following formats:

"yyyy/MM/dd HH:mm"
"yyyy-MM-dd HH:mm"
"yyyy/MM/dd"
"yyyy-MM-dd"

Or use "w"(weeks), "d"(days), "h"(hours) or "m"(minutes) to specify a date relative to the current time. The default is "m"(minutes). Be sure to use quote-marks ("); if you omit the quote-marks, the number you supply will be interpreted as milliseconds after epoch (1970-1-1).

<table>
<thead>
<tr>
<th>Syntax</th>
<th>resolved</th>
</tr>
</thead>
<tbody>
<tr>
<td>Alias</td>
<td>resolutionDate</td>
</tr>
</tbody>
</table>
Field Type | DATE
---|---
Auto-complete | No

**Supported operators**

<table>
<thead>
<tr>
<th>Supported operators</th>
</tr>
</thead>
<tbody>
<tr>
<td>= , != , &gt; , &gt;= , &lt; , &lt;=</td>
</tr>
<tr>
<td>IS , IS NOT , IN , NOT IN</td>
</tr>
</tbody>
</table>

**Unsupported operators**

<table>
<thead>
<tr>
<th>Unsupported operators</th>
</tr>
</thead>
<tbody>
<tr>
<td>~ , !~</td>
</tr>
<tr>
<td>WAS , WAS IN , WAS NOT , WAS NOT IN , CHANGED</td>
</tr>
</tbody>
</table>

**Supported functions**

When used with the EQUALS, NOT EQUALS, GREATER THAN, GREATER THAN EQUALS, LESS THAN or LESS THAN EQUALS operators, this field supports:

- currentLogin()
- lastLogin()
- now()
- startOfDay()
- startOfWeek()
- startOfMonth()
- startOfYear()
- endOfDay()
- endOfWeek()
- endOfMonth()
- endOfYear()

**Examples**

- Find all issues that were resolved before 31st December 2010:
  
  resolved <= "2010/12/31"

- Find all issues that were resolved before 2.00pm on 31st December 2010:
  
  resolved < "2010/12/31 14:00"

- Find all issues that were resolved on or before 31st December 2010:
  
  resolved <= "2011/01/01"

- Find issues that were resolved in January 2011:
  
  resolved > "2011/01/01" and resolved < "2011/02/01"

- Find issues that were resolved on 15 January 2011:
  
  resolved > "2011/01/15" and resolved < "2011/01/16"

- Find issues that were resolved in the last hour:
  
  resolved > -1h

^ top of page

**SLA**

*Used in Jira Service Management only*

Search for requests whose SLAs are in a certain

**Syntax**

Time to resolution

Time to first response

<your custom SLA name>

**Field Type** | SLA
---|---

**Auto-complete** | No

**Supported operators**

<table>
<thead>
<tr>
<th>Supported operators</th>
</tr>
</thead>
<tbody>
<tr>
<td>= , != , &gt; , &gt;= , &lt; , &lt;=</td>
</tr>
</tbody>
</table>
Unsupported operators

• ~, !~
  • IS, IS NOT, IN, NOT IN, WAS, WAS IN, WAS NOT, WAS NOT IN,
  • CHANGED

Supported functions

• breached()
• completed()
• elapsed()
• everBreached()
• paused()
• remaining()
• running()
• withinCalendarHours()

Examples

• Find issues where Time to First Response was breached:
  "Time to First Response" = everBreached()
• Find issues where the SLA for Time to Resolution is paused due to a condition:
  "Time to Resolution" = paused()
• Find issues where the SLA for Time to Resolution is paused due to the SLA calendar:
  "Time to Resolution" = withinCalendarHours()
• Find issues that have been waiting for a response for more than 1 hour:
  "Time to First Response" > elapsed("1h")
• Find issues that will breach Time to First Response in the next two hours:
  "Time to First Response" < remaining("2h")

Syntax

Field Type

• NUMBER

Auto-complete

Yes

Supported operators

• =, !=
  • IS, IS NOT, IN, NOT IN

Unsupported operators

• ~, !~, >, >=, <, <=
  • WAS, WAS IN, WAS NOT, WAS NOT IN, CHANGED

Supported functions

• openSprints()
• closedSprints()
Examples

- Find issues that belong to sprint 999:
  \[ \text{sprint} = 999 \]
- Find issues that belong to sprint "February 1":
  \[ \text{sprint} = \text{"February 1"} \]
- Find issues that belong to either "February 1", "February 2" or "February 3":
  \[ \text{sprint in \{ \text{"February 1"}, \text{"February 2"}, \text{"February 3"} \} } \]
- Find issues that are assigned to a sprint:
  \[ \text{sprint is not empty} \]

^ top of page

Status

Search for issues that have a particular status. You can search by statusname or statusID (i.e. the number that Jira automatically allocates to a status).

Note:

- It is safer to search by statusID than statusname. It is possible for your Jira administrator to change the name of a status, which could break any saved filter that rely on that name. Status IDs, however, are unique and cannot be changed.
- The WAS, WAS NOT, WAS IN and WAS NOT IN operators can only be used with the name, not the ID.

Syntax

<table>
<thead>
<tr>
<th>Field Type</th>
<th>status</th>
</tr>
</thead>
</table>

Auto-complete

Yes

Supported operators

- \[ \text{=} \], \[ \text{!=} \]
- \[ \text{IS} \], \[ \text{IS NOT} \], \[ \text{IN} \], \[ \text{NOT IN} \], \[ \text{WAS} \], \[ \text{WAS IN} \], \[ \text{WAS NOT} \], \[ \text{WAS NOT IN} \], \[ \text{CHANGED} \]

Unsupported operators

- \[ \text{~} \], \[ \text{!~} \], \[ \text{>} \], \[ \text{>=} \], \[ \text{<} \], \[ \text{<=} \]

Supported functions

None

Examples

- Find issues with a status of "Open":
  \[ \text{status} = \text{Open} \]
- Find issues with a status ID of 1:
  \[ \text{status} = 1 \]
- Find issues that currently have, or previously had, a status of "Open":
  \[ \text{status WAS Open} \]

^ top of page

Status category

Status category is a system field for grouping issue statuses. Each issue status in Jira can belong to one of the three status categories: To Do, In Progress, or Done. You can't add or remove status categories.
These status categories represent and generalize the three main stages of an ideal issue workflow. Each issue goes from the stage where the work on it hasn’t started yet, through the stage when you’re working on it, to the stage when the work on has been completed.

These stages can have multiple statuses that you set for your custom workflow. For example, the custom statuses “In development” and “In review” can belong to the single status category **In Progress**, because they represent the stage where you’re developing and reviewing a feature described in the issue.

<table>
<thead>
<tr>
<th>Syntax</th>
<th>statusCategory</th>
</tr>
</thead>
<tbody>
<tr>
<td>Aliases</td>
<td>New, Indeterminate, Complete</td>
</tr>
<tr>
<td>Field Type</td>
<td>STATUS</td>
</tr>
<tr>
<td>Auto-complete</td>
<td>Yes</td>
</tr>
<tr>
<td>Supported operators</td>
<td>=, !=, IN, NOT IN</td>
</tr>
<tr>
<td>Unsupported operators</td>
<td><del>, !</del>, &gt;, &gt;=, &lt;, &lt;=</td>
</tr>
<tr>
<td>IS, IS NOT, WAS, WAS IN, WAS NOT, WAS NOT IN, CHANGED</td>
<td></td>
</tr>
<tr>
<td>Supported functions</td>
<td>None</td>
</tr>
</tbody>
</table>
| Examples        | • Find issues with the status category "To Do":
|                 | statusCategory = "To Do"
|                 | • Find issues with the status category ID 3 where 3 stands for closed issues:
|                 | statusCategory =3
|                 | • Find all issues that are currently in progress:
|                 | statusCategory not in ("To Do", "Done")

Summary

Search for issues where the summary contains particular text. **Jira text-search syntax** can be used.

<table>
<thead>
<tr>
<th>Syntax</th>
<th>summary</th>
</tr>
</thead>
<tbody>
<tr>
<td>Field Type</td>
<td>TEXT</td>
</tr>
<tr>
<td>Auto-complete</td>
<td>No</td>
</tr>
<tr>
<td>Supported operators</td>
<td><del>, !</del></td>
</tr>
<tr>
<td>IS, IS NOT</td>
<td></td>
</tr>
<tr>
<td>Unsupported operators</td>
<td>=, !=, &gt;, &gt;=, &lt;, &lt;=</td>
</tr>
<tr>
<td>IN, NOT IN, WAS, WAS IN, WAS NOT, WAS NOT IN, CHANGED</td>
<td></td>
</tr>
<tr>
<td>Supported functions</td>
<td>None</td>
</tr>
</tbody>
</table>
Examples

- Find issues where the summary contains text that matches "Error saving file" (i.e. a "fuzzy" match):
  summary ~ "Error saving file"
- Find issues where the summary contains the exact phrase "Error saving file":
  summary ~ "\"Error saving file\""

Text

This is a "master-field" that allows you to search all text fields, i.e.:

- Summary
- Description
- Environment
- Comments
- custom fields that use the "free text searcher"; this includes custom fields of the following built-in custom field types:
  - Free text field (unlimited text)
  - Textfield(< 255 characters)
  - Read-only text field

Notes:

- The text master-field can only be used with the CONTAINS operator ("~").
- Jira text-search syntax can be used with these fields.

Syntax

<table>
<thead>
<tr>
<th>text</th>
</tr>
</thead>
<tbody>
<tr>
<td>Field Type</td>
</tr>
<tr>
<td>Auto-complete</td>
</tr>
<tr>
<td>Supported operators</td>
</tr>
<tr>
<td>Unsupported operators</td>
</tr>
<tr>
<td>Supported functions</td>
</tr>
</tbody>
</table>

Examples

- Find issues where a text field matches the word "Fred":
  text ~ "Fred"
  or
  text ~ Fred
- Find all issues where a text field contains the exact phrase "full screen":
  text ~ "\"full screen\"

Time spent

Only available if time-tracking has been enabled by your Jira administrator.
Search for issues where the time spent is set to a particular value (i.e. a number, not a date or date range). Use "w", "d", "h" and "m" to specify weeks, days, hours, or minutes.

**Syntax**
```
timeSpent
```

**Field Type**
DURATION

**Auto-complete**
No

**Supported operators**
=, !=, >, >=, <, <=
IS, IS NOT, IN, NOT IN

**Unsupported operators**
~, !~, WAS, WAS IN, WAS NOT, WAS NOT IN, CHANGED

**Supported functions**
None

**Examples**
- Find issues where the time spent is more than 5 days:
  
  ``
  timeSpent > 5d
  ```

---

**Type**

Search for issues that have a particular issue type. You can search by issue typename or issue typeID (i.e. the number that Jira automatically allocates to an issue type).

Note, it is safer to search by typeID than typename. It is possible for your Jira administrator to change the name of a type, which could break any saved filter that rely on that name. Type IDs, however, are unique and cannot be changed.

**Syntax**
```
type
```

**Alias**
issueType

**Field Type**
ISSUE_TYPE

**Auto-complete**
Yes

**Supported operators**
=, !=
IS, IS NOT, IN, NOT IN

**Unsupported operators**
~, !~, >, >=, <, <=
WAS, WAS IN, WAS NOT, WAS NOT IN, CHANGED

**Supported functions**
None

**Examples**
- Find issues with an issue type of "Bug":
  
  ```
  type = Bug
  ```
- Find issues with an issue type of "Bug" or "Improvement":
  
  ```
  issueType in (Bug, Improvement)
  ```
- Find issues with an issue type ID of 2:
  
  ```
  issueType = 2
  ```
Updated

Search for issues that were last updated on, before, or after a particular date (or date range). Note that if a time-component is not specified, midnight will be assumed. Please note that the search results will be relative to your configured time zone (which is by default the Jira server's time zone).

Use one of the following formats:

"yyyy/MM/dd HH:mm"
"yyyy-MM-dd HH:mm"
"yyyy/MM/dd"
"yyyy-MM-dd"

Or use "w" (weeks), "d" (days), "h" (hours) or "m" (minutes) to specify a date relative to the current time. The default is "m" (minutes). Be sure to use quote-marks ("{}); if you omit the quote-marks, the number you supply will be interpreted as milliseconds after epoch (1970-1-1).

<table>
<thead>
<tr>
<th>Syntax</th>
<th>updated</th>
</tr>
</thead>
<tbody>
<tr>
<td>Alias</td>
<td>updatedDate</td>
</tr>
<tr>
<td>Field Type</td>
<td>DATE</td>
</tr>
<tr>
<td>Auto-complete</td>
<td>No</td>
</tr>
<tr>
<td>Supported operators</td>
<td>= , !=, &gt; , &gt;= , &lt; , &lt;= IS , IS NOT , IN , NOT IN</td>
</tr>
<tr>
<td>Unsupported operators</td>
<td>~ , !~ WAS, WAS IN, WAS NOT, WAS NOT IN, CHANGED</td>
</tr>
<tr>
<td>Supported functions</td>
<td>When used with the EQUALS, NOT EQUALS, GREATER THAN, GREATER THAN EQUALS, LESS THAN or LESS THAN EQUALS operators, this field supports:</td>
</tr>
<tr>
<td></td>
<td>- currentLogin()</td>
</tr>
<tr>
<td></td>
<td>- lastLogin()</td>
</tr>
<tr>
<td></td>
<td>- now()</td>
</tr>
<tr>
<td></td>
<td>- startOfDay()</td>
</tr>
<tr>
<td></td>
<td>- startOfWeek()</td>
</tr>
<tr>
<td></td>
<td>- startOfMonth()</td>
</tr>
<tr>
<td></td>
<td>- startOfYear()</td>
</tr>
<tr>
<td></td>
<td>- endOfDay()</td>
</tr>
<tr>
<td></td>
<td>- endOfWeek()</td>
</tr>
<tr>
<td></td>
<td>- endOfMonth()</td>
</tr>
<tr>
<td></td>
<td>- endOfYear()</td>
</tr>
</tbody>
</table>
### Examples

- Find issues that were last updated before 12th December 2010:
  
  ```java
  updated < "2010/12/12"
  ```

- Find issues that were last updated on or before 12th December 2010:
  
  ```java
  updated < "2010/12/13"
  ```

- Find all issues that were last updated before 2.00pm on 31st December 2010:
  
  ```java
  updated < "2010/12/31 14:00"
  ```

- Find issues that were last updated more than two weeks ago:
  
  ```java
  updated < "-2w"
  ```

- Find issues that were last updated on 15 January 2011:
  
  ```java
  updated > "2011/01/15" and updated < "2011/01/16"
  ```

- Find issues that were last updated in January 2011:
  
  ```java
  updated > "2011/01/01" and updated < "2011/02/01"
  ```

- Find all issues updated since January 1, 2020:
  
  ```java
  updated >= "2020/01/01"
  ```

### Voter

Search for issues for which a particular user has voted. You can search by the user's full name, ID, or email address. Note that you can only find issues for which you have the "View Voters and Watchers" permission, unless you are searching for your own votes. See also votedIssues.

<table>
<thead>
<tr>
<th>Syntax</th>
<th>voter</th>
</tr>
</thead>
<tbody>
<tr>
<td>Field Type</td>
<td>USER</td>
</tr>
<tr>
<td>Auto-complete</td>
<td>Yes</td>
</tr>
</tbody>
</table>

**Supported operators**  
- `= , !=
  - IS , IS NOT , IN , NOT IN

**Unsupported operators**  
- `~ , !~, > , >= , < , <=
  - WAS, WAS IN, WAS NOT, WAS NOT IN, CHANGED

**Supported functions**  
- When used with the **IN** and **NOT IN** operators, this field supports:
  
  - membersOf()

- When used with the **EQUALS** and **NOT EQUALS** operators, this field supports:
  
  - currentUser()

**Examples**

- Search for issues that you have voted for:
  
  ```java
  voter = currentUser()
  ```

- Search for issues that the user "jsmith" has voted for:
  
  ```java
  voter = "jsmith"
  ```

- Search for issues for which a member of the group "Jira-administrators" has voted:
  
  ```java
  voter in membersOf("Jira-administrators")
  ```

### Votes

263
Search for issues with a specified number of votes.

<table>
<thead>
<tr>
<th>Syntax</th>
<th>votes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Field Type</td>
<td>NUMBER</td>
</tr>
<tr>
<td>Auto-complete</td>
<td>No</td>
</tr>
<tr>
<td>Supported operators</td>
<td>= , != , &gt; , &gt;= , &lt; , &lt;= , IN , NOT IN</td>
</tr>
<tr>
<td>Unsupported operators</td>
<td>~ , !~ , IS , IS NOT , WAS , WAS IN , WAS NOT , WAS NOT IN , CHANGED</td>
</tr>
<tr>
<td>Supported functions</td>
<td>None</td>
</tr>
<tr>
<td>Examples</td>
<td>• Find all issues that have 12 or more votes: votes &gt;= 12</td>
</tr>
</tbody>
</table>

Watcher

Search for issues that a particular user is watching. You can search by the user's full name, ID, or email address. Note that you can only find issues for which you have the "View Voters and Watchers" permission, unless you are searching for issues where you are the watcher. See also watchedIssues.

<table>
<thead>
<tr>
<th>Syntax</th>
<th>watcher</th>
</tr>
</thead>
<tbody>
<tr>
<td>Field Type</td>
<td>USER</td>
</tr>
<tr>
<td>Auto-complete</td>
<td>Yes</td>
</tr>
<tr>
<td>Supported operators</td>
<td>= , != , IS , IS NOT , IN , NOT IN</td>
</tr>
<tr>
<td>Unsupported operators</td>
<td>~ , !~ , &gt; , &gt;= , &lt; , &lt;= , WAS , WAS IN , WAS NOT , WAS NOT IN , CHANGED</td>
</tr>
<tr>
<td>Supported functions</td>
<td>When used with the IN and NOT IN operators, this field supports: • membersOf() When used with the EQUALS and NOT EQUALS operators, this field supports: • currentUser()</td>
</tr>
<tr>
<td>Examples</td>
<td>• Search for issues that you are watching: watcher = currentUser() • Search for issues that the user &quot;jsmith&quot; is watching: watcher = &quot;jsmith&quot; • Search for issues that are being watched by a member of the group &quot;Jira-administrators&quot;: watcher in membersOf(&quot;Jira-administrators&quot;)</td>
</tr>
</tbody>
</table>
Watchers

Search for issues with a specified number of watchers.

<table>
<thead>
<tr>
<th>Syntax</th>
<th>watchers</th>
</tr>
</thead>
<tbody>
<tr>
<td>Field Type</td>
<td>NUMBER</td>
</tr>
<tr>
<td>Auto-complete</td>
<td>No</td>
</tr>
<tr>
<td>Supported operators</td>
<td>= , !=, &gt;, &gt;=, &lt;, &lt;=, IN, NOT IN</td>
</tr>
<tr>
<td>Unsupported operators</td>
<td><del>, !</del> IS, IS NOT, WAS, WAS IN, WAS NOT, WAS NOT IN, CHANGED</td>
</tr>
<tr>
<td>Supported functions</td>
<td>When used with the IN and NOT IN operators, this field supports: membersOf() When used with the EQUALS and NOT EQUALS operators, this field supports: currentUser()</td>
</tr>
<tr>
<td>Examples</td>
<td>• Find all issues that are being watched by more than 3 people: watchers &gt; 3</td>
</tr>
</tbody>
</table>

Work log author

*Only available if time-tracking has been enabled by your Jira administrator.*

Search for issues a particular user has logged work against. You can search by the user’s full name, ID, or email address. Note that you can only find issues for which you have “Time Tracking” permissions, unless you are searching for issues that you’ve logged work against.

<table>
<thead>
<tr>
<th>Syntax</th>
<th>worklogAuthor</th>
</tr>
</thead>
<tbody>
<tr>
<td>Field Type</td>
<td>USER</td>
</tr>
<tr>
<td>Auto-complete</td>
<td>Yes</td>
</tr>
<tr>
<td>Supported operators</td>
<td>= , != IS, IS NOT, IN, NOT IN</td>
</tr>
<tr>
<td>Unsupported operators</td>
<td><del>, !</del> WAS, WAS IN, WAS NOT, WAS NOT IN, CHANGED</td>
</tr>
</tbody>
</table>
Supported functions

When used with the **IN** and **NOT IN** operators, this field supports:

- `membersOf()`

When used with the **EQUALS** and **NOT EQUALS** operators, this field supports:

- `currentUser()`

Examples

- Search for issues that you've logged work against:
  ```java
  worklogAuthor = currentUser()
  ```
- Search for issues that the user "jsmith" has logged work against:
  ```java
  worklogAuthor = "jsmith"
  ```
- Search for issues that a member of the group "Jira-software-users":
  ```java
  worklogAuthor in membersOf("Jira-software-users")
  ```

Work log comment

*Only available if time-tracking has been enabled by your Jira administrator.*

Search for issues that have a comment in a work log entry which contains particular text. **Jira text-search syntax** can be used.

<table>
<thead>
<tr>
<th>Syntax</th>
<th>worklogComment</th>
</tr>
</thead>
<tbody>
<tr>
<td>Field Type</td>
<td>TEXT</td>
</tr>
<tr>
<td>Auto-complete</td>
<td>No</td>
</tr>
<tr>
<td>Supported operators</td>
<td>~ , !~</td>
</tr>
<tr>
<td>Unsupported operators</td>
<td>= , != , &gt; , &gt;= , &lt; , &lt;= IS , IS NOT , IN , NOT IN , WAS, WAS IN, WAS NOT, WAS NOT IN , CHANGED</td>
</tr>
<tr>
<td>Supported functions</td>
<td>None</td>
</tr>
</tbody>
</table>
| Examples     | Find issues where a comment in a work log entry contains text that matches "test sessions" (i.e. a "fuzzy" match):
  ```java
  summary ~ "test sessions"
  ```
|              | Find issues where a comment contains the exact phrase "test sessions":
  ```java
  summary ~ "\"test sessions\"
  ```

Work log date

*Only available if time-tracking has been enabled by your Jira administrator.*
Search for issues that have comments in work log entries that were created on, before, or after a particular date (or date range). Note that if a time-component is not specified, midnight 00:00 will be assumed. Please note that the search results will be relative to your configured time zone (which is by default the Jira server's time zone).

Use one of the following formats:

"yyyy/MM/dd HH:mm"
"yyyy-MM-dd HH:mm"
"yyyy/MM/dd"
"yyyy-MM-dd"  

Or use "w" (weeks), "d" (days), "h" (hours) or "m" (minutes) to specify a date relative to the current time. The default is "m" (minutes). Be sure to use quote-marks ('); if you omit the quote-marks, the number you supply will be interpreted as milliseconds after epoch (1970-1-1).

<table>
<thead>
<tr>
<th>Syntax</th>
<th>worklogDate</th>
</tr>
</thead>
<tbody>
<tr>
<td>Field Type</td>
<td>DATE</td>
</tr>
<tr>
<td>Autocomplete</td>
<td>No</td>
</tr>
<tr>
<td>Supported operators</td>
<td>= , != , &gt; , &gt;= , &lt; , &lt;= IS , IS NOT , IN , NOT IN</td>
</tr>
<tr>
<td>Unsupported operators</td>
<td>~ , !~ WAS, WAS IN, WAS NOT, WAS NOT IN, CHANGED</td>
</tr>
<tr>
<td>Supported functions</td>
<td>When used with the EQUALS, NOT EQUALS, GREATER THAN, GREATER THAN EQUALS, LESS THAN or LESS THAN EQUALS operators, this field supports:</td>
</tr>
<tr>
<td></td>
<td>• currentLogin()</td>
</tr>
<tr>
<td></td>
<td>• lastLogin()</td>
</tr>
<tr>
<td></td>
<td>• now()</td>
</tr>
<tr>
<td></td>
<td>• startOfDay()</td>
</tr>
<tr>
<td></td>
<td>• startOfWeek()</td>
</tr>
<tr>
<td></td>
<td>• startOfMonth()</td>
</tr>
<tr>
<td></td>
<td>• startOfYear()</td>
</tr>
<tr>
<td></td>
<td>• endOfDay()</td>
</tr>
<tr>
<td></td>
<td>• endOfWeek()</td>
</tr>
<tr>
<td></td>
<td>• endOfMonth()</td>
</tr>
<tr>
<td></td>
<td>• endOfYear()</td>
</tr>
</tbody>
</table>
### Examples

- Find issues that have comments in work log entries created before midnight 00:00 12th December 2010:
  \[
  \text{worklogDate} < "2010/12/12"
  \]
- Find issues that have comments in work log entries created on or before 12th December 2010 (but not 13th December 2010):
  \[
  \text{worklogDate} \leq "2010/12/13"
  \]
- Find issues that have comments in work log entries created 12th December 2010 before 2:00pm:
  \[
  \text{worklogDate} > "2010/12/12" \text{and} \text{worklogDate} < "2010/12/12 14:00"
  \]
- Find issues that have comments in work log entries created less than one day ago:
  \[
  \text{worklogDate} > "-1d"
  \]
- Find issues that have comments in work log entries created in January 2011:
  \[
  \text{worklogDate} > "2011/01/01" \text{and} \text{worklogDate} < "2011/02/01"
  \]
- Find issues that have comments in work log entries created on 15 January 2011:
  \[
  \text{worklogDate} > "2011/01/15" \text{and} \text{worklogDate} < "2011/01/16"
  \]

### Work ratio

**Only available if time-tracking has been enabled by your Jira administrator.**

Search for issues where the work ratio has a particular value. Work ratio is calculated as follows:

\[
\text{workRatio} = (\text{timeSpent} / \text{originalEstimate}) \times 100
\]

<table>
<thead>
<tr>
<th>Syntax</th>
<th>workRatio</th>
</tr>
</thead>
<tbody>
<tr>
<td>Field Type</td>
<td>NUMBER</td>
</tr>
<tr>
<td>Auto-complete</td>
<td>No</td>
</tr>
<tr>
<td>Supported operators</td>
<td>= , !=, &gt;, &gt;=, &lt;, &lt;= IS, IS NOT, IN, NOT IN</td>
</tr>
<tr>
<td>Unsupported operators</td>
<td>~ , !~ WAS, WAS IN, WAS NOT, WAS NOT IN, CHANGED</td>
</tr>
<tr>
<td>Supported functions</td>
<td>None</td>
</tr>
</tbody>
</table>

**Examples**

- Find issues on which more than 75% of the original estimate has been spent:
  \[
  \text{workRatio} > 75
  \]
Advanced searching - keywords reference

This page describes information about keywords that are used for advanced searching.

A keyword in JQL is a word or phrase that does any of the following:

- joins two or more clauses together to form a complex JQL query
- alters the logic of one or more clauses
- alters the logic of operators
- has an explicit definition in a JQL query
- performs a specific function that alters the results of a JQL query

On this page:

- AND
- OR
- NOT
- EMPTY
- NULL
- ORDER BY

AND

Used to combine multiple clauses, allowing you to refine your search.

You can also use parentheses to control the order in which clauses are executed. See Precedence in JQL queries for details.

- Find all open issues in the "New office" project:
  
  ```jql
  project = "New office" and status = "open"
  ```

- Find all open, urgent issues that are assigned to jsmith:
  
  ```jql
  status = open and priority = urgent and assignee = jsmith
  ```

- Find all issues in a particular project that are not assigned to jsmith:
  
  ```jql
  project = JRA and assignee != jsmith
  ```

- Find all issues for a specific release which consists of different version numbers across several projects:
  
  ```jql
  project in (JRA,CONF) and fixVersion = "3.14"
  ```

- Find all issues where neither the Reporter nor the Assignee is Jack, Jill or John:
  
  ```jql
  reporter not in (Jack,Jill,John) and assignee not in (Jack,Jill,John)
  ```

OR

Used to combine multiple clauses, allowing you to expand your search.

You can also use parentheses to control the order in which clauses are executed. See Precedence in JQL queries for details.

- Find all issues that were created by either jsmith or jbrown:
  
  ```jql
  reporter = jsmith or reporter = jbrown
  ```

- Find all issues that are overdue or where no due date is set:
  
  ```jql
  duedate < now() or duedate is empty
  ```
NOT
Used to negate individual clauses or a complex JQL query (a query made up of more than one clause) using parentheses, allowing you to refine your search.

- Find all issues that are assigned to any user except jsmith:
  
  not assignee = jsmith

- Find all issues that were not created by either jsmith or jbrown:

  not (reporter = jsmith or reporter = jbrown)

ORDER BY
Used to specify the fields by whose values the search results will be sorted.
By default, the field's own sorting order will be used. You can override this by specifying ascending order ("asc") or descending order ("desc").

- Find all issues without aDueDate, sorted byCreationDate:
  
  ```
  duedate = empty order by created
  ```

- Find all issues without aDueDate, sorted byCreationDate, then byPriority(highest to lowest):
  
  ```
  duedate = empty order by created, priority desc
  ```

- Find all issues without aDueDate, sorted byCreationDate, then byPriority(lowest to highest):
  
  ```
  duedate = empty order by created, priority asc
  ```

Ordering by **Components** or **Versions** will list the returned issues first by **Project**, and only then by the field's natural order (see JIRA-31113).
Advanced searching - operators reference

This page describes information about operators that are used for advanced searching.

An operator in JQL is one or more symbols or words that compare the value of a field on its left with one or more values or functions on its right. So, only valid results are retrieved by the clause. Some operators may use the NOT keyword.

EQUALS: =

The = operator is used to search for issues where the value of a specified field exactly matches a specified value.

To find issues where the value of a specified field exactly matches multiple values, use multiple EQUALS (=) statements with the AND keyword.

The operator can't be used with text fields. See the CONTAINS operator.

Examples

- Find all issues that were created by jsmith:

  ```
  reporter = jsmith
  ```

- Find all issues that were created by John Smith:

  ```
  reporter = "John Smith"
  ```

NOT EQUALS: !=

The != operator is used to search for issues where the value of a specified field doesn't match a specified value.

The operator can't be used with text fields. See the DOES NOT MATCH (!~) operator instead.

Examples

- Find all issues that are assigned to any user except jsmith:

  ```
  not assignee = jsmith
  ```

  or

  ```
  assignee != jsmith
  ```
• Find all issues that are not assigned to jsmith:
  assignee != jsmith or assignee is empty

• Find all issues that were reported by you but aren't assigned to you:
  reporter = currentUser() and assignee != currentUser()

• Find all issues where the Reporter or Assignee is anyone except John Smith:
  assignee !="John Smith" or reporter !="John Smith"

• Find all issues that aren't unassigned:
  assignee is not empty

  or

  assignee != null

GREATER THAN: >

The > operator is used to search for issues where the value of a specified field is greater than a specified value.

The operator can only be used with fields that support ordering and can't be used with text fields. For example, date fields and version fields.

To see a field's supported operators, check the individual field reference.

Examples

• Find all issues with more than four votes:
  votes > 4

• Find all overdue issues:
  duedate < now() and resolution is empty

• Find all issues where priority is higher than "Normal":
  priority > normal

GREATER THAN EQUALS: >=

The >= operator is used to search for issues where the value of a specified field is greater than or equal to a specified value.
The operator can only be used with fields that support ordering and can't be used with text fields. For example, date fields and version fields.

To see a field's supported operators, check the individual field reference.

Examples

- Find all issues with four or more votes:
  
  ```
  votes >= 4
  ```

- Find all issues due on or after 31/12/2008:
  
  ```
  duedate >= "2008/12/31"
  ```

- Find all issues created in the last five days:
  
  ```
  created >= "-5d"
  ```

LESS THAN: <

The < operator is used to search for issues where the value of a specified field is less than a specified value.

The operator can only be used with fields that support ordering and can't be used with text fields. For example, date fields and version fields.

To see a field's supported operators, check the individual field reference.

Examples

Find all issues with less than votes:

```
votes < 4
```
• Find all issues that haven't been updated in the last month (30 days):

```
updated <= "-4w 2d"
```

IN

The **IN** operator is used to search for issues where the value of a specified field is one of multiple specified values. The values are specified as a comma-separated list, surrounded by parentheses.

Using **IN** is equivalent to using multiple **EQUALS** (=) statements, but is shorter and more convenient. That is, `reporter IN (tom, jane, harry)` is the same as `reporter = "tom" OR reporter = "jane" OR reporter = "harry"`.  

Examples

• Find all issues that were created by either jsmith, jbrown, or jjones:

```
reporter in (jsmith, jbrown, jjones)
```

• Find all issues where the Reporter or Assignee is either Jack or Jill:

```
reporter in (Jack, Jill) or assignee in (Jack, Jill)
```

• Find all issues in version 3.14 or version 4.2:

```
affectedVersion in ("3.14", "4.2")
```

NOT IN

The **NOT IN** operator is used to search for issues where the value of a specified field isn't one of multiple specified values.

Using **NOT IN** is equivalent to using multiple **NOT_EQUALS** (!=) statements, but is shorter and more convenient. That is, `reporter NOT IN (tom, jane, harry)` is the same as `reporter != "tom" AND reporter != "jane" AND reporter != "harry"`.  

Also, the **NOT IN** operator won't match a field that has no value (a field is empty). For example, `assignee not in (jack, jill)` will only match issues that have an assignee and this assignee isn't "jack" or "jill".  

To find issues that are assigned to someone other than "jack" or "jill" or are unassigned, you should type: `assignee not in (jack, jill) or assignee is empty`.

Examples

• Find all issues where the Assignee is someone other than Jack, Jill, or John:

```
assignee not in (Jack, Jill, John)
```

• Find all issues where the Assignee isn't Jack, Jill, or John:

```
assignee not in (Jack, Jill, John) or assignee is empty
```
• Find all issues where the fix version isn't A, B, C, or D:

```plaintext
FixVersion not in (A, B, C, D)
```

• Find all issues where the fix version isn't A, B, C, or D, or has not been specified:

```plaintext
FixVersion not in (A, B, C, D) or FixVersion is empty
```

---

CONTAINS: ~

The ~ operator is used to search for issues where the value of a specified field matches a specified value: either an exact or fuzzy match. See examples below.

Use it only with version and text fields.

Text fields:

- Summary
- Description
- Environment
- Comments
- Custom fields that use the free text searcher, including custom fields of the following built-in custom field types:
  - Free text field (unlimited text)
  - Text field (<255 characters)
  - Read-only text field

Version fields:

- Affected version
- Fix version
- Custom fields that use the version picker

The JQL field "text", as `intext ~ "some words"`, searches for an issue's summary, description, environment, comments, and all custom text fields.

If you have many text custom fields, you can improve performance of your queries by searching for specific fields. For example: `Summary ~ "some words" OR Description ~ "some words"`.

When using the ~ operator, the value on the right side of the operator can be specified by using Jira text-search syntax.

Examples

- Find all issues where the summary contains the word "win" or the simple derivatives of this word, such as "wins":

```plaintext
summary ~ win
```
• Note that for version fields, the ~ operator returns an exact match. For example, to find the version 9.0, you should use the following query:

   fixVersion ~ "9.0"

• Find all issues where the summary contains a wild card match for the word "win":

   summary ~ "win*"

• Find all issues where the summary contains the word "issue" and the word "collector":

   summary ~ "issue collector"

• Find all issues where the summary contains the exact phrase "full screen". Also, see Search syntax for text fields for details on how to escape quotation marks and other special characters.

   summary ~ "\"full screen\""

   With this query, Jira will find issues where the summaries contain both the exact phrase "full screen" and any other phrase that includes the exact word combination "full screen". For example:
   - "full screen"
   - create "full screen"
   - "full screen" editing mode

• Find all issues where the Fix Version field contains a wild card match for the version "9". For example, 9.1 or 9.0.1:

   fixVersion ~ "9*"

• Find all issues where the Fix Version field contains "9". For example, 1.9:

   fixVersion ~ "*9"

DOES NOT CONTAIN: !~

The !~ operator is used to search for issues where the value of a specified field doesn't match a specified value.

Use it only with version and text fields.

Text fields:

• Summary
• Description
• Environment
• Comments
• Custom fields that use the free text searcher, including custom fields of the following built-in custom field types:
  - Free text field (unlimited text)
  - Text field (<255 characters)
  - Read-only text field

Version fields:
• Affected version  
• Fix version  
• Custom fields that use the Version Picker

The JQL field "text", as intext !~ "some words", searches for an issue's summary, description, environment, comments, and all custom text fields.

If you have many text custom fields, you can improve performance of your queries by searching for specific fields. For example: Summary !~ "some words" OR Description !~ "some words".

When using the !-operator, the value on the right side of the operator can be specified by using Jira text-search syntax.

Examples

• Find all issues where the summary doesn't contain the word "run" or the derivatives of this word, such as "running" or "ran":

  summary !~ run

• Note that for version fields, the ~ operator returns an exact match. For example, to find issues where the fix version is not 9.0, you should use the following query:

  fixVersion !~ "9.0"

This query will return all issues where the value in the Fix Version field isn't 9.0, but it won't return issues where the Fix Version field is empty. To find issues where this field is empty or contains any other value except for 9.0, use the following query:

  fixVersion !~ "9.0" OR fixVersion is empty

• Find all issues where the Fix Version field doesn't contain any version from the 9.x line:

  fixVersion !~ "9.*"

The IS operator can only be used with the EMPTY or NULL keywords. That is, it's used to search for issues where the specified field has no value.

Not all fields are compatible with this operator. For more details, see the individual field reference.

Examples

• Find all issues that have no fix version:

  fixVersion is empty

  or

  fixVersion is null
IS NOT

The IS NOT operator can only be used with the EMPTY or NULL keywords. That is, it's used to search for issues where a specified field has a value.

Not all fields are compatible with this operator. For more details, see the individual field reference.

Examples

- Find all issues that have one or more votes:

  votes is not empty

  or

  votes is not null

WAS

The WAS operator is used to find issues that currently have or previously had a specified value for a specified field.

In a search query, with this operator, you can use the following:

- AFTER "date"
- BEFORE "date"
- BY "username"
- DURING ("date1","date2")
- ON "date"

The WAS operator will match the value name (for example, "Resolved") that was configured in your system at the time when the field was changed.

The operator will also match the value ID associated with the value name. For example, it will match "4" as well as "Resolved".

The operator can be used only with the following fields: Assignee, Fix Version, Priority, Reporter, Resolution, and Status.

Examples

- Find issues that currently have or previously had the status "In Progress":

  status WAS "In Progress"

- Find issues that were resolved by Joe Smith before February 20:

  status WAS "Resolved" BY jsmith BEFORE "2011/02/20"

- Find issues that were resolved by Joe Smith during 2010:

  status WAS "Resolved" BY jsmith DURING ("2010/01/01","2011/01/01")
WAS IN

The **WAS IN** operator is used to find issues that currently have or previously had any of multiple specified values for a specified field. The values are specified as a comma-separated list, surrounded by parentheses.

In a search query, with this operator, you can use the following:

- AFTER "date"
- BEFORE "date"
- BY "username"
- DURING ("date1","date2")
- ON "date"

The **WAS IN** operator will match the value name (for example, "Resolved") that was configured in your system at the time when the field was changed.

The operator will also match the value ID associated with the value name. For example, it will match "4" as well as "Resolved".

### Examples

- Find all issues that currently have or previously had the status "Resolved" or "In Progress":

  ```plaintext
  status WAS IN ("Resolved","In Progress")
  ```

WAS NOT IN

The **WAS NOT IN** operator is used to search for issues where the value of the specified field has never been one of multiple specified values.

In a search query, with this operator, you can use the following:

- AFTER "date"
- BEFORE "date"
- BY "username"
- DURING ("date1","date2")
- ON "date"

### Using WAS NOT IN is equivalent to using multiple WAS statements, but is shorter and more convenient.

That is, `status WAS NOT IN ("Resolved","In Progress")` is the same as `status WAS NOT "Resolved" OR status WAS NOT "In Progress"`.

The operator can be used only with the following fields: Assignee, Fix Version, Priority, Reporter, Resolution, and Status.

### Examples

- Find issues that have never had the status "Resolved" or "In Progress":

  ```plaintext
  status WAS NOT IN ("Resolved","In Progress")
  ```
• Find issues that didn't have the status "Resolved" or "In Progress" before February 20:

\[
\text{status WAS NOT IN } (\text{"Resolved"}, \text{"In Progress"}) \text{ BEFORE } \text{"2011/02/20"}
\]

The WAS IN and WAS NOT IN operators allow using up to 3000 operands.

When the number of operands exceeds the allowed limit, the GET search fails because of the HTTP 400 error on Tomcat. In this case, we recommend using the /search resource through the POST method.

WAS NOT

The WAS NOT operator is used to find issues that have never had a specified value for a specified field.

In a search query, with this operator, you can use the following:

• AFTER "date"
• BEFORE "date"
• BY "username"
• DURING ("date1","date2")
• ON "date"

The WAS NOT operator will match the value name (for example, "Resolved") that was configured in your system at the time when the field was changed.

The operator will also match the value ID associated with the value name. For example, it will match "4" as well as "Resolved".

The operator can be used only with the following fields: Assignee, Fix Version, Priority, Reporter, Resolution, and Status.

Examples

• Find issues that don't have and have never had the status "In Progress":

\[
\text{status WAS NOT } \text{"In Progress"}
\]

• Find issues that didn't have the status "In Progress" before February 20:

\[
\text{status WAS NOT } \text{"In Progress"} \text{ BEFORE } \text{"2011/02/20"}
\]

CHANGED

The CHANGED operator is used to find issues where the value of a specified field was changed.

In a search query, with this operator, you can use the following:

• AFTER "date"
• BEFORE "date"
• BY "username"
• DURING ("date1","date2")
• ON "date"
- FROM "oldvalue"
- TO "newvalue"

The operator can be used only with the following **fields**: Assignee, Fix Version, Priority, Reporter, Resolution, and Status.

**Examples**

- Find issues where the Assignee was changed:
  
  ```
  assignee CHANGED
  ```

- Find issues where the status was changed from "In Progress" back to "Open":
  
  ```
  status CHANGED FROM "In Progress" TO "Open"
  ```

- Find issues where the priority was changed by the user **freddo** after the start and before the end of the current week:
  
  ```
  priority CHANGED BY freddo BEFORE endOfWeek() AFTER startOfWeek()
  ```

^top of page
Advanced searching - functions reference

This page describes information about functions that are used for advanced searching.

A function in JQL appears as a word followed by parentheses, which may contain one or more explicit values or Jira system fields. In a clause, a function is preceded by an operator, which in turn is preceded by a field. A function performs a calculation on either specific Jira data or the function’s content in parentheses, such that only true results are retrieved by the function, and then again by the clause in which the function is used.

Some Jira apps can add additional functions to the advanced issue search. For example, the ScriptRunnerforJIRA app extends JQL with such functions as myProjects() and projectmatch().

approved()

Only applicable if Jira Service Management is installed and licensed.

Search for issues that required approval and have a final decision of approved.

<table>
<thead>
<tr>
<th>Syntax</th>
<th>approved()</th>
</tr>
</thead>
<tbody>
<tr>
<td>Supported fields</td>
<td>Custom fields of type Approval</td>
</tr>
<tr>
<td>Supported operators</td>
<td>=</td>
</tr>
<tr>
<td>Unsupported operators</td>
<td>~ , != ,&gt;= , &gt; , &lt; , &lt;=             IS , IS NOT , IN , NOT IN , WAS , WAS IN , WAS NOT , WAS NOT IN , CHANGED</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Examples</th>
</tr>
</thead>
<tbody>
<tr>
<td>Find all issues that are approved:</td>
</tr>
<tr>
<td>Approvals = approved()</td>
</tr>
<tr>
<td>Find all issues that have been approved by you or are pending your approval:</td>
</tr>
<tr>
<td>Approvals = myApproval() OR Approvals = myPending()</td>
</tr>
</tbody>
</table>

Unless specified in the search query, note that JQL searches don't return empty fields in results. To include empty fields (e.g. unassigned issues) when searching for issues that are not assigned to the current user, you would enter (assignee != currentUser() OR assignee is EMPTY) to include unassigned issues in the list of results.

^ top of page
On this page:

- approved()
- approver()
- breached()
- cascadeOption()
- closedSprints()
- completed()
- componentsLeadByUser()
- currentLogin()
- currentUser()
- earliestUnreleasedVersion()
- elapsed()
- endOfDay()
- endOfMonth()
- endOfWeek()
- endOfYear()
- everbreached()
- futureSprints()
- issueHistory()
- issuesWithRemoteLinksByGlobalId()
- lastLogin()
- latestReleasedVersion()
- linkedIssues()
- membersOf()
- myApproval()
- myPending()
- now()
- openSprints()
- outdated()
- paused()
- pending()
- pendingBy()
- projectsLeadByUser()
- projectsWhereUserHasPermission()
- projectsWhereUserHasRole()
- releasedVersions()
- remaining()
- running()
- standardIssueTypes()
- startOfDay()
- startOfMonth()
- startOfWeek()
- startOfYear()
- subtaskIssueTypes()
- unreleasedVersions()
- updatedBy()
- votedIssues()
- watchedIssues()
- withinCalendarHours()
approver()

Only applicable if Jira Service Management is installed and licensed.

Search for issues that require or required approval by one or more of the listed users. This uses an **or** operator, and you must specify the usernames.

<table>
<thead>
<tr>
<th>Syntax</th>
<th>approver(user, user)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Supported fields</td>
<td>Custom fields of type Approval</td>
</tr>
<tr>
<td>Supported operators</td>
<td>=</td>
</tr>
<tr>
<td>Unsupported operators</td>
<td><del>, !=, !</del>, &gt;, &gt;=, &lt;, &lt;=, IS NOT, IN, NOT IN, WAS, WAS IN, WAS NOT, WAS NOT IN, CHANGED</td>
</tr>
<tr>
<td>Examples</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Find issues that require or required approval by John Smith: approval = approver(jsmith)</td>
</tr>
<tr>
<td></td>
<td>• Find issues that require or required approval by John Smith or Sarah Khan: approval = approver(jsmith, skhan)</td>
</tr>
</tbody>
</table>

\[ top of page \]

breached()

Only applicable if Jira Service Management is installed and licensed.

Returns issues that whose most recent has missed its goal.

<table>
<thead>
<tr>
<th>Syntax</th>
<th>breached()</th>
</tr>
</thead>
<tbody>
<tr>
<td>Supported fields</td>
<td></td>
</tr>
<tr>
<td>Supported operators</td>
<td>=, !=</td>
</tr>
<tr>
<td>Unsupported operators</td>
<td><del>, !</del>, &gt;, &gt;=, &lt;, &lt;=, IS NOT, WAS, WAS IN, WAS NOT, WAS NOT IN, CHANGED</td>
</tr>
<tr>
<td>Examples</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Find issues where Time to First Response was breached: &quot;Time to First Response&quot; = breached()</td>
</tr>
</tbody>
</table>

\[ top of page \]

cascadeOption()

Search for issues that match the selected values of a "cascading select" custom field.

The **parentOption** parameter matches against the first tier of options in the cascading select field. The **childOption** parameter matches against the second tier of options in the cascading select field, and is optional.

The keyword "**none**" can be used to search for issues where either or both of the options have no value.
| Syntax | cascadeOption(parentOption)  
cascadeOption(parentOption,childOption) |
<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Supported fields</td>
<td>Custom fields of type &quot;Cascading Select&quot;</td>
</tr>
<tr>
<td>Supported operators</td>
<td>IN , NOT IN</td>
</tr>
<tr>
<td>Unsupported operators</td>
<td>= , != , ~ , !~ , &gt; , &gt;= , &lt; , &lt;= , IS , IS NOT , WAS , WAS IN , WAS NOT , WAS NOT IN , CHANGED</td>
</tr>
</tbody>
</table>
| Examples | • Find issues where a custom field ("Location") has the value "USA" for the first tier and "New York" for the second tier:  
location in cascadeOption("USA","New York")  
• Find issues where a custom field ("Location") has the value "USA" for the first tier and any value (or no value) for the second tier:  
location in cascadeOption( "USA" )  
• Find issues where a custom field ("Location") has the value "USA" for the first tier and no value for the second tier:  
location in cascadeOption( "USA",none)  
• Find issues where a custom field ("Location") has no value for the first tier and no value for the second tier:  
location in cascadeOption(none)  
• Find issues where a custom field ("Referrer") has the value "none" for the first tier and "none" for the second tier:  
referrer in cascadeOption( "\"none\\"", "\"none\\"" )  
• Find issues where a custom field ("Referrer") has the value "none" for the first tier and no value for the second tier:  
referrer in cascadeOption( "\"none\\"",none) |

^ top of page

closedSprints()  
Search for issues that are assigned to a completedSprint.  

ℹ️ It's possible for an issue to belong to both a completed Sprint(s) and an incomplete Sprint(s). See also openSprints().

<table>
<thead>
<tr>
<th>Syntax</th>
<th>closedSprints()</th>
</tr>
</thead>
<tbody>
<tr>
<td>Supported fields</td>
<td>Sprint</td>
</tr>
<tr>
<td>Supported operators</td>
<td>IN , NOT IN</td>
</tr>
<tr>
<td>Unsupported operators</td>
<td>= , != , ~ , !~ , &gt; , &gt;= , &lt; , &lt;= , IS , IS NOT , WAS , WAS IN , WAS NOT , WAS NOT IN , CHANGED</td>
</tr>
</tbody>
</table>
| Examples | • Find all issues that are assigned to a completedSprint:  
sprint in closedSprints() |

^ top of page
completed()

Only applicable if Jira Service Management is installed and licensed.

Returns issues that have an that has completed at least one cycle.

<table>
<thead>
<tr>
<th>Syntax</th>
<th>completed()</th>
</tr>
</thead>
</table>

<table>
<thead>
<tr>
<th>Supported fields</th>
<th>= , !=</th>
</tr>
</thead>
</table>

<table>
<thead>
<tr>
<th>Supported operators</th>
<th>= , ~ , !~ , &gt; , &gt;= , &lt; , &lt;= , IS , IS NOT , WAS , WAS IN , WAS NOT , WAS NOT IN , CHANGED</th>
</tr>
</thead>
</table>

<table>
<thead>
<tr>
<th>Examples</th>
</tr>
</thead>
<tbody>
<tr>
<td>Find issues where Time to First Response has completed at least one cycle:</td>
</tr>
<tr>
<td>&quot;Time to First Response&quot; = completed()</td>
</tr>
</tbody>
</table>

componentsLeadByUser()

Find issues in components that are led by a specific user. You can optionally specify a user, or if the user is omitted, the current user (i.e. you) will be used.

ℹ️ If you are not logged in to Jira, a user must be specified.

<table>
<thead>
<tr>
<th>Syntax</th>
<th>componentsLeadByUser()</th>
</tr>
</thead>
<tbody>
<tr>
<td>componentsLeadByUser(username)</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Supported fields</th>
<th>Component</th>
</tr>
</thead>
</table>

<table>
<thead>
<tr>
<th>Supported operators</th>
<th>IN , NOT IN</th>
</tr>
</thead>
</table>

<table>
<thead>
<tr>
<th>Unsupported operators</th>
<th>= , != , ~ , !~ , &gt; , &gt;= , &lt; , &lt;= , IS , IS NOT , WAS , WAS IN , WAS NOT , WAS NOT IN , CHANGED</th>
</tr>
</thead>
</table>

<table>
<thead>
<tr>
<th>Examples</th>
</tr>
</thead>
<tbody>
<tr>
<td>Find open issues in components that are led by you:</td>
</tr>
<tr>
<td>component in componentsLeadByUser() AND status = Open</td>
</tr>
<tr>
<td>Find open issues in components that are led by Bill:</td>
</tr>
<tr>
<td>component in componentsLeadByUser(bill) AND status = Open</td>
</tr>
</tbody>
</table>

currentLogin()

Perform searches based on the time at which the current user's session began. See also lastLogin().
### currentLogin()

Perform searches based on the currently logged-in user.

<table>
<thead>
<tr>
<th>Syntax</th>
<th>currentLogin()</th>
</tr>
</thead>
<tbody>
<tr>
<td>Supported fields</td>
<td>Created, Due, Resolved, Updated, custom fields of type Date/Time</td>
</tr>
<tr>
<td>Supported operators</td>
<td>=, !=, &gt;, &gt;=, &lt;, &lt;=, WAS*, WAS IN*, WAS NOT*, WAS NOT IN*, CHANGED*</td>
</tr>
<tr>
<td>Unsupported operators</td>
<td><del>, !</del>, IS, IS NOT, IN, NOT IN</td>
</tr>
<tr>
<td>Examples</td>
<td>• Find issues that have been created during my current session: ( \text{created} &gt; \text{currentLogin()} )</td>
</tr>
</tbody>
</table>

### currentUser()

Perform searches based on the currently logged-in user.

This function can only be used by logged-in users. If you are creating a saved filter that you expect to be used by anonymous users, don’t use this function.

<table>
<thead>
<tr>
<th>Syntax</th>
<th>currentUser()</th>
</tr>
</thead>
<tbody>
<tr>
<td>Supported fields</td>
<td>Assignee, Reporter, Voter, Watcher, custom fields of type User</td>
</tr>
<tr>
<td>Supported operators</td>
<td>=, !=</td>
</tr>
<tr>
<td>Unsupported operators</td>
<td><del>, !</del>, &gt;, &gt;=, &lt;, &lt;=, IS, IS NOT, IN, NOT IN, WAS, WAS IN, WAS NOT, WAS NOT IN, CHANGED</td>
</tr>
</tbody>
</table>
| Examples | • Find issues that are assigned to me: \( \text{assignee} = \text{currentUser()} \)
• Find issues that were reported to me but are not assigned to me:
  \[
  \text{reporter} = \text{currentUser()} \text{ AND } (\text{assignee} \neq \text{currentUser()} \text{ OR assignee is EMPTY})
  \]

### earliestUnreleasedVersion()

Perform searches based on the earliest unreleased version (i.e. next version that is due to be released) of a specified project. See also unreleasedVersions.

Consider that the "earliest" is determined by the ordering assigned to the versions, not by actual Version Due Dates.

| Syntax | earliestUnreleasedVersion(project) |
Supported fields

<table>
<thead>
<tr>
<th>Supported fields</th>
<th>AffectedVersion, FixVersion, custom fields of type Version</th>
</tr>
</thead>
</table>

Supported operators

<table>
<thead>
<tr>
<th>Supported operators</th>
<th>= , != , ~ , != , &gt; , &gt;= , &lt; , &lt;= , IS , IS NOT , WAS , WAS IN , WAS NOT , WAS NOT IN , CHANGED</th>
</tr>
</thead>
</table>

Unsupported operators

<table>
<thead>
<tr>
<th>Unsupported operators</th>
<th>IN , NOT IN</th>
</tr>
</thead>
</table>

Examples

- Find issues whose FixVersion is the earliest unreleased version of the ABC project:
  ```
  fixVersion = earliestUnreleasedVersion(ABC)
  ```
- Find issues that relate to the earliest unreleased version of the ABC project:
  ```
  affectedVersion = earliestUnreleasedVersion(ABC) or fixVersion = earliestUnreleasedVersion(ABC)
  ```

**top of page**

**elapsed()**

*Only applicable if Jira Service Management is installed and licensed.*

Returns issues whose clock is at a certain point relative to a cycle's start event.

<table>
<thead>
<tr>
<th>Syntax</th>
<th>elapsed()</th>
</tr>
</thead>
</table>

Supported fields

| Supported fields | Created, Due, Resolved, Updated, custom fields of type Date/Time |

Supported operators

<table>
<thead>
<tr>
<th>Supported operators</th>
<th>= , != , &gt; , &gt;= , &lt; , &lt;=</th>
</tr>
</thead>
</table>

Unsupported operators

<table>
<thead>
<tr>
<th>Unsupported operators</th>
<th>~ , IS , IS NOT , WAS , WAS IN , WAS NOT , WAS NOT IN , CHANGED</th>
</tr>
</thead>
</table>

Examples

- Find issues that have been waiting for a first response for more than 1 hour:
  ```
  "Time to First Response" > elapsed("1h")
  ```

**top of page**

**endOfDay()**

Perform searches based on the end of the current day. See also endOfWeek(), endOfMonth(), and endOfYear(), startOfDay(), startOfWeek(), startOfMonth(), and startOfYear().

<table>
<thead>
<tr>
<th>Syntax</th>
<th>endOfDay()</th>
</tr>
</thead>
<tbody>
<tr>
<td>endOfDay(&quot;inc&quot;)</td>
<td></td>
</tr>
</tbody>
</table>

*inc* is an optional increment of (+/-) nn (y|M|w|d|h|m). If the time unit qualifier is omitted, it defaults to the natural period of the function, e.g. endOfDay("+1") is the same as endOfDay("+1d"). If the plus/minus (+/-) sign is omitted, plus is assumed.

Supported fields

| Supported fields | Created, Due, Resolved, Updated, custom fields of type Date/Time |

Created in 2023 by Atlassian. Licensed under a [Creative Commons Attribution 2.5 Australia License](https://creativecommons.org/licenses/by/2.5/au/).
| Supported operators | = , != , > , >= , < , <=  
|                    | WAS* , WAS IN* , WAS NOT* , WAS NOT IN* , CHANGED*  
|                    | *Only in predicate  

| Unsupported operators | ~ , !~ , IS , IS NOT , IN , NOT IN  

| Examples |  
|----------------|------------------|----------------|----------------|
| Find issues due by the end of today: | due < endOfDay()  
| Find issues due by the end of tomorrow: | due < endOfDay("+1")  

**top of page**

### endOfMonth()

Perform searches based on the end of the current month. See also `endOfDay()`, `endOfWeek()`, `endOfYear()`, `startOfDay()`, `startOfWeek()`, `startOfMonth()`, and `startOfYear()`.

| Syntax | endOfMonth()  
|        | endOfMonth("inc")  

where _inc_ is an optional increment of (+/-) nn (y|m|w|d|h|m). If the time unit qualifier is omitted, it defaults to the natural period of the function, e.g. `endOfMonth("+1")` is the same as `endOfMonth("+1M")`. If the plus/minus (+/-) sign is omitted, plus is assumed.

| Supported fields | Created, Due, Resolved, Updated, custom fields of type Date/Time  
| Supported operators | = , != , > , >= , < , <=  
|                    | WAS* , WAS IN* , WAS NOT* , WAS NOT IN* , CHANGED*  
|                    | *Only in predicate  

| Unsupported operators | ~ , !~ , IS , IS NOT , IN , NOT IN  

| Examples |  
|----------------|------------------|----------------|----------------|
| Find issues due by the end of this month: | due <= endOfMonth()  
| Find issues due by the end of next month: | due <= endOfMonth("+1")  
| Find issues due by the 15th of next month: | due <= endOfMonth("+15d")  

**top of page**

### endOfWeek()

Perform searches based on the end of the current week. See also `endOfDay()`, `endOfMonth()`, `endOfYear()`, `startOfDay()`, `startOfWeek()`, `startOfMonth()`, and `startOfYear()`.

For the `endOfWeek()` function, the result depends upon your locale. For example, in Europe, the first day of the week is generally considered to be Monday, while in the USA, it is considered to be Sunday.
### Syntax

<table>
<thead>
<tr>
<th>Function</th>
<th>Syntax</th>
</tr>
</thead>
<tbody>
<tr>
<td><code>endOfWeek()</code></td>
<td><code>endOfWeek()</code></td>
</tr>
<tr>
<td><code>endOfWeek(&quot;inc&quot;)</code></td>
<td></td>
</tr>
</tbody>
</table>

*where `inc` is an optional increment of \((+/-)\) nn \((y|M|w|d|h|m)\). If the time unit qualifier is omitted, it defaults to the natural period of the function, e.g. `endOfWeek("+1")` is the same as `endOfWeek("+1w")`. If the plus/minus (+/-) sign is omitted, plus is assumed.*

### Supported fields

| Supported fields | Created, Due, Resolved, Updated, custom fields of type Date/Time |

### Supported operators

| Supported operators | = , != , > , >= , < , <= WAS* , WAS IN* , WAS NOT* , WAS NOT IN* , CHANGED* |

*Only in predicate*

### Unsupported operators

| Unsupported operators | ~ , !~ , IS , IS NOT , IN , NOT IN |

### Examples

- Find issues due by the end of this week:
  ```
  due < endOfWeek()
  ```
- Find issues due by the end of next week:
  ```
  due < endOfWeek("+1")
  ```

---

### endOfYear()

Perform searches based on the end of the current year. See also `startOfDay()`, `startOfWeek()`, `startOfMonth()`, `endOfDay()`, `endOfWeek()`, `endOfMonth()`, and `endOfYear()`.

<table>
<thead>
<tr>
<th>Syntax</th>
<th><code>endOfYear()</code></th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td><code>endOfYear(&quot;inc&quot;)</code></td>
</tr>
</tbody>
</table>

*where `inc` is an optional increment of \((+/-)\) nn \((y|M|w|d|h|m)\). If the time unit qualifier is omitted, it defaults to the natural period of the function, e.g. `endOfYear("+1")` is the same as `endOfYear("+1y")`. If the plus/minus (+/-) sign is omitted, plus is assumed.*

### Supported fields

| Supported fields | Created, Due, Resolved, Updated, custom fields of type Date/Time |

### Supported operators

| Supported operators | = , != , > , >= , < , <= WAS* , WAS IN* , WAS NOT* , WAS NOT IN* , CHANGED* |

*Only in predicate*

### Unsupported operators

| Unsupported operators | ~ , !~ , IS , IS NOT , IN , NOT IN |

### Examples

- Find issues due by the end of this year:
  ```
  due < endOfYear()
  ```
- Find issues due by the end of March next year:
  ```
  due < endOfYear("+3M")
  ```

---
everbreached()

*Only applicable if Jira Service Management is installed and licensed.*

Returns issues that have missed one of their goals.

<table>
<thead>
<tr>
<th>Syntax</th>
<th>elapsed()</th>
</tr>
</thead>
</table>

### Supported fields

<table>
<thead>
<tr>
<th>Supported operators</th>
<th>=, !=</th>
</tr>
</thead>
</table>

### Unsupported operators

~, >, >=, <, <=, IS, IS NOT, WAS, WAS IN, WAS NOT, WAS NOT IN, CHANGED

### Examples

- Find issues have missed their goal for Time to First Response:
  
  "Time to First Response" = everbreached()

---

futureSprints()

Search for issues that are assigned to a sprint that hasn't been started yet.

It is possible for an issue to belong to both completed and incomplete sprints.

<table>
<thead>
<tr>
<th>Syntax</th>
<th>futureSprints()</th>
</tr>
</thead>
</table>

### Supported fields

<table>
<thead>
<tr>
<th>Supported operators</th>
<th>Sprint</th>
</tr>
</thead>
</table>

### Unsupported operators

=, !=, ~, !~, >, >=, <, <=, IS, IS NOT, WAS, WAS IN, WAS NOT, WAS NOT IN, CHANGED

### Examples

- Find all issues that are assigned to asprint that hasn't been started yet:
  
  sprint in futureSprints()
### Syntax

<table>
<thead>
<tr>
<th>IssueHistory()</th>
</tr>
</thead>
</table>

### Supported Fields

- Issue

### Supported Operators

- IN, NOT IN

### Unsupported Operators

- =, !=, ~, !~, >, >=, <, <=, IS, IS NOT, WAS, WAS IN, WAS NOT, WAS NOT IN, CHANGED

### Examples

- Find issues which I have recently viewed, that are assigned to me:
  ```
  issue in issueHistory() AND assignee = currentUser()
  ```

### issuesWithRemoteLinksByGlobalId()

Perform searches based on issues that are associated with remote links that have any of the specified global IDs.

- This function accepts 1 to 100 globalIds. Specifying 0 or more than 100 globalIds will result in errors.

#### Syntax

<table>
<thead>
<tr>
<th>issuesWithRemoteLinksByGlobalId()</th>
</tr>
</thead>
</table>

#### Supported Fields

- Issue

#### Supported Operators

- IN, NOT IN

#### Unsupported Operators

- =, !=, ~, !~, >, >=, <, <=, IS, IS NOT, WAS, WAS IN, WAS NOT, WAS NOT IN, CHANGED

#### Examples

- Find issues that are linked to remote links that have globalId "abc":
  ```
  issue in issuesWithRemoteLinksByGlobalId("abc")
  ```
- Find issues that are linked to remote links that have either globalId "abc" or "def":
  ```
  issue in issuesWithRemoteLinksByGlobalId("abc", "def")
  ```

### lastLogin()

Perform searches based on the time at which the current user's previous session began. See also `currentLogin()`.

#### Syntax

<table>
<thead>
<tr>
<th>lastLogin()</th>
</tr>
</thead>
</table>

#### Supported Fields

- Created. Due, Resolved, Updated, custom fields of type Date/Time
<table>
<thead>
<tr>
<th>Supported operators</th>
<th>= , != , &gt; , &gt;= , &lt; , &lt;= WAS* , WAS IN* , WAS NOT* , WAS NOT IN* , CHANGED* *Only in predicate</th>
</tr>
</thead>
<tbody>
<tr>
<td>Unsupported operators</td>
<td>~ , !~ , IS , IS NOT , IN , NOT IN</td>
</tr>
<tr>
<td>Examples</td>
<td>• Find issues that have been created during my last session: created &gt; lastLogin()</td>
</tr>
</tbody>
</table>

**latestReleasedVersion()**

Perform searches based on the latest released version (i.e. the most recent version that has been released) of a specified project. See also releasedVersions().

Consider that the "latest" is determined by the ordering assigned to the versions, not by actual Version Due Dates.

<table>
<thead>
<tr>
<th>Syntax</th>
<th>latestReleasedVersion(project)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Supported fields</td>
<td>AffectedVersion, FixVersion, custom fields of type Version</td>
</tr>
<tr>
<td>Supported operators</td>
<td>= , !=</td>
</tr>
<tr>
<td>Unsupported operators</td>
<td>~ , !~ , &gt; , &gt;= , &lt; , &lt;= IS , IS NOT , IN , NOT IN , WAS , WAS IN , WAS NOT , WAS NOT IN , CHANGED</td>
</tr>
</tbody>
</table>
| Examples | • Find issues whose FixVersion is the latest released version of the ABC project: fixVersion = latestReleasedVersion(ABC)  
• Find issues that relate to the latest released version of the ABC project: affectedVersion = latestReleasedVersion(ABC) or fixVersion = latestReleasedVersion(ABC) |

**linkedIssues()**

Perform searches based on issues that are linked to a specified issue. You can optionally restrict the search to links of a particular type.

Note that LinkType is case-sensitive.

| Syntax | linkedIssues(issueKey)  
<table>
<thead>
<tr>
<th></th>
<th>linkedIssues(issueKey, linkType)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Supported fields</td>
<td>Issue</td>
</tr>
<tr>
<td>Supported operators</td>
<td>IN, NOT IN</td>
</tr>
<tr>
<td>---------------------</td>
<td>------------</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Unsupported operators</th>
<th>=, !=, <del>, !</del>, &gt;, &gt;=, &lt;, &lt;=, IS, IS NOT, WAS, WAS IN, WAS NOT, WAS NOT IN, CHANGED</th>
</tr>
</thead>
</table>

<table>
<thead>
<tr>
<th>Examples</th>
</tr>
</thead>
</table>
| - Find issues that are linked to a particular issue:  
  issue in linkedIssues(ABC-123)  
- Find issues that are linked to a particular issue via a particular type of link:  
  issue in linkedIssues(ABC-123,"is duplicated by") |

membersOf()

Perform searches based on the members of a particular group.

<table>
<thead>
<tr>
<th>Syntax</th>
<th>membersOf(Group)</th>
</tr>
</thead>
</table>

<table>
<thead>
<tr>
<th>Supported fields</th>
<th>Assignee, Reporter, Voter, Watcher, custom fields of type User</th>
</tr>
</thead>
</table>

<table>
<thead>
<tr>
<th>Supported operators</th>
<th>IN, NOT IN</th>
</tr>
</thead>
</table>

<table>
<thead>
<tr>
<th>Unsupported operators</th>
<th>=, !=, <del>, !</del>, &gt;, &gt;=, &lt;, &lt;=, IS, IS NOT, WAS, WAS IN, WAS NOT, WAS NOT IN, CHANGED</th>
</tr>
</thead>
</table>

<table>
<thead>
<tr>
<th>Examples</th>
</tr>
</thead>
</table>
| - Find issues where the Assignee is a member of the group "Jira-administrators":  
  assignee in membersOf("Jira-administrators")  
- Search through multiple groups and a specific user:  
  reporter in membersOf("Jira-administrators") or reporter in membersOf("Jira-core-users") or reporter=jsmith  
- Search for a particular group, but exclude a particular member or members:  
  assignee in membersOf() and assignee not in ("John Smith","Jill Jones")  
- Exclude members of a particular group:  
  assignee not in membersOf() |

myApproval()

Only applicable if Jira Service Management is installed and licensed.

Search for issues that require approval or have required approval by the current user.

<table>
<thead>
<tr>
<th>Syntax</th>
<th>myApproval()</th>
</tr>
</thead>
</table>

<table>
<thead>
<tr>
<th>Supported fields</th>
<th>Custom fields of type Approval</th>
</tr>
</thead>
</table>

<table>
<thead>
<tr>
<th>Supported operators</th>
<th>=</th>
</tr>
</thead>
</table>
Unsupported operators
~ , ! = , ! ~ , > , >= , < , <=
IS , IS NOT , IN , NOT IN , WAS , WAS IN , WAS NOT , WAS NOT IN , CHANGED

Examples
- Find all issues that require or have required my approval
  approval = myApproval()

\[\text{top of page}\]

myPending()

*Only applicable if Jira Service Management is installed and licensed.*

Search for issues that require approval by the current user.

Syntax
myPending()

Supported fields
Custom fields of type Approval

Supported operators
=

Unsupported operators
~ , ! = , ! ~ , > , >= , < , <=
IS , IS NOT , IN , NOT IN , WAS , WAS IN , WAS NOT , WAS NOT IN , CHANGED

Examples
- Find all issues that require my approval
  approval = myPending()

\[\text{top of page}\]

now()

Perform searches based on the current time.

Syntax
now()

Supported fields
Created, Due, Resolved, Updated, custom fields of type Date/Time

Supported operators
= , ! = , > , >= , < , <=
WAS* , WAS IN* , WAS NOT* , WAS NOT IN* , CHANGED*
*Only in predicate

Unsupported operators
~ , ! ~ , IS , IS NOT , IN , NOT IN

Examples
- Find issues that are overdue:
  duedate < now() and status not in (closed, resolved)
Search for issues that are assigned to a Sprint that has not yet been completed.

It's possible for an issue to belong to both a completed Sprint(s) and an incomplete Sprint(s). See also closedSprints().

<table>
<thead>
<tr>
<th>Syntax</th>
<th>openSprints()</th>
</tr>
</thead>
<tbody>
<tr>
<td>Supported fields</td>
<td>Sprint</td>
</tr>
<tr>
<td>Supported operators</td>
<td>IN, NOT IN</td>
</tr>
<tr>
<td>Unsupported operators</td>
<td>=, !=, <del>, !</del>, &gt;, &gt;=, &lt;, &lt;= IS, IS NOT, WAS, WAS IN, WAS NOT, WAS NOT IN, CHANGED</td>
</tr>
<tr>
<td>Examples</td>
<td>• Find all issues that are assigned to asprint that has not yet been completed: sprint in openSprints()</td>
</tr>
</tbody>
</table>

outdated()

Only applicable if Jira Service Management (Server) is installed and licensed.

Returns issues whose SLAs are out of date because someone has changed the SLA in the settings. After the site reindexes and recalculates the SLAs, the function shouldn't return any issues. Use this function if a reindex is taking a long time or if you've deferred the reindex because you're making a lot of changes.

<table>
<thead>
<tr>
<th>Syntax</th>
<th>outdated()</th>
</tr>
</thead>
<tbody>
<tr>
<td>Supported fields</td>
<td></td>
</tr>
<tr>
<td>Supported operators</td>
<td>= , !=</td>
</tr>
<tr>
<td>Unsupported operators</td>
<td>~, !=, &gt;, &gt;=, &lt;, &lt;= IS, IS NOT, WAS, WAS IN, WAS NOT, WAS NOT IN, CHANGED</td>
</tr>
<tr>
<td>Examples</td>
<td>• Find issues where SLAs are out of date: &quot;Time to First Response&quot;= outdated()</td>
</tr>
</tbody>
</table>

paused()

Only applicable if Jira Service Management is installed and licensed.

Returns issues that have an SLA that is paused due to a condition.

To find issues that are paused because they are outside calendar hours, use withincalendarhours().
### Syntax

<table>
<thead>
<tr>
<th>Syntax</th>
<th>paused()</th>
</tr>
</thead>
</table>

### Supported fields

### Supported operators

=, !=

### Unsupported operators

~, !~, >, >=, <, <=, IS, IS NOT, WAS, WAS IN, WAS NOT, WAS NOT IN, CHANGED

### Examples

- Find issues where Time to First Response is paused:
  "Time to First Response" = paused()

---

### pending()

*Only applicable if Jira Service Management is installed and licensed.*

Search for issues that require approval.

<table>
<thead>
<tr>
<th>Syntax</th>
<th>pending()</th>
</tr>
</thead>
</table>

### Supported fields

Custom fields of type Approval

### Supported operators

=, !=, ~, !, >, >=, <, <=, IS, IS NOT, WAS, WAS IN, WAS NOT, WAS NOT IN, CHANGED

### Examples

- Find all issues that require approval:
  approval = pending()

---

### pendingBy()

*Only applicable if Jira Service Management is installed and licensed.*

Search for issues that require approval by one or more of the listed users. This uses an OR operator, and you must specify the usernames.

<table>
<thead>
<tr>
<th>Syntax</th>
<th>pendingBy(user1,user2)</th>
</tr>
</thead>
</table>

### Supported fields

Custom fields of type Approval

### Supported operators

=, !=, ~, !, >, >=, <, <=, IS, IS NOT, WAS, WAS IN, WAS NOT, WAS NOT IN, CHANGED

### Examples

- Find all issues that require approval by one or more of the listed users:
  approval = pendingBy(user1, user2)
### Unsupported operators

<table>
<thead>
<tr>
<th>Unsatisfied operators</th>
</tr>
</thead>
<tbody>
<tr>
<td><del>, !=, !</del>, &gt;, &gt;=, &lt;, &lt;= IS, IS NOT, IN, NOT IN, WAS, WAS IN, WAS NOT, WAS NOT IN, CHANGED</td>
</tr>
</tbody>
</table>

### Examples

- Find issues that require approval by John Smith:
  ```java
  approval = pendingBy(jsmith)
  ```
- Find issues that require by John Smith or Sarah Khan:
  ```java
  approval = pendingBy(jsmith, skhan)
  ```

### projectsLeadByUser()

Find issues in projects that are led by a specific user. You can optionally specify a user, or if the user is omitted, the current user will be used.

If you are not logged in to Jira, a user must be specified.

#### Syntax

<table>
<thead>
<tr>
<th>Syntax</th>
</tr>
</thead>
<tbody>
<tr>
<td>projectsLeadByUser()</td>
</tr>
<tr>
<td>projectsLeadByUser(username)</td>
</tr>
</tbody>
</table>

#### Supported fields

<table>
<thead>
<tr>
<th>Supported fields</th>
</tr>
</thead>
<tbody>
<tr>
<td>Project</td>
</tr>
</tbody>
</table>

#### Supported operators

<table>
<thead>
<tr>
<th>Supported operators</th>
</tr>
</thead>
<tbody>
<tr>
<td>IN, NOT IN</td>
</tr>
</tbody>
</table>

#### Unsupported operators

<table>
<thead>
<tr>
<th>Unsupported operators</th>
</tr>
</thead>
<tbody>
<tr>
<td>=, !=, <del>, !</del>, &gt;, &gt;=, &lt;, &lt;= IS, IS NOT, WAS, WAS IN, WAS NOT,Was NOT IN,CHANGED</td>
</tr>
</tbody>
</table>

#### Examples

- Find open issues in projects that are led by you:
  ```java
  project in projectsLeadByUser() AND status = Open
  ```
- Find open issues in projects that are led by Bill:
  ```java
  project in projectsLeadByUser(bill) AND status = Open
  ```

### projectsWhereUserHasPermission()

Find issues in projects where you have a specific permission. Note, this function operates at the project level. This means that if a permission (e.g. "Edit Issues") is granted to the reporter of issues in a project, then you may see some issues returned where you are not the reporter, and therefore don't have the permission specified. Also note, this function is only available if you are logged in to Jira.

#### Syntax

<table>
<thead>
<tr>
<th>Syntax</th>
</tr>
</thead>
<tbody>
<tr>
<td>projectsWhereUserHasPermission(permission)</td>
</tr>
</tbody>
</table>

For the `permission` parameter, you can specify any of the permissions described on.

<table>
<thead>
<tr>
<th>Supported fields</th>
</tr>
</thead>
<tbody>
<tr>
<td>Project</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Supported operators</th>
</tr>
</thead>
<tbody>
<tr>
<td>IN, NOT IN</td>
</tr>
</tbody>
</table>

If you are not logged in to Jira, a user must be specified.
### Unsupported operators

| Unsupported operators | = , != , ~ , !~ , > , >= , < , <= IS , IS NOT, WAS , WAS IN , WAS NOT , WAS NOT IN , CHANGED |

### Examples

- Find open issues in projects where you have the "Resolve Issues" permission:
  
  ```
  project in projectsWhereUserHasPermission("Resolve Issues") AND status = Open
  ```

---

### projectsWhereUserHasRole()

Find issues in projects where you have a specific role. Note, this function is only available if you are logged in to Jira.

<table>
<thead>
<tr>
<th>Syntax</th>
<th>projectsWhereUserHasRole(rolename)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Supported fields</td>
<td>Project</td>
</tr>
<tr>
<td>Supported operators</td>
<td>IN , NOT IN</td>
</tr>
<tr>
<td>Unsupported operators</td>
<td>= , != , ~ , !~ , &gt; , &gt;= , &lt; , &lt;= IS , IS NOT, WAS , WAS IN , WAS NOT , WAS NOT IN , CHANGED</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Examples</th>
<th>• Find open issues in projects where you have the &quot;Developers&quot; role:</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>project in projectsWhereUserHasRole(&quot;Developers&quot;) AND status = Open</td>
</tr>
</tbody>
</table>

---

### releasedVersions()

Perform searches based on the released versions (i.e. versions that your Jira administrator has released) of a specified project. You can also search on the released versions of all projects, by omitting the `project` parameter. See also `latestReleasedVersion()`.

<table>
<thead>
<tr>
<th>Syntax</th>
<th>releasedVersions()</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>releasedVersions(project)</td>
</tr>
<tr>
<td>Supported fields</td>
<td>AffectedVersion, FixVersion, custom fields of type Version</td>
</tr>
<tr>
<td>Supported operators</td>
<td>IN , NOT IN</td>
</tr>
<tr>
<td>Unsupported operators</td>
<td>= , != , ~ , !~ , &gt; , &gt;= , &lt; , &lt;= IS , IS NOT, WAS , WAS IN , WAS NOT , WAS NOT IN , CHANGED</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Examples</th>
<th>• Perform searches based on the released versions of a specified project:</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>project in releasedVersions(&quot;Project&quot;) AND status = Open</td>
</tr>
</tbody>
</table>

---

"top of page"
### Examples

- Find issues whose FixVersion is a released version of the ABC project:
  
  ```jql```
  fixVersion in releasedVersions(ABC)
  ```jql```

- Find issues that relate to released versions of the ABC project:
  
  ```jql```
  (affectedVersion in releasedVersions(ABC)) or (fixVersion in releasedVersions(ABC))
  ```jql```

---

**remaining()**

*Only applicable if Jira Service Management is installed and licensed.*

Returns issues whose clock is at a certain point relative to the goal.

<table>
<thead>
<tr>
<th>Syntax</th>
<th>remaining()</th>
</tr>
</thead>
<tbody>
<tr>
<td>Supported fields</td>
<td></td>
</tr>
<tr>
<td>Supported operators</td>
<td>=, !=, &gt;, &gt;=, &lt;, &lt;=</td>
</tr>
<tr>
<td>Unsupported operators</td>
<td>~, IS, IS NOT, WAS, WAS IN, WAS NOT, WAS NOT IN, CHANGED</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Examples</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>• Find issues that will breach Time to Resolution in the next two hours: &quot;Time to Resolution&quot; &lt; remaining(&quot;2h&quot;)</td>
</tr>
</tbody>
</table>

---

**running()**

*Only applicable if Jira Service Management is installed and licensed.*

Returns issues that have an SLA that is running, regardless of the calendar.

To find issues that are running based on calendar hours, use `withincalendarhours()`.

<table>
<thead>
<tr>
<th>Syntax</th>
<th>running()</th>
</tr>
</thead>
<tbody>
<tr>
<td>Supported fields</td>
<td></td>
</tr>
<tr>
<td>Supported operators</td>
<td>=, !=</td>
</tr>
<tr>
<td>Unsupported operators</td>
<td>~, !=, &gt;, &gt;=, &lt;, &lt;=, IS, IS NOT, WAS, WAS IN, WAS NOT, WAS NOT IN, CHANGED</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Examples</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>• Find issues where Time to First Response is running: &quot;Time to First Response&quot; = running()</td>
</tr>
</tbody>
</table>

---

**standardIssueTypes()**
Perform searches based on "standard" Issue Types, that is, search for issues that are not sub-tasks. See also subtaskIssueTypes().

<table>
<thead>
<tr>
<th>Syntax</th>
<th>standardIssueTypes()</th>
</tr>
</thead>
<tbody>
<tr>
<td>Supported fields</td>
<td>Type</td>
</tr>
<tr>
<td>Supported operators</td>
<td>IN, NOT IN</td>
</tr>
<tr>
<td>Unsupported operators</td>
<td>=, !=, ~, !=, &gt;, &gt;=, &lt;, &lt;= IS, IS NOT, WAS, WAS IN, WAS NOT, WAS NOT IN, CHANGED</td>
</tr>
</tbody>
</table>
| Examples             | • Find issues that are not subtasks (i.e. issues whose Issue Type is a standard issue type, not a subtask issue type):
                      |   issuetype in standardIssueTypes() |

**startOfDay()**

Perform searches based on the start of the current day. See also startOfWeek(), startOfMonth(), startOfYear(), endOfDay(), endOfWeek(), endOfMonth(), and endOfYear().

<table>
<thead>
<tr>
<th>Syntax</th>
<th>startOfDay()</th>
</tr>
</thead>
<tbody>
<tr>
<td>Supported fields</td>
<td>Created, Due, Resolved, Updated, custom fields of type Date/Time</td>
</tr>
<tr>
<td>Supported operators</td>
<td>=, !=, &gt;, &gt;=, &lt;, &lt;= WAS*, WAS IN*, WAS NOT*, WAS NOT IN*, CHANGED*</td>
</tr>
<tr>
<td>Unsupported operators</td>
<td><del>, !</del>, IS, IS NOT, IN, NOT IN</td>
</tr>
</tbody>
</table>
| Examples             | • Find new issues created since the start of today:
                      |   created > startOfDay() |
|                      | • Find new issues created since the start of yesterday:
                      |   created > startOfDay("-1") |
|                      | • Find new issues created in the last three days:
                      |   created > startOfDay("-3d") |

**startOfMonth()**
Perform searches based on the start of the current month. See also `startOfDay()`, `startOfWeek()`, `startOfYear()`, `endOfDay()`, `endOfWeek()`, `endOfMonth()`, and `endOfYear()`.

**Syntax**

```
startOfMonth()
startOfMonth("inc")
```

*where inc is an optional increment of \(+/-\)nn\(y|M|w|d|h|m\). If the time unit qualifier is omitted, it defaults to the natural period of the function, e.g. `startOfMonth("+1")` is the same as `startOfMonth("+1M")`. If the plus/minus (+/-) sign is omitted, plus is assumed.*

**Supported fields**

Created, Due, Resolved, Updated, custom fields of type Date/Time

**Supported operators**

`= , ! = , > , >= , < , <=

WAS*, WAS IN*, WAS NOT*, WAS NOT IN*, CHANGED*

*Only in predicate

**Unsupported operators**

~ , !~ , IS , IS NOT , IN , NOT IN

**Examples**

- Find new issues created since the start of this month:
  
  ```
  created > startOfMonth()
  ```

- Find new issues created since the start of last month:
  
  ```
  created > startOfMonth("-1")
  ```

- Find new issues created since the 15th of this month:
  
  ```
  created > startOfMonth("+14d")
  ```

^ top of page

---

**startOfWeek()**

Perform searches based on the start of the current week. See also `startOfDay()`, `startOfMonth()`, `startOfYear()`, `endOfDay()`, `endOfWeek()`, `endOfMonth()`, and `endOfYear()`.

For the `startOfWeek()` function, the result depends upon your locale. For example, in Europe, the first day of the week is generally considered to be Monday, while in the USA, it is considered to be Sunday.

**Syntax**

```
startOfWeek()
startOfWeek("inc")
```

*where inc is an optional increment of \(+/-\)nn\(y|M|w|d|h|m\). If the time unit qualifier is omitted, it defaults to the natural period of the function, e.g. `startOfWeek("+1")` is the same as `startOfWeek("+1w")`. If the plus/minus (+/-) sign is omitted, plus is assumed.*

**Supported fields**

Created, Due, Resolved, Updated, custom fields of type Date/Time

**Supported operators**

`= , ! = , > , >= , < , <=

WAS*, WAS IN*, WAS NOT*, WAS NOT IN*, CHANGED*

*Only in predicate

**Unsupported operators**

~ , !~ , IS , IS NOT , IN , NOT IN
Examples

- Find new issues since the start of this week:
  \[\text{created} > \text{startOfWeek()}\]
- Find new issues since the start of last week:
  \[\text{created} > \text{startOfWeek("-1")}\]

\(\text{startOfYear()}\)

Perform searches based on the start of the current year. See also `startOfDay()`, `startOfWeek()`, `startOfMonth()`, `endOfDay()`, `endOfWeek()`, `endOfMonth()`, and `endOfYear`.  

**Syntax**

\[
\text{startOfYear()} \\
\text{startOfYear("inc")}
\]

where inc is an optional increment of \((+/-) \text{nn} \, \text{y|M|W|d|h|m}\). If the time unit qualifier is omitted, it defaults to the natural period of the function, e.g. `endOfYear("+1")` is the same as `endOfYear("+1y")`. If the plus/minus \((+/-)\) sign is omitted, plus is assumed.

**Supported fields**

Created, Due, Resolved, Updated, custom fields of type Date/Time

**Supported operators**

\(=\), \(!=\), \(>\), \(>=\), \(<\), \(<=\)

\(\text{WAS}^*\), \(\text{WAS IN}^*\), \(\text{WAS NOT}^*\), \(\text{WAS NOT IN}^*\), \(\text{CHANGED}^*\)

*Only in predicate

**Unsupported operators**

\(~\), \(!~\), \(\text{IS}\), \(\text{IS NOT}\), \(\text{IN}\), \(\text{NOT IN}\)

**Examples**

- Find new issues since the start of this year:
  \[\text{created} > \text{startOfYear()}\]
- Find new issues since the start of last year:
  \[\text{created} > \text{startOfYear("-1")}\]

\(\text{subtaskIssueTypes()}\)

Perform searches based on issues that are sub-tasks. See also `standardIssueTypes()`.  

**Syntax**

\[
\text{subtaskIssueTypes()}
\]

**Supported fields**

Type

**Supported operators**

\(\text{IN}\), \(\text{NOT IN}\)

**Unsupported operators**

\(=\), \(!=\), \(~\), \(!~\), \(>\), \(>=\), \(<\), \(<=\), \(\text{IS}\), \(\text{IS NOT}\), \(\text{WAS}\), \(\text{WAS IN}\), \(\text{WAS NOT}\), \(\text{WAS NOT IN}\), \(\text{CHANGED}\)
**Examples**

- Find issues that are subtasks (i.e. issues whose Issue Type is a subtask issue type):

  `issuetype in subtaskIssueTypes()`

<table>
<thead>
<tr>
<th>Syntax</th>
<th>unreleasedVersions()</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>unreleasedVersions(project)</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Supported fields</th>
<th>AffectedVersion, FixVersion, custom fields of type Version</th>
</tr>
</thead>
<tbody>
<tr>
<td>Supported operators</td>
<td>IN, NOT IN</td>
</tr>
<tr>
<td>Unsupported operators</td>
<td>=, !=, <del>, !</del>, &gt;, &gt;=, &lt;, &lt;=, IS, IS NOT, WAS, WAS IN, WAS NOT, WAS NOT IN, CHANGED</td>
</tr>
</tbody>
</table>

**Examples**

- Find issues whose FixVersion is an unreleased version of the ABC project:

  `fixVersion in unreleasedVersions(ABC)`

- Find issues that relate to unreleased versions of the ABC project:

  `affectedVersion in unreleasedVersions(ABC)`

**updatedBy()**

Search for issues that were updated by a specific user, optionally within the specified time range. An update in this case includes creating an issue, updating any of the issue’s fields, creating or deleting a comment, or editing a comment (only the last edit).

For the time range, use one of the following formats:

"yyyy/MM/dd"
"yyyy-MM-dd"

Or use"w"(weeks), or"d"(days)to specify a date relative to the current time. Unlike some other functions, `updatedBy` doesn't support values smaller then a day, and will always round them up to 1 day.

<table>
<thead>
<tr>
<th>Syntax</th>
<th>updatedBy(user)</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>updatedBy(user, dateFrom)</td>
</tr>
<tr>
<td></td>
<td>updatedBy(user, dateFrom, dateTo)</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Supported fields</th>
<th>Issuekey, and its aliases (id, issue, key)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Supported operators</td>
<td>IN , NOT IN</td>
</tr>
<tr>
<td>---------------------</td>
<td>-------------</td>
</tr>
<tr>
<td>Unsupported operators</td>
<td>=, <del>, != ,!</del> ,&gt;, &gt;=, &lt;, &lt;= IS, IS NOT, WAS, WAS IN, WAS NOT, WAS NOT IN, CHANGED</td>
</tr>
</tbody>
</table>
| Examples | • Find issues that were updated by John Smith:  
  `issuekey IN updatedBy(jsmith)`  
  • Find issues that were updated by John Smith within the last 8 days:  
  `issuekey IN updatedBy(jsmith, "-8d")`  
  • Find issues updated between June and September 2018:  
  `issuekey IN updatedBy(jsmith, "2018/06/01", "2018/08/31")`  
  • If you try to find issues updated in the last hour, like in the following example, the time will be rounded up to 1 day, as smaller values aren't supported:  
  `issuekey IN updatedBy(jsmith, "-1h")` |

\[ ^\text{top of page} \]

**votedIssues()**

Perform searches based on issues for which you have voted. Also, see the **Voter** field.

\[ ^\text{This function can only be used by logged-in users.} \]

<table>
<thead>
<tr>
<th>Syntax</th>
<th><code>votedIssues()</code></th>
</tr>
</thead>
<tbody>
<tr>
<td>Supported fields</td>
<td>Issue</td>
</tr>
<tr>
<td>Supported operators</td>
<td>IN , NOT IN</td>
</tr>
<tr>
<td>Unsupported operators</td>
<td>=, != ,~ ,!~ ,&gt;, &gt;=, &lt;, &lt;= IS, IS NOT, WAS, WAS IN, WAS NOT, WAS NOT IN, CHANGED</td>
</tr>
</tbody>
</table>
| Examples | • Find issues that you have voted for:  
  `issue in votedIssues()` |

\[ ^\text{top of page} \]

**watchedIssues()**

Perform searches based on issues that you are watching. Also, see the **Watcher** field.

\[ ^\text{This function can only be used by logged-in users.} \]

<table>
<thead>
<tr>
<th>Syntax</th>
<th><code>watchedIssues()</code></th>
</tr>
</thead>
<tbody>
<tr>
<td>Supported fields</td>
<td>Issue</td>
</tr>
</tbody>
</table>
### withinCalendarHours()

*Only applicable if Jira Service Management is installed and licensed.*

Returns issues that have an SLA that is running according to the calendar.

For example, say your project has two SLAs that count Time to First Response. Some issues with this use a 9am-1pm calendar, and others use a 9am-5pm calendar. If an agent starts work at 3pm, they probably want to work on issues from the 9am-5pm agreement first. They can use withinCalendarHours() to find all the issues where Time to First Response is running at 3pm.

<table>
<thead>
<tr>
<th>Syntax</th>
<th>withinCalendarHours()</th>
</tr>
</thead>
<tbody>
<tr>
<td>Supported fields</td>
<td></td>
</tr>
<tr>
<td>Supported operators</td>
<td>=, !=</td>
</tr>
<tr>
<td>Unsupported operators</td>
<td><del>, !</del>, &gt;, &gt;=, &lt;, &lt;=, IS, IS NOT, WAS, WAS IN, WAS NOT, WAS NOT IN, CHANGED</td>
</tr>
<tr>
<td>Examples</td>
<td>• Find issues where Time to First Response is within calendar hours: &quot;Time to First Response&quot; = withinCalendarHours()</td>
</tr>
</tbody>
</table>

^ top of page
Search syntax for text fields

This page provides information on the syntax for searching text fields, which can be done in the quick search, basic search, and advanced search.

Text searches can be done in the advanced search when the CONTAINS(¬) operator is used, e.g. summary-"windows*". It can also be done in quick search and basic search when searching on supported fields.

Acknowledgments: Jira uses Apache Lucene for text indexing, which provides a rich query language. Much of the information on this page is derived from the Query Parser Syntax page of the Lucene documentation.

---

On this page:

- Query terms
- Term modifiers
- Boosting a term: ^
- Boolean operators
- Grouping
- Special characters
- Reserved words
- Word stemming
- Limitations
- Next steps

Query terms

A query is broken up into terms and operators. There are two types of terms: Single Terms and Phrases.

A Single Term is a single word, such as "test" or "hello".

A Phrase is a group of words surrounded by double quotes, such as "hello dolly".

Multiple terms can be combined together with Boolean operators to form a more complex query (see below). If you combine multiple terms without specifying any Boolean operators, they will be joined using AND operators.

Note: All query terms in Jira are not case sensitive.

Term modifiers

Jira supports modifying query terms to provide a wide range of searching options.

Exact searches (phrases) | Wildcard searches: ? and * | Fuzzy searches: ~ | Prefix and Suffix search | Proximity searches

Exact searches (phrases)

To find exact matches for phrases, for example Jira Software, you need to enclose the whole phrase in quote-marks ("). Otherwise, the search will return all issues that contain both words in no particular order - this would include Jira Software, but also Jira is the best software!

Examples

- Basic search: Find all issues that contain the phrase Jira Software:
  
  Just type "Jira Software" into the search field.

- Advanced search: Find all issues that contain the words Jira and Software, in no particular order.
  
  text ~ "Jira Software"

- Advanced search: Find all issues that contain the phrase Jira Software.
Advanced search: Find all issues that contain the URL https://atlassian.com:

As you can see in the two preceding examples, the query contains two pairs of quote-marks. The external ones are needed to meet the JQL rules and aren't related to your search query. The same pair of quote-marks would be automatically added by Jira in the basic search after running your search.

Using special characters to create phrases

In previous versions of Jira, you could use some special characters to combine terms into phrases, for example Jira+Software or Jira/Software. This is no longer the case, as the mechanism used for searching has changed and the special characters surrounding terms are ignored.

Wildcard searches: ? and *

Jira supports single and multiple character wildcard searches.

To perform a single character wildcard search, use the "?" symbol.

To perform a multiple character wildcard search, use the "*" symbol.

The single character wildcard search looks for terms that match that with the single character replaced. For example, to search for "text" or "test", you can use the search:

```
t?t
```

Multiple character wildcard searches looks for 0 or more characters. For example, to search for Windows, Win95, or WindowsNT, you can use the search:

```
win*
```

You can also use the wildcard searches in the middle of a term. For example, to search for Win95 or Windows95, you can use the search:

```
wi*95
```

Fuzzy searches: ~

Jira supports fuzzy searches. To do a fuzzy search, use the tilde, "~", symbol at the end of a single word term. For example, to search for a term similar in spelling to "roam", use the fuzzy search:

```
roam~
```

This search will find terms like foam and roams.

Note: Terms found by the fuzzy search will automatically get a boost factor of 0.2.

Prefix and Suffix search
Jira supports searching for parts of the words. To perform such search, include either a prefix or a suffix of the word or phrase you’re looking for. For example to look for a MagicBox issue, you can use either of the two search patterns:

<table>
<thead>
<tr>
<th>Prefix search</th>
<th>Suffix search</th>
</tr>
</thead>
<tbody>
<tr>
<td>summary ~ &quot;magic*&quot;</td>
<td>summary ~ &quot;*box&quot;</td>
</tr>
</tbody>
</table>

**Proximity searches**

Jira supports finding words that are within a specific distance away. To do a proximity search, use the tilde, "~", symbol at the end of a phrase. For example, to search for "atlassian" and "Jira" within 10 words of each other in a document, use the search:

"atlassian Jira"~10

**Boosting a term: ^**

Jira provides the relevance level of matching documents based on the terms found. To boost a term, use the caret, "^", symbol with a boost factor (a number) at the end of the term you are searching. The higher the boost factor, the more relevant the term will be.

Boosting allows you to control the relevance of a document by boosting its term. For example, if you are searching for

atlassian Jira

and you want the term "atlassian" to be more relevant, boost it using the ^ symbol along with the boost factor next to the term. You would type:

atlassian^4 Jira

This will make documents with the term atlassian appear more relevant. You can also boost Phrase Terms, as in the example:

"atlassian Jira"^4 querying

By default, the boost factor is 1. Although, the boost factor must be positive, it can be less than 1 (i.e. 0.2).

**Boolean operators**

Boolean operators allow terms to be combined through logic operators. Jira supports AND, "+", OR, NOT and "~" as Boolean operators.

AND | OR | Required term: + | NOT | Excluded term: -

Booleans operators must be ALL CAPS.
AND

The AND operator is the default conjunction operator. This means that if there is no Boolean operator between two terms, the AND operator is used. The AND operator matches documents where both terms exist anywhere in the text of a single document. This is equivalent to an intersection using sets. The symbol \&\& can be used in place of the word AND.

To search for documents that contain "atlassian Jira" and "issue tracking", use the query:

"atlassian Jira" AND "issue tracking"

OR

The OR operator links two terms, and finds a matching document if either of the terms exist in a document. This is equivalent to a union using sets. The symbol || can be used in place of the word OR.

To search for documents that contain either "atlassian Jira" or just "confluence", use the query:

"atlassian Jira" || confluence

or

"atlassian Jira" OR confluence

Required term: +

The "+" or required operator requires that the term after the "+" symbol exists somewhere in the field of a single document.

To search for documents that must contain "Jira" and may contain "atlassian", use the query:

+Jira atlassian

NOT

The NOT operator excludes documents that contain the term after NOT. This is equivalent to a difference using sets. The symbol ! can be used in place of the word NOT.

To search for documents that contain "atlassian Jira" but not "japan", use the query:

"atlassian Jira" NOT "japan"

Note: The NOT operator cannot be used with just one term. For example, the following search will return no results:

NOT "atlassian Jira"

Usage of the NOT operator over multiple fields may return results that include the specified excluded term. This is due to the fact that the search query is executed over each field in turn, and the result set for each field is combined to form the final result set. Hence, an issue that matches the search query based on one field, but fails based on another field will be included in the search result set.

Excluded term: -

The "-" or prohibit operator excludes documents that contain the term after the "-" symbol.
To search for documents that contain "atlassian Jira" but not "japan", use the query:

"atlassian Jira" -japan

Grouping

Jira supports using parentheses to group clauses to form sub queries. This can be very useful if you want to control the boolean logic for a query.

To search for bugs and either atlassian or Jira, use the query:

bugs AND (atlassian OR Jira)

This eliminates any confusion and makes sure that bugs must exist, and either term atlassian or Jira may exist.

Do not use the grouping character '(' at the start of a search query, as this will result in an error. For example, "(atlassian OR Jira) AND bugs" will not work.

Special characters

Special characters arent stored in the index, which means you cant search for them. The index only keeps text and numbers, so searching for "\[Jira Software\]" and "Jira Software" will have the same effect escaped special characters ([]) wont be included in the search.

In previous Jira versions, you could use special characters to combine two separate terms into a phrase, for example "Jira+Software" or "Jira/Software". This doesnt apply to Jira 8.x. If youd like to search for phrases, see Exact searches (phrases).

Reserved words

To keep the search index size and search performance optimal in Jira, the following English reserved words (also known as 'stop words') are ignored from the search index and hence, Jira's text search features:

"a", "and", "are", "as", "at", "be", "but", "by", "for", "if", "in", "into", "is", "it", "no", "not", "of", "on", "or", "such", "that", "the", "their", "then", "there", "these", "they", "this", "to", "was", "will", "with"

Be aware that this can sometimes lead to unexpected results. For example, suppose one issue contains the text phrase "VSX will crash" and another issue contains the phrase "VSX will not crash". A text search for "VSX will crash" will return both of these issues. This is because the words will and not are part of the reserved words list.

Your Jira administrator can make Jira index these reserved words (so that Jira will find issues based on the presence of these words) by changing the Indexing Language to Other (under Administration > System > General Configuration).

Word stemming

Since Jira cannot search for issues containing parts of words (see below), word 'stemming' allows you to retrieve issues from a search based on the 'root' (or 'stem') forms of words instead of requiring an exact match with specific forms of these words. The number of issues retrieved from a search based on a stemmed word is typically larger, since any other issues containing words that are stemmed back to the same root will also be retrieved in the search results.
For example, if you search for issues using the query term 'customize' on the Summary field, Jira stems this word to its root form 'custom', and will retrieve all issues whose Summary field also contains any word that can be stemmed back to 'custom'. Hence, the following query:

```
summary ~ "customize"
```

will retrieve issues whose Summary field contains the following words:

- customized
- customizing
- customs
- customer
- etc.

**Please Note:**

- Your Jira administrator can disable word stemming (so that Jira will find issues based on exact matches with words) by changing the Indexing Language to Other (under Administration > System > General Configuration).
- Word stemming applies to all Jira fields (as well as text fields).
- When Jira indexes its fields, any words that are 'stemmed' are stored in Jira's search index in root form only.

**Limitations**

Please note that the following limitations apply to Jira's search:

**Whole words only**

Jira cannot search for issues containing parts of words but on whole words only. The exception to this are words which are stemmed.

This limitation can also be overcome using fuzzy searches.

**Next steps**

Read the following related topics:

- Searching for issues
- Quick searching
- Basic searching
- Advanced searching
Saving your search as a filter

Jira’s powerful issue search functionality is enhanced by the ability to save searches, called filters in Jira, for later use. You can do the following with Jira filters:

- Share and email search results with your colleagues, as well as people outside of your organization
- Create lists of favorite filters
- Have search results emailed to you according to your preferred schedule
- View and export the search results in various formats (RSS, Excel, etc)
- Display the search results in a report format
- Display the search results in a dashboard gadget

On this page:
- Saving a search as a filter
- Running a filter
- Managing your existing filters
- Managing other user’s shared filters
- Next steps

Screenshot: Issue filter results in detail view

Saving a search as a filter

1. Define and run your search.
2. Click the Save as link above the search results. The Save Filter dialog is displayed.
3. Enter a name for the new filter and click Submit. Your filter is created.

Your new filter will be added to your favorite filters and shared, according to the sharing preference in your user profile. If you haven’t specified a preference, then the global default will be applied, which is ‘Private’ unless changed by your Jira administrator.

Running a filter

2. Choose any filter from the list on the left:
   - System filter My Open Issues, Reported by Me, Recently Viewed, All Issues
   - Favorite filters (listed alphabetically)
   - Find filters lets you search for any filter that’s been shared, which you can then subscribe to (adding it to your Favorite Filters).
3. After selecting a filter, the search results are displayed. The search criteria for the filter are also displayed and can be changed.
   
   Note, if you run the Recently Viewed system filter, this will switch you to the advanced search, as the basic search cannot represent the ORDER BY clause in this filter.

Managing your existing filters

Click Issues > Manage filters to manage your filters.
The Manage Filters page allows you to view and configure filters that you have created, as well as work with filters that other users have shared with you. See the following topics for more information:

- Searching for a filter
- Updating a filter
- Deleting a filter
- Cloning a filter
- Adding a filter as a favorite
- Sharing a filter
- Defining a filter-specific column order
- Subscribing to a filter

### Searching for a filter

You can find and run any filters that you have created or that have been shared by other users.

1. Click the Search tab on the 'Manage Filters' page.
2. Enter your search criteria and click Search to run the search.
3. Your search results are displayed on the same page. Click the name of any issue filter to run it.

**Tip:** If the filter has been added as a favorite by many users, you may also be able locate it on the Popular tab of the Manage Filters page.

### Updating a filter

You can update the name, description, sharing, favorite of any filters that you created, or have permission to edit. If you want to edit a filter for which you only have the view permission, either clone (aka copy) the shared filter, or ask your Jira administrator to change the filter's ownership.

Update the filter's details:

1. Click the My tab on the 'Manage Filters' page.
2. Locate the filter you wish to update, click the cog icon > Edit.
3. The Edit Current Filter page displays, where you can update the filter details as required.
4. Click Save to save your changes.

**Tip:** If you have an editor role assigned and want to save changes to a filter, you must be a member of all groups that the filter is shared with. Otherwise, you will not be able to save the changes.

Update the filter's search criteria:

1. Click the My tab on the 'Manage Filters' page.
2. Locate the filter you want to update and run it.
3. Update the search criteria as desired, and rerun the query to ensure the update is valid. You will see the word **Edited** displayed next to your filter name.

4. Click **Save** to overwrite the current filter with the updated search criteria. If you want discard your changes instead, click the arrow next to the save button, and select **Discard changes**.

**Deleting a filter**

1. Click the **My** tab on the ‘Manage Filters’ page.
2. Locate the filter you wish to delete, click the **cog icon > Delete**.

**Cloning a filter**

You can clone any filter which is just a way of making a copy that you own that was either created by you or shared with you.

1. Locate the filter you wish to clone and run it.
2. Update the search criteria as desired. Click the arrow next to the **Save** button, and select **Save > Save** as to create a new filter from the existing filter.

**Adding a filter as a favorite**

Filters that you've created or that have been shared by others can be added to your favorite filters. Favorite filters are listed in the menu under **Issues > Filters**, and in the left panel of the issue navigator.

1. Locate the filter you wish to add as a favorite.
2. Click the star icon next to the filter name to add it to your favorites.

**Sharing a filter**

Filters that you have created or have permission to edit can be shared with other users, user groups, projects, and project roles. They can also be shared globally. You can choose whether you want to share the filter with the permission to edit, or only to view. Any filter that is shared is visible to users who have the 'Jira Administrators' global permission. See **Managing other users’ shared filters** below.

1. Click the **My** tab on the ‘Manage Filters’ page.
2. Locate the filter you wish to share, click the **cog icon > Edit**.
3. Update the **Add Viewers** and **Add Editors** fields by selecting the user, group, project, or project role that you want to share the filter with, and clicking **Add**. Note that you can only share filters with groups/roles of which you are a member.

   You need the Create Shared Object global permission to configure sharing for a filter. Contact your Jira administrator to obtain this permission.

4. Click **Save** to save your changes.

**Tip:** You can also share your filter by running it, then clicking **Details > Edit Permissions**.

**Defining a filter-specific column order**

You can add a defined column order to a saved filter, which displays the filter results according to the saved column order. Otherwise, the results are displayed according to your personal column order (if you have set this) or the system default.

**Tip:** To display your configured column order in a filter subscription, select " for the 'Outgoing email format' in your **User Profile**. If you receive text emails from Jira, you won’t be able to see your configured column order.

**To add a column layout to a saved filter:**

1. Click the **My** tab on the ‘Manage Filters’ page.
2. Locate the filter you wish to update; click the filter's name to display the results. Be sure you are viewing the filter in the **List** view so that you see the columns.
3. Configure the column order as desired by clicking on the column name and dragging it to the new position. Your changes are saved and will be displayed the next time you view this filter.
To remove a filter’s saved column layout:

1. Click the My tab on the 'Manage Filters' page.
2. Locate the filter you wish to update; click the filter’s name to display the results. Be sure you are viewing the filter in the List view so that you see the columns.
3. Click the Columns option on the top right of the displayed columns, and select Restore Defaults in the displayed window.

Exporting column ordered issues

When the results of a saved filter are exported to Excel, the column order and choice of columns are those that were saved with the filter. Even if a user has configured a personal column order for the results on the screen, the saved configuration is used for the Excel export. To export using your own configuration, save a copy of the filter along with your configuration, and then export the results to Excel.

Subscribing to a filter

See Working with search results.

Managing other user’s shared filters

A shared filter is a filter whose creator has shared that filter with other users. Refer to Sharing a filter above for details. When a shared filter is created by a user, that user:

- Initially 'owns' the shared filter.
- Being the owner, can edit and modify the shared filter.

If you have the Jira Administrators global permission, you can manage shared filters that were created by other users. For instructions, see Managing shared filters.

Next steps

Read the following related topics:

- Searching for issues
- Basic searching
- Advanced searching
- Working with search results
Working with search results

Once you have run a search, your search results will be displayed in the issue navigator. You may want to triage the entire list of issues or may be looking for just one. This page will show you what you can do with your search results, from changing what you see in the issue navigator to modifying the issues.

The following screenshot provides an overview of the key features of the issue navigator.

**Screenshot: Issue navigator (Detail view)**

1. **Filter panel:** Click << to collapse the filter panel so you can have more space in the detail view.
2. **Issue:** Select an issue from this panel to see the details in the detail view window.
3. **Filters:** Select a filter to see all the matching issues in the panel to the immediate right.
4. **Views:** Click to switch between the detail view and list view.
5. **Detail view:** Check out all the details about the selected issue in this detail view.

Changing your view of the search results
<table>
<thead>
<tr>
<th>List view or Detail view</th>
<th>Click the Change view (≡) dropdown to switch between List view and Detail view for your search results.</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td><strong>List view</strong>: Shows your search results as a list of issues. This view is easiest to scan and is best when you only need to know a few details about each issue. <strong>Detail view</strong>: Shows your search results as a list of issues, with the right panel showing the details of the currently selected issue. This view is best when you need more information about the individual issues, or you want to quickly edit issues as you go (via inline edit for certain fields).</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Change the sort order</th>
<th>Click the column name. If you click the same column name more than once, the sort order will switch between ascending and descending. Note:</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td><strong>You cannot sort by the 'Images' column nor the sub-task aggregate columns (i.e. all columns beginning with &quot;)</strong>. <strong>If you sort the search results for an advanced search, an 'ORDER BY' clause will be added/updated for your JQL query to reflect the order of issues in your search results.</strong></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Columns show/hide and move</th>
<th>You can create different column configurations for yourself and for specific filters. To switch between different column configurations, click <strong>Columns</strong> and select one of the following tabs:</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td><strong>My Defaults</strong>: This is your default column configuration for search results. <strong>Filter</strong>: This is enabled if you are viewing the search results for a filter. It will override your default column configuration. <strong>System (shows if you are a Jira administrator)</strong>: This is the column configuration that applies to all users. It will be overridden by a user's default column configuration and filter-specific column configurations.</td>
</tr>
<tr>
<td></td>
<td>You can also modify any of these configurations. Make sure you have switched the desired configuration, then do the following:</td>
</tr>
<tr>
<td></td>
<td><strong>Show/hide columns</strong>: Click <strong>Columns</strong>, choose the desired columns, then click <strong>Done</strong>. <strong>Move a column</strong>: Click the column name and drag it to the desired position.</td>
</tr>
<tr>
<td></td>
<td>If you cannot find a column, please make sure that you haven't run in to any of the following restrictions:</td>
</tr>
<tr>
<td></td>
<td><strong>You can only see columns for issue fields that have not been hidden and that you have permissions to see.</strong> <strong>It is possible to add any of the existing custom fields to the column list, as long as the fields are visible, and you have the right permissions.</strong> <strong>Some custom fields, even if selected, do not appear in the Issue Navigator for all issues. For example, project-specific custom fields will be shown only if the filter has been restricted to that project only. Issue type custom fields will only appear if the filter has been restricted to that issue type.</strong></td>
</tr>
</tbody>
</table>

**Working with individual issues**

You can action individual issues in your search results, directly from the issue navigator. Note that the list of issues will remain constant even if you change an issue, so that it doesn't meet the original search criteria. The advantage of this is that you have a constant set of search results that you can work from when triaging issues.

<table>
<thead>
<tr>
<th>View an issue</th>
<th>Click the key or summary of the issue.</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td><strong>If you are in List view, you will redirected to the issue (leaving the search results page).</strong> <strong>If you are in Detail view, the issue details will display in the right panel.</strong></td>
</tr>
</tbody>
</table>
| Action an issue | To action an issue (e.g. edit it, transition it, log work on it, etc):

- If you are in List view, click the cog icon and select from the options.
- If you are in Detail view, select the issue and action it the issue via the details panel.

You can also select an issue and action it via keyboard shortcuts in either views. Tip: use the 'j' and 'k' keys to select the previous/next issue in the issue navigator. |

---

**Sharing your search results**

Click **Share** in the issue navigator to email a link to a search result or shared filter.

- Recipients will receive an email with a link to the search result and the content of the **Note** field (if specified). The subject of the email will state that you (using your username) shared the issue.
- If you share the results of a filter, rather than an ad-hoc search, recipients will receive a link to the filter. Note, if the recipient does not have permission to view the filter, they will receive a link to the search results instead.

**Displaying your search results in Confluence**

If your Jira applications are connected to Confluence, you can display your search results on a Confluence page using the Jira issues macro. For instructions, see [Jira issues macro](#).

**Displaying your search results as a chart**

Click **Export > Dashboard charts**. Choose the desired chart from the dialog that is displayed, then click **Save to Dashboard**.

The chart will be added to your dashboard. For more information on what each chart shows, see [Reporting](#).

**Exporting your search results**

| CSV | Click **Export > CSV (All fields)** or **Export > CSV (Current fields)**, and choose a delimiter to separate the values.

The CSV file will contain a header row with every applicable issue field, comment, and attachment in your search result.

- **CSV (All fields)**: this will include every issue field, comment and attachment. The header row may contain multiple values of "Comment" and/or "Attachment" if your issues have multiple comments and/or attachments.
- **CSV (Current fields)**: this will include only issue fields that are currently displayed.

Note, large exports (e.g. many hundreds of issues) are not recommended. You can change the number of issues that are exported, by changing the value of the `tempMax` parameter in the URL.

If you're making a lot of exports, your Jira admin can disable the extra dialog that asks about delimiters. In this case, comma will be used as the default delimiter. [Learn more](#). |
The HTML file will contain a header row with a value for every applicable issue field in your search result.

- **HTML (All fields):** this will create an HTML file for every issue field (excluding comments). This will only show the custom fields that are available for all of the issues in the search results. For example, if a field is only available for one project and multiple projects are in the search results then that field will not appear in the HTML file. The same goes for fields that are only available for certain issue types.

- **HTML (Current fields):** this will create an HTML file for the issue fields that are currently displayed.

Note, large exports (e.g. many hundreds of issues) are not recommended. You can change the number of issues that are exported, by changing the value of the `tempMax` parameter in the URL.

**XML**

You can use the URL of the XML view in a Confluence Jira issues macro. However, you can also use the JQL or the URL of the issue search, which are easier to get.

To restrict which issue fields are returned in the XML export, specify the `field` parameter in your URL. For example, to include only the `Issue key` and `Summary`, add `&field=key&field=summary` to the URL. If the `field` parameter is not specified, the XML output will include all issue fields. Otherwise, if one or more `field` parameters are specified, the XML output will contain only the `Issue key` plus your chosen field(s). See the "List of fields for field parameter" below.

**Word**

The export will include the Description, Comments, and all other issue data, not just the issue fields that are currently configured in your Issue Navigator. Note, large exports (e.g. hundreds of issues) are not recommended.

### List of fields for field parameter (XML exports):

<table>
<thead>
<tr>
<th>Value</th>
<th>Sample XML output</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>title</td>
<td>&lt;title&gt;[TEST-4] This is a test&lt;/title&gt;</td>
<td></td>
</tr>
<tr>
<td>link</td>
<td>&lt;link&gt;<a href="https://extranet.atlassian.com:443/Jira/browse/TEST-4">https://extranet.atlassian.com:443/Jira/browse/TEST-4</a>&lt;/link&gt;</td>
<td>This is a 'permalink' to the issue. For links between issues, see <em>issuelinks</em> (below).</td>
</tr>
<tr>
<td>project (or pid)</td>
<td>&lt;project id=&quot;10330&quot; key=&quot;TST&quot;&gt;Test&lt;/project&gt;</td>
<td></td>
</tr>
<tr>
<td>description</td>
<td>&lt;description&gt;This is a detailed description of the issue.&lt;/description&gt;</td>
<td></td>
</tr>
<tr>
<td>environment</td>
<td>&lt;environment&gt;Sydney network&lt;/environment&gt;</td>
<td></td>
</tr>
<tr>
<td>key</td>
<td>&lt;key id=&quot;22574&quot;&gt;TEST-4&lt;/key&gt;</td>
<td></td>
</tr>
<tr>
<td>Field</td>
<td>Value</td>
<td></td>
</tr>
<tr>
<td>---------------------</td>
<td>--------------------------------------------</td>
<td></td>
</tr>
<tr>
<td>summary</td>
<td>&lt;summary&gt;This is a test&lt;/summary&gt;</td>
<td></td>
</tr>
<tr>
<td>type (or issue type)</td>
<td>&lt;type id=&quot;3&quot; iconUrl=&quot;https://extranet.atlassian.com:443/Jira/images/icons/task.gif&quot;&gt;Task&lt;/type&gt;</td>
<td></td>
</tr>
<tr>
<td>parent</td>
<td>&lt;parent id=&quot;22620&quot;&gt;TEST-5&lt;/parent&gt;</td>
<td></td>
</tr>
<tr>
<td>priority</td>
<td>&lt;priority id=&quot;4&quot; iconUrl=&quot;https://extranet.atlassian.com:443/Jira/images/icons/priority_minor.gif&quot;&gt;Minor&lt;/priority&gt;</td>
<td></td>
</tr>
<tr>
<td>status</td>
<td>&lt;status id=&quot;5&quot; iconUrl=&quot;https://extranet.atlassian.com:443/Jira/images/icons/status_resolved.gif&quot;&gt;Resolved&lt;/status&gt;</td>
<td></td>
</tr>
<tr>
<td>resolution</td>
<td>&lt;resolution id=&quot;1&quot;&gt;Fixed&lt;/resolution&gt;</td>
<td></td>
</tr>
<tr>
<td>labels</td>
<td>&lt;label&gt;focus&lt;/label&gt;</td>
<td></td>
</tr>
<tr>
<td>assignee</td>
<td>&lt;assignee username=&quot;jsmith&quot;&gt;John Smith&lt;/assignee&gt;</td>
<td></td>
</tr>
<tr>
<td>reporter</td>
<td>&lt;assignee username=&quot;jsmith&quot;&gt;John Smith&lt;/assignee&gt;</td>
<td></td>
</tr>
<tr>
<td>security</td>
<td>&lt;security id=&quot;10021&quot;&gt;Private&lt;/security&gt;</td>
<td></td>
</tr>
<tr>
<td>created</td>
<td>&lt;created&gt;Mon, 1 Sep 2008 17:30:03 -0500 (CDT)&lt;/created&gt;</td>
<td></td>
</tr>
<tr>
<td>updated</td>
<td>&lt;updated&gt;Mon, 1 Sep 2008 17:30:03 -0500 (CDT)&lt;/updated&gt;</td>
<td></td>
</tr>
<tr>
<td>resolved (or resolution date)</td>
<td>&lt;resolved&gt;Mon, 1 Sep 2008 17:30:03 -0500 (CDT)&lt;/resolved&gt;</td>
<td></td>
</tr>
</tbody>
</table>

Only relevant if the issue is a sub-task.

Only relevant if a security level has been applied to the issue.
<table>
<thead>
<tr>
<th>Field</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>due (or due date)</td>
<td>&lt;due&gt;Mon, 1 Sep 2008 17:30:03 -0500 (CDT) &lt;/due&gt;</td>
</tr>
<tr>
<td>version (or versions)</td>
<td>&lt;version&gt;2.4.7&lt;/version&gt;</td>
</tr>
<tr>
<td>fixFor (or fixVersions)</td>
<td>&lt;fixVersion&gt;2.6&lt;/fixVersion&gt;</td>
</tr>
<tr>
<td>component (or components)</td>
<td>&lt;component&gt;Documentation&lt;/component&gt;</td>
</tr>
<tr>
<td>votes</td>
<td>&lt;votes&gt;1&lt;/votes&gt;</td>
</tr>
<tr>
<td>comments (or comment)</td>
<td></td>
</tr>
<tr>
<td></td>
<td>&lt;comment id=&quot;39270&quot; author=&quot;jsmith&quot; created=&quot;Tue, 24 Feb 2009 16:45:02 -0600 (CST)&quot;&gt;this looks familiar&lt;/comment&gt;</td>
</tr>
<tr>
<td></td>
<td>&lt;comment id=&quot;39273&quot; author=&quot;jbrown&quot; created=&quot;Tue, 24 Feb 2009 16:48:16 -0600 (CST)&quot;&gt;to me too&lt;/comment&gt;</td>
</tr>
<tr>
<td>attachements (or attachement)</td>
<td>&lt;attachments&gt;</td>
</tr>
<tr>
<td></td>
<td>&lt;attachment id=&quot;30318&quot; name=&quot;Issue Navigator - Atlassian Jira-2.png&quot; size=&quot;16161&quot; author=&quot;yoz&quot; created=&quot;Mon, 9 Feb 2009 13:32:58 -0600 (CST)&quot;/&gt;</td>
</tr>
<tr>
<td></td>
<td>&lt;attachment id=&quot;30323&quot; name=&quot;Windows XP (with Firefox 3.0).jpg&quot; size=&quot;5802&quot; author=&quot;vbharara&quot; created=&quot;Tue, 10 Feb 2009 00:30:11 -0600 (CST)&quot;/&gt;</td>
</tr>
<tr>
<td>timeoriginalestimate</td>
<td>&lt;timeoriginalestimate seconds=&quot;600&quot;&gt;10 minutes&lt;/timeoriginalestimate&gt;</td>
</tr>
<tr>
<td>timeestimate</td>
<td>&lt;timeestimate seconds=&quot;300&quot;&gt;5 minutes&lt;/timeestimate&gt;</td>
</tr>
<tr>
<td>timespent</td>
<td>&lt;timespent seconds=&quot;300&quot;&gt;5 minutes&lt;/timespent&gt;</td>
</tr>
<tr>
<td>aggregatetimeestimate</td>
<td>&lt;aggregatetimeoriginalestimate seconds=&quot;36000&quot;&gt;10 hours&lt;/aggregatetimeoriginalestimate&gt;</td>
</tr>
</tbody>
</table>

*Only available if your administrator has enabled attachments.*

*Only available if your administrator has time tracking enabled.*
<table>
<thead>
<tr>
<th><strong>aggregatetimeestimate</strong></th>
<th><code>&lt;aggregatetimeestimate seconds=&quot;18000&quot;&gt;5 hours&lt;/aggregatetimeestimate&gt;</code></th>
<th>Aggregate time for the issue plus all of its sub-tasks. Only available if your administrator has time tracking enabled.</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>aggregatetimespent</strong></td>
<td><code>&lt;aggregatetimespent seconds=&quot;18000&quot;&gt;5 hours&lt;/aggregatetimespent&gt;</code></td>
<td>Aggregate time for the issue plus all of its sub-tasks. Only available if your administrator has time tracking enabled.</td>
</tr>
<tr>
<td><strong>timetracking</strong></td>
<td><code>&lt;timeoriginalestimate seconds=&quot;600&quot;&gt;10 minutes&lt;/timeoriginalestimate&gt;</code> <code>&lt;timeestimate seconds=&quot;300&quot;&gt;5 minutes&lt;/timeestimate&gt;</code> <code>&lt;timespent seconds=&quot;300&quot;&gt;5 minutes&lt;/timespent&gt;</code> <code>&lt;aggregatetimeoriginalestimate seconds=&quot;36000&quot;&gt;10 hours&lt;/aggregatetimeoriginalestimate&gt;</code> <code>&lt;aggregatetimespent seconds=&quot;18000&quot;&gt;5 hours&lt;/aggregatetimespent&gt;</code></td>
<td>This is a convenient shorthand way of specifying all of the above six time tracking fields. Only available if your administrator has time tracking enabled.</td>
</tr>
<tr>
<td><strong>issuelinks</strong></td>
<td><code>&lt;issuelinks&gt;</code> <code>&lt;issuelinktype id=&quot;10020&quot;&gt;</code> <code>&lt;name&gt;Duplicate&lt;/name&gt;</code> <code>&lt;inwardlinks description=&quot;is duplicated by&quot;&gt;</code> <code>&lt;issuelink&gt;</code> <code>&lt;issuekey id=&quot;22477&quot;&gt;INTSYS-1009&lt;/issuekey&gt;</code> <code>&lt;/issuelink&gt;</code> <code>&lt;/inwardlinks&gt;</code> <code>&lt;/issuelinktype&gt;</code> <code>&lt;/issuelinks&gt;</code></td>
<td></td>
</tr>
<tr>
<td><strong>subtasks (or subtask)</strong></td>
<td><code>&lt;subtasks&gt;</code> <code>&lt;subtask id=&quot;22623&quot;&gt;TEST-8&lt;/subtask&gt;</code> <code>&lt;/subtasks&gt;</code></td>
<td></td>
</tr>
</tbody>
</table>
| **customfield_xx xxx**    | `<customfields>` `<customfield id="customfield_10112" key="com.atlassian.Jira.plugin.system.customfieldtypes:select">` `<customfieldname>Department</customfieldname>` `<customfieldvalues>` `<customfieldvalue>Administration</customfieldvalue>` `</customfieldvalues>` `</customfield>` `</customfields>` | "xxxxx" is the id of a given custom field e.g. this output is the result of specifying &field=customfield_10112
Printable views

**Printable**

Click Export > Printable.

Creates a view of your search results in your browser that can be printed ‘Landscape’. This view only contains issue Type, Key, Summary, Assignee, Reporter, Priority, Status, Resolution, Created date, Updated date, and Due date.

**Full content**

Click Export > Full content.

Creates a view of your search results in your browser that can be printed. This view contains all issue fields, comments, and a list of attachments (there is no preview) for every issue returned by your search.

Subscribing to your search results

A subscription provides you with a periodic notification for all issues returned by the search. If you want to be notified when a particular issue changes, you should watch the issue instead.
Email

Your search must be saved as a filter, if you want to create an email subscription for it. You can create a subscription of any frequency for yourself and/or other users. Note, only the first 200 results of a filter are sent.

1. Run the filter that you want to subscribe to, then click Details (next to filter name).
2. Fill in the 'Filter Subscription form' and click Subscribe.

More information:

- If you choose 'Advanced' for your Schedule, see this page for help on constructing Cron expressions.
- You can choose to specify a group as a recipient, however you can only select a group that you are a member of:
  - You must have the 'Manage Group Filter Subscriptions' global permission.
  - Be aware that the emailed filter results will be specific to each recipient. For example, if the filter uses the currentUser() function, the search results will be evaluated with the recipient as the current user. This does not apply to distribution lists (group email aliases).
  - Be careful about sharing a subscription with a group with many members, as it can take a long time to generate the emails to be sent, since the search needs to be executed for each user (as per the previous point).

RSS

Click Export > RSS (Issues) or Export > RSS (Comments). The URL of the page that shows can be used in your feed reader.

Tips:

- You can change the number of issues that are returned, by changing the value of the tempMax parameter in the URL.
- If you only want to receive current comments in an RSS feed, use the Date Updated field when doing a search. For example, to only receive comments created in the last week, add the Date Updated field and set it to updated within the last 1 week.
- You may need to log into your Jira applications to view restricted data in your feed. If so, you can add os_authType=basic to the feed URL (e.g. http://mycompany.com/anypage?os_authType=basic) to show a login dialog when viewing the feed.

Bulk modifying issues in your search results

Bulk operations let you action multiple issues at once. These actions include transitioning issues, deleting issues, moving issues, and watching/unwatching issues.

Click Tools > Bulk Change: all <N> issue(s) and follow the 'Bulk Operation' wizard.

For more information, see Editing multiple issues at the same time.

Next steps

Read the following related topics:

- Searching for issues
- Constructing cron expressions for a filter subscription
Constructing cron expressions for a filter subscription

This page describes how to construct a cron expression. Cron expressions can be used when creating a subscription to a filter, as described in Working with search results.

A cron expression gives you more control over the frequency, compared to the default schedules. For example, you could define a cron expression to notify you at 8:15 am on the second Friday of every month.

Constructing a cron expression

A cron expression is a string of fields separated by spaces. The following table displays the fields of a cron expression, in the order that they must be specified (from left to right):

<table>
<thead>
<tr>
<th>Field</th>
<th>Allowed values</th>
<th>Allowed special characters</th>
</tr>
</thead>
<tbody>
<tr>
<td>Second</td>
<td>0–59</td>
<td>,-<em>/</em></td>
</tr>
<tr>
<td>Minute</td>
<td>0–59</td>
<td>,-<em>/</em></td>
</tr>
<tr>
<td>Hour</td>
<td>0–23</td>
<td>,-<em>/</em></td>
</tr>
<tr>
<td>Day-of-month</td>
<td>1–31</td>
<td>,-<em>/</em> L W C</td>
</tr>
<tr>
<td>Month</td>
<td>1–12 or JAN–DEC</td>
<td>,-<em>/</em> or ? L C #</td>
</tr>
<tr>
<td>Day-of-week</td>
<td>1–7 or SUN–SAT</td>
<td>,-<em>/</em></td>
</tr>
<tr>
<td>Year (optional)</td>
<td>1970–2099</td>
<td></td>
</tr>
</tbody>
</table>

Note, cron expressions are not case-sensitive.

Here is an example:

```
0 15 8 ? JAN MON 2014
```

This literally translates to 0 second, 15 minute, 8 hour, any day of the month, January, 2014.

In plain English, this represents 8:15am on every Monday during January of 2014. Note, the ? character means "no particular value". In this example, we've set the Day-of-month to no particular value. We don't need to specify it, as we've specified a Day-of-week value. Read more about special characters in the next section.

More examples of cron expressions are explained in the Examples section at the bottom of this page.

Special characters

<table>
<thead>
<tr>
<th>Special character</th>
<th>Usage</th>
</tr>
</thead>
<tbody>
<tr>
<td>,</td>
<td>Specifies a list of values. For example, in the Day-of-week field, 'MON,WED,FRI' means 'every Monday, Wednesday, and Friday'.</td>
</tr>
<tr>
<td>-</td>
<td>Specifies a range of values. For example, in the Day-of-week field, 'MON-FRI' means 'every Monday, Tuesday, Wednesday, Thursday and Friday'.</td>
</tr>
<tr>
<td>*</td>
<td>Specifies all possible values. For example, in the Hour field, '*' means 'every hour of the day'.</td>
</tr>
<tr>
<td>/</td>
<td>Specifies increments to the given value. For example, in the Minute field, '0/15' means 'every 15 minutes during the hour, starting at minute zero'.</td>
</tr>
<tr>
<td>?</td>
<td>Specifies no particular value. This is useful when you need to specify a value for one of the two fields Day-of-month or Day-of-week, but not the other.</td>
</tr>
<tr>
<td>L</td>
<td>Specifies the last possible value; this has different meanings depending on context. In the <strong>Day-of-week</strong> field, 'L' on its own means 'the last day of every week' (i.e. 'every Saturday'), or if used after another value, means 'the last xxx day of the month' (e.g. 'SATL' and '7L' both mean 'the last Saturday of the month'). In the <strong>Day-of-month</strong> field, 'L' on its own means 'the last day of the month', or 'LW' means 'the last weekday of the month'.</td>
</tr>
<tr>
<td>---</td>
<td>---</td>
</tr>
<tr>
<td>W</td>
<td>Specifies the weekday (Monday-Friday) nearest the given day of the month. For example, '1W' means 'the nearest weekday to the 1st of the month' (note that if the 1st is a Saturday, the email will be sent on the nearest weekday <strong>within the same month</strong>, i.e. on Monday 3rd). 'W' can only be used when the day-of-month is a single day, not a range or list of days.</td>
</tr>
<tr>
<td>#</td>
<td>Specifies the nth occurrence of a given day of the week. For example, 'TUES#2' (or '3#2') means 'the second Tuesday of the month'.</td>
</tr>
</tbody>
</table>

### Examples

| 0 15 8 ? * * | Every day at 8:15 pm. |
| 0 15 8 * * ? | Every day at 8:15 am. |
| 0 * 14 * * ? | Every minute starting at 2:00 pm and ending at 2:59 pm, every day. |
| 0 0/5 14 * * ? | Every 5 minutes starting at 2:00 pm and ending at 2:55 pm, every day. |
| 0 0/5 14,18 * * ? | Every 5 minutes starting at 2:00 pm and ending at 2:55 pm, AND every 5 minutes starting at 6:00 pm and ending at 6:55 pm, every day. |
| 0 0-5 14 * * ? | Every minute starting at 2:00 pm and ending at 2:05 pm, every day. |
| 0 0/10 * * * ? | Every 10 minutes, forever. |
| 0 10,44 14 ? 3 WED | 2:10 pm and 2:44 pm every Wednesday in the month of March. |
| 0 15 8 ? * MON- FRI | 8:15 am every Monday, Tuesday, Wednesday, Thursday, and Friday. |
| 0 15 8 15 * | 8:15 am on the 15th day of every month. |
| 0 15 8 L * | 8:15 am on the last day of every month. |
| 0 15 8 LW * | 8:15 am on the last weekday of every month. |
| 0 15 8 ? * 6L | 8:15 am on the last Friday of every month. |
| 0 15 8 ? * 6#2 | 8:15 am on the second Friday of every month. |
Managing your user profile

You can manage your Jira settings (e.g. your password, email address, or the format in which you would like to receive email notifications) in your user profile. Your user profile also displays recent work in the Activity Stream, and contains useful shortcuts to issues you have been working on or reported.

To manage your user profile:

Choose your user name at top right of the screen, then choose Profile.

Editing your user details

On this page:
- Editing your user details
- Changing your avatar
- Choosing your homepage
- Managing email notifications
- Managing your user preferences
- Managing service desk preferences
- Managing your OAuth and login tokens

If your instance is using an external user management system like Crowd, these options may not be available to you.

In the Details section on the Summary page, click the edit icon at the top-right of the section to edit your display name, email address, and password. If your Jira administrator has configured the user directory with external password management, the Change Password link will not be available.

Changing your avatar

Select or your current avatar to change the image that appears next to your name in Jira. If your administrator has enabled Gravatar for user avatars, your Gravatar (i.e. the Gravatar associated with the email address in your user profile) will automatically be set as your user avatar. If Gravatar has been enabled, you will not be able to choose Jira-specific user avatars and vice versa. If Gravatar has been disabled, you can choose your user avatar from the ones pre-packaged with Jira or upload your own.

- Your cropped image is resized to 48x48 pixels before it is saved as your new custom user avatar.
- A separate 16x16 pixel version of your custom user avatar will be generated for use in comments.
- Custom user avatars can only be selected by the user who uploaded them.

Choosing your homepage

Your Jira home page is the Jira page you are presented with immediately after you log in.

You can configure the following Jira pages as your Jira home page:

- The Dashboard
- The Issue Navigator
- Boards

1. Click on your profile icon at the top right of the screen.
2. Select the appropriate home page option within the **My Jira Home** section:
   - Dashboard
   - Issue Navigator
   - Boards (available if you're using Jira Software)

   Your page will be reloaded to the Jira home page you selected.

3. *(Optional)* To verify that your Jira home page has been reset, log out and log back in to Jira again. You should be taken directly to the Jira home page you selected in the previous step.

### Managing email notifications

In the **Preferences** section on the **Summary** page, click the edit icon at the top-right of the section to open the **Updated User Preferences** dialog box. You can then manage the following:

- Change the **Email Type** to change the format (plain text or HTML) in which Jira sends its outgoing email notifications.
- In **My Changes**, choose between making Jira send you email notifications about issue updates made by either both you and other people (Notify me) or other people only (i.e. Do not notify me).

### Managing your user preferences

The global defaults for most of the user preferences below can be set by your Jira administrator; however, you can override these default settings by changing the following:

- The **Page Size**, or number of issues displayed on each Issue Navigator page
- Your preferred **language** from the drop-down list. If you don't see your preferred language in the list, see Translating Jira for more information.
- Your **time zone** specified in your profile doesn't match the time zone of the computer you are working on, Jira will ask if you want to update this selected time zone setting. All time fields in Jira will now be displayed in your preferred time zone.
- Choose the **Sharing** setting for when you create new filters and dashboards, which can be either shared with all other users (Shared) or restricted (Unshared).
- Choose to enable or disable Jira's keyboard shortcuts feature.
- Choose between allowing Jira to make you an **autowatcher** of any issue that you create or comment on.
- Choose how you want your external links to open. They can open in the existing or a new tab.

### Managing service desk preferences

Service desk agents can enable or disable the **Pre-populated commenting** field by editing their user profiles. This setting can help save time by pre-filling conversation greeting text when agents comment on customer issues. When enabled, the text **Hi <Reporter_name>**, and **<Agent_name>** appears in the comment field and in the email notification sent to customers.

### Managing your OAuth and login tokens

An OAuth access token is issued by Jira to give gadgets access to restricted data on an external, OAuth-compliant web application or website (also known as a "consumer"). Check out Allowing OAuth access for recommendations on when to issue or revoke OAuth access tokens.

If you are accessing your Jira applications in a public environment, you can clear your login tokens by clicking the **Clear all Tokens** link in the Details section of your Profile.
Allowing OAuth access

About OAuth access tokens

OAuth access tokens allow you to:

- Use a Jira gadget on an external, OAuth-compliant web application or website (also known as a 'consumer')
- Grant the gadget access to the same Jiradata that you can access.

Before you begin

Your Jira administrator must link your Jira instance and the consumer using an application link and OAuth. For example, if you want to add a Jira gadget to your Bamboo homepage, then your Jira administrator must first approve Bamboo as an OAuth consumer.

Issuing OAuth access tokens

To allow a gadget to access the same Jira data that you can, Jira issues it an OAuth access token. The OAuth token is unique to the gadget.

1. When you use a Jira gadget on a consumer (such as Bamboo) and this gadget requires access to your Jiradata, you will be prompted to log in to Jira if you have not already done so.
2. After you log in to Jira, you will be prompted with a Request for Access message.
3. To issue the OAuth token and grant the gadget access to your Jiradata, click Allow. The gadget can access your Jira data until you revoke the token.
4. To view tokens you have issued, go to your Profile > Tools > View OAuth Access Tokens:

Revoking OAuth access tokens

You can revoke an OAuth access token to deny a Jira gadget access to your Jiradata. When you revoke access, the gadget can only access public data on your Jira instance.

1. To view tokens you have issued, go to your Profile > Tools > View OAuth Access Tokens
2. Next to the application whose OAuth access you wish to revoke, click Revoke Access.
3. You may be prompted to confirm this action. If so, click OK.
4. The gadget's access token is revoked and the Jira gadget can only access public Jiradata.
Requesting apps

The **Atlassian Marketplace** website offers hundreds of apps that administrators can install to enhance and extend your Jira applications. If the app request feature is enabled for your instance, you can submit requests for Marketplace apps directly to your administrator.

The 'Atlassian Marketplace for Jira' page presents an integrated view of the Marketplace website from within the Jira user interface. The page offers the same features as the Marketplace website, such as app search and category filtering, but tailors the browsing experience to Jira application users.

This in-product view of the Marketplace gives day-to-day users of the Atlassian applications, not just administrators, an easy way to discover the apps that can help them work. When you find an app of interest, you can submit a request with just a few clicks.

Submitting an app request

1. From anywhere in the application, open your profile menu and choose **Atlassian Marketplace**.
2. In the Atlassian Marketplace page, use the search box to find apps or use the category menus to browse or filter by apps by type, popularity, price or other criteria. You can see what your fellow users have requested by choosing the **Most Requested** filter.
3. When you find an app that interests you, click **Request** to generate a request for your administrator.
4. Optionally, type a personal message to your administrators in the text box. This message is visible to administrators in the details view for the app.
5. When ready, click **Submit Request**.
6. Click **Close** to dismiss the 'Success!' message dialog box.

At this point, a notification appears in the interface your administrators use to administer apps. Also your request message will appear in the app details view, visible from the administrator's 'Find New apps' page. From there, your administrator can purchase the app, try it out or dismiss requests.

Updating an app request

After submitting the request, you can update your message at any time. Click the **Update Request** button next to the listing in the 'Atlassian Marketplace' page to modify the message to your administrator.

The administrator is not notified of the update. However, your updated message will appear, as you have modified it in the details view for the app immediately.
Using keyboard shortcuts

Keyboard shortcuts are a great way for you to speed up editing, navigating, and for performing actions without having to take your fingers off the keyboard.

Some keyboard shortcuts require additional permissions or applications, and depend on how your Jira administrator(s) have configured permissions for your user account and which applications are installed.

View keyboard shortcuts

- Choose the question mark icon at top right of the screen, then choose Keyboard shortcuts.
- When viewing a page, press Shift + /.

The Keyboard Shortcuts dialog is displayed and shows commands for the operating system and browser that you are using. The dialog is divided into sections for the following information:

- **Global shortcuts** - shortcuts that can be used when you are in any part of Jira
- **Navigating issues** - shortcuts for navigating through issues
- **Issue actions** - shortcuts for working with issues
- **App specific** - any application-specific shortcuts. These shortcuts only work in the listed application.

If you have other Jira applications installed, you may have additional keyboard shortcuts available. For example, if you have Jira Software installed, you will see a series of additional keyboard shortcuts in the lower-right of this dialog box (and some additional Global keyboard shortcuts specific to Jira Software in the upper-left section). However, the keyboard shortcuts in the Agile Shortcuts section only function in Jira Software, and not in a Jira context.

Enabling and disabling keyboard shortcuts

Keyboard shortcuts are enabled by default. However, you can disable them on a per-user basis in the Keyboard Shortcuts dialog box.

1. Ensure you are logged in and open the Keyboard Shortcuts dialog box (see above).
2. At the bottom of the Keyboard Shortcuts dialog box, click Disable Keyboard Shortcuts or Enable Keyboard Shortcuts.

You can also disable or re-enable keyboard shortcuts by editing the Preferences section of your user profile. See Managing your user profile for more information.

Modifier keys

Some keyboard shortcuts require modifier keys to be pressed simultaneously, along with a single 'action' key. Modifier keys may differ, depending on your combination of operating system and web browser. The following table identifies the modifier keys for some supported web browsers and operating systems:

<table>
<thead>
<tr>
<th>Web Browser</th>
<th>Mac OS X</th>
<th>Windows</th>
<th>Linux / Solaris</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Firefox</td>
<td>Ctrl</td>
<td>Alt + Shift</td>
<td>Alt + Shift</td>
<td>In Firefox, it is possible to customize 'Modifier key shortcuts'. Please read Mozilla’s documentation for more information.</td>
</tr>
<tr>
<td>Internet Explorer</td>
<td>Alt</td>
<td></td>
<td></td>
<td>Typing a 'Modifier key shortcut' that leads to a link requires you to press the 'Enter' to complete the action.</td>
</tr>
<tr>
<td>Safari</td>
<td>Ctrl + Alt / Option</td>
<td>Ctrl</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Browser</td>
<td>Ctrl + Alt /Option</td>
<td>Alt + Shift</td>
<td>Alt + Shift</td>
<td></td>
</tr>
<tr>
<td>---------</td>
<td>--------------------</td>
<td>-------------</td>
<td>-------------</td>
<td></td>
</tr>
<tr>
<td>Chrome</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
Adding announcements

Do you need to communicate a system outage, post a message about operating hours, or perhaps offer a prompt at login? Announcements are a convenient way to give your customers important information.

Here are all the places within Jira Service Management that you can add an announcement:

Help center announcements

The help center is a collection of all your service projects (customer portals). Customers who go to the help center can see all the service projects they have permission to send requests to. To add an announcement here:

1. Go to Jira administration > Applications > Jira Service Management > Configuration.
2. Below Help center, select the link View and customize.
3. On the right-hand side, in the customize panel, edit the following fields:
   - Announcement subject (for example, Hours of operation)
   - Announcement message (for example, Mon-Fri: 09:00 to 17:00)
4. Choose Save changes to publish your announcement.

You can give your agents permission to add announcements to the help centre.

1. Go to Jira administration > Applications > Jira Service Management > Configuration.
2. Under the help center setting Can agents add announcements to the help center? choose Yes.
Login screen announcements

These announcements are displayed to customers who haven’t logged in. The announcement might be a useful login prompt, or contact information in cases of difficulty. To add an announcement to the login screen:

1. Go to Jira administration > Applications > Jira Service Management > Configuration.
2. Below Help center, select the link View and customize.
3. On the right hand side, in the customize panel, under Add login announcement, edit the following fields:
   - Announcement subject (for example, How to login)
   - Announcement message (for example, Use your employee login as follows...)
4. Choose Save changes to publish your announcement.

Customer portal announcements

Every service project comes with an online portal that your customers use to interact with your service team. To add an announcement to a specific customer portal:

1. Navigate to the service project you want to update.
2. Choose Project settings > Portal settings.
3. Click the link View and change under the Announcement heading.
4. On the right hand side, in the customize panel, under Add help center announcement, edit the following fields:
   - Announcement subject (for example, Holiday hours)
   - Announcement message (for example, The IT team will be out of the office from 20th December to 5th January)
5. Choose Save changes to publish your announcement.
You can give your agents permission to add announcements to the customer portal.

1. Go to **Project settings > Portal settings**.
2. Under the announcement setting **Can agents add announcements to this portal?** choose **Yes**.
Adding request participants

Request participants are customers and organizations who can view, comment, and receive notifications about a request. Participants receive the same notifications as the reporter and can turn off notifications at any time. You might add request participants so they can provide more information about a request, or to notify them of a request’s progress.

Both agents and customers can add and remove request participants. Who customers can add as participants depends on the project’s customer permissions settings. Read Managing access to your service project to learn more.

Add participants to a project

To add participants to a project:

1. From the sidebar, select Project settings > Users and roles, then select Add users to a role.
2. Enter the participant’s email address, choose their role type, then select Add.

Request participants follow issue-level security schemes. For example, if an administrator customizes requests so that only reporters can view them, then request participants won’t be able to view the request. Administrators can refer to the instructions in Configuring issue-level security to update the issue security scheme.

Add participants to an issue

Requests participants can only be added if they have access to the project. Change your customer permissions to set who can access your service desk project.

To add a participant to a request:

1. Open the issue you want to add a request participant to.
2. Select the Request participants or Organizations field on the right side of the issue view.
3. Enter the participant’s details, then click the tick.

When you add a request participant they receive an email notifying them that they are participating in the request, depending on the project’s notification settings.

The following image shows the request participants in the issue view:
Add participants in the customer portal

Customers in an organization can share requests when they raise them. If a customer belongs to only one organization, the request is shared with it by default unless you have changed the default settings to keep all new requests private. If the customer is in more than one organization, the request is private by default.

You can choose whether new requests are private or shared by default. To do so, go to Administration > Applications > Jira Service Management configuration, and look at Organization management.

If you want to share a request with only some participants, you can add them to your request.

How an agent adds a participant to a request:

1. From the sidebar, select Raise a request.
2. Fill out the request form, select Create.
3. Select Share from the right side panel, enter the name, email address, or organization in the Share this request field.
4. Select Share.

How a customer adds a participant to a request:

1. Access the customer portal from the link provided.
2. Fill out the request form, select Create.
3. Select Share from the right side panel, enter the name, email address, or organization in the Share this request field.
4. Select Share.

Participants will receive an email notifying them that they are participating in the request depending on the project's notification settings. The participants will appear under the Shared with section in the request.

The following image shows the request participants in the customer portal request view:
Add participants by mentioning them via the customer portal

You can also add participants by mentioning them in the description or comments. They will be immediately added as a participants and will receive a notification about it (if the Participant added notification is enabled).

- Agents: You can mention anyone in the project.
- Customers: You can only mention customers from your organization. In some projects where customers are allowed to share requests with any customer or organization, you'll be able to mention anyone in the project.

Actions via customer portal won't result in any Jira mention notification emails.

Add participants through email

Customers in an organization can share requests when they raise them. If a customer belongs to only one organization, the request is shared with it by default unless you have changed the default settings to keep all new requests private. If the customer is in more than one organization the request is private by default.

You can choose whether new requests are private or shared by default. To do so, go to Administration > Applications > Jira Service Management configuration, and look at Organization management.

If you want to share a request with only some participants, you can add them to your request.

To add participants through email:

1. Add the participant's email address to either the TO or CC fields.

The participant will receive an email notification that you added them depending on the project's notification settings.

Add watchers

Agents can involve other agents or Jira users to get help with an issue. For example, you might want Jira Software developers to help analyze a bug that a customer has reported.

To involve other users, add them as watchers:

1. Open the issue you want to add a watcher to.
2. Select the Watchers field to the right side, under People.
3. Select the number count, then enter the name or email address in the Add watchers field.
Watchers are notified about internal activity on an issue, and can communicate with you via internal comments.
Using service project queues

Customer requests become issues that you can view and work on in queues. Jira Service Management comes with default queues that your administrator can update to automatically triage issues for your team. As an agent, you can see how many issues are in each queue, and switch between queues to work on the right issues at the right time.

You can easily navigate to your service project queues at any time by selecting **Queues** from your project sidebar.

Switching queues

When you select **Queues** from your project sidebar for the first time, the secondary sidebar menu will open automatically. This sidebar displays all queues in your service project, as well as the number of issues in each queue. Simply select the name of the queue you wish to work from to view its issues.

To expand the view of a single queue, you can minimize your project sidebar by selecting **Collapse sidebar** (←) and minimize your queue sidebar by selecting in the sidebar's upper right corner. When the queue sidebar is collapsed, a Switch queue dropdown will appear, which you can use to view a different queue or to reopen the queue sidebar:
Sorting issues

To make it easier to find the most important issues, you can sort issues in your queues based on any of the available columns. Click a column to choose it as the primary sorting option, and then click again to refine the sorting. For example, you can change the sorting from oldest to newest, or switch the alphabetical order.

Some things to keep in mind:

- Sorting is a personal setting. Whatever you choose, it won't affect your teammates.
- Your settings are saved in the local storage, so they won't be available if you access your queues from a different device.
- To reset sorting, select More (""") > Reset sorting.

Managing multiple issues at once

You can update multiple issues at once instead of opening and editing them one by one.
After selecting multiple issues, you'll be able to choose one of these actions:

- **Assign** issues to a different user
- **Watch / Stop watching** selected issues. This requires that watching is enabled in your Jira instance.
- **Delete** selected issues
- **Add an internal or external comment** to your issues. Adding a comment to 50 issues at once might take some time, so watch out for this.
- **Link** selected issues to other issues

**Good to know**

- You can select a maximum of 50 issues at once because that's what fits on a single page. When you switch to another page, your selections will be cleared.
- Keyboard shortcuts: You can use *up* and *down* arrows to move between issues, and the *space bar* to select them.
Raising requests on behalf of customers

Let's say you're helping a customer resolve an issue over the phone, and you need to follow up with additional information. You can use the customer portal to quickly enter your customer's name, fill in the issue details, and submit the service project request.

If you don't need to create a request but simply want to invite customers to your service project so they know how to get help, you can skip ahead to Invite a new customer.

 Raise a customer request

1. From your service project sidebar, select Raise a request.
2. Select the request type that matches your customer's need.
3. In the Raise this request on behalf of field, enter a new customer's email address, or search for an existing customer:

   ![Raise a request](image)

   Help Center / Charlie Travel Franchises

   Get IT help

   Raise this request on behalf of

   ![Alana Grant]

4. Fill in the request details. If the customer is in an organization, you can choose to share the request with that organization.
5. Select Create. Your customer is emailed a link to the new request. New customers also receive an invitation to finish creating a service desk account.

Invite a new customer

1. From your service project sidebar, select Customers.
2. Select Add customers and enter your customer's email address.
3. If they belong to an organization, select it from the Add to organization dropdown.
4. Select Add, and you're done!
Adding customers

As an agent, you can add customers to your service project. If your administrator grants you permission, you can also manage organizations in the project.

- **Customers** raise requests in your service desk.
- **Organizations** are groups of customers that are shared across projects.

Add customers

Add customers to a project via Customers > Add customers. Customers on this list can raise requests in the project, via the portal or email.

Customers are automatically added to the list if your service project is open to users with Jira accounts, or allows customers to create their own accounts.

Add organizations

Add a new or existing organization to a project via Customers > Add organizations. Organizations that you add display on the Customers list, and their members can raise requests in the project via the portal or email.

Add customers to an organization

1. Go to the Customers.
2. Select the organization in the list.
3. Click Add customers. The customers you add can raise requests in all projects that use the organization.

Because the organization can be used in multiple projects, the customers are not added to the Customers role for the project.

Remove customers from an organization

1. Select an organization in the Customers list.
2. Find the customer you want to remove, and then click X next to their name.

Customers you remove lose access to projects that use the organization, unless they have access through another organization, or have the Customers role for the projects.

Remove organizations from a project

1. Select an organization in the Customers list.
2. Select Remove from project.

When you remove an organization from a project, its members lose access to the project unless they have the Customers role for the project.
Organizing work with versions

Versions are points-in-time for a project. They help you organize your work by giving you milestones to aim for. You can then assign the issues in your project to a specific version, and build up the work you need to do to complete that version.

You need to have the project-specific Administer Projects project permission or the Jira Administrator global permission to be able to:

- Add create a new version against which issues can be aligned.
- Release mark a version as released.
- Archive hide an old version from the Releases report, and in the user interface.
- Delete remove a version. You must choose an action for any issues with that version.
- Merge combine multiple versions into one.
- Reschedule re-arrange the order of versions.

Once a version has been created for a project, the 'Affects version' and 'Fix version' fields will become available for your issues. If you cannot see these fields on your issue, your project may not have any version yet, or the fields are hidden from view.

Managing a project's versions

The easiest way to manage a project's versions is through the Versions page.

1. Choose Administration > Projects, and click the name of the project.
2. Choose Versions in the sidebar. The Versions page is displayed, showing a list of versions.

Add a new version

1. The Add Version form is located at the top of the 'Versions' page.
2. Enter the name for the version. The name can be:
   - simple numeric, e.g. "2.1", or
- complicated numeric, e.g. "2.1.3", or
- a word, such as the project's internal code-name, e.g. "Memphis".

3. Optional details such as the version description (text not HTML), start date and release date (i.e. the planned release date for a version) can be also be specified. These can be changed later if required.

4. Click the Add button. You can drag the new version to a different position by hovering over the 'drag' icon at the left of the version name.

Release a version

1. On the 'Versions' page, hover over the relevant version to display the cog icon, then select Release from the drop-down menu.
2. If there are any issues set with this version as their 'Fix For' version, Jira allows you to choose to change the 'Fix For' version if you wish. Otherwise, the operation will complete without modifying these issues.

To revert the release of a version, simply select Unrelease from the drop-down menu.

Archive a version

1. On the 'Versions' page, hover over the relevant version to display the cog icon, then select Archive from the drop-down menu.
2. The version list indicates the version 'archived' status with a semi-transparent icon. No further changes can be made to this version unless it is un-archived. Also it is not possible to remove any existing archived versions from an issue's affected and fix version fields or add any new archived versions.

To revert the archive of a version, simply select Unarchive from the drop-down menu.

Delete a version

1. On the 'Versions' page, hover over the relevant version to display the cog icon, then select Delete from the drop-down menu.
2. This will bring you to the 'Delete Version: <Version>' confirmation page. From here, you can specify the actions to be taken for issues associated with the version to be deleted. You can either associate these issues with another version, or simply remove references to the version to be deleted.

Merge multiple versions

Merging multiple versions allows you to move the issues from one or more versions to another version.

1. On the 'Versions' page, click the Merge link at the top right of the page.
2. The 'Merge Versions' popup will be displayed. On this page are two select lists both listing all un-archived versions. In the 'Merging From Versions' select list, choose the version(s) whose issues you wish to move. Versions selected on this list will be removed from the system. All issues associated with these versions will be updated to reflect the new version selected in the 'Merge To Version' select list. It is only possible to select one version to merge to.
3. Click the Merge button. If you are shown a confirmation page, click Merge again to complete the operation.

Reschedule a version

Rescheduling a version changes its place in the order of versions.

- On the 'Versions' page, click the icon for the relevant version, and drag it to its new position in the version order.
Workflows

All Jira projects contain issues that your team can view, work on, and transition through stages of work from creation to completion. The path that your issues take is called a workflow. Each Jira workflow is composed of a set of statuses (the state your work can be in) and transitions (how your work moves between statuses) that your issue moves through during its lifecycle, and typically represents work processes within your organization.

In addition, Jira uses workflow schemesto define the relationship between issue types and workflows. Workflow schemes are associated with a project, and make it possible to use a different workflow for different combinations of project and issue types.

Jira administrators and project administrators have different permissions when it comes to workflows.

Project administrators

As a project administrator, you can only edit a workflow that belongs to your project if:

- you have the Extended project administration permission, which is enabled by default (you can check that in Project settings > Permissions),
- the workflow isn't shared with any other projects (it's only available in your project),
- the workflow isn't the default Jira workflow (no-one can edit these workflows).

If the workflow is shared with another project, you'll see that information when you view the workflow. You'll also see how many issue types share the workflow, and would be affected by any changes you may make. You can make the following changes to the workflow:

- Add a status (the statuses must already exist in the Jira instance, you can't create, edit or remove statuses),
- Delete a status (the statuses must not be used by any of the project's issues),
- Create, add, edit or delete transitions (you can't select or update a screen used by the transition, or edit or view a transition's properties, conditions, validators or post-functions).

To view a workflow

1. Select Projects and choose the project whose workflow/s you want to view.
2. Select Project settings in the sidebar.
3. Select Workflows to see the list of workflows and issue types they're associated with.
   - Click a workflow to display it as diagram. If you're able to edit the workflow, you'll see an Edit button. If the workflow is shared with another project or issue type/s, that information will be available, and you can view it by clicking the relevant link.
   - Additionally, you can view a workflow in a simple, text form by clicking View as text next to the workflow's name.

To edit a workflow

1. When viewing a workflow, select Edit.
2. You can add a status or transition by clicking the relevant button. You can edit existing transitions by selecting them.
3. Publish your workflow to make it active.

If you don't publish the workflow, it'll remain as a draft until such time as you publish it, or discard it.

If you have a draft workflow present on your project, and you want to see the original workflow that's currently active, select Project settings > Workflows, and click a workflow.

Jira administrators

As a Jira administrator, you can complete the actions listed in the table below. The actions you have available are more extensive, and the documentation links will direct you to the Administrator documentation set.

<table>
<thead>
<tr>
<th>What you can do...</th>
<th>Documentation</th>
</tr>
</thead>
</table>

350
<table>
<thead>
<tr>
<th>Working with workflows</th>
<th>Configuring workflow schemes</th>
<th>Managing your workflows</th>
<th>Advanced workflow configuration</th>
</tr>
</thead>
<tbody>
<tr>
<td>• Edit existing workflows</td>
<td>• Add a workflow scheme</td>
<td>• Import and export workflows</td>
<td>• Add custom events</td>
</tr>
<tr>
<td>• Create new workflows</td>
<td>• Configure a workflow scheme</td>
<td>• Activate and deactivate workflows</td>
<td>• Configure the initial status</td>
</tr>
<tr>
<td>• Configure existing workflows</td>
<td>• Manage workflow schemes</td>
<td></td>
<td>• Work in text mode</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>• Configure workflow triggers</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>• Use validators and custom fields</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>• Use XML to create a workflow</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>• Workflow properties</td>
</tr>
</tbody>
</table>
Using Jira on a mobile device

When you view a Jira page on a mobile device, such as an iPhone or an Android phone, Jira will display an optimized version of the page. Jira chooses the mobile or desktop interface based on your device.

The Jira mobile interface is designed for viewing and interacting with issues on the go. If you need full access to Jira, you can always switch to the Jira desktop interface via the mobile menu (shown in the screenshots below).

What does Jira look like on a mobile device?

![Jira mobile interface screenshots]

What can you do in Jira on a mobile device?

The Jira mobile interface has been designed to give users quick access to their issues on the go. This includes:

- Viewing issues, comments, attachments, issue links and your favorite filters.
- Performing basic operations like adding comments, watching or voting on issues and assigning issues to users.

If you need to create or modify issues on the go, you can still do so by switching to the desktop interface via the mobile menu (shown in the screenshots above).
Configuring dashboards

Your dashboard is the main display you see when you log in to your project. You can create multiple dashboards for different projects, or multiple dashboards for one big project. Each project has a default dashboard, or you can create a personal dashboard and add gadgets to keep track of assignments and issues you’re working on. Dashboards are designed to display gadgets that help you organize your projects, assignments, and achievements in different charts.

You can see all dashboards by selecting the **Dashboards** drop-down from your Jira application header.

About the default dashboard

The gadgets on the default dashboard can be reordered and switched between the left and right columns. Additional gadgets can also be added, while some gadgets can be configured. The layout of the dashboard (e.g. number of columns) can also be configured.

All changes made to the default dashboard will also change the dashboards of all users currently using the default dashboard. However, gadgets that users do not have permissions to see will not be displayed to them. For example, the 'Administration' gadget, although it may exist in the default dashboard configuration, will not be visible to non-admin users.

Creating a dashboard

You can easily create and customize your own dashboard to display the information you need. Note that only administrators can customize the default dashboard for your project.

1. At the top right of the Dashboard, select **More** (...).
2. Select either **Create Dashboard** to create a blank dashboard, or **Copy Dashboard** to create a copy of the dashboard you are currently viewing.
3. Name and describe your dashboard.
4. Fill out the rest of the fields as applicable.
5. Click **Add**.

By default, sharing is set to private if you have not specified a personal preference. You can adjust this setting in the sharing preferences in your **user profile**, and change dashboard permissions at any time in the **Manage Dashboards** page.

Choosing a dashboard layout

To choose a different layout for your dashboard page (for example, three columns instead of two):
1. At the top right of the Dashboard, click **Edit layout**. A selection of layouts will be displayed:

   ![Edit layout](image)

   Choose your preferred layout.

2. **Managing gadgets**

   To get the most out of your dashboard, including adding, rearranging, removing, and configuring gadgets, see **Adding and customizing gadgets**.

   **Managing dashboards and permissions**

   You can edit, delete, copy, mark favorites, and share your dashboards from the Manage Dashboards page.

   1. Select **Dashboards > Manage Dashboards**.
   2. Choose the dashboard.

   **Sharing and editing your dashboard**

   You can edit the details for your dashboard, and restrict or share with other users according to the permissions that are set. In addition, you can see all the dashboards you’ve created, any public dashboards, and any shared dashboards.

   1. Click **Actions > Edit**. (If you're viewing the dashboard, go to **More > Edit/Share Dashboard**).
   2. Edit the settings.

3. **Adding favorite dashboards**

   If you find a dashboard you like, click the star icon next to its name to add it to your favorite dashboards list. You can also add the default dashboard to your favorites list so it’s easily available to you.

   ![Manage Dashboards](image)

   **Note on dashboard permissions**

   Jira administrators, as set inglobal permissions, can manage their users’ shared dashboards in the **Shared dashboards** menu. Administrators can also change the ownership of a dashboard if the creator is unable to maintain the dashboard or its gadgets. See **Managing shared dashboards** for more information.

   **Setting up a Wallboard**
Turn any Jira application dashboard into a wallboard by plugging your computer into a TV monitor. The Wallboard is a dashboard gadget that acts as an information radiator to provide instant visual insight into project progress and team accomplishments. With your favorite dashboard selected, select More (…) > View as Wallboard. The dashboard will appear against a black background, and will rotate gadgets if the user enables the slideshow option.

The Wallboard below shows the same Created vs. Resolved Issues gadgets and data above.
Adding and customizing gadgets

Adding a gadget to a dashboard

You can add gadgets to your own personal dashboard(s). To add a gadget to the default dashboard for your Jira application, you must be a Jira admin.

Some applications allow dashboards that are shared by groups of people. If you have permission to update a shared dashboard, the other people sharing the dashboard will see your changes, too.

1. Go to the dashboard by selecting the **Dashboards** link in the header.
2. If you don't already have a dashboard, select **Manage Dashboards** from the dropdown, then **Create new dashboard**.
3. Once your dashboard is created, on the dashboard, select **Add Gadget**.
4. Use the gadget wizard to choose the gadgets you want to add. You can see a list of these gadgets in **Gadgets for Jira applications**.

For more information about managing dashboards, see **Configuring dashboards**.

Customizing how gadgets look

There are a few ways you can customize the view of gadgets in a dashboard:

<table>
<thead>
<tr>
<th>To</th>
<th>Do this</th>
</tr>
</thead>
<tbody>
<tr>
<td>Expand or collapse gadgets</td>
<td>Use the <strong>More (⋯)</strong> button in the gadget header.</td>
</tr>
<tr>
<td>Expand a gadget to take up the entire dashboard</td>
<td>Use the <strong>Maximize (확장)</strong> button in the gadget header. This view often provides more functionality than is available in the standard view of the gadget. Only some gadgets provide the maximized or canvas view. The canvas view setting is stored in a cookie, and is not saved to the dashboard server.</td>
</tr>
<tr>
<td>Rearrange gadgets</td>
<td>Use the <strong>Arrange (중복)</strong> button in the gadget header.</td>
</tr>
<tr>
<td>Customize the gadget frames</td>
<td>Use the <strong>More (⋯)</strong> button in the gadget header.</td>
</tr>
<tr>
<td>Delete a gadget</td>
<td></td>
</tr>
</tbody>
</table>

Custom gadgets

You need administrator privileges to add a gadget to the list of available gadgets. If you have permission to add and remove gadgets from the directory itself, you will see the 'Add Gadget to Directory' and 'Remove' buttons on the 'Add Gadget' screen. This functionality is only available for the Server version of applications; if you would like to add an Atlassian gadget to a directory in your Cloud site, please contact Atlassian Support.
Gadgets for Jira applications

Gadgets let you customize the information you display on dashboards or wallboards in Jira applications. This information may include the number of open and resolved issues, labels used in selected projects, version reports, and many more.

Both Jira admins and users can manage gadgets on dashboards. The Jira admin can make changes to the system dashboard, while users can only create and customize their personal dashboards. What the user can see in gadgets on the dashboard depends on global and project permissions.

On this page, you’ll find all the gadgets that you can install on dashboards in Jira Core (JC), Jira Software (JSW), and Jira Service Management (JSM), including additional Bamboo, Crucible, and FishEye gadgets.

<table>
<thead>
<tr>
<th>Gadget</th>
<th>JC</th>
<th>JSW</th>
<th>JSM</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Jira Core gadgets</strong></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Assigne d to Me</strong></td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>Shows all unresolved issues assigned to you.</td>
</tr>
<tr>
<td><strong>Bubble Chart</strong></td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>Tracks the correlation of issues in a project or filter during a configured period based on:</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>• the number of days issues have been open</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>• the number of comments in issues</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>• the number of participants or votes in issues</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>The horizontal axis represents the number of days when issues remained open.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>The vertical axis represents the number of comments in issues.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>The bubble colors also indicate the correlation between the days when issues remained open and the number of comments. The green indicates low values and the red color indicates high values.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Only the first 200 open issues are displayed on the bubble chart.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>You can configure the following settings for the chart:</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>• the <strong>period</strong> during which issue comments are considered recent</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>• the basis of the <strong>bubble size</strong> (participants or votes)</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>• <strong>automatic refresh</strong> of the bubble chart data every 15 minutes</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>• <strong>relative coloring</strong> to distinguish issues with more comments from issues with fewer comments</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>• <strong>logarithmic scale</strong> (the linear scale is the default) to distribute the bubbles from each other. We recommend that you use the logarithmic scale if the bubble chart contains a large range of data.</td>
</tr>
<tr>
<td><strong>Created vs. Resolved Chart</strong></td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>Shows the work progress by showing the number of created and resolved issues for a set period.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>The chart is based on your choice of project or issue filter. The chart can be either cumulative or show the issue count.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>An issue is marked as resolved in the time period if its resolution date fits into this period.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>The resolution date is the last date when the <strong>Resolution</strong> field was set to any non-empty value.</td>
</tr>
<tr>
<td><strong>Favorite Filters</strong></td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>Shows a list of all issue filters that you’ve added as favorite filters.</td>
</tr>
<tr>
<td>Filter Results</td>
<td>✅</td>
<td>✅</td>
<td>✅</td>
<td>Shows the results of a selected issue filter on the dashboard.</td>
</tr>
<tr>
<td>----------------</td>
<td>----</td>
<td>----</td>
<td>----</td>
<td>-------------------------------------------------------------</td>
</tr>
<tr>
<td>Introduction</td>
<td>✅</td>
<td>✅</td>
<td>✅</td>
<td>Lets you configure a message on the dashboard to say hello to users. The text or HTML displayed in the gadget should be configured by the Jira admin. To do this: 1. Go to Administration &gt; System. 2. In the left panel, go to General configuration. 3. Select Edit settings. 4. In the Introduction field, type the text that will be displayed as the introduction message on the dashboard. 5. At the bottom of the page, select Update to save the changes.</td>
</tr>
<tr>
<td>Issue Statistics</td>
<td>✅</td>
<td>✅</td>
<td>✅</td>
<td>Shows issue statistics returned from a selected project or saved filter (grouped by a selected field).</td>
</tr>
<tr>
<td>Issues In Progress</td>
<td>✅</td>
<td>✅</td>
<td>✅</td>
<td>Shows all issues that are currently in progress and assigned to you.</td>
</tr>
<tr>
<td>Labels Gadget</td>
<td>✅</td>
<td>✅</td>
<td>✅</td>
<td>Shows a list of all labels used in a selected project.</td>
</tr>
<tr>
<td>Pie Chart</td>
<td>✅</td>
<td>✅</td>
<td>✅</td>
<td>Shows aggregated data on issues based on a selected filter.</td>
</tr>
<tr>
<td>Quick Links</td>
<td>✅</td>
<td>✅</td>
<td>✅</td>
<td>Adds links to frequently used searches and operations.</td>
</tr>
<tr>
<td>Two Dimensional Filter Statistics</td>
<td>✅</td>
<td>✅</td>
<td>✅</td>
<td>Shows data based on a selected issue filter. For example, you can create a filter to retrieve all open issues in a particular project. Then, you can configure the gadget to display the statistical data on this collection of issues in a table with configurable axes.</td>
</tr>
<tr>
<td>Voted Issues</td>
<td>✅</td>
<td>✅</td>
<td>✅</td>
<td>Shows all issues you've voted for.</td>
</tr>
<tr>
<td>Watched Issues</td>
<td>✅</td>
<td>✅</td>
<td>✅</td>
<td>Shows all issues you're watching.</td>
</tr>
</tbody>
</table>

**Atlassian gadgets**

<table>
<thead>
<tr>
<th>Activity Stream</th>
<th>✅</th>
<th>✅</th>
<th>✅</th>
<th>Shows activity on your instance. (Think of it as of a news feed.)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Average Age Chart</td>
<td>✅</td>
<td>✅</td>
<td>✅</td>
<td>Shows the average age of unresolved issues. This chart is based on your choice of project or issue filter and units of time (hours, days, weeks, months, quarters, or years). For the purposes of this gadget, an issue is defined as unresolved if it has no value in the Resolution field. The age of the issue is the difference between the current date and the date when the issue was created.</td>
</tr>
<tr>
<td>Heat Map</td>
<td>✅</td>
<td>✅</td>
<td>✅</td>
<td>Shows the relative weighting of a selected fields values in issues of a selected project or filter. For example, this gadget can be configured to show a heat map of issue priority in a particular project.</td>
</tr>
<tr>
<td><strong>Jira Road Map</strong></td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>Shows which versions are due for release in a set period, as well as a summary of the progress made towards completing the issues in the versions.</td>
</tr>
<tr>
<td><strong>Projects</strong></td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>Shows information on various issue filters from a selected project.</td>
</tr>
<tr>
<td><strong>Recently Created Chart</strong></td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>Show a rate at which issues are being created as well as how many of these issues are resolved.</td>
</tr>
</tbody>
</table>
| **Resolution Time** | ✔ | ✔ | ✔ | Shows trends in the average time taken to resolve issues. The report is based on your choice of project or issue filter and units of time (hours, days, weeks, months, quarters, or years).
   - The resolution time is the difference between the dates when an issue was created and resolved.
   - If the resolution date isn’t set, the gadget won’t consider this issue.
   - The resolution date is the last date when the Resolution field was set to any non-empty value. |
| **Time Since Chart** | ✔ | ✔ | ✔ | Show the number of issues for which a selected field was set on a selected date (for example, Created, Updated, Due, Resolved, or a custom field).
   - The Resolved field here is the system Resolution Date field. This is the last date when the Resolution field was set to any non-empty value.
   - The report is based on your choice of project or issue filter and units of time (hours, days, weeks, months, quarters, or years). |
| **Wallboard Spacer Gadget** | ✔ | ✔ | ✔ | Lets you modify the layout of your wallboards by adding custom space between gadgets.
   - You should set the height of a spacer in pixels and place the gadget in the preferred position on the dashboard.
   - You can modify the gadgets color as it matches the black background color in the wallboard view. |

### Jira Software gadgets

| **Agile Wallboard Gadget** | ✔ | Helps you see how you’re tracking with an agile board on your wallboard or dashboard. |
| **Days Remaining in Sprint Gadget** | ✔ | Shows how many working days you have before the current sprint ends. |
| **Sprint Burndown Gadget** | ✔ | Shows the burndown for a sprint in a line chart.
   - The vertical axis represents the estimation statistic.
   - The gadget will only display uncompleted sprints. |
<table>
<thead>
<tr>
<th><strong>Sprint Health Gadget</strong></th>
<th>◀</th>
<th>Shows a summary of issues in a sprint in a color-coded bar graph. The colors in this gadget match the colors in the column configuration. The completed work is calculated based on the estimation statistic for a board and is represented with the green part of the progress bar. For example, if you have 50 story points in a sprint and you have 3 resolved issues with 10 story points, the Work complete will be 20% (10 out of 50 story points). The gadget doesn't show the progress of work logged in the Remaining Estimate and Time Spent fields in Jira. Adding or removing an issue from a started sprint is considered a change of scope. The percentage is calculated by using the statistic configured for the board. For example, if you started a sprint with 50 story points and add an issue with 5 story points, the Sprint Health gadget will show a 10% scope change. If you add or remove issues without estimates, the scope change won't be altered. If you're using Jira's time tracking, the scope change won't show. The Blocker field counts all blockers with the statuses To Do or In Progress. For more information, see Configuring estimation and tracking</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Version Report</strong></td>
<td>◀</td>
<td>Tracks a projected release date for a version. This helps you monitor whether the version will release on time so you can take action if the work is falling behind.</td>
</tr>
<tr>
<td><strong>Jira charting gadgets</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Average Number of Times in Status</strong></td>
<td>◐</td>
<td>◐</td>
</tr>
<tr>
<td><strong>Average Time in Status</strong></td>
<td>◐</td>
<td>◐</td>
</tr>
<tr>
<td><strong>Time to First Response</strong></td>
<td>◐</td>
<td>◐</td>
</tr>
<tr>
<td><strong>Workload Pie Chart</strong></td>
<td>◐</td>
<td>◐</td>
</tr>
<tr>
<td><strong>Other gadgets</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Jira Issues Calendar</strong></td>
<td>◐</td>
<td>◐</td>
</tr>
<tr>
<td><strong>Test Sessions</strong></td>
<td>◐</td>
<td>◐</td>
</tr>
</tbody>
</table>
| Text | ![Enable](https://i.imgur.com/361.png) ![Available](https://i.imgur.com/361.png) ![Linked](https://i.imgur.com/361.png) | Shows HTML text on the dashboard.  
This gadget is available if a Jira admin has enabled it. By default, the gadget is disabled because it causes a potential security risk. The gadget may contain arbitrary HTML which potentially may make your Jira system vulnerable to XSS attacks.  
To enable the gadget:  
1. Go to Administration > Manage apps.  
2. In the left panel, select Manage apps to view the apps installed on the Jira site.  
3. In the dropdown list, select System.  
5. Find the Text module and select Enable.  
If you can't enable the gadget, contact Atlassian Support for assistance. |
| --- | --- | --- |
| Bamboo gadgets | ![Enable](https://i.imgur.com/361.png) ![Available](https://i.imgur.com/361.png) ![Linked](https://i.imgur.com/361.png) | Shows Bamboo plan statistics in your dashboard.  
If you want to add the gadget to the dashboard, a Jira admin should configure the Bamboo plugin on a Jira server. If you have multiple Bamboo servers added in Jira, only one Bamboo Charts gadget will be available per server.  
When you add the gadget to the Jira dashboard, you may see the following message:  
The website (container) you have placed this gadget on is unauthorized. Please contact your system administrator to have it approved.  
To fix this, you should configure the Bamboo site to allow Jira to draw information from it via gadgets on the dashboard.  
To do this, the Jira admin should first define the Jira site as an OAuth consumer in Bamboo. Then, you should perform a once-off authentication so that the gadget displays correctly. |
| Bamboo Charts | ![Enable](https://i.imgur.com/361.png) ![Available](https://i.imgur.com/361.png) ![Linked](https://i.imgur.com/361.png) | Shows a graphical summary of a Bamboo build plan.  
If you want to add the gadget to the dashboard, a Jira admin should configure the Bamboo plugin on the Jira server. If you have multiple Bamboo servers added in Jira, only one Bamboo Plan Summary Chart gadget will be available per server.  
When you add the gadget to the Jira dashboard, you may see the following message:  
The website (container) you have placed this gadget on is unauthorized. Please contact your system administrator to have it approved.  
To fix this, you should configure the Bamboo site to allow Jira to draw information from it via gadgets on the dashboard.  
To do this, the Jira admin should first define the Jira site as an OAuth consumer in Bamboo. Then, you should perform a once-off authentication so that the gadget displays correctly. |
<table>
<thead>
<tr>
<th>Bamboo Plans</th>
<th>✔</th>
<th>✔</th>
<th>✔</th>
</tr>
</thead>
</table>
| Shows a list of all plans on a particular Bamboo server and the current status of each plan.  
If you want to add the gadget to the dashboard, a Jira admin should configure the Bamboo plugin on the Jira server. If you have multiple Bamboo servers added in Jira, only one Bamboo Plans gadget will be available per server.  
When you add the gadget to the Jira dashboard, you may see the following message:  
The website (container) you have placed this gadget on is unauthorized. Please contact your system administrator to have it approved.  
To fix this, you should configure the Bamboo site to allow Jira to draw information from it via gadgets on the dashboard.  
To do this, the Jira admin should first define the Jira site as an OAuth consumer in Bamboo. Then, you should perform a once-off authentication so that the gadget displays correctly. |

<table>
<thead>
<tr>
<th>Clover Coverage</th>
<th>✔</th>
<th>✔</th>
<th>✔</th>
</tr>
</thead>
</table>
| Shows the clover coverage of plans from a particular Bamboo server.  
If you want to add the gadget to the dashboard, a Jira admin should configure the Bamboo plugin on the Jira server. If you have multiple Bamboo servers added in Jira, only one Clover Coverage gadget will be available per server.  
When you add the gadget to the Jira dashboard, you may see the following message:  
The website (container) you have placed this gadget on is unauthorized. Please contact your system administrator to have it approved.  
To fix this, you should configure the Bamboo site to allow Jira to draw information from it via gadgets on the dashboard.  
To do this, the Jira admin should first define the Jira site as an OAuth consumer in Bamboo. Then, you should perform a once-off authentication so that the gadget displays correctly. |

| FishEye gadgets |
|-----------------|-----|-----|-----|
| Crucible Charts | ✔  | ✔  | ✔  |
| Shows statistical summaries of your code reviews.  
If you want to add the Crucible Charts gadget to your dashboard, a Jira admin should configure the FishEye app on your Jira server. |
| FishEye Charts | ✔  | ✔  | ✔  |
| Shows Lines of Code data from a FishEye repository.  
If you want to add the FishEye Charts gadget to the dashboard, make sure that:  
1. The FishEye app is bundled with Jira Software and a working FishEye instance is linked to the Jira instance.  
2. A link to the code repository is available. Only three types of repositories are applicable: subversion, perforce, or cvs.  
Contact the Jira admin about these steps. |
| FishEye Recent Changesets | | | Shows two charts about your repository in one: Lines of Code and commit activity. | |
|---------------------------|---|---|If you want to add the FishEye Recent Changesets gadget to the dashboard, make sure that: | |
|                           | ☑ | ☑ | 1. The FishEye app is bundled with Jira Software and a working FishEye instance is linked to the Jira instance. | |
|                           |   |   | 2. A link to the code repository is available. Only three types of repositories are applicable: subversion, perforce, or cvs. | |
|                           |   |   | Contact the Jira admin about these steps. | |
Using the help center

Your service project comes with an online help center for your customers.

From the help center, customers can browse all the service project portals they have access to. They can do a lot of other things too like:

- View available service projects, and filter them by popularity or alphabetical order.
- Browse a specific service project.
- Search for request types and knowledge base articles.
- See requests they have raised.

It’s good practice to direct your customers to the help center so that they don’t have to remember, say, how to submit a request for a new laptop. They simply search for ‘new laptop’ in the search field and the correct request type will be offered up.

Customizing the help center

Here’s a quick look at the help center layout:

1. **Portal cards**: View all customer portals at a glance and switch between them quickly.
2. **Recent**: View the types of requests that you raised recently.
3. **Sorting**: Sort customer portals by popularity, or the ascending or descending order. The popularity of your portals is based on the number of requests raised.

To help your customers get the most out of your help center, we recommend that you do three things:

- Brand your help center.
- Set up a knowledge base for self-service.
- Share the help center with customers.

### Brand the help center

Jira admins, project admins, and agents with permission can brand the help center in a number of ways. Here’s how:

1. Go to **Jira administration > Applications > Jira Service Management > Configuration**.
2. Below **Help center**, select the link **View and customize**.
3. In the **customize** panel on the right hand side do any of the following:
   - Add a help center announcement
   - Add an announcement to the log in screen
   - Give your help center a name
   - Add a logo
   - Add a banner image or banner background color
   - Change the color of components

   - Select **Save changes** to publish your announcement.

Branding doesn't stop at just the help center. You can also brand the customer portal that belongs to a service project. To learn how to do this, check out **Configuring the customer portal**.

### Set up a knowledge base
If you have Jira Service Management and Confluence, you can deflect common requests and solve issues faster by setting up a knowledge base. To learn more, check out Set up a knowledge base for self-service.

Customers can read articles in the help center and mark articles as helpful or not. If customers still need to contact your team after reading a knowledge base article, they can select one of the suggested request types or browse all customer portals they have access to.

**Share the help center with customers**

The help center shows all of the customer portals in your Jira Service Management instance. From here, customers can raise requests in any of the portals they have access to. They can also view all the requests they’ve raised via the Request button in the top right hand corner of the screen.

Check out View requests in the help center to learn how this works.

To share the help center with customers, send them the following link:

http://<computer_name_or_IP_address>:<http_port_number>/jira/servicedesk/customer/portals

You can also add customers to a service project which gives them an account in the help center.

**Manage access to the help center**

You can choose who can raise requests in your help center and who your customers can share requests with.

To learn more about different access options, check out Managing access to your service project.

The customer portal integrates with Atlassian Crowd, Atlassian's single sign-on (SSO) framework. For information about integrating with third-party SSO providers check out Single sign-on integration with Jira and Confluence.

**How the smart search works**

The smart search algorithm learns from past searches and request types raised, so if a customer has previously raised a hardware request for a laptop and monitor they can search for laptop or monitor in future to find the same hardware request type. It also performs a similarity search, so if you searched for Onboard employeeyou’d see the Onboard new employee request type in the results.
Furthermore, the smart search has been built to be language-agnostic, so it can learn from search words or phrases entered in any language. As customers enter more searches and raise more requests, the search algorithm gets smarter regardless of the language used.

**What you can do to improve search**

Your team can help improve search results by updating the request type field when a customer has, for example, searched for *new laptop* and raised a software request instead of a hardware request. To learn more, check out [Setting up request types](#).
View requests in the help center

When a customer raises a request in a service project, they receive a confirmation email and can correspond with the agent via email. Alternatively, if customers have an account they can view all their requests via the help center and customer portals they have access to. Learn more about customer portals

How to view requests

When logged in, you'll see a button in the top right corner that says Requests.

Here, a customer can quickly access the following:

- Approvals - a request submitted by another person that they are an approver on.
- My requests - a request submitted by that person.
- All requests - both of the above, as well as a request submitted by another person that they've been added to as a request participant.

How to sort requests

From the requests page a customer can filter their requests by the following parameters:

- Request status - for example, open or closed.
- Request type - for example, software requests or email access.
- Created by - for example, created by me or created by someone else, but shared with me.
How to find the help center

To share the help center with customers, you can link to the following URL:

http://<computer_name_or_IP_address>:<http_port_number>/jira/servicedesk/customer/portals

You can also add customers to a service project which gives them an account in the help center. Learn more at Adding customers.

A request will display on this page only when a customer has created that request, or if they have been added as a participant on someone else’s request. Learn more at Adding request participants.
Configuring request view

You need a Data Center license to use this feature.

Your customers with accounts can view all their requests in the help center. It's up to you which columns are available to them, though. Selecting specific columns will allow your customers to see and configure those columns in their requests list.

Customize available columns as an admin

You need to be a Jira admin to customize the request view.

Once you save this configuration, it applies globally to all requests.

To select columns available to your customers:

1. Go to the help center.
2. Select Requests > All requests.
3. From the top navigation bar select Customize.
4. Select the checkboxes next to the columns you want to add or remove.
5. Select Save.

Select Type
Select Reference
Select Summary
Select Status
Select Service project
Select Requester
Select Created date
Select Updated date
Select Due date
Select Assignee
Select Priority

Save Cancel
Configure the requests list view as a customer

After you specify which columns are available to your customers, they can configure their requests list view according to their needs. Customers can change:

- Which columns they want to see in their requests list
- The order of columns
- How columns are sorted

To configure the requests list view, a customer needs to go to the help center, then select Requests > My requests. Selecting the more actions menu ( ) will enable them to configure the columns in their requests list and their order.

To sort a column, the customer needs to select the column title.

You can sort the following columns:

<table>
<thead>
<tr>
<th>Column name</th>
<th>Sorting type</th>
</tr>
</thead>
<tbody>
<tr>
<td>Reference</td>
<td>• Sorted A &gt; Z</td>
</tr>
<tr>
<td></td>
<td>• Sorted Z &gt; A</td>
</tr>
<tr>
<td></td>
<td>Also known as Issue key.</td>
</tr>
<tr>
<td>Requester</td>
<td>• Sorted A &gt; Z</td>
</tr>
<tr>
<td></td>
<td>• Sorted Z &gt; A</td>
</tr>
<tr>
<td>Created date</td>
<td>• Sorted oldest &gt; newest</td>
</tr>
<tr>
<td></td>
<td>• Sorted newest &gt; oldest</td>
</tr>
<tr>
<td>Updated date</td>
<td>• Sorted oldest &gt; newest</td>
</tr>
<tr>
<td></td>
<td>• Sorted newest &gt; oldest</td>
</tr>
</tbody>
</table>
| Due date          | • Sorted oldest > newest  
|                  | • Sorted newest > oldest |
| Assignee         | • Sorted A > Z  
|                  | • Sorted Z > A |
| Priority         | • Sorted in ascending order  
|                  | • Sorted in descending order |

ℹ️ Descending order = highest priority > lowest priority.
Organizing work with components

Components are used to organize or group customer requests in a service desk project. You could set up a component for systems that your teams are responsible for (e.g. company intranet), and then set a default assignee so that any customer request about that system is assigned to the agent who manages it.

You need to have the project-specific **Administer Projects** permission or the **Jira Administrator** global permission to be able to:

- Add create a new component against which issues can be aligned
- Edit change a component's details
- Delete remove a component

Once a component has been created for a project, the 'Component' field becomes available for your issues. If you cannot see this field on your issue, your project may not have any components yet, or the field is hidden from view.

Managing a project's components

The easiest way to manage a project's components is through the Components page.

1. Choose **Administration** > Projects, and click the name of the project.
2. Choose **Components** in the sidebar. The **Components** page is displayed, showing a list of components and each component's details. From here, you can manage the project's components as described below.

Adding a new component

1. The Add Component form is located at the top of the 'Components' screen.
2. Enter the **Name** for the component. Optionally, enter a **Description** and select a **Component Lead** and **Default Assignee** (see options below).
3. Click **Add**.

Selecting a default assignee

You can optionally set a default assignee for a component. This will override the project's default assignee for issues in that component. If an issue has multiple components, and the default assignees of components clash, the assignee will be set to the default assignee of the component that is first alphabetically.

<table>
<thead>
<tr>
<th>Default assignee option</th>
<th>Description</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Project Default</td>
<td>Issues matching this component will have the assignee set to the same default assignee as the parent project.</td>
<td>If the project leader is not permitted to be assigned to issues in the permission scheme, this option will be disabled and will say &quot;Project Lead is not allowed to be assigned issues&quot;.</td>
</tr>
<tr>
<td>Project Lead</td>
<td>The assignee will be set to the project leader.</td>
<td></td>
</tr>
</tbody>
</table>
### Componen t Lead

The assignee will be set to the component leader.

If the component leader is not permitted to be assigned to issues in the permission scheme, this option will be disabled and will say "Component Lead is not allowed to be assigned issues". The Component Lead option will also not be available if the component does not have a lead assigned to the component. Instead, under this option, it will say "Component does not have a lead".

### Unassigned

The assignee of the issue will not be set on the creation of this issue.

This option will only be available if "Allow unassigned issues" is enabled in the general configuration.

---

**Editing a component's details**

1. On the 'Components' screen, open the menu in the **Actions** column for the component you want to edit, and select **Edit**.
2. Edit the component's **Name**, **Description**, **Lead**, and **Default Assignee** in the **Edit component** dialog.
3. Click the **Save** button to save your changes.

**Searching for a component**

If you need to find a component in a long list, it's easiest to search for it. Start typing text into the search box that you know the component contains, and your list will automatically be filtered for you.

**Deleting a component**

1. On the 'Components' screen, open the menu in the **Actions** column for the component you want to delete, and select **Delete**.
2. You will be prompted to associate any issues assigned to this component with another component if you wish.
3. Click the **Delete** button to delete the component.
Set up a knowledge base for self-service

Linking Jira Service Management to Confluence and using it as a knowledge base lets your agents share their expertise through knowledge base articles and how-tos. They can be linked from requests, searched in Confluence, or shared via direct links. Customers can then help themselves by finding the right solutions, and new agents can quickly get up to speed with the most common problems.

Confluence Cloud
Choose this option if you're using Confluence Cloud, managed by Atlassian.
Learn more

Confluence Server
Choose this option if you're using on-premise Confluence, managed by your organization.
Learn more
Set up a knowledge base with Confluence Server

Follow this step by step guide for linking Jira Service Management to a Confluence knowledge base, so that customers can help themselves and agents can share their expertise.

- 1. Install Confluence
- 2. Get the right number of Confluence licenses
- 3. Link Jira Service Management to Confluence
- 4. Learn about knowledge base settings and permissions
- 5. Link your project to a Confluence space
- 6. Write and search for knowledge base articles
- Known issues

1. Install Confluence

User: JIRA ADMINS

You’ll need Confluence 5.10 and above and Jira Service Management 3.1 (formerly known as Jira Service Desk) and above to access knowledge base features. Get the latest versions of each for all the bells and whistles.

Steps

1. Install the latest version of Confluence.
2. Have the same user base in both Jira and Confluence by one of the following methods:
   - Connect to Crowd or Jira for user management
   - Connect to an internal Directory with authentication
   - Connect to an directory
3. Check that you’re an administrator in both Jira and Confluence.

Good to know

- Read Use Jira applications and Confluence together to check version compatibility between products.
- Having the same user base in both Jira and Confluence means you won’t have to manually create and maintain customer accounts.

2. Get the right number of Confluence licenses

User: JIRA ADMINS

Your service project agents will need a Confluence license to create and edit knowledge base articles. However, service project customers won’t need a Confluence license to view articles.

Good to know

- Read Confluence licensing and pricing to learn more.
3. Link Jira Service Management to Confluence

User: JIRA ADMINS

Linking two applications allows you to share information and access one application's functions and resources from within the other.

Steps

1. Go to Jira Administration > Applications > Application links.
2. Enter the URL of your Confluence site and select Create new link.
3. Check The servers have the same set of users to configure using OAuth (with impersonation) authentication.
4. If you're not an admin on both servers you won't be able to set up a 2-way (reciprocal) application link. If you want to go ahead and create a 1-way link anyway, clear the I am an administrator on both instances checkbox.
5. Use the wizard to finish configuring the link.

Good to know

- Read Linking to another application to learn how to set up a reciprocal link from Confluence.
- Read this troubleshooting article if you get into difficulty linking Jira to Confluence.

4. Learn about knowledge base settings and permissions

The permissions you set in Confluence determine whether (or not) your agents can create articles and if your customers can view them.

Read Knowledge base settings and permissions to decide what you need.
5. Link your project to a Confluence space

User: PROJECT ADMINS

When you link a Confluence space to your service desk project, agents can search for solutions and create new articles for common requests. Customers can then use the articles to self-service problems.

There are two ways to link your service desk to a Confluence Space:

Link to an existing space

1. Go to Knowledge base > Link existing space.
2. Select the space you want from the dropdown.
3. Choose the link Define who can view knowledge base articles to set permissions.

You can also unlink or change spaces in Project settings > Knowledge base.

Link to a new space

1. Check you have Confluence admin and Create space permissions.
2. Go to Knowledge base.
3. Select Create new space.
4. Congratulations, you have created a new Confluence space.

Good to know

- Read Use Confluence as a knowledge base to learn how to set up a knowledge base blueprint.

6. Write and search for knowledge base articles

User: AGENTS

Once you've linked to a Confluence space, agents are ready to start writing and sharing knowledge with customers and teammates.

Read Write and search for knowledge base articles to learn how to do this.

Known issues

If you run into problems connecting a Confluence knowledge base and Jira Service Management, check out this page. It lists common integration-related issues and explains how to troubleshoot them.
Knowledge base settings and permissions

Now that you've linked your Jira Service Management project to a Confluence space, you'll need to set your agents and customers up with the right permissions.

Who needs a Confluence license

If you want your service project agents to create, comment on, and search the spaces on your Confluence site, they'll need a Confluence license. Your service project customers however, don't need a Confluence license to view knowledge base articles.

There are three levels of permissions in Confluence that determine who can view and create articles:

- **Global permissions** are site-wide and can be assigned by a system or Confluence admin.
- **Space permissions** are space specific and are managed by the space admin.
- **Page restrictions** affect both viewing and editing and are managed by space admin.

If you, your agents or your customers are having difficulty viewing articles, check the permissions with your Confluence admin.

Choose who can view articles

Go to **Project settings > Knowledge base > Access > Viewing**.

This setting determines who can view articles via the help center or a link your team shares. You have two options to choose from:

**Option 1. All active users and customers**

Users who don't have a Confluence license can view knowledge base articles via the customer portal and help center.

Choose this if:

- You want your team to write articles and share them with customers.

Limitations:
If your Jira Service Management site and Confluence site have separate user bases, you’ll need to create a Confluence user account for each service project customer. If you don’t want the customer to use a Confluence license, don’t assign the Confluence user to a group.

Option 2. Only licensed users

Users who don’t have a Confluence license can’t read knowledge base articles unless you allow anonymous access in the knowledge base space.

Choose this if:

- You only want to use your knowledge base for internal articles.

Limitations:

- Anonymous access is not compatible with SSO using 2-legged OAuth.

Data privacy

If you choose the All active users and customers setting, you’ll see the following message in the Confluence space permission screen:

Any active user can view this space

Any active user can view pages in this space, including users who don’t have a Confluence license. This was enabled through JIRA Service Desk so people can view knowledge articles when raising a help request.

This permission overrides all existing space permissions. Any logged in Confluence user will be able to see the space (regardless of their group membership).

You can disable this permission at any time, but it can only be re-enabled from Jira Service Management.

Login process

If you aren’t using SSO or something that passes login information between instances, then users will need to log in to Confluence using their Jira Service Management credentials to view articles.

Check if agents can create articles

Your agents will need a Confluence license to create and edit articles, and permission to create articles in the Confluence space.

To check if an agent can create articles:

1. Go to Project settings > Knowledge base > Access > Authoring.
2. Select the space permissions link, this will take you to your space permission’s page.
3. Check that the agent (or a group they are a member of) has the Add page permission.
Set up a knowledge base with Confluence Cloud

1. Set up a Confluence Cloud account

You'll need a Confluence Cloud account to create the integration. If you don't have one already, check out this link:

- Try Confluence Cloud

2. Get the right number of Confluence licenses

Your service project agents will need a Confluence license to create and edit knowledge base articles. However, service project customers won't need a license to view these articles.

Good to know

- Read Confluence Cloud licensing and pricing to learn more.

3. Create a user with the right permissions to access Confluence

When integrating Jira Service Management with Confluence, you'll need to choose a user that will be used to access Confluence. **It's important** that this user's permissions are similar to what you'd like customers to have.

Why are permissions important?

When customers search your knowledge base, they get results based on the permissions of the user you've chosen. If that's an admin or someone with high permissions, customers might see results they shouldn't have access to.

This will include the title and an excerpt of an article (that's what's displayed in the search). If an article is restricted, they won't be able to view it as the articles restrictions are checking permissions of a specific user who's trying to access it. Nevertheless, it's easy to reveal more than you'd like to, so make sure to set the permissions right.
4. Integrate Jira Service Management with Confluence

**Audience:** JIRA ADMINS

Once you've covered the requirements on the Confluence side, it's time to integrate it with Jira Service Management. That's a one-time action after which your project admins will be able to link their projects to spaces in Confluence.

**Steps**

1. Go to **Administration > Applications > Confluence Cloud integration**.
2. Enter the URL of your Confluence site, including the /wiki suffix, for example:

   ```
   https://confluence.atlassian.net/wiki
   ```

3. Enter a descriptive display name. This is what project admins will see when linking their projects to Confluence.
4. Specify the user that will be used to access Confluence. Make sure to set the right permissions for this user, as described in the previous step.
5. Enter your Confluence API token. You can generate it from your Atlassian account. For more info, see [API tokens](#).
6. Click **Save**.

**Good to know**

- In the past, you might have created integrations with other applications through Application Links. Although this would still work for Confluence Cloud, using it as the knowledge base requires that you create the integration through the **Confluence Cloud integration** page. No AppLinks this time.

5. Learn about knowledge base settings and permissions

The permissions you set in Confluence determine whether (or not) your agents can create articles and if your customers can view them.

- Read [Knowledge base settings and permissions in Confluence Cloud](#) to decide what you need.
6. Link your project to a Confluence space

**Audience:** PROJECT ADMINS

When you link your service project to a Confluence space, agents can search for solutions and create new articles for common requests. Customers can then use the articles to self-service problems.

**Before you begin**

- You need to create a space for your project in Confluence beforehand, as you can only link projects to existing spaces.

**Steps**

1. Go to Knowledge base > Link existing space.
2. Select the space you want from the dropdown.
3. Choose the link Define who can view knowledge base articles to set permissions.

You can also unlink or change spaces in Project settings > Knowledge base.

---

7. Write and search for knowledge base articles

**Audience:** AGENTS

Once you’ve linked to a Confluence space, agents are ready to start writing and sharing knowledge with customers and teammates.

- Read Write and search for knowledge base articles to learn how to do this.

---

**Known issues**

The pagination of search results is not available in Confluence Cloud, that’s why when you search for knowledge base articles, you’ll only see the top 3 articles.

When linking a project to a Confluence space, you’ll need to create this space in Confluence beforehand. You won’t be able to create it from within Jira Service Management.

You also won’t be able to create a Confluence space when creating a service desk project.

To view articles linked in your requests, your customers will need to be logged in to their Atlassian cloud accounts (no license required) unless you allow anonymous access. That’s a known issue that makes this integration different from using Confluence Server or Data Center.

To check what your customers need to view the articles, how to allow anonymous access for your Confluence spaces, and how to create Atlassian cloud accounts without them consuming extra licenses, see Knowledge base settings and permissions in Confluence Cloud.

There is a feature request to improve this behavior:

---

| JSDSERVER-7175 - Knowledge Base articles can't be opened in the customer portal if Confluence Cloud is not configured with anonymous access | GATHERING INTEREST |
Knowledge base settings and permissions in Confluence Cloud

Now that you've linked your Jira Service Desk project to a Confluence Cloud space, you'll need to set your agents and customers up with the right permissions.

Choose who can view articles

First you should decide whether the space linked to your project should be available to all active users and customers (requiring Atlassian cloud account, but not license) or only licensed users, for internal purposes. You can then additionally allow anonymous access for your space.

To configure permissions for your knowledge base:

1. Open your project.
2. Go to Project settings > Knowledge base, and select one of the options.

Option 1. All active users and customers

Users need to log in to their Atlassian cloud accounts to view articles, but they don't need product access to your Confluence site, and hence don't consume a license. If you don't want users to log in, you can allow anonymous access.

To enable this setting, the user you've chosen when integrating with Confluence Cloud needs admin permissions for your space.

<table>
<thead>
<tr>
<th>Tasks in Confluence</th>
<th>What your users needs</th>
</tr>
</thead>
<tbody>
<tr>
<td>• Create articles</td>
<td>• Atlassian cloud account</td>
</tr>
<tr>
<td>• Comment on articles</td>
<td>• Product access to your Confluence site (consuming a license)</td>
</tr>
<tr>
<td>• Search the spaces</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Tasks in Confluence</th>
<th>What your users needs</th>
</tr>
</thead>
<tbody>
<tr>
<td>• View articles linked in requests</td>
<td>• Atlassian cloud account</td>
</tr>
<tr>
<td></td>
<td>• Only site access (not consuming a license)</td>
</tr>
</tbody>
</table>

With anonymous access allowed:
• Nothing

Option 2. Only licensed users
Users need Atlassian cloud accounts and product access for your Confluence site. Choose this option if you're planning to use your knowledge base for internal purposes and already have licenses assigned to your users. Here you can also enable anonymous access to some Confluence spaces so users don't have to log in to view them.

<table>
<thead>
<tr>
<th>Tasks in Confluence</th>
<th>What your users needs</th>
</tr>
</thead>
<tbody>
<tr>
<td>• Create articles</td>
<td>• Atlassian cloud account</td>
</tr>
<tr>
<td>• Comment on articles</td>
<td>• Product access to your Confluence site (consuming a license)</td>
</tr>
<tr>
<td>• Search the spaces</td>
<td></td>
</tr>
<tr>
<td>• View articles linked in requests</td>
<td>• Atlassian cloud account</td>
</tr>
<tr>
<td></td>
<td>• Product access to your Confluence site (consuming a license)</td>
</tr>
<tr>
<td></td>
<td>With anonymous access allowed:</td>
</tr>
<tr>
<td></td>
<td>• Nothing</td>
</tr>
</tbody>
</table>

Configuring anonymous access so customers can view articles without logging in

Even if you give access to your knowledge base to all active users and customers (Option 1 above), they still need to be logged in to their Atlassian cloud accounts to view articles linked in your requests. To avoid creating accounts for your customers and making them log in every time, you can allow anonymous access for your Confluence site and chosen spaces.

⚠️ Confluence spaces for which you allow anonymous access will be available to anyone on the web.

Configure anonymous access

You need to allow anonymous access for **both your site and space**:

- To allow it for your site, see [Set up public access](#). Note that even with anonymous access allowed for the site, your spaces won't be open to public until you specifically allow that.
- To allow it for your space, see [Make a space public](#).

Creating Atlassian cloud accounts for customers without consuming licenses

If you don't want to enable anonymous access, you can invite your customers to Atlassian cloud so they can log in and view knowledge base articles without consuming licenses. To put it shortly, you'll need to make sure their accounts don't have **product access** enabled for Confluence Cloud.

To disable product access for new users:

1. Go to your Atlassian cloud sites `admin.atlassian.com`.
2. In the sidebar, select **Product access**.
3. Clear the **New users have access to this product** option next to your Confluence site.
4. When inviting new users, make sure that your Confluence site isn't selected in **Product access**, and that users aren't added to any groups that have product access (e.g. confluence-users).

To check the product access for existing users:

1. Go to your Atlassian cloud sites `admin.atlassian.com`.
2. In the sidebar, select **Users**.
3. Check the details of your users:
   - Make sure they don't have access granted for Confluence. They should only have the **Has access on site** option enabled.
b. Make sure they aren't added to any groups that have product access (e.g. confluence-users).
Write and search for knowledge base articles

Your knowledge base is there for customers, even when you're working on other requests, at home for the day, or away on holiday.

Here are some reasons you might write knowledge base articles:

- **You get a lot of similar requests.** Like "How do I access office wifi?". When customers search for 'wifi' in the help center, they'll find your article. If they send you a request, you can share the article rather than walking them through the steps in a comment.
- **You're upgrading a system.** You can write a step by step upgrade guide and link to it from an announcement in the help center.
- **You're troubleshooting the same issue with customers.** If you normally walk people through a series of steps to diagnose and troubleshoot a problem, such as a broken printer, a troubleshooting guide will save you time.

How to write articles

After you set up your knowledge base space, the issue view displays a panel called **Related knowledge base articles:**
If you don’t see a relevant article, you can create a new one from the issue. You'll need the **Add page** permission in the Confluence space. Customers can read any article that doesn’t have a red padlock.
To create a new article:

1. Click the **create an article** link.
2. By default, the issue summary becomes the new article's title, you can edit this.
3. Choose either the **How-To** or **Troubleshooting** template.
4. Follow the prompts to create the article, then **Publish**.

5. Check how it displays in the issue view.

Page labels are essential in knowledge base spaces. These are used to add topics to your articles, and allows your knowledge base to become self-organizing over time.

You can also create articles from the sidebar, then **Knowledge base > Create article**.

How to share articles

There are two ways you can share articles with customers:

- Hover over an article to share it as a comment on a request:

  ![Related knowledge base articles](image)

- Share links from a knowledge base article that you access via **Knowledge base** in the sidebar.

  When customers click the link from a request or their email, the article opens in the help center:
How the search works

The knowledge base recommends articles to customers and agents using keywords it pulls from the Summa field of a request.

Help center and customer portal search results

When a customer types something in the search field on the help center or customer portal, the results return the following:

- Related knowledge base articles. These help customers resolve their own issues, without needing to raise a request.
- Related request types. These are recommended to customers, so they know which request type to fill out based on their issue.

To make it even easier for customers to find what they need, you can recommend articles when they fill out a particular request type.
Recommending articles

To recommend articles for certain request types, go to Project settings > Knowledge base > Auto-search on request types, then in the Search KB column, choose Yes:

<table>
<thead>
<tr>
<th>Request form</th>
<th>Search KB</th>
<th>Restrict to articles with labels</th>
</tr>
</thead>
<tbody>
<tr>
<td>Technical support</td>
<td>Yes</td>
<td>Technical_support</td>
</tr>
</tbody>
</table>

You can restrict the search to articles with a certain label. To make life easier for yourself, use a label similar to the name of the request form.

⚠️ You can't use labels as a way of restricting access to an article. For example, if you create a knowledge base article and add the label "display", and then create another article and don't add the label "display" the page without the label will still display in the search. Adding labels are a way to filter related articles, not assign viewing permissions.

If you need to restrict an article so that only certain users can view it, do this through knowledge base settings and permissions.

Using multiple knowledge bases
If you have multiple knowledge bases (Confluence instances) connected to your Jira Service Management instance and are searching through the Help Center, only articles from the primary knowledge base will be returned. This is a known issue related to the Help Center, you can follow a feature request [here](https://jira.atlassian.com/software/SDS-624). Articles from remaining knowledge bases will be returned when searching on individual customer portals.

You can set any Confluence instance as the primary one by going to Administration > Applications > Application links.

Other important information

- **Knowledge base vs. request type search:** The knowledge base search and the request type search are independent of each other.
- **Request type search:** The request type search will display a maximum of 5 results, and:
  - The primary search picks up words that the customer is typing in the Summary field, and looks for them in the request type's Name and Description.
  - The secondary search uses JQL queries to find relevant request types based on the request's Summary field.

---

### Issue view search results

When agents view a request, the knowledge base recommends related articles that they can reference or share with customers. Your service project will search the Confluence space you have linked for any articles that contain keywords in the request's Summary field.

Important things to note:

- The search ignores all other fields from the request (only the summary field is used).
- Check that your request types have a visible **Summary** field. Read [Setting up request types](https://confluence.atlassian.com/jira-service-management-58/knowledge-base-vs-request-type-search-58). 直接跳转到“知识库 vs. 请求类型搜索”
- The search skips articles that the agent doesn't have permission to view.
- The search and ranking follows the same rules as the Confluence search. In short, Confluence identifies all articles that contain keywords matching those in the request's **Summary** field, and sorts them by word frequency.
- Agents can only share articles that the customer has permission to see.

> Change the article title to include more keywords from the request summary field, if you don’t see an article that you think you should.

Agents can also search for articles via the **Knowledge base** in the project sidebar.

---

### How to access search help

When you link a Confluence knowledge base to your service project, a **Search help** link appears below the search field.
When you click on this link, you’re shown a screen that explains how to create an advanced search query using Confluence search syntax (including wildcards) for more precise knowledge base search queries.
Check out Confluence Search Syntax for an overview of this function.
Setting up incident management

You can set up incident management to allow your agents to view and manage Opsgenie incidents within their Jira Service Management projects. This allows them to quickly respond to disruptions, get up to speed with what's going on, create incidents and provide more context for the Opsgenie teams to resolve them.

1. Set up your Opsgenie account

Major incidents are stored and managed in Opsgenie, an Atlassian application used for alerts. You'll need an Opsgenie account to integrate it with Jira Service Management. If you don't have one already, check out this link:

- Try Opsgenie

2. Integrate Jira Service Management with Opsgenie

User: JIRA ADMIN

Integrating Jira Service Management with Opsgenie is a one-time action that will let the two applications exchange information between one another. Once that's done, every project admin can enable incident management for each project separately.

Before you begin

- You'll need the Opsgenie API URL and API key to create the integration. Check Getting Opsgenie API information to learn how to find them.

Steps

1. Go to Administration > Applications > Opsgenie integration.
2. Enter your Opsgenie API URL and API key.
3. Select Save. Your integration is now enabled.

3. Enable incident management for your projects

User: PROJECT ADMIN

If you'd like to use incident management in your project, you can enable it in project settings. This will give agents working on a project access to ongoing major incidents, and some special permissions like linking incident to requests.

1. Go to Projects settings > Incident management.
2. Allow agents to view, link, and manage major incidents within this project.
4. Work with ongoing major incidents

Enabling incident management brings a new screen to your Jira Service Management where you can view ongoing major incidents to be up to date with any disruptions, and link them to requests to help your Opsgenie teams resolve them faster.

- Read [Working with major incidents](#) for more details.
**Getting Opsgenie API information**

When integrating Jira Service Management or Jira Software cloud with Opsgenie, you'll need to provide the Opsgenie API URL and key.

**Opsgenie API URL**

Opsgenie can have two different API URLs, and the one you need depends on where your Opsgenie instance is located.

**US**

- [https://api.opsgenie.com](https://api.opsgenie.com)

**EU**

- [https://api.eu.opsgenie.com](https://api.eu.opsgenie.com)

**Opsgenie API key**

To generate an Opsgenie API key:

1. In Opsgenie, go to **Settings > API key management**.
2. Select **Add new API key**.
3. Enter a name for the API key and select the following access rights for this API key:
   - Create and Update Access
   - Read Access
   - Delete Access
   - Configuration Access

For more info, see [API key management](#).
Working with major incidents

Once you set up incident management, you'll get access to a new page Major incidents. It shows ongoing major incidents from Opsgenie, and allows your agents to view them, stay up to date, and link requests to these incidents, just to give the Opsgenie teams more context.

Viewing major incidents

To view major incidents, select **Major incidents** in the left navigation bar.

1. **Priority, key, and message:** Details about your incident. You can click the incident message to view it in Opsgenie in more detail.
2. **Affected Opsgenie service:** Services are configured on the Opsgenie side and allow you to properly categorize an incident.
3. **Responders:** That's an Opsgenie team that will be responsible for resolving your incident.
4. **Linked requests:** Requests that are linked to an incident. You can click this link to open a view where you can comment on all linked requests, reassign them, or complete some other actions.

Creating major incidents

You should create a major incident when you keep getting requests about some service being down, and need someone to take action on resolving it. The incident will be created in Opsgenie (and shown in Jira Service Management), and will alert the right Opsgenie teams right away.

To create a major incident:

1. Open a request and select the plus sign in the **Linked major incidents** section.

   ![Linked major incidents](image)

   There are no major incidents linked to this issue.

2. Fill in the details of your incident. We'll show you ongoing incidents, just in case someone already created a similar incident.
3. When you're ready, click **Create**. The major incident will be linked to your request, and will also appear on the **Major incidents** page.

<table>
<thead>
<tr>
<th>Linked major incidents</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>P4 #53 Space shuttle isn't working</strong></td>
</tr>
<tr>
<td>1 issue</td>
</tr>
</tbody>
</table>

Linking requests to major incidents

When you keep getting requests about the same incident, you can link all of them to a major incident. This will help you identify the severity of the problem, and will give the Opsgenie teams more context about an issue. It's also useful for other agents.

**Linking a single request**

To link a request to a major incident:

1. Open a request and select the Link sign in the **Linked major incidents** section.
2. Search for a major incident or select it from the list.

**Linking multiple requests**

You can also link multiple requests to a single major incident at once by using agent queues.

To link multiple requests to a major incident:

1. Open your agent queue.
2. Select your requests.
3. Select **Link to major incident**, and choose the incident.

**Linking other related requests**

If it often happens that a request is linked to other requests (*is blocked by, is duplicate*, etc.). When you're linking such a request to a major incident, you can choose whether other linked requests should be linked to this incident as well.

1. Open a request that is linked to some other request.
2. Link it to a major incident.
3. You'll be asked whether you want to link other requests to this incident. Select them, or click **Cancel**.
4. Likewise, when you unlink a request from an incident, we'll ask you what to do with the related requests.

**Interacting with linked requests**

When multiple requests are linked to a major incident, you can easily leave a comment, reassign them, or complete other actions on all of these requests at once, instead of opening them one by one.

1. Open the **Major incidents** page.
2. Next to an incident, click the hyperlink in the **Linked** column.
3. Select requests, and choose an action you want to complete.
Filtering out requests

There are also a few ways that let you find unlinked requests (to check if they need an incident) or requests linked to a specific incident. This can come in handy if you have many requests or incident and can’t easily find them on the Major incidents page.

Finding unlinked requests

1. Open agent queues.
2. In the top-right, change the filter to **Unlinked requests**.

Finding requests linked to a specific incident

1. Open an incident in Opsgenie, and copy its ID from the URL. It will look something like this:

```
582f7731-d00f-4827-9a2d-19e380b26205
```

2. In Jira, open the advanced search and use the following JQL query:

```
"Linked major incidents" in ("582f7731-d00f-4827-9a2d-19e380b26205")
```

Creating a queue with linked or unlinked incidents

1. Go to **Queues > New queue.**
2. Switch to **Advanced.**
3. Use one of the following JQL queries to either find linked or unlinked incidents:

```
"Linked major incidents" is not EMPTY
```

```
"Linked major incidents" is EMPTY
```

More resources

- Opsgenie documentation
Managing your assets with Assets

Assets lets you manage your assets and configuration items in Jira Service Management, and interact with them through requests. It's a database of objects—digital representations of your assets, ranging from hardware and software to employees or various configuration items. You can make your objects whatever you need them to be, and have them displayed in and be affected by issues in Jira.

1. **Object types**: List of object types grouping your assets, organized into a clear tree structure.
2. **Objects**: Your actual assets or configuration items, with all details added through attributes. From simple names to type-specific items, like serial numbers, models, and pretty much anything you need.
3. **Object actions**: You can keep your physical assets in check by printing labels and QR codes, view their dependencies with other objects, and see which Jira issues they're on.

Get started with Assets

Here's a list of pages to get you started:

- Getting started with Assets
- Administering Assets
- Working with object schemas
- Working with object types
- Working with objects
- Importing your data
- Searching for objects
- Working with reports

Advanced usage guides

If you're looking for more advanced knowledge, including Assets app development, REST APIs and Java docs, see Advanced usage guides.
Getting started with Assets

This page will explain the basics of Assets, and it’s then up to you how much deeper you’d like to dive in.

What is Assets?

Assets is used for asset and configuration management. It’s like a database that stores everything you own from hardware and software to offices, keyboards and licenses, Assets can store whatever you need it to store. Its really up to you, though we’re guessing the most popular items will be something like:

- **Business services** (billing, email, payroll)
- **Hardware and software** (servers, computers, mobile phones, software licenses)
- **Employees** (John, Mary, Mathias)
- **Offices** (Sydney, Melbourne, Stockholm)
- **Server components** (RAM, network adapters, hard drives)

But isn’t Jira all about issues? Why assets?

Assets is more than just a Jira app. To be frank, under the hood, it’s a perfectly complete and powerful product that brings new features and possibilities. But it looks like an app, and we’ve bundled it into Jira Service Management, so let’s treat it as an app for now. As for the issues, imagine you create a Jira issue for your laptop: you give it a name, maybe some description, and fill in all these custom fields about brand, model, serial number, RAM, storage, and boom you have an asset. Do you see the similarity?

So are my assets issues?

They look similar, but they’re not your typical issues. Assets has its own structure for data that you put into it. Understanding this structure will help you in the future, but if you want a quick start, it’s really about object schemas, object types, and objects, together with their attributes and relations between them.

Here’s what it looks like in Assets:

1. **Object schema**: It works like a map that holds all of it together. In the Jira world, that would be a project.
2. **Object types**: Containers for your objects (assets), each with its own characteristics, like specific issue types (Computers, Mobile phones).
3. **Objects**: Your actual assets, whatever they are. Similar to Jira issues or requests. Put them into object types, and get going (MacBook MBP M1, Latitude 7480).
4. **Attributes**: What defines your object types (objects inherit them). Like fields or custom fields (Name, RAM, Storage).
5. **References**: Relations and dependencies between objects. If you own a laptop, you have a reference to it (you own it). Like issue links, though they serve a different purpose.
The best way to start quickly is to use the starting from scratch tutorial. It will show you the basics, essentially taking you from zero to hero. If you don’t have time and want to see a ready object schema, take the ITSM tutorial.

License

Assets is part of Jira Service Management Data Center 4.15 and later, but you can also download it at no extra cost for earlier versions of Jira Service Management Data Center, and also for Jira Software Data Center. If you're on one of these earlier versions, its best to see our FAQ for answers to any questions you might have.

Learn more about Assets

If you're curious to learn more, here are some pages for you:

- What is Assets? an overview of the most important concepts and features: object schemas, object types, and objects.
- Assets onboarding guide if you'd rather get a one-pager with everything that matters. We'll guide you through the basic concepts, tell you how to start, and give some tips and tricks on what data to include and how to keep it accurate in the future. That's exactly what you need if you've never used Assets before.

To get some practice, see these tutorials:

- Tutorial: Starting from scratch
- Tutorial: How Jira issues affect Assets objects (ITSM)

Start working with Assets

If you'd rather get working with Assets right away, here are the pages you'll need:

- Administering Assets
- Working with object schemas
- Working with object types
- Working with objects
- Searching for objects
- Working with reports
- Importing your data

Advanced usage guides

If you're looking for advanced knowledge, including Assets app development, REST APIs and Java docs, see Advanced usage guides.
What is Assets?

You can jump right into Assets, but understanding what it's made of and how it's treating your data will make your future work easier. Here you'll find the most important concepts and information about useful features.

Jump to...
- Understanding your data in Assets
- Interacting with objects through requests
- Importing your data
- Reporting
- Searching and IQL

Understanding your data in Assets

To understand how your data is structured in Assets, you'll need to learn about its main building blocks.

Object schemas

An object schema is a collection of object types (groups of objects) and their attributes (fields), as well as underlying objects and references between them. It also includes your configuration items, such as roles, icons, statuses, and automation rules. Object schemas work like maps that hold all of it together, and are the first thing you'll create in Assets. In the Jira world, object schemas would be your projects, but you're not limited to one schema per project.

An empty object schema, without any object types or objects. A fresh start.

Learn more at Working with object schemas.

Object types

Once you have your schema ready, you'll create a set of object types that will group objects your actual assets. Rather than a single PC, your object types would be Computers, Hardware, Software, Employees, and so on. Object types can be whatever you want them to be as Assets is very open and flexible. In the Jira world, object types would be your issue types configuration (characteristics of bugs, incidents, problems).

An object schema with object types, but without objects yet
Learn more at [Working with object types](#).

**Attributes**

Attributes is what defines your object types (and underlying objects that use these attributes). They work like fields to which you add data. You’d choose attributes for your object types, and then the same attributes need to be filled in for underlying objects, whenever someone creates them. They come in different shapes and sizes: text, dates, references to other objects, and so on. In the Jira world, attributes would be issue fields or custom fields.

**Attributes defined for an object type Computers**

Learn more at [Adding attributes](#).

**Objects**

Objects are your actual assets. Every object is a digital representation of anything that you're mapping in Assets, be it a specific computer, employee, office they work at, or even a license for your software. You can create as many objects as you like, and group them within object types that represent their characteristics. In the Jira world, objects would be your issues or requests, and just like you wouldn't mix epics with bugs, you shouldn't put employees into hardware.

**Object schema with objects and their details defined through attributes**
Learn more at Working with objects.

References

References are types of attributes that let you create references to other objects. Information about a specific object can be useful, but viewing its relations and dependencies is even better. If you look at references of an employee, you know right away the office they work at, hardware they’re using, role they belong to, or mobile phone they’ve been assigned. You can view them in the graphical viewer that lets you see all of it at a glance. In the Jira world, references would be issue links (blockers, duplicates), but they serve a bit different purpose in Assets.

An employee with references to other object types and objects

Learn more at Viewing references.

While we’re at references, you can have two types:

Outbound references (outgoing)
Outbound references are attributes within an object that point to another object. For example, a Host object might have references to other important parts of its system, such as operating system, CPU, network interface, or scanning information.

Inbound references (incoming)

Inbound references are references that come from other objects. Each outbound reference creates an inbound reference on the object it's referencing, which lets you see how different objects are connected across your object schema.

For example, in the image above, you had the host Acturus referencing a number of CPUs, including one called Intel(R) Core (TM) i7-4700HQ CPU. If you clicked on this CPU reference, you'd see the object itself and a list of its inbound references, including the host Acturus.

Interacting with objects through requests

Having a database of assets is awesome, but there's a reason we've added Assets to Jira Service Management.
Showing object details on issues

You can add your objects to Jira issues through Assets custom fields. This could be adding the affected business service to your incident issues or adding a computer to a hardware request. Whatever you do, extra information about affected assets will give everyone involved more context.

Learn more at Adding Assets custom fields.

Affecting your objects

Have you noticed the **RUNNING** status on the screenshot above? Well, things break. Assets lets you add conditions, validators, and post functions to your workflow transitions so that your issues affect related objects when they transition through the workflow. And what about broken parts that can also be your objects? Decommissioned, for good.

Learn more at Adding Assets functions to workflows.

Importing your data

You're free to handle your objects however you like, but entering everything manually might not be the best idea if you have a lot of assets. To help you get going, we have several tools that will either scan your environment automatically or facilitate your manual imports.

Learn more at Importing your data.

Reporting
You can also use dynamic reports to view information about your object schema in a variety of formats.

Learn more at [Working with reports](#).

### Searching and IQL

Searching for and filtering objects in Assets is similar to Jira: you can use basic search (free text) or something that's called Assets Query Language. Although different in use, the idea behind it is similar to the Jira Query Language (JQL). By using IQL and placeholders, you can not only search for objects, but also create advanced queries and decide what objects should be included where.

Learn more at [Searching for objects](#).
Tutorial: Starting from scratch

This tutorial will guide you through the most important aspects of Assets, essentially taking you from zero to hero. Here's what you'll learn:

- Create a basic object schema
- Create object types
- Add attributes to object types
- Create objects for each object type
- Link your object schema to a Jira project
- Add your objects to Jira issues

Before you begin

The tutorial takes you through all the basic actions you'll need to know about in Assets. This, however, has some disadvantages:

- You'll be adding custom fields to screens in Jira, which requires admin permissions.
- You'll be creating object types, attributes, and objects manually, which might take some time.

If you don't have sufficient permissions (but can create projects) or want to see a schema pre-filled with data, you can also try the ITSM tutorial that uses sample data to create a nice object type schema.

In this tutorial

Here are all the steps you'll follow in this tutorial:

- 1. Build your first object schema
- 2. Create object types
- 3. Add attributes
- 4. Create objects
- 5. View object graphs
- 6. Link your object schema to a Jira project
- 7. Add object to your requests
1. Build your first object schema

An object schema is a collection of object types and their attributes, objects, and references between them. It also includes your configuration items, such as roles, icons, statuses, and automation rules. Object schemas work like maps that hold all of it together.

To create a new object schema:

1. In the Jira top navigation bar, select **Assets > Assets object schemas**.
2. Select **Create an object schema**.
3. Select **Empty object schema**, as shown below.

![Create Object Schema](image)

4. Give it a name, say “Resources”.
5. Select **Create** and voilà! You can now access your object schema under **Assets > Object schemas**.

Here’s some explanation for what you should be seeing on your screen:

1. **Object types**: When you start creating object types, they’ll appear here in a tree structure.
2. **Vertical menu**: Some actions for your schema. You can use it to expand or collapse the object type view, or create new object types.
3. **Create**: Here you’ll create your first object type.
4. **Object schema actions**: Some configuration and actions for your object schema.

Next up

When you’re ready, go to 2. Create object types.
2. Create object types

An object type groups objects that use the same kind of information, conveyed through their common attributes. Rather than a single PC, your object types would be Computers, Hardware, Software, Employees, and so on.

Create your first object type

To create the first object type:

1. In your object schema, select **Create**.
2. Call your object type **Company assets**. You can select an icon for the type and enter a description.
3. Set its parent to **None**. We'll make it an individual, stand-alone object type.

Here's what you should see:

1. **Object type**: Your first object type, congratulations!
2. **Attributes**: Default attributes (fields) created for your object type. We'll add some more in the next steps.
3. **Object type view**: Here you can switch between viewing objects, attributes, and a graph for your selected object type.
4. **Object type actions**: Here you can configure your object type, or create a new one.

To create another object type:

1. Select the **Object type** dropdown at the top-right, and select **Create**.
2. Call your object type **Server Type**.
3. Set its parent to **Company Assets**. It will be a child object type.
4. Select Object Type at the top-right, and again select **Create**.

Create some more

Create more object types, like shown in the image below. Set the parent for all these object types to **Company assets**.

<table>
<thead>
<tr>
<th>Parent object type</th>
<th>Child object types</th>
</tr>
</thead>
<tbody>
<tr>
<td>Company assets</td>
<td>Manufacturer</td>
</tr>
<tr>
<td></td>
<td>Location</td>
</tr>
<tr>
<td></td>
<td>Server Type</td>
</tr>
<tr>
<td></td>
<td>Server</td>
</tr>
<tr>
<td></td>
<td>Computer</td>
</tr>
<tr>
<td></td>
<td>Computer Type</td>
</tr>
<tr>
<td></td>
<td>Software</td>
</tr>
</tbody>
</table>
Here’s what your schema should look like after creating these object types. Hopefully you’ve picked better icons than we did:

![Diagram of a user object](image)

Next up

When you’re ready, go to 3. Add attributes.
3. Add attributes

Attributes are details that define your object types. You can view all attributes of an object type by selecting Attributes at the top-right. Assets creates a few default attributes when you create an object type.

View attributes for an object type

To view attributes:

1. When viewing an object type, switch to Attributes at the top-right.
2. You'll see the default attributes, and will be able to add new ones by adding them to the list.

![Attributes view](image)

Each attribute needs the following to be defined:

<table>
<thead>
<tr>
<th>Attribute value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name of your choice.</td>
</tr>
<tr>
<td>Type</td>
<td>Type of an attribute. Each type does a different thing, but we'll get to that with examples. Just to let you in on some secret, type Object would be responsible for linking to other objects.</td>
</tr>
<tr>
<td>Type value</td>
<td>Value for a type. The options here would depend on the type you've chosen. For example:</td>
</tr>
<tr>
<td>Additional value</td>
<td>This is some additional information for the attributes, and it also depends on the types you've chosen. For example, if you're configuring an attribute of type Object, in this field you'd specify a specific reference.</td>
</tr>
</tbody>
</table>

Add attributes to your object types

Now, to get a little practice, create attributes for all your object types as shown in the table below.

<table>
<thead>
<tr>
<th>Object type you have</th>
<th>Attribute name</th>
<th>Type</th>
<th>Type value</th>
<th>Additional value</th>
</tr>
</thead>
</table>

415
<table>
<thead>
<tr>
<th>User</th>
<th>Email Address</th>
<th>User</th>
<th>jira-users/any other group</th>
<th>Text</th>
<th>Location</th>
<th>-</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Phone Number</td>
<td>Default</td>
<td></td>
<td></td>
<td></td>
<td>-</td>
</tr>
<tr>
<td></td>
<td>Location</td>
<td>Object</td>
<td></td>
<td></td>
<td></td>
<td>Reference</td>
</tr>
<tr>
<td>Software</td>
<td>Manufacturer</td>
<td>Object</td>
<td>Manufacturer</td>
<td>Reference</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Manufacturer</td>
<td>Street Address</td>
<td>Default</td>
<td>Textarea</td>
<td>-</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Phone Number</td>
<td>Default</td>
<td>Text</td>
<td>-</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Server</td>
<td>Warranty Expires</td>
<td>Default</td>
<td>Date</td>
<td>-</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Manufacturer</td>
<td>Object</td>
<td>Manufacturer</td>
<td>Reference</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>System Owner</td>
<td>Object</td>
<td>User</td>
<td>Belongs</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Type</td>
<td>Object</td>
<td>Server Type</td>
<td>Type</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Location</td>
<td>Object</td>
<td>Location</td>
<td>Deployed</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Installed Software*</td>
<td>Object</td>
<td>Software</td>
<td>Installed</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Computer</td>
<td>Warranty Expires</td>
<td>Default</td>
<td>Date</td>
<td>-</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Manufacturer</td>
<td>Object</td>
<td>Manufacturer</td>
<td>Reference</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>RAM</td>
<td>Default</td>
<td>Text</td>
<td>-</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Type</td>
<td>Object</td>
<td>Computer Type</td>
<td>Uses</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Display Size</td>
<td>Default</td>
<td>Text</td>
<td>-</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>User</td>
<td>Object</td>
<td>User</td>
<td>Type (Enter &quot;Type&quot; to create a new reference type)</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

* Additionally, for the Server > Installed Software attribute, select the cog wheel at the far right and select **Configure**. Under the **Cardinality** tab, select the **Unlimited** checkbox. This allows you to specify more than one software installed on a server.

Next up

When you're ready, go to 4. Create objects.
4. Create objects

Objects are your actual assets. Every object is a digital representation of anything that you're mapping in Assets, be it a specific computer, employee, office they work at, or even a license for your software.

To create an object:

1. Select an object type.
2. At the top-right, select **Create object**. You'll need to specify its name and attributes. The required attributes will depend on the object type you've chosen.
3. Create objects based on the table below, and try to come up with some sample attributes.

<table>
<thead>
<tr>
<th>Object type</th>
<th>Objects</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Manufacturer</strong></td>
<td>Oracle</td>
</tr>
<tr>
<td></td>
<td>Atlassian</td>
</tr>
<tr>
<td></td>
<td>Apple</td>
</tr>
<tr>
<td></td>
<td>Microsoft</td>
</tr>
<tr>
<td></td>
<td>Dell</td>
</tr>
<tr>
<td></td>
<td>IBM</td>
</tr>
<tr>
<td></td>
<td>Hewlett Packard</td>
</tr>
<tr>
<td><strong>Software</strong></td>
<td>JAVA 1.8</td>
</tr>
<tr>
<td></td>
<td>Jira</td>
</tr>
<tr>
<td></td>
<td>Confluence</td>
</tr>
<tr>
<td><strong>Server Type</strong></td>
<td>Virtual, Physical</td>
</tr>
<tr>
<td><strong>Location</strong></td>
<td>New York</td>
</tr>
<tr>
<td></td>
<td>Stockholm</td>
</tr>
<tr>
<td></td>
<td>Madrid</td>
</tr>
<tr>
<td><strong>Computer Type</strong></td>
<td>Laptop</td>
</tr>
<tr>
<td></td>
<td>Desktop</td>
</tr>
<tr>
<td><strong>User</strong></td>
<td>[Your Name]</td>
</tr>
<tr>
<td><strong>Computer</strong></td>
<td>MacBook Pro (15&quot;)</td>
</tr>
<tr>
<td></td>
<td>MacBook Air (13&quot;)</td>
</tr>
<tr>
<td></td>
<td>ThinkPad (15&quot;)</td>
</tr>
<tr>
<td></td>
<td>Latitude (15&quot;)</td>
</tr>
<tr>
<td></td>
<td>Vostro (13&quot;)</td>
</tr>
<tr>
<td><strong>Server</strong></td>
<td>Dell PowerEdge VRTX</td>
</tr>
<tr>
<td></td>
<td>HPE ProLiant DL580 Gen9</td>
</tr>
</tbody>
</table>

And some explanations once you're done creating objects:
1. **Object count**: Now your object types show the number of objects they contain.
2. **Objects**: Objects from the selected object type.
3. **View**: Switch between the different view types.
4. **Details**: Here, you can switch between the detail view and the list view.
5. **Print label** and **Print QR code**: You can print a label or QR code and put it on your physical asset. When you scan the label or code, the asset details will open in Jira.

Next up

When you’re ready, go to 5. **View object graphs**.
5. View object graphs

References are types of attributes that let you create references to other objects. Information about a specific object can be useful, but viewing its relations and dependencies is even better. You can do it by using a graphical viewer.

Object schema graph

To view a graph for your object schema:

1. At the top-right, next to the object schema configuration, select **Graph**.
2. You’ll see the object schema graph. It lets you see how all object types are knitted together.

Object type graph

To view a graph for your object type:

1. Select an object type, and select **Graph** next to the object type configuration.
2. You’ll see the object type graph. It should help you see your object type’s relations with other object types. You can select other object types to see their graphs.

Object graph

To view a graph for your object:

1. Select an object and select **Object graph**, just below its name in the detail view.
2. You'll see the object graph that shows your object's relations with other objects and object types. Here you can additionally switch to the Tree view.

Next up

When you're ready, go to 6. Link your object schema to a Jira project.
6. Link your object schema to a Jira project

You can link your object schema to Jira project by adding Assets custom fields to the right screens. These will let you select your objects when creating or editing issues.

Create a custom field

You'll include objects in your issues by adding a custom field to relevant screens. This custom field will then pull data about your objects (you'll limit the data to only specific objects or object types). In this example, we'll add all objects from the Server object type to the Create Issue screen.

1. In Jira, go to Administration > Issues > Custom fields.
2. Select Add custom field.
3. Select the Assets object field.
4. Name it "Affected Server", and add it to the Create issue screen for your project. You can add it to other screens, too.

Configure the custom field

Now, let's limit this custom field to show only a specific object type.

1. Select More (…) in the Actions column of your custom field (on the Custom fields page), and select Configure.
2. Select Edit Assets configuration.
3. Define the following:
   • Object schema: Mindville resources (or any other that you created)
   • Filter scope (AQL): objecttype = Server
   • Type of interaction: Select.
   • Object attributes in issue view: Select which attributes of Server you'd like to see in an issue when you create it.
### Configure Assets Custom Field - Affected Server (customfield_10133)

<table>
<thead>
<tr>
<th>Scope</th>
<th>Resources</th>
</tr>
</thead>
<tbody>
<tr>
<td>Object Schema</td>
<td>Resources</td>
</tr>
<tr>
<td>Filter Scope (AQL)</td>
<td>objecttype = Server order by label ASC</td>
</tr>
<tr>
<td>Filter Issue Scope (AQL)</td>
<td>Not configured</td>
</tr>
<tr>
<td>Filter Assign Scope (AQL)</td>
<td>Not configured</td>
</tr>
<tr>
<td>Make Filter Assign Strict</td>
<td></td>
</tr>
</tbody>
</table>

#### User Interaction

<table>
<thead>
<tr>
<th>Type of interaction</th>
<th>Select Checkbox / Radio button</th>
</tr>
</thead>
<tbody>
<tr>
<td>Filter objects with attributes</td>
<td>Label</td>
</tr>
<tr>
<td>Object attributes on Issue view</td>
<td>Name × User × Location × Installed Software × System Owner ×</td>
</tr>
<tr>
<td>Multiple</td>
<td></td>
</tr>
<tr>
<td>Option to add all objects</td>
<td></td>
</tr>
</tbody>
</table>

#### Jira Service Management

<table>
<thead>
<tr>
<th>Show object picker on customer portals</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Force to show on Customer Issue details</td>
<td></td>
</tr>
</tbody>
</table>

**Next up**

When you're ready, go to [7. Add objects to your requests.](#)
7. Add object to your requests

With Assets custom fields added to the right screens, you should be able to use them to select your objects.

Create a Jira issue

Create a Jira issue (make sure you've added your field to the Create issue screen for your project). You should be able to see your field like this:

1. **Object picker**: These little icons let you browse Assets objects or create new ones directly from your issue.

View object details on your issue

Once you created your issue, you should see your custom field on it, as shown below:

Create a request from the customer portal

To test your custom field on a customer request, select Raise a request in the left panel. Select "Desktop /Laptop Support", and check if your custom field is available on the form.
That's it for this tutorial

Well done, legend! You're now familiar with the basics of Assets and can easily start working with your objects. If you'd like to dive a bit deeper and see how requests can affect your objects, head on to the next tutorial.

- Tutorial: How Jira issues affect Assets objects (ITSM)
Tutorial: How Jira issues affect Assets objects (ITSM)

Let's dive into how to create a sample IT Service Management (ITSM) project and use it to automate and simplify a typical ITSM problem.

In this tutorial, you'll use the ITSM template, pre-populated with sample data, issue types (incident, problem, change) to see an end-to-end ITSM process. You'll also see how Assets functions can work with Jira workflows and affect objects when a related issue is transitioned through a workflow.

In this tutorial

Here are all the steps you'll follow in this tutorial:

- 1. Create an ITSM project
- 2. Create an incident
- 3. Work on the problem
- 4. Work on the change
1. **Create an ITSM project**

Let's start by creating a new project based on the Assets' ITSM template, and include some sample data for our tutorial.

- In Jira, the template will create issue types, issue type scheme, workflows, workflow scheme, screens, screen scheme, and issue type screen scheme. Everything you need.
- In Assets, the template will create an object schema, object types with attributes, and object type references.

Since we'll create an ITSM template with sample data, a few Jira issues and Assets objects are also created and linked together.

**Create your project**

To create a sample project:

1. In the top menu, select **Projects > Create project**.
2. At bottom, select **Create sample data**.
3. Under the **Business** header, select the **Assets IT Service Management** template.
4. Review the issue types and custom fields that will be created and select **Select**.
5. Enter a **Name**, **Key**, and **Project Lead** for the project.
6. Select **Submit** to create the project.

**View your project's object schema**

Your sample project comes together with an object schema in Assets. Here's how to view it:

1. In the top navigation bar, select **Assets**, and select your schema. The name will be similar to the project you created.
2. Feel free to play around with the sample data. Check your object types and their attributes, use the visual graph to see the relations between objects.

**Object types**: List of object types in your schema.

**Objects**: Selected object type, its child objects, and object details in the main panel.

**Object schema actions**: Here you can configure your object schema.

**Object type actions**: Here you can configure the selected object type, and switch between viewing its objects, attributes, or the visual graph.

Next up
When you're ready, let's get some work done! Go to 2. Create an incident.
2. Create an incident

After you've created your project, you can start working on it right away. Let's imagine we're working as frontline support, and we're reporting an incident.

Create an incident

1. Create an issue in your project, and set its type to Incident.
2. Write a summary. Let's say, "I can't send emails".
3. Set the Affected business service field to Email service. What you're doing here is actually choosing the affected Assets object.

If you look at the incident you created, you can see that it's linked to an object in Assets. The details of your affected email service automatically appear in the Affected business service field.

Related workflow

Here's the workflow that your project uses for incidents, just so you know how the incident will move through it. You can always view it in Project settings > Workflows.
Get the work going

Let's transition the incident through it's workflow to see what happens to the Assets objects.

1. **Confirm the incident**
   1. Select **Confirm incident** to confirm it and proceed through the workflow. The status of the affected object changes to Incident in progress.
   2. Select **Investigate incident** to start the work. The status of the issue will change.

   <Details>
   - **Type:** Incident
   - **Priority:** Low
   - **Status:** WORK IN PROGRESS
   - **Resolution:** Unresolved
   - **Affected Business Service:** Email Service
     - Status: INCIDENT IN PROGRESS
     - Business Service Owner: Wes Shults
     - Service Group Phone: +46 3284 234 442
     - Importance: Critical

2. **Investigate the incident**
   1. Let's assume that you found the culprit, which is hardware failure. Select **Hardware failure**.
2. Select the **Related Server** that you suspect is the source of the incident and confirm. The current user (you) will be automatically assigned to investigate.

![Hardware failure](image)

3. Now that you’ve identified the culprit, the **Related server** from Assets is also linked to the Jira issue. Post-functions built into the template have updated the status of the **Affected business service** and **Related server**.

![Details](image)

3. **Investigate failure**

   1. Proceed to **Investigate failure**.
   2. When enough information has been gathered, resolved the issue with **Resolve**. This indicates that you have determined the incident's cause or that you were unable to reproduce the failure.
3. For the sake of the example, let's assume you can reproduce the incident and have an idea of what's causing it. Change the issue state to **Report problem** to create a new issue of issue type **Problem** to begin tracking the underlying cause of this incident.

Next up

When you're ready to solve some problems, go to 3. **Work on the problem.**
3. Work on the problem

Typically, this is where the role of the front-line support ends. A higher-level support representative might take over the new Problem issue, which has its own workflow, reporter and assignee, but includes the information about the affected Assets objects, inherited from the incident.

Where's the problem?

You can see the newly created problem in the issue links of your incident. Select it to see what's it all about.

You should be moved to the problem issue:

![Problem Issue](image)

**Related workflow**

Here's the workflow for the Problem issue type, just so you know how your issue will move through it. You can always view it in Project settings > Workflows.
Get the work going

1. Investigate the problem
   
   1. Select **Review** and later **Investigate**. This will move your problem right into the investigation state.
   2. During the investigation, the assignee could find a component or system that needs to be changed - for example, the problems with the exchange server might be caused by a faulty network card. The assignee would change the ticket status to **REQUEST FOR CHANGE** and select the faulty component.

2. Request for change

   1. Select **Request for change**.
   2. Select the component that you think is affected from the drop-down list. It will be the job of another person to replace it. In this tutorial, it will be you.

<table>
<thead>
<tr>
<th>Request for change</th>
</tr>
</thead>
<tbody>
<tr>
<td>Summary</td>
</tr>
<tr>
<td>Affected Server</td>
</tr>
<tr>
<td>Affected Server Components</td>
</tr>
<tr>
<td>Issue Type</td>
</tr>
<tr>
<td>Reporter</td>
</tr>
</tbody>
</table>

Start typing to get a list of possible matches.
3. You've selected the faulty component and the status of the issue is now Waiting for change. The affected business service, server, and component are all linked to the issue.

Next up

When you're ready to get your hands dirty, go to 4. Work on the change.
4. Work on the change

When the Problem issue reaches the Waiting for change status, the new Change issue will be created automatically through Assets automation. Since this ticket requires on-site hardware changes, the support representative managing the Problem ticket might hand this ticket over to the server owner to make the changes.

Where's the change?

Again, you can see the newly created change in the issue links of your problem. Select it to see the details.

Related workflow

Here's the workflow for the Change issue type, just so you know how your issue will move through it. You can always view it in Project settings > Workflows.

Get the work going

Approve the change and find a replacement

1. Select Approve to approve the change. Here you'll be able to select a replacement component for the malfunctioning server.
2. If there are any available server components identified, they will appear in the dropdown list. But, let’s say there aren’t any and create a new one by selecting Create an object in the dialog.

Create Object

<table>
<thead>
<tr>
<th>Object Type</th>
<th>Network Interface</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>TP-LINK TG-3468</td>
</tr>
<tr>
<td>ID</td>
<td>34366</td>
</tr>
<tr>
<td>Server</td>
<td></td>
</tr>
<tr>
<td>Status</td>
<td></td>
</tr>
</tbody>
</table>

3. After you’ve created the object, select it in Available server component and progress through the workflow until we reach the Implementing state.

4. You’ll notice when we are implementing the change, the Affected server is automatically stopped.

Complete the change

1. Select Change completed. Here’s what happens when you do it:
   - The change ticket is Resolved
   - The Resolution is Done
   - The faulty server component is changed to Decommissioned
   - The Affected Server is running again
   - The server component linked to the server is updated to show the new network card

2. And above all, the change request is resolved.
3. Similarly, the **problem** is automatically updated and closed.

4. Just like the **incident** that started it all.

That's it for this tutorial.
The IT Service Management (ITSM) template is only an example of how you can structure your ITSM practices with Assets and Jira. Feel free to use this template, modify it, or start your own from scratch.
Administering Assets

From Assets roles and permissions to configuring Assets custom fields and functions, and making them work with Jira, here you'll find administering tasks that will set up your team for success.

Get started with administering Assets

Here's a list of pages to get you started:

- Installing Assets
- Configuring roles and permissions
- Configuring global Jira settings
- Configuring global Assets settings
- Adding Assets custom fields to screens in Jira
- Enabling Assets custom fields on customer portals
- Adding Assets functions to workflows in Jira
- Adding approvers from Assets to requests in Jira
- Importing and exporting object schemas
- Assets REST API documentation
- Advanced usage guides
- Upgrading Insight with Jira Service Management
Installing Assets

If you're using Jira Service Management Data Center 4.15 or later, Assets is already included and there's no need to download anything. You can find it by selecting Assets in the top Jira navigation.

If you're using Jira Service Management Data Center 4.14 or earlier, you can install the Assets app for free from the Atlassian Marketplace.

Assets is available also for Jira Software Data Center users, but some restrictions apply depending on your Jira version. See our FAQ for details.

Install the app

To install the Assets app from Atlassian Marketplace:

1. Log into Jira as an admin.
2. Select Administration > Manage apps.
4. The appropriate app version appears in the results.
5. Follow the instructions to install the app. If you're on Data Center, this version won't need any license.
6. You'll be prompted to log into MyAtlassian and Assets will begin to download.
7. Once downloaded, you'll see Assets in the top Jira navigation.

System requirements

We strongly believe that your Data Center instance will pull it off, but here's some system requirements, just in case.

Make sure that Jira is configured to handle the amount of data you plan to import into Assets. If you plan to use a lot of scheduling tasks and import a large amount of data we recommend that you follow the table below.

Remember to always test the memory consumption in a test environment for a huge data set, because it's not always the number of objects, but the content of the object attributes as well at play.

<table>
<thead>
<tr>
<th>Objects in Assets</th>
<th>JVM memory (minimum)</th>
<th>JVM memory (recommended)</th>
</tr>
</thead>
<tbody>
<tr>
<td>~ 1,000,000</td>
<td>16 GB</td>
<td>20 GB</td>
</tr>
<tr>
<td>~ 2,000,000</td>
<td>20 GB</td>
<td>25 GB</td>
</tr>
<tr>
<td>~ 5,000,000</td>
<td>40 GB</td>
<td>50 GB</td>
</tr>
<tr>
<td>~ 6,000,000 + 700k issues with connections</td>
<td>50 GB</td>
<td>60 GB</td>
</tr>
<tr>
<td>~ 8,000,000 + 800k issues with connections</td>
<td>70 GB</td>
<td>90 GB</td>
</tr>
</tbody>
</table>

On large installations of Assets, there are some options you can tweak to increase performance.

**Garbage collection**

To decrease the pause time we recommend that you switch the garbage collection (GC) algorithm to G1 from the default. You can configure it by adding the following JVM argument to your Jirasetenvscript.

```
-XX:+UseG1GC
```
Based on your environment, other options to tune the G1 may be required. Check out the information from Oracle (http://www.oracle.com/technetwork/tutorials/tutorials-1876574.html) and tune your JVM based on your requirements.

Assets executes tasks in parallel (e.g. reindex, imports). On a large instance, you can increase the number of threads that perform the tasks. You can see this here: Configuring global Jira settings. By default, the parallelism is configured to be equal to the amount of cores available to the JVM.

**Database pool**

If you have increased the number of threads (Assets parallelism), it is recommended to check the database connection pool monitor and determine if an increased connection pool is required as well.

**Jira shutdown**

On Jira shutdown Assets persists the index on disk for faster startup. In large instances, the index file fails to be saved on disk in time before the force shutdown command is sent. This will cause Assets to do a database reindex on each startup. To prevent this change, you need to change the timeout on force shutdown in the stop-jira script.

Change the value 20 (the unit is seconds) to a value that is more reasonable based on the amount of data in your installation. Below is a snippet from the standard Jira stop-jira.sh and it is the value that should be changed at two places.

```bash
if [ -z "$JIRA_USER" ] || [ $(id -un) == "$JIRA_USER" ]; then
    echo executing as current user
    exec $PRGDIR/shutdown.sh 20 -force $@
elif [ $UID -ne 0 ]; then
    echo JIRA has been installed to run as $JIRA_USER so please sudo run this to enable switching to that user
    exit 1
else
    echo executing using dedicated user
    if [ -x "/sbin/runuser" ]; then
        sucmd="/sbin/runuser"
    else
        sucmd="su"
    fi
    $sucmd -m $JIRA_USER -c "$PRGDIR/shutdown.sh 20 -force $@
fi
```

If you have configured your heap with the CATALINA_OPTS in setenv, make sure that the JVM configuration (JVM_MAXIMUM_MEMORY) is not the same value as the max heap configured in CATALINA_OPTS.

If you are using Assets to accommodate millions of objects and plan to use importers heavily, (e.g, with the Asset Discovery product), then we recommend that you move to Data Center version if you're not already using it. This will offer you the possibility to isolate the importers to only one import node with the other nodes being the user nodes. With one import node, the import process will have less impact on user interaction. It will also be more robust since any failing import or any over consumption of memory will only affect the import node and not any of your user nodes.

It is difficult for us to set any exact object size or import size recommendation since it's about the data stored on your objects, as well as how often the imports occur. But in general, when reaching millions of objects or memory usage over 32 Gb or if you don't ever want to impact any user interaction, then you should consider using the Data Center version of Assets.
During imports and re-index with Data Center, we need to send messages to other nodes to update the index. This is done through provided Atlassian functionality and the `clustermessage` table is the DB table where all nodes push and pull. The problem we have seen is that Atlassian have a retention period of 30 days for this table. We think this is a bit too much and recommend that you should remove all Assets related data rows which are older than 24 hours with your own retention scripts.

Next steps

Head on right into Administering Assets.
Configuring roles and permissions

Learn about roles and permissions available in Assets, and how to grant them to specific users or groups. At the bottom of the page, you can also find a detailed permission matrix that will tell you how permissions correspond to tasks that users can perform.

Roles

A role is a set of permissions granted to Jira users or groups to view or modify data in Assets. Here's a summary of available roles:

<table>
<thead>
<tr>
<th>Role</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Assets Administrator</strong></td>
<td>This role can perform all actions in Assets. This includes:</td>
</tr>
<tr>
<td></td>
<td>• Configuring Assets globally</td>
</tr>
<tr>
<td></td>
<td>• Managing individual schemas</td>
</tr>
<tr>
<td><strong>Assets Managers</strong></td>
<td>This role can execute the following tasks on an object schema. This includes:</td>
</tr>
<tr>
<td></td>
<td>• Configuring all schema details</td>
</tr>
<tr>
<td></td>
<td>• Viewing objects</td>
</tr>
<tr>
<td></td>
<td>• Searching for objects using basic and advanced search</td>
</tr>
<tr>
<td></td>
<td>• Creating and editing objects</td>
</tr>
<tr>
<td></td>
<td>• Exporting objects</td>
</tr>
<tr>
<td></td>
<td>• Printing QR codes and labels</td>
</tr>
<tr>
<td><strong>Assets Developers</strong></td>
<td>This role means builders or creators, rather than e.g. software developers. It can execute the following tasks on an object schema:</td>
</tr>
<tr>
<td></td>
<td>• Viewing objects</td>
</tr>
<tr>
<td></td>
<td>• Searching for objects using basic and advanced search</td>
</tr>
<tr>
<td></td>
<td>• Creating and editing objects</td>
</tr>
<tr>
<td></td>
<td>• Exporting objects</td>
</tr>
<tr>
<td></td>
<td>• Printing QR codes and labels</td>
</tr>
<tr>
<td><strong>Assets Users</strong></td>
<td>This role can do the following on an object schema:</td>
</tr>
<tr>
<td></td>
<td>• Viewing objects</td>
</tr>
<tr>
<td></td>
<td>• Searching for objects using basic and advanced search</td>
</tr>
<tr>
<td></td>
<td>• Exporting objects</td>
</tr>
<tr>
<td></td>
<td>• Printing QR codes and labels</td>
</tr>
</tbody>
</table>

Permission levels

Assets offers three levels of permissions:

<table>
<thead>
<tr>
<th>Level</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Global permissions</strong></td>
<td>These permissions allow you to configure the entire Assets app.</td>
</tr>
<tr>
<td></td>
<td>By default, as part of Global permissions, the <em>jira-administrators</em> group is mapped to the Assets administrator role. So, if you're a Jira administrator for your Jira instance, then you can perform all actions in Assets.</td>
</tr>
<tr>
<td></td>
<td>However, if you remove this default mapping, then you wouldn't be able to execute tasks despite of being a Jira administrator.</td>
</tr>
</tbody>
</table>
Object schema permissions

These are permissions to configure and execute actions on the object schema level.

Object type permissions

These are permissions to execute actions on an individual object type. You can view a detailed matrix of all tasks and corresponding permissions at the bottom of this page.

Granting permissions

Assets automatically grants the Assets Administrator role to all Jira admins. However, it might not inherit permissions from any particular active directory running on your Jira instance.

⚠️ You need to be a Jira admin to be able to assign users or groups to a specific role in Assets.

Granting global permissions

1. In the top navigation bar, select **Assets > Configure**.
2. Switch to the **Roles** tab.
3. Assign users or groups to the administrator role.

Granting object schema permissions

1. In the top navigation bar, select **Assets > Object schemas**.
2. Open your object schema.
3. In the top-right, select **Object schema > Configure**.
4. Switch to the **Roles** tab.
5. Assign users or groups to the roles.

Granting object type permissions

1. Open your object type.
2. In the top-right, select **Object type > Configure**.
3. Switch to the **Roles** tab.
4. Assign users or groups to the roles.

Good to know

- Object type permissions take precedence over object schema permissions. For example, a user might be assigned to the User role on the schema (to not make any changes), but then have a more powerful Developer role on a specific object type, so they can create objects.
- If you want users to work with object types (and objects) you need to grant them permissions for object types, but also for the schema (at least User permissions, so they can view it). Without giving them any permissions for the schema, they won’t be able to access it.
- If you don’t specify permissions for object types, they will be inherited from the object schema.

Permission matrix

Here’s how roles relate to specific actions users can complete.

<table>
<thead>
<tr>
<th>Assets functions</th>
<th>Assets Users</th>
<th>Assets Developers</th>
<th>Assets Managers</th>
<th>Assets Administrators</th>
<th>Jira Administrators</th>
</tr>
</thead>
<tbody>
<tr>
<td>Report Jira issues on Assets objects</td>
<td>✔️</td>
<td>✔️</td>
<td>✔️</td>
<td>✔️</td>
<td>✔️</td>
</tr>
<tr>
<td>Search for Assets objects and attributes</td>
<td>✔️</td>
<td>✔️</td>
<td>✔️</td>
<td>✔️</td>
<td>✔️</td>
</tr>
</tbody>
</table>

Created in 2023 by Atlassian. Licensed under a Creative Commons Attribution 2.5 Australia License.
<table>
<thead>
<tr>
<th>Function</th>
<th>1</th>
<th>2</th>
<th>3</th>
<th>4</th>
<th>5</th>
</tr>
</thead>
<tbody>
<tr>
<td>View object graph explorer</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>View object type graph explorer</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>View Assets custom field</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Create/Edit Assets objects</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Move objects (Object Type To)</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Note that this function applies to roles on the Object type level</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Move objects (Object Type From)</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Note that this function applies to roles on the Object type level</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Delete Assets objects</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Create/Edit/Delete attributes</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Modify Assets object schema</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Delete Assets object schema</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Create Assets object schema</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Manage icons</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Manage references</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Import object schemas</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Create/Configure/Enable imports</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Manage global Assets permissions</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Create/Manage Assets custom field</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Move object type (drag &amp; drop)</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Delete object type</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Add/edit Assets post-functions in Jira workflows</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
</tbody>
</table>
Configuring global Jira settings

Global Jira settings for Assets include configuration for the Assets app itself, rather than object schemes, object types, or even objects. Here you can configure log settings, date and time, Assets reindexing, and so on. Read on for more details on available settings.

Accessing global Jira settings

To access global Jira settings for Assets:

1. Go to Administration > Manage apps.
2. Look for pages in the Assets section.

General configuration

To open general configuration, select Assets configuration.

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
<th>No</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>User interaction</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Attribute default label</td>
<td>The text type attribute to be used as default label for every object type. You can change this on the specific object type configuration too. Note that this affects only for those object types that are created after this setting has changed.</td>
<td>No</td>
</tr>
<tr>
<td>Attribute default description</td>
<td>The description for the default label attribute. You can change this on the specific object type configuration too.</td>
<td>No</td>
</tr>
<tr>
<td>Open Object dialog event</td>
<td>Determines if the object dialog should open when a user selects an object link or when the user hovers with the mouse over an object link. This will also apply when you view Assets object fields while you view a Jira issue.</td>
<td>No</td>
</tr>
<tr>
<td>Default number of objects fetched in custom fields</td>
<td>This indicates the number of objects that Assets will fetch in custom fields for each request. The default value is set to 25. Once the user starts to search any objects on the custom field, more objects matching the search criteria are fetched from server asynchronously. Hence, the default limit of 25 is recommended and should be enough. If you increase this number, it will affect the performance since more objects would then have to be fetched on every request.</td>
<td></td>
</tr>
<tr>
<td>General configuration</td>
<td>This will ensure that on start up, Assets index will be restored from a file. This will help increase the startup time. Assets will perform a consistency check of the file against the database on startup and recreate the index if they mismatch. If you uncheck this, you may experience a slower start up time. However, it could remove the risk of a potential corrupted index file which may cause data inconsistency. By default, this is checked. The file is located at {$JIRA_HOME/caches/assets_indexes} E.g, path of the file on MacOS will be {/var/atlassian/application-data/jira/caches/assets_indexes}</td>
<td></td>
</tr>
<tr>
<td>Include attribute values in audit log</td>
<td>This checkbox is enabled only if the above &quot;Assets Audit Log enabled&quot; is checked. If checked, this will include all attribute values of an object in the audit log.</td>
<td></td>
</tr>
<tr>
<td>Restore Assets index from file</td>
<td>This indicates that the Assets index should be persisted to a file on Assets shutdown (e.g, in cases of a plugin upgrade, Jira restart, Assets disable etc). It is recommended that if &quot;Restore Assets index from file&quot; is checked, this property should be switched on too.</td>
<td></td>
</tr>
<tr>
<td>Store cache on shutdown</td>
<td>This helps to limit the amount of objects allowed to be stored in Assets. This will subsequently limit the memory footprint by allowing only a limited number of objects to reside in the cache. The default and recommended way to use Assets is to not restrict objects in cache. The limit will have negative performance impact.</td>
<td></td>
</tr>
<tr>
<td>Number of objects allowed in cache</td>
<td>This is enabled only if &quot;Restrict Assets Cache&quot; is checked. This property indicates the number of Assets objects that will be be stored in the cache. The recommended way is to not limit objects in cache.</td>
<td></td>
</tr>
<tr>
<td>Maximum File upload size</td>
<td>The maximum file upload size in bytes when uploading files, images, attachments into Assets.</td>
<td></td>
</tr>
<tr>
<td>Assets parallelism</td>
<td>This is number of threads that Assets will spawn to perform parallel tasks, e.g, importing data, re-indexing etc. If this number is set to a lower value, Assets will put less strain on Jira. However, it will come at the cost of a low performance speed.</td>
<td></td>
</tr>
<tr>
<td>Process data sources via temp files during imports</td>
<td>Temporarily store data on disk when using the import modules to reduce memory footprint during import.</td>
<td>No</td>
</tr>
<tr>
<td>Use a custom locale for Assets</td>
<td>This is used to indicate if the data stored in Assets should be sorted by a locale other than Jira's default one. Fetching of objects may be slower if this option is switched on. Hence, by default, this is disabled to avoid performance issues.</td>
<td>No</td>
</tr>
<tr>
<td>The locale for Assets</td>
<td>This is enabled only if &quot;Use a custom locale for Assets&quot; is checked. This determines the language Assets should use when sorting data.</td>
<td>No</td>
</tr>
<tr>
<td>Service Desk portal search text (single)</td>
<td>Placeholder for the Assets field on the Jira Service Desk portals (Single fields)</td>
<td></td>
</tr>
<tr>
<td>Service Desk portal search text (multi)</td>
<td>Placeholder for the Assets field on the Jira Service Desk portals (Multiple fields)</td>
<td></td>
</tr>
</tbody>
</table>
| Dedicated Scheduling Node | This node will be the dedicated node to execute Assets scheduling tasks, such as Importers, Automation, etc. Notethat, if a node was selected as the dedicated scheduling node and happens to be unavailable at the time of running a scheduled task, then that task will
| |

**Date settings**

All dates in Assets use the Jira administrator settings, and can be changed under the following URL:

https://host:port/secure/admin/AdvancedApplicationProperties.jspa

**Log files**

Logs are located in the following directory:

<Jira-shared-home>/log

**Attachments**

Assets attachments are stored accordingly in subfolders named avatars, files, icons, and objects in the following directory:

<Jira_home>/data/attachments/assets

**Indexing**

To open indexing configuration, select Indexing Assets.
You can select from the following options for indexing:

- **Clean re-index**
  A clean re-index means that all objects will be removed from the index, and then will be indexed again. This is recommended if you want to have a fresh state of the index. Once the indexing is in progress, you won’t be able to search for objects or filter them.

- **Re-index**
  A re-index means that all objects will stay in the index during the process, and Assets will index them again. You can search for objects during the process.

- **Persist Assets index to file**
  You can manually persist (copy) the index on your disk. This is useful if you have a big Assets environment with a large number of objects and are planning to reinstall the app. With the index on your disk, Assets won’t have to recreate it from scratch.

### Testing Groovy scripts

To test Groovy scripts, select **Assets script console**. It gives you a quick and easy way to test Groovy scripts that you want to use in Assets automation or post-functions.

### Syncing reports

To open reports syncing configuration, select **Assets reports**. Here you can set up a cron schedule, which syncs the data in your reports.
Analytics

To open analytics configuration, select **Mindville analytics**.

Additional Data Center configuration

**Configure data retention period for clustermessage table**

Configuring the data retention period helps you avoid performance issues that might result from overloading the `clustermessage` table. If you import large data sets to Assets in a short period of time, the `clustermessage` table will be filled with information and can cause performance issues.

To configure the data retention period, complete the following steps:

1. Go to **Administration > System**.
2. Scroll down to the **Advanced** section and select **Services**.
3. Under **Add Service**, under **Class**, select **Build-in services**.
4. Select **Cluster messaging flush service**.
5. Enter the following information:
   a. **Name**: Cluster Messaging Flush Service
   b. **Class**: com.atlassian.jira.service.services.cluster.ClusterMessageCleaningService
   c. **Schedule**: -0 0 4/12 * * ?
6. Select **Add Service**.
7. Enter the following for **Retention Period**: -2880m
8. Select **Update**.
## Services

<table>
<thead>
<tr>
<th>Name</th>
<th>Class</th>
<th>Schedule</th>
<th>Edit</th>
<th>Delete</th>
</tr>
</thead>
<tbody>
<tr>
<td>Mail Queue Service</td>
<td>core.atlassian.jisservices.email MailQueueService</td>
<td>0 * * * *</td>
<td>Edit</td>
<td>Delete</td>
</tr>
<tr>
<td>Audit log cleaning service</td>
<td>core.atlassian.jisservices.auditing.AuditLogCleaningService</td>
<td>Daily at 12:00 am</td>
<td>Edit</td>
<td>Delete</td>
</tr>
<tr>
<td>Backup Service</td>
<td>core.atlassian.jisservices.expert.BackupService</td>
<td>0 0 0 12 * * *</td>
<td>Edit</td>
<td>Delete</td>
</tr>
</tbody>
</table>

**Add Service**

Add a new service by entering a name and class below. You can then edit it to set properties. Mail handlers should be added or edited via our new incoming mail section.

**Name**

- Built-in Service
- Debugging service
- Indexing service
- Replicated index flush service
- Queue messaging flush service
- Audit log cleaning service

**Schedule**

- Daily
- Days per Week
- Days per Month
- Advanced

**Interval**

- once per day

The current server time is 16:05:25 16:45 AM - Coordinated Universal Time.
Configuring global Assets settings

Configuring global Assets settings allows you to choose base references, statuses, and permissions for users. These can be later available when creating object types and objects.

To access global Assets settings:

1. In the top navigation bar, select **Assets > Configure**.
2. Switch tabs to configure the settings you need. You can read more about them below.

References

Objects can have references to other objects, and here is where you create, edit, and delete those references on a global level (additional references can be configured in specific object schemes). You can name a reference, specify an outward and inward description, as well as set a color that will be used by the reference arrows in the object graph.

Statuses

Objects can have statuses that represent a special attribute type. For example, you can add the attribute **Status** to your object and set it to **Active**. Through automation, this status will change to e.g. **Inactive** when a specific event occurs. Here you can configure global statuses, and set their category to Active, Inactive, or Pending. These statuses will be available to use as attributes in objects.

Good to know:

- You should see the status categories as their state. For example, a new status called **Running** would most likely belong to the **Active** category, while **Broken** to **Inactive**.
Global permissions

As a member of the Jira-administrators group, you can specify who should have administrative permissions in Assets. Based on the role users have (User, Manager, Developer, Administrator), they might only be able to view existing objects, or also create new objects, object types, and even object schemes. It really depends on how your company works; probably there will be a set of people responsible for creating objects, while the rest can only view them and raise requests against them.

For more info about what each role can do, see Roles and permissions.

Importing and exporting object schemas

Here you can import an existing object schema or export that one you're using. This is useful if you'd like to create a backup or have an existing schema in a different instance of Assets.

For more info, see Importing and exporting object schemas.
Adding Assets custom fields to screens in Jira

You can have your objects displayed in Jira issues by adding Assets custom fields to Jira screens (just like you would with your usual Jira custom fields). This could be adding the affected business service to your incident issues, adding a computer to a hardware request issue, or adding a set of potentially affected hosts to a change request issue.

Quick overview

Here's a video on Assets custom fields if you'd like get a quick overview:

Creating Assets custom fields

You can create three types of custom fields: Default, Referenced, and Readonly.

- Default Assets custom field
- Referenced Assets custom field
- Read-only Assets custom field

Enabling access for customers

When you add Assets custom fields to Jira Service Management, you need to enable them for customer portals. Without these steps, customers won't be able to access these fields. Learn more about enabling Assets custom fields on customer portals
**Default Assets custom field**

The default Assets custom fields gives you the most flexibility, and is what you'll use in most cases. When you're looking to add objects to issues while creating them, the default custom fields will help you achieve that.

Create a default custom field

To create the default Assets custom field:

1. Log in to Jira as an admin.
2. Go to Administration > Issues > Custom fields.
3. Select Add custom field > Advanced.
4. Search for Assets object/s, and select it.
5. Enter a name and description for your field.
6. Once created, associate the custom field with desired screens in Jira.

The Assets default custom field is now created and associated with the right screen in Jira. Now, you need to configure this field so it allows your users to choose specific objects.

Configure the default custom field

With your custom field created and associated with the right screens in Jira, you can now configure how it will behave.

1. Find your custom field on the Custom fields page, and select Configure next to it.
2. Select Edit Assets configuration.
3. Select which object schema the custom field should use.
4. Configure other settings. You can check what they mean in the table below.

<table>
<thead>
<tr>
<th>Scope</th>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Object Schema</td>
<td>PROJ - ITSM</td>
<td></td>
</tr>
<tr>
<td>Filter Scope (AQL)</td>
<td>objectType in objectTypeAndChildren(&quot;Server Components&quot;)</td>
<td></td>
</tr>
<tr>
<td>Filter Issue Scope (AQL)</td>
<td>Server IN ($(Affected Server$(0)))</td>
<td></td>
</tr>
<tr>
<td>Filter Assign Scope (AQL)</td>
<td>Not configured</td>
<td></td>
</tr>
<tr>
<td>Make Filter Assign Strict</td>
<td></td>
<td></td>
</tr>
<tr>
<td>User Interaction</td>
<td>Type of interaction: Select</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Checkbox / Radio button</td>
<td></td>
</tr>
<tr>
<td>Filter objects with attributes</td>
<td>Label ×</td>
<td></td>
</tr>
<tr>
<td>Object attributes on Issue view</td>
<td>Server × ID × Status ×</td>
<td></td>
</tr>
<tr>
<td>Multiple</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Option to add all objects</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Jira Service Management</td>
<td>Show object picker on customer portals</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Force to show on Customer Issue details</td>
<td></td>
</tr>
</tbody>
</table>

**Scope**

Find your custom field on the Custom fields page, and select **Configure** next to it. Select **Edit Assets configuration**. Select which object schema the custom field should use. Configure other settings. You can check what they mean in the table below.
Object schema | Object schema that the custom field should use. If you want this field to refer to specific objects, make sure you point to the right schema.
--- | ---
Filter scope (AQL) | Define the scope of objects that are valid for this field. For example, if you want it to show only specific object types (Applications, but not Hardware), then you could use a query like this one:
```
objecttype = Application
```
Filter issue scope (AQL) | In the create/edit view, and in the customer portal, you can filter objects based on their attributes, in addition to the filter scope you configured above. This doesn't apply to JQL searches. Placeholders are supported, but only for “Select type”.
**Example**
This AQL will show objects that are owned by the group selected in the request:
```
Server."Owner Group" = ${Group}
```
This AQL will show objects that are owned by the reporter:
```
Owner = currentReporter()
```
Filter assign scope (AQL) | Allows you to automatically set objects to the custom field. This can be filtered on any issue field values with support for placeholders.
**Example**
This AQL will show objects that are owned by the group selected in the request:
```
Server."Owner Group" = ${Group}
```
This AQL will show objects that are owned by the reporter:
```
Owner = currentReporter()
```

For more info on creating your queries, see:
- [AQL - Assets Query Language](#)
- [Advanced: Placeholders](#)

### User interaction

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
</table>
| Type of interaction | You can specify what type of interaction the custom field should use:
- Select
- Checkbox / Radio buttons |
| Filter objects with attribute | You can specify the attributes to filter on, this field is mandatory and at least one has to be configured. Label is default. |
| Object attributes on issue view | You can specify which of the object's attributes will be displayed in a Jira issue. For example, you might specify only the most important attributes, so as to not clutter your issues, and users can view the rest after opening the object. |
| Multiple | You can specify if users can choose multiple values for this field. |
Option to add all objects

If you allowed multiple values (above), you can add an option to select all values.

### Service Desk

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Show object picker on customer portals</td>
<td>This is for Jira Service Management. You can select whether the object picker (which allows to browse and select objects) should be available on the customer portal.</td>
</tr>
</tbody>
</table>

#### Enable access for customers

When you add Assets custom fields to Jira Service Management, you need to enable them for customer portals. Without these steps, customers won't be able to access these fields. Learn more about enabling Assets custom fields on customer portals.
Referenced Assets custom field

A referenced Assets custom field allows you to specify a parent custom field and then shows objects that have references to or from the object chosen in the parent field.

Example

<table>
<thead>
<tr>
<th>Parent field: Affected server</th>
<th>Reference</th>
<th>Referenced field: Affected part</th>
</tr>
</thead>
<tbody>
<tr>
<td>Biggest server in the server room</td>
<td>CPU</td>
<td>Intel(R) Xeon(R) CPU E7- 4830 @ 2.13GHz</td>
</tr>
<tr>
<td></td>
<td>Network interface</td>
<td>Apc Network Management Card 2</td>
</tr>
<tr>
<td></td>
<td>Memory</td>
<td>32GB DDR4-2400 ECC REG DIMM</td>
</tr>
</tbody>
</table>

The objects available in your referenced custom field will change depending on what the user has chosen in the parent custom field.

Creating a referenced custom field

To create a referenced custom field:

1. Log in as the Jira administrator.
2. Go to Administration > Issues > Custom fields.
3. Select Add custom field, and select Advanced.
4. Search for Assets referenced object, and select either the single- or multi-select field.
5. Enter a name and description for your field.
6. Associate the custom field with desired screens in Jira.

Configuring a referenced custom field

With your custom field created and associated with the right screens in Jira, you can now configure how it will behave.

1. Find your custom field on the Custom fields page, and select Configure next to it.
2. Select Edit Assets configuration.
3. Select which object schema the custom field should use.
4. Configure other settings. You can check what they mean in the table below.
## Configure Assets Custom Field - Affected Server (customfield_10200)

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Scope</strong></td>
<td></td>
</tr>
<tr>
<td>Parent Custom Field</td>
<td>Select the parent custom field. Your referenced custom field will return objects based on what was chosen in the parent custom field.</td>
</tr>
<tr>
<td>Reference direction</td>
<td>Select the direction of the references:</td>
</tr>
<tr>
<td></td>
<td>- <strong>Outbound references</strong>: All references that exist on the object chosen in the parent custom field. This would typically include all attributes of type Objects, which means references to other Assets objects.</td>
</tr>
<tr>
<td></td>
<td>- <strong>Inbound references</strong>: All references from other objects that go to the object chosen in the parent custom field.</td>
</tr>
<tr>
<td>Reference type</td>
<td>Reference type. You can choose any type that you have configured in Assets or leave it blank to use all references.</td>
</tr>
<tr>
<td>Restrict to User related objects</td>
<td>You can restrict this custom field to just show objects related to the Jira users filling in data for this field. You can additionally restrict it to a specific user by using AQL. For more info on creating your queries, see AQL - Assets Query Language.</td>
</tr>
<tr>
<td>Restrict to Project related objects</td>
<td>You can restrict this custom field to just show objects related to a project where this field is used.</td>
</tr>
</tbody>
</table>
| **Additional filter scope (AQL)** | You can filter objects on attributes to select only those that fit your needs.  
An example:  
```  
Status = Active  
```

| **Filter issue scope (AQL)** | In the create/edit view, and in the customer portal, you can filter objects based on their attributes, in addition to the filter scope you configured above. This doesn't apply to JQL searches. Placeholders are supported, but only for "Select type".  
Here's an example:  
```  
*System Owner*.User = currentReporter()  
```

For more info on creating your queries, see [AQL - Assets Query Language](#).

**User interaction**

| **Filter objects with attributes** | You can specify the attributes to filter on, this field is mandatory and at least one has to be configured. Label is default. |
| **Object attributes on issue view** | You can specify which of the object's attributes will be displayed in a Jira issue. For example, you might specify only the most important attributes, so as to not clutter your issues, and users can view the rest after opening the object. |

**Jira Service Management**

| **Show object picker on customer portals** | This is for Jira Service Management. You can choose whether the object picker (which allows to browse and select objects) should be available on the customer portal. |
| **Force to show on Customer Issue details** | This is for Jira Service Management. You can choose whether the custom field is visible in customer issue details, even if it's not a visible request field. |

**Enabling access for customers**

When you add Assets custom fields to Jira Service Management, you need to enable them for customer portals. Without these steps, customers won't be able to access these fields. [Learn more about enabling Assets custom fields on customer portals](#).
Read-only Assets custom field

Read-only custom fields allow you to include information about objects in your issues. This information can only be viewed and can't be edited.

Example

An example of how you can use a read-only custom field is during employee offboarding. The custom field can display the employee's current assets in the offboarding issue, so you know what needs to be collected before they leave.

To create and configure read-only Assets custom fields, you must be logged in as a user with Jira Administrator or Jira System Administrator permissions.

Creating a read-only custom field

1. Go to Administration > Issues > Custom fields.
2. Select Add custom field and then select Advanced.
3. Search for Assets readonly object and select it.
4. Enter a name and description for your field.
5. Associate the custom field with desired screens in Jira.

Configuring the read-only custom field

With your custom field created and associated with screens in Jira, you can now configure how it will behave.

1. Go to Administration > Issues > Custom fields.
2. Find your custom field on the Custom fields page, and select More > Configure.
3. Select Edit Assets configuration.
4. Select which object schema the custom field should use.
5. Configure other settings. Check what they mean in the table below.

Configure Assets Custom Field - Assigned Hardware (customfield_10301)

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Object schema</td>
<td>Resources</td>
</tr>
<tr>
<td>Filter Scope (AQL)</td>
<td>objectType = Computer</td>
</tr>
<tr>
<td>Filter Assign Scope (AQL)</td>
<td>Owner = ${reporter}</td>
</tr>
<tr>
<td>User Interaction</td>
<td></td>
</tr>
<tr>
<td>Object attributes on issue view</td>
<td>Name × Key × RAM ×</td>
</tr>
</tbody>
</table>

Setting | Description
--- | ---
Scope | The object schema that the custom field should use. If you want this field to refer to specific objects, make sure you point to the right schema.
<table>
<thead>
<tr>
<th>Filter scope (AQL)</th>
<th>The general filter for the custom field. Use AQL to specify which objects you want to show in this field. <a href="#">Learn more about AQL</a></th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Examples</strong></td>
<td>If you want to show objects that belong to the Computer object type, use the following AQL:</td>
</tr>
<tr>
<td></td>
<td><code>objectType = &quot;Computer&quot;</code></td>
</tr>
<tr>
<td></td>
<td>If you want to show software that is created by Atlassian, try something like this:</td>
</tr>
<tr>
<td></td>
<td><code>objectType = &quot;Software&quot; AND Manufacturer = &quot;Atlassian&quot;</code></td>
</tr>
<tr>
<td>Filter assign scope (AQL)</td>
<td>This filter is used to automatically add objects to your custom field based on values in issue fields or another Assets custom field. To get the values from these fields, use placeholders. <a href="#">Learn more about placeholders</a></td>
</tr>
<tr>
<td></td>
<td><strong>Important</strong></td>
</tr>
<tr>
<td></td>
<td>• To see a value in your read-only custom field, you must enter an AQL query here. This is the only way to populate the custom field.</td>
</tr>
<tr>
<td></td>
<td>• The object is added to your custom field automatically only when an issue is created or edited.</td>
</tr>
<tr>
<td><strong>Example</strong></td>
<td>If your custom field is filtered to show the Computer object type and you want to display the computer that is owned by the reporter of the issue, there are two AQL queries that you can use:</td>
</tr>
<tr>
<td></td>
<td><code>Owner = currentReporter()</code></td>
</tr>
<tr>
<td></td>
<td><code>Owner = ${reporter}</code></td>
</tr>
<tr>
<td>User interaction</td>
<td>This is where you can specify which attributes of the object displayed in your custom field you want to show in the Jira issue.</td>
</tr>
<tr>
<td>Enabling access for customers</td>
<td>When you add Assets custom fields to Jira Service Management, you need to enable them for customer portals. Without these steps, customers won’t be able to access these fields. <a href="#">Learn more about enabling Assets custom fields on customer portals</a></td>
</tr>
</tbody>
</table>
Enabling Assets custom fields on customer portals

When you add Assets custom fields to Jira Service Management, you need to enable them for customer portals. Without these steps, customers won’t be able to use these fields.

Enable custom fields on customer portals

Add custom field to your service project

1. Go to your service project.
2. Go to Project settings > Customer portal.
3. Select the request type to which you want to add your custom field.
4. Select Edit form, and switch to the Fields tab.
5. Select Add a field and select your field.

Enable and show the custom field

Enable the custom field:

Show the custom field:
Enable access for customers

Once your custom field is enabled, you need to configure access on your object schema so that customers can select objects in your field:

1. Open your object schema in Assets.
2. At the top-right, select Object schema > Configure.
3. Switch to the Roles tab.
4. In the Jira Service Management tooltip, select Enable.
Adding Assets functions to workflows in Jira

Assets includes several post functions, conditions and validators, and Groovy scripts that let you automate the execution of actions. By adding to workflows in Jira, you can trigger actions on your objects when an issue transitions through a workflow. These actions include updating an asset, sending a notification, or running a script.

For instance, when an issue is created requesting the onboarding of an employee, you can assign necessary assets to the new user including laptop, cell phone and cell phone subscription.

Get started with Assets functions

- Conditions and validators
- Post functions
- Groovy scripts
Conditions and validators

Conditions and validators allow you to add certain requirements on workflow transitions to make sure that your request can be transitioned only if these requirements are met. Insight introduces conditions and validators that are related to object attributes (for example, you'd allow a change request for a server only if it's not in production).

To view available conditions and validators:

1. Open a workflow that you'd like to add the conditions or validators to.
2. Select a transition. Conditions and validators are added to a transition rather than a workflow step.
3. Select Conditions or Validators, then select Add.
4. Select Assets condition or Assets validator.
5. Select one of the available options. Learn more about them in the table below.

Available options

Here are the Assets conditions or validators that you can use:

<table>
<thead>
<tr>
<th>Name</th>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Validate on object attributes</td>
<td>Condition</td>
<td>Allows to transition a request only if the related object's attributes meet this condition/validator's criteria. For example:</td>
</tr>
<tr>
<td></td>
<td>Validator</td>
<td>▪ Allow change request only if the target server has enough licenses available</td>
</tr>
<tr>
<td></td>
<td></td>
<td>▪ Allow change request only if the target server is not in production</td>
</tr>
<tr>
<td></td>
<td></td>
<td>▪ Allow holiday request only if the user has enough remaining vacation days</td>
</tr>
<tr>
<td></td>
<td></td>
<td>▪ Allow specific hardware request to be approved only if there's enough hardware models available</td>
</tr>
<tr>
<td></td>
<td></td>
<td>▪ Allow only specific requests on server that have a sufficient SLA level</td>
</tr>
<tr>
<td></td>
<td></td>
<td>You'd build your queries here using AQL - Assets Query Language.</td>
</tr>
<tr>
<td>Run a Groovy script</td>
<td>Condition</td>
<td>Allows you to run a groovy script within the conditions/validator, which can be useful when you need some specific requirements met.</td>
</tr>
<tr>
<td></td>
<td>Validator</td>
<td>For more info about Groovy scripts and examples, see Groovy scripts.</td>
</tr>
</tbody>
</table>
Post functions

Adding post functions to your Jira workflows allow you to trigger actions against your objects when an issue is transitioned through the workflow. Here you can find available post functions for Assets.

To view available conditions and validators:

1. Open a workflow that you’d like to add the post functions to.
2. Select a transition. Post functions are added to a transition rather than a workflow step.
3. Select Post-functions, then select Add.
5. Select one of the available options. Learn more about them in the table below.

Available options

Here you can find the available post functions.

The selected object will be added, removed, or set to the corresponding attribute of the target object.

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Condition</td>
<td>Specify the Groovy code to use as condition for this post function to execute. Condition ignored on empty value.</td>
</tr>
<tr>
<td>Source custom field</td>
<td>Specify the custom field where objects are selected and to be added, removed, or set.</td>
</tr>
<tr>
<td>Change type</td>
<td>Specify the change type.</td>
</tr>
<tr>
<td>Target custom field</td>
<td>Specify the custom field where objects should be changed.</td>
</tr>
</tbody>
</table>

The selected user custom field will be used to find Assets objects that are associated with that user.

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Condition</td>
<td>Specify the Groovy code to use as condition for this post function to execute. Condition ignored on empty value.</td>
</tr>
<tr>
<td>Source custom field</td>
<td>Specify the custom field where information (email addresses or Jira users) can be found.</td>
</tr>
<tr>
<td>Target custom field</td>
<td>Specify the custom field where objects should be assigned.</td>
</tr>
<tr>
<td>Assets object type attribute name</td>
<td>Optional object type attribute to filter objects on.</td>
</tr>
</tbody>
</table>

Select an object attribute value of a selected object and set it to another target custom field. Supported fields are Jira Text fields, Jira user fields, Jira group fields and Assets custom fields (not reference fields).

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Condition</td>
<td>Specify the Groovy code to use as condition for this post function to execute. Condition ignored on empty value.</td>
</tr>
<tr>
<td>Source custom field</td>
<td>Specify the Assets custom field from where objects attribute should be fetched.</td>
</tr>
<tr>
<td>Assets object type attribute name</td>
<td>Specify the name of the object type attribute where to fetch the value.</td>
</tr>
<tr>
<td>Target custom field</td>
<td>Specify the custom field where object attribute should be stored (reference fields can't be selected).</td>
</tr>
</tbody>
</table>

Select an Assets object and specify the attribute the assignee will be fetched from.

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Condition</td>
<td>Specify the Groovy code to use as condition for this post function to execute. Condition ignored on empty value.</td>
</tr>
</tbody>
</table>

| Source custom field | Specify the Assets custom field from where objects attribute should be fetched. |

| Assets object type attribute name | Specify the name of the object type attribute the user will be fetched from. Any type except "User" or "Default / Email" will be ignored. |

Select an Assets object and specify the "User" or "Default / Email" attribute to which an email will be sent.

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Condition</td>
<td>Specify the Groovy code to use as condition for this post function to execute. Condition ignored on empty value.</td>
</tr>
</tbody>
</table>

| Source custom field | Specify the Assets custom field from where objects attribute should be fetched. |

| Assets object type attribute name | Specify the name of the object type attribute the user will be fetched from. Any type except "User" or "Default / Email" will be ignored. |

| Email subject | Specify the email subject. Issue placeholders are supported. |

| Email message | Specify the email message. Issue placeholders are supported. |

Increase or decrease an object attribute value (of type Integer) by a set amount.

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Condition</td>
<td>Specify the Groovy code to use as condition for this post function to execute. Condition ignored on empty value.</td>
</tr>
</tbody>
</table>

| Source custom field | Specify the Assets custom field from where objects attribute should be fetched. |

| Assets object type attribute name | Specify the name of the object type attribute the user will be fetched from. Any type except "User" or "Default / Email" will be ignored. |

| Change type | Specify the change type: Increase or Decrease. |

| Change value | Specify the change value. Anything except a number will be set to default (1). |

Selected objects will have their specified attribute set to the predetermined value.

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Condition</td>
<td>Specify the Groovy code to use as condition for this post function to execute. Condition ignored on empty value.</td>
</tr>
</tbody>
</table>

| Source custom field | Specify the Assets custom field from where objects attribute should be fetched. |
Create an Assets object when you have specific requirements that a predefined Assets post function can't handle. About parameters into the Groovy engine, you have all the parameters available as in a normal post function. The most common one is "issue" where you may query as you like. Check out Assets Groovy script examples.

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Groovy script</td>
<td>Enter your Groovy code.</td>
</tr>
</tbody>
</table>

Select an Assets object schema, object type, and configure the attributes to be populated from a Jira Issue.

The value of the Issue field mapped to an object attribute must be data format compatible, otherwise Assets won't be able to create a new object. An example of a mapping that will fail: A Jira URL picker mapped to an object attribute of type Integer.

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Condition</td>
<td>Specify the Groovy code to use as condition for this post function to execute. Condition ignored on empty value.</td>
</tr>
<tr>
<td>Assign to issue</td>
<td>The newly created object isn't automatically linked to the issue. To assign it to the issue, select the custom field on the issue to contain the reference.</td>
</tr>
<tr>
<td>Always create</td>
<td>If selected, Assets will create the object even if mandatory object attributes haven't been mapped correctly.</td>
</tr>
<tr>
<td>Object schema</td>
<td>Specify the object schema that contains the object type of interest.</td>
</tr>
<tr>
<td>Object type</td>
<td>Specify the object type that corresponds to the type of object that should be created.</td>
</tr>
<tr>
<td>Attributes/Issue fields</td>
<td>Once the object type is selected, the list of attributes will be listed, allowing a mapping against an Issue field.</td>
</tr>
</tbody>
</table>

Supported Jira issue fields:

<table>
<thead>
<tr>
<th>Field</th>
<th>Jira type</th>
<th>Object type attribute type</th>
<th>Expected object type attribute value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Affected version(s)</td>
<td>Version(s)</td>
<td>Version</td>
<td>Numeric</td>
</tr>
<tr>
<td>Assignee</td>
<td>User</td>
<td>User</td>
<td>Email</td>
</tr>
<tr>
<td>Field</td>
<td>Type</td>
<td>Data Formats</td>
<td></td>
</tr>
<tr>
<td>---------------------</td>
<td>----------</td>
<td>--------------------------------------------------------------</td>
<td></td>
</tr>
<tr>
<td>Description</td>
<td>Text</td>
<td>• Text area</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Other</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Description in Wiki format</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Description</td>
<td></td>
</tr>
<tr>
<td>Due date</td>
<td>Date</td>
<td>• Date</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Date time</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Other</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Date</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Date time</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>• System/User locale format of Date</td>
<td></td>
</tr>
<tr>
<td>Fix version(s)</td>
<td>Version(s)</td>
<td>• Version</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Numeric</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Other</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Jira Version(s)</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Jira Version ID(s)</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Jira Version name(s)</td>
<td></td>
</tr>
<tr>
<td>Issue type</td>
<td>Issue type</td>
<td>• Numeric</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Other</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Issue type ID</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Issue type name</td>
<td></td>
</tr>
<tr>
<td>Key (issue)</td>
<td>Text</td>
<td>• Any</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>• The Issue key</td>
<td></td>
</tr>
<tr>
<td>Labels</td>
<td>Label(s)</td>
<td>• Any</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>• The label(s) value(s)</td>
<td></td>
</tr>
<tr>
<td>Priority</td>
<td>Priority</td>
<td>• Numeric</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Other</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Priority ID</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Priority name</td>
<td></td>
</tr>
<tr>
<td>Project</td>
<td>Project</td>
<td>• Project</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Numeric</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Other</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Jira Project</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Jira Project ID</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Jira Project name</td>
<td></td>
</tr>
<tr>
<td>Reporter</td>
<td>User</td>
<td>• User</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Email</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Other</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Jira User</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Jira User email</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Jira User display name</td>
<td></td>
</tr>
<tr>
<td>Resolution</td>
<td>Resolution</td>
<td>• Date</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Date time</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Other</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Resolution Date</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Resolution Date time</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Resolution name</td>
<td></td>
</tr>
<tr>
<td>Resolved</td>
<td>Date</td>
<td>• Date</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Date time</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Other</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Date</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Date time</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>• System/User locale format of Date</td>
<td></td>
</tr>
<tr>
<td>Status (Issue)</td>
<td>Status</td>
<td>• Any</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Status name</td>
<td></td>
</tr>
<tr>
<td>Summary</td>
<td>Text</td>
<td>• Any</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>• The summary</td>
<td></td>
</tr>
</tbody>
</table>
**customfield_xxxxx** | Undefined | • Any | The value of the custom field.

Make sure that when using custom fields, the custom field value is possible to set to the target attribute. Otherwise, it will be discarded.

Assign objects to custom fields depending on a configured AQL query. Any issue value is available as place holders. Use the common field definitions for Jira fields. The AQL query will run upon the schema which the Assets custom field belongs.

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Condition</strong></td>
<td>Specify the Groovy code to use as condition for this post function to execute. Condition ignored on empty value.</td>
</tr>
<tr>
<td><strong>AQL</strong></td>
<td>Specify the AQL to filter the objects to set on the specified custom field in next configuration. The AQL supports placeholders from any issue field.</td>
</tr>
<tr>
<td><strong>Target custom field</strong></td>
<td>Specify the Assets custom field that the filtered objects should be attached. (Referenced Assets Custom fields aren't supported)</td>
</tr>
</tbody>
</table>
Groovy scripts

You can run Groovy scripts in conditions and validators and post functions. They give you more power and flexibility, but are recommended for advanced users.

Configuring Groovy scripts

Before you run any Groovy scripts, you have to configure how they're used on your instance.

1. Go to Administration > Manage apps > Assets script configuration.
2. Decide who can use the Assets script console and select Jira administrators and Jira system administrators or Only Jira system administrators. The default setting is Only Jira system administrators.
   When deciding who can access the Assets script console, keep in mind that its used when adding conditions, validators and post functions.

   To change who can access the Assets script console, you must be logged in as a user with the Jira system administrators global permissions.

3. Add the Groovy scripts that you want to run to your allowlist. Enter the filename of a script on your server and select Add script to allowlist. Repeat this action for all of the scripts you want to use.

4. Select Save.
Ensure that the directory and the subdirectories where your Groovy script is located are readable by all users and executable by the user running Jira. For example:

```bash
$ ls -al ~/Users/jira/jira-home/atlassian-jira-servicedesk-4.20.0/scripts
```

<table>
<thead>
<tr>
<th>Variable</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>issue</td>
<td>The issue to be transitioned.</td>
</tr>
<tr>
<td>originalIssue</td>
<td>The original issue.</td>
</tr>
<tr>
<td></td>
<td>You can use the attributes of issues as conditions. For example, if you want</td>
</tr>
<tr>
<td></td>
<td>something to happen if the assignee has changed, use the following code in</td>
</tr>
<tr>
<td></td>
<td>your condition:</td>
</tr>
<tr>
<td></td>
<td><code>issue.assignee != originalIssue.assignee</code></td>
</tr>
<tr>
<td>currentUser</td>
<td>The current Jira user.</td>
</tr>
<tr>
<td></td>
<td>To check if the reporter is the current user, use the following code:</td>
</tr>
<tr>
<td></td>
<td><code>currentUser == issue.reporter</code></td>
</tr>
<tr>
<td>log</td>
<td>A log framework. You can log to <code>atlassian-jira.log</code> by:</td>
</tr>
<tr>
<td></td>
<td><code>log.warn(&quot;This is a warning!&quot;);</code></td>
</tr>
</tbody>
</table>

**Examples**

If you’re looking for some inspiration and examples, see [Groovy script examples](https://confluence.atlassian.com/addmacro/groovy-script-examples).
Adding approvers from Assets to requests in Jira

1. You need to have a Data Center license to use this feature.

Jira Service Management allows you to require approvals for a workflow step. This means that a request can’t move from one status to another until it’s approved by the right people. In Assets, the right people are the owners of your assets or groups responsible for their maintenance. You can add them as approvers when a request that affects an asset they own or have relations to is raised. The approvers will change dynamically based on the assets selected in your requests.

Before you begin

To add approvers from Assets, you’ll need the following items:

- Attribute of type User or Group added to an object type. If you select groups, keep them rather small as bigger groups will affect performance.
- One of the Assets object custom fields mapped to your objects in Assets. Supported types are:
  - Assets objects
  - Assets referenced object (single)
  - Assets referenced object (multiple)
  - Assets object (single) (deprecated)
  - Assets object (multiple) (deprecated)

If you don’t have these attributes or fields already, follow these steps:

When you add the User/Group attribute to your object type, you can then fill it in for the underlying objects by choosing a specific user or group. These people will have relations to your objects and can be assigned as approvers. For more information on attributes, see Adding attributes to object types.

To add an attribute to your object type:

1. In Assets, select an object type, and switch to the Attributes tab.
2. Add an attribute of the User or Group type. In the following example, we added a User attribute well assign a user to this object in the next step.
3. You can configure extra details for each of your attributes by selecting the cog icon on the right and then selecting Configure. One of the options is cardinality it will let you specify how many users can be selected in this field.

4. Switch to the Objects tab, edit an object, and assign a user or group to the attribute you added.

If you select groups, keep them rather small as bigger groups will affect performance we need to search through every user in the group.

An Assets object field works like a link between Assets and your projects in Jira. The field is configured differently than Jira custom fields, but when it comes to adding it to Jira screens, it behaves like a regular custom field. You will select this field, together with an attribute, when creating an approval step. For more info on the Assets objects field, see Default Assets custom field.

To create an Assets object field:

1. In Jira, go to Administration > Issues > Custom fields, and create a new custom field.
2. Select one of the Assets object fields. The object fields marked as legacy are also supported.
3. Select the name, applicable projects and issue types.
4. Associate the custom field with the screens that are used by the workflow you're planning to add the approval to. Typically, these would be the Create and Edit screens related to the issue type used by your workflow.

To link the Assets object field to your projects and objects:

1. On the Custom field page, find the custom field, and select the more options menu > Configure.
2. Select Edit Assets configuration. You'll now see all possible configurations related to this field.
3. To use the field for approvals, select the object schema in which you store your assets. Selecting the object schema is enough to use the field for approvals. You can, however, change any of the other settings. For details on how to configure an Assets custom field, see Adding Assets custom fields to screens in Jira.

Adding, configuring, and viewing your approvers

With the attributes and the custom field ready, you can now configure the approval step and add approvers from Assets to your request.

1. Add the approval step to your workflow

To add the approval step to your workflow:

1. Edit the workflow to which you want to add the approval.
2. Select a status, and select Add approval.
3. Select **Assets object field** and select your custom field. Well check this field for any valid attributes, that is the ones that are of the User or Group types.

![](image)

4. Select the attribute that is associated with the users or groups that you want to become your approvers.
5. Select how many approvals are required and which transition your request should use when its approved or declined.
6. Select **Create** to add the approval.

2. **Enable the Assets object/s field on the customer portal**

   Approvers change based on the object selected in your request, but someone needs to actually select an object. In this step, you'll let customers select objects on the customer portal. If you skip it, your agents can still select objects in the agent view.

   To enable the custom field on the customer portal:

   1. In your project, go to **Project settings > Request types**.
   2. Select the relevant request type.
   3. If your field isn't in **Visible fields** already, select **Add a field**, and add it.

3. **Raise a request and view approvers**

   When you raise a request and select an object in it, approvers will be added automatically when the request reaches your approval step.

   To raise a request:

   1. Open your customer portal and raise a request.
2. The Assets objects field should let you select one of your objects from Assets.

To view approvers for the request:

1. Transition the request to the workflow status with your approval step.
2. Approvers related to the selected object should be added automatically. They will also receive an email notification asking them to approve or decline this request.
Importing and exporting object schemas

Importing and exporting schemas can be useful if you’re using other instances of Assets and want to move schemas between them, or if you exported a schema in the past, and now’s the time to bring it back. You can choose to export only schema structure (including object types and their attributes) or also include objects.

Importing an object schema

To import an existing Assets object schema:

1. In the top navigation bar, select **Assets > Configure**.
2. Switch to the **Import/Export** tab.
3. Fill in the schema details. You can find descriptions of available fields in the table below.
4. Once you’re ready, select **Import**.

After importing an object schema, you’ll need to reindex Assets (not Jira). You can do it by going to **Administration > Manage apps > Indexing Assets**.

---

### Import/Export Form

**You can import a new object schema from the server.**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
<th>Required</th>
</tr>
</thead>
<tbody>
<tr>
<td>File name</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Name</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Key</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Description</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Import objects</td>
<td>Yes</td>
<td></td>
</tr>
<tr>
<td>Include</td>
<td>Attachments</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Object Avatar</td>
<td></td>
</tr>
<tr>
<td>Password</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

---

479
| **File name** | List of previously exported object schemas that are available for import. This includes all schemas that are in the import directory specified below this field. If your schema is not on the list, copy it to this directory. | Yes |
| **Name** | Name of the object schema that will be created by the import. The name must be unique. | Yes |
| **Key** | Key of the object schema that will be created by the import. The key must be unique. | Yes |
| **Description** | Description of your schema. | No |
| **Import objects** | Choose whether you’d like to import objects that belong to the schema. Here are some details: | Yes |
|  | - Yes (default): Objects will be imported. |
|  | - No: Only object schema structure will be imported. This includes object types, object type attributes, etc., but not objects themselves. |
| **Include** | Choose whether to include attachments and avatars of objects. | No |
| **Password** | If the file chosen for the import is protected by a password, then that password must be provided in order to perform the import. | No |

### Exporting an object schema

To export an object schema:

1. In the top navigation bar, select **Assets > Configure**.
2. Switch to the **Import/Export** tab.
3. Fill in the schema details. You can find descriptions of available fields in the table below.
4. Select **Export**.
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>File name</td>
<td>File name for your exported schema. The file will be saved in the directory shown below this field.</td>
</tr>
<tr>
<td>Object schema</td>
<td>List of object schemas that can be exported.</td>
</tr>
<tr>
<td>Object schema with / without objects</td>
<td>Choose whether to export objects together with the schema, or only the schema structure (object types, object type attributes).</td>
</tr>
<tr>
<td>Password</td>
<td>If provided, the exported file will be protected by the password entered by the user. Later when importing this file, the same password must be provided in order to be able to perform the import.</td>
</tr>
</tbody>
</table>
Assets REST API documentation

You can use Assets API to integrate and customize Assets to your needs. You can integrate with an external system to get the data about your assets or create your own post functions.

For Jira Service Management 5.7, refer to Assets 10.7.0 REST API documentation.

For Jira Service Management 5.4, refer to Assets 10.4.4 REST API documentation.

For Jira Service Management 4.20, refer to Assets 9.1.16 REST API documentation.

For other advanced information, also check Advanced usage guides.
Advanced usage guides

If you're looking for advanced knowledge, including Assets app development, REST APIs and Java docs, see Advanced usage guides.
Upgrading Insight with Jira Service Management

Insight - Asset Management is part of Jira Service Management Data Center, but it's also available as a separate app on Atlassian Marketplace so people not ready to upgrade their instances can also get it. This page will help you understand which version of the Marketplace app corresponds to Jira Service Management, and will guide you through some upgrade steps if you're using this app.

Versions

The built-in functionality and the Marketplace app are essentially the same. Here's how the app's version corresponds to Jira Service Management:

<table>
<thead>
<tr>
<th>Jira Service Management</th>
<th>Insight - equivalent Marketplace app</th>
</tr>
</thead>
<tbody>
<tr>
<td>4.18</td>
<td>8.8.0</td>
</tr>
<tr>
<td>4.17</td>
<td>8.7.9</td>
</tr>
<tr>
<td>4.16</td>
<td>8.7.4</td>
</tr>
<tr>
<td>4.15</td>
<td>8.6.13</td>
</tr>
</tbody>
</table>

There were some differences in issues resolved and release timeline in versions 4.15-4.17. Since version 4.18, the built-in functionality and the Marketplace app are aligned.

Upgrading Insight with Jira Service Management

Whether you need to complete any pre-upgrade steps before upgrading Insight or Jira Service Management depends on the Insight version you're using, so let's start with checking that.

Step 1: Check your Insight version

To check which Insight version you're using:

1. Go to Administration > Manage apps > Manage apps.
2. Find Insight and expand it to see the version.

![Insight app](image)

If you're seeing Insight in versions 9.x, like on the image above, it means that you're using the built-in Insight functionality in Jira Service Management. You don't have to take any actions and can safely upgrade.

Step 2: Complete the pre-upgrade steps

Look at the versions below and complete the steps required for your version.
Insight 8.4 or later

You're good to go. You're on one of the latest versions and there are no breaking changes.

Insight 8.x - 8.3

Complete these steps before upgrading: Preparing for Insight 8.4

Insight 7.x

1. Upgrade to the latest version of Insight 7.x, which is 7.1.4.
2. Upgrade to Insight 8.3.
3. Complete these steps: Preparing for Insight 8.4
4. Upgrade to the latest version of Insight or Jira Service Management, as described below.

Step 3: Upgrade Insight or Jira Service Management

If you completed all the required steps, your app is ready to be upgraded.

- If you're looking to just upgrade the Marketplace app to the latest version, upgrade it in Administration > Manage apps > Manage apps.
- If you're upgrading Jira Service Management that has the Insight functionality built in, your app will be automatically upgraded.

How to upgrade Insight to specific versions instead of the latest one

When you try to update the app in Manage apps, it will be updated to the latest version, which isn't a good idea if you need to upgrade through intermediary versions first.

To download and install a specific version:

1. Check the Version history tab on Marketplace.
2. Download your version.
3. In Jira, in Manage apps, click Upload app. Your version will be uploaded and installed.
Working with object schemas

An object schema is your actual CMDB. It’s a collection of object types and their attributes, objects and references between them. It also includes your configuration items, such as roles, icons, statuses, and automation rules. Object schemas work like maps that hold all of it together. You can have many object schemas, and refer to objects inside them from your issues and requests.

Have one, or many

For example, you might have an HR object schema that captures all relevant HR data that adds value to your HR projects. It can contain information about employees, workplaces, and business areas, as well as information about employee assets, such as keyboards, monitors, and laptops. These can be linked together, so when you click on an employee, you immediately see other objects with information about their office, personally-assigned laptop, or even keyboard.

Here’s what a sample schema from the ITSM template looks like:

Note:

1. **Object types**: The list of all object types within a schema, organized in a tree structure.
2. **Objects**: The list of objects within the selected object type, and details about them. As you can see, although all these objects are different, they use the same information, like Name, Model, or Serial Number.

Quick overview

Here’s a video on object schemas if you’d like to get a quick overview:

Get started with object schemas

Here’s a list of pages that have all the info you need:

- Creating object schemas
- Configuring object schemas
- Configuring Assets automation rules
- Configuring print labels

486
Creating object schemas

An object schema is a map on which you add various object types and then underlying objects. You need to have an object schema before you can create any object types and objects. Learn more about object schemas

Create an object schema

To create a new object schema:

1. In the top navigation bar, select Assets > Assets object schemas.
2. Select Create object schema.
3. Select Empty object schema. You can also select one of the schema templates that already come with a specific structure, including object types and attributes.
4. Give it a name, key, and description.
5. Set permissions for your schema, so your users can create object types and objects (see details below).

Sample IT assets schema

Here's the view of an object schema, based on the sample IT assets schema, pre-filled with data.

Object types: List of object types in a schema.
Object type view: Switch between viewing object type's objects, attributes, or graph the visual representation of its references.
Object schema actions: Configuration options for the current object schema.
Object schema actions: Configuration options for the selected object type.

Set permissions for your schema

Permissions let you choose roles that can view or edit your schema.

Important

If you want your users to later work on object types and objects, they need to have at least the User role for the schema itself. Without this role, they won’t be able to view or do anything with your schema.

To set schema permissions:

1. Open your schema.
2. At the top-right, select the Object Schema dropdown menu, and select Configure.
3. Switch to the Roles tab, and add users or groups to specific roles. For more info about permissions, see Configuring roles and permissions.

Configure your schema

Object schemas have several configuration options that let you tailor it to your needs and make the future work easier for your users. For available options, see Configuring object schemas.
Object schema templates

Assets comes with default templates for object schemas. They have some basic structure for the most common uses cases, so you can try them out for some inspiration.

Object schema template come with:

- Object type structure
- Attributes for object types
- References between object types

Sample IT asset schema

Here's the default structure for the IT asset schema:

Sample HR asset schema

Here's the default structure for the HR asset schema:

Sample CRM asset schema

Here's the default structure for the CRM asset schema:
### Customer

<table>
<thead>
<tr>
<th>Id</th>
<th>Name</th>
<th>Description</th>
<th>Type</th>
<th>Type Value</th>
<th>Additional Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>754</td>
<td>Key</td>
<td></td>
<td>Default</td>
<td>Text</td>
<td></td>
</tr>
<tr>
<td>755</td>
<td>Name</td>
<td>The name of the object</td>
<td>Default</td>
<td>Text</td>
<td></td>
</tr>
<tr>
<td>756</td>
<td>Created</td>
<td></td>
<td>Default</td>
<td>DateTime</td>
<td></td>
</tr>
<tr>
<td>757</td>
<td>Updated</td>
<td></td>
<td>Default</td>
<td>DateTime</td>
<td></td>
</tr>
<tr>
<td>758</td>
<td>Country</td>
<td></td>
<td>Default</td>
<td>Text</td>
<td></td>
</tr>
<tr>
<td>759</td>
<td>Billing Address</td>
<td></td>
<td>Default</td>
<td>Textarea</td>
<td></td>
</tr>
<tr>
<td>760</td>
<td>Visiting Address</td>
<td></td>
<td>Default</td>
<td>Textarea</td>
<td></td>
</tr>
</tbody>
</table>
**Configuring object schemas**

You can configure your object schema to change permissions, roles, statuses, references, and more.

To configure your object schema:

1. Open your schema.
2. At the top-right, select the **Object Schema** dropdown menu, and select **Configure**.

---

**Available configuration**

Here's what you can do with your schema.

<table>
<thead>
<tr>
<th>Tab</th>
<th>Description</th>
</tr>
</thead>
</table>
| **General** | In the **General** tab, you can change the schema name and description. You can also customize the following options:  
  - Shows a ‘create object’ icon next to the Assets custom field displayed on issues to allow users to create objects directly from issues (if they can't find their objects). Only available for users with at least the Assets developer role.  
  - Enable the possibility to create referenced objects when editing or creating new objects. Only available for users with at least the Assets developer role.  
    - If the previous option is enabled, then you can restrict the quick creation of referenced objects to validate all object attributes to respect data consistency.  
    - You can choose to publish events related to objects on the Assets activity stream.  
    - This option allows other schemas to select objects from this schema. You can select objects only from schemas that have this option enabled. |
| **References** | In the **References** tab, you can configure references that can be later used when linking objects to one another. When users choose to create a reference in their object, they'll see references that you specify here. |
| **Statuses** | In the **Statuses** tab, you can configure statuses that are displayed on objects. For example, you can have statuses like Running and Problem, and choose to change from one to another when an issue is reported against one of your objects. |
| **Icons** | In the **Icons** tab, you can check available icons to be used for object types and objects, and upload new icons. |
| **Roles** | In the **Roles** tab, you can check permissions for you scheme, and add users and groups to specific roles. |
In the **Import** tab, you can import data into your object schema. This is useful if you’d like to import a CSV files with your assets instead of creating objects manually. For more info, see Importing data into an object schema.

In the **Automation** tab, you can add automation rules for your schema. For more info, see Configuring Assets automation rules.

Templates for print labels. For more info, see Configuring print labels.

In the **Files** tab, you can view all files added to your object schema and check their usage. The list will show all files added to the schema itself or any object referenced in it. Those can be user avatars or a CSV file that you imported to your schema.

**Related pages**

Have a look at these pages:

- Importing your data
- Working with object types
Configuring Assets automation rules

You can create automation rules that automatically perform actions (for example, notify users) based on specific events (for example, object updated) for all objects, or only a group of objects in a schema.

Before you begin

Make sure you have the right permissions:

- To configure automation rules, you need to have at least the Assets manager role for the schema.
- To run and execute automation rules, the user (either the logged-in user or the user that you select for running scheduled events) needs to have at least the Assets users role for the schema. If this user has a different role for the object types affected by the rule (object type’s permissions take precedence over schema’s permissions), then also grant them the Assets users role for these object types. This is only needed if a rule affects such object types, otherwise permissions are inherited from the schema.

For more info about permissions, see Configuring roles and permissions.

Create a rule

1. Open your schema, and select Object schema > Configure.
2. Switch to the Automation tab.
3. Create a rule.
4. Enter the rule’s name and description.
5. Select each of the boxes (WHEN, IF, THEN). A panel will appear on the right allowing you to add an event, condition, and action. You can read more about them below.

Configure your rule

Configure your rule by specifying events (WHEN), conditions (IF), and actions (THEN).

1. Add events (WHEN)

   1. Select the WHEN box.
   2. On the right, select Add events.
   3. Select the desired event, then select Add.

   ▶️ Good to know

   - You can add up to five events for a single rule.
   - Instead of creating two or more rules with the same actions (for example, email notification), add two or more events to the same rule. It will be easier to maintain later.
### User events
Most events, except the Scheduled event, are triggered when a logged-in user performs an action on an object (object updated, attachment added, etc.). These events don't require any additional configuration.

### Scheduled events
Scheduled events aren't triggered by an action performed by a user. They run according to the specified cron expression (e.g., once a day, once an hour) and conditions.

Here are the required parameters for scheduled events:

1. **Condition:** This is an IQL (Assets Query Language) expression. When the scheduled rule is activated, all objects that match the condition will trigger individual actions.
2. **Cron expression:** This determines when and how often the provided condition will try to match Assets objects. By default, the expression is set to "0 0 12 1/1 * ? "; that is: once a day at noon. [Learn more about cron expressions](#).
3. **Triggered rule will run as:** You need to select a specific user here because scheduled events can't be triggered by a logged-in user. You can select the user on the top-right of the page.

### 2. Add conditions (IF)
You can add a condition if you don't want the configured action to apply to all objects in your schema, but rather a specific set of objects.

1. Select the IF box.
2. On the right, select Add condition.
3. Enter an AQL statement and select Add.

**Good to know**
- A condition (IF) always needs a THEN box. When you add another condition, you'll be able to edit its actions.
- You can configure up to three IF/THEN pairs.

**Example**
- A rule is triggered by an object updated event.
- The rule has a condition: "name = Windows server".
- The rule has an email notification action.

The rule configuration in this example means that if a user updates an object whose exact name is Windows server, an email notification is automatically sent.

### 3. Add actions (THEN)

1. Select the THEN box.
2. On the right, select Add action.
3. Select your action and fill in the details. Every action requires different information. For example, details needed for Create a Jira issue will differ from those needed to Execute a Groovy script.
4. Select Add.

**Available actions**

Here’s a list of actions that you can select:

This action allows the rule to change the value of an object’s attribute.

Set an attribute value of the Assets object affected by the event. Multiple values are separated by a comma (,).

<table>
<thead>
<tr>
<th>Field</th>
<th>Single value example</th>
<th>Multiple values example</th>
</tr>
</thead>
<tbody>
<tr>
<td>Attribute name</td>
<td>Status</td>
<td>Server</td>
</tr>
<tr>
<td>Value</td>
<td>Stopped</td>
<td>Server 1,Server2</td>
</tr>
</tbody>
</table>

This action allows the rule to create a Jira issue.

**Good to know**

- The issue type selected must be available for the chosen project, otherwise a Jira issue can’t be created.
- If the custom field is populated, the chosen project must be configured to handle this object type, otherwise this field won’t have any effect.
This action allows the rule to send email notifications related to the event that was triggered.

Example: For the object updatedevent, an email will be sent showing the changes related to this object.

Note that for the Recipients by attribute option you need to select the object type in the rule’s condition with attributes of the email, user, or group type.
This action allows a triggered rule to execute a Groovy script.

### Fields that support placeholders

<table>
<thead>
<tr>
<th>Fields that support placeholders</th>
<th>Example syntax</th>
<th>Example result</th>
</tr>
</thead>
<tbody>
<tr>
<td>Subject</td>
<td>Server: ${label} is stopped.</td>
<td>Server:exchange.prod.main1is stopped.</td>
</tr>
<tr>
<td>Message</td>
<td>Server: ${label} (${Key}) has status: ${Status}</td>
<td>Server:exchange.prod.main1(WS-5969) has status: Stopped.</td>
</tr>
</tbody>
</table>

Groovy scripts need adequate permissions and must be whitelisted to be executed. Learn how to add Groovy scripts to the Whitelist.
Data available to the Groovy script by our rule engine

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
<th>JAVA class</th>
</tr>
</thead>
<tbody>
<tr>
<td>object</td>
<td>The object that was directly involved in a user action (like updating an</td>
<td>com.riadalabs.Jira.plugins.assets.services.model.ObjectBean</td>
</tr>
<tr>
<td></td>
<td>Assets object) or matched by a scheduled rule through AQL, with an&quot;Execute</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Groovy Script&quot; as an action</td>
<td></td>
</tr>
<tr>
<td></td>
<td>object that was directly involved in a user action (for example, updating</td>
<td></td>
</tr>
<tr>
<td></td>
<td>an object) or matched by a scheduled rule through AQL, with an &quot;Execute</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Groovy Script&quot; action.</td>
<td></td>
</tr>
<tr>
<td>currentUser</td>
<td>The user who triggered the rule or a specific user chosen to run the rule.</td>
<td>com.atlassian.Jira.user.ApplicationUser</td>
</tr>
<tr>
<td>log</td>
<td>An instance of the Apache Log interface, for convenient logging in a script.</td>
<td>org.apache.commons.logging.Log</td>
</tr>
<tr>
<td>objectUpdateList</td>
<td>A list of object attributes that are affected in an object update event that</td>
<td>List&lt;com.riadalabs.jira.plugins.assets.services.model.ObjectUpdateBean&gt;</td>
</tr>
<tr>
<td></td>
<td>includes an affected attribute in an object, as well as values added or</td>
<td></td>
</tr>
<tr>
<td></td>
<td>removed for it.</td>
<td></td>
</tr>
</tbody>
</table>

This action allows a triggered rule to make an HTTP request. It supports the standard HTTP methods: GET / POST / PUT / DELETE.
4. Add more conditions and actions

A rule can only consist of one event (WHEN), but it can have up to three pairs of conditions and actions (IF /THEN). This allows you to add more conditions and actions, if the first ones aren’t matched.

1. Select the ELSE IF / THEN box.
2. Add actions, and conditions if needed.
3. Select Save.
More automation

Automation rules are related to a specific object scheme, but there's way more automation that you can add. Your Jira admin can add conditions and validators, as well as post-functions, to Jira workflows that will make issues affect objects while they're being transitioned through workflows. For more info, see Adding Assets functions to Jira workflows.
Configuring print labels

You need to create at least one print labels template before you can print labels for your objects. Templates are created for each object scheme separately.

To create a template:

1. Open your object schema.
2. At the top-right, select Object schema > Configure.
3. Switch to the Label templates tab.

Template configuration

Here’s the explanation for fields that you see when creating a new template or editing an existing one.

Responsive height

You can select this option to give your template responsive height, allowing it to expand to fit the content.

Border

You can select this option to add a border to your template. Here’s an example of a template with and without a border:

Template

This editors allows you to create a customized template. It supports placeholders and images, and comes with some styling options. When you create a new template, the editor will already include a default template.

Source gives you the possibility to edit the html source for the template.
You can use the **Insert placeholders** drop-down to add any of the attributes available for this object schema. One of the first attributes is “Attribute list” when selected, it will add an additional configuration when printing a template, where you can select the attributes you want.

### Some things to watch out for

- Some attributes may be specific to certain object types. Using the same template for other object types will render the text as “No value” on the printed labels.
- Additionally, if you have a language setting enabled for Assets, for example Spanish, the “No value” text will be printed as “Sin valor”. Well, at least everybody will get it.

### Adding images

You can also add images to your templates. This can be pretty much anything you need in your template from QR codes to logos or icons. We’ve added some default images for you, so feel free to play around.

### Printing labels and QR codes

Once you’re ready with the template, you can try printing some labels. For more info, see [Printing labels and QR codes](#).
Working with object types

An object type groups objects that use the same kind of information, conveyed through their common attributes. Rather than a single PC, your object types would be Computers, Hardware, Software, Employees, and so on. You can create as many different object types as you like, and then group your various objects within. Object types can be whatever you want them to be as Assets is very open and flexible.

Common object types include:

- Business services
- Hosts
- Laptops
- Software

But they don’t have to be IT assets. For example, many people add other useful information, such as:

- Vendors
- Locations
- Employees
- Business priority

You can organize object types in the hierarchy tree in a way that makes sense. This tree is mainly for navigation and readability as you can have empty object types here (e.g. Hardware in the image on the right).

Define your object types with attributes

Attributes is what defines your object types (and underlying objects). They work like fields to which you add data. Jira’s issue fields would be the best comparison. You’d choose attributes for your object types, and then the same attributes need to be filled in for underlying objects, whenever someone creates them. You can have as many attributes as you need, and they also come in different shapes and sizes: text, dates, references to other objects, statuses, and so on.

Here’s a sample object type with its attributes:
1. **Object types**: List of object types within a schema, with Server selected.
2. **Attributes**: List of attributes configured for this specific object type.
3. **Type**: Type of attributes, here you can see the default ones or object (references to other objects)
4. **Type and additional value**: Extra values that depend on the attribute type. Note statuses; these will change through automation when an incident is raised against one of the underlying servers.

**Quick overview**

Here’s a video on object types if you'd like to get a quick overview:

**Get started with object types**

Here’s a list of pages that have all the info you need:

- Creating object types
- Adding attributes to object types
- Configuring inheritance of attributes
- Customizing the object view layout
Creating object types

Object types work like containers, or categories. Depending on your structure, they can group other object types or just objects. For example, you can have an object type Hardware that groups child object types Server, Computer, and Mobile phones. Each of these can then group specific objects. Learn more about object types

Create an object type

To create an object type:

1. Open your object schema.
2. At the top-right, select Object type > Create (you can also select the plus sign in the vertical menu)
3. Choose the name, icon, and description for your object type.
4. Select the object type’s parent. If you select None, the object type will be at the top of your asset tree.

Example object type

Here’s the view of an object type, based on the sample IT assets schema:

1. Object types: List of object types in a schema.
2. Object type view: Switch between viewing object type’s objects, attributes, or graph the visual representation of its references.
3. Object type actions: Configuration options for the current object type.
4. Attributes: List of object type’s attributes. These attributes will apply to all child objects.

Next steps

Object types need attributes that define them, so let’s add some:

- Adding attributes to object types
Adding attributes to object types

Attributes are fields that let you add important information to your objects—anything that you need. You specify attributes for an object type, and then they’re passed on to all child objects, requiring users to fill them in. An object type comes with a default set of attributes.

To add attributes to an object:

1. Select your object type.
2. Select Attributes to switch to the right view.
3. Add an attribute by entering its name, type, and values. You can read more about them below.

Attribute types

You can select the attribute type, this setting determines how the attribute value should be managed (and if its allowed).

<table>
<thead>
<tr>
<th>Attribute type</th>
<th>Type value</th>
<th>Additional value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Default</td>
<td>Text</td>
<td>-</td>
<td>Data type with text representation, often used to show normal text. Max 450 characters.</td>
</tr>
<tr>
<td>Boolean</td>
<td>-</td>
<td></td>
<td>Data type with only two possible values: true or false.</td>
</tr>
<tr>
<td>Integer</td>
<td>-</td>
<td></td>
<td>Commonly known as a &quot;whole number&quot;, is a number that can be written without a fractional component. For example, 21, 4, and 2048 are integers.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>This Attributes supports the Long Integer and will allow numbers that range from -2,147,483,648 to +2,147,483,647</td>
</tr>
<tr>
<td>Float</td>
<td>-</td>
<td></td>
<td>Data type representing numbers with decimals.</td>
</tr>
<tr>
<td>Date</td>
<td>-</td>
<td></td>
<td>Data type representing a Date field.</td>
</tr>
<tr>
<td>Date Time</td>
<td>-</td>
<td></td>
<td>Data type representing a Date and Time field.</td>
</tr>
<tr>
<td>URL</td>
<td>-</td>
<td></td>
<td>Data type representing an URL field. May be used for URL Ping service that pings the address every 5 minutes from the server side. Watch object to get email notifications on URL Ping Up/Down.</td>
</tr>
<tr>
<td>Email</td>
<td>-</td>
<td></td>
<td>Data type representing an email field.</td>
</tr>
<tr>
<td>Attribute</td>
<td>Description</td>
<td></td>
<td></td>
</tr>
<tr>
<td>-------------</td>
<td>-----------------------------------------------------------------------------</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Textarea</td>
<td>Data type with text representation, often used when showing large text. Use Assets rich editor to customize the content. Unlimited characters in comparison to the Text attribute.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Select</td>
<td>Data type to represent text values, predefined as options.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>IP Address</td>
<td>Data type to represent IP Addresses (IPv4)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Object</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>User</td>
<td>This type makes it possible to select a user from the selected Jira group and connect objects with users.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Confluence</td>
<td>This type enables a link to a Confluence page.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Group</td>
<td>This type makes it possible to select a Jira group and connect object(s) with user(s) in specified groups.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Version</td>
<td>This type makes it possible to reference a Jira Version from a specific Jira Project to your object(s).</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Project</td>
<td>This type makes it possible to reference a Jira Project to your object(s).</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Status</td>
<td>This type is used to set a Status of an object. Define the statuses that should be allowed, and left empty means all statuses allowed.</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

** Attribute configuration**

Some attribute types have additional configurations that lets you specify default suffixes or options, cardinality, and filtering. These configuration options depend on the type of attribute you’ve added.

1. To configure an attribute, select the cog icon next to it.
2. Adjust the configuration to your needs. Below you can find some details about each configuration option.

**General**

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
</table>

---
| **Suffix** | For default type "Integer" and "Float" you can set a suffix for the attribute. Example is "$" for an attribute. |
| **Hidden** | Hide the attribute from users in the "assets-users" role. |
| **Include children** | Include objects from a child object type(s). |
| **Unique** | Validate attribute values to be unique within the object type. |
| **Show Sum** | For default type "Integer" and "Float" you can choose to add the values and display the sum of the attribute. |
### Indexed

This is a checkbox and you can use this to determine if you want to index this attribute or not.

The Indexed feature on every attribute essentially helps you to retrieve your search results faster. If your attribute is indexed, Assets will not retrieve results from the database every time but instead retrieve them from an index/cache which yields results quicker. However, this comes at the cost of a higher memory consumption. For non-indexed attributes, memory consumption will be lower.

If you index an attribute, a small icon \(\mathbb{I}\) precedes the `Name` of the attribute as shown below. This icon will not be visible when you uncheck the `Indexed` checkbox.

Additionally, for the `label` attribute, the indexed icon will appear adjacent to the icon for the `label` (`\(\mathbb{I}\)`).

![Example screenshot of Jira Service Management](image)

By default, Assets will index all attributes on an object type, but the "Textarea" attribute is an exception to this rule. The `Key`, `Label`, `Created`, and `Updated` attributes will always be indexed, as will any attributes of the `Reference` type.

#### Cardinality

You can specify a minimum and maximum of number of attributes values that can be associated to the attribute. This is common when you need to set an attribute multiple choices or required / mandatory.

For attributes of type "Default" you can only set maximum cardinality to 1, except "URL" and "Email" where you may space separate.

#### Validation

You may validate attributes of default type "Text", "Email" & "URL" with regular expressions. This can be handy if you want to validate specific information, like an IP address, a domain name, a phone number, or anything else that may require validation.

#### Options

You may add multiple Options to a "Select" Type Attribute by adding them here.

#### Filter objects

For attribute of type "Object" you may filter objects to be selected by AQL. By using this filter it is possible to create dependencies to other fields when creating/editing objects.

The following examples shows how to configure an object reference attribute on the object type Employee to reference a Laptop. If a value is entered in the Manufacturer textbox only Laptops with the corresponding Vendor will be choosable. It is possible to combine multiple fields in the AQL to get multiple dependencies.

<table>
<thead>
<tr>
<th>Example description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Filter objects</td>
</tr>
</tbody>
</table>

The following table shows an example of how to use filter objects to create dependencies:

<table>
<thead>
<tr>
<th>AQL</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><code>WHERE Vendor = &quot;Vendor Name&quot;</code></td>
<td>Filter only Laptops with the corresponding Vendor.</td>
</tr>
</tbody>
</table>

### Example screenshot

![Example screenshot of Jira Service Management](image)
The employee has an outbound reference to Laptop. The employee also has an attribute called Computer Manufacturer.

The AQL for attribute Laptop is configured with:

```
Vendor = ${Computer Manufacturer}
```

The laptop has an attribute called Vendor.

Next steps

Have a look at these pages:

- Configuring inheritance of attributes
- Customizing the object view layout
- Working with objects
Configuring inheritance of attributes

You can configure object types to inherit attributes from their parent object types. This is useful if you need to create multiple object types, nested in one another, and want them to keep the same structure.

A good example for inheritance is an object type Host, with child objects Linux Host and Windows Host, which inherit common attributes, such as IP Address and Host name.

To enable inheritance of attributes:

1. Create the first, parent object type.
2. Select Object type > Configure.
3. Select the Let the attributes be inherited by the subclasses checkbox.
4. Optionally, set this object type to Abstract to prevent creating any objects in it. This can be useful if you want the object type to exist only to pass on the attributes, without grouping any objects.
5. Create child object types.

The inheritance will work on the grandchildren and their children and so forth.

Related pages

Have a look at these pages:

- Customizing the object view layout
- Working with objects
Customizing the object view layout

When you open an object, you'll see some details about it. That's usually some basic information about the object itself, its attributes, connected Jira issues, and so on. This information is presented through widgets; you can remove these widgets or add some more to always see the info you're most interested in. You make these changes not on objects specifically, but on object types; the changes then apply to all objects within this type.

Here's an example of an object. We described the panels, actions, and widgets that you can see and customize below:

1. **Side panel**: Two widgets are shown on the panel—Inbound references (expanded) and Attachments (collapsed).
2. **Attachments and comments**: These two actions are enabled, allowing users to add attachments and comments to your object.
3. **Main panel**: Several widgets are shown as separate tabs. Users can switch between them to get the info they need.

Customizing the page layout

1. Select the object type for which you want to customize the page layout.
2. In the top-right, select **Object type > Configure**.
3. In the top-right, select **Configure page layout**.
4. Read on for more information on what you can do with specific panels.
5. Once you're done with your changes, select **Save changes**.

Here's a brief description on what you can do in specific panels:

<table>
<thead>
<tr>
<th>Panel</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Side panel</td>
<td>Here you can add widgets that will be displayed below each other. To add a new widget, select <strong>Add panel</strong>, or just edit the widget that's already there. For the list of available widgets, see Adding widgets.</td>
</tr>
<tr>
<td>Attachments and comments</td>
<td>Here you can choose whether users can add attachments and comments to your objects. Clearing any of the check boxes will hide the related buttons from your objects.</td>
</tr>
</tbody>
</table>
## Main panel (tabs)

Here you can add widgets that will be displayed in tabs in the main part of your object. To add a new widget, select the plus sign and choose the widget you want. For the list of available widgets, see [Adding widgets](#).

### Good to know

- Double-click the tab to change its name
- Drag & drop tabs to rearrange them

## Reverting your changes

You can always reset the page layout to the default one by selecting **Reset**. This option will appear only after you save your changes.

## Related pages

Have a look at these pages:

- [Working with objects](#)
- [Viewing objects in the object view](#)
Adding widgets

Widgets are flexible components that you can insert in different places, such as object type layout page or dashboard. They can help you and your team quickly access information about your objects.

To add new widgets, or edit the settings for existing ones, go to your object schema, go to Object type > Configure > Configure page layout.

Attributes widget

Displays the selected attributes of your object in a customized order. It's useful to show specific information to your team without displaying all attributes at once, overwhelming them with data.

- **Add**: Select attributes from the drop-down list and add them to your widget.
- **Delete**: Hover over an attribute, and delete it.
- **Reorder**: Drag and drop attributes to change their order in the widget.

**Settings**

Settings for the Attribute widget:

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
</table>

---

514
Display content in a collapsible panel

- If ON, displays the attributes in a collapsible panel.
- If OFF, displays the attributes inline with other page text. Automatically turns "load content only when visible" OFF, since the attributes always displayed.

*This setting available in the side panel of the object page layout screen ONLY.*

Load content only when visible (Lazy loading)

- If ON, loads the data in the widget only when the widget is displayed. Default setting.
- If OFF, loads the data in the widget with the page.

Connected tickets widget

Displays all Jira issues that are connected to an object.

Settings

Settings for the Connected tickets widget:

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number of items per page</td>
<td>Set the number of connected tickets displayed on each page.</td>
</tr>
</tbody>
</table>
| Load content only when visible (Lazy loading) | - If ON, loads the data in the widget only when the widget is displayed. Default setting.  
  - If OFF, loads the data in the widget with the page. |

Comments widget

You can use this widget to view, edit, and add comments to an object.
Settings

Settings for the Comments widget:

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number of items per page</td>
<td>Set the number of comments displayed on each page.</td>
</tr>
<tr>
<td>Display the editor</td>
<td>• If ON, display the editor for comments at the top of the widget.</td>
</tr>
<tr>
<td></td>
<td>• If OFF, does not display the widget editor.</td>
</tr>
<tr>
<td>Load content only when visible</td>
<td>• If ON, loads the data in the widget only when the widget is displayed.</td>
</tr>
<tr>
<td>(Lazy loading)</td>
<td>• If OFF, loads the data in the widget with the page.</td>
</tr>
</tbody>
</table>

Attachments widget

You can use this widget to view, add, and delete attachments from an object.
Settings

Settings for the Attachments widget:

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number of items per page</td>
<td>Set the number of attachments displayed on each page.</td>
</tr>
<tr>
<td>Display the dropdown</td>
<td>• If ON, display the dropdown for adding attachments at the top of the widget.</td>
</tr>
<tr>
<td></td>
<td>• If OFF, does not display the dropdown.</td>
</tr>
<tr>
<td>Load content only when visible</td>
<td>• If ON, loads the data in the widget only when the widget is displayed.</td>
</tr>
<tr>
<td>(Lazy loading)</td>
<td>• If OFF, loads the data in the widget with the page.</td>
</tr>
</tbody>
</table>

Inbound references widget

You can use this widget to view inbound references to an object.
Settings

Settings for the Inbound references widget:

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Display content in a collapsible panel</td>
<td>• If ON, displays the inbound references in a collapsible panel. If OFF, displays the inbound references inline with other page text. Automatically turns &quot;load content only when visible&quot; OFF, since the inbound references are always displayed.</td>
</tr>
<tr>
<td></td>
<td><em>This setting is available in the side panel of the object page layout screen ONLY.</em></td>
</tr>
<tr>
<td>Load content only when visible (Lazy loading)</td>
<td>• If ON, loads the data in the widget only when the widget is displayed. Default setting. If OFF, loads the data in the widget with the page.</td>
</tr>
</tbody>
</table>

History widget

You can use this widget to view the history of changes to an object, or the history of changes to all connected Jira issues.
Settings

Settings for the History widget:

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>History of</td>
<td>• If OBJECT is selected, displays the entire history of the object.\n• If CONNECTED TICKETS is selected, displays the history and changes to Jira tickets connected to the object.</td>
</tr>
<tr>
<td>Number of items per page</td>
<td>Set the number of history items displayed on each page.</td>
</tr>
<tr>
<td>Load content only when visible(Lazy loading)</td>
<td>• If ON, loads the data in the widget only when the widget is displayed.\nDefault setting.\n• If OFF, loads the data in the widget with the page.</td>
</tr>
</tbody>
</table>

AQL query widget

You can use this widget to display objects, and their attributes, returned by an AQL query.
Settings

Settings for the AQL query widget:

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number of items per page</td>
<td>Set the number of objects returned by the AQL query.</td>
</tr>
<tr>
<td>Load content only when visible</td>
<td>• If ON, loads the data in the widget only when the widget is displayed. Default setting.</td>
</tr>
<tr>
<td></td>
<td>• If OFF, loads the data in the widget with the page.</td>
</tr>
<tr>
<td>Description</td>
<td>Enter a description of this query and the information returned.</td>
</tr>
<tr>
<td>AQL query</td>
<td>Enter an AQL query to run in the widget. For more information about AQL, see Advanced search: AQL.</td>
</tr>
</tbody>
</table>

Placeholders

Placeholders are very handy when used in the AQL query widget, because they can return information that is filtered by the current object. For example, the AQL query on the screenshot below returns all objects that meet the following criteria:

- Have outbound references to the current object
- Are Network interfaces

This is a great way of finding more detailed information about objects within an object type.
- For more info about Assets Query Language (AQL), see Advanced search: AQL.
- For more info about placeholders, see Advanced: Placeholders.
Working with objects

Objects are your actual assets. Every object is a digital representation of anything that you're mapping in Assets, be it a specific computer, employee, office they work at, or even a license for your software. You can create as many objects as you like, and group them within object types that represent their characteristics (an employee wouldn't be the best fit for the hardware object type).

Here's an example of an employee:

![Employee Profile](image)

References between objects

Information about an employee can be useful, but viewing their dependencies is even better. Thanks to this, you can know right away the office they work at, hardware they're using, role they belong to, or mobile phone they've been assigned. You can view references using the graphical viewer that lets you see all of it at a glance.

Here are the references of our example employee:
Get started with objects

Here’s a list of pages to get you started:

- Creating objects
- Adding objects to Jira issues
- Viewing objects in the object view
- Viewing references in a graph
- Printing labels and QR codes
Creating objects

Objects are your actual assets or configuration items. What an object looks like depends on the object type it belongs to. Learn more about objects

Create an object

To create an object:

1. Select the object type where you’d like to add your object. The object will use the object type’s attributes, so that’s quite important.
2. At the top-right, select Create object.
3. Enter the details and any required attributes.

Example object

Here’s the view of an object, based on the sample ITSM schema:

1. Object: List of objects within an object type.
2. Object type actions: Actions for the parent object type.
3. Object actions: Some of the object actions: printing labels or QR codes, watching.

How object keys are generated

All objects have an object key. The key uses the pattern KEY-NUMBER where:

- KEY - object schema key
- NUMBER - sequence number from the Object table in the database

The KEY is used to categorize objects and easily identify the object schema they belong to. The NUMBER is the MAX(Object Id) + 1 from the Object table (AO_8542F1_IFJ_OBJ). A new object schema (e.g. CRM) could have its first object with a key of CRM-12345 if this is the number of the max(Object ID) + 1 received from the database.

In earlier versions, objects received keys based only on the object schema and the sequence in which they were created, for example KEY-1, KEY-2, KEY-3, and so on. This was changed for the following reasons:

- Data Center support: To ensure the keys are unique through the whole cluster, we switched to a database sequence.
- Performance: By using a database sequence, we can sync fewer steps while creating objects, which improves performance in a multi-threaded environment.
Using the object view

Here's the same object as seen in the object view:

For more info on how you can customize the object view and what you can do in it, see Viewing objects in the object view.

Next steps

Have a look at these pages:

- Viewing objects in the object view
- Viewing references in a graph
- Adding objects to Jira issues
Adding objects to Jira issues

When you add objects to your Jira issues, information about them will be displayed directly on the issues, giving everyone interested enough context. Depending on how your workflows are set up, the added objects can also be affected when an issue is moving through a workflow.

Before you begin

You’ll add objects to your issues by choosing them as values of the Assets custom fields. These custom fields need to be first added to the right screens in Jira, which needs to be done by your Jira admin. For more info, see Adding Assets custom fields to screens Jira.

Add an object to your Jira issue

To add an object to a Jira issue:

1. Create or edit a Jira issue, and locate the Assets custom field. It will look just like any other field. In the example below, it’s "Affected Server".

2. Select your object from the drop-down menu. If you can't find it, try using the object picker that will let you browse available objects.

Select objects with the object picker

The object picker lets you search through Object types (left-side) and Objects (right-side).

- You can expand objects to view their attributes. This should help you make sure you're choosing the right one.
- You can select + Shift an object type to select all object types in its tree structure.
View object details on your Jira issues

All objects connected to an issue are shown when you view this issue. The amount of details shown depends on how the custom field (responsible for adding the object) is configured. Some custom fields might allow fewer attributes than others, and that's up to how your Jira admin configured them.

You can select an object to view all details about it. You can then use the icons to switch between overview, attributes, or graph.
Viewing objects in the object view

The object view lets you see all object details, including comments, attachments, and the history of changes. You can also view and modify object attributes, see all issues connected to an object, or view its references. All in a nice and friendly way.

Accessing the object view

You can access the object view in many ways, the easiest one being just selecting the object key (displayed as breadcrumbs when viewing the object):

- Select **Assets > Recent objects**, and select any object.
- Select any object in the schema and select its object key (displayed in breadcrumbs above the project name)
- Search for objects and select the object key.

Customize the object view

If you have the permission to edit the object schema, you can customize the object view to only display the information you need. For more info, see [Customizing the object view layout](#)

What you can do in the object view

Here are the actions that you can perform on objects in the default object view:

<table>
<thead>
<tr>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>View object details</td>
</tr>
<tr>
<td>---</td>
<td>---------------------</td>
</tr>
<tr>
<td>2</td>
<td>View attributes</td>
</tr>
<tr>
<td>3</td>
<td>View connected issues</td>
</tr>
</tbody>
</table>
4. **View comments and attachments**

The **Comments** tab lets you view and add comments for the object. You can filter them by author, description, or summary. You can add comments by selecting **Comment**.

5. **View attachments**

You can see attachments added to the object in the attachments widget on the right.

6. **View history of changes**

The **History** tab shows a time-ordered list of changes made to this object.
7 View references in a graph

After selecting **Graph** at the top-right, you can view references between this and other object within the object schema.

8 View inbound references

In the **Inbound references** widget, you can see all objects that have some references to this object.

9 Edit, move, or delete objects

If you are an **Assets Schema manager** or **Assets Schema administrator**, you can edit an object using the **Edit** button. You can also move an object to a different object type, or delete it entirely.
If you are an **Assets Schema manager** or **Assets Schema administrator**, you can also print a label or a QR code for this object.

### Host / Actarus

![Actarus](image.png)

#### Attributes

- **IT-23**

#### Attachments

- **Attachment**

#### Connected tickets
Viewing references in a graph

Assets contains four different graphs to help you get a better overview of your data:

- Object schema graph
- Object type graph
- Object graph (including force graph and tree graph)

Object schema graph

To view an object schema's graph:

1. Open your object schema.
2. At the top-right, select Graph.

To get information about a certain object type, click on it.

- Gray lines point to the parent object type.
- Colored lines mark object attribute dependency.
- You can click the cog icon in the vertical menu to hide parent lines or visualize the object count.
- You can also create new references directly in the graph by pressing shift and dragging from one object type to another indicated by a purple line as seen in the image below.

Object type graph

To view an object type's graph:

1. Open your object type.
2. At the top-right, select Graph.
The object type graph is mostly the same as the object schema graph, but allows you to focus more on a specific part. By double-clicking on the icon for an object type, you can expand the graph and also show the types connected to this one.

**Object graph**

To view an object's graph.

1. Select your object.
2. Select **Object graph**.

**Force graph view**

The object graph is used to view specific objects and their relations. On the right, you can see all attributes, issues, and attachments for the selected object. By double-clicking an object, you can expand the graph to include all related objects.

As with the other graphs you can stop the icons moving around by clicking the lock icon. In the configuration, you can set the reference depth which tells how far from the initial object the graph should show, i.e. if you set it to 1 you will only see the selected object and related objects, set it to 2 and you will also see all objects related to the related objects and so on.

**Tree graph view**
This view let you watch your object references in a hierarchical tree structure. Referenced objects are grouped by Object Type to make it easier to distinguish them.
Printing labels and QR codes

Using labels and QR codes can really streamline the management of tangible assets. For this, Assets lets you print labels and QR Codes for any object. These documents show you how to do that.

Print labels

The easiest way to print labels is to search for multiple objects and then use bulk actions to print labels for all of them.

1. Search for your objects or select an object type (you can also print individual labels by selecting the printer icon on an object).
2. Select **Bulk actions > Print labels**.

3. If there’s a template available, select it, and select Print. Otherwise, your admin will need to create a template.

Here’s an example of a ready label:

![Label Example](image)

Print QR codes

You can view an object’s QR code after opening your object.

![QR Code Example](image)

To print QR codes for multiple objects:

1. Search for your objects or select an object type (you can also print individual QR codes as shown on the image above)
2. Select **Bulk actions > Print QR codes**.
## Importing your data

Entering everything manually could be a life’s work in a large organization. So that’s why there are a few tools to help.

<table>
<thead>
<tr>
<th>Import</th>
<th>Description</th>
<th>See Importing with Asset Discovery</th>
</tr>
</thead>
<tbody>
<tr>
<td>Asset Discovery</td>
<td>Asset Discovery is an agentless scanner that picks up network assets. You can choose which of assets, and which attributes, you pull into your Assets object schemas and you can create your own scanning patterns to find more specific details</td>
<td></td>
</tr>
<tr>
<td>Integrations</td>
<td>Integrations can be used to connect to other tools, such as cloud services, asset managers, and other CMDBs. These integrations can be downloaded for free from Atlassian Marketplace, and include AWS, Azure, Google Cloud, ServiceNow, and some more.</td>
<td></td>
</tr>
<tr>
<td>Built-in importers</td>
<td>Import your data from CSV, database, Jira users, JSON, LDAP, or other object schema. Once you create your import configuration, you can keep it in sync so your assets stay up to date.</td>
<td></td>
</tr>
</tbody>
</table>


Importing with Asset Discovery

Asset Discovery is available for free for Jira Service Management Data Center.

Asset Discovery is an agentless scanner (although there is an agent available to get more detailed information) that picks up network assets. You can select which of assets, and which attributes, you pull into your Insight object schemas and you can create your own scanning patterns to find more specific details. If you run it on a schedule it will pick up changes to keep data updated. With automation rules you can even trigger Jira issues, email notifications, and more based on detected changes.

- Download Asset Discovery from Marketplace
- View Asset Discovery documentation
Importing with Integrations

Asset Integrations can be used to connect to other tools, such as cloud services, asset managers, and other CMDBs.

While we have all these tools, we don’t recommend you bring in every bit of data you have into Assets unless you plan to depreciate the tool. Bring in what you need to use in Jira Service Management, you can always bring in more later.

All Asset Integrations can be installed through the Marketplace for free.

Here is the full list of Asset Integrations:

- Asset Integration - AWS
- Asset Integration - Azure
- Asset Integration - Google Cloud
- Asset Integration - SCCM
- Asset Integration - Snow
- Asset Integration - ServiceNow
- Asset Integration - Jamf
- Asset Integration - Device42
- Asset Integration - NVD
- Asset Integration - Jira & Bitbucket
- Asset Integration - Tempo
Importing with built-in importers

Assets has several built-in importers that let you import your data from CSV, database, JSON, LDAP, and so on. You'll use these importers by creating an import configuration, specifying its details, and then mapping the data you're importing to object types and attributes in Assets. Such an import configuration can be then synced on a regular basis, so your assets stay up to date.

You need to be an Assets Manager for an object schema to create, configure, and enable imports.

Get started with importers

- Understand importing concepts
- 1. Create your import configuration
  - CSV import
  - Database import
  - Jira users import
  - JSON import
  - LDAP import
  - Object schema import
- 2. Create object type and attribute mapping
- 3. Inspect your import configuration
- 4. Enable and sync your import
Understand importing concepts

In Assets, you’ll import your data by creating an import configuration, which consists of three elements:

- Base import configuration
- Object type mapping
- Attribute mapping (goes in pair with object type mapping)

Once created, such a configuration keeps importing your data (if synced) from updated data sources, and you can always make edits to it to make it even better. This page will help you understand the parts of your import configuration and the mappings you’ll need to create. It’s a good start before jumping right into importing your data.

You need to be an Assets Manager for an object schema to create, configure, and enable imports.

Complete import configuration

Here’s what a sample import configuration looks like after it’s created in Assets. This should help you understand the concepts described on this page:

1. **Base import configuration**: That is from where, and when, will your data be collected. Your data source.
2. **Object type mapping**: Target object type for your data. You need to create a separate mapping for every object type that your data concerns.
3. **Attribute mapping**: Mapping between the data locators in your data source and Assets attributes. This mapping always goes together with the object type mapping, because these attributes are for your specific, target object type.
4. **Another object type mapping (collapsed)**: Another object type mapping. It also has attribute mapping, when expanded. You can have as many object type mappings (and related attribute mappings) in one import configuration as you need.
Import configuration

Creating the base import configuration is the first step you do when you access Import in your object schema. When following the steps, you'll configure the following details:

If you'd like to see the import types, available fields for each type, and the predefined structure and configuration, head to 1. Create your import configuration, and choose the import type.

Import types

Import type is the type of your data source. It can be CSV, database, Jira users, JSON, and so on. Depending on which import type you choose, the details you have to fill in will differ.

Import fields

Import fields are fields that define your import type. From simple name and description to concatenators and date formats, these fields will instruct Assets how to treat your data source. Import fields are specific to import types.

Scheduling

Details on whether your data source should be synced on a regular basis to keep the objects up to date. You can always enable it on the ready import configuration.

Predefined structure and configuration

The last step before creating your import configuration will be choosing whether you'd like Assets to create a predefined structure and configuration. These are optional and even if created can be modified after importing your data.

- **Predefined structure**: The import module will create an Assets object type structure, together with attributes, based on your data. This will only be available if you haven't created any object type mapping.
- **Predefined configuration**: The import module will create mappings between attributes and data locators, AQL references, and any other configuration items. Based on the name of the object type as well attribute names supplied from the import module, Assets will determine which object types(s) that should be added to the configuration. You can use the predefined configuration without using the structure.

Object type and attribute mapping

Assets needs to know where your data is going. Unless you created the predefined structure and configuration and are happy with it, you'll need to create object type and their related attribute mappings. Even with the predefined structure, you'll most likely need to make some edits and reviews.

If you'd like to have a closer look at what fields are required when configuring the mappings and what they mean, head to 2. Create object type and attribute mapping.

A pair of object type and attribute mapping

Here's an example of an object type mapping and its attribute mapping. These will always go in pairs.
In the example above, the mapping is specified for the Employees object type. It means that the attribute mapping will import data from your data source to the mapped attributes only for this object type. If your data is for multiple object types, you’ll need to create such mappings for every one separately (still within the same import configuration).

This example is based on a simple CSV file that looked like this:

<table>
<thead>
<tr>
<th>Source CSV file</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name, Computer</td>
</tr>
<tr>
<td>Alex, PC</td>
</tr>
<tr>
<td>Sara, Mac</td>
</tr>
</tbody>
</table>

The CSV headers (Name, Computer) are mapped to related Assets attributes (Name, Computer). "Name" was a text field, so it doesn’t need additional object mapping (AQL). As for "Computer", it’s a reference to another object type, so we used an AQL with placeholders:

```plaintext
<Referenced object type identifier, Label> = {Header from the CSV file where Assets should look for data, Computer}
```

Here’s a video that shows how this example was created:

**Importing objects with references**

Although importing data for default attributes (text, dates, etc) shouldn’t be an issue, it might get tricky with data for objects that have references to other objects. It helps if you have created a structure of object types in Assets, because you know them, and can map them one by one. If you’re having problems, see **Object type reference** for some examples.

**Next steps**

When you’re ready, go to **1. Create your import configuration.**
1. Create your import configuration

The first step to importing your data is creating an import configuration. The configuration depends on the import type (the source from which you’re importing) and some of its configuration fields and options will differ based on what you’ve chosen. Assets provides some default import types available for configuration.

You need to be an Assets Manager for an object schema to create, configure, and enable imports.

Create your import configuration

Your data will be imported into object schemas. To create a new configuration:

1. Open your object schema.
2. Select Object schema > Configure.
3. Switch to the Import tab.
4. Select Create configuration. You’ll see all available import types, something like this:

Choose your import type

Once you’ve decided on your import type, select it and go to one of these pages:

- CSV import
- Database import
- Jira users import
- JSON import
- LDAP import
- Object schema import

More import types

When you install any of Assets integrations, they will appear as a new import type. You can also create your own import type, but this will require some developer knowledge.
CSV import

Your data will be imported from a CSV file. This is useful if you're still using spreadsheets (not judging) or have CSV files for all of your assets. Learn more about importing

You need to be an Assets Manager for an object schema to create, configure, and enable imports.

Before you begin

Here are some requirements for your CSV file:

- The CSV file needs to have headers, as they are used to create the data locators for the imports. An empty header value is not allowed.
- To divide multiple values (for the Assets Attributes with multiple cardinality), use || (2 pipe characters).

Import fields

Once you've chosen your import type, you'll need to enter details about it. Here's the description of fields you should see in Assets.

Here are general fields, common for every import type:

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>The name of the import.</td>
</tr>
<tr>
<td>Description</td>
<td>The description for your convenience.</td>
</tr>
<tr>
<td>Concatenator</td>
<td>You can specify a default concatenator. When joining multiple data locators into one Insight attribute, this will be the default concatenator. One example could be to join two columns like &quot;First name&quot; and &quot;Last name&quot; into one attribute. So &quot;Mathias&quot; (first name) and &quot;Edblom&quot; (last name) will be concatenated as &quot;Mathias Edblom&quot; if using \s as concatenator. Enter \s for space-concatenated. To include a concatenate character, place the value between double quotes (i.e &quot;s&quot;).</td>
</tr>
<tr>
<td>Empty Values</td>
<td>Defines what should happen when a Data Locator is empty. Should the import remove the attribute value or just ignores it and leave the current value as is.</td>
</tr>
<tr>
<td>Unknown Values</td>
<td>Defines what should happen if a Data Locator is unknown to Insight. This could happen with attribute types like &quot;Status&quot; and &quot;Select&quot;. The value can be added as an option or just ignore the value.</td>
</tr>
<tr>
<td>Date Format</td>
<td>Format for date fields in import source to convert dates into Insight. If left empty, Insight will automatically try to find correct format. The format should be specified according to the Java SimpleDateFormat guidelines.</td>
</tr>
</tbody>
</table>
These fields are specific to an import type (module).

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Import from</td>
<td>Choose a file or URL.</td>
</tr>
<tr>
<td>• URL</td>
<td>Protocol, Hostname, and Port of where to find the external CSV file. Example: http(s)://example.com/file.csv or file:///opt/csv/example.csv</td>
</tr>
<tr>
<td>• File</td>
<td>Choose a file to upload.</td>
</tr>
<tr>
<td>Username</td>
<td>Optional username for basic authentication.</td>
</tr>
<tr>
<td>Password</td>
<td>Optional password for basic authentication.</td>
</tr>
<tr>
<td>Delimiter</td>
<td>The delimiter used in the file. Enter \t for tab-delimited. To include a delimiter character, place the value between double quotes. To include a delimiter or a double quote character, place each value between double quotes.</td>
</tr>
</tbody>
</table>

Scheduling fields are responsible for keeping your data in sync:

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Synchronizing Account</td>
<td>The Jira user to use when synchronize data into Insight</td>
</tr>
<tr>
<td>Cron Expression</td>
<td>The interval for the automatic synchronization.</td>
</tr>
<tr>
<td>Automatically Synchronize</td>
<td>If the import should be scheduled for automatic synchronization.</td>
</tr>
</tbody>
</table>

Pre-defined structure and configuration

In the next step, after you've filled in the required fields, Assets will ask you whether you want to create a predefined structure (object type mappings) and configuration (attribute mappings). Details of this will differ depending on the import type.

Here’s some details for the CSV import:

- Each column from the CSV file will be created as an Assets attribute of type Default Text, and configuration will be mapped accordingly.
- The object type created will always be the same.
- Some object type mappings are disabled by default. Make sure to select the relevant ones.

If you want to have different attribute types created by the import of the data from the CSV file, create the predefined structure and then change the attribute types.

Import configuration created

You can now view your import configuration, but it's not ready yet. You still need to create or review the object type and attribute mapping, and make sure there are no problems with your import configuration.

When you're ready, go to 2. Create object type and attribute mapping.
Before you go
Object type mapping settings

In the next step, you'll create the object mapping settings. Here are some settings specific to the CSV import type.

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Selector</td>
<td>The selector for the CSV import is not used. Use AQL to filter any data from the CSV file</td>
</tr>
</tbody>
</table>
Database import

You might want to import data from an internal or third-party system like BMC Remedy or Service Now. This article guides you through importing data from another database. Learn more about importing

You need to be a Jira admin to create and configure database imports.

Supported databases

We’re using a common framework (jdbc) to connect to the database, so we support many databases:

<table>
<thead>
<tr>
<th>Database Type</th>
<th>Driver</th>
</tr>
</thead>
<tbody>
<tr>
<td>Microsoft SQL Server</td>
<td>com.microsoft.sqlserver.jdbc.SQLServerDriver</td>
</tr>
<tr>
<td>Oracle</td>
<td>oracle.jdbc.OracleDriver</td>
</tr>
<tr>
<td>PostgreSQL</td>
<td>org.postgresql.Driver</td>
</tr>
<tr>
<td>MySQL</td>
<td>com.mysql.jdbc.Driver</td>
</tr>
</tbody>
</table>

Import fields

Once you’ve selected your import type, you’ll need to enter details about it. Here’s the description of fields you should see in Assets.

Here are general fields, common for every import type:

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>The name of the import.</td>
</tr>
<tr>
<td>Description</td>
<td>The description for your convenience.</td>
</tr>
<tr>
<td>Concatenator</td>
<td>You can specify a default concatenator. When joining multiple data locators into one Insight attribute, this will be the default concatenator. One example could be to join two columns like &quot;First name&quot; and &quot;Last name&quot; into one attribute. So &quot;Mathias&quot; (first name) and &quot;Edblom&quot; (last name) will be concatenated as &quot;Mathias Edblom&quot; if using <code>\s</code> as concatenator. Enter <code>\s</code> for space-concatenated. To include a concatenate character, place the value between double quotes (i.e. &quot;\s&quot;).</td>
</tr>
<tr>
<td>Empty Values</td>
<td>Defines what should happen when a Data Locator is empty. Should the import remove the attribute value or just ignores it and leave the current value as is.</td>
</tr>
<tr>
<td>Unknown Values</td>
<td>Defines what should happen if a Data Locator is unknown to Insight. This could happen with attribute types like “Status” and “Select”. The value can be added as an option or just ignore the value.</td>
</tr>
<tr>
<td>Setting</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td><strong>Date Format</strong></td>
<td>Format for date fields in import source to convert dates into Insight. If left empty, Insight will automatically try to find correct format. The format should be specified according to the <a href="https://docs.oracle.com/javase/8/docs/api/java/text/SimpleDateFormat.html">Java SimpleDateFormat guidelines</a>.</td>
</tr>
<tr>
<td><strong>Date/Time Format</strong></td>
<td>Format for date/time fields in import source to convert dates into Insight. If left empty, Insight will automatically try to find correct format. The format should be specified according to the <a href="https://docs.oracle.com/javase/8/docs/api/java/text/SimpleDateFormat.html">Java SimpleDateFormat guidelines</a>.</td>
</tr>
</tbody>
</table>

These fields are specific to an import type (module).

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>URL</strong></td>
<td>The database connection URL. If you want to connect to the Jira database, you can look into the dbconfig.xml in Jira_HOME to find the correct configuration and URL.</td>
</tr>
<tr>
<td><strong>Driver</strong></td>
<td>The driver class to use to connect to the database. Place the JDBC driver (*.jar) to the <code>&lt;Jira_INSTALL&gt;/lib</code> folder. Don't forget to restart Jira after adding the driver to lib folder.</td>
</tr>
<tr>
<td><strong>Username</strong></td>
<td>The username used to authenticate.</td>
</tr>
<tr>
<td><strong>Password</strong></td>
<td>The password used to authenticate. You can enter the password for your database.</td>
</tr>
</tbody>
</table>

If you want to query the Jira database, you can look into the dbconfig.xml found in Jira_HOME directory, to find out the correct configuration.

Scheduling fields are responsible for keeping your data in sync:

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Synchronizing Account</strong></td>
<td>The Jira user to use when synchronize data into Insight</td>
</tr>
<tr>
<td><strong>Cron Expression</strong></td>
<td>The interval for the automatic synchronization.</td>
</tr>
<tr>
<td><strong>Automatically Synchronize</strong></td>
<td>If the import should be scheduled for automatic synchronization.</td>
</tr>
</tbody>
</table>

Pre-defined structure and configuration

Predefined structure and configuration is not available for this import type.

Import configuration created

You can now view your import configuration, but it's not ready yet. You still need to create or review the object type and attribute mapping, and make sure there are no problems with your import configuration.

When you're ready, go to 2. Create object type and attribute mapping.

Before you go

In the next step, you'll create the object type and attribute mappings. Here are some settings specific to the database import type.

**Object type mapping configuration**

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
</table>
The selector for the Database import is a SQL query. How to build SQL queries depends on the database type.

How to build up the selector (the SQL statement) depends on how you have configured the database connection. Below you will see some examples that will hopefully guide you in the right direction when setting this up.

<table>
<thead>
<tr>
<th>Database Type</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>Microsoft SQL Server</td>
<td><code>select * from &lt;database.name&gt;.&lt;schema-name&gt;.Application</code></td>
</tr>
<tr>
<td></td>
<td><code>&lt;schema-name&gt;</code> is &quot;dbo&quot; as default so an example could be:</td>
</tr>
<tr>
<td></td>
<td><code>select * from dbname.dbo.Application</code></td>
</tr>
<tr>
<td>Oracle</td>
<td><code>select * from &lt;schema-name&gt;.Application</code></td>
</tr>
<tr>
<td></td>
<td>If <code>&lt;schema-name&gt;</code> is &quot;Jiraschema&quot; the query will be:</td>
</tr>
<tr>
<td></td>
<td><code>select * from Jiraschema.Application</code></td>
</tr>
<tr>
<td>PostgreSQL</td>
<td><code>select * from &quot;Application&quot;</code></td>
</tr>
<tr>
<td>MySQL</td>
<td><code>select * from Application</code></td>
</tr>
</tbody>
</table>

If you want to query the Jira database, you can look into the `dbconfig.xml` found in `Jira_HOME` directory, to find out the correct configuration, such as `schema name` etc.
Jira users import

You might want to collect more information about your Jira users or relate Jira users to customers. For this, you need to import your Jira users or specific user groups in Assets. Learn more about importing

You need to be an Assets Manager for an object schema to create, configure, and enable imports.

Import fields

Once you've chosen your import type, you'll need to enter details about it. Here's the description of fields you should see in Assets.

Here are general fields, common for every import type:

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>The name of the import.</td>
</tr>
<tr>
<td>Description</td>
<td>The description for your convenience.</td>
</tr>
<tr>
<td>Concatenator</td>
<td>You can specify a default concatenator. When joining multiple data locators into one Insight attribute, this will be the default concatenator. One example could be to join two columns like &quot;First name&quot; and &quot;Last name&quot; into one attribute. So &quot;Mathias&quot; (first name) and &quot;Edblom&quot; (last name) will be concatenated as &quot;Mathias Edblom&quot; if using \s as concatenator. Enter `s for space-concatenated. To include a concatenate character, place the value between double quotes (i.e &quot;s&quot;).</td>
</tr>
<tr>
<td>Empty Values</td>
<td>Defines what should happen when a Data Locator is empty. Should the import remove the attribute value or just ignores it and leave the current value as is.</td>
</tr>
<tr>
<td>Unknown Values</td>
<td>Defines what should happen if a Data Locator is unknown to Insight. This could happen with attribute types like “Status” and “Select”. The value can be added as an option or just ignore the value.</td>
</tr>
<tr>
<td>Date Format</td>
<td>Format for date fields in import source to convert dates into Insight. If left empty, Insight will automatically try to find correct format. The format should be specified according to the Java SimpleDateFormat guidelines.</td>
</tr>
<tr>
<td>Date/Time Format</td>
<td>Format for date/time fields in import source to convert dates into Insight. If left empty, Insight will automatically try to find correct format. The format should be specified according to the Java SimpleDateFormat guidelines.</td>
</tr>
</tbody>
</table>

These fields are specific to an import type (module).

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Restrict Groups</td>
<td>Only users in selected group(s) will be imported.</td>
</tr>
</tbody>
</table>
Include Inactive users

Specify if Assets should include inactive users from source.

Scheduling fields are responsible for keeping your data in sync:

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Synchronizing Account</td>
<td>The Jira user to use when synchronize data into Insight</td>
</tr>
<tr>
<td>Cron Expression</td>
<td>The interval for the automatic synchronization.</td>
</tr>
<tr>
<td>Automatically Synchronize</td>
<td>If the import should be scheduled for automatic synchronization.</td>
</tr>
</tbody>
</table>

Import configuration created

You can now view your import configuration, but it’s not ready yet. You still need to create or review the object type and attribute mapping, and make sure there are no problems with your import configuration.

When you’re ready, go to 2. Create object type and attribute mapping.

Before you go

In the next step, you’ll create the object mapping settings. Here are some settings specific to the Jira users import type.

Object type mapping configuration

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Selector</td>
<td>The selector for the Jira User import isn't used. User AQL to filter any data from the User data.</td>
</tr>
</tbody>
</table>
JSON import

This import type will import objects into Assets with a JSON file that holds the data to import. Learn more about importing.

You need to be an Assets Manager for an object schema to create, configure, and enable imports.

Import fields

Once you've chosen your import type, you'll need to enter details about it. Here's the description of fields you should see in Assets.

Here are general fields, common for every import type:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>The name of the import.</td>
</tr>
<tr>
<td>Description</td>
<td>The description for your convenience.</td>
</tr>
<tr>
<td>Concatenator</td>
<td>You can specify a default concatenator. When joining multiple data locators into one Insight attribute, this will be the default concatenator. One example could be to join two columns like &quot;First name&quot; and &quot;Last name&quot; into one attribute. So &quot;Mathias&quot; (first name) and &quot;Edblom&quot; (last name) will be concatenated as &quot;Mathias Edblom&quot; if using \s as concatenator. Enter \s for space-concatenated. To include a concatenate character, place the value between double quotes (i.e &quot;\s&quot;).</td>
</tr>
<tr>
<td>Empty Values</td>
<td>Defines what should happen when a Data Locator is empty. Should the import remove the attribute value or just ignores it and leave the current value as is.</td>
</tr>
<tr>
<td>Unknown Values</td>
<td>Defines what should happen if a Data Locator is unknown to Insight. This could happen with attribute types like &quot;Status&quot; and &quot;Select&quot;. The value can be added as an option or just ignore the value.</td>
</tr>
<tr>
<td>Date Format</td>
<td>Format for date fields in import source to convert dates into Insight. If left empty, Insight will automatically try to find correct format. The format should be specified according to the Java SimpleDateFormat guidelines.</td>
</tr>
<tr>
<td>Date/Time Format</td>
<td>Format for date/time fields in import source to convert dates into Insight. If left empty, Insight will automatically try to find correct format. The format should be specified according to the Java SimpleDateFormat guidelines.</td>
</tr>
</tbody>
</table>

These fields are specific to an import type (module).
In the next step, after you’ve filled in the required fields, Assets will ask you whether you want to create a predefined structure (object type mappings) and configuration (attribute mappings). Details of this will differ depending on the import type.

Here’s some details for the Jira users import:

- The predefined structure and configuration will be created based on the JSON file/URL present in the configuration.
- Some object type mappings are disabled by default. Make sure to select the relevant ones.

Import configuration created

You can now view your import configuration, but it’s not ready yet. You still need to create or review the object type and attribute mapping, and make sure there are no problems with your import configuration.

When you’re ready, go to 2. Create object type and attribute mapping.

Before you go

In the next step, you’ll create the object type and attribute mapping. Here are some settings specific to the JSON import type.

### Object type mapping settings

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
</table>
### Selector

The selector for the JSON import.

**Use** `[Attribute.*[Attribute]]`

**Exemple:**
- "items"
- "items.item"
- "json.data.systems"

Only JSON arrays are valid as selector.

### Attribute mapping settings

Data locator:

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><code>attribute1[*].attribite2 [*]</code></td>
<td>The data locators provided are depending on the JSON and the selector configured.</td>
</tr>
</tbody>
</table>
LDAP import

Maybe you work with a corporate directory that contains your assets or employee-manager relationships used for approval processes. Such LDAP entries can be imported in Assets. To make things easy, Assets has modules that work with popular LDAP directories, which fetch the structure and the assets from your directory. This article shows you how to set this up. Learn more about importing

You need to be a Jira admin to create and configure LDAP imports.

Overview

An LDAP directory is a collection of data about users and other assets. LDAP (Lightweight Directory Access Protocol) is an Internet protocol that web applications can use to look up information about those assets from the LDAP server.

We provide a built-in connectors for the most popular LDAP directory servers:

- Microsoft Active Directory
- Apache Directory Server (ApacheDS)
- Apple Open Directory
- Fedora Directory Server
- Novell eDirectory
- OpenDS
- OpenLDAP
- OpenLDAP Using Posix Schema
- Posix Schema for LDAP
- Sun Directory Server Enterprise Edition (DSEE)
- A generic LDAP directory server

LDAPS validation

LDAPS (Secure LDAP) is supported and doesn't have any special requirements from Assets to work.

If you are trying to import from an LDAPS source, you can choose to validate the LDAP server certificate with an imported Certificate Authority (CA) certificate. If you select to validate the LDAP server certificate, you must import the root CA certificate from the CA that signed the LDAP server certificate, so your Jira can use the CA certificate to validate the LDAP server certificate. More information is explained here.

Be sure to change the port to 3269. This is due to the fact that a GC (global catalog) server returns referrals on 389 which refers to the greater AD "forest", but acts like a regular LDAP server on 3268 (and 3269 for LDAPS) when changing from LDAP to LDAPS.

Import fields

Once you've chosen your import type, you'll need to enter details about it. Here's the description of fields you should see in Assets.
<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>The name of the import.</td>
</tr>
<tr>
<td>Description</td>
<td>The description for your convenience.</td>
</tr>
<tr>
<td>Concatenator</td>
<td>You can specify a default concatenator. When joining multiple data locators into one Insight attribute, this will be the default concatenator. One example could be to join two columns like &quot;First name&quot; and &quot;Last name&quot; into one attribute. So &quot;Mathias&quot; (first name) and &quot;Edblom&quot; (last name) will be concatenated as &quot;Mathias Edblom&quot; if using <code>\s</code> as concatenator. Enter <code>\s</code> for space-concatenated. To include a concatenate character, place the value between double quotes (i.e &quot;\s&quot;).</td>
</tr>
<tr>
<td>Empty Values</td>
<td>Defines what should happen when a Data Locator is empty. Should the import remove the attribute value or just ignores it and leave the current value as is.</td>
</tr>
<tr>
<td>Unknown Values</td>
<td>Defines what should happen if a Data Locator is unknown to Insight. This could happen with attribute types like &quot;Status&quot; and &quot;Select&quot;. The value can be added as an option or just ignore the value.</td>
</tr>
<tr>
<td>Date Format</td>
<td>Format for date fields in import source to convert dates into Insight. If left empty, Insight will automatically try to find correct format. The format should be specified according to the Java SimpleDateFormat guidelines.</td>
</tr>
<tr>
<td>Date/Time Format</td>
<td>Format for date/time fields in import source to convert dates into Insight. If left empty, Insight will automatically try to find correct format. The format should be specified according to the Java SimpleDateFormat guidelines.</td>
</tr>
</tbody>
</table>

These fields are specific to an import type (module).

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>URL</td>
<td>Protocol, Hostname and Port of the server running LDAP. Example: <code>ldap://ldap.example.com:389</code></td>
</tr>
<tr>
<td>User DN</td>
<td>The distinguished name of the user that the application will use when connecting to the directory server. Examples:</td>
</tr>
<tr>
<td></td>
<td>- <code>cn=administrator,cn=users,dc=ad,dc=example,dc=com</code></td>
</tr>
<tr>
<td></td>
<td>- <code>cn=user,dc=domain,dc=name</code></td>
</tr>
<tr>
<td></td>
<td>- <code>user@domain.name</code></td>
</tr>
<tr>
<td>Password</td>
<td>The password of the user specified above.</td>
</tr>
<tr>
<td>Base DN</td>
<td>The root distinguished name (DN) to use when running queries against the directory server. Examples:</td>
</tr>
<tr>
<td></td>
<td>- <code>o=example,c=com</code></td>
</tr>
<tr>
<td></td>
<td>- <code>cn=users,dc=ad,dc=example,dc=com</code></td>
</tr>
<tr>
<td></td>
<td>- For Microsoft Active Directory, specify the base DN in the following format: <code>dc=domain1,dc=local</code>. You will need to replace <code>domain1</code> and <code>local</code> for your specific configuration. Microsoft Server provides a tool called <code>ldp.exe</code> which is useful for finding out and configuring the the LDAP structure of your server.</td>
</tr>
<tr>
<td></td>
<td>If you want specific Base DN in your object type see the Selector value below</td>
</tr>
</tbody>
</table>
Search filter

Defines the scope of the filter search. Default is `(objectClass=*)` which will give you all entries. If you only want Jira Users for example, you can set `(objectClass=person)`. Note that the Users in LDAP need to have the the "objectClass" set to "person".

The search filter is important in the way that it can affect the synchronization time.

Search scope when importing

Search scope determines how objects should be fetched from the LDAP. Default setting is ONE_LEVEL while the locators and structure are created with SUBTREE.

Follow Referrals

LDAP functionality to make sure you always get the correct data, even in a distributed LDAP environment.

Include namespace

This option is only applicable when creating an Assets object structure from an LDAP server. The option will append the namespace e.g. `cn=users,ou=company,=dc=example, dc=com` to the object type description. The value is not used while performing synchronizations.

⚠️ Be sure you test the synchronization in a test environment before doing it in production.

Scheduling fields are responsible for keeping your data in sync:

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Synchronizing Account</td>
<td>The Jira user to use when synchronize data into Insight</td>
</tr>
<tr>
<td>Cron Expression</td>
<td>The interval for the automatic synchronization.</td>
</tr>
<tr>
<td>Automatically Synchronize</td>
<td>If the import should be scheduled for automatic synchronization.</td>
</tr>
</tbody>
</table>

Pre-defined structure and configuration

In the next step, after you’ve filled in the required fields, Assets will ask you whether you want to create a predefined structure (object type mappings) and configuration (attribute mappings). Details of this will differ depending on the import type. Some object type mappings are disabled by default, so make sure to select the relevant ones.

You can import users or groups from only one Organizational Unit (OU) during an Assets LDAP import. For more information, see How to import users or groups from specific OUs with Assets LDAP import.

Here’s some details for the LDAP import:

The structure will be created based on the result from the LDAP server. When creating the predefined structure a query will be sent to the LDAP server with the configuration specified and fetch the result. Based on the result an object type hierarchy will be created. Each node (identified by DN) that has children will be treated as an object type and created. The attributes belonging to the Assets object type will be the attributes found on the node in the LDAP server.

If the result returned by LDAP server retrieves objects that don’t have children, then it will be not possible to create a predefined structure automatically and it should be created manually.

The predefined structure will create two additional attributes for each object type. The attribute CN (Common Name) will be used as label and the attribute DN (Distinguished Name) will be set with the property hidden.

All attributes created by the predefined structure in the LDAP import will be of type Default Text. If the data represent something else review the attributes and change them accordingly.

Example
The predefined configuration will query the LDAP server and create a configuration mapping based on the same criteria as the structure described above. As data locators all attributes found will be choosable with the addition of the CN (Common Name) and the DN (Distinguished Name).

The identifier will be set to DN for each object to uniquely identify each object from the LDAP server.

Since the predefined configuration will be different based on the connected LDAP server the following is one example mapping the Employees as seen in the previous example

Example

If the LDAP import is configured to import users one can use the REGEX configuration to split users in order to create multiple users.

Import configuration created

You can now view your import configuration, but it’s not ready yet. You still need to create or review the object type and attribute mapping, and make sure there are no problems with your import configuration.

When you’re ready, go to 2. Create object type and attribute mapping.

Before you go
In the next step, you'll create the object mapping settings. Here are some settings specific to the LDAP import type.

**Object type mapping**

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
</table>
| **Selector** | In the LDAP import type the Selector is prepended to the Base DN value before the search in LDAP is executed. The value is used to narrow down the structured tree in the LDAP to specific nodes.  

The search filter will be the same as specified in the general configuration but the selector will narrow the scope where the search filter is applied.  

For example:  

If the Base DN is `dc=ad, dc=example, dc=com` and the Selector is `cn=users` the resulting LDAP search base will be `cn=users, dc=ad, dc=example, dc=com`. |
Object schema import

Import structured data from an Assets object schema (Object Types, Attributes, and Objects). You can import data from another schema on the same server, or from an object schema on an entirely different server. Learn more about importing

Some use cases could be:

- Synchronize two different servers, each running a different object schema.
- Create a staging instance containing a subset of the full data from an object schema.
- Synchronize data between a master server and a set of child servers that contain a subset of the full data.

This import type won't include your schema's automation rules, roles, or any other configuration.

You need to be an Assets Manager for an object schema to create, configure, and enable imports.

Import fields

Once you've chosen your import type, you'll need to enter details about it. Here's the description of fields you should see in Assets.

Create Import configuration

Here are general fields, common for every import type:

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>The name of the import.</td>
</tr>
<tr>
<td>Description</td>
<td>The description for your convenience.</td>
</tr>
<tr>
<td>Concatenator</td>
<td>You can specify a default concatenator. When joining multiple data locators into one Insight attribute, this will be the default concatenator. One example could be to join two columns like &quot;First name&quot; and &quot;Last name&quot; into one attribute. So &quot;Mathias&quot; (first name) and &quot;Edblom&quot; (last name) will be concatenated as &quot;Mathias Edblom&quot; if using \s as concatenator. Enter \s for space-concatenated. To include a concatenate character, place the value between double quotes (i.e &quot;\s&quot;).</td>
</tr>
<tr>
<td>Empty Values</td>
<td>Defines what should happen when a Data Locator is empty. Should the import remove the attribute value or just ignores it and leave the current value as is.</td>
</tr>
<tr>
<td>Unknown Values</td>
<td>Defines what should happen if a Data Locator is unknown to Insight. This could happen with attribute types like &quot;Status&quot; and &quot;Select&quot;. The value can be added as an option or just ignore the value.</td>
</tr>
<tr>
<td>Date Format</td>
<td>Format for date fields in import source to convert dates into Insight. If left empty, Insight will automatically try to find correct format. The format should be specified according to the <a href="https://docs.oracle.com/en/java/javase/11/docs/api/java.base/java/text/SimpleDateFormat.html">Java SimpleDateFormat guidelines</a>.</td>
</tr>
</tbody>
</table>
These fields are specific to an import type (module).

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>URL</td>
<td>The URL of the server that is running Jira with Assets.</td>
</tr>
<tr>
<td>Username</td>
<td>The username for authentication with the other server.</td>
</tr>
<tr>
<td>Password</td>
<td>The password for authentication with the other server.</td>
</tr>
<tr>
<td>Object Schema</td>
<td>The Name or Object Schema ID for the target server.</td>
</tr>
</tbody>
</table>

Scheduling fields are responsible for keeping your data in sync:

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Synchronizing Account</td>
<td>The Jira user to use when synchronize data into Insight</td>
</tr>
<tr>
<td>Cron Expression</td>
<td>The interval for the automatic synchronization.</td>
</tr>
<tr>
<td>Automatically Synchronize</td>
<td>If the import should be scheduled for automatic synchronization.</td>
</tr>
</tbody>
</table>

Object collision

Because of the possibility the two synchronizing servers might contain objects with the same name, every object imported from another server is assigned an **External Hash Key** as an attribute. This hash key is built by appending the URL, schema ID, and the object key to create a longer, unique hash.

Pre-defined structure & configuration

In the next step, after you've filled in the required fields, Assets will ask you whether you want to create a predefined structure (object type mappings) and configuration (attribute mappings). Details of this will differ depending on the import type.

Here's some details for the object schema import:

- The predefined structure and configuration will be based upon the existing configuration of the target Assets object schema.
- Some object type mappings are disabled by default, so make sure to select the relevant ones.

Import configuration created

You can now view your import configuration, but it's not ready yet. You still need to map any object references or attributes between your source and Assets.

When you're ready, go to 2. Create object type and attribute mapping.
2. Create object type and attribute mapping

Once your base import configuration is created, you need to map your data to object types and their attributes. You might not need to create full mappings if you've chosen to create a predefined structure and configuration, but this page will help you to review and edit them, if needed.

View your import configuration

Just to make it easier to see where you are, here's a sample import configuration without mappings created (it's invalid because it doesn't have any object type mappings).

Create object type mapping

To create object type mapping:

1. When viewing your import configuration, select Create object type mapping.
2. Specify the required fields.
3. Remember that every object type mapping imports your data into a single object type. If you have more object types, you'll create more object type mappings on the same import configuration. Before you start adding another object type mappings, complete the attribute mapping, as described below.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Object type</strong></td>
<td>The Assets object type you want to import your data into. This value can't be changed, you need to create a new object type mapping to import into another object type.</td>
</tr>
<tr>
<td><strong>Selector</strong></td>
<td>This will differ based on your import type. See your type for details:</td>
</tr>
<tr>
<td></td>
<td>• CSV import (doesn't use the selector)</td>
</tr>
<tr>
<td></td>
<td>• Database import</td>
</tr>
<tr>
<td></td>
<td>• Jira users import</td>
</tr>
<tr>
<td></td>
<td>• JSON import</td>
</tr>
<tr>
<td></td>
<td>• LDAP import</td>
</tr>
<tr>
<td></td>
<td>• Object schema import</td>
</tr>
<tr>
<td><strong>Filter data source by AQL</strong></td>
<td>You can filter the data to be imported by AQL before it's actually imported. For example, if you're importing data into Computers object type, you can choose to only import PCs, and not Macs.</td>
</tr>
<tr>
<td></td>
<td><strong>Filter on object references</strong></td>
</tr>
<tr>
<td></td>
<td>You can't filter based on object references. These are handled separately after the object is created or updated.</td>
</tr>
<tr>
<td></td>
<td>Here's a video that explain how to split your import source into different object types using AQL:</td>
</tr>
</tbody>
</table>

564
| Missing objects | Choose what to do if an object is missing in the data source (but exists in Assets):
| Update: Update the object with a predefined value to a specified attribute. The Threshold configuration will apply.  
Delete: Delete the object from Assets. The Threshold configuration will apply.  
Ignore: Just let the object be. |
| Missing objects outbound references | Choose what to do if a referenced object (referenced from an existing object in your data source) is missing in the data source. For example, if an import is configured to import the referenced Host and Application object types, and one of them is missing.
| Remove: The outbound reference to a missing object will be removed.  
Ignore: Leave the reference as is. |
| Threshold type | When objects are missing in the data source, you can specify a threshold for the Update and Delete configurations. This means that Assets will wait with performing these actions until the conditions specified in the threshold are met (days or synchronizations).
When you set the Threshold type to Synchronizations and the Threshold number to 1, missing objects will only be removed starting from the second synchronization. Similarly, if you set the Threshold number to 2, missing objects will be removed from the third synchronization onwards. |
| Threshold number | The number of days or synchronizations before performing the actions described above. If you want to remove missing objects from the first synchronization onwards, set the Threshold number to 0. |
| Empty values | Defines what to do if a Data locator is empty. Should the import remove the attribute value or just ignore it and leave the current value?  
This overrides the ‘General fields’ configuration of your import type for this object mapping. |
| Unknown values | Defines what to do if a Data locator is unknown to Assets. This can happen with attribute types like "Status" and "Select". The value can be added as an option or just ignored.  
This overrides the General fields configuration of your import type for this object mapping. |
| Match identifier | Case sensitive - Identifier AQL will be built up with STRICT_EQUAL (==) which means that for text attributes, identifiers will be compared respecting case, 'Data Value' will NOT be considered the same as 'data value'.  
Case insensitive - Identifier AQL will be built up with EQUAL (=) which means that for text attributes, identifiers will be compared ignoring case, 'Data Value' will be considered the same as 'data value'. |

Create attribute mapping

Once your object type mapping is created, you can expand it to see the attribute mapping. Attribute mapping is created for each object type mapping separately, as you’ll map data locators from your data source to the object type’s attributes in Assets. There needs to be at least one attribute mapping for every object type mapping.
Specifies if the attribute should be considered a part of the object identifier. If multiple attributes are used as identifiers, the combined value will be used to identify the object and duplicates. This is used to construct an internal AQL responsible for identifying objects.

For example, if two import attributes are configured for Assets attributes First Name and Last Name, and specified as identifiers, the following AQL will be used to identify objects in Assets:

```
"First Name" == <first name value from source> AND "Last Name" == <last name value from source>
```

All attributes can be identifiers. But, for best performance, try to use the default attribute types as much as you can. For example, if using "User" attribute as identifier, we will have to query the Jira API to find users from the data source for the configured data locator. This means that Jira might be a bottleneck in this case if you have a large User directory. Try in this case to add another attribute for the user key (Default / Text) and the import will be much faster.

If you are importing objects from a CSV file into Assets, you must identify the objects by the attribute that is assigned as a label, not their name or key. The object key is generated automatically when an object is created manually or via import. Even if the object key is present in the source file (say CSV or JSON), a new object and its key will be generated instead of using the one in the source file, especially if the object key is the identifier. This could result in multiple duplicates.

Every import type needs to provide data locators. It’s what Assets recognizes as a category that holds your data. For example, in CSV import, all columns are data locators.

The Assets attribute to which you want to map the data locator, and import its data.

Only used for Assets attributes of type Object (references between objects).

In this case, you need to provide an AQL to fetch the objects to set, depending on the data provided by the Data Locator. In the examples that follows, Name is a reference to the value in Assets that the referenced object has, in the attribute Name.

You can use place holders in the AQL like:

- For single attributes (max cardinality equals 1) the AQL with the placeholder could look like this:

  ```
  Name = ${DATA LOCATOR}
  ```

- For multiple attributes (max cardinality larger then 1) the AQL with the placeholder could look like this:

  ```
  Name IN (${DATA LOCATOR}{0})
  ```

  The "0" (zero) stands for all values, and 1 for the first value, 2 for the second value and so on.
For more info, see Understanding import concepts.

Description for the attribute mapping, just for convenience.

You can access other configuration by selecting the cog icon next to your attribute mapping.

**Concatenator**

When joining multiple data locators into one Assets attribute, this works as the default concatenator.

**Regular expression**

You can use regular expressions to edit the value from the import source.

For the regular expression we use Java syntax [https://docs.oracle.com/javase/7/docs/api/java/util/regex/Pattern.html](https://docs.oracle.com/javase/7/docs/api/java/util/regex/Pattern.html). If the regular expression does not find any match the attribute is left empty. It is possible to extract from the value given by the Data Locator by making what you wish to extract the first group in the regular expression, for example using the regular expression "(\w*)\W" (quotation marks excluded) on the value "Blue Whale" yields "Blue" to the corresponding attribute. If there is no group present and the regex finds a match the whole value is given.

Some examples:

<table>
<thead>
<tr>
<th>Purpose</th>
<th>Pattern</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>Validate that input contains at least one digit</td>
<td>\d</td>
<td>&quot;foo 123 bar&quot; is returned as is but &quot;foo bar&quot; gives empty attribute value</td>
</tr>
<tr>
<td>Extract first digit</td>
<td>(d)</td>
<td>&quot;foo 123 bar&quot; gives 1 but &quot;foob&quot; gives empty attribute value</td>
</tr>
<tr>
<td>Extract only first word of text</td>
<td>(\w*)\W</td>
<td>&quot;Blue whale&quot; becomes &quot;Blue&quot;</td>
</tr>
<tr>
<td>Shorten number to show only two decimals</td>
<td>(\d*.\d\d)</td>
<td>12.3456 becomes 12.34</td>
</tr>
</tbody>
</table>

Next steps

When you're ready with your mappings, go to 3. Inspect your import configuration.
3. Inspect your import configuration

You can quickly view any elements of your import configuration that have been changed or are missing (from the expected configuration). Although you should strive for perfection, any problems here doesn't necessarily mean that your configuration is wrong, if you mapped things differently on purpose.

To inspect your import configuration,

1. Open your import configuration.
2. Select the cog icon next to it, and select **Inspect configuration**.

Results

Here are some sample results:

- **Changed**: Data locator is called differently in your data source and the attribute it's mapped to. This doesn't break your import (if the mapping is done properly), but you might want to have a look why you have these differences.
- **Missing**: The expected attribute mapping is missing.

If you're seeing problems, go back to your import configuration and check what's wrong. Make sure the data you're importing is mapped to the relevant attributes.

Next steps

When your import configuration looks fine, go to 4. **Enable and sync your import**.
4. Enable and sync your import

When your import configuration is ready (you're just about starting to import your data), you can enable your mappings and the configuration itself, and sync them.

Enabling object type mappings

To enable the object mappings:

1. Select the cog icon next to the object type mapping, and select Enable.
2. You can keep some mappings disabled if you're not ready to import the related data.
3. You can also synchronize only some of your object type mappings. In any case, you need to enable your import configuration before you can sync any mappings.

Enabling and syncing your import

To enable and sync your import configuration:

1. Select the cog icon next to the object type mapping, and select Enable.
2. If your mappings are ready, also select Synchronize for your whole configuration. This will sync any object type mappings that are enabled.
3. To configure regular synchronization for your import (if you haven't done that when creating your import), go to Configure, and move to Scheduling fields.

Finishing up

If everything went ok, your data should be imported to your object types. If you're missing something, go back to your configuration and edit the fields or the mappings. It might be useful to watch some of our videos on importing to get a better understanding of how imports work. Learn more about importing concepts
Searching for objects

To open the object view search, select **Assets** > **Search for objects**. You can either AQL or FreeText in the text box:

- **FreeText** will search the text of all objects and object attributes for relevant strings, but will not search any non-string data.
- **AQL** can be used to create more advanced queries using logical statements, placeholders, and references. In the object search screen, the built-in autocomplete will assist you in creating AQL searches. For more info, see **AQL - Assets Query Language**.

When you launch any of your favorite search filters, you get a smoother search feedback when the results are being displayed.

1. **Filters**: List of saved and favorite filters, just like in issue search.
2. **Type of search**: Here you can switch between basic (FreeText) and advanced (AQL) search.
3. **Objects**: Search results, or the list of objects found.
4. **Bulk actions**: Actions that you can perform on your search results.

Manage your search results

Here’s what you can do with your search results:

<table>
<thead>
<tr>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Rearrange columns</td>
<td>Drag and drop columns to rearrange them. Use the <strong>Columns</strong> option to show or hide specific columns, and pin them so they’re permanently displayed.</td>
</tr>
<tr>
<td>View object’s graph</td>
<td>Create a new object from your search by selecting <strong>Create object</strong> in the panel at top-left.</td>
</tr>
<tr>
<td>Edit, move, or delete objects</td>
<td>Edit, move or delete objects that are the results of your search using the <strong>options</strong> button that appears on the right when you hover over your results.</td>
</tr>
<tr>
<td>Share or export search results</td>
<td>When viewing your search results, just select <strong>Share</strong> or <strong>Export</strong> to share your results or export them into CSV.</td>
</tr>
<tr>
<td>Save search results</td>
<td>Save your search results for later use by selecting <strong>Save as</strong> at the top-right. Saved search results become filters, and are displayed in the left-hand side menu.</td>
</tr>
</tbody>
</table>
Manage your filters

Searches that you saved, or filters that have been shared with you, appear as filters in the panel on the left. You can select the **Options** menu next to a filter name to edit, delete, or remove it from your favorites.

Modify multiple objects with bulk actions

You can also modify multiple objects from your search results.

1. When viewing your search results, select **Bulk**, and choose one of the bulk actions.
2. In the next step, you’ll be able to select specific objects by selecting them. This helps you to further limit the objects you want to complete a bulk action on.

Advanced search: AQL - Assets Query Language

Ready for some more advanced information? AQL can be used to create advanced queries using logical statements, placeholders, and references. You’ll see it not only to search for your objects, but also to call them out when configuring custom fields and relations between objects.

- Advanced searching: AQL - Assets Query Language
- Advanced: Placeholders
- Assets JQL functions
Advanced searching: AQL - Assets Query Language

AQL (Assets Query Language) is a language format used in Assets to create search queries for one or more objects. Using AQL, you can return any object or group of objects in Assets in a search, filter objects, modify objects, create custom fields, automations and post-functions, and more.

Basic syntax

The basic syntax of an AQL query is `<attribute> <operator> <value/function>`. One or more objects is returned by the query when the attributes of these objects match the operator and value specified.

Example

- A basic AQL query that returns all objects for which the Owner is "Jennifer Evans". Note the quotations around "Jennifer Evans" they're needed because of a space in the value name.

```
AQL search   Owner = "Jennifer Evans"
```

Syntax for special characters

AQL has a defined syntax and must be entered exactly.

- AQL is case-sensitive.
- If you are using an expression where the value or attribute contains a space, you must include quotations surrounding the value, for example "Ted Anderson".
- If you are using an expression where the value or attribute contains quotation marks, you must escape the quotes by surrounding them with backslashes. For example, if you have an object name such as "15" Screen", to search for it enter: "15" Screen"
- The attribute name that you specify in the AQL must exist in your Assets schema. If not, the AQL will be considered invalid. The attribute name is case sensitive.

Dot notation

Dot notation is used in AQL to travel down a reference chain of objects. The format `<attribute>.<attribute> <operator> <value/function>` will return information based upon objects referenced by the parent object.

Example

- In this case, the Employee object type has a referenced attribute called "Belongs to Department". The query returns all the Employees which belong to the "Management" department.
Keywords

You can use keywords in AQL to return one or more objects based upon properties of those objects instead of the object's attributes. The syntax looks like this: `<keyword><operator> <value/function>`.

For example, you could return all objects of a specific object type using the `objectType` keyword, or all objects of any type with a certain attribute by using the `anyAttribute` keyword. The table below describes the keywords supported along with their respective examples.

<table>
<thead>
<tr>
<th>Keyword</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><code>objectType</code></td>
<td>You can limit the search result to a specific object type name, e.g. <code>objectType = &quot;Employment Start Date&quot;</code>. Note that the since the attribute contains spaces, it is enclosed within a pair of double quotes.</td>
</tr>
<tr>
<td><code>objectTypeld</code></td>
<td>You can limit the search result on object type ids. e.g. <code>objectTypeld in (1, 2)</code>.</td>
</tr>
</tbody>
</table>
| `anyAttribute` | You can search all attributes on all objects for a relevant match. e.g. "anyAttribute = 123.123.123.123".  
  
  *Note that the use of this keyword may cause delays in searching results. The larger the Assets installation, the more time it will take to execute a query with this keyword.* |
| `object` | You can limit the search to the object, e.g. "object having inboundReferences()" will search all objects having any inbound references to it. |
| `objectId` | You can find an object by object Id, e.g. "objectId = 114". Note that the object id is the number from the Key of the object, but without the prefix. E.g. if the Key of your object is ITSM-1111, then the prefix is ITSM and the object id is 1111. Note that the Key could change when you move objects across schemas. |

Example
• An AQL query that returns all objects with the "Computers" object type

![AQL query result](image)

Operators

Operators allow you to create more detailed logical expressions.

The table describes the operators supported in AQL.

<table>
<thead>
<tr>
<th>Operator</th>
<th>Description</th>
<th>Example AQL query</th>
</tr>
</thead>
</table>
| =        | Equality test for case insensitive values. | "Office = Stockholm"
|          | Checks if the Office attribute has a value equal to Stockholm or STOCKHOLM |
| ==       | Equality test for case sensitive values. | "Office==Stockholm"
|          | Checks if the Office attribute has a value equal to Stockholm considering the case of the input provided. |
| !=       | Inequality test | "objecttype=Employee and Office!=Stockholm"
|          | Checks if the Employee object has an attribute Office whose value is NOT equal to Stockholm. |
| <        | Less than test. | "Price < 2000"
|          | Checks if the Price is less than 2000 dollars. |
| >        | Greater than test. | "Price > 2000"
|          | Checks if the Price is greater than 2000 dollars. |
| <=       | Less than or equal to test | "Price <= 2000"
|          | Checks if the Price is less than or equal to 2000 dollars. |
| >=       | Greater than or equal to test. | "Price >= 2000"
|          | Checks if the Price is greater than or equal to 2000 dollars. |
| like     | Matches a value with any subset of input in the query. It is case insensitive. | "objecttype=Employees and Office like Stock"
<table>
<thead>
<tr>
<th>Operator</th>
<th>Description</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>not like</td>
<td>Excludes values which match with any subset of input in the query.</td>
<td>&quot;objecttype=Employees and Office not like Stock&quot;</td>
</tr>
<tr>
<td>in()</td>
<td>Finds a match in the given arguments and returns results.</td>
<td>Office in (&quot;Stockholm&quot;, &quot;Oslo&quot;, &quot;San Jose&quot;)</td>
</tr>
<tr>
<td>not in()</td>
<td>Excludes the results for which a match is found in the given arguments.</td>
<td>Office not in (&quot;Stockholm&quot;, &quot;Oslo&quot;, &quot;San Jose&quot;)</td>
</tr>
<tr>
<td>startswith</td>
<td>Finds a match whose value starts with the given input. It is case insensitive.</td>
<td>&quot;Office startsWith St&quot;</td>
</tr>
<tr>
<td>endswith</td>
<td>Finds a match whose value ends with the given input. It is case insensitive.</td>
<td>&quot;Office endsWith St&quot;</td>
</tr>
<tr>
<td>is</td>
<td>Helps test whether a value exists or not.</td>
<td>&quot;Office is EMPTY&quot;</td>
</tr>
<tr>
<td>dot operator</td>
<td>Helps navigate the Referenced object's attributes for an object.</td>
<td>&quot;Country.Office = Stockholm&quot;</td>
</tr>
<tr>
<td>having</td>
<td>Used with either inboundReferences() OR outboundReferences() functions</td>
<td>&quot;object having inboundReferences()&quot;</td>
</tr>
<tr>
<td>not having</td>
<td>Used with either inboundReferences() OR outboundReferences() functions</td>
<td>&quot;object not having inboundReferences()&quot;</td>
</tr>
</tbody>
</table>
Example

- An AQL query that uses the **IN** operator and **objectType** to return objects of three different object types.

![Example query using IN operator and objectType]

Combination operators

You may use operators such as AND/OR to create larger and more complex AQL expressions.

Example

- An AQL query that includes two statements linked with the AND operator

![Example query using AND operator]

Functions
You can use different functions to supply dynamic values to AQL expressions.

<table>
<thead>
<tr>
<th>Type</th>
<th>Function name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Date</td>
<td>now()</td>
<td>You can use a range of functions to write queries which involve date and time.</td>
</tr>
<tr>
<td></td>
<td>startOfDay()</td>
<td>We use <code>m</code> for minutes, <code>h</code> for hours, <code>d</code> for days and <code>w</code> for weeks to represent relative time.</td>
</tr>
<tr>
<td></td>
<td>endOfDay()</td>
<td>e.g. A query with a condition like: <code>Created &gt; &quot;now(-2h 15m)&quot;</code> returns all objects created in the last 2 hours and 15 minutes.</td>
</tr>
<tr>
<td></td>
<td>startOfWeek()</td>
<td>e.g. A query containing something like: <code>objectType = Employees and &quot;Employment End Date&quot; &lt; endOfMonth(-90d)</code> returns all Employee objects</td>
</tr>
<tr>
<td></td>
<td>endOfWeek()</td>
<td>whose <code>Employment End Date</code> falls before 90 days from the current month's end date.</td>
</tr>
<tr>
<td></td>
<td>startOfMonth()</td>
<td>e.g. You may also check for an upcoming date, e.g. check when the license of a software expires by the end of the year. Your query can then</td>
</tr>
<tr>
<td></td>
<td>endOfMonth()</td>
<td>include something like: <code>licenseEndDate = endOfYear()</code></td>
</tr>
<tr>
<td></td>
<td>startOfYear()</td>
<td>You can use all other date functions in a similar manner.</td>
</tr>
<tr>
<td></td>
<td>endOfYear()</td>
<td></td>
</tr>
<tr>
<td>IP Address</td>
<td>CIDR(IP RANGE)</td>
<td>CIDR(IP RANGE)-Filter on IP ranges</td>
</tr>
<tr>
<td></td>
<td></td>
<td>e.g. &quot;IP Address&quot; IN CIDR(&quot;192.0.0.0/8&quot;)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>&quot;IP Address&quot; IN CIDR(&quot;192.168.0.0/16&quot;)</td>
</tr>
<tr>
<td>User</td>
<td>currentUser()</td>
<td>You can filter on user attributes connected to the current (logged in) user by invoking this function in your AQL query. Note that the</td>
</tr>
<tr>
<td></td>
<td></td>
<td>attribute used in the query for filtering needs to be of type User.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>e.g. <code>objectType = Computer and User = currentUser()</code></td>
</tr>
<tr>
<td></td>
<td></td>
<td>This function will work when a <code>currentUser</code> is selected, i.e. the user is logged in.</td>
</tr>
<tr>
<td></td>
<td>currentReporter()</td>
<td>You can filter on user attributes connected to current reporter in custom fields by invoking this function in your AQL query. Note that the</td>
</tr>
<tr>
<td></td>
<td></td>
<td>attribute used in the query for filtering needs to be of type User.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>e.g. <code>User = currentReporter()</code></td>
</tr>
<tr>
<td></td>
<td></td>
<td>This function will only work when an issue is selected, and refers to the reporter that appears in the current issue.</td>
</tr>
<tr>
<td></td>
<td>user(user1,</td>
<td>You can filter on objects which have a reference to the users that you provide in the argument list of the function. The attribute used</td>
</tr>
<tr>
<td></td>
<td>user2, ..)</td>
<td>to filter must be of User type.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>This function will work with multiple arguments only if the <code>User</code> type attribute that you filter on allows multiple values i.e. the</td>
</tr>
<tr>
<td></td>
<td></td>
<td>cardinality for it is more than one.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>e.g. An object type <code>Team</code> has an attribute <code>Member</code>. This attribute is of <code>User</code> type. Additionally, this attribute has been configured to</td>
</tr>
<tr>
<td></td>
<td></td>
<td>have a cardinality of 3. If you want to search a set of <code>Team</code> objects where the users: <code>admin</code> and <code>manager</code> are its members, you can</td>
</tr>
<tr>
<td></td>
<td></td>
<td>write the following query: <code>objectType = Team and Member having user(&quot;admin&quot;, &quot;manager&quot;)</code></td>
</tr>
</tbody>
</table>
Group

<table>
<thead>
<tr>
<th>Group</th>
<th>Filter on any object connected to a user within a specific group. The attribute used to filter has to be of <em>User</em> type.</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Example: <code>User in group(&quot;jira-users&quot;, &quot;jira-administrators&quot;)</code></td>
</tr>
</tbody>
</table>

User

<table>
<thead>
<tr>
<th>User</th>
<th>Filter on any object connected to a user within a specific group. The attribute used to filter has to be of <em>Group</em> type.</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Example: <code>Group having user(&quot;currentReporter()&quot;)</code></td>
</tr>
</tbody>
</table>

Project

<table>
<thead>
<tr>
<th>Project</th>
<th>Filter on any object connected to the currently selected Jira project. Works only in the context of a ticket.</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Example: <code>Project = currentProject()</code></td>
</tr>
</tbody>
</table>

Reference functions

Reference functions are functions that take two arguments - AQL and/or a reference-type argument. Essentially, you can use reference functions to run an AQL query on a subset of objects of a particular reference type. Such a query will run on a small subset of the total objects, which allows you to limit results and/or processing time.

- The **AQL argument** can be an arbitrary AQL including an AQL with reference function.
- The **Reference Type argument** is optional.

<table>
<thead>
<tr>
<th>Sr. no</th>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>a</td>
<td></td>
<td>Filter objects having inbound references where the referenced objects match the AQL query</td>
</tr>
<tr>
<td></td>
<td></td>
<td>e.g. An AQL query like: <code>object having inboundReferences()</code> will return all objects having inbound references.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>But an example query like: <code>object having inboundReferences(Name=&quot;John&quot;)</code> will return all objects having inbound references where the referenced object has the attribute Name with the value &quot;John&quot;.</td>
</tr>
</tbody>
</table>

| b      |      | This is a variant of the `inboundReferences(AQL)` function described in (a) |
|        |      | Using this, you can filter the inbound referenced objects further by providing the **Reference Type** argument. |
|        |      | Reference Type is the **Additional Value** field that you provide on an attribute when you define a referenced object in the object type definition.
# Employees

*No description*

<table>
<thead>
<tr>
<th>Id</th>
<th>Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>313</td>
<td>Key</td>
</tr>
<tr>
<td>314</td>
<td>Name</td>
</tr>
<tr>
<td>315</td>
<td>Created</td>
</tr>
<tr>
<td>316</td>
<td>Updated</td>
</tr>
<tr>
<td>501</td>
<td>Active</td>
</tr>
<tr>
<td>502</td>
<td>Email Address</td>
</tr>
<tr>
<td>503</td>
<td>Username</td>
</tr>
<tr>
<td>504</td>
<td>Manager</td>
</tr>
<tr>
<td>505</td>
<td>Phone</td>
</tr>
<tr>
<td>506</td>
<td>Computer</td>
</tr>
<tr>
<td>507</td>
<td>Country</td>
</tr>
<tr>
<td>508</td>
<td>Office</td>
</tr>
</tbody>
</table>
e.g. An AQL query like this: `object having inR(objectType = "File System", refType IN ("Depends"))` will return objects which have inbound referenced objects of "File System" and only for those.

Similarly, an AQL query like: `object having inR(objectType = "File System", refType IN ("Depends", "Installed", "Using"))` will return objects which have inbound referenced objects of "File System" and only for those.

Filter objects having outbound references where the referenced objects match the AQL query provided as an argument to the function. 

**Filter objects having outbound references where the referenced objects match the AQL query provided as an argument to the function.**

```
object having outboundReferences() `will return all objects having outbound references since the empty AQL argument to the function will match all outbound referenced objects.
```

But an example query like: `object having outboundReferences(Name="John")` will return all objects which have an outbound referenced object with an attribute Name and value for Name as "John".

**This is a variant of the outboundReferences(AQL) function described in (b). Using this, you can filter the outbound referenced objects further by providing the Reference Type is the Additional Value field that you provide on an attribute when you define objects. An AQL query like this: `object having outR(objectType = "Employees", refType IN ("Location", "Country"))` will return objects which have outbound referenced objects of "Employees" and only for those Employees.

Similarly, an AQL query like: `object having outR(objectType = "Employees", refType IN ("Location", "Country"))` will return objects which have outbound referenced objects of "Employees" and only for those Employees.
Example

- An AQL query that uses the inR function to return all objects that are of object type "Computers", and have inbound references of type "A reference" or "IP Address"

Using the `connectedTickets()` function

The `connectedTickets()` function is used to filter objects having tickets connected to them. Specific Jira issues may be selected by providing a proper Jira Query Language (JQL) query. If no JQL query is provided, all objects having Jira issues connected are returned.

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><code>connectedTickets()</code></td>
<td>All objects having tickets connected to them are returned.</td>
</tr>
<tr>
<td><code>connectedTickets(JQL query)</code></td>
<td>Object having tickets connected to them that match given JQL query are returned.</td>
</tr>
</tbody>
</table>
- This query runs a JQL query (labels IS empty) on all connected issues, and then returns objects based on the results.

![Jira Service Management search interface](image)

**Using the `objectTypeAndChildren()` function**

This function is used to return objects (and their children) of a specific object type.

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><code>objectTypeAndChildren(Name)</code></td>
<td>Filter objects based on the object type specified by the Name and its children. If the name contains spaces, make sure you enclose it within a pair of double quotes.</td>
</tr>
<tr>
<td><code>objectTypeAndChildren(ID)</code></td>
<td>Filter objects based on the object type specified by the ID and its children.</td>
</tr>
</tbody>
</table>

**Example**

<table>
<thead>
<tr>
<th>Key</th>
<th>Object Type</th>
<th>Label</th>
</tr>
</thead>
<tbody>
<tr>
<td>PROJ-ITSM-97</td>
<td>Memory</td>
<td>32GB DDR4-2400 ECC REG DIMM</td>
</tr>
<tr>
<td>PROJ-ITSM-34</td>
<td>Network...</td>
<td>Apc Network Management Card 2</td>
</tr>
<tr>
<td>PROJ-ITSM-72</td>
<td>Business...</td>
<td>Billing Service</td>
</tr>
<tr>
<td>PROJ-ITSM-73</td>
<td>Business...</td>
<td>Email Service</td>
</tr>
<tr>
<td>PROJ-ITSM-74</td>
<td>Business...</td>
<td>ERP Service</td>
</tr>
<tr>
<td>PROJ-ITSM-26</td>
<td>Servers</td>
<td>exchange.prod.app1</td>
</tr>
<tr>
<td>PROJ-ITSM-30</td>
<td>Servers</td>
<td>oracledb-11g-prod</td>
</tr>
<tr>
<td>PROJ-ITSM-75</td>
<td>Business...</td>
<td>Payroll Service</td>
</tr>
<tr>
<td>PROJ-ITSM-31</td>
<td>Servers</td>
<td>sap-erp-prod</td>
</tr>
</tbody>
</table>
Functions, references, and AQL can be combined in powerful ways. For example, you could add multiple object references to a custom field attached to an object, and then search those references for a specific key:

```
object HAVING inboundReferences(Key IN (${MyCustomField${0}}))
```

Or a specific label, by using dot notation:

```
object HAVING inboundReferences(Label IN (${Portfolios.label${0}}))
```

*Note that the above two queries make use of Assets placeholders.*

**Ordering**

You can order the results of your query by adding the following suffix to any AQL:

```
order by [AttributeName|label] [asc|desc]
```

**Good to know**

- If you do not specify an order by clause, the default will be ascending order by the *label* attribute of an object type.
- If the attribute specified in the order by clause is of the object reference type you can use dot notation to order by attributes on the referenced object. E.g. if you want to order by the referenced *Department* object of an *Employee* object, you can mention the clause like: order by Employee.Department. This can
be done in unlimited depth. However, note that the every dot in the order by clause will decrease the performance of that particular AQL.

- Missing values will appear at the top of the list. This will hold true if the order in the query is ascending order: "asc".
- The attribute name specified in the AQL must exist in Assets. If not, the AQL will be considered invalid. The attribute name is case sensitive.
- If the results do not contain the attribute specified in the "order by" clause the order of the objects returned will be arbitrary.
- The placeholder label can be used instead of the attribute name to order the objects by their configured label.

### Example

- These search results are ordered in descending order by their keys

![Example Diagram]
**Advanced: Placeholders**

Assets supports a wide range of different placeholders that allow you to dynamically replace a specified placeholder with anything from an Issue field value, Assets Object attribute value or other Assets related information depending on the context.

**When to use placeholders?**

Here are some use cases that will show you how placeholders work:

- Get an email when a license is about to expire, with the name and end date of that specific license.
- Set/update an object attribute with the value from an issue field when issue is transitioned to a specific status.

What these use cases have in common is that you know where to find the value, but not what the value will be at the time when you'll need it. Placeholders will find the right value.

**Placeholder structure**

The placeholders are structured like this:

```
${Name of placeholder}
```

or

```
${Name of placeholder${Number}}
```

The following table describes how placeholders are used, with some examples:

<table>
<thead>
<tr>
<th>Placeholder</th>
<th>What it does</th>
<th>Example placeholder</th>
<th>Replaced with value</th>
</tr>
</thead>
<tbody>
<tr>
<td>${Name of placeholder}</td>
<td>Replaces the content ${Name of placeholder} with the value matched by Name of placeholder</td>
<td>${Name}</td>
<td>One object</td>
</tr>
<tr>
<td></td>
<td></td>
<td>${Email}</td>
<td><a href="mailto:user@example.com">user@example.com</a></td>
</tr>
<tr>
<td>${Name of placeholder${0}}</td>
<td>Replaces the content ${Name of placeholder${0}} with all values matched by Name of placeholder. This is used to match multiple values e.g. when populating an attribute with multiple cardinality and all values will be one instance of that attribute. When replaced as text this is similar to the above example but when replaced in a multi value context this notation will render multiple values but the above will render one value as a comma separated string.</td>
<td>${Price${0}}</td>
<td>12</td>
</tr>
<tr>
<td></td>
<td></td>
<td>${Email${0}}</td>
<td><a href="mailto:user@example.com">user@example.com</a>, anotheruse <a href="mailto:r@example.com">r@example.com</a></td>
</tr>
<tr>
<td>${Name of placeholder${1}}</td>
<td>Replaces the content ${Name of placeholder${1}} with the first value matched by Name of placeholder. This is used when only the first value is required</td>
<td>${Price${1}}</td>
<td>12</td>
</tr>
<tr>
<td></td>
<td></td>
<td>${Email${1}}</td>
<td><a href="mailto:user@example.com">user@example.com</a></td>
</tr>
<tr>
<td>${Name of placeholder${n}}</td>
<td>Replaces the content ${Name of placeholder${n}} with the n:th value matched by Name of placeholder. This is used when only the n:th value is required</td>
<td>${Price${2}}</td>
<td>&lt;empty value&gt;</td>
</tr>
<tr>
<td></td>
<td></td>
<td>${Email${2}}</td>
<td>anotheruse <a href="mailto:r@example.com">r@example.com</a></td>
</tr>
<tr>
<td></td>
<td></td>
<td>${Email${4}}</td>
<td>&lt;empty value&gt;</td>
</tr>
</tbody>
</table>
Placeholder context

Placeholders can replace different data for different contexts (custom fields, automation, post functions).

Automation rules

For more info on automation rules, see Automation rules.

<table>
<thead>
<tr>
<th>Placeholder name</th>
<th>Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Attribute Name</td>
<td>The attribute value</td>
<td>The value of the attribute with the same name as the placeholder. This will render the attribute in the human readable form.</td>
</tr>
<tr>
<td>Attribute Name.id</td>
<td>The attribute value as stored</td>
<td>The value of the attribute with the same name as the placeholder. This will render the attribute in the form that is stored. e.g. if the attribute is an object reference this will render the referenced object id. This will only work on attributes that are stored with another value than presented.</td>
</tr>
<tr>
<td>label</td>
<td>The label of the object</td>
<td>The value is replaced by the configured label for the object.</td>
</tr>
<tr>
<td>objectType</td>
<td>The object type name of the object</td>
<td>The value is replaced by the object type name.</td>
</tr>
<tr>
<td>objectTypeId</td>
<td>The object type id</td>
<td>The value is replaced by the id of the object type of the current object.</td>
</tr>
<tr>
<td>objectId</td>
<td>The objects id (not the key)</td>
<td>The integer that identifies this object.</td>
</tr>
<tr>
<td>Key</td>
<td>The key of the object</td>
<td>The key value of the current object.</td>
</tr>
</tbody>
</table>

Object create / edit

When creating or editing objects with object reference attributes you can specify an AQL that is used to limit the selection of objects. The placeholders available are all the attributes available in the create/edit dialog.
Here's a video if you'd like to see how this can be done:

Post-functions

For more info on post-functions, see Post-functions.

The following post-functions support placeholders:

- Email user(s) based on attribute in a selected Assets object
- Set the value of an object attribute with a predefined value
- Assign object/s based on an AQL query

Custom fields

For more info on custom fields, see Assets custom fields.

The standard Assets custom field "Assets Object/s" supports placeholders for any issue field data. This is configured in the "Issue Scope AQL" and can be constructed as the following example:

```
Organisation = ${customfield_12345.name} AND Location = ${Country} AND "Issue Type" like ${issuetype.name}
```

The placeholders will be replaced with the identifiers for the specific underlying objects. Remember to use IN in the AQL if you have multiple values.

<table>
<thead>
<tr>
<th>Custom field key</th>
<th>Custom field name</th>
<th>${placeholder.id} / ${placeholder.key}</th>
</tr>
</thead>
</table>

<table>
<thead>
<tr>
<th>Placeholder name</th>
<th>Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Attribute Name</td>
<td>The attribute value</td>
<td>The value of the attribute with the same name as the placeholder. This will render the attribute in the human readable form</td>
</tr>
<tr>
<td>Attribute Name.id</td>
<td>The attribute value as stored</td>
<td>The value of the attribute with the same name as the placeholder. This will render the attribute in the form that is stored. e.g. if the attribute is an object reference this will be the id of the object that is referenced.</td>
</tr>
</tbody>
</table>
The placeholder won't work for Jira Service Management requests. You must use a custom field instead:

<table>
<thead>
<tr>
<th>${customfield_xxxxx}</th>
<th>&lt;Custom Field Name&gt;</th>
<th>The identifier</th>
<th>The label / name</th>
</tr>
</thead>
<tbody>
<tr>
<td>The identifier</td>
<td>The label / name</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

The table below shows the keys for issue placeholders to use for Jira fields. Make sure to use IN for multi values to not break the AQL:

<table>
<thead>
<tr>
<th>Issue key</th>
<th>Label / Description</th>
<th>Multiple</th>
<th>Type</th>
<th>${key.id}</th>
<th>${key.label}</th>
</tr>
</thead>
<tbody>
<tr>
<td>key</td>
<td>The Issue Key</td>
<td>false</td>
<td>String</td>
<td>key</td>
<td>key</td>
</tr>
<tr>
<td>affectedVersions</td>
<td>Affected Versions</td>
<td>true</td>
<td>Version</td>
<td>Id</td>
<td>Name</td>
</tr>
<tr>
<td>assignee</td>
<td>Assignee</td>
<td>false</td>
<td>ApplicationUser</td>
<td>userKey</td>
<td>Display Name</td>
</tr>
<tr>
<td>description</td>
<td>Description</td>
<td>false</td>
<td>String</td>
<td>description</td>
<td>description</td>
</tr>
<tr>
<td>dueDate</td>
<td>Due Date</td>
<td>false</td>
<td>Date</td>
<td>dueDate</td>
<td>dueDate</td>
</tr>
<tr>
<td>fixVersions</td>
<td>Fix Versions</td>
<td>true</td>
<td>Version</td>
<td>Id</td>
<td>Name</td>
</tr>
<tr>
<td>issuekey</td>
<td>Issuekey</td>
<td>false</td>
<td>String</td>
<td>key</td>
<td>key</td>
</tr>
<tr>
<td>environment</td>
<td>Environment</td>
<td>false</td>
<td>String</td>
<td>environment</td>
<td>environment</td>
</tr>
<tr>
<td>issuetype</td>
<td>Issue Type</td>
<td>false</td>
<td>IssueType</td>
<td>Id</td>
<td>Name</td>
</tr>
<tr>
<td>creator</td>
<td>Creator</td>
<td>false</td>
<td>ApplicationUser</td>
<td>userKey</td>
<td>Display Name</td>
</tr>
<tr>
<td>labels</td>
<td>Labels</td>
<td>true</td>
<td>String</td>
<td>labels</td>
<td>labels</td>
</tr>
<tr>
<td>components</td>
<td>Components</td>
<td>true</td>
<td>ProjectComponent</td>
<td>Id</td>
<td>Name</td>
</tr>
<tr>
<td>attachments</td>
<td>Attachments</td>
<td>true</td>
<td>Attachment</td>
<td>Id</td>
<td>filename</td>
</tr>
<tr>
<td>priority</td>
<td>Priority</td>
<td>false</td>
<td>Priority</td>
<td>Id</td>
<td>Name</td>
</tr>
<tr>
<td>pid</td>
<td>Project</td>
<td>false</td>
<td>Project</td>
<td>Id</td>
<td>Name</td>
</tr>
<tr>
<td>reporter</td>
<td>Reporter</td>
<td>false</td>
<td>ApplicationUser</td>
<td>userKey</td>
<td>Display Name</td>
</tr>
<tr>
<td>resolution</td>
<td>Resolution</td>
<td>false</td>
<td>Resolution</td>
<td>Id</td>
<td>Name</td>
</tr>
<tr>
<td>votes</td>
<td>Votes</td>
<td>true</td>
<td>Long</td>
<td>votes</td>
<td>votes</td>
</tr>
<tr>
<td>watchers</td>
<td>Watchers</td>
<td>true</td>
<td>Long</td>
<td>watchers</td>
<td>watchers</td>
</tr>
<tr>
<td>resolutionDate</td>
<td>Resolution Date</td>
<td>false</td>
<td>Date</td>
<td>resolutiondate</td>
<td>resolutiondate</td>
</tr>
<tr>
<td>created</td>
<td>Created</td>
<td>false</td>
<td>Date</td>
<td>created</td>
<td>created</td>
</tr>
<tr>
<td>updated</td>
<td>Updated</td>
<td>false</td>
<td>Date</td>
<td>updated</td>
<td>updated</td>
</tr>
<tr>
<td>status</td>
<td>Status</td>
<td>false</td>
<td>Status</td>
<td>Id</td>
<td>Name</td>
</tr>
<tr>
<td>summary</td>
<td>Summary</td>
<td>false</td>
<td>String</td>
<td>summary</td>
<td>summary</td>
</tr>
</tbody>
</table>

The `issuetype` placeholder won't work for Jira Service Management requests. You must use a custom field instead:
Wrong: issuetype

"Related Jira Projects" = currentProject() AND "Related Jira Issue Types"."Name" in (${issuetype.label}) AND Status = "Active"

Right: customfield

"Related Jira Projects" = currentProject() AND ("Related Jira Issue Types"."Name" in (${issuetype.label}) OR "Related Jira Issue Types"."Name" in (${customfield_10654})) AND Status = "Active"
Assets JQL functions

We provide a number of JQL functions that can be handy when searching for issue in Jira. Below we’ll describe how they work and what you can do with them. If you have any request for additional JQL functions, please let us know and we will add it to our backlog.

What is issueFunction below?

In the JQL examples below you will find something called customField. It is your custom field that you may add to your Jira instance. Remember that the name is of your own choice, so use the ones that you have created.

aqlFunction

Using the AQL function with object schema or specifying an object type in the AQL will increase performance by a lot. If the AQL function is used when calculating JSD SLA’s for instance, try to limit the AQL by adding object type name, schema id or object key since this will decrease the execution time of the query.

aqlFunction(aql)

aql is the AQL to filter on.

Example:

```
customField in aqlFunction("Customer.\"Account Manager\" = \"Mathias Edblom\"")
```

or

```
customField in aqlFunction("Host.Virtual = true")
```

This will filter any issues where an application is reported and where the application is installed on a virtual server.

aqlFunction(object schema name/id, aql) (Deprecated)

This one is deprecated since the object schema/s are determine by the custom field configuration it self. This possibility will be removed in future releases.

Object Schema Name/ID is the name (or id) of an object schema.

aql is the AQL to filter on.

attributeValue (Deprecated)

This JQL function is deprecated. Use the aqlFunction instead!

attributeValue(attribute, operator, value)

Attribute is the name of an object type attribute.
Operator can be one of the following: 

- `=`, `!=`, `<`, `<=`, `>`, `>=`, `like`, `startswith`, `endswith`

Value is the value to search on.

Example:

```plaintext
customField in attributeValue("salary", ">", "70000")
```

This will return all issues with an insight object connected and the object has an attribute “salary” and the value is more then 70000.

Example:

```plaintext
customField in attributeValue("Expiration Date", "<", "28/Jun/14")
```

This will return all issues with an insight object connected and the object has an attribute "Expiration Date" and the date is earlier then 28/Jun/14.

You may use `now()` to use current date. Use `now(90)` to add 90 days from today and similar query’s like `now(-30)`.

Example:

```plaintext
customField in attributeValue("Name", "like", "joh")
```

This will return all issues with an insight object connected and the object has “joh” somewhere in the name.

Example:

```plaintext
customField in attributeValue("Owner", ",=", "Mathias Edblom")
```

This will return all issues with an insight object connected and the Jira user "Mathias Edblom" is the owner of the object/s.

For User type, you may use "currentUser()" to filter on the current user. Ex: customField in `attributeValue("Owner", ",=", "currentUser()")`

Note that attribute name are case-sensitive in the attributeValue function!
Working with reports

In Assets, you can create reports to visualize your object schema in a variety of formats. Once your report is ready, you can share it with other users, export it to a file, print it or add it to your Jira dashboard for easy access to your data. The data in your reports is automatically updated in regular intervals, so you always have an up-to-date view of your assets.

- Report types
  - Attribute value count report
  - Attribute value report
  - Catalog report
  - Issue count report
  - Map report
  - Object count report
  - Object search
  - Payroll report
  - Two-dimensional report
  - User report

- Creating a report
- Working with reports in the Report manager
- Displaying a report on your Jira dashboard
- Viewing audit logs related to reports

Report types

Here are all report types that you can create in Assets:

**Attribute value count report**

A pie chart showing how the objects of an object type are distributed based on attributes.

**Attribute value report**

A chart showing attribute totals reported for one or more objects of a specific type.
Catalog report

A catalog of objects and their attributes.

Issue count report

A line or bar chart showing historical totals of issues reported for one or more object types or objects.
Map report

A world map showing the location of objects based on an attribute with geographical data. The objects must have a text attribute with a comma-separated latitude and longitude, for example -33.8,151.2 (Sydney).

Object count report

A line chart showing historical totals of objects for one or more object types.
Object search

A table showing the objects of an object type and their attributes. This report is based on a saved quick search (filter) from the Assets Object Search View. When you open an object search report, you can select the Quick search link to view the filter that generates the table.

Payroll report

A chart showing payroll expenditures.
Two-dimensional report

A table showing the objects of an object type and their attributes.

User report

A table showing the total of one or more objects assigned to one or more users.

Creating a report

To create a report, you must have access to the object schema and object type that your report will contain.

1. In the top navigation bar, select **Assets > Reports**.
2. Select **New Report**.
3. Select a report type.

- **Attribute count**: A chart showing how the objects of an object type are distributed based on attributes.
- **Catalog**: A list of attributes of objects.
- **Issue count**: A chart showing historical totals of issues reported for one or more object types or objects.
- **Map report**: A report showing geographical locations (configurable attributes) of objects in a map.
- **Object count**: A chart showing historical totals of objects for one or more object types.
- **Object search**: A table showing the objects of an object type and their attributes based on a saved quick search.
- **User Object Count**: A table showing the total count of objects and their children assigned to one or more users.

Select a report type, give your new report a name, select how frequently you want to refresh the data in your report, and select the required parameters. Optionally, you can also add labels and a description to your report.

4. Give your new report a name, select how frequently you want to refresh the data in your report, and select the required parameters. Optionally, you can also add labels and a description to your report.

5. Select **Generate preview** to see a preview of the report or select **Create** to generate the report.

Once you start creating reports, they'll appear in the Report manager. This is where you can order and filter them, or do many other things, such as printing, sharing, and syncing your reports. To see the list of available actions for your reports, select **More options** next to each report. To learn more about each available option, see Working with reports in the Report manager.

**Working with reports in the Report manager**

Your reports (as well as reports that have been shared with you) are stored in the Report manager. In addition to viewing the reports, you can also perform actions such as editing, printing or sharing reports with other users. To open the Report manager, in the top menu go to **Assets > Reports**.

Organize your report view by grouping the reports.
1. Select **Group by**.
2. Select one of the following options:
   a. **Label** - group reports based on their labels.
   b. **Owner** - group reports based on who created the report.
   c. **Type** - group reports based on report types.

You can order your reports alphabetically or by the date they were created. Select **Order by** to change the way your reports are ordered.

To edit a report, select **More actions** > **Edit** next to the name of the report you want to edit.

You can change any of the parameters of your report. When you're done, select **Generate preview** to see a preview of your updated report or select **Update** to immediately save your changes.

To print your report, select the report you want to print. In the dialog, select **More actions** > **Print**.

To export your report, select the report you want to print. In the dialog, select **Export** and select the format of your export (CSV, JSON, XML).

The visibility of the data in the reports you share is based on your own permissions. This means that the people or groups you share a report with will be able to see the data, even if they don't have access to the object schemas or object types included in your report.

To share a report, select **More actions** > **Share** next to the name of the report you want to share.

1. In the dialog, select the name of a user or group.
2. Select the permissions you want to give to the user or group:
   a. **View** - users or groups you share the report with can only view this report.
   b. **Edit** - users or groups you share the report with can view and edit this report.
   c. **Delete** - users or groups you share the report with can view, edit, and delete this report.
3. Select **Add**. Repeat this process to add more users or groups.
4. When you're ready to share, select **Share**.

The data in your report is updated automatically based on the frequency you selected when you created your report. You can also update the data in your report manually, instead of waiting for a scheduled update.

Updating the data may take several minutes, or longer, depending on the amount of data in your report.

To update data manually, select **More actions** > **Resync** next to the name of the report you want to synchronize.

To add a report to your favorites, select **Add to favorite** next to the name of the relevant report.

You can filter your reports based on a few options:

- **My favorites** - displays only those reports that you've added to your favorites.
- **Shared with me** - displays only those reports that others have shared with you.
- **Shared by me** - displays only those reports that you have shared with others.
- **Report name** - enter a name or part of a name.
- **Labels** - select one or more labels. If you select more than one label, the filter will show only those reports that have all of the labels you selected.
- **Owned by** - displays only those reports owned by the person you selected.

To clear your filters, select **Clear filter**.

To delete a report, select **More actions** > **Delete** next to the name of the report you want to delete.

Displaying a report on your Jira dashboard
To display a report on a Jira dashboard, add an Assets Widget to your dashboard. Learn more about configuring your dashboard.

1. In the top menu, select Dashboards > (name of your dashboard).
2. Select Add gadget.
3. In the dialog, search for Assets Widget and select Add gadget. If you dont see Assets Widget, select Load all gadgets.
4. Configure your gadget:
   a. Widget: select the report you want to display.
   b. Refresh interval: select how frequently you want to refresh the report.
5. Select Save.

Viewing audit logs related to reports

To view audit logs, you must be logged in as a user with the Jira Administrators or Jira System Administrators global permission.

Some user activities surrounding Assets reports are tracked in the Jira audit log. If you're a Jira admin, you can see who viewed, printed or shared reports.

Learn more about auditing in Jira.
See all audit logs used for Assets reports.
Providing help in multiple languages

You can meet your customers’ language preferences by adding additional languages to your service project. This translates the language they receive when they’re using your portal and help center to their preferred language.

You need to be a Jira Service Management project admin to change the language settings.

What is language support?

When you create a service project, it displays in the default language inherited from your Jira instance. To meet your customer’s language preferences, you can add multiple languages to their service projects.

You can translate your:

- request types (names, descriptions, fields, and groups)
- portal names
- announcements (login, help center, and portal)
- customer notifications

Limitations

Here are some things that aren't included right now:

- Linking a Confluence space to a chosen language
- Translating the customer satisfaction survey
- Translating the Approve and Reject buttons for approvals
- Searching for translated request types and portals on the customer portal

Add languages to your service project

Your team can add and edit translations based on the languages of your service project customers. Adding translations is especially important for customized content, such as help center announcements, which will otherwise appear in your default service project language.

To add languages and translations:

1. From your service project, go to Project settings > Language support.
2. Select Add language.
3. Select the language and select Add.

Your languages appear in the languages table. New languages don’t come with ready translations, so you’ll need to edit and update them. We disable newly added languages by default. We do this so you can quality check your new language and its translations before customers see them.
Review or update translations

You can add custom translations to your service project to enhance your customers’ experience. Custom content may include translations of request types, portal names, and announcements.

To review or update custom language translations:

1. From your service project, go to Project settings > Language support.
2. Select the language’s entry in the Language column.
3. Review or update the languages’ content.
4. Select Save.

We group your customer-facing content into sections in the translation space. Use the service project sidebar to jump between sections. For most sections, the service project default language appears in the left column and the translated text appears in the right.

Announcement banner translations
To prevent inconsistencies when you delete your announcement banner for the help center or the customer portal, well check if there are any translations attached to it. If there are, the translations for the deleted fields will be cleared and youll see a warning message to confirm the change.

When you update the announcement banner, well keep the existing translations. However, if there are any translations attached to it, youll see a warning message for reviewing existing translations.

To review your announcement translations:

- For global announcement translations, go to Project settings > Language support. We recommend consistently using only one selected project to manage all your global announcement translations.
- For customer portal announcement translations, select the project that is linked to the specific portal. Next, go to Project settings > Language support.

**Change your service project's default language**

We recommend setting the service projects default language to match the language of the majority of your customers. Setting your service projects default language to be the same as your customers, allows them to effectively use their service project.

Customers will see the service projects default language if the project admin hasn't added their preferred language or the preferred language is disabled.

To set the default service project language:

1. From your service project, go to Project settings > Language support.
2. Select your preferred language.
3. Review your language's translations and confirm they are up to date.
4. Select Save.
5. Toggle the slider so the language is Available to customers.
6. Select Change default language.
7. Select your required language.
8. Select Change.

**Stop supporting a language**
If you'd like to stop supporting a language, we recommend you disable rather than remove it. That way, you can keep up with translations in case you re-enable it. Removing a language would also remove its translations.

To stop supporting a language:

1. From your service project, go to **Project settings > Language support**.
2. Find the language's entry in the **Language** column.
3. In the **Available to customers** column, toggle the slider off.

As a result of disabling a language, customers whose preferred language is no longer supported will see the portal text in their preferred language (for example, Log in or Profile), and the service project request types and notifications in the service project default language.

Let customers know how to set their language preference

Customers can change their own language preference in their help center profile.

To assist customers to change their language preference, recommend the following:

1. From the help center, select the avatar.
2. Select **Edit preference** under **Preferences**.
3. In the **Language** dropdown, select the preferred language.
4. Select **Save**.

Translate customer notifications

You can also add languages for notifications sent to customers. In this case, you wont be able to provide custom translations; the notifications will use the translations provided with Jira.

- See **Translate Jira Service Management notifications**.
Collecting customer satisfaction (CSAT) feedback

Measuring customer satisfaction can help you better understand your customers and improve service levels.

Jira Service Management provides a simple, built-in mechanism to collect customer feedback. Key features include:

- Simple customer workflow to provide feedback on resolved issues
- Customer satisfaction scores are visible within resolved issues and on agent queues for resolved issues
- Single-click to view customer satisfaction report for a service project
- Easily create and view custom reports and trend graphs based on satisfaction scores.

Customer feedback data can be used to identify strengths and weaknesses in the service quality, engage and motivate the team to improve satisfaction scores, and provide mentoring and training where required.

Enabling the customer satisfaction feature

This feature is enabled by default for new service projects; however, it must be enabled for each existing service project. To enable customer satisfaction settings for an existing project:

1. Log in as a service project administrator.
2. Select the service project you wish to configure.
3. Select Project settings > Satisfaction settings.
4. Enable Collect customer satisfaction feedback.
5. Optionally, edit the Question phrase to suit your environment. This phrase appears in the resolved issue notification message that customers see.

You can send satisfaction rating email notifications to your customers whenever a request is resolved. To do so, you need to enable the Request resolved rule:

1. Go to Project settings > Customer notifications.
2. Next to Request resolved select Edit.
3. Select Enable, then select Save.

When you enable satisfaction settings for a service project and enable the Request resolved rule, the resolved issue notifications will contain a satisfaction rating scale. Customers can select the rating scale to indicate their level of satisfaction. A confirmation page is displayed on the customer portal, where they can change the rating, and optionally provide any additional comments that they would like to convey to the team.
Viewing and reporting on customer feedback

Customer satisfaction scores and comments are displayed in the issue view for resolved issues. Agents can also view the satisfaction scores on their own recently resolved queues.

Service project administrators and agents can view the default Satisfaction report, which displays the average customer satisfaction scores for the team.

<table>
<thead>
<tr>
<th>Rating</th>
<th>Comment</th>
<th>Key</th>
<th>Agent</th>
<th>Received</th>
</tr>
</thead>
<tbody>
<tr>
<td>★★★★</td>
<td>Thanks for coming down to my desk to help me print in A3</td>
<td>IT-1384</td>
<td>Will Turner</td>
<td>Yesterday</td>
</tr>
<tr>
<td>★★★★</td>
<td>I had to wait 3 days for a solution. I replied on Wednesday but nobody got back to me until this morning.</td>
<td>IT-1216</td>
<td>Mia Kennedy</td>
<td>3 days ago</td>
</tr>
<tr>
<td>★★★★</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

A service project administrator can also create and view custom reports analyzing satisfaction trends. Agents can also view any custom satisfaction reports created for their service projects.
Useful examples of custom reports include:

- A trend graph of the average satisfaction rating for a specific period to view changes in service levels.
- Satisfaction scores based on the type of service request. This would identify issues for which the team could provide knowledge articles.
- Satisfaction scores for an individual agent compared to team scores to help identify agents who would benefit from further training.
Jira Service Management best practices

Check out the following best practice articles:

- Best practices for designing the customer portal
- Best practices for IT teams using Jira Service Management
- Best practices for software teams using Jira Service Management
Best practices for designing the customer portal

Every service project comes with an online portal that your customers can use to interact with your service team.

Here are some best practices on how to design a customer portal that makes it easy to find help, and work effectively.

### Brand your help center

Customers can use the global help center to browse all the service projectsthey have access to. You can brand your help center in a number of ways:

- Add a company logo
- Name your help center
- Add a banner image across the top
- Change the color of some components.

What's more, your customer portals will inherit these design changes making the experience consistent across all of your service projectchannels.

To learn how to do this check out Using the help center.

### Brand your customer portal

Add a name and logo to your customer portal so that people know they're sending requests to your team and organization. It will look something like this:
Help customers find request types

You can set up request types in a way that makes it easier for your customers to find them. Here’s how:

- Name your request type something that your customers will understand. For example, *Access to a system instead of VPN access.*
- Use different icons for each request type so customers can recognise *IT help* from, say, *Book a flight.*
- Add contextual help. For example, say what size and format is accepted in the attachment field.
- Use examples in your request type descriptions. For example, *If you need a software license such as Microsoft Office, raise a request here.*
- Link to helpful information in the request type description. For example, if you have a list of available Microsoft Office license numbers on your intranet, add a link so they don’t need to open a request.

To learn how to do this check out [Setting up request types](#).

Group similar request types together

If you have a lot of request types (more than seven), we recommend grouping some of them together to help customers find what they need. Grouped request types appear as tabs in your customer portal.
Project settings

Summary

Details
Re-index project
Delete project

Request types
Customer permissions
Portal settings
Email requests
Customer notifications
Satisfaction settings
Knowledge base
SLAs

GROUPS
Comm
Logins
Comp
Applic
Server
Tester
Hidden
Add g
To add groups:

1. Select **Add group** from the sidebar.
2. While viewing a group, select **Add existing request type** to add your request types to it.
3. Change the order that the groups appear on the customer portal, by drag and drop.

To learn more about request types, check out [Setting up request types](#).

To prevent a request type from showing on the customer portal, move it to the **Hidden from portal** group, underneath the other groups. Removing a request type won’t impact requests that have already been created.

Set up a knowledge base

Over time, your service team will accumulate a lot of knowledge that can be shared with your customers so that they can solve their own problems without needing to open a request. You can set up a knowledge base by integrating Jira Service Management with Confluence.

To learn how to do this check out [Set up a knowledge base for self-service](#).
Best practices for IT teams using Jira Service Management

Information Technology Infrastructure Library (ITIL) is a framework for ITSM (IT service management). ITIL recommendations have been an industry standard for 20 years. Adopting these practices takes time. You can seek formal training on how to make ITIL recommendations work best for your business.

If you're interested in more general information about ITSM or other guides, check out our ITSM resources.

We recommend starting with processes that are essential to your business goals. Jira Service Management provides workflows for IT teams in our IT Service Management project template. We created the following ITIL workflow add-ons, available in the Atlassian Marketplace:

- Change management for Jira Service Management
- Jira Service Management incident management
- Problem management for Jira Service Management
- Service requests for Jira Service Management

Jira Service Management is configurable. We recommend you start with an ITIL framework and then adjust to your specific business needs.

What follows is an overview of some best practices for your IT service desk. This guide covers:

- Fulfilling service requests with your IT service desk
- Managing changes with your IT service project
- Managing incidents with your IT service desk
- Managing problems with your IT service desk
- Calculating priority automatically
- Manage changes with your IT service management project

Use the IT Service Management template

Only Jira administrators can create projects.

To create a project using the IT Service Desk template:

1. Select Projects > Create Project.
2. Choose the IT Service Management template and select Next.
3. Name your project.
4. Select Submit.

Provide a robust service catalog

Using simple forms, your customers can do a lot of the early leg work for your service project. Jira Service Management provides them with clear and concise options for requesting help. A robust service catalog makes sure that service requests are prioritized and get to the correct service agent. And, your agents get the information needed to fulfill the request before beginning work.

The IT Service Management template comes with a service catalog of common requests. We call these forms "request types" and you can customize them to suit your needs.

To start, identify the most common and urgent IT tasks for your service project. Double-check that there’s a corresponding request type for each of these.

Go to Project settings > Request types to view or edit your service catalog. The entries there appear in your customer portal. Read more about request types.

Help your customers serve themselves with a knowledge base
Mature IT service desks solve common problems without ever seeing a ticket. We recommend providing your customers a knowledge base.

Link your Jira Service Management site to a Confluence knowledge base. Keep a record of known solutions and two important things happen:

1. Your customers find and view relevant articles when they search the customer portal. They may find the answers they need without ever raising a request.
2. Your service agents can find relevant articles when working on issues. This saves them time hunting down answers or workarounds to common IT requests.

Learn more at Set up a knowledge base for self-service.

Start with ITIL recommended workflows and adapt to your needs

ITIL recommendations are a framework, a set of ITSM best practices meant for you to adapt from and grow.

In Jira Service Management, we associate your service catalog with workflows by assigning a request type to an underlying issue type. Our recommendations for IT teams use four ITIL-inspired workflows. To learn more about how these issue types and workflows work to streamline your service project, check out our guides for handling:

- Fulfilling service requests with your IT service desk
- Managing changes with your IT service project
- Managing incidents with your IT service desk
- Managing problems with your IT service desk
- Calculating priority automatically
- Manage changes with your IT service management project

These allow you to have many customer request forms that follow the same workflow. For example, new hardware requests and password resets use the same service request workflow.

Our default workflows make your service project effective, out of the box. You can customize them as you go, scaling to the needs of your business.
Fulfilling service requests with your IT service desk

The scope of service requests in Information Technology Infrastructure Library (ITIL) is large. Tasks can range from resetting a password to onboarding a new hire. Service requests include customer comments, complaints, or other requests for information.

The IT Service Desk template comes with a few pre-built service request types. We set these up to help your service desk agents handle common service requests.

The service request fulfillment process:

- manages customer expectations
- speeds up request resolution
- standardizes any approval processes

Effective service request management reduces the bureaucracy and cost of maintaining IT services.

This page describes some best practices for fulfilling service requests using Jira Service Management. You may seek formal training in how to make ITIL recommendation work best for your business.

Service request fulfillment process

The information needed to capture and resolve service requests varies. But, you can standardize the process for fulfilling these requests.

The IT Service Desk template associates certain requests with a service request fulfillment workflow. We set up the workflow to complement the following service request fulfillment process. Use it as a jumping off point for your service desk.

The service request fulfillment process, in brief:
A customer requests help from your service catalog or via email. The service desk assesses the request alongside pre-defined approval and qualification processes. If needed, they send the request for financial or business approval.

A service desk agent works to fulfill the service request, or forwards the request to someone who can.

After resolving the request, the service desk closes the ticket. The agent consults the customer to make sure they are satisfied.

**Setup for service request fulfillment in Jira Service Desk**
Configure the workflow and fields with the service request workflow add-on

We used the ITIL framework for change management to build a workflow for Jira Service Management: https://marketplace.atlassian.com/plugins/com.atlassian.servicedesk.servicerequest/server/overview.

You can use this add-on as a template to help you build your own service request fulfillment process.

To use the workflow from the Marketplace:

1. Log in as a user that has the Jira administrator global permission, and follow the instructions listed here to import a workflow.
2. To add the workflow fields to your change issues, activate the screen by following the instructions here: Defining a screen.

Service request fulfillment workflow

Tips for creating service request forms on your portal

- Begin with the most common requests. Choose ones that are simple and easy to fulfill. This delivers immediate value to customers. It allows the service desk team to learn as they build out future phases of the service catalog.
- Document all the requirements for a service request before adding it to the catalog. These include question data, the approval process, fulfillment procedures, the fulfillment team, process owners, SLAs, reports, and so on. This allows the IT team to better manage the request type over time.
- Capture the data needed to start fulfilling the request. But, don’t overload the customer with too many questions.
- Work with stakeholders to standardize the approval process, where possible. For example, pre-approve all requests for new monitors. Or, assign software approvals to the customer’s manager.
- Document any knowledge base information that might allow customers to service their own request. Record this in a linked Confluence space. If you do, customers can view articles while they search your portal. Read more about creating a knowledge base.
- Review your team’s performance in fulfilling requests. Adjust your SLAs, requirements, and training to improve customer satisfaction.
- Create reports to help manage the lifecycle of a service request offering. These trends can uncover forms that are no longer needed, too complex, or insufficient.

Read more about creating reports.

Default form fields for service requests
Jira Service Management allows you to customize the fields of information collected from customers. Additionally, you can customize the fields of information used by your agents. Jira Service Management does this through issue type fields and screens. Fields help agents fulfill the request, discuss with vendors, and categorize requests.

By default, we include the following fields in your agents' view of a service request:

<table>
<thead>
<tr>
<th>Field name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Summary</td>
<td>A short description of the request.</td>
</tr>
<tr>
<td>Reporter</td>
<td>The person who submitted the request.</td>
</tr>
<tr>
<td>Component/s</td>
<td>Segments of your IT infrastructure that relate to the request. For example, &quot;Billing services&quot; or &quot;VPN server&quot;. These are used for labeling, categorization, and reporting.</td>
</tr>
<tr>
<td>Attachment</td>
<td>Files or images added to the request.</td>
</tr>
<tr>
<td>Description</td>
<td>A long, detailed description of the request.</td>
</tr>
<tr>
<td>Linked Issues</td>
<td>A list of other requests that affect or are effected by the request. If your business uses other Atlassian products, this list may include linked development issues.</td>
</tr>
<tr>
<td>Assignee</td>
<td>The service desk agent assigned to fulfill the request.</td>
</tr>
<tr>
<td>Priority</td>
<td>The importance of the request's resolution, usually in regards to your business needs and goals. Sometimes, priority is calculated by impact and urgency.</td>
</tr>
<tr>
<td>Labels</td>
<td>A list of additional custom labels used for categorizing or querying records.</td>
</tr>
<tr>
<td>Request participants</td>
<td>A list of extra customers or vendors who take part in resolving the request.</td>
</tr>
<tr>
<td>Approvers</td>
<td>A list of business or financial contacts responsible for approving the service request.</td>
</tr>
<tr>
<td>Organizations</td>
<td>A list of customer or vendor groups interested in the request's resolution.</td>
</tr>
</tbody>
</table>

**Extra form fields recommended by ITIL**

ITIL recommends a few more fields for their in-depth processes. The IT Service Desk template doesn't include these by default. This is because IT teams who use Jira Service Management don't often use these fields. If needed, you can include these fields or add custom fields. [Find out more about fields in Jira.](#)

ITIL also recommends including the following fields:

<table>
<thead>
<tr>
<th>Field name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Impact</td>
<td>The effect of the service request, usually in regards to service level agreements.</td>
</tr>
<tr>
<td>Urgency</td>
<td>The time available before the business feels the service request's impact.</td>
</tr>
<tr>
<td>Pending reason</td>
<td>A short description or code that indicates why the service request is not progressing.</td>
</tr>
<tr>
<td>Product categorization</td>
<td>A category of IT asset or system that the request effects.</td>
</tr>
<tr>
<td>Operational categorization</td>
<td>A category of action or function required to fulfill the request.</td>
</tr>
</tbody>
</table>

Learn more about IT service management (ITSM)

Get more tips and tricks for successful ITSM, view case studies, and learn how to take your service desk to the next level.

Check out the ITSM resources on IT Unplugged.
Managing changes with your IT service project

Effective service teams plan and control changes, as they understand their impact to their business. Although Jira Service Management provides default change management workflows and fields, weve now updated them to better follow the Information Technology Infrastructure Library (ITIL) best practices. Weve also added a few additional steps that will let you create an inventory of assets and open changes against them by using the built-in asset management functionality.

Set up change management in Jira Service Management

Have a look at the list of customizations weve made to the change management process. If youd like to use them, youll need to adjust your individual projects manually.

Change management workflow

The workflow follows the ITIL best practices and terminology, and makes sure your changes are approved and accounted for. Extra steps let you properly plan and assess the most important and risky changes, at the same time not slowing down critical changes that must be implemented right away. All this with the right stakeholders sharing their expertise and approving your changes along the way.

Different types of changes using different workflow paths

Thanks to automation rules, different types of changes can take different paths. Just so emergency changes dont have to wait for all of the approvals theyre emergencies after all.

Automation rules handling repetitive tasks for you
Automation rules will also take some burden off your back and automate repetitive tasks, just so you don't have to think about them:

- Determine change risk based on the importance of affected assets
- Calculate priority based on Impact and Urgency
- Escalate Emergency changes
- Auto-approve Standard changes

**Change plans**

With custom fields, each change request can store detailed plans, just to make sure everyone working on it knows what they're doing or can quickly roll back if it turns out they don't.

- Implementation plan
- Test plan
- Backout plan

**Inventory of assets and configuration items**

Jira Service Management lets you create an inventory of assets and configuration items, together with their details and relations between them. You can then open changes against these assets and get them linked together. Thanks to that, details about an asset are included in the change request and everyone involved has enough context to decide how risky or important a change is.

**Approvals from the right stakeholders**

Make sure the most important and risky changes are approved by the right people. You can include change managers, CAB, and approvers that are directly responsible for your assets - the right people at the right time. By using Insight custom fields, these approvers will change dynamically depending on the asset affected by your change request.

- Change managers (user picker field)
- Change Advisory Board (user picker field)
- Owners of your Insight assets (Insight field)

**Get started with improved change management**

To get started, follow these steps. They'll help you adjust your projects to all of these changes and provide some explanations about what these changes do:

- **What to expect: Sample lifecycle of a change**
- **1. Update the change management workflow**
- **2. Create resolutions, post-functions, and priorities**
- **3. Create and update custom fields**
- **4. Link your project to Assets asset management**
- **5. Add approvals to your workflow**
- 6. Create and update automation rules
- 7. (Optional) Set up a calendar to coordinate your changes
What to expect: Sample lifecycle of a change

Here's an example of how a change request could look like, and how it progresses through the change management workflow. This should help you understand the changes you'll be making to your projects.

Requesting a software upgrade  Jira Software

This example shows a request for a software upgrade of our Jira Software instance that lives as an asset in Jira Service Management.

<table>
<thead>
<tr>
<th>What we're doing</th>
<th>What it looks like in Jira</th>
</tr>
</thead>
<tbody>
<tr>
<td>Viewin g an asset in Insight</td>
<td></td>
</tr>
<tr>
<td>Lets have a look at our Jira instance (asset) in Insight. Its quite an old version and we want to get it upgraded to get new features, security updates, and all the other bug fixes.</td>
<td></td>
</tr>
</tbody>
</table>
Well open a change request against it to upgrade it to the latest LTS release: 8.13.

**Applications / Jira Software**

**INSITSM-119**

**Jira Software**

<table>
<thead>
<tr>
<th>Attributes</th>
<th>Connected tickets</th>
<th>Comment</th>
</tr>
</thead>
<tbody>
<tr>
<td>Version</td>
<td>8.5 LTS</td>
<td></td>
</tr>
<tr>
<td>Status</td>
<td><strong>Running</strong></td>
<td></td>
</tr>
<tr>
<td>License</td>
<td><img src="image" alt="Data Center license" /></td>
<td></td>
</tr>
<tr>
<td>License Type</td>
<td>Commercial</td>
<td></td>
</tr>
<tr>
<td>Server</td>
<td><img src="image" alt="exchange.prod.ap" /></td>
<td></td>
</tr>
<tr>
<td>Owner</td>
<td><img src="image" alt="System admins" /></td>
<td></td>
</tr>
<tr>
<td>Importance</td>
<td>High</td>
<td></td>
</tr>
<tr>
<td>Teams</td>
<td><img src="image" alt="Monsters" />, <img src="image" alt="DELTA" /></td>
<td></td>
</tr>
<tr>
<td>What's important here is some of the fields of our asset that will affect how our change request behaves:</td>
<td></td>
<td></td>
</tr>
<tr>
<td>---------------------------------------------------------------</td>
<td></td>
<td></td>
</tr>
<tr>
<td>* <strong>Importance</strong> (based on which our change will be assigned a proper risk)**</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

<p>| | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
</table>
### Attributes

<table>
<thead>
<tr>
<th>Version</th>
<th>8.5 LTS</th>
</tr>
</thead>
<tbody>
<tr>
<td>Status</td>
<td>Running</td>
</tr>
<tr>
<td>License</td>
<td>Data Center license</td>
</tr>
<tr>
<td>License Type</td>
<td>Commercial</td>
</tr>
<tr>
<td>Server</td>
<td>exchange.prod.ap</td>
</tr>
<tr>
<td>Owner</td>
<td>System admins</td>
</tr>
<tr>
<td>Importance</td>
<td>High</td>
</tr>
<tr>
<td>Teams</td>
<td>Monsters, DELTA</td>
</tr>
</tbody>
</table>
**Creating a change request**

Let's open a change request, and choose this Jira instance as an affected object.
<table>
<thead>
<tr>
<th>Change type</th>
<th>Change reason</th>
<th>Urgency</th>
<th>Impact</th>
</tr>
</thead>
</table>

Let's fill in the fields explaining the change:

1. Change type
2. Change reason
3. Urgency
4. Impact
Let's leave the new fields for plans empty right now. Who will be filling them out depends on the company process usually its the change request.
tor, but let's try including the whole team in it later.
Viewing the asset on the change request

After the change request is created, details of our Jira instance are pulled into the request. Both you, and everyone interested, can view it.

You can configure what exactly is displayed here.
We need to upgrade
or just click it to view more details and dependencies.

The change request was also linked to our Jira instance in Insight. The system admin responsible for this instance will be alerted right away.
Applications / Jira Software

Jira Software

INSITSM-119

Attributes

Connected tickets

Unresolved

Jira filter...

TEAM-3 We need to upgrade Jira to...
Viewing the effect of automation rules

But, there's more. Thanks to automation rules, Jira automatically:

- Defined the priority as High
- Defined the change risk as High
This will help the approvers take necessary steps when approving this change for example, they could move the date to a weekend and make sure that the teams using this Jira instance can work without it.
**How did we do it?**

We added new automation rules to Jira Service Management. The ones used here:
Use assets importance to determine the change risk

Use change requests impact/urgency to assign a proper priority

Project settings

Summary
Details
Audit log
Re-index project
Delete project

Request types
Customer permissions
Language support
Portal settings
Email requests
Customer notifications
Satisfaction settings
Knowledge base
SLAs
Calendars
Automation

Incident management

Automation
By default run

Name
Transition on

Update when
Auto-close

Auto-appro

Determine

Calculate priority

Escalate or
In this case, automation rules don't affect the change request that much because normal change requests usually go through all workflow steps and approvals and are not emergencies, so we have time to review them.
But if it was an emergency, that's a different story. Thanks to automations, emergency changes can bypass a few steps, so you can implement them right away instead of running around asking for permissions.

It's an emergency after all.
Planning the change

After our change request is transitioned to the Planning stage, the whole team can get together and collect all the necessary info.
- Implementation plan (how will we do it?)
- Test plan (how will we test it works?)
- Backout plan (how do we quickly roll back?)

Just to make sure we know what we were doing or can roll back if it turns out we don't.
With the plan ready, we can transition the change request to the Approving step, where it will undergo the initial review. It would usually be done by change managers (fetched from a Jira user picker custom field) and someone responsible for this Jira instance at the right time.

TEAM-3

We need to upgrade Jira to 8

Details

- Type: Change
- Priority: High
- Component/s: None
- Labels: None
- Impact: Significant / Large
- Urgency: High
- Change type: Normal
- Change reason: Upgrade
- Change risk: High
- Affected object:

Implementation plan:

1. Back up everything
2. Upgrade Jira and:
   - Download Jira
   - Extract the file
   - Install the data

Jira Software

Status
License
Server
Importance
Although you usually know who change managers are, you can have as many asset owners as you have assets. You don’t have to know who they are, because Jira will automatically assign them as approvers based on their relation to the asset.
It will be a different owner for a different software or server, or maybe no owner if the asset isn't that important.
<table>
<thead>
<tr>
<th>How did we do it?</th>
</tr>
</thead>
<tbody>
<tr>
<td>We used approvers who are related to the Insight object. It won't always be a fixed group of users they will change based on the asset you select in the change request.</td>
</tr>
</tbody>
</table>

Jira will:
Check what the affected assets look for approvers in its attributes. As sign these people as approvers.
Assessing the risk: CAB review

After the initial review, the change is moved to the next approval step. Normal changes don't have established processes so it's good to properly assess them.
Here the change is being assessed by the Change Advisory Board (CAB) that can include additional experts to reduce the risk and avoid any problems.

TEAM-3

We need to upgrade Jira to 8

Details

Type: Change
Priority: High
Component/s: None
Labels: None
Impact: Significant / Large
Urgency: High
Change type: Normal
Change reason: Upgrade
Change risk: High
Affected object:

Implementation plan:
1. Back up every path
2. Upgrade Jira
   - Download Jira
   - Extract the file
   - Uninstall the old
   - Install the new
Implementing the change

Once the change is approved, we can start implementing it. Let's assume that all the teams have been informed and we can just upgrade this instance.

- Install the data
- Re-apply modifications
- Disable automation
- Post-upgrade steps
- Start Jira for the
We need to upgrade Jira to 8.

Implementation plan:
1. Back up everything
2. Upgrade Jira
   - Download Jira
   - Extract the files
   - Install the files
- Install the data
- Re-apply modifications
- Disable automatic
- Post-upgrade status updates
- Start Jira for the upgrade
- Update Jira Service Management
- Upgrade your app
- Rebuild index

Optional:
Changing the object's status

But, in case someone was wondering what's going on with this Jira instance, starting the work on it triggered a status change.
Jira is no longer Running, as we're implementing the change. It's in Service.

This can be done through Insight post-functions added to the workflow. In this case, they change the objects attribute when the change request is moved through a certain transition.

TEAM-3

We need to upgrade Jira to 8.

Details

Type: Change
Priority: High
Component/s: None
Labels: None
Impact: Significant / Large
Urgency: High
Change type: Normal
Change reason: Upgrade
Change risk: High
Affected object:

Implementation plan:

1. Back up everything.
2. Upgrade Jira.
   - Download Jira.
   - Extract the file.
   - Install the data.
This is not part of change management. If you'd like to use it, see Adding Insight functions to workflows in Jira.
Issue type schemes
Sub-tasks

BROWSE AND EXPORT
Archived issues

WORKFLOWS
Workflows
Workflow schemes

SCREENS
Screens
Screen schemes
Issue type screen schemes

FIELDS
Custom fields
System fields
Field configurations
Field configuration schemes
Custom fields optimizer

PRIORITIES
Priorities
Priority schemes

Workflows / INS: Insight IT

Transition: Change

Screen: TM: Insight IT

Conditions  Validations
0  0

The following will be done:

1. Set issue status
2. Add a comment
3. Update changes
4. Re-index an issue
5. Fire a Generic
6. The attribute
7. The attribute
8. The attribute
9. The attribute
10. Objects selected
Compl eting and closin g the change

Once Jira is upgraded and the work is done, we can complete the change, and see how everything is green again.

When closing the change request, you can select the resolution: Change successful or Change failed.
TEAM-3

We need to upgrade Jira to 6.0.0

Details

- Type: Change
- Priority: High
- Component/s: None
- Labels: None
- Impact: Significant / Large
- Urgency: High
- Change type: Normal
- Change reason: Upgrade
- Change risk: High
- Affected object: Jira Software

Implementation plan:
1. Back up everything
2. Upgrade Jira
   - Download Jira
   - Extract the files

Created in 2023 by Atlassian. Licensed under a Creative Commons Attribution 2.5 Australia License.
Once the change is complete, you can also view some insight reports for your assets and change that affected them.

- Install the data
- Re-apply modifications
- Disable automation
- Post-upgrade steps
- Start Jira for the first time
For example, you can check how many issues were raised against your assets. How many incidents, problems, or changes.

And if there's too many. Well, this might just mean its time to buy a new asset.
How many change requests?

Area chart

28 Mar 2021
Ready?

If you'd like your changes to use this flow, let's get started with 1. Update the change management workflow.
1. Update the change management workflow

Jira Service Management has a default change management workflow, but we’ve updated it with additional statuses and transitions. You can download the ready workflow from Atlassian Marketplace, and have all the missing statuses created automatically.

Your new workflow at a glance

Here’s what the new workflow looks like. The statuses closely follow the ITIL best practices and terminology:

Download the workflow

To download the change management workflow:

1. Go to Administration > Issues > Workflows.
2. Select Import > Import Workflow.
4. Click Select and enter the workflow name.

Review statuses
After importing the workflow, Jira will automatically match the statuses to the ones that already exist in your instance and suggest creating new ones. We recommend that you do it as presented on the screen.

The following statuses would be created in a default Jira instance:

- Approving
- CAB Review
- Post-implementation review
- Review

If you're happy with them, just click Next and then Import. Alternatively, you could try mapping these missing statuses to some similar ones that you already have.

**Associate the workflow with your project**

To associate the workflow with your project:

1. Open your project, and go to **Project settings > Workflows**.
2. Select **Add Workflow > Add existing**.
3. Select the new **Change management for Jira Service Management workflow**.
4. Assign the **Change** issue type to this workflow.
5. When you publish the workflow, your issues will be migrated and your project will start using it.

**Next steps**

When you're ready, go to 2. **Create resolutions, post-functions, and priorities**.
2. Create resolutions, post-functions, and priorities

The change management workflow, and the whole process you'll be using, needs some additional configuration items, such as new resolutions, post-functions, and priorities.

Create and associate resolutions

For more info about resolutions, see Defining resolution field values.

The result of the change should be reflected on the requests resolution when it transitions to Closed. To make it happen, create the resolutions Changed failed and Change successful and make them available when resolving a change.

To create the resolutions:

1. Go to Administration > Issues > Resolutions.
2. Create the following resolutions:
   - Change successful
   - Changed failed

To make the resolution available when resolving a change:

1. Go to Administration > Issues > Workflows, and open your change management workflow in the Text mode.
2. Select one of the Close transitions, and click Edit.
3. In the Transition View field, select your Resolve Issue Screen (you can use the one with this name in a default Jira instance), and save. The screen will be added to the transition and users will be able to select a resolution when closing a change through this transition.

4. Repeat these steps for the remaining Close transitions. There are four in total.
5. Remember to publish the workflow to apply these changes.

Add post-functions to clear resolutions when the change is reopened

For more info about post functions, see Advanced workflow configuration.

It might happen that you'll need to reopen a change or just move it back on the workflow. These post-functions will make sure that the resolution is cleared when that happens, just to avoid confusing your users.

To add post-functions to your workflow transitions:

1. Edit your workflow in the Text mode.
2. Select one of the transitions going out of the status Closed. Here are all of them for your reference:
   - Back to post-implementation review
   - Back to Completed
   - Back to Canceled
   - Back to Declined
3. Select Post-functions, and click Add post function. Use the following details when adding one:
Create the Critical priority

For more info about priorities, see Defining priority field values.

Jira comes with the default Highest priority, but it doesnt have the Critical priority. Create one to follow the ITIL terminology. It is also required for other steps to work automation rules that youll configure later will use this priority.

To create the Critical priority:

1. Go to Administration > Issues > Priorities.
2. Select Add priority.
3. Call your priority Critical, give it some description and icon. Click Add.

To associate the priority with your project:

1. Go to Administration > Issues > Priority schemes.
2. Find the scheme used by your project and select Edit.
3. Move the Critical priority to the list of Selected priorities.

Next steps

When youre ready, go to 3. Create and update custom fields.
3. Create and update custom fields

Most of the custom fields used for change management already exist in Jira so you can reuse them, but well still need to create a few theyre needed so your team has the right fields to share their plan and approach for tackling the changes.

Review existing custom fields

Here are existing custom fields that youll reuse. Were listing them for reference:

- Change type
- Change start date
- Change completion date
- Impact
- Urgency
- Change risk
- Change reason
- Change managers
- CAB
- Approvers (optional)

Update existing custom fields

Here are some recommendations on what to do with existing custom fields:

<table>
<thead>
<tr>
<th>Custom field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Change managers</td>
<td>They will be used to get your change requests approved, well do it in the next step. At this point, you can decide whether you want to include a list of approvers or let agents or customers add them manually.</td>
</tr>
<tr>
<td>CAB</td>
<td>Here are your options: Agents can add or edit approvers for these fields when they fill in the details of a change request. To let customers do it, youll need to enable and show these fields on the customer portal. You can add approvers as default values of these fields. After the change request is created, the approvers can be modified up until the request reaches the approval steps. You can pull a list of approvers for these fields automatically only on the customer portal. To do it, enable these field on the customer portal, but keep them Hidden. For more info, see Configuring Jira Service Management approvals.</td>
</tr>
<tr>
<td>Approvers</td>
<td>This a default field and works just like the fields mentioned above. You can keep it, but weve removed it and used the Insight object/s field instead. The Insight field lets you add approvers that are related to the assets youre changing, and they are the best approvers of your requests. Regardless of what youll do with this field, youll also create the Insight field in the next step.</td>
</tr>
</tbody>
</table>

Create new custom fields

The best practice of ITIL is to have the implementation, test, and backout plans for your changes. These fields are text fields and will let you enter and store these plans when creating or editing a change.

Create the custom fields

To create the planning custom fields:

1. Go to Administration > Custom fields.
2. Select Add custom field.
3. Create the fields as described in the table below.
4. Associate each field with the Change issue type and your project.
5. Associate each field with the Create and Edit/View screens for your Change issue type.

Just to give you some tips in a default Jira instance, these screens would be called:
- Project key: Jira Service Management: Change Create Issue Screen
- Project key: Jira Service Management: Change View/Edit Screen

<table>
<thead>
<tr>
<th>Custom field</th>
<th>Type</th>
</tr>
</thead>
<tbody>
<tr>
<td>Implementation plan</td>
<td>Text field (multi line)</td>
</tr>
<tr>
<td>Test plan</td>
<td>Text field (multi line)</td>
</tr>
<tr>
<td>Backout plan</td>
<td>Text field (multi line)</td>
</tr>
</tbody>
</table>

View the new fields

Here's how these fields should look on your changes:

Enable the fields on the customer portal

By default, all these custom fields are available only in the agent view. If you'd like customers to create change requests through customer portal, you need to enable and show them on the portal.

To enable fields on the customer portal:

1. Open your project and go to Project settings > Request types.
2. Create or select a request that will work as a change request for your customers.
3. Select Edit fields.
4. Select + Add a field, and add your fields. After saving, they should appear in the Visible fields section.

Next steps
When you're ready, go to 4. Link your project to Assets asset management.
4. Link your project to Assets asset management

A change request should be opened against something: be it a configuration item, physical server, or some other asset that you need to change or improve. We'll help you create a basic inventory of assets in Jira Service Management and then link it to your project so you can start including assets in changes.

Over time, you can improve your inventory and make any adjustments to this configuration you need.

Assets at a glance basic overview

If you're not so familiar with the basics, assets in Assets are called objects. This is what it looks like in Assets:

1. **Object types**: These work like categories that group your actual assets. They would typically be offices, computers, or devices.
2. **Objects**: These are your assets, grouped within object types. Each asset has attributes that help identify and describe it, just like issue fields.

**Linking your inventory and including assets**

Objects can be selected and included in issues through Assets custom fields that link projects to your Assets inventory. Such a custom field can be linked to your whole inventory or only parts of it; this will affect the objects that can be selected by users.

**Selecting an object**

**Viewing the object in your issue**

Create a basic Assets inventory

Create the object schema
To create a basic Assets inventory:

1. In the Jira top navigation bar, select **Assets > Assets Object Schemas**.
2. Select **Create Object Schema**.
3. Choose **Create Sample IT Asset Schema**.
4. Give it a name and click **Create**.

Your inventory has been created with a sample structure, but it still needs some objects and adjustments.

Add attributes needed for approvals and automation rules

Approvals and automation rules that you will add in the next steps rely on the **Importance** and **Owner** attributes of your objects in Assets. Let’s add these attributes, you can make the adjustments later.

To add attributes:

1. Select the **Applications** object type in the list on the left. You can select any other, but we will use this one in the examples.
2. In the top right, select **Attributes**.
3. Add an attribute by specifying fields in the last line of attributes. You can choose a name, type and type value, as well as configure additional items by selecting the cog icon.
4. Click **Add**. Your attribute will be added to the object type, which means it will be used by all objects within this object type.

Need more details? See [Adding attributes to object types](#).

Add the following attributes to the **Applications** object type, which is under **Asset details**. You can choose other object types, but we will use this one in examples:

<table>
<thead>
<tr>
<th>Attribute name</th>
<th>Type and Type value</th>
<th>Values</th>
</tr>
</thead>
<tbody>
<tr>
<td>Importance</td>
<td>Type: Default</td>
<td>To add the options, click the <strong>cog icon &gt; Configure</strong>.</td>
</tr>
<tr>
<td></td>
<td>Type value: Select</td>
<td>• Critical</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• High</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Medium</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Low</td>
</tr>
<tr>
<td>Owner</td>
<td>Type: User or Group</td>
<td>You can choose the value when you edit an underlying object. Choose a user or group who will be responsible for this particular object.</td>
</tr>
</tbody>
</table>

Create some objects
Add a Jira Software object to the Applications object type. You can add more objects if you wish.

To create objects:

1. Select any of the object types in the list on the left.
2. In the top right, select Objects.
3. Select Create objects, and fill in the attributes (fields). All these attributes have been inherited from the parent object type.

Need more details? See Creating objects.

Here's a sample Jira Software object you can create:

**Object type:** Asset details > Applications.

**Object details:**
- Name: Jira Software
- Vendor: Atlassian
- Version: LTS
- Importance: High
- Owner: jira-administrators, or any other user

**Link your inventory to your Jira project**

Your Assets inventory can be linked to Jira projects by using Assets custom fields. They behave like regular Jira custom fields but have an additional configuration that lets you map it to your inventory, or some parts of it.

For more details, see Adding Assets custom fields to screens in Jira.

**Create an Assets object/s custom field**

To create an Assets custom field:

1. Go to Administration > Custom fields.
2. Select Add custom field.
3. Select All, and choose Assets Object/s.
4. Give it a name Affected object and associate the field with change requests and your project.
5. Click Create.
6. Associate the field with the Create and View/Edit screens, like you did in one of the previous steps.

**Configure the field**

We'll map the field to your whole inventory, just to have access to all assets. You can adjust it later if you wish.

To configure the Assets custom field:

1. On the Custom fields page, search for your custom field.
2. Select > Configure.
4. Set Object Schema to the object schema you created. That's your inventory.
5. Leave the remaining fields as they are.
Enable the field on the portal

Like with other custom fields, if you'd like your customers to be able to select a value for this field, you need to enable and show it on the customer portal.

To enable the field on the customer portal:

1. Open your project and go to Project settings > Request types.
2. Find a request that works as a change request for your customers.
3. Select Edit fields.
4. Select + Add a field, and add your field. After saving, it should appear in the Visible fields section.

View the field

When you create a new change, your custom field should be displayed on the screen. You should also be able to select objects from your inventory.

Agent view

Customer portal

Next steps

When you're ready, go to 5. Add approvals to your workflow.
5. Add approvals to your workflow

Every change should be approved and accounted for. In this step, well show you how to add approvers to your workflows. Well use approvers from Assets objects (people responsible for your assets) and Jira users (CAB and change managers), and well add them to two workflow steps.

Add approvals to your workflow

To add an approval:

1. In your project, go to **Project settings > Workflows**.
2. Select your change workflow and edit it.
3. Select the right workflow steps, as described in the next sections. Youll do it separately for the Approving and CAB review steps.
4. Select **Add approval**, and click **Configure** next to it.

**Workflow step: Approving**

This workflow step is only used by Normal changes. Its an initial review by change managers and asset owners that are overseeing changes made to production services.

Configure approval for the Approving step in the following way:
### Field | Value
--- | ---
Get approvers from | User picker field
  - Custom field: Change managers
Assets object field |  
  - Custom field: Affected object
  - Attribute: Owner
Consider approved after | Up to you, usually one or two approvals are enough.
Transition when approved | Awaiting CAB review
  **Note:** Not all teams use CAB reviews and we also treat it as an optional step. If you’d like to omit it, you can set this transition to Ready for implementation.
Comment required when approving | Select this to make sure that approvers add comments when they approve a change.
Transition when declined | Decline
Comment required when declining | Select this to make sure that approvers add comments when they decline a change.
Workflow step: CAB review

This workflow step is only used by Normal changes. It's a thorough review by Change Advisory Board (CAB) to assess the change and reduce the potential risk.

Configure approval for the **CAB review** step in the following way:

### Field | Value
---|---
Get approvers from | User picker field
  - Custom field: CAB
Consider approved after | Up to you, usually one or two approvals are enough.
Transition when approved | Ready for implementation
Comment required when approving | Select this to make sure that approvers add comments when they approve a change.
Transition when declined | Decline
Comment required when declining | Select this to make sure that approvers add comments when they decline a change.

**Result**

Here's a sample change request with approvals, in two different workflow steps that you configured:
Approving CAB review

Next steps

When you're ready, go to 6. Create and update automation rules.
6. Create and update automation rules

Automation rules will do the repetitive tasks for you and make sure your change requests behave as they should. The rules you'll create will do the following actions:

- Determine and assign the proper change risk
- Calculate the priority
- Escalate Emergency changes
- Auto-approve Standard changes

Create automation rules

1. Open your project.
2. Go to Project settings > Automation.
3. Select Add rule and choose Custom rule.
4. Add the following rules:

**Rule 1: Determine risk based on affected objects importance**

This rule will check the value of the Importance attribute of the affected Insight object and adjust the change risk accordingly. For example, if the objects importance is Critical, the risk will be set to Critical, and if its High the risk will be set to High as well.

<table>
<thead>
<tr>
<th>When...</th>
<th>If...</th>
<th>Then...</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Trigger:</strong> Issue created</td>
<td><strong>Condition:</strong> Issue matches</td>
<td><strong>Action:</strong> Edit issue</td>
</tr>
<tr>
<td></td>
<td><strong>Advanced query:</strong></td>
<td><strong>Field:</strong> Change risk</td>
</tr>
<tr>
<td></td>
<td>`issuetype = Change AND &quot;Affected object&quot; in iqlFunction (*&quot;Importance = &quot;Critical&quot;)'</td>
<td><strong>Replace with value:</strong> Critical</td>
</tr>
<tr>
<td></td>
<td><strong>Else if...</strong></td>
<td><strong>Then...</strong></td>
</tr>
<tr>
<td></td>
<td><strong>Condition:</strong> Issue matches</td>
<td><strong>Action:</strong> Edit issue</td>
</tr>
<tr>
<td></td>
<td><strong>Advanced query:</strong></td>
<td><strong>Field:</strong> Change risk</td>
</tr>
<tr>
<td></td>
<td>`issuetype = Change AND &quot;Affected object&quot; in iqlFunction (*&quot;Importance = &quot;High&quot;)'</td>
<td><strong>Replace with value:</strong> High</td>
</tr>
<tr>
<td></td>
<td><strong>Else if...</strong></td>
<td><strong>Then...</strong></td>
</tr>
</tbody>
</table>
**Rule 2: Calculate priority based on changes impact and urgency**

This rule will check the values of the *Impact* and *Urgency* fields of the change and update the priority accordingly.

<table>
<thead>
<tr>
<th>When...</th>
<th>If...</th>
<th>Then...</th>
</tr>
</thead>
<tbody>
<tr>
<td>Trigger: Issue created</td>
<td>Condition: Issue matches</td>
<td>Action: Edit issue</td>
</tr>
<tr>
<td></td>
<td>Advanced query:</td>
<td>Field: Priority</td>
</tr>
<tr>
<td></td>
<td><code>issuetype = Change AND (Impact = &quot;Extensive / Widespread&quot; AND Urgency in (High, Critical)) OR (Impact = &quot;Significant / Large&quot; AND Urgency = Critical)</code></td>
<td>Replace with value: Critical</td>
</tr>
<tr>
<td>Else if...</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Condition: Issue matches</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Advanced query:</td>
<td>Action: Edit issue</td>
<td></td>
</tr>
<tr>
<td><code>issuetype = Change AND (Impact = &quot;Moderate / Limited&quot; AND Urgency = Critical) OR (Impact = &quot;Significant / Large&quot; AND Urgency = High) OR (Impact = &quot;Extensive / Widespread&quot; AND Urgency = Medium)</code></td>
<td>Field: Priority</td>
<td>Replace with value: High</td>
</tr>
<tr>
<td>Else if...</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

---

683
**Rule 3: Escalate emergency changes**

This rule will transition Emergency changes right to the *Implementation* status on the workflow. Also, a public comment about it will be added.

<table>
<thead>
<tr>
<th>When...</th>
<th>If...</th>
<th>Then...</th>
</tr>
</thead>
<tbody>
<tr>
<td>Trigger: Issue created</td>
<td>Condition: Issue matches</td>
<td>Action: Transition issue</td>
</tr>
<tr>
<td></td>
<td>Advanced query:</td>
<td>Transition: Emergency override</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Action: Add comment</td>
</tr>
<tr>
<td></td>
<td>issuetype = Change AND &quot;Change type&quot; = Emergency</td>
<td>Comment text:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>This is an automated message to tell you that your request has been transitioned to Implementing.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Comment type: Public</td>
</tr>
</tbody>
</table>

**Update existing automation rules**

Edit the following rule to make it work with the new workflow.

**Rule: Auto-approve standard changes**

With these updates, Standard changes will be automatically approved and transitioned to the Implementing status. Also, a public comment about it will be added.
<table>
<thead>
<tr>
<th>When...</th>
<th>If...</th>
<th>Then...</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Trigger</strong>: Issue created</td>
<td><strong>Condition</strong>: Issue matches Advanced query:</td>
<td><strong>Action</strong>: Transition issue</td>
</tr>
<tr>
<td></td>
<td>issuetype = Change AND &quot;Change type&quot; = Standard</td>
<td><strong>Transition</strong>: Ready for implementation</td>
</tr>
<tr>
<td></td>
<td></td>
<td><strong>Action</strong>: Auto approve/decline</td>
</tr>
<tr>
<td></td>
<td></td>
<td><strong>Answer</strong>: Approve</td>
</tr>
<tr>
<td></td>
<td></td>
<td><strong>Action</strong>: Add comment</td>
</tr>
<tr>
<td></td>
<td></td>
<td><strong>Comment text</strong>: This is an automated message to tell you that your request has been pre-approved.</td>
</tr>
<tr>
<td></td>
<td></td>
<td><strong>Comment type</strong>: Public</td>
</tr>
</tbody>
</table>

**Next steps**

When youre ready, go to 7. (Optional) Set up a calendar to coordinate your changes.
7. (Optional) Set up a calendar to coordinate your changes

Team Calendars is part of Confluence Data Center, and you can optionally use it to view your planned changes in a calendar. It will let you track changes and schedule them so they coincide with business events. Learn more about Team Calendars

To set up a change calendar with Confluence:

1. In Confluence, go to your teams space.
2. From the sidebar, select Calendars.
3. Select Add calendar.
4. Viewing the calendar, select Add event.
5. Select the Event Type drop down and choose Jira Issue Dates.
6. Under Display, select the JQL (advanced) and enter the following:

   \[ \text{project} = "Your IT service desk project name" \text{ AND issuetype} = \text{Change} \]

7. Under Date range, select Add start and end date Select Change start date as the start date. Select Change completion date as the end date.
8. Select OK.

The calendar automatically picks up the start and end dates of change requests from your service project. Then, it plots them on the calendar.

You're good to go

These are all the steps needed to adjust your project to new change management. If you haven't checked it already, see Sample lifecycle of a change for an overview of how your changes will behave.
Managing incidents with your IT service desk

An incident model helps service desks investigate, record, and resolve service interruptions or outages. An Information Technology Infrastructure Library (ITIL) incident management workflow aims to reduce downtime and negative impacts.

Incident management focuses on short-term solutions. To manage recurring incidents or underlying problems, see Managing problems with your IT service desk.

The IT Service Desk template comes with an incident management workflow. This workflow ensures that you log, diagnose, and resolve incidents. We recommend you start with this workflow and adapt it to your business needs.

When managed well, incident records can identify:

- missing service requirements
- potential improvements
- future team member training

This page describes some best practices for managing incidents using Jira Service Management. You may seek formal training in how to make ITIL recommendation work best for your business.

Incident management process

The IT Service Desk template associates certain requests with an incident workflow. We set up the workflow to complement the following incident management process. We recommend you start with this workflow and adapt it to your specific needs over time.

The ITIL incident management process, in brief:

1. Service end users, monitoring systems, or internal IT members report interruptions.
2. The service desk describes and logs the incident. They link together all reports related to the service interruption.
3. The service desk records the date and time, reporter name, and a unique ID for the incident. Jira Service Management does this automatically.
4. A service project agent labels the incidents with appropriate categorization. The team uses these categories during post-incident reviews and for reporting.
5. A service desk agent prioritizes the incident based on impact and urgency.
6. The team diagnoses the incident, the services effected, and possible solutions. Agents communicate with incident reporters to help complete this diagnosis.

7. If needed, the service project team escalates the incident to second-line support representatives. These are the people who work regularly on the affected systems.

8. The service project resolves the service interruption and verifies that the fix is successful. The resolution is fully documented for future reference.

9. The service desk closes the incident.

10. Team members should carry out post-incident reviews for major incidents. These investigations can help determine:
   a. missing requirements
   b. potential changes to service level agreements
   c. potential service improvements or focus areas

Set up incident management in Jira Service Management

Configure the workflow and fields with the Incident Management workflow add-on

We used the ITIL framework to build the following workflow add-on for incident management: https://marketplace.atlassian.com/plugins/com.atlassian.servicedesk.incident/server/overview.

You can use this workflow as a template for your own incident management process.

To use the workflow from the Marketplace:

1. Log in as a user that has the Jira administrator global permission, and follow the instructions listed here to import a workflow.
2. To add the workflow fields to your incidents, activate the screen by following the instructions here: Defining a screen.

Incident management workflow
Default form fields for incident reports

Jira Service Management allows you to customize the fields of information collected from customers. Additionally, you can customize the fields of information used by your agents. Jira Service Management does this through issue type fields and screens. Fields help agents investigate, assess, and categorize the incident for reporting or querying.

By default, we include the following fields in your agents' view of an incident. If needed, you can add custom fields. Find out more about fields in Jira.

<table>
<thead>
<tr>
<th>Field name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Summary</td>
<td>A short description of the request.</td>
</tr>
<tr>
<td>Reporter</td>
<td>The person who submitted the request.</td>
</tr>
<tr>
<td>Component/s</td>
<td>Segments of your IT infrastructure that relate to the request. For example, &quot;Billing services&quot; or &quot;VPN server&quot;. These are used for labeling, categorization, and reporting.</td>
</tr>
<tr>
<td>Attachment</td>
<td>Files or images added to the request.</td>
</tr>
<tr>
<td>Description</td>
<td>A long, detailed description of the request.</td>
</tr>
<tr>
<td>Linked Issues</td>
<td>A list of other requests that affect or are effected by the request. If your business uses other Atlassian products, this list may include linked development issues.</td>
</tr>
<tr>
<td>Assignee</td>
<td>The team member assigned to work on the request.</td>
</tr>
<tr>
<td>Priority</td>
<td>The importance of the request's resolution, usually in regards to your business needs and goals. Sometimes, priority is calculated by impact and urgency.</td>
</tr>
<tr>
<td>Labels</td>
<td>A list of additional custom labels used for categorizing or querying records.</td>
</tr>
<tr>
<td>Request participants</td>
<td>A list of extra customers who take part in the request, for example, people from other teams or vendors. Read more about participants.</td>
</tr>
<tr>
<td>Approvers</td>
<td>A list of people responsible for approving the request, usually business, financial or technical contacts.</td>
</tr>
<tr>
<td>Organizations</td>
<td>A list of customer groups interested in the request's resolution.</td>
</tr>
<tr>
<td>Impact</td>
<td>The effect of the incident, usually in regards to service level agreements.</td>
</tr>
<tr>
<td>Urgency</td>
<td>The time available before the business feels the incident's impact.</td>
</tr>
<tr>
<td>Pending reason</td>
<td>A short description or code that indicates why the incident is not progressing.</td>
</tr>
<tr>
<td>Product categorization</td>
<td>A category of IT asset or system that the request effects.</td>
</tr>
<tr>
<td>Operational categorization</td>
<td>A category of action or function required to fulfill the request.</td>
</tr>
<tr>
<td>Source</td>
<td>The asset or system where the incident originated.</td>
</tr>
</tbody>
</table>

Learn more about IT service management (ITSM)

Get more tips and tricks for successful ITSM, view case studies, and learn how to take your service project to the next level.
Check out the ITSM resources on IT Unplugged.
Managing problems with your IT service desk

Information Technology Infrastructure Library (ITIL) distinguishes between incidents and problems. Incident management serves to quickly restore services or broken experiences. For more information on incidents, see incident management.

Problem management seeks to prevent incidents from happening again. Problems are typically reported by internal IT members and not their customers.

An ITIL problem management workflow aims to investigate, record, and prevent IT infrastructure problems. The IT Service Desk template comes with a built-in workflow for handling problems. We recommend you start with the template's default workflow and adapt it to your business needs. When correctly managed, problem records prompt agents to detail known errors and workarounds in your knowledge base. These documents:

- help service agents resolve issues and restore services
- reduce downtime
- increase the quality and trust of your IT infrastructure

This page describes best practices for managing problems using Jira Service Management. You may seek formal training in how to make ITIL recommendation work best for your business.

Problem management process

The IT Service Desk template comes with a problem-management workflow. We set up this workflow to complement the following problem management process. Use the workflow to transition problem registers alongside these ITIL recommended activities:

- problem investigation
- identification of workarounds
- recording of known errors

We recommend you start with our default workflow and adapt it to your specific needs over time.

The ITIL problem management process, in brief:

1. Incident trends, vendors, or technical support staff report problems to the service desk.
2. A service desk team member records the details of the problem and links all related incidents.
3. A service desk agent labels the problem with appropriate categorization. They may reusethelabels of the incidents linked to the problem. The team uses these categories during review and for reporting.

4. A service desk agent prioritizes the problem. They base priority on the frequency of related incidents and their impact.

5. The service desk team determines the root cause of the problem.

6. The service desk team records the workarounds used to resolve related incidents. These workarounds to reduce service interruptions until the service desk fully resolves the problem.

7. The service desk team adds known errorsto their knowledge base. They include symptoms of related incidents and relevant workarounds.

8. The service desk team proposes a change to the infrastructure to resolve the problem.

9. The service desk closes the problem.

10. Team members should carry out in-depth reviews of major problems.

Set up problem management in Jira Service Management

Configure the workflow and fields with the problem management workflow add-on

We used the ITIL framework to build the following workflow add-on for problem management: https://marketplace.atlassian.com/plugins/com.atlassian.servicedesk.problem.

You can use this workflow as a template for your own problem management process.

To use the workflow from the Marketplace:

1. Log in as a user that has the Jira administrator global permission, and follow the instructions listed here to import a workflow.

2. To add the workflow fields to your incidents, activate the screen by following the instructions here: Defining a screen.

Problem management workflow
Default form fields for problem reports

Jira Service Management allows you to customize the fields of information collected from customers. Additionally, you can customize the fields of information used by your agents. Jira Service Management does this through issue type fields and screens. Fieldshelp agents investigate, assess, and categorize the problems for reporting or querying.

By default, we include the following fields in your agents' view of a problem. If needed, you can add custom fields. Find out more about fields in Jira.

<table>
<thead>
<tr>
<th>Field name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Summary</td>
<td>A short description of the request.</td>
</tr>
<tr>
<td>Reporter</td>
<td>The person who submitted the request.</td>
</tr>
<tr>
<td>Component /s</td>
<td>Segments of your IT infrastructure that relate to the request. For example, &quot;Billing services&quot; or &quot;VPN server&quot;. These are used for labeling, categorization, and reporting.</td>
</tr>
<tr>
<td>Attachment</td>
<td>Files or images added to the request.</td>
</tr>
<tr>
<td>Description</td>
<td>A long, detailed description of the request.</td>
</tr>
<tr>
<td>Linked Issues</td>
<td>A list of other requests that affect or are effected by the request. If your business uses other Atlassian products, this list may include linked development issues.</td>
</tr>
<tr>
<td>Assignee</td>
<td>The team member assigned to work on the request.</td>
</tr>
<tr>
<td>Priority</td>
<td>The importance of the request's resolution, usually in regards to your business needs and goals. Sometimes, priority is calculated by impact and urgency.</td>
</tr>
<tr>
<td>Labels</td>
<td>A list of additional custom labels used for categorizing or querying records.</td>
</tr>
<tr>
<td>Request participants</td>
<td>A list of extra customers who take part in the request, for example, people from other teams, or vendors. Read more about participants.</td>
</tr>
<tr>
<td>Approvers</td>
<td>A list of people responsible for approving the request, usually business, financial or technical contacts.</td>
</tr>
<tr>
<td>Organizations</td>
<td>A list of customer groups interested in the request's resolution.</td>
</tr>
<tr>
<td>Impact</td>
<td>The effect of the problem, usually in regards to service level agreements.</td>
</tr>
<tr>
<td>Urgency</td>
<td>The time available before the business feels the problem's impact.</td>
</tr>
<tr>
<td>Source</td>
<td>The asset or system where the problem originated.</td>
</tr>
<tr>
<td>Investigation reason</td>
<td>The trigger for prompting an investigation. For example, reoccurring incidents, non-routine incidents, or other.</td>
</tr>
<tr>
<td>Pending reason</td>
<td>A short description or code that indicates why the problem is not progressing.</td>
</tr>
<tr>
<td>Product categorization</td>
<td>A category of IT asset or system that the request effects.</td>
</tr>
<tr>
<td>Operational categorization</td>
<td>A category of action or function required to fulfill the request.</td>
</tr>
<tr>
<td>Root cause</td>
<td>The original cause of the incidents related to the problem.</td>
</tr>
<tr>
<td>Workaround</td>
<td>The detailed description of a temporary, known solution to restore a service. If you have Confluence, we recommend you document your workaround in your knowledge base.</td>
</tr>
</tbody>
</table>

Learn more about IT service management (ITSM)

Get more tips and tricks for successful ITSM, view case studies, and learn how to take your service desk to the next level.

Check out the ITSM resources on IT Unplugged.
Calculating priority automatically

Jira Service Management comes with some powerful automation tools. IT teams can set up their service project to calculate a request's priority automatically.

Removing manual processes gives time back to your team. Your team spends less time triaging and prioritizing requests. And, they spend more time resolving IT service tasks. Calculating the correct priority helps put requests into the correct SLA.

Some IT teams use an impact-urgency matrix to determine the priority of an issue. This page walks through an example for defining this matrix. Then, it discusses using these decisions to automate how priority calculation with these fields.

At the end, you should know a bit more about automation and how it can help you remove all sorts of manual processes. Automation frees up your agents' time and makes your service desk more efficient.

Create a priority matrix using impact and urgency values

Work with your team to determine how your service desk prioritizes incidents. Below is a sample matrix for how our team thinks about priority. Yours may differ depending on your resources and other factors.

Here's an example matrix:

<table>
<thead>
<tr>
<th>Impact</th>
<th>Urgency</th>
<th>Critical</th>
<th>High</th>
<th>Medium</th>
<th>Low</th>
</tr>
</thead>
<tbody>
<tr>
<td>Extensive / Widespread</td>
<td>Highest priority</td>
<td>Highest priority</td>
<td>High priority</td>
<td>Medium priority</td>
<td></td>
</tr>
<tr>
<td>Significant / Large</td>
<td>Highest priority</td>
<td>High priority</td>
<td>Medium priority</td>
<td>Low priority</td>
<td></td>
</tr>
<tr>
<td>Moderate / Limited</td>
<td>High priority</td>
<td>Medium priority</td>
<td>Low priority</td>
<td>Lowest priority</td>
<td></td>
</tr>
<tr>
<td>Minor / Localized</td>
<td>Medium priority</td>
<td>Low priority</td>
<td>Lowest priority</td>
<td>Lowest priority</td>
<td></td>
</tr>
</tbody>
</table>

Note that the priority values listed above are just examples for this tutorial. You can also create priorities that are specific to your service desk. See Defining priority field values and Associating priorities with projects for more details.

Before you begin

Make sure you have the following two custom fields of the type Select List (single choice), each containing the values listed in the previous table:

- **Urgency**: Critical, High, Medium, Low
- **Impact**: Extensive, Significant, Moderate, Minor

Automating the calculation

After Step 1, the workflow transitions a change to Priority triage status as soon as an issue is created. You will also have 4 transitions to set the Priority to a value.

With Step 2, you will set up an automation rule that checks the value of the Urgency and Impact fields and fires off the corresponding transition according to the matrix.

Step 1: Configure the workflow

1. Go to the workflow that is used by your Change issue type.
2. Between the Create transition and your first status, add a new status and name it Priority Triage.
3. Add the following four transitions from this status:
   a. Highest
   b. High
4. In each of these transitions, add a post function.
   a. Select the **Update Issue Field** post function.
   b. In the post function, update the **Priority** field to match the transition, for example, the **Highest** transition will have a post function that changes the **Priority** field to **Highest**. Similarly, the **High** transition will have this post function to set the **Priority** field as **High**, and the **Medium** transition to set the value to **Medium**, and **Low** to **Low**.

5. Publish the workflow.

**Step 2: Configure the automation rule**

After the post function is set, let's create an automation rule that triggers the appropriate transition depending on the urgency and impact selected during request creation.

The rules should follow the following pattern:

- **When**: Issue created
- **If**, or **Else if**: Specify the urgency and impact value pair according to the matrix, for example:

  ```
  status = "Priority triage" AND Impact = "Extensive / Widespread" AND Urgency = Highest
  ```

- **Then**: Transition issue, and select the transition that matches the value pair according to the matrix.

**Note**: If your **Urgency** or **Impact** value is optional on the request type form or issue create screen, then there might be cases where these fields are empty. In this case, make sure that you add an **Else if** condition that caters for this scenario, for example:

- **Else if**: 

---

Created in 2023 by Atlassian. Licensed under a Creative Commons Attribution 2.5 Australia License.
• **Then**: Transition issue, **Low**.

Learn more about IT service management (ITSM)

Get more tips and tricks for successful ITSM, view case studies, and learn how to take your service desk to the next level.

Check out the ITSM resources on IT Unplugged.
Manage changes with your IT service management project 1

Effective service teams plan and control changes, as they understand their impact to their business. Although Jira Service Management provides default change management workflows and fields, weve now updated them to better follow the Information Technology Infrastructure Library (ITIL) best practices. Weve also added a few additional steps that will let you create an inventory of assets and open changes against them by using the built-in asset management functionality.

Learn more about ITIL and change management

If you're not familiar with the ITIL best practices, check out our resources. They'll explain you the basic concepts, definitions, and processes. Learn more about change management

Set up change management in Jira Service Management

Have a look at the list of customizations we've made to the change management process. If you'd like to use them, you'll need to adjust your individual projects manually.

Change management workflow

The workflow follows the ITIL best practices and terminology, and makes sure your changes are approved and accounted for. Extra steps let you properly plan and assess the most important and risky changes, at the same time not slowing down critical changes that must be implemented right away. All this with the right stakeholders sharing their expertise and approving your changes along the way.

Different types of changes using different workflow paths

Thanks to automation rules, different types of changes can take different paths. Just so emergency changes don't have to wait for all of the approvals, they're emergencies after all.

EMERGENCY

An emergency change must be assessed and implemented as quickly as possible. Such a change omits a few steps and goes right into implementation, but it includes an extra review once it's done.

STANDARD

A standard change occurs frequently, is low risk, and has a pre-established procedure with documented tasks for completion. As such, it needs less planning and fewer approvals.
A normal change typically requires an important change to a service or infrastructure, but you might not have a well established process for it. It's good to properly plan and approve it.

Automation rules handling repetitive tasks for you

Automation rules will also take some burden off your back and automate repetitive tasks, just so you don't have to think about them:

- Determine change risk based on the importance of affected assets
- Calculate priority based on impact and urgency
- Escalate emergency changes
- Auto-approve standard changes

Change plans

With custom fields, each change request can store detailed plans, just to make sure everyone working on it knows what they're doing or can quickly roll back if it turns out they don't:

- Implementation plan
- Test plan
- Backout plan

Inventory of assets and configuration items

Jira Service Management lets you create an inventory of assets and configuration items, together with their details and relations between them. You can then open changes against these assets and get them linked together. Thanks to that, details about an asset are included in the change request and everyone involved has enough context to decide how risky or important a change is.

Approvals from the right stakeholders

Make sure the most important and risky changes are approved by the right people. You can include change managers, CAB, and approvers that are directly responsible for your assets, the right people at the right time. By using Insight custom fields, these approvers will change dynamically depending on the asset affected by your change request.

- Change managers (user picker field)
- Change Advisory Board (user picker field)
- Owners of your Insight assets (Insight field)
Get started with improved change management

To get started, follow these steps. They’ll help you adjust your projects to all of these changes and provide some explanations about what these changes do:
Best practices for software teams using Jira Service Management

This guide helps teams using server versions of Jira Service Management and Jira Software.

Software teams that develop with Jira Software can give technical support and get customer feedback using Jira Service Management. Teams using Jira Software can view and comment on Jira Service Management bug reports without any additional licensing or billing cost. Read more about collaborating on Jira Service Management.

You can use this guide and Jira Service Management’s customer service project template to:

- collect user bugs and feedback via a built-in web portal
- give users technical support
- help users with licensing and billing

Jira Service Management is highly configurable, and the template is just a starting point. Over time, you can fine-tune the template to your specific business needs.

This guide covers how to:

- Get set up for customer service
- Collect effective bug reports from customers
- Customize Jira Service Management’s bug report workflow
- Collaborate with other Jira teams on Jira Service Management issues
- Escalate Jira Service Management issues to other Jira teams
**Collaborate with other Jira teams on Jira Service Management issues**

Software teams can get context from your service project agent's conversations with customers. You can set up your service project to allow Jira Software teams to view and comment on Jira Service Management issues.

By default, Jira Service Management agents can:

- view Jira Software issues
- comment on Jira Software issues
- transition Jira Software issues

By default, Jira Software and Jira Core users:

- can’t view Jira Service Management requests in the customer portal
- can’t view Jira Service Management issues in a Jira Service Management project
- can’t comment on Jira Service Management requests in the customer portal
- can’t comment on Jira Service Management issues in a Jira Service Management project
- can’t view links to Jira Service Management issues in Jira Software or Jira Core project

If you plan to work with other Jira teams, you should change your project's permissions. We recommend giving all logged-in users permission to view and comment on service desk projects.

The table below contains a breakdown of three different types of permissions. These permissions make collaboration between service desk agents and software development teams possible:

<table>
<thead>
<tr>
<th>Permissions</th>
<th>Request participants</th>
<th>View permissions on Jira Service Management projects</th>
<th>Comment permission on Jira Service Management projects</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>These users can:</td>
<td>These users can:</td>
<td>These users can:</td>
</tr>
<tr>
<td></td>
<td>• view requests in the portal</td>
<td>• view issues in service projects</td>
<td>• add internal comments on service project issues</td>
</tr>
<tr>
<td></td>
<td>• add public comments in the portal</td>
<td>• view linked service project issue information in Jira Software projects</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• add attachments in the portal</td>
<td>• transition the request through customer visible statuses in the portal</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• transition the request through customer visible statuses in the portal</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Effect on Jira Service Management licensing and billing</td>
<td>None</td>
<td>None</td>
<td>None</td>
</tr>
</tbody>
</table>

The easiest way to collaborate (out of the box)

Jira Service Management agents can add other Jira team members as request participants. Then, Jira Software or Jira Core members can interact with customers in the web portal.

Request participants can:

- view requests in the portal
- add public comments in the portal
- add attachments in the portal
- transition the request through customer visible statuses in the portal
Agents can add request participants to service desk issues. Look for the People section in the issue and select the Request participants field to add members from other Jira teams.

Read more about request participants.

Modify your permissions to let other teams view and comment on service project issues

To view and edit the permission scheme for your service project, go to Project settings > Permissions.

![Warning]
You need to be a Jira admin to change project permission schemes. Changes to permission schemes affect all projects that share that scheme. Be careful!

Read more about configuring project permission schemes.

Give developers permission to view service project issue

To let all Jira Server users on your site view issues on your service project:

1. On the project permission scheme page, select Actions > Edit permissions.
2. Under Project Permissions, select Edit in the Browse Projects entry.
3. In the Granted to selection, choose Application access.
4. From the dropdown, select Any logged in user.
5. Select Grant.

This allows other Jira users to:

- view service project issues
- view links to service project requests in their own projects

Give developers permission to comment on service project issues

To let all Jira Server users on your site comment internally on service project issues:

1. On the project permission scheme page, select Actions > Edit permissions.
2. Under Comment Permissions, select Edit in the Add comments entry.
3. In the Granted to selection, choose Application access.
4. From the dropdown, select Any logged in user.
5. Select Grant.

Agents, not customers, will see these comments. Only Jira Service Management agents and admins can comment directly to customers. Other Jira users may comment publicly if the agent adds them as request participants.

Share your development teams' custom fields

Bug issues in Jira Software and Jira Service Management can stay in sync if they share custom fields and screens. We suggest you replicate the issue fields and screens from your development teams' bug issues in your Jira Service Management request types.

Work with your development teams' and Jira administrators to share custom fields between your request types and development projects.

Read more about custom fields.
Collect effective bug reports from customers

Jira Software is an issue and bug tracker that helps developers plan, build and ship their work. Jira Service Management is a simple way for customers to send your team bugs and feedback about shipped software.

Your users are your best friends. Their bug reports can help you:

- resolve issues before other users encounter them
- investigate and fix problems that slip through QA or automated testing
- catch issues from platforms you don’t prioritize during testing
- show your users you care about quality and their experience

Issues can happen in any part of software development, not just the code. If your designers, documentation writers, product managers, or other team members track their work in Jira, you can escalate bugs related to their work directly to their teams, too.

The bug reporting and resolution process

The information needed to replicate and resolve bugs varies. But, you can standardize your process for collecting bug reports.

The customer service template associates certain requests with a bug report workflow. This workflow complements the bug report process. Use it as a jumping off point for your service project.

Requests that follow a bug report process have the same workflow in Jira Service Management and Jira Software. But, the teams' processes for handling bug reports have significant differences.

<table>
<thead>
<tr>
<th>Bug process for agents working in Jira Service Management</th>
<th>Bug process for developers working in Jira Software</th>
</tr>
</thead>
<tbody>
<tr>
<td>1. A user reports a problem with their software or service.</td>
<td>1. The development team receives a bug report.</td>
</tr>
<tr>
<td>2. A service project agent investigates to see if they can provide any known solutions to the customer:</td>
<td>2. The project manager determines the bug's priority. They assign the issue to a developer.</td>
</tr>
<tr>
<td>- If the problem has a known solution, the service project agent works with the customer to fix the problem.</td>
<td>3. The developer investigates the bug and either verifies or rejects the report.</td>
</tr>
<tr>
<td>- The problem may be new or the service project agent can’t find an answer from a knowledge base or development point of contact. In this case, the service project agent escalating the bug report to the development team for fixing. Read more about escalating issues to other Jira teams.</td>
<td>4. The developer fixes the problem and transitions the issue to a QA tester.</td>
</tr>
<tr>
<td>3. The service project agent liaises between the customer and development team to collect any extra information needed to fix the bug. They communicate the development team's progress.</td>
<td>5. The tester verifies they fixed problem and resolves the ticket. They notify the service project agent that development is complete. They may provide extra information, like when the fix will reach the customer.</td>
</tr>
<tr>
<td>4. The service project agent verifies with the customer that they fixed the problem. Then, the agent resolves the customer's bug report.</td>
<td></td>
</tr>
</tbody>
</table>

Collect specific information from users with custom fields

Work with your development team and Jira administrators to share a custom field set. Define what custom fields you want to collect to aid developers fixing bugs. Your Jira administrator can maintain these fields in a single screen scheme. They can apply the scheme to both development and service projects. Read more about custom fields and screen schemes.
Developers note incomplete information as the biggest blocker to investigating and fixing bugs. The most common information that developers use are:

- the steps to reproduce
- observed and expected behavior
- screenshots

You might want to collect other information to categorize, report, or automate actions related to the bug report. For example:

- operating system
- version
- component
- URL
- user agent string

The more information you can collect, the easier diagnosing the problem will be. Your development team will thank you.

By default, the **Report a bug** request type comes with these fields:

- Summary
- Symptom
- Attachment

To add pre-created custom fields to your request types:

1. In your service desk project, select **Project settings** > **Request types**.
2. In the **Report a bug** request type entry, select **Edit fields**.
3. Select **Add a field**.

Read more about adding custom fields.

**Tips for creating bug report forms on your portal**

- You can add help and instructions to your bug report request type. Encourage your customers to report each problem on a separate request. This helps tracking bugs in reports and development sprints.
- Use natural language when asking for information. For example, if you add a field to collect expected behavior, ask your customer to report these in plain terms: “What did you expect to happen?”
- Check in with your development teams every so often. Ask if there's any more information they need to squash bugs in your software.
- Check in with your Jira administrators every so often. Ask if there's any changes to screens that you should reproduce in your request types.
Customize Jira Service Management's bug report workflow

When a customer reports a bug using the portal, Jira Service Management assigns the request to your organization's Bug workflow. By default, this workflow is the same for both Jira Service Management and Jira Software issues.

This workflow follows the basic process above. Jira administrators can customize it to adapt to the needs of your customers, developers, and service desk agents.

Customize your bug report and resolution workflow
Jira’s default Bug workflow is a good starting point for most teams. As your organization grows, you may want to update your workflow to suit the specific needs of your business. For example, you can add steps for approvals or QA verification.

⚠️ You need to be a Jira admin to make changes to workflows. Changes to workflows affect all projects that use the workflow. Be careful!

To edit the bug workflow:

1. In your service project, select Project settings > Workflows.
2. Select the edit icon next to the entry titled <Project key>: Jira Service Desk default workflow.
3. Use the workflow editor to add or remove steps and transitions.

Read more about working with workflows.

Add a "waiting on development" step to the request’s workflow

You may want to add a stage to your bug workflow for when a development team investigates the issue. This status helps your service team track which bugs are being handled by a development team. And, it informs customers when the issue is being looked at by developers.

To add a new step in the workflow:

1. Follow the above steps to customize the <Project key>: Jira Service Desk default workflow.
2. Select + Add status.
3. Give the status a name. For example, Waiting on development team and select Add.
4. Give the status a description. This helps administrators who manage workflows across Jira Server apps.
5. Switch the category to In progress.
6. Select Create.

To add an incoming "escalate to development team" transition:

1. Select the Waiting on development team status.
2. Select Add Transition.
3. In the From status drop down, select Work in progress.
4. In the To status drop down, select Waiting on development team.
5. In the Name field, provide the call to action. For example, Escalate to development team.
6. In the Screen drop down, select Workflow Screen.
7. Select Add.

To add a transition to allow the agent to mark the request as done:

1. Select + Add transition.
2. In the From status drop down, select Waiting on development team.
3. In the To status drop down, select Done.
4. In the Name field, provide the call to action. For example, Mark as close.
5. In the Screen drop down, select Resolve Issue Screen.

Publish your draft workflow.
Escalate Jira Service Management issues to other Jira teams

As agents investigate bug reports, they may need to escalate issues to the development team. For example, the agent may not find a fix from the knowledge base or a development contact. In this case, they may escalate the issue to a development team to fix in the software.

The development team should use an issue on their software board or backlog to track the fix. To make this easier, Jira Service Management agents can create these issues for them. Here's how the process works:

1. A service project agent receives a bug report from a customer.
2. The agent verifies that the bug needs a developer to fix the issue.
3. The service project agent creates a linked issue in the development team's Jira Software project.
4. The development team lead prioritizes and assigns the software issue to a developer to fix.
5. The developer works in their Jira Software project while fixing the issue.
6. The developer resolves the issue and Jira Service Management automatically updates the service agent about the fix.

Agents can pass on feature requests or improvement suggestions to project planning teams. They can also create issues with public-facing websites for marketing or documentation teams that use Jira Core.

Create linked issues

Service project agents can escalate a Jira Service Management issue to a Jira Software of Jira Core project by creating a linked issue. To create a linked issue:

1. View the issue.
2. Select the More option.
3. Select Create linked issue.
4. Choose the appropriate project where the issue needs to be escalated to.
5. Select Create.

Linked issues created this way use a "causes" link by default. This means:

- The service desk issue is "caused by" the linked development issue.
- The development issue "causes" the linked service desk issue.

Jira Software and Jira Core teams get the most use of this technique when they can view and comment on issues in your service project. Read more about collaborating with other Jira teams on Jira Service Management issues.

Automatically update Jira Service Management agents about the progress of a linked issue

Service projects come with an automation rule that updates agents on the status of linked issues. The rule adds an internal comment on the service desk issue whenever another team transitions a "caused by" linked issue.

So, when a developer looks into a bug and resolves it as "fixed", they notify the service desk agent in the process. Then, the agent can follow up with the customer to make sure the fix works for them.

We enable the Update when a linked issue changes automation rule by default. To view or edit this rule:

In your service desk project, select Project settings ( ) > Automation.

Read more about automation.
Get set up for customer service

Create a customer service project

You need to be a Jira administrator to do this step.

To create a project using the customer service template:

1. Select **Projects > Create project**.
2. Choose the **Customer service** template and hit **Next**.
3. Name your project.
4. Select **Submit**.

Your new project comes with a service catalog, recommended workflows, and basic reports. If you bundle Jira Service Management with Confluence, we also create a Confluence knowledge base. We recommend using this to record known solutions, FAQs and other articles that your customers can use to serve themselves. Try Confluence for free.

Create forms to collect the right information from your users

Our web forms make sure users give you all the details you need to give support or collect feedback. If you get all the information up front, you can:

- prioritize requests
- get them to the right agent
- give development teams the information they need to investigate and fix bugs quickly

We call these customizable web forms request types. To start, find the most common and urgent requests that users have sent your way, then make sure there's a corresponding request type for each of these.

To view or edit your request forms:

1. In your service project, select **Project settings > Request types**. The forms there display in your web portal.

The customer service template comes with the following request types:

- Technical support
- Licensing and billing questions
- Product trial questions
- Other questions
- Report a bug
- Suggest a new feature
- Suggest improvement

Read more about request types.

Fill a knowledge base so customers can help themselves

A knowledge base stores how-tos, FAQs, and other short articles. Customers can use these to solve problems without contacting support. And, agents can use these to share knowledge and solve requests faster.

The easiest way to add a knowledge base to your service desk is to link your project to a Confluence knowledge base space. When you add a knowledge base to your service project, it benefits both your users and your agents:

1. Customers search and view relevant articles when they search the customer portal. They may find the answers they need without ever raising a request.
2. Agents find relevant articles when they work on issues. This saves time finding and writing common answers or onboarding new team members.
Learn more at Set up a knowledge base for self-service.
Getting help with Jira Service Management

How can we help you?

We have a number of help resources available. You can get your problem resolved faster by using the appropriate resource.

I don't know how to do something

1. Search the Atlassian Community.
2. Raise a support request*.

Something isn't working

1. Check the ‘Jira Service Management’ (previously Jira Service Desk) knowledge base at https://confluence.atlassian.com/display/JiraKB.
2. Search the Atlassian Community.
3. Raise a support request*.

If you've identified a bug but don't need further assistance, raise a bug report (https://Jira.atlassian.com).

I don't like the way something works

• Raise a suggestion (https://Jira.atlassian.com).

Something else?

• If you need help with something else, raise a support request*.

* Tip: If you are the Jira system administrator, you have a number of additional support tools available. See Raising support requests as an administrator for details.

About our help resources

Atlassian Support

Our support team handles support requests that are raised in our support system. You need to log in using your Atlassian account before you can raise support requests.

For information on our general support policies, including support availability, SLAs, bugfixes, and more, see Atlassian Support Offerings. Note, you'll find anything security-related at Security@ Atlassian.

Tip:

If you are a Jira system administrator, you have a number of additional support tools available. These include the ability to raise a support request from within your Jira applications, create zip files of key Jira application information, and more. For details, see the Administering Jira Applications documentation.

Atlassian Community

Atlassian Community is our official application forum. Atlassian staff and Atlassian users contribute questions and answers to this site.

You may be able to find an answer immediately on the Atlassian Community, instead of having to raise a support request. This is also your best avenue for help if:
You are using an unsupported instance or an unsupported platform, you are trying to perform an unsupported operation, or you are developing an app for Jira Service Management.

You can also have a look at the most popular Jira Service Management answers and the most popular Jira answers.

**Jira Service Management knowledge base**

If there are known issues with a version after it has been released, the problems will be documented as articles in our knowledge base.

**Atlassian issue tracker**

Our official issue tracker records our backlog of bugs, suggestions, and other changes. This is open for the public to see. If you log in with your Atlassian account, you will be able to create issues, comment on issues, vote on issues, watch issues, and more.

---

**Tip:**

Before you create an issue, search the existing issues to see if a similar issue has already been created.
Automate your project

Automation lets you set up rules to automate repetitive tasks around Jira, such as closing stale issues, auto-assigning issues to the right people, or sending notifications to your teammates.

Create a rule

Each rule is made up of a trigger that kicks off a rule, conditions that refine the rule, and actions which execute it.

To create a rule:

1. In your project, go to Project settings.
2. Select Automation.
3. Select Create rule. You'll then add triggers, conditions, and actions.

Read more about the rule components below.

1. Triggers

Every rule starts with a trigger. You can choose from many triggers including issue transitioned, scheduled trigger, or issue created. If you wish, you can customize your trigger before moving on to your next component and completing your rule. Learn more about triggers

2. Conditions

Conditions allow you to narrow the scope of the rule. For example, only escalate an issue if it's high priority. Rules don't have to have conditions, but if you want to include them, they can be placed anywhere in the rule chain. If one condition fails, the rule will stop running. Learn more about conditions

3. Actions

Actions run once a rule is triggered and all conditions are met. You can perform many tasks, such as editing issues, sending notifications, creating sub-tasks, or adding audit messages. Learn more about actions

Use automation at scale

To give you an overview of what you can achieve with automation, we've prepared three examples of rules you can use to make the work go smoother.

Keep response times on track

Automation is now part of Jira Service Management Data Center. To start using it in your projects, upgrade to Jira Service Management Data Center 5.0 or later. Can't upgrade yet? Download the equivalent Marketplace app free of charge.
This rule reduces the number of times you need to go over your SLAs by notifying the assignee that they need to take an action when an SLA threshold is about to breached. This way you get more time to focus on other things while your customers receive a response to their requests on time.

The rule consists of:

- **A trigger:** An SLA threshold will be breached in the next 30 minutes.
- **An action:** Add a comment to the issue notifying the assignee about the breach.

**Balance the workload**

Ensure that your team shares the workload so you can respond as quickly and effectively as possible. Whenever an issue is created, this rule searches for a member of your team with the least amount of open tickets.

The rule consists of:

- **A trigger:** An issue is created.
- **An action:** Assign the issue to a team member using the balanced workload assignment method.

**Improve customer communication**
Remind your customer to respond. Close the issue when they don’t. Then, reopen it when they do. Simplify your communication with customers with these three rules.

Remind your customer to respond

- **Rule details**

  - **When: Scheduled**
    Searches with:
    - status = "Waiting for customer" and
    - updated < -2d
    - every 1 Days

  - **Then: Add comment to issue**
    Hi {{reporter.displayName}}, [something about needing the customer to respond]

  The rule consists of:
  
  - A trigger: A scheduled daily search for issues with the Waiting for customer status that haven’t been updated in 2 days.
  - An action: Add a comment notifying the reporter they need to remind the customer to respond.

Resolve an issue due to inactivity

- **When: Scheduled**
  Searches with:
  - status = "In Progress" and updated < -5d
  - every 1 Days

  - **Then: Transition the issue to**
    RESOLVED

  - **And: Add comment to issue**
    Hi {{issue.reporter.displayName.split(" ", first)}}, We haven’t heard back from you for 5 days, so we’re automatically
The rule consists of:

- A trigger: A scheduled daily search for issues with the In progress status that haven’t been updated in 5 days.
- Actions: Change the status to Resolved. Add a comment notifying the reporter the issue is being automatically closed due to inactivity.

Reopen an issue when there’s a new response

When: Issue commented
Rule is run when a comment is added to an issue.

If: Initiator is
Issue reporter

And: Issue matches JQL
statusCategory = done

Then: Transition the issue to
IN PROGRESS

The rule consists of:

- A trigger: A new comment is added to the issue.
- Conditions: The comment was added by the issue reporter. The issue is closed.
- Actions: Change the status to In progress.

Get started with Jira automation

To get started, see Jira automation.
Jira Data Center and Server mobile app

A native app for Jira Service Management Data Center and Server is here!

ℹ️ Jira Service Management has successfully passed the Beta stage and is now officially supported in the mobile app. To get this version, you'll need to upgrade to Jira Service Management 4.15 or later. If you can't upgrade yet, you can continue using Beta.
About the app

Here’s what you’ll get, and what you can do in the app.

**Available right now**

- Viewing Jira Service Management projects and requests
- Viewing agent queues
- Working on requests (creating, editing, linking, reassigning, responding to customers, etc.)
- Viewing SLAs and planning which tasks need to be resolved first
- Viewing and editing fields specific to Jira Service Management (Organizations, Request types, Request participants)
- Approving and declining
- Commenting internally and externally
- Receiving notifications about request updates
- Attaching files
- Viewing Assets fields (available on iOS, Android support coming soon)

**Still working on**

- Editing Assets fields

**Requirements**

**Jira Service Management**

You’ll need to install the latest version of the [Mobile Plugin for Jira](https://marketplace.atlassian.com) from Atlassian Marketplace, or upgrade to Jira Service Management 4.15 or later, which includes the plugin out of the box.

**Device requirements**

To use the app, your users will need a device with either:

- Android 5.1 (Lollipop) or later, or
- iOS 15 or later (iPhone, iPad, or iPod Touch)

**Downloading the app**
If you already used our Jira Data Center and Server app for Jira Software or Jira Core, you're good to go, it's the same app. If not, you can download it for Android or iOS.

Considerations for administrators

Here are some things to consider when determining whether your users will be able to use the app.

**VPN and firewalls**

If your Jira instance is not accessible on the public internet, users will need to connect their device to your network or virtual private network (VPN) in order to use the app.

We recommend providing your users with step-by-step instructions on how to connect to your VPN when you let them know the mobile app is available, as this is something Atlassian Support will not be able to help them with.

**SSL**

The app accepts both HTTP and HTTPS connections.

If your Jira instance is configured to use SSL, you will not be able to log in on the app if:

- your certificate is self signed
- the Certificate Authority (CA) is unknown, or is not one that Android / iOS trusts by default (for example it might be a new CA that is not yet trusted, or a private CA)
- your certificate is missing an intermediate CA, affecting the certificate chain
- your certificate doesn't meet Apple's Requirements for trusted certificates in iOS 13 (affects people using the app on iOS devices).

See our Knowledge base article for information on how to resolve this.

**Storage and encryption**

The iOS and Android apps cache some content (issues, projects, boards) locally on the device. This helps keep the app responsive when navigating around projects and issues. We don't use any application-level encryption when storing cached data, but the device's internal storage may be encrypted by the operating system.

When a user logs out, all cached data is deleted.

We don't store passwords in the app. Instead we use session cookies, which are encrypted by default.

**Login and authentication**

The app supports all common Jira user management configurations, including external user directories and SAML single sign-on (NTLM method isn’t supported, only basic). Users will need to sign in to use the app, even if your site allows anonymous access.

The app uses an RFC-compliant user-agent header for making the requests during login. This allows us to effectively identify the app and apply further processing based on the users hardware and software.

Given the wide variety of supported configurations we decided to adopt the most versatile format. For both iOS and Android we compose the User-Agent header value by concatenating the standard WebView User-Agent and unique app identifier.

**iOS User-Agent**

<table>
<thead>
<tr>
<th>Format</th>
</tr>
</thead>
<tbody>
<tr>
<td>Mozilla/5.0 (&lt;system-information&gt;) &lt;platform&gt; (&lt;platform-details&gt;) Safari/&lt;technical-version&gt; AtlassianMobileApp</td>
</tr>
</tbody>
</table>
Android User-Agent

Format

Mozilla/5.0 (<system-information>) <platform> (<platform-details>) AtlassianMobileApp

Example

Mozilla/5.0 (Linux; Android 9; Mi A1 Build/PPQ1.180917.001) AppleWebKit/537.36 (KHTML, like Gecko) AtlassianMobileApp

These headers are used in iOS app version 1.27.0 and Android app version 0.21.6 and later.

Mobile Device Management (MDM)

You can distribute the Jira Server app to people in your organisation using your MDM solution. For more info on how to do this, see Mobile Device Management.

Third party add-ons and visual customizations

The mobile app provides a simple, lightweight way for users to view, create, edit and collaborate on issues. Complex interactions, including those provided by add-ons, will not be available in the app.

Any look and feel customizations you've made to your Jira instance will not be reflected in the app.

The Jira Data Center and Server mobile app can push notifications directly to users' devices. Users choose whether they'd like to receive push notifications from the app, and can opt out at any time. This feature uses a cloud-based notifications service developed and maintained by Atlassian and hosted on our AWS infrastructure. No user or message content is sent to the service, only notification IDs, and we don't store any data.

If you need to avoid using any cloud-based services you can choose to disable push notifications entirely. Head to Administration > System > Jira mobile app.

If you're using restrictive firewall or proxy server settings, you'll need to allow (whitelist) https://mobile-server-push-notification.atlassian.com/ to ensure push notifications work as expected.

For sites that are not accessible on the public internet (for example users need to be connected via VPN to use the app) we adapt the push notification message as follows:

- If the user is connected to your network or VPN, we'll show the full notification, for example “Sara Leung shared 'End of year party' with you”
- If the user is not currently connected to your network or VPN, we'll show a shorter notification, for example “1 new notification”.

For more info about push notifications, see Push notifications.

Related pages and known issues

If you're having problems with logging in or encountered some other issues, head on to our knowledge base articles that will tell you what to do:

- Jira Data Center and Server mobile apps
Accessibility

We want every team around the globe to be able to use Jira with the least amount of trouble, and the accessibility settings bring us closer towards this goal. Whether your vision is impaired, you can't really tell colors apart, or just strongly believe that blue, azure, and sapphire are the same thingwe've got you covered.

More accessibility improvements!

Accessibility in Jira is not a one-time effortwe're constantly reviewing our VPAT report and fix accessibility issues in almost every Jira version. For more info, see Accessibility improvements in Jira.

Changing your accessibility settings

You can personalize your accessibility settings to make it easier to work with Jira. To change the settings, click your user avatar and select Accessibility. You can choose the following options:

- **Underlined links**
  This option underlines all hyperlinks around Jira to make them more visible.

- **Patterns on issue statuses**
  This options adds unique patterns to issue statuses to distinguish between them more easily.
- **Increased text spacing**
  This option increases text spacing between characters, words, lines of text, and paragraphs.

- **Background in subtle buttons**
  This option adds a gray background to subtle buttons (normally displayed on hover) to make them more prominent.

---

**For app developers**

If you're an app developer, you can make your app add new options to accessibility settings. For more info, see [Accessibility for app developers](#).